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Chapter 1 Getting Started

The Pac7 Software User's Guide is divided into the following sections:

This section... Contains information about the following ...

Introduction Basic usage of the Pac7 system, including the following:

l Sign In / Sign Out
l Navigating in Paciolan 7
l Updating Account Information

Setup Setting up and preparing the Pac7 system for use.

Order Man-
agement

Using the order level, order line, payment processes on the Order Management
tab.

Item Sales Using the general, onsale, and promotional sales paths on the Item Sales tab.

Inquiry Generating inquiries to get order information about patrons for all sales paths
(eVenue, TK.SELL, and Pac7).

Adjustments Returning order items and processing will call order pickups.

Patron Capturing and maintaining ticket-buying and fund development patron data.

Administration Managing users, business organizations, and terminals, as well as preparing for
and conducting onsales.

Reporting Generating sales summary, detailed transaction, and balancing reports for item
sales.

Back Office
Reference

The back office process screen controls that are used to set up Pac7.

Sign In / Sign Out
Before you can use Pac7, you must sign in to the application. You cannot sign in more than once
using the same account. So, you can only have one active Pac7 browser window. If you try to sign
in to Pac7 in another browser window, you will be automatically signed out of the first browser. The
application will also automatically sign you out if you stop using it for an hour or more.

To sign in to Pac7

1. If you are not already at the Sign In page, do the following:

a. In your browser Address box, enter the URL assigned by Paciolan. Your browser displays
the Warning - Security dialog box.

b. Do one of the following:

l Click the Yes button. The security warning will display each time you sign in.
l Click the Always button. The security warning will not display again.
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Pac7 displays the Sign In page.

2. In User Name, enter your user name. User names are case-sensitive.
3. In Password, enter your password. Passwords are case-sensitive and must contain at least
one numerical and one alphabetical character. There is also a minimum password length that
is set by your administrator.

Note: Your administrator sets the maximum number of times you are allowed to enter an
incorrect password. You will receive a warning before the last allowed time. If you enter an
incorrect password the maximum number of times, you will be locked out of the system.
Contact your administrator to have your access restored.

4. Click the Sign In button. The system signs you in and displays the Select a Data Account
page.

Note: Your administrator sets how long you can use your current password until it expires.
You will receive a warning several days before the password expires, and you will be
required to change the password when it expires using the Change Password page.
However, if you do not have the authority to change your password, you will have to contact
your administrator to have your password reset (Paciolan will display a message).

5. Click the policy with which you will be selling tickets. If the page contains more than one
data account, click a data account name to display its policies, and then select a policy.

Pac7 Release 7.2
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Tip: You can change policies at any time after logging in to Pac7. To change policies, click
the Select link in the Pac7 menu. Pac7 will display the Select Data Account page again, and
you can select a new policy.

To sign out of Pac7

1. To sign out of Paciolan, click the Log Out link in the Paciolan menu. The system displays the
Sign In page.

Navigating in Pac7
The table below describes the navigational elements that are always present when navigating the
Pac7 application.

Pac7 Release 7.2
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Element Description

Selection
tabs

Click a tab to navigate to the corresponding application tab (Order Man-
agement, Item Sales, Inquiry, Adjustments, or Patron)

Page name The name of the page on which you are working. Each tab has its own set of
pages through which you can navigate.

Current con-
trol

The control in use by the current operator.

Alert mes-
sages

Messages about the user account or from the selling control for the currently
signed in operator.

Control
selection

Click the Select link to display the Select a Data Account page. You can
then select a control from one of the displayed data accounts.

Current
operator
and time
zone

Shows the name of the current operator with the time zone of the location
assigned to the terminal.

Application
functions

Provides access to commands and administrative pages in the application.

Current
Batch

The batch number. Batch information is useful for reconciling sales and
reports.

Batch
change

If your operator permissions allow batch changes, click the Change link to
display the Select/Create Batch page to change batches.

Updating Account Information
You can update your account information, including your name, password, phone number, email
address, and language, from the My Account page.

To update your account information

Pac7 Release 7.2
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1. Click My Accountin the Paciolan menu.

Paciolan displays the My Account page.

2. Modify the following information as required:

Parameter Description

Last Name Your last name

First Name Your first name

User Name The name with which you log in. You cannot modify
this parameter

User Status The user status. Set to either Active or Inactive

Phone The phone number at which you can be reached
when using Paciolan

Email The email address at which you can be reached
when using Paciolan

Language The language in which the parameters in the Paci-
olan interface display

3. If you want to change your password, do the following:

a. Click the Change Password button. Paciolan displays the Change Password page.

Pac7 Release 7.2
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b. In Old Password, enter your current password.
c. In New Password, enter your new password. Your password must contain at least one let-
ter and one number. The length must be at least 7 characters, and may need to be longer
depending on your organization's password policy. You cannot re-use any of the previous
four passwords used.

d. In Confirm Password, re-enter your new password, and then click the Save button.

Note: Your password will expire no later than 90 days after it is activated or changed. The
administrator for your business organization may also have set passwords to expire sooner
(between 30 and 75 days, instead of the default of 90 days).

4. Click the Save button to update your profile.

Pac7 Release 7.2
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Chapter 2 Setup

Before you can begin using the Pac7 system, you must setup up Pac7 order management and item
sales for your business. The majority of this setup is done in tRes through SBClient, with the
remainder completed on the administration pages of the Pac7 Web-based interface.

Setup Process
To complete the setup process, do the following:

1. Enable the system.
2. Set up a data account.
3. Set up transaction logging.
4. Set up patron management access.
5. Create business accounts.
6. Define facility time zones.
7. Define level section print conversion.
8. Define price level names (item sales only).
9. Define item groups (item sales only).
10. Define delivery methods (item sales only).
11. Create alert messages (item sales only).
12. Create Paciolan 7 selling controls.
13. Configure Operator Seat Map Access
14. Set up at the item level, including any of the following:

l Set up item sale dates by operator group.
l Set up promotions (item sales only).
l Set up price type dependencies.
l Set up multi-day events.
l Set up order quantity rules.

15. Create custom forms for the Order Management tab and the Item Sales tab.
16. Configure TK.SELL print forms for Paciolan 7.
17. Set up email confirmation for order management and item sales.
18. Set up print at home delivery.
19. Set up magstripe delivery.
20. Set up laser printing.
21. Set up cash drawers.
22. Synchronize data.
23. Add Seasons for massloading.
24. Massload data.

Permissions
The permissions and rules for Pac7 set up user access to the data account. The Setup Data Rela-
tionship diagram below shows how access to your data account is structured.
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The Pac7 platform has the following five permission levels:

l Data Account

Data account permissions define system-wide behaviors. Each data account has specific para-
meters, such as the data account description, that are visible to all users selling from that
account. Permissions setup at this level will apply to all levels of permissions, except where
a lower level permission overrides a data account permission.

l Business Account

Business accounts are the business organizations through which you sell tickets. You can cre-
ate a different business account for each unique business organization that will be selling
inventory from this data account.

You set up business accounts so that independent business organizations can manage their
users and sales reports separately. For example, a third party outlet (like a convenience
store) and a box office can be separate business accounts while using the same data account.

Operators must be assigned to a business account to have access to that business account.
Permissions setup at this level will apply to all lower levels (patron policy, control, and oper-
ator) of permissions, except where lower a lower level permission overrides a business
account permission.

l Patron Policy

Patron Policies define patron data permissions for users of the system. Both the selling and
patron management controls will use the permissions defined in a patron policy for what pat-
ron data the users assigned to the controls can access.

l Controls

Pac7 has two types of operator access controls: the Pac7 (selling) control and the patron man-
agement control. The Pac7 controls are designed to provide flexibility for joint sales solu-
tions, where third party outlets and box offices are separate business accounts selling from
the same data account. Selling controls are set up differently for item sales (predefined
paths for onsales, general sales, and promotions) and order management. Pac7 controls will
also allow access to patron management features by their patron policy assignments.

The patron management controls are designed to allow access to patron management fea-
tures, while not allowing access to either item sales or order management. Access to patron
management features is defined by patron policy assignments.

Pac7 Release 7.2
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l Operator

The Pac7 operator codes are the primary drivers of the selling parameters for Pac7 users.
Users are assigned to operator codes and through those assignments inherit the union of the
parameters defined for the data account owner, business account, patron policy, control, and
operator. As the lowest level permissions, operator codes supersede permissions assigned at
the higher, more broadly defined levels.

Enabling Paciolan 7
When the Paciolan 7 option is selected on the System Setup screen (TK.SETUP.E), tRes sends real-
time data changes to Pac7. If the option is not selected, data will not be sent.

Note: This option is for display only. The first request for a Pac7 massload automatically enables
the option. (You will complete the massload later as part of this setup.) Once the Paciolan 7 option
is selected, you cannot turn it back off; this helps keep tRes and Pac7 data from getting out of sync.
If you need to disable the option, contact Paciolan for assistance.

Setting Up Data Accounts
Data account settings define system-wide behaviors. This process is used to set up Pac7 para-
meters for the data account (owner of data base/supplier). The values are global for all Pac7 busi-
ness accounts.

To set up a data account

1. Execute the TK.TSETUP.E process or, in tRes, select Paciolan 7 > General Setups > Data
Account. tRes displays the Paciolan 7 Data Account Setup screen.
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2. Enter values or select options as required. For descriptions of the fields on this screen, see
the Paciolan 7 Data Account Setup Screen reference topic.

3. Click the Save button.

Setting Up Transaction Logging
Transaction logging prints every transaction from a selling process. This is used as a hard copy
backup in case of disk drive failure on the server.

To set up transaction logging

1. Execute the SYS.SETUP.E process or, in System Functions, select Maintenance > System >
System Setup. Pac7 displays the System Functions Setup screen.

Note: For information about a control on this screen, click in the control field and press F1.

2. Write down the value in Client ID (in the example above, the Client ID is 916).

3. Execute the SYS.LINE.E process or select Utilities > Terminal Line. Pac7 displays the Ter-
minal Line screen.
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Note: For a description of the purpose and functions of the Terminal Line screen and the rest
of its controls, see the tRes reference topic.

4. In Line, enter PAC7<ClientID> (in this example, PAC7916), enter a description of the ter-
minal line in Name, and then enter the terminal type. Press the F3 button for a list of ter-
minal types.

5. In the Other Devices group, click the Transaction Logger button. The tRes system will display
the Transaction Logger Device subscreen.

6. In Type, enter P for the System Printer.

Note: Do not select the X printer type.

7. In Params, enter any transaction logging parameters that are required for the printer to per-
form its function correctly (usually left blank).

8. Click the Accept button and then, on the Terminal Line screen, click the Save button.

Setting Up Patron Management Access
Pac7 allows you to set up different levels of user access to patron management functionality. The
procedures you can use to do this include:
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l Defining Patron Policies
l Creating Operator Codes
l Creating Patron Management Controls

Defining Patron Policies
Use this procedure to create the patron policies that define Pac7 patron permissions. Once created,
these policies are used with Paciolan 7 selling controls and patron management controls to define
operator access to patron functionality on the Order Management, Item Sales, and Patron tabs.

To define a patron policy

1. Execute the TK.PPOLICY.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron
Policy. tRes displays the Patron Policy screen.

2. For each non-button control, enter values or select options as required. For descriptions of
the controls on this screen, see the Patron Policy Screen reference topic.

3. For the buttons on the screen, click a button to display its subscreen, enter values or select
options as required, and then click the Accept button. For information about these sub-
screens, use the reference information in the following list.

l Additional Settings
l Patron Search Options
l Other Patron Attributes
l Data Access Options

4. On the Patron Policy screen, click the Save button.

Creating Operator Codes
Along with patron policies and patron management controls, operator codes are used to define
operator access to patron functionality. If you do not already have operator codes set up to assign
to Pac7 users, perform the following procedure to create them.

To create an operator code

1. Execute the SYS.OP.E process or, in System Functions, select Operators > Operator Access.
System Functions displays the system level Operator Access screen.
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2. For each new operator, enter values or select options as required, and then click the Save
button. For descriptions of the controls on this screen, see the Operator Access Screen (In
System Functions) reference topic.

Creating Patron Management Controls
Patron management controls set the policy for users of full patron management. These controls
allow users access to the full patron management functionality, but do not allow them access to the
selling process. You can define one or more patron management controls per data account.

To create a patron management control

1. Execute the TK.PMGMT.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron Man-
agement Control. tRes displays the Patron Management Control screen.

2. In Control, enter the code to represent the control.

3. In Name, enter a descriptive name for the control. This is the text that will display as a link
on the Select a Data Account page in Pac7.

4. In Operator, enter the operator codes that can be used to access this control. Only users
whose accounts are linked to this operator code will be allowed access to the control. You can
set up this linkage when managing individual users in Pac7.
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5. In Policy, enter the policy code that represents the patron functionality you want to be avail-
able using this control. If necessary, you can set up a patron policy.

6. Click the Save button.

Setting Up Operator Access
Use the following procedure to set up an operator's customer and batch access.

To set up operator access

1. Execute the TK.OP.E process or, in tRes, select Paciolan 7 > Patron Setup > Shortcut to Oper-
ator Access. tRes displays the Operator Access screen.

2. In the Operator field, enter the operator code. You can also press F3, and then select from
the list of available operator codes.

3. Click the Sell Params button. tRes displays the Selling Parameters screen.

4. For each control, enter values or select options as required to set up customer and batch
access. For descriptions of the controls on this screen, see the Selling Parameters Subscreen
reference topic.

Note: If you are also setting the Hold Codes options for Pac7 users, make sure you define
the seat codes for which the they require access.

5. Click the Accept button, and then, in the Operator Access screen, click the Save button.

Creating Business Accounts
Use this procedure to define valid Pac7 business accounts for clients and distributors.

To create a business account

1. Execute the TK.BA.E process or, in tRes, select Paciolan 7 > General Setups > Business
Accounts. tRes displays the Pac7 Business Accounts screen.
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2. For each non-button control, enter values or select options as required. For descriptions of
the controls on this screen, see the Pac7 Paciolan 7 Business Accounts Screen reference
topic.

3. For the button controls on the screen, click a button to display its subscreen, enter values or
select options as required, and then click the Accept button. For information about these sub-
screens, use the reference information in the following list.

l Operators
l Report Options
l Access Pass Options
l Passwords
l Adjustment Options

4. In the Business Accounts screen, click the Save button.

Defining Facility Time Zones
You must configure the time zone of the facility associated with an inventory. In Pac7, the selected
time zone displays next to the event time wherever it is listed (for example, PST for Pacific Stand-
ard Time or EST for Eastern Standard Time).

Note: You must configure the time zone for the facility to sell tickets to events at the facility
through Pac7. The system needs to know the time zone of the facility to display on the UI to the
user, since events in Pac7 can be sold from inventories in different time zones.

To define a facility time zone

1. Execute the TK.FACILITY.E process or, in tRes, select Maintenance > Facility Templates >
Facilities. tRes displays the Facilities screen.
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2. In Facility, enter the code of the facility associated with the inventory for which you need to
set the time zone. You can also press the F3 key, and then select from the list of available
facility codes.

3. Click the Address button. tRes displays the Address subscreen.

4. In Time Zone, enter the time zone code for the time zone where the facility is located. The
name of the selected time zone displays beneath the time zone code. If you do not know the
time zone code, you can press the F3 key, and then select from the list of available time zone
codes.

5. Click the Save button.

Defining Level Section Print Conversion
Use this procedure only if you want the level or section names specified in tRes to be different
when printed on tickets through Pac7 item sales. If you do not enter any conversions on this
screen, the tRes names will print on tickets. The Level:Sect "from" data is validated as existing in
the master facility template (TK.MANIFEST.MASTER) for the facility.

To define the level section print conversion for item sales

1. Execute the TK.FACILITY.E process or, in tRes, select Paciolan 7 > Selling Setups > Shortcut
to Facilities. tRes displays the Facilities screen.
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2. In Facility, enter the code of the facility, and then click the Lev:Sect:Conv button. tRes dis-
plays the Level:Section Conversions subscreen.

3. For each table, enter values as required. For descriptions of the controls on this screen, see
the Level:Section Conversions Subscreen reference topic.

4. Click the Accept button.

Defining Item Sales Price Level Names
You can define the price level (PL) names that will display on the Pac7 Item Sales tab pages for
both seasons and activities. This allows you to have unique PL descriptions for different events that
happen at the same facility. Defining the names also allows you to use PL descriptions that are
easy for Pac7 operators to understand.

To define season price level names

1. Execute the TK.PTABLE.SEA.E process or, in tRes, select Paciolan 7 > Selling Setups > Short-
cut to Season Price Table. tRes displays the Season Price Table screen.
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2. In Season, enter the code for the season whose price level names you want to define.
3. In Table, enter the code for the price table you want to define.

4. Click the Paciolan 7 PL Names button. tRes displays the Paciolan 7 PL Names subscreen.

5. In PL Name, enter the price level names next to their corresponding price levels (PrLev
fields).

6. Click the Accept button, and then, on the Season Price Table screen, click the Save button.

To define activity price level names

1. Execute the TK.PTABLE.ACT.E process or, in tRes, select Paciolan 7 > Selling Setups > Short-
cut to Activity Price Table. tRes displays the Activity Price Table screen.
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2. In Activity, enter the code for the activity whose price level names you want to define.
3. In Table, enter the code for the price table you want to define.

4. Click the Paciolan 7 Item Sales PL Names button. tRes displays the Paciolan 7 Item Sales PL
Names screen.

5. In PL Name, enter the price level names next to their corresponding price levels (PrLev
fields).

6. Click the Accept button, and then, on the Activity Price Table screen, click the Save button.

Defining Item Sales Item Groups
For item sales in Pac7, you must define the item groups that you want to assign to selling controls.
Item groups can include single items, combo items, miscellaneous items, gift certificates, donation
items, and access passes. For operators assigned to Pac7 controls with item groups, Pac7 will dis-
play the sum of all items from all seasons listed here on the Item Group Results page.

To define item groups

1. Execute the TK.TGROUP.E process or, in tRes, select Paciolan 7 > Selling Setups > Item
Groups. tRes displays the Item Sales Item Groups screen.
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2. For each non-button control, enter values as required to define an item group. For descrip-
tions of the controls on this screen, see the Item Sales Item Groups Screen reference.

3. For button controls on the screen, click a button to display its subscreen, and then enter val-
ues or select options as required. For information about these subscreens, use the reference
information in the following table.

For this
button... Click this link for reference...

(Season X
Items sub-
screen)

Season X Items subscreen

Copy Copy to TCS Item subscreen

Use the Copy button to copy the currently displayed item group and use it to cre-
ate a new item group. tRes will display the Copy to TCS Item subscreen, where
you must enter the name of the new item sales item group code.
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For this
button... Click this link for reference...

tRes will create an item group with the new code using the definition of the cur-
rent item group.

Copy From Copy Data from tRes subscreen

Use the Copy From button to copy information from a new or existing item
group. The system will prompt you for a tRes item group code and will display
the Copy Data from tRes subscreen, where you must select an existing tRes
group to copy from.

Press F3 for the list of available tRes groups. The system will copy the Name,
Season, and Item data from that record into the current record.

4. On the Item Sales Item Groups screen, click the Save button.

Defining Item Sales Delivery Methods
Use this procedure to create and modify the delivery methods that are available in Pac7 for item
sales operators assigned to this inventory, including mapping to tRes (TK) disposition codes. Once
created, delivery methods must be assigned to controls for them to be available in Pac7 item sales.
You will make these assignments later in the setup process, when you are creating controls.

Note: If you need to define a print at home delivery method, do not use this procedure. Instead,
use the print at home setup procedure, which includes delivery method definition.

To define delivery methods

1. Execute the TK.TDMETH.E process or, in tRes, select Paciolan 7 > Selling Setups > Item
Sales Delivery Method. tRes displays the Item Sales Delivery Methods screen.
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2. Enter values on this screen as required. For descriptions of the controls on this screen, see
the Item Sales Delivery Methods Screen reference.

Note: If you are using Magstripe Credit Card or Magstripe Student ID delivery methods,
make sure to use the MSCC or MSID codes for the Type option.

3. Click the Save button.

Creating Alert Messages
Note: Alert messages are defined for each data account and limited to the specified business
account.

Alert messages provide a means for a ticket manager to readily communicate with users (for
example, box office, phone center, or outlet operators) of a specific business account or group of
business accounts during item sales. Alert messaging is often necessary because business
accounts can be geographically dispersed, and ticket managers need to communicate effectively
with ticket sellers in remote locations.

Once you create messages, you can update or delete them, or they can expire. If there are mul-
tiple messages, Pac7 will display the first three messages in order by start date. If there are more
than three messages, Pac7 displays the first three messages and a link (more...) to the remaining
messages.

Users do not need to respond to the messages. Common messages are about events selling out,
big onsales starting, or new price types being available for an event.

To create alert messages

1. Execute the TK.TALERT.E process or, in tRes, select Paciolan 7 > General Setups > Item
Sales Alert Messages. tRes displays the Paciolan 7 Alert Messages screen.
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2. For each business account, enter values as required. For descriptions of the controls on this
screen, see the Paciolan 7 Alert Messages Screen reference topic.

3. Click the Save button.

Creating Paciolan 7 Selling Controls
Pac7 selling controls are sets of user permissions that determine selling policies, as well as the
inventory that is available to each selling organization. You can create different controls for each
business account or reuse the same configuration for multiple selling organizations, depending on
your requirements. You can also assign multiple Pac7 controls to one business account and multiple
operators to controls. Pac7 controls set user permissions for both item sales and order man-
agement.

You create and modify controls, as well as assign them to selling organizations and the operators
within the organization. Assigning a control to a business organization sets the selling parameters
that display in Pac7. Pac7 users are assigned to operator codes and through those codes inherit the
union of the parameters defined for the data account, business account, control, patron policy, and
operator— the union of all levels of permissions.
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Tip: If you want some users to have access to patron management but not to selling functionality,
you can assign an operator code to a patron management control, instead of to a Pac7 selling con-
trol.

Each Pac7 control is represented as a policy in the Pac7 interface, and each policy is available
under one of the data accounts from which your organization sells. See an example:

In the example Select a Data Account page below, the USC data account has been expanded to
show its policies, and the Paciolan policy (selling control) is selected.

Note: When users log into Pac7 and select a selling control policy, they are assigned all per-
missions from the data account, business account, TK.OP.E, TK.PMGMT, and tRes configured selling
control. If a user is placing an order and you modify or remove one or more policies from tRes, the
system will apply the original policy to the current order. The system will then refresh/validate all
policies for the next sale, patron, or when the user cancels the order.

To create or modify Pac7 selling controls
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1. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.

2. For each non-button option, enter values as required. For descriptions of the options on this
screen, see the Paciolan 7 Controls Screen reference topic.

3. To configure options that are common to both order management and item sales, click the
buttons in the Shared Setups, and then enter values or select options on the displayed sub-
screens as required. For descriptions of the controls on a common subscreen, click the but-
ton name below:
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l Batch Options
l Order/Exchange Options
l Patron Options
l Payment Options
l Print/Receipt Options
l Seat Searching/Map Options

4. To configure the control for the Order Management tab, do the following:

a. In the Order Management group, select the Allow Order Management Access option.
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b. To select the Pac7 tab that you want to display by default when this control is selected,
select the Default to Item Sales or Default to Order Management option.

c. Click the Order Options button to display the Order Management Order Options subscreen,
enter values or select options as required, and then click the Accept button. For descrip-
tions of the options on this subscreen, see Order Management Order Options Subscreen.

d. Click the Payment/Post Sale Options button to display the Order Management Pay-
ment/Post Sale Options subscreen, enter values or select options as required, and then
click the Accept button. For descriptions of the options on this subscreen, see Order Man-
agement Payment/Post Sale Options Subscreen.

5. To configure the Item Sales, Inquiry, and Adjustments tabs, click the buttons in the Item
Sales, Inquiry, and Adjustments group and configure each subscreen. For descriptions of the
controls on a subscreen, click the button name below:
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l Delivery Methods
l Display Options
l Item Groups
l Order Options
l Patron Options
l Post Sale Options

6. In the Season table, add the seasons from which you want operators to sell when using this
control.

7. For each season you add to the Season table, do the following:

a. Select the season, and then click the details buttonx . tRes displays the Season Detail
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subscreen.

b. Use the settings and subscreens to configure the sales items and charge, discount, search
plan, and seat status options for the season. For more information about the settings and
subscreens, see Season Detail Subscreen.

c. Click the Accept button. tRes redisplays the Paciolan 7 Controls screen.
8. In the Salecode table on the Paciolan 7 Controls screen, enter the salecodes that you want to
be available for selection on the Order Management and Item Sales tabs. Press the F3 key to
select from the list of available salecodes.

9. Click the Save button.

Configuring Operator Seat Map Access
The seat map allows operators to select seats for a customer using a graphical interface. In Pac7
the same seat map is used for both Order Management and Item Sales. The map uses HTML5 tech-
nology so it does not require Java to run.Operators have the option of viewing the map in either
auto rotate or orientation mode. In addition to the standard map functionality, operators can also
take advantage of the following features:

l Navigation – Operators using the new map in orientation mode can now navigate to any part
of the map by clicking and dragging the image across the screen.

l Nesting – Operators can now quickly see how many of the same seats are available from
within a combo item without any degradation in performance.

l Availability Mode – Operators can choose to have the overview map display price level colors
or seat availability. If the overview map is displayed in the new availability mode, seat avail-
ability is displayed as a gradient color per section.
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You can also configure access to some of the basic functionality at the selling control level, includ-
ing the following:

l Availability in Item Sales.
l Viewing seat details.
l Viewing seat history.
l Viewing seat status.
l Manually nesting a map section.
l Viewing how seats were sold.

For information about seat map configuration, see the Creating Paciolan 7 Selling Controls pro-
cedure topic and the Seat Searching/Map Options subscreen reference topic.

Configuring Order Management Returns
The Pac7 return feature allows you to return seats from a single event item or an event from a
combo item and give the customer a refund or a donation credit. You can return any number of the
purchased seats. The return process is initiated from the order management order line. You can
search for the seats you want to return by customer name, patron ID, keyword, phone, address,
email, credit card, magstripe ID, or barcode.

A return is different than a cancel, because customers retain seat ownership, which allows them to
reorder the seats next season. Also you can track which seats were returned by specifying a unique
seat status for them. Returns can be done for individual patrons or house customers. The per-
missions that an operator has are the same as in the existing rules for the Order Management tab.

You configure Pac7 returns in the single and combo item setups, season return parameters, system
setup, business accounts, and selling controls. In the order management order line, unlike the inter-
face in TK.SELL, you can customize the toolbar buttons and table fields in the Order Lines table. You
can add a Return toolbar button. For more information, see Creating Custom Forms for Order Man-
agement.

To configure a single event item to allow returns

1. In tRes, execute the TK.EVENT.SEA.E process or select Maintenance > Event Templates >
Events > Season > Internal. tRes displays the Season Events screen.
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2. In Season, enter the code of the season containing the event and then, in Event, enter the
code of the event you want to configure.

3. Click the Item Misc button. tRes displays the Item Miscellaneous subscreen.
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4. To allow an allocated or printed single event item to be exchanged for another item, select
Return in the As a Single Item group. An item cannot be returned after the event takes place.

Note: For complete descriptions of the options on the Item Miscellaneous subscreen, see the
tRes Help topic.

5. To allow an allocated or printed single event item to be returned as part of a combo item,
select Return in the As Part of a Combo group. The return is only allowed if the combo item
also has its Return option selected. If the event is part of a combo item with its Return option
cleared, the event also cannot be returned as a single item after being sold as part of that
combo. An item cannot be returned after the event takes place.

6. Click the Accept button and then, on the Season Events screen, click the Save button.

To configure a combo item to allow returns

1. In tRes, execute the TK.COMBO.SEA.E process or select Maintenance > Event Templates >
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Items > Season > Combo. tRes displays the Season Combo Items screen.

2. In Season, enter the code of the season containing the event and then, in Combo, enter the
code of the combination item you want to configure.

3. Click the Misc button. tRes displays the Item Miscellaneous subscreen.

4. To allow the allocated or printed single event items in a combination item to be returned for
other single event items, select the Return option. The return is only allowed if the single
event item also has its Return option set to be allowed as part of combo item in
TK.EVENT.SEA.E. (See the procedure to configure a single event item above.) An event item
cannot be returned after the event takes place.
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5. Click the Accept button and then, on the Season Combo Items screen, click the Save button.

To set up season return parameters

1. In tRes, execute the TK.RPARAM.E process or select Maintenance > System > Season Para-
meters > Return Parameters. tRes displays the Season Return Parameters screen.

2. In Season, enter the code of the season for which you want to set return parameters.
3. If you want to use a charge code to track return fees, enter the charge code in the Return
Fee field. If the charge amount is defined as changeable, the operator will be allowed to
change the fee. If your site doesn’t charge the patron a fee for returning tickets, leave this
field empty.

4. If the return results in a credit balance, specify the default miscellaneous or donation item
that you want to absorb the credit balance in the Misc/Don Item field. This setting is neces-
sary if you do not allow refunds for exchanged items. If the season is configured with an
return fee, the fee is subtracted from the refund amount or from the credit balance before it
is moved to the miscellaneous or donation item. The operator may be allowed to change the
refund amount or credit balance.

5. In the Seat Status field, enter the seat status code to use for seats when they are returned.
If do not enter a code here, the seat’s previously Open status is used. The Open status can be
an open or a user-defined seat status.

6. Click the Save button.

To configure used barcode processing in the system setup

1. In tRes, execute the TK.SETUP.E process or select Maintenance > System > System Setup.
tRes displays the System Setup screen.
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2. Click the Order Parameters button. tRes displays the Order Parameters subscreen.

3. In the Used Barcode Processing area, select one of the following options:

Pac7 Release 7.2



User Guide  36

l No Warn. Select this option if you want the system to allow tickets whose barcodes
have already been scanned to be returned without a warning and with no password
required.

l Warn Only. Select this option to display a warning during the return for tickets whose
barcodes have already been scanned. This option will allow operators to return
scanned tickets without entering a password.
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l Require Password. Select this option to display a warning during the return for tickets
whose barcodes have already been scanned. Operators will have to enter a password
to return scanned tickets.

Note: The scanned ticket warning reflects the state of the tickets when the operator begins
the return. If a barcode is scanned in during the return, the process will not be updated to
show that a ticket's barcodes has since been scanned. However, operators will be warned if
an event is edited or updated during the exchange process.

4. Click the Accept button and then, on the System Setup screen, click the Save button.

To set up business account passwords that limit access to the return process

1. In tRes, execute the TK.BA.E process or select Paciolan 7 > General Setups > Business
Accounts. tRes displays the Paciolan 7 Business Accounts screen.
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2. In Business Account, enter the code of the business account for which you are adding pass-
words, and then click the Passwords button. tRes displays the Passwords subscreen.
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3. In the Order Management Passwords group, clear the Use same passwords for all option.

Note: If you are using the same password for all order management functions (the Use
same password for all option is selected), the refund process will use the same password. If
you want to use different passwords for the refund functions, you will also need to set a pass-
word for each of the rest of the order management functions, even if they are all using the
same password.
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4. Click the Order Management Passwords button. tRes displays the Order Management Pass-
words subscreen.

5. In the Refund and Refund Seat Status Changeable fields, enter the passwords that operators
will be required to enter to use those functions, and then click the Accept button to save the
settings and redisplay the Passwords screen. Passwords must be between 8 and 20 char-
acters.

6. Click the Accept button and then, on the Passwords subscreen, click the Accept button.
7. On the Paciolan 7 Business Accounts screen, click Save.

Configuring Order Management Exchanges
The Pac7 exchange features allow you to exchange seats from a single event item or an event
within a combo item (exchange out) for seats in another event (exchange in). You can exchange
any number of the purchased seats. The exchange process can be initiated from within order man-
agement or from a standalone process (equivalent to Go Exchange in TK.SELL). In both order man-
agement and Go Exchange, you can search for the seats you want to exchange by customer name,
patron ID, keyword, phone, address, email, credit card, magstripe ID, or barcode.

You configure Pac7 exchanges in the single and combo item setup, season exchange parameters,
system setup, business account, and selling controls. In the Pac7 Go Exchange interface, unlike the
interface in TK.SELL, you can customize the toolbar buttons and table fields in the Exchange In
table. The table fields that you can configure include which fields display, the order of the fields,
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and whether or not the fields are mandatory. For more information, see Creating Custom Forms
for Exchanges.

To configure a single event item to allow exchanges

1. In tRes, execute the TK.EVENT.SEA.E process or select Maintenance > Event Templates >
Events > Season > Internal. tRes displays the Season Events screen.

2. In Season, enter the code of the season containing the event and then, in Event, enter the
code of the event you want to configure.

3. Click the Item Misc button. tRes displays the Item Miscellaneous subscreen.
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4. To allow an allocated or printed single event item to be exchanged for another item, select
Exchange in the As a Single Item group. An item cannot be exchanged after the event takes
place.

Note: For complete descriptions of the options on the Item Miscellaneous subscreen, see the
tRes Help topic.

5. To allow an allocated or printed single event item to be exchanged as part of a combo item,
select Exchange in the As Part of a Combo group. The exchange is only allowed if the combo
item also has its Exchange option selected. If the event is part of a combo item with its
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Exchange option cleared, the event also cannot be exchanged as a single item after being
sold as part of that combo. An item cannot be exchanged after the event takes place.

6. Click the Accept button and then, on the Season Events screen, click the Save button.

To configure a combo item to allow exchanges

1. In tRes, execute the TK.COMBO.SEA.E process or select Maintenance > Event Templates >
Items > Season > Combo. tRes displays the Season Combo Items screen.

2. In Season, enter the code of the season containing the event and then, in Combo, enter the
code of the combination item you want to configure.

3. Click the Misc button. tRes displays the Item Miscellaneous subscreen.
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4. To allow the allocated or printed single event items in a combination item to be exchanged
for other single event items, select the Exchange option. The exchange is only allowed if the
single event item also has its Exchange option set to be allowed as part of combo item in
TK.EVENT.SEA.E. (See the procedure to configure a single event item above.) An event item
cannot be exchanged after the event takes place.

5. Click the Accept button and then, on the Season Combo Items screen, click the Save button.

To set up season exchange parameters

1. In tRes, execute the TK.EPARAM.E process or select Maintenance > System > Season Para-
meters > Exchange Parameters. tRes displays the Season Exchange Parameters screen.
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2. In Season, enter the code of the season for which you want to set exchange parameters.
3. If you want to use a charge code to track exchange fees, enter the charge code in the
Exchange Fee field. If the charge amount is defined as changeable, the operator will be
allowed to change the fee. If your site doesn’t charge the patron a fee for exchanging tickets,
leave this field empty.

4. If the exchange results in a credit balance, specify the default miscellaneous or donation
item that you want to absorb the credit balance in the Misc/Donation Item field. This setting
is necessary if you do not allow refunds for exchanged items. If the season is configured with
an exchange fee, the fee is subtracted from the refund amount or from the credit balance
before it is moved to the miscellaneous or donation item. The operator may be allowed to
change the refund amount or credit balance.

5. In the Seat Status field, enter the seat status code to use for seats when they are exchanged
out. If do not enter a code here, the seat’s previously Open status is used. The Open status
can be an open or a user-defined seat status.

6. To set exchange quantity validation by season, enter N for no validation or Q to enable quant-
ity validation in the Validation Mode field. You may choose to turn off validation to allow oper-
ators to exchange out tickets at one I:PL/PT for tickets of the same value at a different
quantity and I:PL/PT. When choosing whether to validate exchange quantities, note the fol-
lowing:

l If you do not set this option for a season, the Validation Mode field will be left empty
and validation will be enabled.

l Validation does not enforce order quantity rules (Min/Max/Multiple).
l Validation does not change how exchange balance due or credits are handled.

7. Click the Save button.

To configure used barcode processing in the system setup

1. In tRes, execute the TK.SETUP.E process or select Maintenance > System > System Setup.
tRes displays the System Setup screen.
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2. Click the Order Parameters button. tRes displays the Order Parameters subscreen.

3. In the Used Barcode Processing area, select one of the following options:
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l No Warn. Select this option if you want the system to allow tickets whose barcodes
have already been scanned to be exchanged without a warning and with no password
required.

l Warn Only. Select this option to display a warning during the exchange for tickets
whose barcodes have already been scanned. This option will allow operators to
exchange scanned tickets without entering a password.
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l Require Password. Select this option to display a warning during the exchange for tick-
ets whose barcodes have already been scanned. Operators will have to enter a pass-
word to exchange scanned tickets.

Note: The scanned ticket warning reflects the state of the tickets when the Exchange form
is first displayed. If a barcode is scanned in during the exchange, the form will not be
updated to show that a ticket's barcodes has since been scanned. Operators will be warned if
an event is edited or updated during the exchange process.

4. Click the Accept button and then, on the System Setup screen, click the Save button.

To set up business account passwords that limit access to the Go Exchange process

1. In tRes, execute the TK.BA.E process or select Paciolan 7 > General Setups > Business
Accounts. tRes displays the Paciolan 7 Business Accounts screen.
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2. In Business Account, enter the code of the business account for which you are adding pass-
words, and then click the Passwords button. tRes displays the Passwords subscreen.
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3. To use the same password for both the Exchange and Exchange Seat Status Changeable func-
tions, do the following:

a. In the Go Exchange Passwords group, select the Use same passwords for all option.

b. In the field to the right of the Use same passwords for all option, enter the password you
want to use for the Go Exchange functions. The password must be between 8 and 20 char-
acters.

4. To use different passwords for the exchange functions, do the following:

a. In the Go Exchange Passwords group, clear the Use same passwords for all option
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b. Click the Go Exchange Passwords button. tRes displays the Go Exchange Passwords sub-
screen.

c. In the Exchange and Exchange Seat Status Changeable fields, enter the passwords that
operators will be required to enter to use those functions, and then click the Accept button
to save the settings and redisplay the Passwords screen. The password must be between
8 and 20 characters.

5. Click the Accept button.

To set up business account passwords that limit access to the order line exchange pro-
cess

1. In tRes, execute the TK.BA.E process or select Paciolan 7 > General Setups > Business
Accounts. tRes displays the Paciolan 7 Business Accounts screen.
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2. In Business Account, enter the code of the business account for which you are adding pass-
words, and then click the Passwords button. tRes displays the Passwords subscreen.
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3. In the Order Management Passwords group, clear the Use same passwords for all option.

Note: If you are using the same password for all order management functions (the Use
same password for all option) selected), the order line exchange process will use the same
password. If you want to use different passwords for the exchange functions, you will also
need to set a password for each of the rest of the order management functions, even if they
are all using the same password.
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4. Click the Order Management Passwords button. tRes displays the Order Management Pass-
words subscreen.

5. In the Exchange and Exchange Seat Status Changeable fields, enter the passwords that oper-
ators will be required to enter to use those functions, and then click the Accept button to save
the settings and redisplay the Passwords screen. Passwords must be between 8 and 20 char-
acters.

6. Click the Accept button.

To set up Go Exchange options for a selling control

1. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.
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2. In the Control field, enter the code of the control for which you want to set exchange options.

3. In the Shared Setups group, click the Order/Exchange Options button. tRes displays the
Order/Exchange Options subscreen.
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4. In the Exchange In Form field, enter the code of the custom exchange form that you want to
use to configure the Exchange In table during the exchange process, and then click the
Accept button.

The form will be used for exchanges from both the Order Management and Exchange tabs.
The Exchange tab is equivalent to Go Exchange in TK.SELL. For information about custom
exchange forms, see Creating Custom Forms for Exchanges.

5. In the Order Management group, click the Order Options button. tRes displays the Order Man-
agement Order Options subscreen.

6. To prevent control user access to the Order Management exchange functionality, deselect
the Allow Exchanges option.
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7. To allow control user access to the Order Management exchange functionality, do the fol-
lowing:

a. Select the Allow Exchanges option.

b. To require a password to perform exchanges on the Order Management tab, select the
Require Password option. The password is set at the business account level. See See "To
set up business account passwords that limit access to the order line exchange process"
on page 51

c. To allow users of the control to exchange tickets for tickets with different seat statuses,
select the Exchange Out Seat Status Changeable option. You can require a password to
allow the seat status change by selecting the Require Password option below the Exchange
Out Seat Status Changeable option. This password is also set at the business account
level.
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d. Click the Accept button.

8. In the Go Exchange Options group, click the Go Exchange Options button. tRes displays the
Go Exchange Options subscreen.

9. To prevent control user access to the Go Exchange functionality, deselect the Allow Access to
Go Exchange option.
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10. To allow control user access to the Go Exchange functionality, do the following:

a. Select the Allow Access to Go Exchange option.

b. To require a password for access to the Go Exchange functionality, select the Require
Password option. The password is set at the business account level. See See "To set up
business account passwords that limit access to the Go Exchange process" on page 48See
"To set up business account passwords that limit access to the order line exchange pro-
cess" on page 51

c. To allow users of the control to exchange tickets for tickets with different seat statuses,
select the Exchange Out Seat Status Changeable option. You can require a password to
allow the seat status change by selecting the Require Password option below the Exchange
Out Seat Status Changeable option. This password is also set at the business account
level.

d. Click the Accept button.
11. On the Paciolan 7 Controls screen, click the Save button.

Creating Custom Forms for Exchanges
Pac7 allows you to process exchanges as part of order management or through a standalone
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Exchange process, which is similar to "Go Exchange" in TK.SELL. Both exchange processes use the
same Exchange In table. You can use the default configuration of the table, or you can customize
the toolbars, table columns, and fields that are displayed. You do this by creating your own
Exchange In form and then referencing the form in one or more of your Paciolan 7 selling
controls.

To create a custom Exchange In form

1. In tRes, execute the TK.EXFORM.E process or select Paciolan 7 > Selling Setups > Exchange
In Forms. tRes displays the Exchange In Forms screen.

2. Do one of the following:

l To create a new Exchange In form, enter a short descriptive code in the Form field, and
then enter a longer description in the Name field. After entering the code in the Form
field, the default set of fields will be loaded into the table below.
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l To edit an existing Exchange In form, enter the code in the Form field. If you do not
know the code, press the F3 key to select it from a list. The name and currently con-
figured fields are displayed.

3. Add or delete the fields corresponding to the columns you want to include in the Pac7
Exchange In table. If you are creating a new form, you cannot delete any of the default
fields. The item (ITEM), item quantity (QTY), price level (PRLEV), price type (PRTYP), and
seatblock (SEAT) fields are required and are automatically entered in the first rows of the
table in that order. You can add the item name field (ITEMN), but only directly under ITEM.
The columns display in the Order Lines table from left to right based on the order they are
entered.

4. To customize the toolbar buttons that you want to display in the Exchange In table toolbar,
do the following:
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5. Click the Toolbar Buttons button. The Exchange In Toolbar Buttons subscreen is displayed.
The buttons in the first table (Add, Delete/Remove, Seat Map, Assign Best Seats, and Seats)
are not editable and will always be displayed first in the Order Lines table toolbar.

6. In the second table, enter the code numbers of the buttons you want to add to the toolbar.
They will display from left to right after the buttons from the first table in the order you add
them to the second table. You can also add one or more separator lines in the toolbar
between any two toolbar buttons.
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See the list of the toolbar buttons for the Exchange In table

Button Code
# Function Configurable?

1 Add or insert an
order line

No

2 Delete/Remove
order line

No

3 Seat map No

4 Assign best avail-
able seats

No

5 Seats menu No

0 Separator line Yes

6 Area search Yes

7 Item details Yes

8 Price split Yes
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Button Code
# Function Configurable?

9 Search plan Yes

7. Click the Accept button and then, on the Exchange In Forms screen, click the Save button.

To configure a Paciolan 7 selling control to use a custom Exchange In form

1. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.

2. In Control, enter the code of the control for which you to use the custom form.

3. In the Shared Setups area, click the Order/Exchange Options button.
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tRes displays the Order/Exchange Options screen.

4. In Exchange In Form, enter the code of your custom form, or press F3 to select it from a
list.

5. Click Accept and then, on the Paciolan 7 Controls screen, click Save.

Setting Up Item Level Options
This section contains descriptions of some of the item level options you can set up for Pac7. It
includes the following:

l Setting Up Item Sale Dates by Operator Group
l Setting Up Item Sales Promotions
l Setting Up Price Type Dependencies
l Setting Up Multi-Day Events
l Setting Up Order Quantity Rules
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Setting Up Item Sale Dates by Operator Group
If you want to control the item sale dates by operator group during order management and item
sales, complete the following steps:

1. Setup an operator group. (See TK.OPGRP.E in the tRes Reference Manual.)
2. Assign operators to the operator group. (See TK.OP.E in the tRes Reference Manual.)

Note: Selecting the House Cust Access option (in the Selling Parameters subscreen of
TK.OP.E) at this level allows operators to change the house customer during the selling pro-
cess.

3. On the Item Sale Dates subscreen for the single event or combo item, enter the Sale From
and Sale To dates by operator group. (See TK.EVENT.SEA.E and TK.COMBO.SEA.E in the tRes
Reference Manual.)

4. You can also configure Sale From and Sale To dates for operator groups at the price level
(PL) and price type (PT) level.

The items that are returned on the Search for Item form or page will be available for sales by
that user (operator code). An item is available for purchase if any PT is available for that user to
sell. If the Show Future Events option is selected, the item sale dates will be the date the first PT
goes is available for sale for that item and that user. An item will no longer be returned on the
Search for Item form or page when the Sell To dates for all PTs have passed.

To determine the Sell From and Sell To dates and times for an item, the system looks for date/time
entries at the lowest level of detail first. For the item PL and PT that a user can sell, this is order of
levels in which the system looks for date/time entries:

1. Operator group PL/PT level
2. Operator group item level
3. PL/PT level
4. Item level

If nothing is defined at any of the four levels, the item is always available for sale.

Setting Up Promotions
Promotions allow you to limit access to some of your inventory to a specific group of customers dur-
ing item sales. For example, promotions may be used to sell distressed inventory as an incentive
to use a particular credit card, or as a reward for club members. You set up promotions by assign-
ing items to promotion codes. Promotions can include items across multiple seasons. You can use
single event items (including multi-day events and order quantity rules) and combination items
(both fixed and designer combos) for promotions. However, miscellaneous, donation, gift cer-
tificate, and access pass items cannot be sold using promotions.

Promotions can be set for limited or unlimited use. Limited use promotions require both a promo
code and a password for user access. For passwords, you can you can allow unlimited use or set a
maximum number of usages. For unlimited use promotions, users only need to enter the promo
code. You can also assign start and end dates for items sold through the promotions selling path.

The promotions feature is configured using the same process (TK.PROMO.E) for both Pac7 and
eVenue. However, items can have different eVenue and Pac7 sales dates for the same promotion.
For more detailed promotion configuration or operation information, choose any of the following:

Configuration features for both Pac7 and eVenue

l The same promotions can be made available to both eVenue and Pac7, and you can modify
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existing eVenue promotions to include Pac7. If a promotion is made available in both, the
promo code and any associated passwords will work on both platforms.

l For each single event and combination item in a promotion, you can set up order quantity
rules. These include setting minimum and maximum per order quantity rules, and requiring
the quantity per order to be a multiple of any number (see an example If an item has a min-
imum of 4 and a maximum of 10, you can set a multiple of 2 to require the item order quant-
ity to be 4, 6, 8, or 10). Promotion items do not use item order quantity rules setups in the
selling controls or the item entry processes.

l Promotion items can be assigned their own delivery methods, paymodes, seat status restric-
tions, and order charges per season. During promotion sales, promotion settings override
selling control settings.

l Optionally, you can set promotion text to be displayed for one to all of an item's price level/-
price type (PL/PT) combinations. If enabled, operators can pause over a PL/PT combination
to display the promotion text.

l For limited use promotions, you can import a set of passwords that can only be used once
each, or you can enter a single password and specify the number of times it can be used.
Passwords must be unique within each promo.

l The batch change permissions set at the operator level apply during promotion sales.
l You can modify promotions that have already begun selling. Changes will apply to all sub-
sequent sales. However, once you have imported passwords for a limited-use promotion,
you cannot change the promotion type to unlimited.

l If a promotion item is allocatable, you can assign seats using the seat map.
l If a promotion item has reserved seats but is not allocatable, you cannot assign seats for the
promotion, although seats may be assigned through the other sales paths. If a reserved seat
item is set to allocate, you will be required to assign seats.

l If a promotional combination item is allocatable, all its component items will also be alloc-
ated, regardless of individual item allocation settings. Combination items may also be set to
select the same seat for each component item or to select the best seat for each combo item.

l If a promotion item is not allocatable, you can allow the operator to assign a seat location
preference for an order. This is only available if one or more location preferences are listed
in the promotion setup for the specific item.

l If a promotion includes an item that is set up with an autoload item, the autoload item will be
ignored when the item is sold through the promotion sales path.

Configuration features that are Pac7-specific

l If you add a season to a promotion and the season has not yet been massloaded to Pac7, you
must massload the season before the promotion will be available in Pac7. If the added sea-
son is already massloaded, tRes will data sync the season information when the promotion is
saved. Promotion order information is stored in both tRes and Pac7 (in DB2).

l Access to promotion sales is set at the selling control level. When enabled for the control in
use, a Promo Sales link is displayed with the General Sales and Onsale link under the Item
Sales tab.

l If you do not set a promotion option (for example, delivery methods, paymodes, etc.), Pac7
will use the setting from the selling control. Promotions always use the selling control set-
tings for general sales patron options, including those for search criteria and search results.
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l Only the order charges listed in the promotion setup are applied to the promotion sale. Pro-
motions will not use the order charges listed in the selling control.

Operation features in the Pac7 user interface

l Once operators add items to the cart from the promotion sales path, they cannot add items
from the general sales or onsale paths for the current order.

l You can add more than one promotion item to the cart. However, an item within a promotion
cannot be purchased in the same order with items that are not available in that promotion,
including items from other promotions. You can only view or select the items within one pro-
motion at a time.

l Promotion passwords are checked when operators enter promotion codes and when they
complete orders with promotion items. When an order is complete, Pac7 sends password
information to tRes with the rest of the order information. tRes records that the password
has been used once. If an order is voided at the end of a sale, the tRes password parameters
are updated to remove the password usage.

l Cancel, void, reprint, and order confirmation email work the same for promotions. Returns
are also allowed. However, post sale transactions do not update the password usage. For
example, if a password is used to place an order and the order is returned the next day, the
system will not reset the password usage.

l Pac7 promotion sales orders are searchable using the Pac7 Inquiry tab.
l Operators using a selling control that allows promotion sales can sell all configured pro-
motion inventory for the data account, provided they enter a valid promotion access code.
This includes operators that do not have access to some or all of the price types or seat
statuses used in the promotion. The price types and seat statuses listed in the promotion
setup override all TK.OP.E restrictions during promotion sales.

l An item included as part of a promotion may also be available through the general sales and
onsales paths.

l Only the table view is supported on the Best Available page. The list view and quick entry
view are not available.

l Promotion items configured with unlimited use passwords can be sold to either individual or
house customers.

To set up a promotion for sales in Pac7

1. In tRes, complete the promotion setup. To complete this procedure for a Pac7 promotion, make
sure you do the following:

a. On the Promotions screen (TK.PROMO.E), enter the Type code to make the promotion
either Limited (L) or Unlimited (U).
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b. Enable the promotion for Pac7 by selecting the Paciolan 7 option.
c. Configure the Pac7 parameters using the Paciolan 7 Item Sales subscreen.

Note: If you do not enter an order charge (Order Chg field left blank) on the Paciolan 7
Item Sales subscreen for a season used in the promotion, Pac7 will use the general sales
order charges for the season as configured for the current Paciolan 7 selling control. For
more information, see the Charge Options subscreen reference topic. If you do enter an
order charge on the Paciolan 7 Item Sales subscreen, the order charge is required, not
changeable, and automatically applied during promotional item sales in Pac7.

1. If the promotion setup includes seasons that have not yet been massloaded to Pac7, mass-
load the season data.

2. Set up each control that will sell the promotion by doing the following:

a. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups >
Paciolan 7 Controls. tRes displays the Paciolan 7 Controls screen.
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b. In the Control field, enter the code of the control for which you want to enable pro-
motions.

c. In the Item Sales, Inquiry, and Adjustments group, click the Order Options button. tRes
displays the Order Options subscreen.

d. Select the Allow Access to Promotions option, click the Accept button, and then save the
control.

3. If you created a limited use promotion, do the following:
a. If you have not yet generated passwords for the promotion, see the Setting Up Limited
Use Passwords tRes topic.

b. Distribute the promotion code to the group of promotion eligible customers. This dis-
tribution is not executed from the Paciolan system.

Setting Up Price Type Dependencies
Price type (PT) dependencies allow you to require your customers to buy extra items with their
items of choice. For example, you can require the purchase of an adult ticket to be able to buy a
half-priced child's ticket. In this example, the half-priced child's ticket is called the dependent PT.
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While this example is a one-to-one relationship, the relationship between the required and depend-
ent PTs can also be one-to-many. For example, to buy the half-priced child's ticket, you can
require the purchase of either an adult ticket or a senior ticket. A PT can also be required by two dif-
ferent dependent PTs. For example, both the half-priced and full-priced child's ticket can require
the purchase of an adult ticket. However, a dependent PT cannot also be a required PT for another
dependent PT.

Note: PT dependencies do not apply to post-sale transactions, including returns, exchanges, voids,
transfers, and reprints. So, for example, the system will allow a customer to buy a half-priced
child's ticket and the required adult ticket and then later return the adult ticket. In effect, the cus-
tomer is allowed to buy an unrestricted half-priced child's ticket.

You can use order quantity rules (min, max, and multiple quantity settings) with PT dependencies
to require that two or more of an item be purchased with a dependent PT item. However, you can
also override the order quantity rules of a dependent PT item for one or more of its required PTs.
For instance, if your quantity rules allow the purchase of two or more of a dependent PT item with
a single required PT item, you can override the rules to limit purchases of the dependent PT item to
one per required PT item. You can also use PT dependencies with promotions to enforce the pur-
chase of a required PT item to take advantage of the promotional pricing of a dependent PT item.

You set up PT dependencies in season price tables. The dependent and required PTs used for a PT
dependency must be in the same price table, so the table must have at least two PTs before you
can create any PT dependencies. Once you add a PT dependency to a price table, the dependency is
in effect for all event items that use that price table. The PT dependency is then applied to sales of
the dependent item PTs for all Pac7 selling controls configured with both the required and depend-
ent item PTs. Once you set a PT dependency for a price table, you cannot remove the dependent or
required PTs from the table without first removing the PT dependency. See an example if a price
table originally has price types A, B, and C, and A is dependent on B, you cannot remove A or B
from the price table.

Note: PT dependencies are enforced in every sales channel (Pac7 Item Sales/Order Management,
TK.SELL, and eVenue) through which the dependent and required item PTs are sold.

To add and enforce an item PT dependency for sales through Pac7, you must first set up the PT
dependency in a season price table. Then, you must add the PT dependent item to a Pac7 selling
control.

To set up a PT dependency in a season price table

1. Execute the TK.PTABLE.SEA.E process or, in tRes, select Maintenance > Event Templates >
Price Tables > Season. tRes displays the Season Price Table screen.
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2. In Season, enter the code of the season that contains the price table.

3. In Table, enter the code of the price table, and then click the Price Type Dependency button.
tRes displays the Price Type Dependency subscreen.

4. In Dependent Price Type, enter the PT that will require the purchase of additional PTs. Press
the F3 key for a list of PTs in the price table.

5. Click the details buttonx . tRes displays the Price Type Dependency Detail subscreen.

6. In Required Price Type, enter one or more PTs that must be purchased with the dependent
PT. The effect of adding more than one required PT depends on the quantity restriction option
setting below.

7. Set the quantity restriction option, by doing one of the following:
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l Clear the option. With this setting, any quantity of the dependent PT can be purchased as
long as at least 1 of any one of the required PTs is also purchased. This setting allows the
enforcement of the order quantity rules setup for both the dependent PT and the required
PTs.

l Select the option. With this setting, the allowed purchase quantity of the dependent PT is
limited to the sum of the purchase quantities of all the required PTs (those listed in the
Required Price Type column above). This setting disregards the order quantity rules setup
for the dependent PT and allows enforcement of the required PTs' rules setups.

See examples of the cleared and selected settings.

Quantity Restric-
tion
Option Setting

Quantity of Each Required
PT

Quantity Allowed of the Depend-
ent PT

Cleared Parent A: 1
Parent B: 0

Discount Child: 1+ (no qty limit)

Selected Parent A: 1
Parent B: 0

Discount Child: 1

Selected Parent A: 1
Parent B: 2

Discount Child: 3

8. Click the Accept button. tRes redisplays the Price Type Dependency screen. If necessary, you
can add another dependent PT by repeating the above steps.

9. Click the Accept button to display the Season Price Table screen, and then click the Save but-
ton.

To add a PT dependent item to a Paciolan 7 selling control

1. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.
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2. In Control, enter the code of the selling control.

3. In the Season table, add the code of the season that includes the required and dependent PT
items.
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4. Select the season containing the items, and then click the details buttonx . tRes displays
the Season Detail subscreen.

5. If the Only Items Listed are Available option is selected in the General Sales Items group, do
the following:
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Note: Only select this option if you want to restrict the items from the season that can be
sold or if you need to set up order quantity rules at the item level. To allow operators using
this selling control to sell all the season's items through order management and general
sales, select the All Items are Available option and skip this step.

a. In the Item column, add all the items that you want sold through the order management
and general sales with this Paciolan 7 selling control. You can add them manually or load
them by item group. For more information, see the Season Detail Subscreen reference
topic.

b. Select the item with the dependent PT, and then click the Details button. tRes displays the
Season Item subscreen.

c. In the PrLevel and PrType columns, add the required and dependent price level/price type
(PL/PT) combinations. You can add them manually or load all PL/PT combinations by click-
ing the Load All button. For more information, see the Season Item Subscreen reference
topic.

d. Click the Save button to redisplay the Season Detail subscreen.
6. To add dependent PT items to the onsale path for this selling control, do the following:
a. In the Onsale Items group, add the PT items you want sold through the onsale path to the
Item column of the table.

b. In the Item column, select the PT item with the PT dependency, and then click the details

buttonx . tRes displays the Season Item subscreen.
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c. In the PrLev and PrType columns, add all the required and dependent price level/price
type (PL/PT) combinations. You can add them manually or load all PL/PT combinations by
clicking the Load All button. For more information, see the Season Item Subscreen ref-
erence topic.

d. Click the Save button to redisplay the Season Detail subscreen.
7. Click the Accept button to display the Paciolan 7 Controls screen, and then click the Save but-
ton.

Setting Up Multi-Day Events
Multi-day events allow your customers to purchase event items that are valid for a date range,
instead of a single date. The customer receives one ticket that can be used to access a venue
within a date range. Multi-day events are single event items, and they can be included in com-
bination items that also contain single-day events. All multi-day events must have a contiguous
date range, such as 08/21/08 – 08/25/08. If a multi-day event has reserved seats, each ticket will
have the same seat assignment for all days of the event.

In addition to start and end dates, multi-day events must have start and end times, and these
times are the same for each day in the date range. End dates and end times display in the Pac7
user interface at every place that currently displays start dates and times. Operators can search
for multi-day event items using any date within the date range, and they can sell the items until
their end dates and times. Multi-day events can be used with all features that are currently used
for single-day items, including the following:

l Item sales (general sales, onsales, and promotions)
l Order management sales
l Searches using the Pac7 search engine
l Autoload items
l Returns
l Printing and reprints
l Prorations as part of combination items
l Display of future events
l Confirmations
l Reports and inquiries
l Delivery method cutoffs
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Note: To accommodate the added printing space required by multi-day events, the EDATE.END
and ETIME.END print form variables have been added to tRes, and new print forms that utilize
these variables have been created for BOCA, laser, and print at home printing. If you use custom
print forms, you may need to modify them or create new ones for multi-day events. The single-day
event print forms have not changed. Receipt and mailer printing is not supported for multi-day
events.

To set up a multi-day event item for a Pac7 selling control

1. In tRes, execute the TK.EVENT.SEA.E process or select Maintenance > Event Templates >
Events > Season > Internal. tRes displays the Season Events screen.

2. In Season, enter the code of the season containing the event and then, in Event, enter the
code of the event you want to configure.

3. While updating or creating the event, make it a multi-day event by doing the following:

a. In the Date and Time group, enter values in Start Date and Start Time. The event must
start at the same time on each day of the multi-day event, so you only enter one Start
Time per event.

b. Select the Multiple Day Event option.
c. Enter values in End Date and End Time. The event must end at the same time on each day
of the multi-day event, so you only enter one End Time per event.

4. Click the Save button to save the event.
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5. Add the multi-day event to the appropriate Pac7 selling controls by doing the following:

a. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups >
Paciolan 7 Controls. tRes displays the Paciolan 7 Controls screen.

b. In the Control field, enter the selling control code.

c. In the Season table, select or add the season that includes the multi-day event, and then

click the details buttonx .
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tRes displays the Season Detail subscreen.

d. Add the multi-day event item to the Order Management and General Sales Items or
Onsale Items tables. For more information, see the Season Detail subscreen reference
topic.

e. Click the Accept button, and then, on the Paciolan 7 Controls screen, click the Save but-
ton.
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Tip: You can set up order quantity rules for any item and its price level/price type com-
binations by entering minimum, maximum, or multiple quantity amounts. You can also
reserve tickets to multi-day events for a subset of customers by setting up promotion codes
and passwords.

Setting Up Order Quantity Rules
The order quantity rules option allows you to set the per order minimum, maximum, and multiple
quantity restrictions for items and individual item price level/price type (I:PL/PT) combinations.
The multiple setting is used to require that the quantity of an item per order be a multiple of the
positive integer of your choice (example A multiple of 2 requires that quantities of 2, 4, 6, etc. be
purchased). The minimum and maximum settings can be used alone, together, and with a multiple
setting to further restrict item quantities (example If you set an item level minimum of 4 and max-
imum of 10, you can set a multiple of 2 to require the item order quantity to be 4, 6, 8, or 10). Pac7
enforces these rules by not allowing operators to add invalid item quantities to an order line in
order management or the cart in general sales.

Tip: You can use order quantity rules and price type dependencies together to simultaneously
enforce quantity limitations and require the purchase of additional items with dependent items. For
example, you can require that for every 1/2 price child ticket, a minimum of 2 adult tickets must
be purchased. In addition, you can limit the total quantity of items that customers can obtain per
season. Form more information, see Setting Seasonal Customer Item Limits.

For Pac7, you can set the order quantity rules for single event, combination, and miscellaneous
items. Order quantity rules are not available for gift certificates or donations. The rules for items
can be set independently for order management/general sales and onsales. Post sale transactions
(returns, exchanges, transfers, reprints, and voids) are not affected by the these settings.

Note: Order quantity rules can also be applied to promotion items. However, the rules for pro-
motion sales are set up separately— this setup only includes order management/general sales and
onsales quantity rules. During promotion sales, Pac7 ignores all order quantity rules set up for
order management/general sales and onsales. Similarly, item rules in the promotions setup are
ignored during order management/general sales and onsales. To set up order quantity rules for pro-
motion items, see Setting Up Promotions.

For more information about setting up order quantity rules for items, choose the item type below:

l Single and Combination items
l Miscellaneous items

For a short description of each of the major functions of this option, see the order quantity rules
function table.

Function Item Types Description

Min/Max/Multiple Single,
combo, mis-
cellaneous

Set min/max/multiple rules for the quantity of an item
that can be added to the cart for an order. The rules can
be set at in the Pac7 selling controls and the seasonal
item entry processes (TK.EVENT.SEA.E,
TK.COMBO.SEA.E, and TK.IMISC.SEA.E).

Item level rules Single,
combo, mis-
cellaneous

The item level min/max/multiple settings apply to the
total quantity of the item added to the cart for an order.
For single and combo items, item level rules apply to the
sum of all the I:PL/PT combination quantities. Mis-
cellaneous items are only set at the item level.

I:PL/PT level Single, combo An I:PL/PT level min/max/multiple quantity setting only

Pac7 Release 7.2

http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/How/Setting_Seasonal_Customer_Item_Limits.htm


User Guide  82

Function Item Types Description

rules applies to the I:PL/PT combination for which it is set.
I:PL/PT level rules are set in the selling controls and the
item entry processes.

Paciolan 7 selling
control setup

Single,
combo, mis-
cellaneous

Min/max/multiple rules set in a Paciolan 7 selling control
only apply to item sales by operators using that control.
For single and combo items, set both item level and
I:PL/PT level rules in selling controls. Min/max/multiple
settings in the selling control take precedence over sea-
sonal item entry process settings.

Seasonal item
entry process
setup at the
I:PL/PT level

Single, combo I:PL/PT level min/max/multiple rules can be set in the
seasonal item entry processes (TK.EVENT.SEA.E or
TK.COMBO.SEA.E). Settings in TK.EVENT.SEA.E or
TK.COMBO.SEA.E are overridden by Paciolan 7 selling con-
trol settings for the same I:PL/PT combination.

Seasonal item
entry process
setup at the item
level

Miscellaneous Item level min/max/multiple rules can be set in a mis-
cellaneous item’s seasonal item entry process
(TK.IMISC.SEA.E). Settings in TK.IMISC.SEA.E are over-
ridden by Paciolan 7 selling control settings for the same
miscellaneous item. Note that you cannot set item level
rules in the seasonal item entry processes for single and
combo items.

Combo item
setup

Combo Combo item min/max/multiple settings apply to all the
items in the combo. Paciolan 7 ignores the min/max/mul-
tiple settings of the included single and miscellaneous
items.

Affects of set-
tings on eVenue
& TK.SELL

Single,
combo, mis-
cellaneous

I:PL/PT or item level min/max/multiple settings in the
item entry processes (TK.EVENT.SEA.E,
TK.COMBO.SEA.E, or TK.IMISC.SEA.E) also apply to
eVenue and TK.SELL sales, if those channels sell the
same I:PL/PT combinations or items. eVenue and TK.SELL
do not use settings from the Paciolan 7 selling controls.

Differences
between sales
channels
(eVenue/TK.SELL
vs. Pac7)

Single, combo Unlike Pac7, TK.SELL and eVenue do not combine the
item level and I:PL/PT level rules to determine allowable
item quantities during sales. Instead, if there are settings
for an item at both levels, TK.SELL and eVenue only use
the I:PL/PT level settings.

Setting Up Order Quantity Rules for Single and Combo Items

The order quantity rules for single event and combination (combo) items allow you to set min-
imum, maximum, and multiple (used to require that the quantity of an item be a multiple of the
positive integer of your choice) quantity restrictions at the item level and the item price level/price
type (I:PL/PT) level. Pac7 allows you to set the item and I:PL/PT level rules independently for the
onsales and order management/general sales selling paths. For onsale items only, you can also set
the order quantity that displays by default in the onsale path.

For detailed descriptions of how order quantity rules are used for single and combo items in Pac7,
reference the following:
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l What are item level and I:PL/PT level rules?

Item level rules are applied per order to the sum of all the item's I:PL/PT combination's
quantities as they are added to an order line or the cart. I:PL/PT level rules are set sep-
arately for each I:PL/PT combination, so an I:PL/PT combination's rule settings apply to
quantities of that combination only.

l Where can you set order quantity rules for single and combo items?

You can set order quantity rules for single and combo items in the Pac7 selling controls and
the seasonal item entry processes (TK.EVENT.SEA.E and TK.COMBO.SEA.E). In the selling
controls, rules can be set at the item level and the I:PL/PT level. You can also set I:PL/PT
level rules in item entry processes. However, you cannot set item level rules in the item
entry processes.

You set selling control item rules separately for order management/general sales and
onsales (there are separate settings for promotion sales). In contrast, I:PL/PT level rules set
in the item entry processes apply to both order management/general sales and onsales.
Note, however, that you are allowed to set rules for the same I:PL/PT combination in both
the item entry process and the selling control. When this happens, Pac7 uses the selling con-
trol I:PL/PT setting and ignores the setting in item entry process.

l How do order quantity rules apply to combo items and their included single items?

When enforcing a combo item's order quantity rules, Pac7 uses the combo item's settings in
the selling control and the combo item entry process (TK.COMBO.SEA.E). However, Pac7
ignores the item level and I:PL/PT level settings of the individual single event items in the
combo item, including each single item's settings in both the selling control and the single
item entry process (TK.EVENT.SEA.E). Instead, the combo's single items are evaluated using
the combo item's I:PL/PT level and item level rules in the selling control, as well as the
combo's single item I:PL/PT settings from TK.COMBO.SEA.E.
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The combo's single item I:PL/PT settings from TK.COMBO.SEA.E.
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l Do the rules set for Pac7 also apply to TK.SELL and eVenue?

I:PL/PT level order quantity rules set in the item entry processes also apply to TK.SELL and
eVenue sales, if those channels sell the same I:PL/PT combinations. Make sure to take this
into account when adding order quantity rules through the item entry processes. However,
TK.SELL and eVenue ignore the Pac7 selling control rules. Similarly, Pac7 ignores the rules in
the TK.SELL selling controls (TK.CONTROL.E) and the eVenue Internet Order Man-
agement/General Sales Setup (TK.INSU.GSALES.E).

Note: Unlike Pac7, TK.SELL and eVenue do not combine the item level and I:PL/PT level set-
tings to determine allowable item quantities during sales. Instead, if there are settings for an
item at both levels, TK.SELL and eVenue only use the I:PL/PT level settings.

l How does Pac7 apply rules to single and combo items?

As operators add items to an order line or the cart during sales, Pac7 enforces the item order
quantity rules that you have set up at the item and I:PL/PT levels in the selling controls and
the item entry processes. Depending on your setup, the allowable item quantities for the
order may be determined by one or more of the following rule setting scenarios:

l If an item has item level rules (minimum, maximum, or multiple), they apply to the sum
of the quantities of all its I:PL/PT combinations that are included in the order. See
examples:

Only one item is used in the two examples below. The item has 2 I:PL/PT combinations:
Level1/Adult and Level1/Child.

Item
level
rules in
the
selling
control

I:PL/PT
level
rules in
the
selling
control

I:PL/PT
level rules
in the item
entry pro-
cess

Each of these
orders can
be added to
an order line
or the cart...

Each of these
orders cannot
be added to an
order line or the
cart...

1 Min = 2
Max =
10
Multiple
= 2

(Blank) (Blank) • Adult = 4,
Child = 2
• Adult = 3,
Child = 1

• Adult = 4, Child
= 1 ( Why not?)
• Adult = 8, Child
= 4 ( Why not?)

2 Min = 2
Max =
10
Multiple
= 2

(Blank) For Level1/A-
dult:
Min = 4
Max =
(Blank)
Multiple =
(Blank)
For
Level1/Child:
Min = 2
Max = 8
Multiple =
(Blank)

• Adult = 4,
Child = 2
• Adult = 5,
Child = 3

• Adult = 5, Child
= 1 ( Why not? )
• Adult = 2, Child
= 4 ( Why not? )
Note that this
example's settings
will also not allow
either of the failed
orders used in
example 1 above.
( Why?)

l If an I:PL/PT combination has a multiple setting in the control or the item entry process,
the order quantity of the I:PL/PT must be a multiple of that setting. See examples:
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Only one item is used in the two examples below. The item has 2 I:PL/PT combinations:
Level1/Adult and Level1/Child.

Item level
rules in
the selling
control

I:PL/PT level
rules in the
selling control

I:PL/PT level
rules in the
item entry
process

Each of these
orders can be
added to an order
line or the cart...

Each of these
orders cannot be
added to an order
line or the cart...

1 Min =
(blank)
Max =
(blank)
Multiple
= 2

For Level1/A-
dult:

Min = (Blank)
Max =
(Blank)
Multiple = 3

For
Level1/Child:

Min = (Blank)
Max =
(Blank)
Multiple =
(Blank)

(Blank) • Adult = 3, Child
= 1

• Adult = 6, Child
= 4

• Adult = 4, Child =
2 ( Why not?)

2 Min =
(blank)
Max =
(blank)
Multiple
= 2

(Blank) For Level1/A-
dult:

Min = (Blank)
Max =
(Blank)
Multiple = 3

For
Level1/Child:

Min = (Blank)
Max =
(Blank)
Multiple = 4

• Adult = 6, Child
= 4

• Adult = 6, Child
= 8

• Adult = 12,
Child = 8

• Adult = 6, Child =
6 ( Why not?)

l If an item has a different setting for the same rule (minimum, maximum, or multiple) at
the item level and the I:PL/PT level in the selling control, the I:PL/PT quantity must meet
the most restrictive setting. That is, it must be greater than the highest minimum, less
than the lowest maximum, or a multiple of both multiple settings. See an example:

The item used in the example below has 2 I:PL/PT combinations: Level1/Adult and
Level1/Child.

Item level
rules in
the selling
control

I:PL/PT level
rules in the
selling control

I:PL/PT
level rules
in the item
entry pro-
cess

Each of these
orders can be
added to an order
line or the cart...

Each of these orders
cannot be added to an
order line or the cart...

Min = 2
Max = 10
Multiple

For Level1/A-
dult:

(Blank) • Adult = 4, Child =
2

• Adult = 6, Child =

• Adult = 8 ( Why not? )

• Adult = 3 ( Why not? )
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Item level
rules in
the selling
control

I:PL/PT level
rules in the
selling control

I:PL/PT
level rules
in the item
entry pro-
cess

Each of these
orders can be
added to an order
line or the cart...

Each of these orders
cannot be added to an
order line or the cart...

= 2 Min = 4
Max = 6
Multiple =
(Blank)

For
Level1/Child:

Min = (Blank)
Max =
(Blank)
Multiple =
(Blank)

4 • Adult = 6, Child = 6 ( 
Why not?)

l If you set one or more I:PL/PT rules in the item entry process and the selling control has
no rules (minimum, maximum, or multiple) set for that I:PL/PT combination, Pac7
enforces the rule settings in the item entry process. See an example:

The item used in the example below has 2 I:PL/PT combinations: Level1/Adult and
Level1/Child.

Item level
rules in the
selling con-
trol

I:PL/PT level
rules in the
selling control

I:PL/PT level
rules in the
item entry pro-
cess

These orders cannot be
added to an order line or
the cart...

Min =
(Blank)
Max =
(Blank)
Multiple =
(Blank)

For Level1/A-
dult:

Min = (Blank)
Max =
(Blank)
Multiple =
(Blank)

For
Level1/Child:

Min = (Blank)
Max =
(Blank)
Multiple =
(Blank)

For Level1/A-
dult:

Min = 2
Max = 10
Multiple =
(Blank)

For
Level1/Child:

Min = (Blank)
Max = 8
Multiple =
(Blank)

• Adult = 1, Child = 4 ( Why
not?)

• Adult = 2, Child = 10 ( 
Why not?)

l If an I:PL/PT combination has rules set in the item entry process and the control has any
of the rules (minimum, maximum, or multiple) set for the same I:PL/PT combination,
Pac7 enforces the rules set in the control and ignores all of the item entry process rules.
See an example:

The item used in the example below has 2 I:PL/PT combinations: Level1/Adult and
Level1/Child.
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Item level
rules in the
selling con-
trol

I:PL/PT level
rules in the
selling control

I:PL/PT level
rules in the
item entry pro-
cess

These orders can be added
to an order line or the
cart...

Min =
(Blank)
Max =
(Blank)
Multiple =
(Blank)

For Level1/A-
dult:

Min = (Blank)
Max = 8
Multiple =
(Blank)

For
Level1/Child:

Min = 4
Max =
(Blank)
Multiple =
(Blank)

For Level1/A-
dult:

Min = 2
Max = 10
Multiple =
(Blank)

For
Level1/Child:

Min = (Blank)
Max = 8
Multiple =
(Blank)

• Adult = 1, Child = 4 ( 
Why? )

• Adult = 2, Child = 10 ( 
Why?)

Use the following procedures to set up order quantity rules for single or combo items:

To set up order quantity rules for a single or combo item in the Paciolan 7 selling con-
trols

Tip: If you need to set I:PL/PT level rules for more than one single or combo item, you can save
time by using the single or combo item load process (TK.ILOAD).

1. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.
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2. In the Control field, enter the code of the control for which you want to add order quantity
rules.

3. In the Season table, select the season that contains the item you want to set up, and then

click the details buttonx .
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tRes displays the Season Detail screen.

4. To set up an item for order management/general sales, do the following:

a. In the Order Management and General Sales Items group, select the Only Items Listed
are Available option.
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b. In the Item column, locate or add the item for which you want to set order quantity rules.
c. To set item level rules, enter quantities in the item's Min Qty, Max Qty, and Multiple
columns. Do not enter a quantity in a field if there is no restriction— the number 0
restricts the quantity to zero, whereas leaving the field blank does not restrict quantity.

d. To set I:PL/PT level rules for the item, do the following:

i. In the Item column of the Order Management and General Sales Items group, select

the item, and then click the details buttonx . tRes displays the Season Item sub-
screen.

ii. If no I:PL/PT rows are displayed, click the Load All button or enter the desired I:PL/PT
combinations. When you add I:PL/PT combinations to the Season Item subscreen, only
the ones you add will be available for this control. When no I:PL/PT combinations are
listed on the Season Item subscreen, all the item's I:PL/PT combinations are available.
Clicking the Load All button adds all of the item's I:PL/PT combinations to the Season
Item subscreen.

iii. For each I:PL/PT that needs order quantity rules, enter the quantities in the Min Qty,
Max Qty, and Multiple columns. Do not enter a quantity in a field if there is no restric-
tion— the number 0 restricts the quantity to zero, whereas leaving the field blank does
not restrict quantity.

iv. Click the Save button.

5. To set up an item for onsales, do the following:

a. In the Item column of the Onsale Items group, locate or add the item for which you want
to set order quantity rules.
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b. To set item level rules, enter quantities in the item's Def Qty, Min Qty, Max Qty, and Mul-
tiple columns. Do not enter a quantity in a field if there is no restriction— the number 0
restricts the quantity to zero, while leaving the field blank does not restrict quantity. Also,
if you enter a value for Def Qty, make sure it is greater than the value in Min Qty and less
than the value in Max Qty, if either is not blank.

c. To set I:PL/PT level rules for the item, do the following:

i. In the Item column of the Onsale Items group, select the item, and then click the

details buttonx . tRes displays the Season Item subscreen.

ii. If no I:PL/PT rows are displayed, click the Load All button or enter the desired I:PL/PT
combinations. When you add I:PL/PT combinations to the Season Item subscreen, only
the ones you add will be available for this control. When no I:PL/PT combinations are
listed on the Season Item subscreen, all the item's I:PL/PT combinations are available.
Clicking the Load All button adds all of the item's I:PL/PT combinations to the Season
Item subscreen.

iii. For each I:PL/PT that needs order quantity rules, enter the quantities in the Min Qty,
Max Qty, and Multiple columns. Do not enter a quantity in a field if there is no restric-
tion— the number 0 restricts the quantity to zero, whereas leaving the field blank does
not restrict quantity.

iv. Click the Save button.

6. Click the Accept button, and then click the Save button on the Paciolan 7 Controls screen.

To set up I:PL/PT level order quantity rules in the single event item entry process

Click here to display a new window with the tRes Help topic.

To set up I:PL/PT level order quantity rules in the combo item entry process
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Click here to display a new window with the tRes Help topic.

Note: If the item I:PL/PT you want to change is also sold through TK.SELL or eVenue, the changes
you make in the item entry process will affect sales of the item in those channels. It is recom-
mended that you test the order quantity rules setup of the item I:PL/PT by placing orders through
all sales channels, including Pac7, TK.SELL, and eVenue.

Setting Up Order Quantity Rules for Miscellaneous Items

Order quantity rules for miscellaneous items allow you to set minimum, maximum, and multiple
(used to require that the quantity of an item be a multiple of the positive integer of your choice)
quantity restrictions at the item level. Item level rules are applied per order to the total quantity of
the item when it is added to an order line in order management and the cart in general sales. For
onsales items, you can also set the order quantity that displays by default in the onsale path.

For detailed descriptions of how order quantity rules are used for miscellaneous items in Pac7, ref-
erence the following:

l Where can you set order quantity rules for miscellaneous items?

You can set order quantity rules for miscellaneous items in both the Pac7 selling controls and
the miscellaneous item entry process (TK.IMISC.SEA.E). The selling control rules are set
independently for onsales and general sales, while the rules in TK.IMISC.SEA.E apply to both
sales paths. If an item has a setting for any of the rules (minimum, maximum, or multiple)
in the selling control, Pac7 ignores all of the TK.IMISC.SEA.E settings and uses the settings in
the control.

l Do the rules set for Pac7 also apply to TK.SELL and eVenue?

Rules that are set in TK.IMISC.SEA.E will also be applied to TK.SELL and eVenue sales, if
those channels sell the same miscellaneous items. Make sure to take this into account when
adding order quantity rules through TK.IMISC.SEA.E. However, TK.SELL and eVenue ignore
the Paciolan 7 selling control rules, and Pac7 ignores the rules in the TK.SELL selling controls
(TK.CONTROL.E) and the eVenue Internet General Sales Setup (TK.INSU.GSALES.E).

l How does Pac7 apply rules to miscellaneous items?

When an operator or the Pac7 autoload function add miscellaneous items into an order line or
the cart during sales, Pac7 enforces the item order quantity rules in the selling control and
TK.IMISC.SEA.E. Depending on your setup, the allowable item quantities may be determined
by one or more of the following rules:

l The rules settings in the selling control take precedence over the settings in
TK.IMISC.SEA.E. See an example:

Item set-
tings in
selling con-
trol

Item set-
tings in
item
entry
process

Quantities
that can
be added
to an
order line
or the cart

Why?

Min = 2
Max = 10
Multiple =
2

Min = 3
Max = 12
Multiple
= 3

2, 4, 6, 8,
10

Because there are settings in the selling
control, Pac7 ignores the item entry set-
tings. So, item quantities do not have to
be a multiple or minimum of 3, but they
also cannot exceed the selling control
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maximum of 10.

l If one or more of an item's rules are set in TK.IMISC.SEA.E and no rules are set for that
item in the selling control, Pac7 uses the settings in TK.IMISC.SEA.E. See an example:

Item set-
tings in
selling con-
trol

Item set-
tings in
item
entry
process

Quantities
that can
be added
to an
order line
or the cart

Why?

Min =
(Blank)
Max =
(Blank)
Multiple =
(Blank)

Min = 3
Max = 12
Multiple
= 3

3, 6, 9 12 The settings in the selling control are all
blank, so Pac7 enforces the settings in
the item entry process. Hence, all valid
results are multiples of 3 between the
minimum of 3 and the maximum of 12.

l If even one of an item's rules is set in the selling control, Pac7 ignores all the settings for
that item in TK.IMISC.SEA.E. See an example:

Item set-
tings in
selling con-
trol

Item set-
tings in
item
entry
process

Quantities
that can
be added
to an
order line
or the cart

Why?

Min =
(Blank)
Max = 5
Multiple =
(Blank)

Min = 3
Max = 12
Multiple
= 3

1, 2, 3, 4, 5 Because the selling control has a max-
imum setting of 5, Pac7 ignores all of the
settings in the item entry process. So,
despite the minimum and multiple set-
tings of 3 in the item entry process, Pac7
reads the blank selling control settings
and does not enforce a minimum or mul-
tiple. Only the selling control maximum
of 5 is enforced.

Use the following procedures to set up order quantity rules for miscellaneous items:

To set up order quantity rules for a miscellaneous item in the Pac7 selling controls

Tip: If you need to add the same rules for more than one miscellaneous item at a time, you can
save time by using the miscellaneous item load process (TK.ILOAD.MISC).

1. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.
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2. In the Control field, enter the code of the control for which you want to add order quantity
rules.

3. In the Season table, select the season that contains the item you want to set up, and then

click the details buttonx .
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tRes displays the Season Detail screen.

4. To set up an item for order management and general sales, do the following:

a. In the General Sales Items group, select the Only Items Listed are Available option.
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b. In the Item column, locate or add the item for which you want to set order quantity rules.
c. Enter quantities in the item's Min Qty, Max Qty, and Multiple fields. Do not enter a quantity
in a field if there is no restriction— the number 0 restricts the quantity to zero, whereas
leaving the field blank does not restrict quantity.

5. To set up an item for onsales, do the following:

a. In the Item column of the Onsale Items group, locate or add the item for which you want
to set order quantity rules.

b. Enter quantities in the item's Def Qty, Min Qty, Max Qty, and Multiple fields. Do not enter
a quantity in a field if there is no restriction— the number 0 restricts the quantity to zero,
whereas leaving the field blank does not restrict quantity. Also, if you enter a value for
Def Qty, make sure it is greater than the value in Min Qty and less than the value in Max
Qty, if either is not blank.

6. Click the Accept button, and then click the Save button on the Paciolan 7 Controls screen.

To set up order quantity rules for a miscellaneous item using the item entry process

Note: If the item you want to change is also sold through TK.SELL or eVenue, the changes you
make in the item entry process may affect sales of the item in those channels. You should test the
order quantity rules setup of the item by placing orders through all sales channels, including Pac7,
TK.SELL, and eVenue.

Creating Custom Sales Forms
Because the item sales and order management environments can vary within your organization
and over time, Pac7 allows customization of the some of the functionality on the pages of the Item
Sales and Order Management tabs.

Creating Custom Forms for Item Sales

Creating Custom Forms for Order Management

Creating Custom Forms for Item Sales
Because the item sales environments can vary within your organization and over time, Pac7 allows
page layout customization. You can customize the displayed fields, field requirements, and field
positioning on the Review Items in the Cart and Enter Additional Information pages on the Item
Sales tab.
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Tip: You can also change the display of ticket prices, seatblocks, item availability, and best avail-
able views when creating the Pac7 selling control.

Forms customization allows you to define multiple versions of page layouts. You can then associate
these layouts to Pac7 selling controls for general sales and onsales. You can also use different
forms for the onsales and general sales paths.

To create a custom form

1. Execute the TK.EFORMAT.E process or, in tRes, select Paciolan 7 > Selling Setups > Item
Sales Forms. tRes displays the Item Sales Formats screen.

2. In Format, enter a code for the format, and then, in Name, enter some descriptive text.

Tip: If a format has already been created that is similar to the format you want to create,
enter the format code, and then click the Copy button. Using the Copy to Formats screen, you
can enter the code for your new format, click Accept to create it and, then, use the steps
below to modify the copy of the original format.

3. In Default Headings, select an abbreviation option to set the length of the format's default
headings on the Review Items in the Cart page.

If you select Not Abbreviated, Pac7 displays the long column headers. If you select Abbre-
viated, the shortened version is displayed. The following table shows each form of the

Pac7 Release 7.2



User Guide  100

Review Items in the Cart page headings.

Abbreviated Not Abbreviated

Qty Qty

PL Price Level

PT Price Type

Seatblock Seatblock (for the Abbreviated seat)

Lev Level (for the Not Abbreviated seat)

Sec Section (for the Not Abbreviated seat)

Row Row (for the Not Abbreviated seat)

SFrom Seat From (for the Not Abbreviated seat)

STo Seat To (for the Not Abbreviated seat)

Unit $ Unit Price

Sub $ Subtotal

FFee Facility Fee

Disc Discount Name

Disc $ Discount

SChg Surcharge Name

SChg $ Surcharge

IFee Item Fee Name

IFee $ Item Fee

Total Total

Mark Mark

Promo Promotion

Gift Cert# Gift Certificate #

APass # Access Pass #

Special Special Handling

Notes Notes

Print Print/Process

BPlan Billing Plan

Item Pref Item Preference

Loc Pref Location Preference

OLPri Order-Line Priority

Grp# Group #

ODate Order Date

4. For the button controls in the Cart Display Options and Item Additional Options groups, click
a button to display its subscreen, and then enter values or select options as required. For
information about these subscreens, use the reference information in the table below.
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For this button... Click this link for reference...

Cart Definition Cart Definition subscreen

Order-Line Details Order-Line Detail subscreen

Additional Information Additional Information subscreen

5. On the Item Sales Formats screen, click the Save button.

To associate a custom form with a Pac7 control

1. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.

2. In Control, enter the code of the control with which you want to associate the custom form.

3. In the Item Sales, Inquiry, and Adjustments group, click the Display Options button. tRes dis-
plays the Display Options subscreen.
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4. In the Cart Display Options group, do the following:

a. In Onsale Form Code, enter the code of the custom form you want to use for the Onsale
pages. For information about the operator access options (Access To Item Additional Page
and Access To Charge Details Page), see the Display Options Subscreen reference topic.

b. In General Sales Form Code, enter the code of the custom form you want to use for the
General Sales pages.

5. Click the Accept button, and then, on the Paciolan 7 Controls screen, click the Save button.

Creating Custom Forms for Order Management
Order Management tab custom forms allow you to choose the order information that will display on
the main page for each order line. For example, you may want to include fields for seatblocks, dis-
positions, or surcharges. Some information is required however, such as item name and quantity,
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and cannot be removed or rearranged.

Forms customization also allows you to choose the functional buttons that will be included in the
order level and Order Line table toolbars. Toolbar buttons allow operators quick access to com-
monly used functions during order management. There are some buttons in the toolbars that can-
not be removed or moved, however, although most of them can be deleted and rearranged as you
like.
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Note: Some toolbar buttons will only appear when their functions are applicable to the current
order. For example, the order level Reorder and Reallocate button will not display unless the pat-
ron's order for the current season includes a renewable item.

When configuring order management forms, you can create one from the default required settings,
copy and edit a previously configured order management form, or convert an existing TK.SELL
order form (OForm) to an order management form.

To create an order management form by adding to the required settings

1. Execute the TK.OMFORM.E process or, in tRes, select Paciolan 7 > Selling Setups > Order
Management Forms. tRes displays the Order Management Forms screen.

2. In Form, enter the code you want to use for the new form, and then press the Tab key. tRes
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automatically enters the required fields in the Field table.

3. In Name, enter a descriptive name for the new form. This is only used to help you identify
the form that is configured for the form code on this screen.

4. At the bottom of the Field column, add the optional fields for which you want columns in the
Order Lines table in Pac7. The fields display as columns in the Order Lines table from left to
right based on the top to bottom order here. For more information, see Order Management
Forms Screen.

5. In the Mandatory column, enter Y for fields that require operators to enter a value, and then
enter N for fields that do not require the operator to enter a value.
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6. Click the Order Line Additional button. tRes displays the OM Form Additional Fields
subscreen.

7. In the Field column, add the fields that you want in the Order Line Additional group in Pac7.
The fields display top to bottom based on the order you enter them. For more information,
see OM Form Additional Fields Subscreen.

8. In the Mandatory column, enter Y for fields that require operators to enter a value, and then
enter N for fields that do not require the operator to enter a value.

9. Click Accept and then, on the Order Management Forms screen, click the Toolbar Buttons but-
ton. tRes displays the Order Management Toolbars subscreen.
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10. In the empty table of the Order Header Buttons group, enter the numbers of the buttons you
want in the toolbar. Press the F3 key to select from a list of buttons. The top to bottom order
of the buttons sets the left to right order on the toolbar. For more information, see Order Man-
agement Toolbars Subscreen.

See the list of toolbar buttons for the order header
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Button Code
# Function

N/A Comments, tags, and order
priority

N/A User defined fields

0 Separator line

3 Application items

5 Billing plans

6 Previous season overviews

7 Reorder and reallocate

8 Reprint prior receipts

9 Reallocate

10 Order held seats

11 Hold seats

12 Print Boca batch summary

11. In the empty table of the Order Line Buttons group, enter the numbers of the buttons you
want in the toolbar. Press the F3 key to select from a list of buttons. The top to bottom order
of the buttons sets the left to right order on the toolbar. For more information, see Order Man-
agement Toolbars Subscreen.
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See the list of the toolbar buttons for the Order Lines table

Button Code # Function

1 Add or insert an order line

2 Cancel order line

4 Seat map

3 Assign best available seats

5 Seats menu

0 Separator line

6 Area search

7 Display event details

8 Select events for combo
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Button Code # Function

9 Facility fee inquiry

10 Item details

11 Search for multiple events

12 Price split

13 Prorate

14 Reprint tickets

15 Search plan

16 Seat fields

17 Void

18 Exchange

19 Return

12. Click the Accept button and then, on the Order Management Forms screen, click the Save
button.

To create an order management form from an existing order management form

1. Execute the TK.OMFORM.E process or, in tRes, select Paciolan 7 > Selling Setups > Order
Management Forms. tRes displays the Order Management Forms screen.
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2. In Form, enter the code of the existing order management form, and then press the Tab key.
tRes loads the form settings. You can also select the form from a list by pressing the F3 key.

3. Click the Copy To button. tRes displays the Copy TO OM Form subscreen.

4. Enter a code for the new form, and then click the Accept button. The Order Management
Forms screen redisplays with the original form still loaded.

5. Click in the Form field, enter the code of the new form, and then press the Tab key. The new
form is now loaded into the screen.

6. Edit the form as required. For more information, reference the procedure above or see Order
Management Forms Screen.

To create an order management form from an existing TK.SELL order form (OForm)

1. Execute the TK.OMFORM.E process or, in tRes, select Paciolan 7 > Selling Setups > Order
Management Forms. tRes displays the Order Management Forms screen.
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2. In Form, enter the code you want to use for the new form, and then press the Tab key. tRes
automatically enters the required fields in the Field table.

3. Click the Copy From button. tRes displays the Copy FROM OForm subscreen.
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4. Enter the code of the existing TK.SELL OForm, and then click the Accept button. You can also
press F3 to select the form from a list. The form is converted into a Pac7 order management
form and loaded into the Order Management Forms screen.

Note: For information about the conversion from TK.SELL OForm to Pac7 order management
form, see the Copy From section of the Order Management Forms Screen reference topic.

5. Edit the form as required. For more information, reference the procedure above or see Order
Management Forms Screen.

Using TK.SELL Print Forms for Pac7
Pac7 order management and item sales share print forms with TK.SELL. To create print forms for
tickets and receipts, you can either reconfigure existing TK.SELL forms, copy and modify forms
already configured for Pac7, or create new forms.

To configure existing TK.SELL print forms for Pac7

1. Execute the TK.FORMS.E process or, in tRes, select Maintenance > System > Format >
Forms. tRes displays the Print Forms screen.
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2. Open the TK.SELL print form that you want to use for item sales.
3. Select the Use with Paciolan 7 option. By selecting this option, tRes will validate the print
variables on the form for Paciolan 7 Item Sales.

4. Enter values for the remaining fields and subscreens as required, and then click the Save
Form button. For information about the remaining fields on the Print Forms screen, see the
tRes reference topic.

To copy and modify print forms that are already configured for Pac7

1. Execute the TK.FORMS.E process or, in tRes, select Maintenance > System > Format >
Forms. tRes displays the Print Forms screen.

2. Open the print form you want to copy and modify for item sales.

3. Click the Copy button and, when prompted, enter a name for the new print form. tRes dis-
plays the Print Forms screen for the new print form.

4. Enter values for the remaining fields and subscreens as required, and then click the Save
Form button. For information about the remaining fields on the Print Forms screen, see the
tRes reference topic.
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To create new print forms for Pac7

1. Execute the TK.FORMS.E process or, in tRes, select Maintenance > System > Format >
Forms. tRes displays the Print Forms screen.

2. Enter the user code, and then, in Form Type, enter the type of form you want to edit.
3. In Form Code, enter the code of the form you want to use for printing.
4. Select the Use with Paciolan 7 option. When this option is selected and you save this form,
tRes will validate the print variables on the form for Paciolan 7 item sales.

5. Enter values for the remaining fields and subscreens as required, and then click the Save
Form button. For information about the remaining fields on the Print Forms screen, see the
tRes reference topic.

Note: When using TK.SELL print forms with Pac7, each variable must be on its own line. Pac7 does
not allow users to concatenate variables on the same line.

Setting Up Email Confirmation for Order Management
Note: For information about the setup in item sales and order inquiry, see Setting Up Email Con-
firmation for Item Sales.

When processing sales in order management, you can choose to send email messages to cus-
tomers as a confirmation at the completion of their orders. Order management in Pac7 uses the
same confirmation email setup as that used for TK.SELL. The only different step is that you must
enable the feature in Pac7 controls.

To set up email confirmation for order management

1. Set up confirmation email for TK.SELL.

2. Execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls. tRes displays the Paciolan 7 Controls screen.
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3. In the Order Management group, click the Payment/Post Sale Options button. tRes displays
the Order Management Payment/Post Sale Options subscreen.
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4. In the End of Sale group, select the Optional default setting. Select Optional (Default No) if
you want the default selection on the Payment Information page to not send a confirmation
email. Operators will still be able to send a confirmation email by changing the selection. To
make the default selection sending an email, select Optional (Default Yes). For more inform-
ation, see the Order Management Payment/Post Sale Options subscreen reference topic.
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5. If you want operators using this control to be able enter an email address and send a con-
firmation email message while using a house customer for selling, select Allow Send for
House Customer.

6. If you want operators using this control to be able to print an order summary when finishing
an order, select the Show Order Summary Link on End of Sale Dialog option.

7. Click the Accept button and then, on the Paciolan 7 Controls screen, click the Save button.

Setting Up Email Confirmation for Item Sales
Note: For information about the setup for order management, see Setting Up Email Confirmation
for Order Management.

During item sales and order inquiry in Pac7, you can choose to send email messages to customers
as a confirmation at the completion of their orders, as well as during subsequent inquiries about
completed orders. You must also set up a template for the confirmation email messages, including
the return email address, subject line text, and text for the beginning and end of the message
body.

If you enable confirmation email messages, operators are allowed to choose whether to send
email confirmation at the completion of each item sales order and during order inquiry.

To set up email confirmation for item sales and inquiry

1. Execute the TK.ET.EMAIL.E process or, in tRes, select Paciolan 7 > Selling Setups > Item
Sales Email Templates. tRes displays the Item Sales Email Entry screen.
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2. In Email Template, enter a short, descriptive text name for the code, and then complete the
rest of the options on the screen using the Item Sales Email Entry screen reference topic.

Note: In Type, make sure you enter O.

3. When you have set all the options, click the Save button.

4. Execute the TK.BA.E process or select Paciolan 7 > General Setups > Business Accounts.
tRes displays the Paciolan 7 Business Accounts screen.

5. In Business Account, enter the code of the business account for which you want to set up
email confirmation.

6. In the Email Confirmation Template field within the Item Sales Only group, enter the Email
Template code you set up above, and then click the Save button.

7. For each Paciolan 7 Control, do the following:

a. Execute the TK.ETCONTROL.E process or select Paciolan 7 > Selling Setups > Paciolan 7
Controls. tRes displays the Paciolan 7 Controls screen.
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b. In Control, enter the code of the control for which you want to set up email confirmation,
and then, in the Item Sales, Inquiry, and Adjustments group, click the Post Sale

Options buttonx . tRes displays the Post Sale Options subscreen.

c. From the Allow Order Confirmation Email list, select Optional (Default Yes) or Optional
(Default No). Select Optional (Default Yes) to make the default choice sending a message,
or select Optional (Default No) to default to not sending a message.
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d. To allow sending email during order inquiry, select the Allowed option for Order Inquiry,

and then click the Order Inquiry Options buttonx . tRes displays the
Order Inquiry Options subscreen.

Note: When an order confirmation is resent through order inquiry, the order confirmation
email will display the order as it was at the time the order was placed in Pac7. Any sub-
sequent back office (tRes) changes made to the order will not be reflected in the resent
order confirmation.

e. Select the Able to Email Order Confirmation option, and then click the Accept button.
f. On the Post Sale Options subscreen, click the Accept button, and then, on the Paciolan 7
Controls screen, click Save.

Setting Up Print at Home Delivery
Note: Print at Home (PAH) must be enabled by Paciolan before you can use the feature. In addi-
tion, you will likely use Paciolan's Access Management (AM) to scan and validate PAH tickets when
customers use them at your events. Contact Paciolan Customer Support for information about activ-
ating PAH and AM.

The Print at Home (PAH) feature allows your customers to print their own tickets, eliminating the
cost of printing tickets and distributing tickets by mail or at will call. In Pac7, you can use the PAH
delivery method during order management and item sales for allocatable items, vouchers, parking
passes, concession credits, and gift certificates. When using the PAH delivery method in item
sales, the following are not supported:

l Donation items and access passes
l Mailers and receipts
l Partial and under payments
l House customers

To deliver items as PAH, patrons must have a PAH email address and contact phone number in
their patron records. If a patron does not have a PAH email address or contact phone number dur-
ing item sales, the operator will be prompted to enter them at the end of the sale. Only one PAH
email address can be captured per patron record during item sales. In order management, you can
edit the patron record and add more than one email address or phone number.

Customers who opt for the PAH delivery method will automatically be sent a confirmation email
message at the completion of their order, followed by a PAH email message with an Adobe Port-
able Document Format (PDF) attachment containing their items. The PDF attachments include bar-
codes for the items they contain, so that Access Management (AM) can validate their authenticity.
AM will only allow one valid scan per barcode when customers attempt to enter an event.

Note: Pac7 limits the size of the PDF attachments to 1MB. If the PDF attachment for an order is
greater than 1MB, the order will be split into multiple PDF files, each sent with a separate email
message.
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The timing of the PAH email message depends on whether you make printing tickets electronically
the default in the Paciolan 7 control. If printing tickets is the default, the email will be sent imme-
diately. If printing tickets is not the default, you will need to send the email using the tRes
TK.PRINT.F process.

To set up print at home for item sales

1. Create the PAH ticket format by doing the following:

a. Execute the TK.FORMS.E process or, in tRes, select Maintenance > System > Format >
Forms. tRes displays the Print Forms screen.

b. Enter your User Code, and then, in Form Type, enter P.
c. In Form Code, enter PAH.#, where # is the number of the format you want to use. Press
F3 for a list of existing PAH formats. You can change or copy the one that is closest to the
format you want.

d. Click the Printer Type button. tRes displays the Print at Home Parameters screen.

e. Enter the form's parameters in inches, and, in the Template field, enter the PDF tem-
plate's filename.

Note: Contact Paciolan for a list of the available laser printing templates (PDF files). Paci-
olan sets up the templates for you and uploads the template PDF files to your Pac7 server.

f. Click the Accept button, and then, in the Printer Type field, enter P.
g. Select the Use with Paciolan 7 option. When this option is selected and you save this form,
tRes will validate the print variables on the form for Pac7.

h. Enter values for the remaining fields and subscreens as required, and then click the Save
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Form button. For information about the remaining fields on the Print Forms screen, see
the tRes reference topic. Here is an example of a completed Print Forms screen.

2. If you want to set up PAH ticket formats for individual items, item price levels, or item price
levels/price types, do the following:

l On the Item Miscellaneous subscreen of the Season Events screen (TK.EVENT.SEA.E),
enter the PAH format code in the P@H Format field.

l On the Item Miscellaneous subscreen of the Season Events screen of the Season Combo
Items screen (TK.COMBO.SEA.E), enter the PAH format code in the P@H Format field.
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3. Set up the PAH disposition by doing the following:

a. Execute the TK.DCODE.E process or select Maintenance > Other Parameters > Dis-
positions. tRes displays the Dispositions screen.

b. In Disposition, enter a disposition code, and then, in Disposition Name, enter a descrip-
tion of the disposition.

c. For the Type option, select Print At Home, and then click the Save button. Here's an
example of a Dispositions screen set up for PAH.
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4. For item sales only (not order management), set up a PAH delivery method for item sales by
doing the following:

a. Execute the TK.TDMETH.E process or select Paciolan 7 > Selling Setups > Item Sales
Delivery Method. tRes displays the Item Sales Delivery Methods screen.

b. In Delivery Method, enter a short, descriptive text name for the code.
c. In Name, enter a more descriptive name for the delivery method, and then, in Type, enter

PAH.
d. In tRes Disposition Code, enter the code you created in the previous step.
e. Complete the rest of the options on the screen using the Item Sales Delivery Methods ref-
erence information, and then click the Save button.

f. Execute the TK.ETCONTROL.E process or select Paciolan 7 > Selling Setups > Paciolan 7
Controls. tRes displays the Paciolan 7 Controls screen.
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g. In Control, enter the code of the control for which you want to set up the PAH delivery

method, and then click the Delivery Methods buttonx . tRes dis-
plays the Delivery Methods subscreen.

h. In a new row of the Delivery Method column, enter the delivery method code you created
above.

i. Click the Accept button, and then, on the Paciolan 7 Controls screen, click the Save button.
5. If you have not done so already, set up email confirmation. A confirmation email will auto-
matically be sent for each order that uses the Print at Home delivery method you set up in
the previous step.

6. For item sales only (not order management), set up the PAH email template (for the email
message to which the PDF tickets will be attached) by doing the following:

a. Execute the TK.ET.EMAIL.E process or select Paciolan 7 > Selling Setups > Item Sales
Email Templates. tRes displays the Item Sales Email Entry screen.
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b. For Email Template, enter a short, descriptive text name for the code (for example, PAH).
c. In Type, enter P.
d. Complete the rest of the options on the screen using the Item Sales Email Entry reference
information, and then click the Save button.

7. Set up item sales PAH for each of your business accounts by doing the following:

a. Execute the TK.BA.E process or select Paciolan 7 > General Setups > Business Accounts.
tRes displays the Paciolan 7 Business Accounts screen.

b. In Business Account, enter the code of the business account for which you want to set up
PAH.

c. In PAH Email Template, enter the email template code of the print at home email tem-
plate you set up on the Item Sales Email Entry screen above, and then click the Save but-
ton.

8. To store valid PAH email addresses for your customers, configure a PAH email phone type by
doing the following in tPatron:

Note: If you are already using PAH for TK.SELL or eVenue, this email phone type should
already be set up. To verify that it is set up, display the Paciolan 7 Data Account Setup screen
(Paciolan 7 > General Setups > Data Account). If there is a code displayed in the Print At
Home Email Type field, proceed to step 9.
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a. Execute the PD.PTYPE.E process or, in tPatron, select Maintenance > Patron Parameters >
Phone and Email Types. tPatron displays the Phone and Email Type Entry screen.

b. In Phone Type, enter a code name for the PAH email type (for example, PAH), and then,
in Name, enter a descriptive name for the type (for example, Print at Home).

c. Select both the Email Address and P@H Email options.
d. In the Edit column under Access by Software System, enter the list of Paciolan systems
from which editing is allowed for this address type. If you want all systems to have edit
access to this address type, leave the column blank.

e. In the View column, enter the list of Paciolan systems from which this address type can
be viewed. Systems with edit access are automatically given view access. It is not neces-
sary to list view access unless the viewing restrictions are different than the editing
restrictions.

f. Click the Save button.
9. To set when the PAH email should be sent after the completion of a sale, do the following for
each Pac7 selling control:

a. Execute the TK.ETCONTROL.E process or select Paciolan 7 > Selling Setups > Paciolan 7
Controls. tRes displays the Paciolan 7 Controls screen.
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b. In Control, enter the code of the control for which you want to set PAH email timing, and

then click the Print/Receipt Options buttonx . tRes displays the
Print/Receipt Options for Selling Paths subscreen.

c. To automatically send the PAH email message at the completion of each sale, select the
Print Tickets and Process Items options in the Electronic Delivery Defaults group. Process
Items sets the option for non-allocatable items (vouchers, parking passes, concession
credits, and gift certificates).

d. To manually send PAH email messages at any time after the completion of sales, clear
the Print Tickets and Process Items options in the Electronic Delivery Defaults group. Pro-
cess Items sets the option for non-allocatable items. You can manually send PAH email
messages using the Pac7 Adjustments tab.

e. Click the Accept button, and then, on the Paciolan 7 Controls screen, click the Save but-
ton.

Setting Up Magstripe Delivery
Magstripe delivery must be enabled by Paciolan before you can use the feature. You need to enable
magstripe delivery if you want to use Access Management (AM) to scan magstripe credit cards and
student IDs instead of printed tickets when patrons enter events. Contact Paciolan Customer Sup-
port for information about implementing magstripe delivery and AM.

The magstripe student ID (MSID) and magstripe credit card (MSCC) features associate item pur-
chases with individual students and card holders to print their own tickets, eliminating the cost of
printing tickets and distributing tickets at will call. In Pac7, you can use the magstripe delivery
method for allocatable items (singles, fixed combos, and flex combos), vouchers, parking passes,
and concession credits. Magstripe delivery also accommodates partial and under payments. When
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using the magstripe delivery method, the following are not supported:

l Donation items, gift certificates, and access passes
l Mailers and receipts
l House customers

If the patron record for a customer using magstripe delivery for an order has an associated patron,
the order lines or cart items will use the primary patron's magstripe card (MSID or MSCC). Only
one magstripe card can be used for all lines items in an order with magstripe delivery selected. For
students with an MSID number already in their patron records, that number will be automatically
used with the MSID delivery method.

To set up magstripe delivery

1. Set up the magstripe delivery (MSID or MSCC) disposition by doing the following:

a. Execute the TK.DCODE.E process or, in tRes, select Maintenance > Other Parameters >
Dispositions. tRes displays the Dispositions screen.

b. In Disposition, enter a disposition code, and then, in Disposition Name, enter a descrip-
tion of the disposition.

c. For the Type option, select Magstripe Student ID or Magstripe CC, and then click the Save
button. Here's an example of a Dispositions screen set up for magstripe student ID.

2. For item sales only (not order management), set up a magstripe delivery method by doing
the following:

a. Execute the TK.TDMETH.E process or select Paciolan 7 > Selling Setups > Item Sales
Delivery Method. tRes displays the Item Sales Delivery Methods screen.
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b. In Delivery Method, enter a short, descriptive text name for the code.
c. In Name, enter a more descriptive name for the delivery method, and then, in Type, enter
MSID or MSCC.

d. In tRes Disposition Code, enter the code you created in step 1.
e. Complete the rest of the options on the screen using the Item Sales Delivery Methods ref-
erence information, and then click the Save button.

f. Execute the TK.ETCONTROL.E process or select Paciolan 7 > Selling Setups > Paciolan 7
Controls. tRes displays the Paciolan 7 Controls screen.

g. In Control, enter the code of the control for which you want to set up the magstripe

Pac7 Release 7.2



User Guide  132

delivery method, and then click the Delivery Methods buttonx .
tRes displays the Delivery Methods subscreen.

h. In a new row of the Delivery Method column, enter the Delivery Method code you created
above.

i. Click the Accept button, and then, on the Paciolan 7 Controls screen, click the Save button.
3. If Pac7 is configured to use full patron entry, set up each patron policy for magstripe access
by doing the following:

a. Execute the TK.PPOLICY.E process or select Paciolan 7 > Patron Setup > Patron Policy.
tRes displays the Patron Policy screen.

b. In Policy Code, enter the code of the patron policy, and then click the Data Access Options
button. tRes displays the Data Access Options subscreen.
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c. In the Access Options group, select the Allow Access to Magnetic Strip ID option.
d. Click the Save button, and then, on the Patron Policy screen, click its Save button.

4. If you are using MSID (not MSCC), you can manually add ID numbers by doing the following:

Note: This step is for adding ID numbers to one patron at a time. Contact Paciolan Customer
Support if you want to upload multiple student ID numbers in a single batch.

a. Execute the PD.MAGSTRIPE.E process or, in tPatron, select Patrons > Access Passes >
Magnetic Stripe I.D. Entry. tPatron displays the Magnetic Stripe I.D. Entry screen.

b. In Patron, enter the patron code, and then, in New Mag Stripe I.D., enter the ID number.
c. Click the Save button.

Setting Up Laser Printing
Note: The laser printing option must be enabled by Paciolan. If you do not have laser printing
enabled and are interested in using this option, contact your Paciolan representative. To determine
if you have laser printing enabled, do the following:

1. In tRes, execute the TK.FORMS.E process or select Maintenance > System > Format >
Forms. tRes displays the Print Forms screen.
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2. Enter a valid User Code, and then, in the Form Type field, press the F3 key. tRes displays a
new window with a list of the available form types.

If the AL, NL, ML, and RL types are listed, you have laser printing enabled. If they are not lis-
ted, the option is not enabled. In the graphic above, they are listed and so laser printing is
enabled.

Pac7 allows you to print items (for example, allocatable/non-allocatable, gift certificates, or access
passes) to a laser printer in any ticket office. To set up the appearance and layout of your printed
items, Pac7 also allows you to create laser printing forms. For each variation of an item that you
want to print to a laser printer, you can assign a print form. The form types for which you can cre-
ate templates include the following:

l AL: Allocatable Laser Form
l NL: Non-allocatable Laser Form
l ML: Mailer Laser Form
l RL: Receipt Laser Form

Tip: Before setting up laser printing, you should optimize ticket printing performance based on the
following:

l Use the fastest possible network connection between the terminal and the printer. Faster
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network speeds decrease printing times, by shortening the time it takes the PDF file to spool
to the printer. You should use the same network speed as is recommended for Pac7. Do not
use a VPN to bulk print remotely.

l Paciolan recommends using only laser printers for 8.5 x 11 printing. Do not use dot matrix
printers. Inkjet printers may work, but are not recommended because of the possibility of
ink smears.

l To increase ticket printing speed, use laser printers with highest possible pages per minute.
l Keep the size of the PDF template file as small as possible (less than 100kb). You can do this
by reducing the number of images used in the template file.

l Make sure that the barcode is located in a blank area of the PDF template. There should be
no images, watermarks, or borders touching the barcode.

l The printer paper does not have to be white, but the paper color must contrast with the bar-
code color so it can be read.

l To make sure that the printed barcode is compatible with all types of access devices (hand-
helds and turnstiles), Paciolan strongly recommends that you print and scan test tickets. Be
sure to print the test tickets on the same printers and printer paper that operators will use
for real events.

To set up laser printing

1. Execute the TK.FORMS.E process or, in tRes, select Maintenance > System > Format >
Forms. tRes displays the Print Forms screen.

2. Do the following:
a. Enter the user code, and then, in the Form Type field, enter the type of laser printer form
(AL, NL, RL, ML) you want to edit. You can find your user code in the Program Suffix field
on the System Setup screen.

b. In the Form Code field, enter the code of the form you want to use for laser printing.

c. Click the Printer Type button. tRes displays the Laser Form Parameters screen.
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d. Enter the form's parameters in inches, and, in the Template field, enter the PDF tem-
plate's file name.

Note: Contact Paciolan for a list of the available laser printing templates (PDF files). Paci-
olan sets up the templates for you and uploads the template PDF files to your Pac7 server.

e. Click the Accept button, and then, in the Printer Type field, enter L.

f. Select the Use with Paciolan 7 option. When this option is selected and you save this form,
tRes will validate the print variables on the form for Pac7. Here is an example of a com-
pleted Print Forms screen.

g. Enter values for the remaining fields and subscreens as required, and then click the Save
Form button. For information about the remaining fields on the Print Forms screen, see
the tRes reference topic.

3. Execute the TK.DCODE.E process or select Maintenance > Other Parameters > Dispositions.
tRes displays the Dispositions screen.
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4. For each disposition you want to use for laser printing, select Traditional for the Type option,
and then click the Save button. For information about the fields on the Dispositions screen
(TK.DCODE.E), see the tRes reference topic.

5. For Item Sales only (not Order Management), do the following:
a. Execute the TK.TDMETH.E process or select Paciolan 7 > Selling Setups > Item Sales
Delivery Method. tRes displays the Item Sales Delivery Methods screen.

b. Setup the delivery method by doing the following:
c. In the Delivery Method field, enter a new code or the code of an existing delivery method
that you want to set up.

d. In the Type field, enter I. Laser printing delivery methods are always immediate delivery.
e. In the tRes Disposition Code field, enter the value you previously entered in the Dis-
position field of the Dispositions screen (TK.DCODE.E).

f. Enter values for the remaining fields on the Item Sales Delivery Methods screen as
required, and then click the Save button.

6. For each Pac7 control you are setting up for laser printing, do the following:

a. Execute the TK.ETCONTROL.E process or select Paciolan 7 > Selling Setups > Paciolan 7
Controls. tRes displays the Paciolan 7 Controls screen.
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b. In Control, enter the code of the control and then, in the Shared Setups group, click the
Print/Receipt Options button. tRes displays the Print/Receipt Options for Selling Paths
screen.

c. For the Print To option, select Laser.
d. If Always or Optional is selected for the Mailer Options, enter the Mailer Form Code of the
print form you want to use.

e. If Always or Optional is selected for the Print Receipt option, enter the Receipt Form Code
of the print form you want to use.
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f. Click the Accept button. tRes redisplays the Paciolan 7 Controls screen.

g. For Item Sales only (not Order Management), click the Delivery Methods button to display
the Delivery Method screen, and then add the delivery methods you configured in the
Item Sales Delivery Methods screen in the previous step. The delivery methods you add
for laser printing must have a disposition code type of Traditional. When you are finished,
click the Accept button.

h. On the Paciolan 7 Controls screen, click the Save button.
7. Log in to Pac7 as an administrator, and then modify the ticket printer settings to include the
local laser printer. Delivery methods with the disposition code type of Traditional will now
print to this laser printer.

Setting Up Cash Drawers
Note: Cash Drawer automation only works for transactions that print allocatable items or receipts
to a BOCA printer.

If you have the correct hardware configuration, you can set up Pac7 to automate the opening of a
cash drawer at the completion of a transaction when operators begin printing allocatable items and
receipts. If cash drawer is based on receipt forms, then cash drawer automation can be con-
figurable at the control level, based on the print forms you use for receipts.

Note: Pac7 configuration does not use the SBClient SYS.LINE.E process for its hardware setup, so
settings there have no effect on cash drawer automation in Pac7.

Tip: If you have already set up the BOCA print forms, dispositions, and controls for the items that
will require cash drawer automation, you only need to edit the existing print forms as detailed in
step 1 of the procedure below. However, you can still use the rest of the procedure to verify that
your setup is correct.

To set up a cash drawer

1. Set up print forms by doing the following:

a. Execute the TK.FORMS.E process or, in tRes, select Maintenance > System > Format >
Forms. tRes displays the Print Forms screen.
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b. Enter the user code, and then, in the Form Type field, enter the type of laser printer form
you want to edit. To use an automatic cash drawer, the type should be A (Allocatable) or R
(Receipt).

c. In the Form Code field, enter the code of the form you want to use when printing alloc-
atable items or receipts with a cash drawer. The rest of the values for the form will auto-
matically display.

d. In the Variable column, insert your cursor in the top row, and then type Ctrl-Insert. A new
row is added to the top of the table.

e. In the new Variable field, type "CHAR(7)CHAR(7)". You must include the quotation
marks. The Print Forms screen should look like this example.

f. Enter values for the remaining fields and subscreens as required, and then click the Save
Form button. For information about the remaining fields on the Print Forms screen, see
the tRes reference topic.

2. Execute the TK.DCODE.E process or select Maintenance > Other Parameters > Dispositions.
tRes displays the Dispositions screen.
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3. For each disposition you want to use for BOCA printing with automatic cash drawer, select
Traditional for the Type option, and then click the Save button. For information about the
remaining fields on the Dispositions screen (TK.DCODE.E), see the tRes reference topic.

4. For single events, set up BOCA print forms with automatic cash drawer by doing the fol-
lowing:

a. Execute the TK.EVENT.SEA.E process or select Maintenance > Event Templates > Events
> Season > Internal. tRes displays the Season Events screen.

b. Enter the Season and Event that you want to set up, and then click the Item Misc

buttonx . tRes displays the Item Miscellaneous screen.
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c. To define the BOCA print form at the item level, enter the form code in the Format field.
d. To define the BOCA print form at the PL/PT level, enter the form code in the Format
column of the PL table below.

Note: All PL/PT combinations use the BOCA print form you assign at the item or PT levels,
except when you assign different print forms to specific PL/PT combinations— PL/PT level
print form assignments override item and PT level assignments.

e. Click the Accept button. tRes redisplays the Season Events screen.

f. To define the BOCA print form at the PT level, do the following:

i. Click the Item Print Info button. tRes displays the Item Print Info screen.

ii. In the Format column of the PT list, enter template names for price types.

Note: All price type (PT) levels use the BOCA print form you assign at the item level,
except when you assign different print forms to specific PT levels— PT level print form
assignments override item level assignments. However, if a PT level has been
assigned a print form as part of a PL/PT combination, the PT level assignment is over-
ridden by the PL/PT combination assignment.

iii. Click the Accept button. tRes redisplays the Season Events screen.

g. Click the Save button.
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5. For combo items, set up BOCA print forms with automatic cash drawer by doing the
following:

a. Execute the TK.COMBO.SEA.E process or select Maintenance > Event Templates > Items
> Season > Combo. tRes displays the Season Combo Items screen.

b. Enter the Season and Combo that you want to set up, and then click the Misc buttonx

. tRes displays the Item Miscellaneous screen.

c. To define the BOCA print form at the item level, enter the form code in the Format field.
d. To define the BOCA print form at the PL/PT level, enter the form code in the Format
column of the item list.

Note: All PL/PT combinations use the BOCA print form you assign at the item or PT levels,
except when you assign different print forms to specific PL/PT combinations— PL/PT level
print form assignments override item and PT level assignments.

e. Click the Accept button. tRes redisplays the Season Combo Items screen.
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f. To define the BOCA print form at the PT level, do the following:

i. Click the Print Info button. tRes displays the Item Print Info screen.

ii. In the Format column of the PT list, enter template names for price types.

Note: All price type (PT) levels use the BOCA print form you assign at the item level,
except when you assign different print forms to specific PT levels— PT level print form
assignments override item level assignments. However, if a PT level has been
assigned a print form as part of a PL/PT combination, the PT level assignment is over-
ridden by the PL/PT combination assignment.

iii. Click the Accept button. tRes redisplays the Season Combo Items screen.

g. Click the Save button.

6. For donation items, set up BOCA print forms with automatic cash drawer by doing the fol-
lowing:

a. Execute the TK.IDON.SEA.E process or select Maintenance > Event Templates > Items >
Season > Donation. tRes displays the Season Donation Items screen.

b. Enter the Season and Donation values for the item that you want to set up.
c. In the Format field, enter the BOCA print form you want to use for this donation item.
d. Click the Save button.
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7. For miscellaneous items, set up BOCA print forms with automatic cash drawer by doing the
following:

a. Execute the TK.IMISC.SEA.E process or select Maintenance > Event Templates > Items >
Season > Miscellaneous. tRes displays the Season Misc Items screen.

b. Enter the Season and Misc values for the item that you want to set up.
c. In the Format field, enter the BOCA print form you want to use for this miscellaneous
item.

d. Click the Save button.

8. For gift certificate items, set up BOCA print forms with automatic cash drawer by doing the
following:

a. Execute the TK.IGC.SEA.E process or select Maintenance > Event Templates > Items >
Season > Gift Certificate. tRes displays the Season Gift Certificates screen.
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b. Enter the Season and Gift Cert values for the item that you want to set up.
c. In the Format field, enter the BOCA print form you want to use for this gift certificate
item.

d. Click the Save button.

9. For access pass items, set up BOCA print forms with automatic cash drawer by doing the fol-
lowing:

a. Execute the TK.IAPASS.SEA.E process or select Maintenance > Event Templates > Items
> Season > Access Pass. tRes displays the Access Passes screen.

b. Enter the Season and Access Pass values for the item that you want to set up.
c. In the Format field, enter the BOCA print form you want to use for this access pass item.
d. Click the Save button.

10. For item sales only (not order management), do the following:
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a. Execute the TK.TDMETH.E process or select Paciolan 7 > Selling Setups > Item Sales
Delivery Method. tRes displays the Item Sales Delivery Methods screen.

a. In the Type field, enter I. BOCA printing delivery methods are always immediate delivery.

b. In the tRes Disposition Code field, enter the value you previously entered in the Dis-
position field of the Dispositions screen (TK.DCODE.E).

c. Enter values for the remaining fields on the Item Sales Delivery Methods screen as
required, and then click the Save button.

11. Set up Paciolan 7 controls by doing the following:

a. Execute the TK.ETCONTROL.E process or select Paciolan 7 > Selling Setups > Paciolan 7
Controls. tRes displays the Paciolan 7 Controls screen.
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b. In Control, enter the code of the control that will be used for the automatic cash drawer.

c. Click the Print/Receipt Options button to display the Print/Receipt Options for Selling Paths
screen.

d. Complete the following steps:

i. Make sure that Boca is selected.
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ii. If you set up a print form for allocatable items that opens the cash drawer (the one
that has "CHAR(7)CHAR(7)" in the first variable field on the Print Forms screen), select
the Print Tickets option under Traditional Delivery Defaults.

iii. If you want the cash drawer to open when receipts begin printing, select Always for
the Print Receipt option, and then, in Receipt Form Code, enter the code of the form
you set up for automatic cash drawer opening (the one that has "CHAR(7)CHAR(7)" in
the first variable field on the Print Forms screen).

iv. Click the Accept button.

e. For item sales only (not order management), click the Delivery Methods button to display
the Delivery Methods screen, and then add the delivery methods you configured on the
Item Sales Delivery Methods screen above. The delivery methods you add for BOCA print-
ing must have a disposition code type of Traditional.

f. Click the Save button.

Synchronizing Data
Data synchronization occurs automatically when smaller changes are made in the back office. (Lar-
ger changes require data massloading.) Few data errors occur during synchronization because tRes
requires valid field entries on setup screens. For example, changing the configuration of an exist-
ing control requires seats to be assigned during order placement.

Data Synchronization processes have the following characteristics:

l They are triggered by changes made primarily in the Maintenance area of tRes.
l They do not require offline processing like massloads.
l They are executed when the record is saved in tRes.
l For data changes to take effect, users must exit the sales process (or log out and back in) in
Pac7.

Note: For lists of the tRes functions that require data synchronization or massloading for changes,
see Data Update Types by tRes Function.

Massloading Data Overview
The system loads data from tRes to Pac7 as either a massload or a data synchronization (data
sync). The process of synchronizing data is automatic.

Note: For lists of tRes functions and the data update types (massload type or data syn-
chronization) they require to update Pac7 with changes, see Data Update Types by tRes Function.

Massloads are triggered by the following:

l Executing the season entry (TK.ETSTAT.E) process (Paciolan 7 > Massload Parameters >
Massload Season Entry).

l Executing the seat creation (TK.SEAT.CREATE) process (Allocations > Seat Processing >
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Create Seats).
l Changing the Facility Map, Seat Statuses, or Price Level display parameters.

Note: Before you massload a season, you should set up the complete season. A season massload
with 20 events takes approximately 20 minutes.

Massloads require the related parts of Pac7 to be taken offline during the update process. The
related parts taken offline are determined by the type of data you are updating, including the fol-
lowing:

Data Massload Type Parts Offline Until Massload Finishes

Full All

Season Season & related events

Event seat Event

Seat map Seat map for the event

l Full massload

This process is used for the initial load of data from tRes to Pac7, after a client is installed.
This process is run by Paciolan as part of the install process and will take Pac7 offline com-
pletely for the installed client.

l Season massload

This process loads the data for a given season from tRes to Pac7. A season mass load is
triggered from tRes by the TK.ETSTAT.E process (Paciolan 7 > Massload Parameters > Mass-
load Season Entry). On the Paciolan 7 Season Status Entry screen, Pac7 changes the season
status to S when the season has successfully loaded.
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l Event seat massload

This process loads all the seats for an event, as well as the seat map for that event. The
event seat massload is triggered when a tRes user executes the create or recreate seats pro-
cess (TK.SEAT.CREATE) in tRes. The event seat massload will only be triggered if the event
belongs to a season that has been successfully loaded to Pac7. This massload updates the
seat map.xml and the seat status (for example, creating each seat with status for an event).

l Seat map massload

This process loads the seat map for an event. The seat map massload is triggered when a
tRes user changes one of the following:

l A seat status that the seat map uses
l The facility map for the event
l The display character for a price level in the event configuration

The seat map massload will only be triggered if the event for which the seat map is created
belongs to a season that has been successfully loaded to Pac7.

Data massload processes

You will do a combination of the following data massload processes:
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l Prepare for the first data massload
l Pre-Check the massload data
l Massload data
l Update types by tRes function

Preparing for the First Data Massload
After the initial setup of Pac7, you will complete a data pre-check and then massload your data. For
the pre-check and massload to be successful, make sure you have already completed this pro-
cedure to make the preparations.

To prepare for the first data massload

1. Create all seasons and events, along with their associated seat maps, that you will sell on
Pac7. At a minimum, you must create the following:

l 1 season
l 1 facility
l 1 event (you should completely setup as many events as possible before initiating a mass-
load— this will be the most efficient way to send the data)

l 1 item group
l 1 delivery method
l 1 patron policy
l 1 business account with at least 1 operator assigned
l 1 Pac7 control

2. Complete Pac7 setups for the following:

l Data account
l Patron policy
l Business account
l Pac7 control

3. Run the data pre-check.
4. Run the data massload by doing one of the following:

l If this is the initial data massload, Paciolan must perform the process. Contact Paciolan to
schedule the initial massload.

l For all subsequent season massloads, see Adding Seasons for Massloading to start the
massload.

Pre-Checking Massload Data
Note: The Pac7 release requires the conversion of the back office database from UniVerse to DB2.
The conversion to DB2 requires that your data pass this pre-check.

The data pre-check ensures that the massload of the inventory data into the Pac7 system is suc-
cessful. It must be done after creating the controls for operators, but prior to loading inventory for
the first time. In addition, the pre-check can be used to check that the data in a new season or an
item being added to the Pac7 system is setup correctly. All data errors that are found as a result of
the pre-check must be fixed before you can use Pac7 to sell the items in a season.

To perform a massload data pre-check

1. Execute the TK.TCS.PRECHECK process or, in tRes, select Paciolan 7 > Massload Parameters
> Massload Data Pre-Check. tRes displays the Massload Data Pre-Check screen.
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2. Click the Select All button. This selects all Seasonal Data, Non-Seasonal Data, tPatron Data,
and tFund Data options, as well as the eRes Email Templates and SYS Operators options.

3. Click Load Paciolan 7 Seasons to load the seasons assigned to Paciolan 7 controls.
4. In the Season table, enter all seasons that are currently being sold in the back office, as well
as any configured seasons that will be sold in the future in the back office and Pac7. Press the
F3 key to display a list of the available seasons.

5. Click Run to start the pre-check. This process takes from two to five minutes, depending
upon the number of seasons checked. After the pre-check is complete, any data errors that
were found are displayed in the Messages screen.

6. Fix all the data errors listed in the Messages screen. The errors must be fixed prior to load-
ing data into Pac7. For a list of common data check errors and their solutions, see Fixing
Data Pre-Check Errors.

7. Close the Messages screen and then, on the SB+ Dialog box, click the Continue button.

Note: If you close the messages screen before fixing the data errors, you can retrieve the
data error messages using the Message Log Inquiry screen (TK.MLOG.I). See the tRes ref-
erence topic for more information.
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8. If you fixed any errors, click repeat Steps 5 through 8 until the pre-check runs without any
errors (tRes displays this Messages screen).

Fixing Data Pre-Check Errors

The data pre-check has options for checking different types of seasonal and non-seasonal data.
Click one of the following data check options to view the associated errors and their solutions:

Seasonal Data Errors Non-Seasonal Data Errors

Adjustments (Charges, Discounts) Alert Messages

Events Business Accounts

Items Data Accounts

Manifests/Configurations/Areas Delivery Methods

Price Tables Facilities

Seat Status Codes Item Groups

Operators

Patron Management

Patron Policies

Selling Controls

Adjustment (Charges, Discounts) Errors

The Adjustment (Charges, Discounts) pre-check is for seasonal data.

l Charge table x, season s references unknown price type y
l Charge table x, season s references unknown charge code y
l Charge table x, season s references non-ticket charge code y
l Charge table x, season s has non-numeric pricing

Charge table x, season s references unknown price type y

Test failed: Verification that the price types exist in the TK.PRTYPE file.

Solution: Delete the price type on the Season Ticket Charge Table screen (execute the
TK.CTABLE.SEA.E process or, in tRes, select Maintenance > Event Templates > Charge Tables >
Season).

Charge table x, season s references unknown charge code y

Test failed: Verification that the charges exist in the TK.CHARGE file

Solutions:

Delete the ticket charge code in the Season Ticket Charge Table screen (execute the
TK.CTABLE.SEA.E process or, in tRes, select Maintenance > Event Templates > Charge Tables >
Season). This does not work if ticket charge code is already referenced in orders.
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Create the ticket charge code as inactive in the Season Ticket Charge screen (execute the
TK.CTABLE.SEA.E process or, in tRes, select Maintenance > Event Templates > Charge Tables >
Season).

Charge table x, season s references non-ticket charge code y

Solutions:

Delete the ticket charge code in the Season Ticket Charge Table screen (execute the
TK.CTABLE.SEA.E process or, in tRes, select Maintenance > Event Templates > Charge Tables >
Season). This does not work if ticket charge code is already referenced in orders.

If you cannot delete the ticket charge code, contact Paciolan Implementation Services.

Charge table x, season s has non-numeric pricing
Test failed: Verification that all of the amounts specified are numeric.

Solution: Change charges to numeric values in the Season Ticket Charge Table screen (execute the
TK.CTABLE.SEA.E process or, in tRes, select Maintenance > Event Templates > Charge Tables >
Season).

Event Errors

The Event seasonal data check verifies that all events reference valid facility fee charge codes,
facility codes, and configuration codes. These values become invalid if they are deleted from tRes,
but are still referenced by the event.

Event x, season s references unknown event group y

Solutions:

l Create the Event Group code using the Season Event Groups screen (execute the
TK.EGROUP.SEA.E process or, in tRes, select Maintenance > Event Templates > Event
Groups > Season).

l Delete the event group code in the Season Events screen (execute the TK.EVENT.SEA.E pro-
cess or, in tRes, select Maintenance > Event Templates > Events > Season > Internal).

l Change the Event Group code in the Season Events screen to an existing Event Group code
(execute the TK.EVENT.SEA.E process or, in tRes, select Maintenance > Event Templates >
Events > Season > Internal).

Event x, season s references unknown event type y

Solution:

1. Create the Event Type code in the Event Types screen (execute the TK.ETYPE.SEA.E process
or, in tRes, select Maintenance > Event Templates > Event Types).
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2. Change the Event Type code in the Season Events screen to an existing Event Type code
(execute the TK.EVENT.SEA.E process or, in tRes, select Maintenance > Event Templates >
Events > Season > Internal).

Event x, season s references unknown configuration y

Solutions:

l Make the event reference an existing configuration code in the Season Events screen
(execute the TK.EVENT.SEA.E process or, in tRes, select Maintenance > Event Templates >
Events > Season > Internal). The may not work if seats have been created.

l Create the configuration in the Season Configuration screen (execute the TK.CONFIG.SEA.E
process or, in tRes, select Maintenance > Facility Templates > Configuration Season).

Event x, season s references unknown facility y

Solution: Create the non-existent Facility in the Facilities screen (execute the TK.FACILITY.E pro-
cess or, in tRes, select Maintenance > Facility Templates > Facility). This also fixes facility
errors.

Event x, season s references unknown facility fee y

Solutions:

l Create the non-existent facility fee referenced in the error message as inactive in the Season
Facility Fee screen (execute the TK.FCHARGE.SEA.E process or, in tRes, select Maintenance
> Event Templates > Charges > Season > Fee).

l Remove reference for fees from the Season Events screen (execute the TK.EVENT.SEA.E pro-
cess or, in tRes, select Maintenance > Event Templates > Events > Season > Internal).

Item Errors

The Item seasonal data check verifies that all items reference valid ticket charge codes and price
type codes. These values become invalid if they are deleted from tRes, but are still referenced by
the item.

Item x, season s references unknown basis y

Solution: Contact Paciolan Implementation Services.

Item x, season s references unknown default charge code y

Solution:

1. Delete the Ticket Charge code in the Charges subscreen of the appropriate Item Entry
screen. To delete the code, navigate to item type screens as follows:

l For miscellaneous items, use the Season Misc Items screen (execute the TK.IMISC.SEA.E
process or, in tRes, select Maintenance > Event Templates > Items > Season > Mis-
cellaneous).

l For gift certificate items, use the Season Gift Certificates screen (execute the
TK.IGC.SEA.E process or, in tRes, select Maintenance > Event Templates > Items >
Season > Gift Certificate).

l For access pass items, use the Access Passes screen (execute the TK.IAPASS.SEA.E pro-
cess or, in tRes, select Maintenance > Event Templates > Items > Season > Access
Pass).

2. Create the Ticket Charge code as Inactive on the Season Ticket Charge screen (execute the
TK.TCHARGE.SEA.E process or, in tRes, select Maintenance > Event Templates > Charges >
Season > Ticket).

Item x, season s references unknown price detail y
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Solution: Contact Paciolan Implementation Services.

Price detail x, season s references unknown charge code y

Solutions:

l Delete the charge code using the Season Events screen (execute the TK.EVENT.SEA.E pro-
cess or, in tRes, select Maintenance > Event Templates > Events > Season > Internal).
On that screen, click the Tcharge by PL/PT button to display and delete charges for the
event.

l Create the ticket charge code on the Season Ticket Charge screen (execute the
TK.TCHARGE.SEA.E process or, in tRes, select Maintenance > Event Templates > Charges
> Season > Ticket), and make the non-existent code inactive.

Price detail x, season s references unknown discount y

Solutions:

l Delete the discount code by doing one of the following:

l For a single event item:

i. Open the event on the Season Events screen (execute the TK.EVENT.SEA.E process or,
in tRes, select Maintenance > Event Templates > Events > Season > Internal), and
then click the Item Misc button to display the Item Miscellaneous subscreen.

ii. Select the Price Level:Price Type referred to in the error, and then click the detail icon.
In the Disc Not Available or the Disc Available list, delete the discount code.

l For a combo item:

i. Open the combo item on the Season Combo Items screen (execute the
TK.COMBO.SEA.E process or, in tRes, select Maintenance > Event Templates > Items
> Season > Combo), and then click the Misc button to display the Item Miscellaneous
subscreen.

ii. Select the Price Level:Price Type referred to in the error, and then click the detail icon.
In the Unavail Discounts or the Avail Discounts list, delete the discount code.

l Create the Discount code as Inactive on the Season Discount screen (execute the
TK.DISC.SEA.E process or, in tRes, select Maintenance > Event Templates > Discounts >
Season).

Price detail x, season s references unknown price type y

Solution: Create the Price Type code as Inactive and with a sort order of 999 on the Season
Price Types screen (execute the TK.PRTYPE.SEA.E process or, in tRes, select Maintenance >
Event Templates > Price Types > Season).

Season: Item s : x references non-existent Pdetail key x : n : GQ

Solution: In this error, n = line number. Below are examples of this error:

l Season: Item FOXBWY0405 : FOX13MARM references non-existent Pdetail key
FOX13MARM : 1 : GQ

l Season: Item FOXBWY0405 : FOX13MARM references non-existent Pdetail key
FOX13MARM : 2 : GQ

For these examples, fix the error as follows:

a. From the uniVerse shell, edit the item record as follows:

>ED TK.ITEM.FOXBWY0405 FOX13MARM

95 lines long.
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b. Navigate to field #26, which contains the list of price detail keys:

----: 26

and remove the non-existent price detail key with the following command:

----: R/^253FOX13MARM:1:GQ//

Repeat this command for each non-existent price detail key.

c. Save the item record with:

----: FI

"FOX13MARM" filed in file "TK.ITEM.FOXBWY0405".

Repeat for each event.

Manifests/Configurations/Areas Errors

The Manifests/Configurations/Areas pre-check is for seasonal data.

Area x, season s references unknown facility x

Test failed: Verification that the Facility specified in the Area exists in the TK.FACILITY file.

Solution: Delete the facility from the manifest on the Season Areas screen (execute the
TK.AREA.SEA.E process or, in tRes, select Maintenance > Facility Templates > Areas >
Season).

Area x, season s references unknown manifest y

Solutions:

l Delete the manifest from the area on the Season Areas screen (execute the TK.AREA.SEA.E
process or, in tRes, select Maintenance > Facility Templates > Areas > Season).

l Create the manifest on the Season Manifests screen (execute the TK.MANIFEST.SEA.E pro-
cess or, in tRes, select Maintenance > Facility Templates > Manifests > Season > Maintain to
open the screen).

Configuration x, season s references unknown area y

Solution: Same solutions as in old stuff for Facility Data, error Season:Config xxx:yyy references
non-existent area: xx:aaa.

Configuration x, season s references unknown facility y

Solution: Same solutions as in old stuff for Facility Data, error Season:Config xx:yy reference non-
existent facility code ff.

Manifest x, season s references unknown facility y

Test failed: Verification that the facility specified in the Manifest exists in the TK.FACILITY file.

Solution: Delete facility from manifest.

Manifest x, season s does not have row allocation defined

Test failed: Verification that all of the levels and sections specified in the area exist in the
TK.MANIFEST file.

Solution: Set up the row allocation order in the Alloc Order subscreen of the Season Manifests
screen (execute the TK.MANIFEST.SEA.E process or, in tRes, select Maintenance > Facility Tem-
plates > Manifests > Season > Maintain to open the screen).
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Manifest 'abc:x:y', season '1234:' does not have row allocation defined

Solution:

Complete the following procedure:

1. Execute the TK.MANIFEST.SEA.E process or, in tRes, select Maintenance > Facility Tem-
plates > Manifests > Season > Maintain. tRes displays the Season Manifests screen.

2. At the prompt for season, enter the season code from the error code ('1234').
3. At the prompt for facility, enter the facility code from the error code ('abc').
4. At the prompt for level, enter the level code from the error code ('x').
5. At the prompt for section, enter the section code from the error code ('y').
6. Click the F6-Alloc Order button, and then select one of the Auto Sort Options from the screen.
7. Click F2-Accept, and then click F2-Save.

Manifest x, season s references unknown area y

Test failed: Verification that all of the areas specified in the configuration exist in the TK.AREA file.

Solution: Delete the area from the season on the Season Areas screen (execute the TK.AREA.SEA.E
process or, in tRes, select Maintenance > Facility Templates > Areas > Season).

Price Table Errors

Price Table seasonal data check verifies that all price tables reference valid price type codes. The
price type code can become invalid if it is deleted.

Price table x, season s references unknown price type y

Solutions:

l Delete the price table in the Season Price Table screen (execute the TK.PTABLE.SEA.E pro-
cess or, in tRes, select Maintenance > Event Templates > Price Tables > Season to open the
screen). This does not work if there are items referencing the price table.

l Create the Price Type code as Inactive and with a sort order of 999 in the Season Price Type
screen (execute the TK.PRTYPE.SEA.E process or, in tRes, select Maintenance > Event Tem-
plates > Price Types > Season to open the screen).

Seat Status Code Errors

Seat Status Code seasonal data check verifies that all the standard seat statuses exist: H (Held), K
(Killed), O (Open), T (Customer Hold), and X (Allocated).

Seat status x, season s does not exist

Solution: Create the non-existent seat status in the Seat Statuses screen (execute the
TK.SSTAT.E process or, in tRes, select Maintenance > Other Parameters > Seat Statuses to
open the screen).

Alert Message Errors

Alert message non-seasonal data check verifies that all alert messages reference valid seller
codes.

Alert message x does not reference any business accounts
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Solution: Add a valid code to the Business Account list on the Paciolan 7 Alert Messages screen
(execute the TK.TALERT.E process or, in tRes, select Paciolan 7 > General Setups > Alert Mes-
sages to open the screen).

Alert message x references unknown business account y

Solution: Delete the Alert Code using the Paciolan 7 Alert Messages screen (execute the
TK.TALERT.E process or, in tRes, select Paciolan 7 > General Setups > Alert Messages to open
the screen).

Business Account Errors

The Business Account pre-check is for non-seasonal data.

Business account x references unknown operator (user i.d.) y

Test failed: Verification that all of the operators specified in the business account exist in the
SYS.OPERATOR file.

Solution: Remove the operator code from the Operators subscreen on the Paciolan 7 Business
Accounts screen (execute the TK.BA.E process or, in tRes, select Paciolan 7 > General Setups >
Business Accounts to open the screen).

Business account x references an unknown adjustment options business account

Test failed: Verification that all of the business accounts available to view specified for the busi-
ness account exist in the TK.BA file.

Solution: Delete the business account on Adjustment Options subscreen of the Paciolan 7 Busi-
ness Accounts screen (execute the TK.BA.E process or, in tRes, select Paciolan 7 > General
Setups > Business Accounts to open the screen).

Data Account Errors

The data account pre-check is for non-seasonal data.

No description has been assigned to this data account

Failed test: Verification that there is a description in the data account.

Solution: Enter a data account description in the Description field on the Paciolan 7 Data Account
Setup screen (execute the TK.TSETUP process or, in tRes, select Paciolan 7 > General Setups >
Data Account to open the screen).

No primary language I.D. has been assigned to this data account

Failed test: Verification that a primary language ID has been assigned to the data account.

Solution: Contact Paciolan Implementation Services.

Language code x name y is duplicated

Failed test: Verification that there are no duplicate language codes in the PD.LANGUAGE file.

Solution: Delete the duplicated language code on the Language Code Entry screen (execute the
PD.LANGUAGE.E process or, in tPatron, select Maintenance > Biographical Parameters > Lan-
guage Codes to open the screen).
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Delivery Method Errors

Delivery method non-seasonal data check verifies that all delivery methods reference valid order
charges.

Delivery method x references unknown charge code y

Solution: Remove the charge code from the delivery method on the Item Sales Delivery Meth-
ods screen (execute the TK.TDMETH.E process or, in tRes, select Paciolan 7 > Selling Setup >
Delivery Method to open the screen).

Facilities Errors

Facility non-seasonal data check verifies that all manifests (level:sections), configurations, and
areas reference valid facility codes.

Facility x does not reference a time zone

Solution: Add the correct time zone to the facility in the Address subscreen in the Facilities
screen (execute the TK.FACILITY.E process or, in tRes, select Maintenance > Facility Templates
> Facilities > Address to open the screen). Select the correct time zone so that events will not
display at the wrong time.

Item Group Errors

Item group non-seasonal data check verifies that all item groups reference valid item codes.

Operator Errors

Operator non-seasonal data check verifies that all operators reference valid seat status codes and
price type codes.

Operator x is not defined as a system operator

Solution: Create the operator code as a system operator on the Operator Access screen
(execute the SYS.OP.E process or, in tRes, select File > System Functions > Operators > Oper-
ator Access to open the screen).

Operator x, season s references unknown price type y

Solutions:

l Create the price type code as inactive and with a sort order of 999 on the Season Price
Type screen (execute the TK.PRTYPE.SEA.E process or, in tRes, select Maintenance >
Event Templates > Price Types > Season to open the screen.

l Remove the price type from the operator code on the Operator Access screen (execute
the TK.OP.E process or, in tRes, select Paciolan 7 > Patron Setup > Shortcut to Operator
Access to open the screen).

Operator x, season s references unknown seat status y

Solution: Remove the non-existent seat status from the operator code on the Operator Access
screen (execute the TK.OP.E process or, in tRes, select Paciolan 7 > Patron Setup > Shortcut to
Operator Access). If you cannot locate the operator code associated with the non-existent seat
status, create the operator code in SYS.OP.E, so that you are able to access the operator code in
TK.OP.E, then do one of the following:

Pac7 Release 7.2



User Guide  162

l Fix the TK.OP.E error, if still required.
l Delete the TK.OP.E operator code, then delete the SYS.OP.E operator code, if it is no
longer used.

l Create the non-existent seat status in the Seat Statuses screen (execute the TK.SSTAT.E
process or, in tRes, select Maintenance > Other > Seat Statuses to open the screen).

Patron Management Errors

The patron management pre-check is for non-seasonal data.

Patron Management x references invalid operator code y

Test failed: Verification that all of the operator codes specified exist in the TK.OPERATOR file.

Solution: Delete the operator code from the Operator field on the Patron Management Control
screen (execute the TK.PMGMT.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron
Management Control).

Patron Management x references an invalid Patron Policy Code y

Test failed: Verification that the patron policy code specified exists in the TK.PPOLICY file.

Solution: Change the patron policy code in the Policy field of the Patron Management Control
screen (execute the TK.PMGMT.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron
Management Control).

Patron Policy Errors

The patron policy pre-check is for non-seasonal data.

l Patron policy x references invalid ticketing type y
l Patron policy x references invalid organization type y
l Patron policy x references invalid status code y
l Patron policy x references invalid source code y
l Patron policy x references invalid ticketing status code y
l Patron policy x additional settings phone types references invalid phone type y
l Patron policy x additional settings address types references invalid address type y
l Patron policy x override shipping address references invalid address type y
l Patron policy x override billing address references invalid address type y
l Patron policy x patron search options references invalid phone type y
l Patron policy x patron search options references invalid address type y
l Patron policy x other patron attributes references invalid donor code y
l Patron policy x other patron attributes references invalid donor type y
l Patron policy x other patron attributes references invalid address type y
l Patron policy x other patron attributes references invalid phone type y
l Patron policy x other patron attributes references invalid accessible salutation type y
l Patron policy x other patron attributes references invalid accessible VIP code y

Patron policy x references invalid ticketing type y

Test failed: Verification that the ticketing type specified exists in the TK.CTYPE file.

Solution: Enter a valid ticketing type in the Ticketing Type field on the Patron Policy screen
(execute the TK.PPOLICY.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron
Policy).
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Patron policy x references invalid organization type y

Test failed: Verification that the organization type specified exists in the PD.OTYPE file.

Solution: Enter a valid organization type in the Organization Type field on the Patron Policy
screen (execute the TK.PPOLICY.E process or, in tRes, select Paciolan 7 > Patron Setup > Pat-
ron Policy).

Patron policy x references invalid status code y

Test failed: Verification that the patron status type exists in the PD.STATUS file.

Solution: Enter a valid patron status in the Patron Status field on the Patron Policy screen
(execute the TK.PPOLICY.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron
Policy).

Patron policy x references invalid source code y

Test failed: Verification that the patron source exists in the PD.SOURCE file.

Solution: Enter a valid patron source in the Patron Source field on the Patron Policy screen
(execute the TK.PPOLICY.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron
Policy).

Patron policy x references invalid ticketing status code y

Test failed: Verification that the ticket status exists in the TK.STATUS file.

Solution: Enter a valid ticketing status in the Ticketing Status field on the Patron Policy screen
(execute the TK.PPOLICY.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron
Policy).

Patron policy x additional settings phone types references invalid phone type y

Test failed: Verification that all of the additional settings phone/email types specified exist in
the PD.PTYPE file.

Solution: Delete the invalid phone type from the Accessible Phone/Email Types list on the Addi-
tional Settings subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process or, in
tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Additional Settings but-
ton).

Patron policy x additional settings address types references invalid address type y

Test failed: Verification that the additional settings address types specified exist in the
PD.ATYPE file

Solution: Delete the invalid address type from the Accessible Address Types list on the Addi-
tional Settings subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process or, in
tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Additional Settings but-
ton).

Patron policy x override shipping address references invalid address type y

Test failed: Verification that the additional settings override shipping address types specified
exist in the PD.ATYPE file.

Solutions:

l Delete Shipping Address type key in the Default Shipping Address Type field on the Addi-
tional Settings subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process
or, in tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Additional
Settings button).
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l Enter a valid shipping address type in the Default Shipping Address Type field on the Addi-
tional Settings subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process
or, in tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Additional
Settings button).

Patron policy x override billing address references invalid address type y

Test failed: Verification that the additional settings override billing address type exists in the
PD.ATYPE file.

Solution: Enter a valid billing address type in the Default Billing Address Type field on the Addi-
tional Settings subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process or, in
tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Additional Settings but-
ton).

Patron policy x patron search options references invalid phone type y

Tests failed: Verification that the additional settings and patron search options phone types spe-
cified exist in the PD.PTYPE file.

Solution: Enter a valid phone number type in the Phone Number text field on the Patron Search
Options subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process or, in tRes,
select Paciolan 7 > Patron Setup > Patron Policy, and then click the Patron Search Options but-
ton).

Patron policy x patron search options references invalid address type y

Tests failed: Verification that the patron search option types for email address, shipping
address, and billing address exist in the PD.ATYPE file.

Solution: Enter a valid address type in the Email Address, Shipping Address, or Billing Address
text field on the Patron Search Options subscreen of the Patron Policy screen (execute the
TK.PPOLICY.E process or, in tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then
click the Patron Search Options button). The invalid address type to replace is indicated in the
error message.

Patron policy x other patron attributes references invalid donor code y

Test failed: Verification that the other patron attributes donor code exists in the FD.MCODE file.

Solution: Delete the invalid donor mail code from the Donor Mail Code field on the Other Patron
Attributes subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process or, in tRes,
select Paciolan 7 > Patron Setup > Patron Policy, and then click the Other Patron Attributes but-
ton). If you require a donor mail code for fund development, enter a valid code in the field.

Patron policy x other patron attributes references invalid donor type y

Test failed: Verification that the other patron attributes donor type exists in the FD.TYPE file.

Solution: Delete the invalid donor type code from the Donor Type field on the Other Patron
Attributes subscreen of the Patron Policy screen (execute the TK.PPOLICY.E process or, in tRes,
select Paciolan 7 > Patron Setup > Patron Policy, and then click the Other Patron Attributes but-
ton). If you require a donor type code for fund development, enter a valid code in the field.

Patron policy x other patron attributes references invalid address type y

Test failed: Verification that the other patron attributes organization address type exists in the
PD.ATYPE file.

Solution: Delete the invalid organization address type code from the Org Address Type field on
the Other Patron Attributes subscreen of the Patron Policy screen (execute the TK.PPOLICY.E pro-
cess or, in tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Other Pat-
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ron Attributes button). If you add new patrons that are organization types, enter a valid code in
the field.

Patron policy x other patron attributes references invalid phone type y

Test failed: Verification that the other patron attributes organization phone type exists in the
PD.PTYPE file.

Solution: Delete the invalid organization phone type code from the Org Phone Type field on the
Other Patron Attributes subscreen of the Patron Policy screen (execute the TK.PPOLICY.E pro-
cess or, in tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Other Pat-
ron Attributes button). If you add new patrons that are organization types, enter a valid code in
the field.

Patron policy x other patron attributes references invalid accessible salutation type y

Test failed: Verification that the other patron attributes salutation types exist in the PD.STYPE
file.

Solution: Delete the invalid salutation type code from the Accessible Salutation Types list on the
Other Patron Attributes subscreen of the Patron Policy screen (execute the TK.PPOLICY.E pro-
cess or, in tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Other Pat-
ron Attributes button).

Patron policy x other patron attributes references invalid accessible VIP code y

Test failed: Verification that the other patron attributes VIP’s specified exist in the PD.VIP file.

Solution: Delete VIP Code key. Delete the invalid VIP code from the Accessible VIP Codes list on
the Other Patron Attributes subscreen of the Patron Policy screen (execute the TK.PPOLICY.E pro-
cess or, in tRes, select Paciolan 7 > Patron Setup > Patron Policy, and then click the Other Pat-
ron Attributes button).
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Selling Control Errors

Control non-seasonal data check verifies that all controls reference valid order charge codes, ticket
charge codes, seller codes, delivery method codes, seat status codes, item/event codes, item
group codes, payment mode codes, price type codes, and operator codes.

l ET control x references unknown delivery method y
l ET control x references unknown item group y
l ET control x references unknown paymode y
l ET control x references unknown selling operator y
l ET control x references unknown sale code y
l ET control x, operator o references unknown house customer y
l ET control x, season s references unknown charge y
l ET control x, season s references unknown item y
l ET control x, season s references unknown price type y
l ET control x, season s references unknown seat status y
l WBST control x references unknown delivery method y
l WBST control x references unknown item group y
l WBST control x references unknown paymode y
l WBST control x references unknown selling operator y
l WBST control x references unknown sale code y
l WBST control x, operator o references unknown house customer y
l WBST control x, season s references unknown charge y
l WBST control x, season s references unknown item y
l WBST control x, season s references unknown price type y
l WBST control x, season s references unknown seat status y

ET control x references unknown delivery method y
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Solution: Remove the delivery method from the control in the Paciolan Controls screen (execute
the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paciolan 7 Con-
trols to open the screen).

ET control x references unknown item group y

Solution: Remove the item group from the control in the Paciolan 7 Controls screen (execute the
TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paciolan 7 Controls to
open the screen).

ET control x references unknown paymode y

Solution: Remove the paymode from the control in the Payment Options screen in the Paciolan 7
Controls screen (TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paci-
olan 7 Controls to open the screen).

ET control x references unknown selling operator y

Solution: Remove the operator code from the control in the Paciolan 7 Controls screen (execute
the TK.ETCONTROL.E). Select Paciolan 7 > Selling Setups > Paciolan 7 Controls to open the
screen.

ET control x references unknown sale code y

Solutions:

l Remove the sale code from the control in the Paciolan 7 Controls screen (execute the
TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paciolan 7 Con-
trols to open the screen).

l Create the sale code in the Sales Code screen (execute the TK.SALECODE.E process or, in
tRes, select Maintenance > Other Parameters > Sale Codes to open the screen).

ET control x, operator o references unknown house customer y

Solutions:

l Replace the house customer with an existing house customer in the Paciolan 7 Controls
screen (execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling
Setups > Paciolan 7 Controls to open the screen).

l Create the house customer in the House Customer Entry screen (execute the TK.HCUST.E
process or, in tRes, select Customers > Entry > House to open the screen).

ET control x, season s references unknown charge y

Solution: Remove the order charge code and/or the default ticket charge code from the General
Sales Options and/or On Sales Options season detail screen in the Paciolan 7 Controls screen
(execute the TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paciolan
7 Controls to open the screen).

ET control x, season s references unknown item y

Solution: Remove the item code from the General Sales Options and/or On Sales Options season
detail screen in the Paciolan 7 Controls screen (execute the TK.ETCONTROL.E process or, in
tRes, select Paciolan 7 > Selling Setups > Paciolan 7 Controls to open the screen).

ET control x, season s references unknown price type y

Solutions:

l Remove the price type code from the General Sales Options and/or On Sales Options sea-
son detail, item detail screen in the Paciolan 7 Controls screen (execute the
TK.ETCONTROL.E process or, in tRes, select Paciolan 7 > Selling Setups > Paciolan 7
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Controls to open the screen).
l Create the price type code as Inactive and with a sort order of 999 in the Season Price
Type screen (execute the TK.PRTYPE.SEA.E process or, in tRes, select Maintenance >
Event Templates > Price Types > Season to open the screen).

ET control x, season s references unknown seat status y

Solution: Remove the seat status codes from the control, General Sales Options > Season Detail
screen and/or On-Sale Options > Season Detail screen (execute the TK.ETCONTROL.E process
or, in tRes, select Paciolan 7 > Selling Setups > WBST Controls to open the screen).

WBST control x references unknown delivery method y

Solution: Remove the delivery method from the control in the Web-Based Sales Terminal Con-
trols screen (execute the TK.TCONTROL.E process or, in tRes, select Maintenance > System >
WBST & Paciolan 7 > Control to open the screen).

WBST control x references unknown item group y

Solution: Remove the item group from the control in the Item Group screen in the Web-Based
Sales Terminal Controls screen (execute the TK.TCONTROL.E process or, in tRes, select Main-
tenance > System > WBST & Paciolan 7 > Control to open the screen).

WBST control x references unknown paymode y

Solution: Remove the paymode from the control in the Payment Options screen in the Web-
Based Sales Terminal Controls screen (execute the TK.TCONTROL.E process or, in tRes, select
Maintenance > System > WBST & Paciolan 7 > Control to open the screen).

WBST control x references unknown selling operator y

Solutions:

l Remove the operator code from the control in the Web-Based Sales Terminal Controls
screen (execute the TK.TCONTROL.E process or, in tRes, select Maintenance > System >
WBST & Paciolan 7 > Control to open the screen).

l Delete the control in the Web-Based Sales Terminal Controls screen (execute the
TK.TCONTROL.E process or, in tRes, select Maintenance > System > WBST & Paciolan 7 >
Control to open the screen).

l Change the control to reference the correct seller code in the Web-Based Sales Terminal
Controls screen (execute the TK.TCONTROL.E process or, in tRes, select Maintenance >
System > WBST & Paciolan 7 > Control to open the screen).

WBST control x references unknown sale code y

Solutions:

l Replace the sale code with an existing sale code in the Web-Based Sales Terminal Con-
trols screen (execute the TK.TCONTROL.E process or, in tRes, select Paciolan 7 > Selling
Setups > WBST Controls to open the screen).

l Create the sale code in the Sales Code screen (execute the TK.SALECODE.E process or, in
tRes, select Maintenance > Other Parameters > Sale Codes to open the screen).

WBST control x, operator o references unknown house customer y

Solutions:

l Replace the house customer with an existing house customer in the Web-Based Sales Ter-
minals Controls screen (execute the TK.TCONTROL.E process or, in tRes, select Paciolan 7
> Selling Setups > WBST Controls to open the screen).
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l Create the house customer in the House Customer Entry screen (execute the TK.HCUST.E
process or, in tRes, select Customers > Entry > House to open the screen).

WBST control x, season s references unknown charge y

Solution: Remove the charge code from the season in the Web-Based Sales Terminal Controls
screen (execute the TK.TCONTROL.E process or, in tRes, select Maintenance > System > WBST
& Paciolan 7 > Control to open the screen).

WBST control x, season s references unknown item y

Solution: Remove the item code from the control in the Season screen in the Web-Based Sales
Terminal Controls screen (execute the TK.TCONTROL.E process or, in tRes, select Maintenance
> System > WBST & Paciolan 7 > Control to open the screen).

WBST control x, season s references unknown price type y

Solutions:

l Remove the price type code from the item in the control in the Season and Item screens
in the Web-Based Sales Terminal Controls screen (execute the TK.TCONTROL.E process
or, in tRes, select Maintenance > System > WBST & Paciolan 7 > Control to open the
screen).

l Create the price type code as Inactive and with a sort order of 999 in the Season Price
Type screen (execute the TK.PRTYPE.SEA.E process or, in tRes, select Maintenance >
Event Templates > Price Types > Season).

WBST control x, season s references unknown seat status y

Solution: Remove the seat status code from the control, Seat Search Options sub-screen in the
Web-Based Sales Terminal Controls screen (execute the TK.TCONTROL.E process or, in tRes,
select Maintenance > System > WBST & Paciolan 7 > Control to open the screen).
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Massloading Data
Note: Contact Paciolan Implementation Services for assistance with performing data massloads.

When the massload process starts, tRes automatically runs the massload data pre-check for all sea-
sons with a status of I (Load Initialize). Season statuses include:

l F = Massload Failed
l I = Initialize
l P = Massload in Progress
l S = Massload Successful
l X = Do Not Initialize

The data pre-check is run with all data pre-check options selected (the ones listed on the Massload
Data Pre-Check screen). If the data pre-check generates errors, tRes will stop the massload pro-
cess. You will need to fix the data pre-check errors or remove the seasons that are generating
them, before tRes will complete the massload.

Note: After starting a massload of season data, you can view the massload status for the data
account. In addition to season massloads, this view also includes event and seat map massload
status information.

To massload season data to the Pac7 system

1. Execute the TK.ETSTAT.E process or, in tRes, select Paciolan 7 > Massload Parameters >
Massload Season Entry. tRes displays the Paciolan 7 Season Status Entry screen.
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2. Make sure that all the seasons whose data you need to massload are listed on this screen
with status I. If any seasons are missing, you need to add the seasons.

3. Click Massload New. tRes displays all seasons that are eligible for massload (status = I) on
the New Seasons to Massload screen.

Seasons may be removed from, but not added to this list.
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4. Click Accept, and then Click Yes on the SB+ Dialog.

Once the massload has been initiated, tRes changes the season statuses to P (Load in Pro-
gress) and indicates the massload has been initiated by displaying another SB+ Dialog.

Note: If the system encounters errors during the massload, it will stop loading the seasons
that generated the errors. tRes changes the status to Massload Failed (F), for each season
with errors. To finish the season massloads, you will need to fix the errors or remove the sea-
sons with errors from the list on the Paciolan 7 Season Status Entry screen. Then, click Retry
Massload and fix errors until tRes completes the massload with no errors.

Data Update Types by tRes Function
Different tRes functions require specific data update types (massload type or data synchronization)
to move data changes from tRes to Pac7. Click an area in the list below to see a breakdown of the
functions and their data update type requirements.

Facility

tRes Function Data Update Type

Facility Map Seat map massload

Manifest Data sync

Seat Statuses Data sync or seat map mass-
load

Change to Text for Existing Status Data sync

Add New Seat Status Seat map massload

Modify Display Characteristics of Existing Seat Status (e.g.,
color)

Seat map massload

Areas Data sync

Configurations Data sync

Seasons

tRes Function Data Update Type

Seasons Season massload
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tRes Function Data Update Type

Season status Data sync

Price types & tables Data sync or *event seat massload

Charges & tables Data sync

Event Groups Data sync

Promotions Data sync

Events

tRes Function Data Update Type

Event setup

General Data (time, date) Data sync

Print Info Data sync

Item Print Info Data sync

Item Misc Data sync

Item Sale Dates Data sync

Item Charge Table (PL/PT) Data sync

Seat creation/configuration Event seat massload

Pac7 system maintenance

tRes Function Data Update Type

Inventory owner setup Data sync

Item groups Data sync

Delivery methods Data sync

Level:section conversions Data sync

Sellers Data sync

Control records Data sync

Item groups Data sync

Payment options Data sync

Print/log options Data sync

Customer options Data sync

Seat search options Data sync

Delivery methods Data sync

Adding operators to control Data sync

Alert messages

Alert message changes require a data sync.

Adding Seasons Overview
For initial setup, you need to have created a data account, a patron policy, and at least one busi-
ness account with a list of operators. You also must have assigned seasons to controls, so that oper-
ators can sell from them.
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During initial setup, tRes makes all seasons with an Open ticketing status available to add for the
massloading process. When you add seasons, tRes will set the status of the seasons you add to I or
Initialize (New). Paciolan Implementation Services will massload all seasons with I status during
the initial massload process.

Season statuses include:

l F = Massload Failed
l I = Initialize
l P = Massload in Progress
l S = Massload Successful
l X = Do Not Initialize

Once the initial massload is complete, the system is in maintenance mode, and you will be able to
add seasons with a status of S (Massload Successful) to controls. If you want to add seasons to a
control that were not included in the initial massload, you must first add those seasons and initiate
another massload.

Note: If you want to know a season's massload status, you can perform a season status inquiry.

Adding Seasons
Use the procedure below to add the seasons that you want to massload into the system. tRes
makes all seasons with an Open ticketing status available to add for the massloading process.
When you display this screen, Pac7 lists all seasons that have been assigned a Pac7 status code,
along with their current statuses. When you are finished adding seasons, Paciolan Implementation
Services uses this screen to massload seasons into Pac7.

Note: When you run a season data massload, tRes automatically runs a data pre-check using the
settings on the Massload Data Pre-Check screen. tRes must run this process without errors before
any seasons can be massloaded.

To add seasons for massloading

1. Execute the TK.ETSTAT.E process or, in tRes, select Paciolan 7 > Massload Parameters >
Massload Season Entry. tRes displays the Paciolan 7 Season Status Entry screen.
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2. In the Season column, enter the season codes of the seasons you want to massload. The
status code for added seasons defaults to I or Initialize (New).

Note: For descriptions of the controls on this screen, see the Paciolan 7 Season Status Entry
Screen reference topic.

3. When you are ready to load these seasons into the system, contact Paciolan Implementation
Services for assistance.

Performing a Season Status Inquiry
Use the procedure below to view a display-only grid of the season code, season name, Pac7 status
code, and Pac7 status name for all seasons that have been entered into the system. If you need to
enter additional seasons, see Adding Seasons.

To perform a season status inquiry

1. From the File menu, select Execute Process. tRes displays the SB+ Prompt screen.
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2. In Process, enter TK.ETSTAT.I, and then click Accept. tRes displays the Enterprise Ticketing
Season Status Inquiry screen.

3. If you add seasons or change season status on the Paciolan 7 Season Status Entry screen,
click Refresh on this screen to display the latest information.

Supported Print Form Variables
The tables below list all the predefined variables you can use with Pac7 print forms. Variables, in
conjunction with conditions, determine what prints on forms. Any alphanumeric characters you
enter in quotes into the variable field are printed verbatim with the print form. For example, if you
enter "VOID" in a ticket variable field, the characters VOID will print out on tickets that use forms
with that variable.

You can use allocatable, non-allocatable, receipt, and mailer form types to print from Pac7 with the
following variables:

Allocatable

Variable Description
ACT Activity code associated to season of tickets being printed
ACUST Item associated customer number
AISLE Aisle seat indicator. “*  ” = on left aisle; “ *” = on right aisle; “” = not on aisle
AISLE.LT Left aisle indicator. “*” if AISLE = “* “ else “”
AISLE.RT Right aisle indicator. “*” if AISLE = “ *” else “”
ANAME Activity name
ATYPE Item address Type
BARCODE Barcode of seat
BATCH Print batch number
BOX BOCA Box graphic

CADDR1 The standard mail address type address line 1 for CNUMBER. See Setting Up
Standard Address Type Data.

CADDR2 The standard mail address type address line 2 for CNUMBER. See Setting Up
Standard Address Type Data.

CADDR3 The standard mail address type address line 3 for CNUMBER. See Setting Up
Standard Address Type Data.
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Variable Description

CADDR4 The standard mail address type address line 4 for CNUMBER. See Setting Up
Standard Address Type Data.

CCSZ The standard mail address type city, state, zip for CNUMBER. See Setting Up
Standard Address Type Data.

CDMNAME The default mail name for CNUMBER (PAT.MNAME)
PAC7.CLIENTID Pac7 client ID
PAC7.LOC Pac7 location
PAC7.NUMBER Pac7 item sales order number
PAC7.ORG Pac7 organization ID
PAC7.TCONTROLPac7 ticketing control
PAC7.USERID Pac7 user ID
PAC7.CLIENTID Pac7 client ID

CMNAME The standard mail address type mail name for CNUMBER. See Setting Up
Standard Address Type Data.

CNAME The name associated to CNUMBER in format LAST, FIRST (PAT.NAME)
CNAME2 The second name associated to CNUMBER in format LAST, FIRST (PAT.NAME2)

CNUMBER
Customer Number. If the order line references an associated customer, then
ONUMBER = actual order number and CNUMBER = associated customer num-
ber. If not, ONUMBER = CNUMBER.

COUNTRY The standard mail address country code for CNUMBER. See Setting Up Stand-
ard Address Type Data.

COUNTRY.NAME The name associated to the standard mail address type country code forCNUMBER. See Setting Up Standard Address Type Data.
CPRI Customer priority for customer being printed
CTNAME Name associated with customer name
CTYPE Customer type code for customer being printed

CXNAME The name in external format associated to CNUMBER in format TITLE FIRST
LAST (PAT.NAME, PAT.TITL)

CXNAME2 The second name in external format associated to CNUMBER in format TITLE
FIRST LAST (PAT.NAME2, PAT.TITL2)

DATE Today’s Date
DAY Today’s day of week in alpha format
DEVICE Output print device “BOCA”
DISP Item disposition code
DISP.NAME Item disposition name

EAPRICE Event accounting amount. Free format money field. Only used for printing pur-
poses

ECATG Event category. Set to ITEM:PL:PT category if not null, else set to
ITEM:PRICETYPE category

ECODE Event Code
ECPRICE Event item charge price
EDATE Event date
EDATE.END The end date of a multi-day event
ETIME.END The end time in 12-hour format for a multi-day event
EDAY Event day of week
EFAC Event facility code
EFEE Event fee amount. Free format money field. Only used for printing purposes
EFNAME Facility name
EITIME Event time in Universe internal format
EMONTHL Event month in alpha format all lower case
EMONTHT Event month in alpha format 2+letters lower case
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Variable Description
EMONTHU Event month in alpha format all upper case
EMSG Event ticket print message
ENAME Event name
EPL Price level code
EPPRICE Event print price.  Free format money field. Only used for printing purposes
EPRICE Event price
ETAX Event tax amount. Free format money field. Only used for printing purposes
ETIME Event Time 12-hour format or “TBA”
ETPRICE Event total tax amount. EPPRICE + ETAX
EVENT Event Code
FORM Print form code
GATE Event seatblock gate
HLINE BOCA horizontal line graphic
I.CHG Item charge code
I.CHG.NAME Item charge name
I.DISC Item discount code
I.DISC.NAME Item discount name
I.FMT Item format code
I.PT.FMT
I.SCHG Item surcharge code
I.SCHG.NAME Item Surcharge Code Name
IBASIS Item basis S,C
ICLASS Item class code
ICLASS.NAME Name associated to item class code
IEPLPT ITEM:EPL:PT
IMSG Item:PT message
IPRICE Item price of item being printed
ITEM Item code
LEV Level code
LSN Name associated to FAC:LEVEL:SECTION of seatblock
MARK Item mark code
MONTHL Today’s month in alpha format all lower case
MONTHT Today’s month in alpha format 2+letters lower case
MONTHU Today’s month in alpha format all upper case
MSHIPS List of customer memberships separated by comma “,”
NEVENTS Number of event associated to Item being printed

ONAME
This is the primary customer name (owner of the order being
printed). NUMBER (customer being printed) is = to ONUMBER except in cases
where associated customer is being printed 

ONUMBER
This is the primary customer number (owner of the order being
printed). NUMBER (customer being printed) is = to ONUMBER except in cases
where associated customer is being printed 

PB Print batch info (Transaction.Sequence.Print.Sequence)
PLINE1 Event print line 1
PLINE2 Event print line 2
PLINE3 Event print line 3
PLINE4 Event print line 4
PLINE5 Event print line 5
PLINE6 Event print line 6
PLINE7 Event print line 7
PLINE8 Event print line 8
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Variable Description
PLINE9 Event print line 9
PSNAME Previous seat stat name
PSTAT Previous open status of seat
PT Price type code
PTNAME Name associated to price type
REPRINT Reprint flag (True/False 1/0)
ROW Row
SBL LEV:SECT:ROW:SEAT
SEASON Season code
SEAT Seat
SEATING Event seating type “R” “G” “S”
SECT Section code
SNAME Season name
SPEC Item special handling
STOCK Stock code tickets printed on
STOCK.TYPE Stock type (S=single,M=Multi) associated to STOCK
TCONTROL TControl which sold ticket
TDATE Print transaction date (Normally used by bulk process)
TDAY Print tansaction day of week
TKEY Print transaction key (SEASON:TSEQ)
TMONTHL Print transaction month all lower case
TMONTHT Print transaction month 2+lower case
TMONTHU Print transaction month all upper case
TSTOCK Total # of tickets printed for item/event
USER.ID tRes operator code
VLINE BOCA vertical line graphic
WCCUST Item will-call customer number
WCNAME Name associated to item will-call customer

Non-Allocatable

Variable Description

ACT Activity code associated to season of tickets being printed

ACUST Associated customer number

ANAME Activity name

BARCODE Barcode of seat

BATCH Print batch number

BOX BOCA Box graphic

CADDR1 The standard mail address type address line 1 for CNUMBER.
See Setting Up Standard Address Type Data.

CADDR2 The standard mail address type address line 2 for CNUMBER.
See Setting Up Standard Address Type Data.

CADDR3 The standard mail address type address line 3 for CNUMBER.
See Setting Up Standard Address Type Data.

CADDR4 The standard mail address type address line 4 for CNUMBER.
See Setting Up Standard Address Type Data.

CCSZ The standard mail address type city, state, zip for CNUMBER.
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Variable Description

See Setting Up Standard Address Type Data.

CDMNAME The default mail name for CNUMBER  (PAT.MNAME)

PAC7.BUSACCT Pac7 business account

PAC7.LOC Pac7 location

PAC7.NUMBER Pac7 item sales order number

PAC7.ORG Pac7 organization ID

PAC7.TCONTROL Pac7 ticketing control

PAC7.USERID Pac7 user ID

PAC7.CLIENTID Pac7 client ID

CMNAME The standard mail address type mail name for CNUMBER. See
Setting Up Standard Address Type Data.

CNAME The name associated to CNUMBER in format LAST, FIRST
(PAT.NAME)

CNAME2 The second name associated to CNUMBER in format LAST,
FIRST (PAT.NAME2)

CNUMBER Customer Number. If the order line references an associated
customer, then ONUMBER = actual order number and
CNUMBER = associated customer number. If not, ONUMBER =
CNUMBER.

COUNTRY The standard mail address country code for CNUMBER. See Set-
ting Up Standard Address Type Data.

COUNTRY.NAME The name associated to the standard mail address type country
code for CNUMBER. See Setting Up Standard Address Type
Data.

CPRI Customer priority for customer being printed

CTNAME Name associated with customer name

CTYPE Customer type code for customer being printed

CXNAME The name in external format associated to CNUMBER in format
TITLE FIRST LAST (PAT.NAME, PAT.TITL)

CXNAME2 The second name in external format associated to CNUMBER in
format TITLE FIRST LAST (PAT.NAME2, PAT.TITL2)

DATE Today’s Date

DEVICE Output print device “BOCA”

DISP Item disposition code

DISP.NAME Item disposition name

FORM Print form code

GROUP Item group number

HLINE BOCA horizontal line graphic

I.DISC Item discount code

I.DISC.NAME Item discount name

I.FMT Item format code
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Variable Description

I.PLINE1 Event print line 1

I.PLINE2 Event print line 2

I.PLINE3 Event print line 3

I.PLINE4 Event print line 4

I.PLINE5 Event print line 5

I.PLINE6 Event print line 6

I.PLINE7 Event print line 7

I.PLINE8 Event print line 8

I.PLINE9 Event print line 9

IAPNUM Item access pass number

ICLASS Item class code

ICLASS.NAME Name associated to item class code

IGCDOC Item gift certificate doc.

INAME Name associated to itemcode

IPRICE Item price of item being printed

ITEM Item code

MARK Item mark code

MSHIPS List of customer memberships separated by comma “,”

ONAME This is the primary customer name (owner of the order being
printed). NUMBER (customer being printed) is = to ONUMBER
except in cases where associated customer is being printed 

ONUMBER This is the primary customer number (owner of the order being
printed). NUMBER (customer being printed) is = to ONUMBER
except in cases where associated customer is being printed 

PB Print batch info (Transaction.Sequence.Print.Sequence)

PREF Item location preference code

REPRINT Reprint flag (True/False 1/0)

SEASON Season code

SNAME Season name

SPEC Item special handling

STOCK Stock code tickets printed on

STOCK.TYPE Stock type (S=single,M=Multi) associated to STOCK

TCONTROL TControl which sold ticket

TDATE Print transaction date (Normally used by bulk process)

TKEY Print transaction key (SEASON:TSEQ)

TSTOCK Total # of tickets printed for item/event

USER.ID tRes operator code

VLINE BOCA vertical line graphic
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Variable Description

WCCUST Item will-call customer number

WCNAME Name associated to item will-call customer

Receipt

Variable Description

BATCH tRes Batch #

BOX BOCA Box graphic

CCAUTH CC authorization code

CCEXP CC expiration date

CCNAME Credit Card name

CCNUM Credit card #

CHANGE Change Due

PAC7.BUSACCT Pac7 business account

PAC7.LOC Pac7 location

PAC7.NUMBER Pac7 item sales order number

PAC7.ORG Pac7 organization ID

PAC7.TCONTROL Pac7 ticketing control

PAC7.USERID Pac7 user ID

PAC7.CLIENTID Pac7 client ID

CNAME The name associated to CNUMBER in format LAST, FIRST (PAT.NAME)

CNUMBER Customer Number. See Setting Up Standard Address Type Data.

CREDIT Determines whether the transaction used a credit card paymode (yes or
no)

CXNAME The name in external format associated to CNUMBER in format TITLE
FIRST LAST (PAT.NAME, PAT.TITL)

DATE Today’s Date

DEVICE Output print device “BOCA”

FORM Print form code

HLINE BOCA horizontal line graphic

MERCHANT Paymode Merchant ID

MODE Receipt print mode. O=Printing from order form, I=printing from item
form, P=printing receipt for previous payment

NETPAY Total net payment amount (PAMOUNT – CHANGE)

PAMOUNT Pay amount

PAYMODE Payment mode code

PNAME Payment mode name

TCONTROL TControl which sold ticket

TIME Receipt print time
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Variable Description

USER.ID tRes operator code

VLINE BOCA vertical line graphic

XCCNUM Credit card number in external format.  All but last 4 numbers replaced
with “X”

Mailer

Variable Description

BATCH Print batch number

BOX BOCA Box graphic

CADDR1 The standard mail address type address line 1 for CNUMBER. See
NOTE A

CADDR2 The standard mail address type address line 2 for CNUMBER. See
NOTE A

CADDR3 The standard mail address type address line 3 for CNUMBER. See
NOTE A

CADDR4 The standard mail address type address line 4 for CNUMBER. See
NOTE A

CCSZ The standard mail address type city, state, zip for CNUMBER. See
NOTE A

CDMNAME The default mail name for CNUMBER  (PAT.MNAME)

PAC7.BUSACCT Pac7 business account

PAC7.LOC Pac7 location

PAC7.NUMBER Pac7 item sales order number

PAC7.ORG Pac7 organization ID

PAC7.TCONTROL Pac7 ticketing control

PAC7.USERID Pac7 user ID

PAC7.CLIENTID Pac7 client ID

CMNAME The standard mail address type mail name for CNUMBER. See Setting
Up Standard Address Type Data.

CNAME The name associated to CNUMBER in format LAST, FIRST (PAT.NAME)

CNAME2 The second name associated to CNUMBER in format LAST, FIRST
(PAT.NAME2)

CNUMBER Customer Number. If the order line references an associated cus-
tomer, then ONUMBER = actual order number and CNUMBER = asso-
ciated customer number. If not, ONUMBER = CNUMBER.

COUNTRY The standard mail address country code for CNUMBER. See Setting Up
Standard Address Type Data.

COUNTRY.NAME The name associated to the standard mail address type country code
for CNUMBER. See Setting Up Standard Address Type Data.

CXNAME The name in external format associated to CNUMBER in format TITLE
FIRST LAST (PAT.NAME, PAT.TITL)
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Variable Description

CXNAME2 The second name in external format associated to CNUMBER in format
TITLE FIRST LAST (PAT.NAME2, PAT.TITL2)

DATE Today’s Date

DEVICE Output print device “BOCA”

HLINE BOCA horizontal line graphic

ITEM Item code

MSTOCK Total number of pieces of stock printed associated to this mailer

ONAME This is the primary customer name (owner of the order being
printed). NUMBER (customer being printed) is = to ONUMBER except
in cases where associated customer is being printed 

ONUMBER This is the primary customer number (owner of the order being
printed). NUMBER (customer being printed) is = to ONUMBER except
in cases where associated customer is being printed 

TCONTROL TControl which sold ticket

USER.ID tRes operator code

Unsupported Print Form Variables
Delete this text and replace it with your own content.

Name Type Description

B.NPRINT Numeric Total # pieces of stock printed in this batch. During bulk printing,
batch can change, therefore this # would be reset on a batch
change

BALANCE Monetary Total order balance at time of print. Typically used to print on sea-
son ticket stock.

GTWGROUP Numeric Item Group-Ticket-Window group number

FPMODE Alphanumeric First payment mode of payments applied to Item

EVENT.LOGO Alphanumeric Name of a .BMP logo file associated to the event

OPRI Numeric Order priority for customer:season being printed

NPRINT Numeric Total # pieces of stock printed during process

H.CMNAME Alphanumeric The standard home address type mail name for CNUMBER

H.CADDR1 Alphanumeric The standard home address type address line 1 for CNUMBER

H.CADDR2 Alphanumeric The standard home address type address line 2 for CNUMBER

H.CADDR3 Alphanumeric The standard home address type address line 3 for CNUMBER

H.CADDR4 Alphanumeric The standard home address type address line 4 for CNUMBER

H.CCSZ Alphanumeric The standard home address type city, state, zip for CNUMBER

H.CNTRY Alphanumeric The standard home address country code for CNUMBER

H.CNTRY.NAME Alphanumeric The name associated to the standard home address type country
code for CNUMBER

B.CMNAME Alphanumeric The standard business address type mail name for CNUMBER

B.CADDR1 Alphanumeric The standard business address type address line 1 for CNUMBER
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Name Type Description

B.CADDR2 Alphanumeric The standard business address type address line 2 for CNUMBER

B.CADDR3 Alphanumeric The standard business address type address line 3 for CNUMBER

B.CADDR4 Alphanumeric The standard business address type address line 4 for CNUMBER

B.CCSZ Alphanumeric The standard business address type city, state, zip for CNUMBER

B.CNTRY Alphanumeric The standard business address country code for CNUMBER

B.CNTRY.NAME Alphanumeric The name associated to the standard business address type coun-
try code for CNUMBER

O.CMNAME Alphanumeric The standard other address type mail name for CNUMBER

O.CADDR1 Alphanumeric The standard other address type address line 1 for CNUMBER

O.CADDR2 Alphanumeric The standard other address type address line 2 for CNUMBER

O.CADDR3 Alphanumeric The standard other address type address line 3 for CNUMBER

O.CADDR4 Alphanumeric The standard other address type address line 4 for CNUMBER

O.CCSZ Alphanumeric The standard other address type city, state, zip for CNUMBER

O.CNTRY Alphanumeric The standard other address country code for CNUMBER

O.CNTRY.NAME Alphanumeric The name associated to the standard other address type country
code for CNUMBER

Setting up Standard Address Type Data
The allocatable, non-allocatable, and mailer programs set up a list of standard mailing, home, busi-
ness, and other address data.

Standard Mailing Address Type Data

Determines the standard mailing address type in the following order:

1. If the order-line being printed has an order-line address type (ODET.ATYPE), then the stand-
ard mailing address type is set to the order-line address type.

2. If the order-line does not have an order-line address type, then it looks to see if the cus-
tomer record has a mail address type (CUST.M.ADTYPE) and uses this if not null.

3. If this is null, then it uses the ‘Standard Mail Address Type’ specified in TK.SETUP.E (global
tRes system parameters).

Once this mailing address type is determined, the process reads the patron address records for the
specified address type to set up the ‘standard mail address type’ data.

Standard Home Address Type Data

Initializes the address type to the standard home address type specified in TK.SETUP.E. If this is
not null, looks at patron address records for the address type to set up the standard home address
type data.

Standard Business Address Type Data

Initializes the address type to the standard business address type specified in TK.SETUP.E. If this is
not null, looks at patron address records for the address type to set up the standard business
address type data.

Standard Other Address Type Data

Initializes the address type to the standard other address type’ specified in TK.SETUP.E. If this is
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not null, looks at patron address records for the address type to set up the standard other address
type data.

Address Components

CMNAME ADR.NAME

CADDR1 ADR.ADR1

CADDR2 ADR.ADR2

CADDR3 ADR.ADR3

CADDR4 ADR.ADR4

CCSZ City, State Zip Feedback based on ADR.ZIP

COUNTRY ADR.COUNTRY

COUNTRY.NAME Country name feedback based on COUNTRY

Paciolan 7 Record Locking Recommendations
This topic includes record locking recommendations for Pac7 while placing an order and saving a
patron record.

Placing an Order
Pac7 will be unable to confirm orders if records in any of the files in the table below are locked at
the same time an order is placed or the Patron record is being updated.

Follow these record locking rules when you are selling using the SB Client screens:

l If a record in a file related to a patron is open this will prevent Pac7 from placing an order for
that Patron.

l If a record in a file related to a season, item, event, or facility is open this will prevent Pac7
from placing an order for that item.

l If you need to update season, item, event or facility data we recommend doing this while
sale volume is low.

In general, these are the same record locking rules you follow when selling in tRes using TK.SELL.
However, the transaction implications for the two systems are much different:

l When an order is placed in tRes and a required file is locked, the transaction will not com-
plete until the file becomes unlocked.

l When an order is placed in Pac7 and a required file is locked in the back office, Pac7 will only
wait for the file to become unlocked for three minutes. If the file is not unlocked by that
time, Pac7 will return an error message to the operator.

Note: The back office may still process a Pac7 order once the file is unlocked. However, Pac7 will
have no record of the completion of the transaction. So, whenever an incomplete order message is
returned in Pac7, you must check the tRes system to make sure that the order did not complete,
charge the customer, and assign seats. If so, you need to void that transaction in tRes.

When a user tries to access one of the processes below and Pac7 is online, the system will provide
a warning message Warning: Pac7 is online. Please be aware that while you have a record called
up in this screen, Pac7 will not be able to place an order for the items/events/patron affected. This
check would be initiated only if the client has Pac7 online.

Process Menu Path File/Record
Locked Comments

TK.CUST.E Customer Entry TK.CUSTOMER, Affects the ability to place
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Process Menu Path File/Record
Locked Comments

PD.PATRON orders for the Customer
ID accessed.

TK.HCUST.E House Cust Entry TK.CUSTOMER,
PD.PATRON

Affects the ability to place
orders for the Customer
ID accessed.

TK.CUST.MPACESS.E Marketplace Access
Entry

TK.CUSTOMER Affects the ability to place
orders for the Customer
ID accessed.

TK.CUST.PROMO.E Promotional Codes Entry TK.CUSTOMER Affects the ability to place
orders for the Customer
ID accessed.

TK.MERGE Customer Merge TK.CUSTOMER,
PD.PATRON

Affects the ability to place
orders for the Customer
ID accessed.

TK.CREDIT.E Credit Information Entry TK.CUSTOMER Affects the ability to place
orders for the Customer
ID accessed.

TK.EVENT.SEA.E Season Event Entry TK.EVENT.season,
TK.ITEM.season

Affects the ability to place
orders for the Item
accessed.

TK.COMBO.SEA.E Season Combo Item
Entry

TK.ITEM.season Affects the ability to place
orders for the Item
accessed.

TK.IDON.SEA.E Season Donation Item
Entry

TK.ITEM.season Affects the ability to place
orders for the Item
accessed.

TK.IMISC.SEA.E Season Misc Item Entry TK.ITEM.season Affects the ability to place
orders for the Item
accessed.

TK.IGC.SEA.E Season Gift Cert Entry TK.ITEM.season Affects the ability to place
orders for the Item
accessed.

TK.IAPASS.SEA.E Season Access Pass
Entry

TK.ITEM.season Affects the ability to place
orders for the Item
accessed.

TK.DISC.SEA.E Season Discount Entry TK.DISCOUNT.season Affects the ability to place
orders with that Discount.

TK.OCHARGE.SEA.E Season Order Charge
Entry

TK.CHARGE.season Affects the ability to place
orders with that Order
Charge.

TK.FCHARGE.SEA.E Season Facility Fee Entry TK.CHARGE.season Affects the ability to place
orders with that Facility
Fee.

TK.SCHARGE.SEA.E Season Surcharge Entry TK.CHARGE.season Affects the ability to place
orders with that
Surcharge.
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Process Menu Path File/Record
Locked Comments

TK.TCHARGE.SEA.E Season Ticket Charge
Entry

TK.CHARGE.season Affects the ability to place
orders with that Ticket
Charge.

TK.CTABLE.SEA.E Season Ticket Charge
Table Entry

TK.CTABLE.season Affects the ability to place
orders with that Ticket
Charge.

TK.PTABLE.SEA.E Season Price Table Entry TK.ITEM.season Affects the ability to place
orders with that Item.

TK.BPLAN.SEA.E Season Bill Plan Entry TK.BPLAN.season Affects the ability to place
orders with that Billing
Plan.

TK.BATCH.E Batch Entry TK.BATCH Affects the ability to place
orders to the batch
accessed.

TK.DRAWER.E Batch Drawer Entry TK.BATCH Affects the ability to place
orders to the batch
accessed.

TK.BALANCE.E Batch Operator Balance TK.BATCH Affects the ability to place
orders to the batch
accessed.

TK.SEASON.E Season Entry TK.SEASON Season Entry - Retrieves
next transaction
sequence from here when
creating a new trans-
action

TK.SELL In order form path TK.ORDER.season In order form
path.  Affects the ability
to place orders for that
Customer and Season
accessed.

TK.SELL.CUST.E Customer screen in
selling process

TK.CUSTOMER,
PD.PATRON

Customer screen in
selling process.  Affects
the ability to place orders
for that Customer and
Season.

TK.HSEAT.E Customer Seat Holds
Entry

TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.

TK.APPLY.E Payment Application
Entry

TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.

TK.WRITEOFF Order Writeoffs Specific
Customer

TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.

TK.ALLOCATE Seat Alloc-
ations/Deallocations

TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.
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Process Menu Path File/Record
Locked Comments

TK.TRANSFER Transfer TK.ORDER.season Transfer – applies to both
Specific Seat and Bulk
modes.  Affects the abil-
ity to place orders for
that Customer and
Season.

TK.REPRINT.F Reprint Items TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.

TK.REPRINT.EVENT.F Reprint Events TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.

TK.REISSUE.F Misc Item PAH Reissue TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.

TK.VOID Voids TK.ORDER.season Voids – applies to both
Specific Seat and Bulk
modes.  Affects the abil-
ity to place orders for
that Customer and
Season.

TK.RETURN Returns TK.ORDER.season Affects the ability to place
orders for that Customer
and Season.

Saving a Patron
Calling up a patron record in the PD.PATRON.E, PD.MERGE, FD.DONOR.E, FD.SOLICITOR.E, or
TK.CUST.E processes or the Customer Entry screen from within TK.SELL will lock the patron record
(PD.PATRON file) in the back office until the user saves the record, calls up another record, con-
tinues the sale, or exits to another process.

The related patron files such as PD.ADDRESS, PD.ORG, FD.DONOR, TK.CUSTOMER, etc. are not
locked by the UI unless the related PD.PATRON record has also been locked. Therefore, Pac7
always locks the PD.PATRON record first before locking the related records, and the PD.PATRON
record remains locked until the related locks have been released.

When someone saves a patron in Pac7 and another operator has the same patron ID locked in the
back office, we make repeated attempts at saving the patron record for a set time interval. This
function is controlled by two parameters passed from Pac7 to the back office: maximum number of
retries and a retry interval in seconds.

If the patron update is unsuccessful due to a record lock and has timed out based on the retry para-
meters, we return the following message back to Pac7: "Patron record is locked." ERRCODE-
E=291001.

Another record locking issue arises when a new patron is created in Pac7 and the new patron ID is
automatically assigned in the back office. If an operator in the back office has the Patron System
Setup Parameters process (PD.SETUP.E) locked, the function of assigning a new patron ID will
hang until the system parameters have been saved or the process is exited. If a Pac7 user is cre-
ating a new patron as part of a selling transaction, the transaction will also be delayed.
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Process File/Record Locked Comments

PD.PATRON.E PD.PATRON Affects the ability to update the Patron
record

PD.MERGE PD.PATRON Affects the ability to update the Patron
record

FD.DONOR.E PD.PATRON Affects the ability to update the Patron
record

FD.SOLICITOR.E PD.PATRON Affects the ability to update the Patron
record

TK.CUST.E PD.PATRON Affects the ability to update the Patron
record

PD.SETUP.E PD.PATRON Affects the ability to assign a new Patron
ID if the setup automatically creates a
new patron ID
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Chapter 3 Order Management

In Pac7, you can place orders using either the item sales or order management process. Item sales
is a linear method of selling that guides you through the sales process using predefined sales
paths. The more flexible order management process allows you to sell from multiple seasons and
perform additional order adjustments, such as canceling or voiding order lines. Once you've added
order lines in order management, you can also collect payment information for the seasonal order.

Order management processes primarily include order level, order line, and payment information
functional areas. At the order level you select patrons and seasons, as well as make any other
selections or entries that apply to the order as a whole. The order line is where you add, insert,
edit, delete, and cancel individual items (single event, combo, miscellaneous, donation, gift cer-
tificate, and access pass items) for the order. Once you've added order lines, order management
allows you to finish orders with or without adding payment information, depending on whether you
have made fiscal changes to the order.

When using the Order Management tab in Pac7, you can do the following:

Navigate the tab Use the Order Line Additional pane

Move between tab pages Collect payment information

Use order level processes Finish Orders

Use order line processes Cancel order changes

Note: Pac7 order management currently includes only a subset of the back office selling pro-
cesses. The remaining processes, such as returns and exchanges, are available using the TK.SELL
order form in tRes.

Navigating the Order Management Tab
The Order Management tab is comprised of main Order Management, Customer Seat Holds, Pay-
ment Information, and Payment Application pages. The main order management page is also
divided into order level and order line process areas. This topic describes the controls that you can
use to navigate and process orders on each of the pages.

Order Management page controls

The Order Management page controls are described in the following table.

http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/orders/order_form.htm
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Control
type Description of use

Toolbar
buttons

Click buttons on the order level or order line toolbar to perform the associated process
(for example, reprint prior receipts). The buttons that are displayed vary based on the
form that is associated with your selling control. Most toolbar buttons are also avail-
able through the toolbar drop-down menus.

Drop-
down
menus

Most controls with a down arrow allow you to select a relevant process from a drop-
down menu.

Tab nav-
igation
buttons

Click an Order Management tab navigation button to clear the page or display the Pay-
ment Information page, depending on the button and the state of the order. For more
information, see Finishing Orders in Order Management.
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Control
type Description of use

Form dis-
play links

Click any of the form display links to edit or view the associated order information.
For example, you can click an Edit link to display the Edit Phone/Email form and
modify a patron's contact phone numbers and email addresses.

Patron
search
field

Display the Patron Search form by clicking the magnifying glass in the search for pat-
ron field. You can enter patron information, such as part of a name or patron ID, in the
search field before clicking the magnifying glass to narrow the search when the Pat-
ron Search form is displayed.

Text entry
boxes

Type numeric or alphanumeric keyboard entries in text entry boxes. Numeric text
boxes will only accept numbers, while alphanumeric text boxes allow any string of
characters.
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Control
type Description of use

Find item
rows in
the Order
Lines
table

Enter text in the Order Lines table search box to locate individual order line rows.
When searching order lines, your search text is compared to the fields in each of the
rows, and then the matching rows are shaded to distinguish them from non-matching
rows. You can then use the up and down arrows to move between the selected rows.

Customer Seat Holds page controls

The Customer Seat Holds page controls are described in the following table.

Control type Description of use

Toolbar but-
tons

Click buttons on the Seat Holds table toolbar to perform the associated process
(for example, view the details of an item row).
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Control type Description of use

Tabnavigation
buttons

Click an Order Management tab navigation button to cancel or save any changes
mad on this page since the last time it was saved.

Form display
links

Click any of the form display links to edit or view the associated order information.
For example, you can click a link in the Seatblock column to display a popup that
shows which seats are customer held and which are counter held.

Sequence
search

Display the Seat Holds Search form by clicking the magnifying glass in the
Sequence id field. If you enter a sequence number, the form will include only the
sequences that include that number.

Text entry
boxes

Type numeric or alphanumeric keyboard entries in Comments text entry box.
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Control type Description of use

Payment Information page controls

The Payment Information page controls are described in the following table.

Control
type Description of use

Tab nav-
igation but-
tons

Click an Order Management tab navigation button to clear the page by canceling or
purchasing the order, or to return to the Payment Information page. For more inform-
ation, see Finishing Orders in Order Management.
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Control
type Description of use

Form dis-
play links

Click any of the form display links to edit or view the associated order information.
For example, you can click an Edit link to display the Edit Phone/Email form and
modify a patron's contact phone numbers and email addresses.

Payment
Methods
toolbar but-
tons

Click buttons on the Payment Methods toolbar to perform the associated process (for
example, reswiping a credit card).

Drop-down
menus

Select the appropriate process from the drop-down menus.
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Control
type Description of use

Radio but-
tons

Select one of a group of 2 or more options by clicking its radio button.

Payment Application page controls

The Payment Application page controls are described in the following table.
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Control
type Description of use

Tab nav-
igation but-
tons

Click an Order Management tab navigation button to cancel or apply payment applic-
ation settings and return to the Order Management page. For more information, see
Applying Payments.

Transaction
date entry

Use the Transaction date control to enter a date for the payment application trans-
action. You can click in the text box to manually enter numbers for the date or click

the calendar buttonx to select the date from the popup calendar.

Sale code
drop-down
list

Click the Sale code drop-down menu to select a sale code from a list for the pay-
ment application transaction.

Order
amount
link

Click the Order amount link to display the Order Amount Breakdown form. For
more information, see Viewing the Order Amount Breakdown.
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Control
type Description of use

Payment
Details
table

Click the plus buttonx or trash buttonx in the Payment Details table to add or
subtract payment types and amounts for the row selected in the Items table.

Reset apply
amount but-
ton

Click the Reset apply amount buttonx to clear any amounts
entered in the Apply amount column of the Payment Details table.

Moving Between Order Management Pages
At any time during order management, you can choose to navigate between the main order entry
page (Order Management page) and the collect payment page (Payment Information page). See
example pages below. For example, you may need to go back the Order Management page to
change order lines or order charges for the current patron's order after navigating to the Payment
Information page. When you attempt to navigate between these two order management pages, the
system requires that your entries on are valid on the page you are navigating from.
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When you make valid entries on the Payment Information page and return to the Order Man-
agement page, your selling control configuration determines whether payment related entries are
saved if you return again to the Payment Information page. All control configurations update the
Payment Information page based on changes you make to the Order Management page that affect
payment information.

If you are manually applying payments from the Payment Information page, you will also be able
to navigate to the Payment Application page. This navigation is only allowed your control allows
manual payment application and you are at the end of sale for a patron with undistributed pay-
ments.

To go to the Payment Information page from the Order Management page

1. On the Order Management page, click the Finish and pay button.
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The Payment Information page is displayed.

To go to the Order Management page from the Payment Information page

1. On the Payment Information page, click the Back to order button.

The Order Management page is displayed.

To go to the Payment Application page from the Payment Information page
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1. On the Payment Information page, click the Purchase button.

2. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.

The End of Sale - Confirmation form is displayed.

3. On the End of Sale - Confirmation form, click the Apply payments buttonx

.

The Payment Application page is displayed.

Using Order Level Processes in Order Management
The order level processes allow you to select patrons and seasons, as well as make any other
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selections or entries that apply to an order as a whole. Once you have selected the patron, season,
and order level settings, you can use order line level processes and collect payment information to
further update the order.

The order level processes you can use when working in Pac7 include the following:

Create orders Use customer seat holds

Create patrons View previous season overviews

Select patrons Print the Boca batch summary

Use house customers Reorder & reallocate items

Edit patrons Reprint prior receipts

Select seasons Edit patron information

Add order level information View the patron summary

Edit user defined fields Use contact entry

Add application items Use order charges

Use billing plans View the order amount breakdown

Note: Pac7 order management currently includes only a subset of the back office selling pro-
cesses. The remaining processes, such as returns and exchanges, are available using the TK.SELL
order form in tRes.

Creating Orders in Order Management
In addition to looking up existing orders for a patron, you can use the Order Management tab to cre-
ate an order (add order lines) for a patron or sell items to a house customer. This is an alternative
to creating new sales on the Item Sales tab. Once you add one or more order lines for a patron,
you can edit (for example, cancel or void) or add new order lines for the patron at any time.

To use the order management functionality, you must be using a selling control that allows access
to the Order Management tab. Once on the tab, you select a patron or create a patron record, and
then select the season to add order items from the season to order lines.

To create an order for a specific patron

1. On the Order Management tab, select an existing patron or create a new patron record.

2. Select a Season.
3. Add order lines.
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Creating Patrons in Order Management
During order management, you can create a new individual patron or organization record and enter
identifying information (name, type, status, phone, email, address, comments). Depending on the
patron policy assigned to your selling control, you may also be able to enter a new patron ID num-
ber, instead of allowing the system to automatically assign a new number. The patron policy may
also be configured to check for duplicate names and email addresses during patron creation.

To create a patron on the Order Management tab

1. Click the Order Management tab.

2. Click the patron button.

3. From the drop-down list, select Create new patron.

Tip: You can also create a new patron at any time on the Patron Search form during patron
selection by clicking the Create new patron button.

The Create Patron form is displayed. The box entries and options will differ based on the
patron policy assigned to your selling control.
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4. For Type, select either Individual or Organization.

5. If the Patron Id box is editable, enter a number for the new patron's ID or select Assign
new patron ID automatically to have the system create the number for you.

6. If Type is Individual, enter the patron's last and first name/middle initials in Last name and
First name/MI, or , if Type is Organization, enter the name in Organization name.

7. Click in or tab to the next field for which you want to enter or select a value.

If duplicate name checking is enabled and the name (or a shortened version) or an email
address matches an existing patron record, the Duplicate Patron Records Found form is dis-
played.

If the Duplicate Patron Records Found form is displayed, do one of the following:
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l If the patron you are attempting to create is in the table (already in the system), select
the patron row, and then click the No, continue with the selected patron button. The
Order Management tab is redisplayed with the selected patron loaded. You are finished
creating the patron.

l If the patron you are attempting to create is not in the table, click the Yes, continue to
create a new patron button. When the Create Patron form is redisplayed, click the
Continue button.

8. Enter or select values for the optional (no asterisk) fields as appropriate, and then click the
Continue button.

If duplicate name checking is enabled and the name (or a shortened version) or an email
address matches an existing patron record, the Duplicate Patron Records Found form is
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displayed.

If the Duplicate Patron Records Found form is displayed, do one of the following:

l If the patron you are attempting to create is in the table (already in the system), select
the patron row, and then click the No, continue with the selected patron button. The
Order Management tab is redisplayed with the selected patron loaded. You are finished
creating the patron.

l If the patron you are attempting to create is not in the table, click the Yes, continue to
create a new patron button. When the Create Patron form is redisplayed, click the
Continue button.
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Selecting Patrons in Order Management
Before you can add or edit orders in order management, you must select an individual patron or
house customer for the order. Access to individual patrons and house customers is configured in
the patron options of the current selling control. You may have access to one of them or to both.

When selling to individual patrons, you can select the patron from the last order or select one from
the last 20 patrons selected. You can also search for them using the Standard (name, patron ID,
keyword, phone, address, and email), Credit card, Magstripe Id, or Barcode search types.

When searching using the standard search type, you enter text that describes the patron for which
you are looking. You can enter more than one word at a time for a search, since the default oper-
ator between all words and terms is AND. The item fields whose values are searched include the
following:

l Patron name
l Name 2
l Phones
l Keywords
l Address line 1
l Address line 2
l Address line 3
l Address line 4
l Zip code

Prepositions, conjunctions or common verbs are ignored when performing a search (for example,
about, the, of, a, in, as, if, not, why, never, before, is, it). Search options you can use with your
search text include the following:

l AND operator. Use the AND operator between two words to only return events if their details
include both words.
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l OR operator. Use the OR operator between two words to return events that include either
word in their details. This type of search typically returns more records than the default AND
search.

l NOT operator or - (minus sign). Use the NOT operator or the minus sign in front of a word to
exclude it from the search (for example, smith NOT smithson)

l Quotation marks. Use quotation marks around two or more words to search for an exact
term. You can use quotation marks in conjunction with operators, the minus sign, and wild-
cards.

l ? (question mark) and * (asterisk) wildcards. Use the question mark in place of a single char-
acter and the asterisk in place of zero or more characters. Wildcards cannot be used as the
first character or the only character in a search string.

The Credit card search type is only available if credit card search is enabled in the selling control.
Wild card search is not valid for the Credit card, Magstripe Id, and Barcode search types. You
must enter the full number. For the Barcode search type only, both numbers and letters can be
used, and the search string is limited to 20 characters. The search will not find a patron if the bar-
code you enter has been voided.

When selling using a house customer, you can use your control's default house customer or search
for other house customers to select by name, keyword, or patron ID. Wildcard characters are not
valid when searching for house customers.

To select the individual patron from the last order

1. Click the Order Management tab.

2. Click the patron button.

3. From the drop-down list, select Use last patron.

The last used patron is loaded into the Order Management tab.

Pac7 Release 7.2



User Guide  211

To select an individual patron from the last 20 selected patrons

1. Click the Order Management tab.

2. Click the patron button.

3. From the drop-down list, select Last 20 patrons.

The Patron Search form is displayed with the Last 20 patrons tab selected.

4. To select a patron, double-click the patron row, or select the row and then click the
Continue button.

The selected patron is loaded into the Order Management tab.
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To select an individual patron using the Patron Search function

1. Click the Order Management tab.

2. In the Patron field, enter the patron information (use a patron name, ID, keyword, phone
number, physical address, or email address) you want to use for the search, and then click
the magnifying glass button. You can also leave the Patron field empty and click the mag-
nifying glass button to display the Patron Search form without results.

The Patron Search form is displayed with the patron records that match your search cri-
teria in the search results table.

When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.

3. To find a patron within the search results, enter patron information in the Find box. Records
that contain the text are shaded as you enter the text.
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You can also use the up and down arrows to move between the shaded records.

4. To start a new search after the Patron Search form is displayed, do the following:

a. Select one of the options for Search type, and then enter the required text in the search
box. The allowable search text is displayed in the search box when you select a search
type. The text entered is matched at the word and number level, so partial words or num-
bers will not return patrons or house customers with only partial matches. See an
example (if you search for 123, a patron with ID 1234 will not be included in the search
results).

b. Click the Search button. The patron records that match your search criteria are displayed
in the search results table.
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5. To select a patron, double-click the patron row, or select the row and then click the
Continue button.

The selected patron is loaded into the Order Management tab.

To select the house customer assigned to you in the control

1. Click the Order Management tab.

2. Click the house customer button.

The house customer is loaded into the Order Management tab.
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To select a house customer other than the one assigned to you in the control (with
access to individual patrons)

1. Click the Order Management tab.

2. Click the magnifying glass button. The Patron Search form is displayed.

3. Click the House customer search tab.

4. Select one of the options for Search type, and then enter the required text in the search
box. The allowable search text is displayed in the search box when you select a search type.
The text entered is matched at the word and number level, so partial words or numbers will
not return patrons or house customers with only partial matches. See an example (if you
search for 123, a patron with ID 1234 will not be included in the search results).

5. Click the Search button. The house customer records that match your search criteria are dis-
played in the search results table.
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When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.

6. To find a house customer within the search results, enter the name, a keyword, or the num-
ber of the house customer in the Find box. Records that contain the search information are
highlighted as you enter the information in the Find box.

You can also use the up and down arrows to move between the highlighted records.
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7. To select a house customer, double-click the house customer row, or select the row and then
click the Continue button.

The house customer is loaded into the Order Management tab.

To select a house customer other than the one assigned to you in the control (with no
access to individual patrons)

1. Click the Order Management tab.

2. In the House Customer field, enter the name, a keyword, or the number of the house cus-
tomer for which you are searching, and then click the magnifying glass button. You can also
leave the House Customer field empty and click the magnifying glass button to display the
Patron Search form without results.
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The Patron Search form is displayed with the house customer records that match your search
criteria in the search results table.

When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.

3. To find a house customer within the search results, enter the name, a keyword, or the num-
ber of the house customer in the Find box. Records that contain the search information are
highlighted as you enter the information in the Find box.

You can also use the up and down arrows to move between the highlighted records.
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4. To start a new search after the Patron Search form is displayed, do the following:

a. Select one of the options for Search type, and then enter the required text in the search
box. The allowable search text is displayed in the search box when you select a search
type. The text entered is matched at the word and number level, so partial words or num-
bers will not return patrons or house customers with only partial matches. See an
example (if you search for 123, a patron with ID 1234 will not be included in the search
results).

b. Click the Search button. The house customer records that match your search criteria are
displayed in the search results table.

5. To select a house customer, double-click the house customer row, or select the row and then
click the Continue button.

The house customer is loaded into the Order Management tab.
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Using House Customers in Order Management
Before you can add or edit orders in order management, you must select an individual patron or
house customer for the order. Access to individual patrons and house customers is configured in
the patron options of the current selling control. You may have access to one of them or to both.

If you have access to house customers, the Order Management tab allows you to quickly select the
house customer that is assigned to you in the selling control. You can also use the patron search
function to locate and select a house customer besides the selling control default. The house cus-
tomer search is by name, keyword, or number. Wildcard characters are not valid when searching
for house customers.

The patron search function has different tabs displayed based whether your operator permissions
allow you access to individual patrons. However, as long as you have access to house customers,
the house customer search tab works the same whether or not you have access to individual pat-
rons.

To use a house customer in Order Management

1. Click the Order Management tab.

2. Click the house customer button.

The house customer is loaded into the Order Management tab.

1. Click the Order Management tab.
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2. Click the magnifying glass button. The Patron Search form is displayed.

3. Click the House customer search tab.

4. Select one of the options for Search type, and then enter the required text in the search
box. The allowable search text is displayed in the search box when you select a search type.
The text entered is matched at the word and number level, so partial words or numbers will
not return patrons or house customers with only partial matches. See an example (if you
search for 123, a patron with ID 1234 will not be included in the search results).

5. Click the Search button. The house customer records that match your search criteria are dis-
played in the search results table.

When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.
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6. To find a house customer within the search results, enter the name, a keyword, or the num-
ber of the house customer in the Find box. Records that contain the search information are
highlighted as you enter the information in the Find box.

You can also use the up and down arrows to move between the highlighted records.

7. To select a house customer, double-click the house customer row, or select the row and then
click the Continue button.

The house customer is loaded into the Order Management tab.
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1. Click the Order Management tab.

2. In the House Customer field, enter the name, a keyword, or the number of the house cus-
tomer for which you are searching, and then click the magnifying glass button. You can also
leave the House Customer field empty and click the magnifying glass button to display the
Patron Search form without results.

The Patron Search form is displayed with the house customer records that match your search
criteria in the search results table.

When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.

3. To find a house customer within the search results, enter the name, a keyword, or the num-
ber of the house customer in the Find box. Records that contain the search information are
highlighted as you enter the information in the Find box.

Pac7 Release 7.2



User Guide  224

You can also use the up and down arrows to move between the highlighted records.

4. To start a new search after the Patron Search form is displayed, do the following:

a. Select one of the options for Search type, and then enter the required text in the search
box. The allowable search text is displayed in the search box when you select a search
type. The text entered is matched at the word and number level, so partial words or num-
bers will not return patrons or house customers with only partial matches. See an
example (if you search for 123, a patron with ID 1234 will not be included in the search
results).
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b. Click the Search button. The house customer records that match your search criteria are
displayed in the search results table.

5. To select a house customer, double-click the house customer row, or select the row and then
click the Continue button.

The house customer is loaded into the Order Management tab.

Editing Patrons in Order Management
Pac7 allows you to edit basic patron information right on the Order Management tab. However, if
you need to edit additional information in the patron record, you can also access and edit the full
patron record during order management. This same form may be accessed on the Patron tab and
during item sales, depending the configuration of your control.

To edit a patron record during order management

1. Click the Order Management tab.

2. Select the patron whose record you want to edit.

3. Click the patron button.

4. Select Edit patron.
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Tip: You can also access the full patron edit from the Patron Summary page. See Viewing Pat-
ron Summaries in Order Management for more information.

The Patron Information page is displayed.

5. If you need to contact the patron whose record you are editing, you can send an email from
the Enter Patron Information page. To start a new email for the patron, select an address
from the email address drop-down list, and then click the Send Email buttonx

.

If the email address list is not displayed or the required address is not in the list, you can add
email addresses to the patron record by doing the following:

a. Click the Home tab, and then locate the Phone/Email group.

b. In the Email section, enter the email address in the text box adjacent to the email type.

c. Click the Hold Updates buttonx . Pac7 redisplays the Enter Patron
Information page with the email address drop-down list.

6. On the Patron Information page, edit the fields on one or more of the patron record tabs, as
required.
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Depending on your selling control, some tabs and data fields may not be displayed. Some
fields allow you to enter more than one value (multi-value fields).

Use these multi-value fields as follows:

l For a multi-value text box, enter text in the text box, and then click the add more buttonx

.

The system adds a text box below the original one, allowing you to make another text
entry. You can repeat this process to add as many entries as required.

l For a multi-value drop-down list, select an option from the drop-down list, and then click

the add more buttonx .

The system displays your selection in static text above the drop-down list, allowing you to
add another selection. You can repeat this process to add as many selections as required.
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l For a multi-value drop-down list with a text box, select an option from the drop-down list,

enter text in the adjacent text box, and then click the add more buttonx .

The system displays another line with a drop-down list and a text box, allowing you to
make an additional entry.

Note: To delete a multi-value line, click its delete buttonx . The system redisplays the
page with the line removed.

Note: If you enter information on a patron record tab and then click one of the other tabs
before saving the record, Pac7 will display a dialog box (for example, in Internet Explorer)
that requires you to either hold (temporarily save) or discard the information you entered.
To hold the information without getting this dialog box, click the Hold Updates buttonx

before you click another tab.

7. If you want to enter fund development information for a patron and you have the per-
missions, use the Development tab. If you have permissions and the tab is not displayed for
the patron, do the following:

a. Click the Home tab, and then select the Donor option.

b. Click the Hold Updates buttonx , and then click the Development tab.
The system displays the Development tab.
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8. If you want to enter ticketing information for a patron, use the Ticketing tab.

9. If you want to enter organization information for a patron and you have the permissions, do
the following:

a. Click the Home tab, and then select the Organization patron type.

b. Enter the organization name, and then select the organization type.

c. Click the Hold Updates buttonx . The system adds the Organization
tab for the patron. You can now click the tab to display the organization data fields.

d. Enter organization information as required.

10. Click the Save Record buttonx . The edits are saved and the Order Man-
agement page is redisplayed.

Selecting Seasons in Order Management
Once you have selected an individual patron or a house customer, you need to select the season
containing the order or inventory you want to or adjust or sell. Only open seasons that have been
configured for the current selling control can be selected. The default season selection is the one
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configured for your operator access, as long as that season is open and configured for the selling
control.

If there is no default season and more than one open season available in the control, you must
select a season for the first patron order. However, seasons configured in the control will not be
available if a season activity has operator restrictions and the current operator does not have
access. Once a season has been selected for the first order, that season will be the default for the
next order.

To select the season for an order

1. Click the Order Management tab.

2. Select the patron for the order.

3. In the Season drop-down list, select the season containing the order or inventory you want to
adjust or sell.

4. Click the Go button. The existing order lines or a new order line will display in the Order
Lines table.

Adding Order Level Information in Order Management
Information that is associated with a specific patron and season is called order level information.
Order level information includes comments, tags, and order priority. Order comments can be any
alphanumeric string. Tags are one-word identifiers used for marking the record. You can use them
to select tagged records when generating reports, labels, mailings, and markings with user
requests in the back office. Order priority is a number in a priority system that is specific to your
organization. For example, they can be used to prioritize seat changes and upgrades when pro-
cessing season renewals.
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Note: Changes made using this form will not be submitted until the order is processed.

To add order level information for a selected customer and season

1. Click the Order Management tab.

2. Select the patron, and then select the season.

The order level options are displayed in the order level toolbar.

3. Click the comments button.

The Comments and Miscellaneous form is displayed.

4. In the Order Comment box, enter any character string, including special characters and
numbers. Pressing your Enter key adds a new line to the comments. HTML code is treated as
text.

5. In the Priority box, enter the number that represents the order priority for your organ-
ization. You can use a dash for a negative sign and a period for decimal places. Pac7 always
displays 2 decimal places. If you use three or more decimal places, the decimals will be roun-
ded down to two places. If you enter one decimal place or a whole number, Pac7 adds a 0 for
each unused decimal place. See examples:

This entry... Is displayed...

12 12.00

Pac7 Release 7.2



User Guide  232

This entry... Is displayed...

12.1 12.10

12.10 12.10

12.111 12.11

12.118 12.12

6. In the Tag box, enter the tag codes for the order. Tag codes cannot contain spaces and can
be made of any combination of alphanumeric characters. Tag codes are also case sensitive
(for example, you can use TAG, Tag, and tag for the same order). To add a tag, click in an
empty row, click in a row with a tag entered and press the Enter key, or click the plus

buttonx . To remove a tag, click in the tag row, and then click the minus buttonx .

7. Click the Continue button. The information is saved and the form is closed. You can add to
or edit this information at any time by opening the patron season order again and clicking the

comments buttonx .

You can now continue processing the patron order. The changes will not be saved until you fin-
ish processing the order.

Editing User Defined Fields in Order Management
Although there are many system defined fields within the Paciolan software, your organization may
decide to collect data that is not defined by the system. In this case, user defined (UD) fields may
have been created to collect and display the desired information in Pac7. The following types of UD
fields are supported:

l Editable UD fields. These are text boxes that allow you to enter specific UD information.
l UD fields that reference UD codes. These fields allow you to select a value from a predefined
list of UD codes.

l Read-only UD fields. These fields display data that is pulled from elsewhere in the system
and are not editable.

This functionality is only available if UD fields are configured for the TK.ORDER file. Each field can
be required or optional. The type of information required for a field may be alphanumeric,
numeric, date format, or monetary unit. Each information type may also be configured to require a
drop-down selection or allow multiple entries.

Note: Changes made using this form will not be submitted until the order is processed.

To edit user defined fields during order management

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

The order level options are displayed in the order level toolbar.

3. Click the user fields button.

The User Defined Fields form is displayed.

4. Enter or select data in the user defined fields. Fields that allow multiple entries (multi-valued
fields) include plus and minus buttons at the bottom of the text box.

To add an entry in a multi-valued field, click in a row with a value entered and press the

Enter key, or click the plus buttonx . To remove a value, click in the value's row, and then

click the minus buttonx .

5. Click the Continue button. You can edit this data again at any time during order processing

by clicking the user fields buttonx .
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You can now continue processing the patron order. The changes will not be saved until you fin-
ish processing the order.

Using Order Level Actions in Order Management
When managing patron orders on the Order Management tab, you can work at both the order and
order line levels. Order level actions apply to the order as a whole and include selecting a patron
and season, editing patron records, adding order charges, and using other order level actions.

The order level actions you can use include the following:

l Add application items
l Use billing plans
l Use customer seat holds
l View previous season overviews
l Print the Boca batch summary
l Reorder/reallocate items
l Reprint prior receipts

Note: In addition to using order level actions, you can add order level information for the selected
patron and season, including comments, tags, and order priority. If your organization has created
custom fields for patron information entry, you can edit the fields at the order level. You can also
add order charges and view the order amount breakdown at the order level.

Adding Application Items in Order Management

If you have published a season renewal application for a patron to eVenue, you can add items from
the application to the patron's order in order management. This allows your patrons to contact the
box office to order if they do not want to order the application items online. The items in an applic-
ation can include any combination of single event, combination, miscellaneous, and donation
items. Access pass and gift certificate items are not available when adding application items.

Applications are available in Pac7 once they have been published to eVenue. If you print hard copy
applications for customers, they are not available from within Pac7. In back office terms, the avail-

Pac7 Release 7.2



User Guide  235

able applications are preseason (as opposed to postseason), since they are pulled from the pre-
vious season and published for individual patrons.

A patron may also have more than one application available for a selected season. In this case,
you must select an application from which you want to add items to order lines. You can also select
items from multiple applications at the same time. Once an application item is added to an order
line, you can edit the order line like any other added order line item.

When adding application items to order lines in Pac7, you are allowed to add quantities of items
that are not allowed by customer item limits and order quantity rules (min/max/multiple). The
application items function will also list items that are not configured in the current selling control,
as well as allow you to add them to order lines. However, these quantity and item restrictions will
be enforced when you attempt to finish processing the patron's order on the Order Management
tab. You will then have to change the quantities to successfully process the order.

The item maximum quantity limit set in the application template is enforced when you attempt to
add items to order lines. However, once the order line is added to the tab, you can change the
quantity to any amount within the customer item limit and the order quantity rules. In this way,
you are allowed to process order lines that exceed the application item quantity limit.

To add an application item to an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

The order level options are displayed in the order level toolbar.

3. Click the Order actions button, and then select Application items from the drop-down

list. If the Application items buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Application Items form is displayed.
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4. If the patron has more than one application available, select one of the applications from the
Application drop-down list. If the patron has only one application, it is automatically dis-
played in the form.

5. For each item the patron wants to purchase, click the item row to expand the item, and then
enter the desired quantity of the item. For single event and combo items, multiple price
level/price type (PL/PT) combinations may be available. You can enter any quantity up to the
maximum quantity (in the Max qty column) for each PL/PT. If there is no number in the
Max qty column, the quantity is unlimited. You can collapse an expanded item by clicking
the item row. Your item quantity entries are maintained when you collapse items.

6. If the patron has multiple applications for the season and you want to add items from
another application, do the following:

a. Select the application from the Application drop-down list and then, when the Attention
dialog box is displayed, click the Yes button.

b. Enter the quantities for the requested application items. Click the item row to expand
application items and enter item quantities. For single event and combo items, multiple
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price level/price type (PL/PT) combinations may be available. You can enter any quantity
up to the maximum quantity (in the Max qty column) for each PL/PT. If there is no num-
ber in the Max qty column, the quantity is unlimited. You can collapse an expanded item
by clicking the item row. Your item quantity entries are maintained when you collapse
items.

7. Click the Continue button.

The Order Management tab is redisplayed with the application items that have quantities spe-
cified added to order lines.

Using Billing Plans in Order Management

Billing plans allow your patrons to pay for their orders in installments, instead of all at once when
they place the orders. When working on the Order Management tab, you can assign billing plans to
order lines and order charges, and then view or edit the plans at the order level or when entering
payment information.

Note: To assign a billing plan to an order line, the order form assigned to your selling control must
include a billing plan column for the Order Lines table. See your box office manager for more
information.
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You can assign a default payment type to all the installments of a billing plan or different payment
types to individual installments. If a billing plan is configured to be changeable, you can change
individual installment amounts. When you change the amount of individual installments, you can
immediately recalculate the distribution of the amount due across all installments in the plan.
However, an individual installment cannot be changed after it has been billed (invoiced), so it will
not be included in the recalculation.

To select a billing plan for a single order charge

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Add Order Charge group, select a billing plan from the Select a bill plan drop-down
list.

To select billing plans for orders with multiple order charges

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Add Order Charge group, click the Prior order charges link.
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The Prior Order Charges form is displayed.

4. In the Billing plan column, select billing plans for order charge rows from the drop-down
lists.

5. Click the Continue buttonx .

To select a billing plan for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. If you haven't yet added the order items for which you want to select a billing plan, add the
order lines.

4. In each order line for which you want to select a billing plan, select the billing plan from the
Bill plan column. If the Bill plan column is not displayed, your selling control is not con-
figured with an order form that includes the column. See your box office manager for more
information.
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To edit a billing plan from the order level

1. Click the Order Management tab.

2. Select the patron, and then select the season.

To edit a billing plan, it must be assigned to one or more of the patron's order lines for the
season. The same billing plan may be assigned to multiple order lines, and individual order
lines may have different billing plans.

3. Click the Order actions button, and then select Bill plans from the drop-down list. If the

Bill plan buttonx is also in the toolbar, you can click the button instead of selecting the
command from the drop-down list.
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The Billing Plans form is displayed. The patron name and number (in parentheses) are in the
Patron field, and the season name is in the Season field.

4. To change the displayed billing plan, select one from the drop-down list. Only billing plans
that have been selected in an order line or an order charge are available. If you have made
changes to the currently displayed billing plan, you will be prompted to save the changes
when you switch to another plan.

5. If you want to add or change the default payment type for all the installments, do one of the
following:

Note: If you enter a payment type here, it will be used for any installments that do not have
a payment type specified in the Installments table below. If you don't enter a payment type
here or in the Installments table, payment type information can be added later.

l To select a new payment type, select the payment type from the Default payment type
drop-down list. Depending on the payment type, you may also need to enter additional
information, such as credit card number and expiration date.
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l If the patron has previously used one or more credit cards and you want to use one of
them, do the following:

i. Click the Use previous credit card link. This link is only displayed if the patron has
previously used a credit card for an order.

The Use Previous Credit Card form is displayed.

ii. Select the row of the card you want use, and then click the Continue buttonx

. The credit card information is loaded into the default payment type
fields.

l If a default payment type is selected and you do not want to use one for the billing plan,
select the blank menu option.

6. If you want to use a different payment type for an individual installment, do the following:

Note: This individual installment payment type setting will override the default payment
type, if you entered one above.

a. Select the row of the installment to which you want to assign a payment type by clicking
anywhere in the row.

b. Click the row in the Payment type column to display the drop-down list, and then select
the payment type.
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c. Depending on the payment type, you may also need to enter patron specific information in
the Number, Month, and Year columns. For example, a credit card may require the
credit card number, the expiration month, and the expiration year. See an example.

7. If the billing plan is configured to be changeable, you can also do one or more of the fol-
lowing:

Action Instructions

Add an install-
ment after the
last scheduled
installment.

Click the down arrow next to the plus button, and then select Add an
installment from the drop-down list.

A new installment row is added after the last scheduled installment.

Insert an
installment
between two
scheduled
installments.

Select the row above which you want to insert the new installment, click the
down arrow next to the plus button, and then select Insert an installment
from the drop-down list.
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Action Instructions

A new installment row is added above the selected installment.

Delete an
installment
row.

Select the row of the installment that you want to delete, and then click the
trash button.

Recalculate
installment
amounts after
changing the
installment
total.

Click the Recalculate button.

This recalculation is necessary if the sum of the installment amounts is not
equal to the total amount allotted to the billing plan (amount due). The total
allotted to the billing plan is the sum of the item and order charge balances
of all of the order lines that have been assigned the billing plan.
These totals will not match if you change the installment total by adding an
installment row with an amount, deleting an installment row that had an
amount, or changing the amount in an existing installment row.
The recalculation is done using the tRes recalculate algorithm (percentages
are recalculated for each installment based on the updated Amount values,
and then each amount is recalculated based on the updated percentages). If
invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.
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8. If the Installment total amount is not the same as the Total on plan amount, make them

equal by clicking the Recalculate buttonx . The recalculation is done using the
tRes recalculate algorithm (percentages are recalculated for each installment based on the
updated Amount values, and then each amount is recalculated based on the updated per-
centages). If invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.

9. To save changes and return to the Order Management tab, click the Continue button.

To view or edit a billing plan when finishing or paying an order

1. Click the Order Management tab.

2. Select the patron, and then select the season.

To edit a billing plan, it must be assigned to one or more of the patron's order lines for the
season. The same billing plan may be assigned to multiple order lines, and individual order
lines may have different billing plans.
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3. Click the Finish and pay buttonx . If an Attention dialog box prompts you
to go the billing plans page for the patron, click the No button. Or, you can click the Yes but-
ton to view or change billing plans without finishing and paying the order.

The Payment Information page is displayed.

4. In the Payment Methods group, click the Billing Plan button.

The Billing Plans form is displayed. The patron name and number (in parentheses) are in the
Patron field, and the season name is in the Season field.
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5. To change the displayed billing plan, select one from the drop-down list. Only billing plans
that have been selected in an order line or an order charge are available. If you have made
changes to the currently displayed billing plan, you will be prompted to save the changes
when you switch to another plan.

6. If you want to add or change the default payment type for all the installments, do one of the
following:

Note: If you enter a payment type here, it will be used for any installments that do not have
a payment type specified in the Installments table below. If you don't enter a payment type
here or in the Installments table, payment type information can be added later.

l To select a new payment type, select the payment type from the Default payment type
drop-down list. Depending on the payment type, you may also need to enter additional
information, such as credit card number and expiration date.

l If the patron has previously used one or more credit cards and you want to use one of
them, do the following:

i. Click the Use previous credit card link. This link is only displayed if the patron has
previously used a credit card for an order.
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The Use Previous Credit Card form is displayed.

ii. Select the row of the card you want use, and then click the Continue buttonx

. The credit card information is loaded into the default payment type
fields.

l If a default payment type is selected and you do not want to use one for the billing plan,
select the blank menu option.

7. If you want to use a different payment type for an individual installment, do the following:

Note: This individual installment payment type setting will override the default payment
type, if you entered one above.

a. Select the row of the installment to which you want to assign a payment type by clicking
anywhere in the row.

b. Click the row in the Payment type column to display the drop-down list, and then select
the payment type.

c. Depending on the payment type, you may also need to enter patron specific information in
the Number, Month, and Year columns. For example, a credit card may require the
credit card number, the expiration month, and the expiration year. See an example.
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8. If the billing plan is configured to be changeable, you can also do one or more of the fol-
lowing:

Action Instructions

Add an install-
ment after the
last scheduled
installment.

Click the down arrow next to the plus button, and then select Add an
installment from the drop-down list.

A new installment row is added after the last scheduled installment.

Insert an
installment
between two
scheduled
installments.

Select the row above which you want to insert the new installment, click the
down arrow next to the plus button, and then select Insert an installment
from the drop-down list.

A new installment row is added above the selected installment.
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Action Instructions

Delete an
installment
row.

Select the row of the installment that you want to delete, and then click the
trash button.

Recalculate
installment
amounts after
changing the
installment
total.

Click the Recalculate button.

This recalculation is necessary if the sum of the installment amounts is not
equal to the total amount allotted to the billing plan (amount due). The total
allotted to the billing plan is the sum of the item and order charge balances
of all of the order lines that have been assigned the billing plan.
These totals will not match if you change the installment total by adding an
installment row with an amount, deleting an installment row that had an
amount, or changing the amount in an existing installment row.
The recalculation is done using the tRes recalculate algorithm (percentages
are recalculated for each installment based on the updated Amount values,
and then each amount is recalculated based on the updated percentages). If
invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.

9. If the Installment total amount is not the same as the Total on plan amount, make them

equal by clicking the Recalculate buttonx . The recalculation is done using the
tRes recalculate algorithm (percentages are recalculated for each installment based on the
updated Amount values, and then each amount is recalculated based on the updated per-
centages). If invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.

Pac7 Release 7.2



User Guide  251

10. To save changes and return to the Order Management tab, click the Continue button.

Using Customer Seat Holds in Order Management

Pac7 allows you to place seats from single event items on temporary hold (counter hold) for a cus-
tomer during order management. This process does not create an order for the seats. Customer
held seats are saved for individual customers and are independent of the order management sales
process. You can edit customer seat holds at any time after they are created.

Once a customer seat hold is created and processed, you can add the held seats to an order line if
the patron decides to purchase the seats. You can also release customer held seats without adding
them to an order.

When using customer seat holds during order management, you can do the following:

l Add Customer Seat Holds
l Add Held Seats to Customer Orders
l Edit Customer Seat Holds
l Release Held Seats

Adding Customer Seat Holds in Order Management

Customer seat holds allow you to place seats from a single event on temporary hold for a customer
during order management. This process does not add the seats to an order. Instead, a separate file
is updated and the seats are marked with a special seat status (for example, a status of T for
Timed). Held seats are saved independently of the order management sales process.

Tip: You can also place seats on hold for an order directly using the best available seat feature, the
seat map, an area search, a search plan, or the Seat Fields form.
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More than one group of seats can be held for a single patron and season combination. For this
reason, each group of held seats is automatically assigned a unique sequence number. Each
sequence of held seats can be moved to an order or released independently.

When placing seats on hold for a patron, you can specify a date and time for the customer hold to
expire. A process runs at 4 AM and 4 PM in the back office to find any unsold seat holds that have
expired and release the seats. You can also manually release held seats at any time. For more
information, see Releasing Held Seats in Order Management.

The seats you select for customer hold are placed on counter hold until you save the sequence.
When you save the sequence, they are moved from counter hold to customer hold status. Once the
seats are on customer hold, you can add the held seats to the customer's order at any time. You
can also edit a customer hold after it has been added.

Note: Held seats are included in the audit report as unsold items showing the maximum potential
revenue.

To place seats on hold for a patron

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.

4. Click the Add new buttonx . The page is redisplayed with NEW in the Sequence id
box and entry fields in the Details and Seat Holds groups.
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5. If you know the code of the event item for which you want to hold seats, enter it in the new
event field of the Seat Holds group.

6. If you need to search for the event item for which you want to hold seats, do the following:

a. Click the magnifying glass button next to the new event field.

The Search for Item form is displayed.

b. To search using the information you know about the item, enter any combination of the
standard search box and the Advanced search parameters, and then click the Search

buttonx .
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Description of standard search box

When searching using the standard search type, you enter text that describes the item for
which you are looking. You can enter more than one word at a time for a search, since the
default operator between all words and terms is AND. For example, if you enter Bas-
ketball February, the results will display only basketball games that take place in
February. The item fields whose values are searched include the following:

l Item code
l Item name
l Season code
l Facility code
l Facility name
l Keywords (defined in the back office)
l Day of the week
l Month of the year
l Year
l Item basis/item type
l Event date using mm/dd/yy or dd/mm/yy format

Prepositions, conjunctions or common verbs are ignored when performing a search (for
example, about, the, of, a, in, as, if, not, why, never, before, is, it). Search options you
can use with your search text include the following:

l AND operator. Use the AND operator between two words to only return events if
their details include both words.

l OR operator. Use the OR operator between two words to return events that include
either word in their details. This type of search typically returns more records than
the default AND search.

l NOT operator or - (minus sign). Use the NOT operator or the minus sign in front of a
word to exclude it from the search (for example, men's basketball NOT Thursday)

l Quotation marks. Use quotation marks around two or more words to search for an
exact term. You can use quotation marks in conjunction with operators, the minus
sign, and wildcards.

l ? (question mark) and * (asterisk) wildcards. Use the question mark in place of a
single character and the asterisk in place of zero or more characters. Wildcards can-
not be used as the first character or the only character in a search string.

Description of Advanced search parameters

The item search function also includes advanced search options that allow you to further
narrow your search results. These include using a date range, facility, event time (morn-
ing, afternoon, or evening), and any combination of event days in conjunction with your
search text. All of the parameters are optional. See descriptions of the parameters.

Parameter Description

Date from Enter the date from which to begin the item search. You can either
enter the date in mm/dd/yyyy format, or you can click the calendar
icon and select one from the popup calendar. If no Date to date is
entered, all valid items from this date into the future will be
searched. If no date is entered here, all valid items with past dates
will be searched, unless your selling control is configured to drop
past events. Multiple day events will be included in the search if
either the Date from or Date to falls within the event date range.
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Parameter Description

Date to Enter the date through which you want to run the item search. You
can either enter the date in mm/dd/yyyy format, or you can click the
calendar icon and select one from the popup calendar. If no Date
from date is entered, all valid past items through this date will be
searched, unless your selling control is configured to drop past
events. If no date is entered here, all valid items in the future will be
searched. Multiple day events will be included in the search if either
the Date from or Date to falls within the event date range.

Facility Select the facility to which you want to limit the item search. Only
facilities for which the season is valid are available for selection.

Item type Only the single event item type can be selected.

Event time Select the start time of the items that you want to search. The selec-
tions are time frames, including Morning (12:00 am to 11:59 am),
Afternoon (12:00 pm to 4:59 pm), and Evening (5:00 pm to 11:59
pm). Times are calculated using the facility time zone. Multiple day
events are included if any part of the time range falls within the selec-
ted time frame. TBA events are included for all time frames.

Event day Select the days of the week of the events you want to include in the
search. Multiple day events are included if any of the days in the
range match the selected days. If all days of the week are cleared,
the search results will include events that occur on any day of the
week.

c. To select from a list of items you have recently used for seat holds and order lines, click
the Recent Items tab. Up to the last 50 selected item codes from your current Pac7 ses-
sion are listed. Items selected from multiple event search results are not added to this
list.

d. To find an item within the search results, enter item information in the Find box. Records
that contain the text are highlighted as you enter the text.

You can use the up and down arrows to move between the highlighted records.
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7. Select the item for which you want to hold seats, and then click the Continue button.

If your organization requires a password for customer seat holds or other relevant restric-
tions (for example, item sale dates), the Password Required form displays. Enter the pass-

word, and then click the Continue buttonx .

The event is added to a row in the Seat Holds table.

8. In the Qty column, enter the number of seats to hold and then, in the Price level and Price
type columns, enter the price level and price type codes. If you don't know the codes or you
want to split the seats between two or more price level/price type combinations, do the fol-
lowing:

a. Click in the Price level cell, and then click the magnifying glass button.
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The Price Split form is displayed.

b. From the Price level drop-down list, select the price level and then, in the Available
Price Types table, enter the desired quantity of seats by price type.

c. If you want to split the quantity with another price level, select a new price level from the
Price Level drop-down list, and then enter price type quantities. The price type quant-
ities for the first price level are retained when you change to the new price level. You can
split the quantities among as many price levels as you want. The quantity of price types
assigned by price level is displayed in the adjacent Summary table.

d. Click the Continue buttonx . The price level/price type quantities you selec-
ted are added to the Seat Holds table. If you split the quantity between price level/price
type combinations, a new row is added for each one. The example below contains a quant-
ity of 6 that is split into 3 rows with a quantity of 2 for the 1:R, 2:R, and 3:R price level/-
price type combinations.

9. Assign seatblocks to each Seat Holds table row by selecting the row and then doing one of
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the following:

l To automatically assign the best available seats, click the best available seats button.

The assigned seats are put on counter hold and added to the Seatblock column. You can
click the seatblock data to display the status of the held seats. You can also use the seat
map to change the seat assignments.

l To use the seat map to assign seats, click the view seat map button.

The overview version of the seat map page is displayed. Use the seat map to select the

seats to hold, and then click the Continue buttonx . For more information,
see Using the Seat Map in Order Management.

The assigned seats are put on counter hold and added to the Seatblock column. You can
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click the seatblock data to display the status of the held seats. You can also use the seat
map to change the seat assignments.

10. If you want to mark one or more of the seat hold rows, select a mark from the drop-down
list in the Mark code column for each one. You may choose to mark held seats for such pro-
cesses as reporting, tracking marketing sources, or flagging seats to print separately from
mass printings.

11. If you want to select a disposition for one or more of the seat hold rows, select one from
the drop-down list in the Disposition column for each one.

12. If you want to set a date and time for when to automatically release the held seats, do the
following:

a. In the Expiration date box, enter the date in mm/dd/yyyy format, or select a date from

a calendar by the clicking the calendar buttonx .
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b. From the Expiration time drop-down list, select the expiration time. If you do not select
an expiration time, the held seats will be released at 11:59 PM on the expiration date. To
enter an expiration time, you must also enter an expiration date.

13. If you want to record additional information about the seat hold, enter it in the Comments
box.

14. Click the Save button. The seats are changed from counter held to customer held, a
sequence ID number is assigned, and then the Order Management tab is redisplayed. The
sequence ID number to used to distinguish the held seats from existing or future blocks of
held seats.

15. Save the order by clicking the Finish buttonx . You can now order the customer
held seats at any time.

Ordering Customer Held Seats in Order Management

Customer seat holds allow you to place seats from a single event on temporary hold for a customer
without adding them to a customer order. If seats are on customer hold at the order level and the
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patron decides to purchase them, you can move the held seats to order lines. This process is called
ordering customer held seats. You change held seats to ordered status by moving the event item
and its accompanying order quantity, price level, price type, seatblock, disposition, and mark code
to order lines on the Order Management tab.

Because a patron can have more than one set of customer held seats at once, each set is assigned
a sequence number. You use the sequence number to select the set of held seats that you want to
add to an order line. When using the sequence numbers to locate and order customer held seats,
note the following:

l Sequence sets can contain seat quantities for one or more item price level/price type (PL/PT)
combinations.

l If a sequence set has more than one item PL/PT combination, you can select one, some, or
all of them to add to order lines at once.

l For each PL/PT combination you add to an order, you can choose to add less than the full
quantity of seats that are on hold. If you add less than the full quantity of held seats for a
PL/PT combination, you can still add the remaining seats from the sequence set to order lines
later on.

Any customer held seats that are not going to be added to order lines should be taken off hold and
released to open status. For more information, see Releasing Customer Held Seats in Order Man-
agement.

To order held seats in order management

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Order held seats from the drop-down list.

If the Order held seats buttonx is also in the toolbar, you can click the button instead of
selecting the command from the drop-down list. If this control is not in the drop-down list,
there are no seats on hold or you have not yet processed the order for the held seats.

The Order Held Seats form is displayed.
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4. Select the sequence containing the held seats you want to add to the patron's order by doing
one of the following:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .

If you enter a number for which there is no sequence, the Seat Holds Search form is dis-

played. Select the sequence row, and then click the Continue buttonx . You
can also just double-click the sequence row.

l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.
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Once you have selected a sequence, the Held Seats table and associated information are dis-
played on the Order Held Seats form.

Note: On this form, you can only change which PL/PT combination rows are selected and
what quantity of seats will be added for them. The rest of customer hold information is read-
only.

5. If there are multiple rows (item PL/PT combinations) in the Held Seats table, select the
rows containing the seats you want to add to the patron's order.

6. If you want to decrease the number of seats added to the order for an item PL/PT com-
bination row, change the number in the Qty column.

7. Click the Continue buttonx . The selected held seats are added to new rows in
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the Order Lines table on the Order Management tab.

Editing Customer Seat Holds in Order Management

Customer seat holds allow you to place seats from a single event on temporary hold for a customer
without adding them to a customer order. Once you have added a customer seat hold, you can edit
it at any time until you delete the seat hold sequence. The information you can edit includes expir-
ation date and time, comments, quantity of held seats, event items held, and seatblocks.

If you delete an existing event item with allocated seats, any counter held seats will immediately
be released. If there are customer held seats allocated, they will be released when you save the
sequence.

Once you have added a customer seat hold sequence, you can edit it using one or more of the fol-
lowing procedures:

To change the expiration date and time

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.
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4. Select the sequence containing the held seats you want to edit or delete by doing one of the
following:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .

If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.

l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.
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Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.

5. To edit the expiration date and time do the following:

a. In the Expiration date box, enter the date in mm/dd/yyyy format, or select a date from

a calendar by the clicking the calendar buttonx .

b. From the Expiration time drop-down list, select the expiration time. If you do not select
an expiration time, the held seats will be released at 11:59 PM on the expiration date. To
enter an expiration time, you must also enter an expiration date.

6. Click the Save button. Your edits are saved, and the Order Management tab is redisplayed.
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To edit the comments

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.

4. Select the sequence containing the held seats you want to edit or delete by doing one of the
following:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .

If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.
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l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.

Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.

5. Add, edit, or delete comments in the Comments box.
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6. Click the Save button. Your edits are saved, and the Order Management tab is redisplayed.

To change the quantity of held seats for an event item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.
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4. Select the sequence containing the held seats you want to edit or delete by doing one of the
following:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .

If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.

l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.
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Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.

5. For each event item whose quantity you want to change, do the following:

a. In the Seat Holds table, locate the row of the event item, and then click the row in the
Qty column.

b. Change the quantity, and then click the seat map button.

The detailed view of the seat map is displayed with the focus on the held seats. In this
example seat map, Seat Hold 4 is the current quantity of held seats and Ordered 2 is
the quantity to which you want to change.
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c. Select and deselect seats on the seat map until the Held Qty is equal to the Initial
Order Qty.

d. Click the Continue buttonx .

The Order Management tab is redisplayed with the new quantity and seatblock in the Seat
Holds table.

6. Click the Save button. Your edits are saved, and the Order Management tab is redisplayed.
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To add an event item and allocate seats

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.

4. Select the sequence containing the held seats you want to edit or delete by doing one of the
following:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .
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If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.

l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.

Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.
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5. In the Seat Holds table, click the add event button.

An event row is added to the table.

6. If you know the code of the event item for which you want to hold seats, enter it in the new
event field of the Seat Holds group.

7. If you need to search for the event item for which you want to hold seats, do the following:

a. Click the magnifying glass button next to the new event field.
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The Search for Item form is displayed.

b. To search using the information you know about the item, enter any combination of the
standard search box and the Advanced search parameters, and then click the Search

buttonx .

Description of standard search box

When searching using the standard search type, you enter text that describes the item for
which you are looking. You can enter more than one word at a time for a search, since the
default operator between all words and terms is AND. For example, if you enter Bas-
ketball February, the results will display only basketball games that take place in
February. The item fields whose values are searched include the following:

l Item code
l Item name
l Season code
l Facility code
l Facility name
l Keywords (defined in the back office)
l Day of the week
l Month of the year
l Year
l Item basis/item type
l Event date using mm/dd/yy or dd/mm/yy format

Prepositions, conjunctions or common verbs are ignored when performing a search (for
example, about, the, of, a, in, as, if, not, why, never, before, is, it). Search options you
can use with your search text include the following:

l AND operator. Use the AND operator between two words to only return events if
their details include both words.

l OR operator. Use the OR operator between two words to return events that include
either word in their details. This type of search typically returns more records than
the default AND search.
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l NOT operator or - (minus sign). Use the NOT operator or the minus sign in front of a
word to exclude it from the search (for example, men's basketball NOT Thursday)

l Quotation marks. Use quotation marks around two or more words to search for an
exact term. You can use quotation marks in conjunction with operators, the minus
sign, and wildcards.

l ? (question mark) and * (asterisk) wildcards. Use the question mark in place of a
single character and the asterisk in place of zero or more characters. Wildcards can-
not be used as the first character or the only character in a search string.

Description of Advanced search parameters

The item search function also includes advanced search options that allow you to further
narrow your search results. These include using a date range, facility, event time (morn-
ing, afternoon, or evening), and any combination of event days in conjunction with your
search text. All of the parameters are optional. See descriptions of the parameters.

Parameter Description

Date from Enter the date from which to begin the item search. You can either
enter the date in mm/dd/yyyy format, or you can click the calendar
icon and select one from the popup calendar. If no Date to date is
entered, all valid items from this date into the future will be
searched. If no date is entered here, all valid items with past dates
will be searched, unless your selling control is configured to drop
past events. Multiple day events will be included in the search if
either the Date from or Date to falls within the event date range.

Date to Enter the date through which you want to run the item search. You
can either enter the date in mm/dd/yyyy format, or you can click the
calendar icon and select one from the popup calendar. If no Date
from date is entered, all valid past items through this date will be
searched, unless your selling control is configured to drop past
events. If no date is entered here, all valid items in the future will be
searched. Multiple day events will be included in the search if either
the Date from or Date to falls within the event date range.

Facility Select the facility to which you want to limit the item search. Only
facilities for which the season is valid are available for selection.

Item type Only the single event item type can be selected.

Event time Select the start time of the items that you want to search. The selec-
tions are time frames, including Morning (12:00 am to 11:59 am),
Afternoon (12:00 pm to 4:59 pm), and Evening (5:00 pm to 11:59
pm). Times are calculated using the facility time zone. Multiple day
events are included if any part of the time range falls within the selec-
ted time frame. TBA events are included for all time frames.

Event day Select the days of the week of the events you want to include in the
search. Multiple day events are included if any of the days in the
range match the selected days. If all days of the week are cleared,
the search results will include events that occur on any day of the
week.

c. To select from a list of items you have recently used for seat holds and order lines, click
the Recent Items tab. Up to the last 50 selected item codes from your current Pac7
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session are listed.

d. To find an item within the search results, enter item information in the Find box. Records
that contain the text are highlighted as you enter the text.

You can use the up and down arrows to move between the highlighted records.

8. Select the item for which you want to hold seats, and then click the Continue button.

If your organization requires a password for customer seat holds or other relevant
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restrictions (for example, item sale dates), the Password Required form displays. Enter the

password, and then click the Continue buttonx .

The event is added to a row in the Seat Holds table.

9. In the Qty column, enter the number of seats to hold and then, in the Price level and Price
type columns, enter the price level and price type codes. If you don't know the codes or you
want to split the seats between two or more price level/price type combinations, do the fol-
lowing:

a. Click in the Price level cell, and then click the magnifying glass button.

The Price Split form is displayed.

b. From the Price level drop-down list, select the price level and then, in the Available
Price Types table, enter the desired quantity of seats by price type.

c. If you want to split the quantity with another price level, select a new price level from the
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Price Level drop-down list, and then enter price type quantities. The price type quant-
ities for the first price level are retained when you change to the new price level. You can
split the quantities among as many price levels as you want. The quantity of price types
assigned by price level is displayed in the adjacent Summary table.

d. Click the Continue buttonx . The price level/price type quantities you selec-
ted are added to the Seat Holds table. If you split the quantity between price level/price
type combinations, a new row is added for each one. The example below contains a quant-
ity of 6 that is split into 3 rows with a quantity of 2 for the 1:R, 2:R, and 3:R price level/-
price type combinations.

10. Assign seatblocks to each Seat Holds table row by selecting the row and then doing one of
the following:

l To automatically assign the best available seats, click the best available seats button.

The assigned seats are put on counter hold and added to the Seatblock column. You can
click the seatblock data to display the status of the held seats. You can also use the seat
map to change the seat assignments.
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l To use the seat map to assign seats, click the view seat map button.

The overview version of the seat map page is displayed. Use the seat map to select the

seats to hold, and then click the Continue buttonx . For more information,
see Using the Seat Map in Order Management.

The assigned seats are put on counter hold and added to the Seatblock column. You can
click the seatblock data to display the status of the held seats. You can also use the seat
map to change the seat assignments.

11. If you want to mark one or more of the seat hold rows, select a mark from the drop-down
list in the Mark code column for each one. You may choose to mark held seats for such pro-
cesses as reporting, tracking marketing sources, or flagging seats to print separately from
mass printings.
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12. If you want to select a disposition for one or more of the seat hold rows, select one from
the drop-down list in the Disposition column for each one.

13. Click the Save button. Your edits are saved, and the Order Management tab is redisplayed.

The seats are changed from counter held to customer held

To delete an event item

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.

4. Select the sequence containing the held seats you want to edit or delete by doing one of the
following:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .

If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.
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l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.

Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.

5. Select the event item row that you want to delete, and then click the delete event button.

An Attention dialog box is displayed warning you about releasing held seats. This will release
both the counter held and customer held seats for the event item row. For more information
about releasing held seats, see Releasing Customer Held Seats in Order Management.
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6. Click the Yes buttonx . The event item row is deleted and the seatblock is
removed from customer seat hold.

7. Click the Save button. Your edits are saved, and the Order Management tab is redisplayed.

To change the allocated seats in the seatblock

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.

4. Select the sequence containing the held seats you want to edit or delete by doing one of the
following:
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l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .

If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.

l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.

Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.
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5. For each event item whose seatblock allocation you want to change, do the following:

a. Select the event item row, and then click the seat map button.

The detailed view of the seat map is displayed with the focus on the held seats. In this
example seat map, Ordered 2 is the current quantity of held seats.

Select and deselect seats as required, and then click the Continue buttonx .

If you changed the quantity of selected seats, a Warning dialog box is displayed. Click the
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Adjust order qty > button.

The Customer Seat Holds page is redisplayed with the new seatblock in the Seatblock
column.

6. Click the Save button. Your edits are saved, and the Order Management tab is redisplayed.

To release allocated seats for an event item or a whole sequence

Releasing Customer Held Seats in Order Management

Customer seat holds allow you to place seats from a single event on temporary hold for a customer
without adding them to a customer order. If seats placed on customer hold are not going to be
ordered by the patron, they need to be released to open (o) status to allow other patrons to order
them. Held seats are released by you or by an automatic process when they expire.

To be automatically released, customer held seats must be set to expire at a specific date and
time. The expiration date and time can be added or edited at any time. At expiration, any remain-
ing unordered seats are marked for release. A process runs daily at 4 AM and 4 PM in the back
office that will locate and release the marked seats.

If you want to immediately release customer held seats, you can do it manually by deleting event
item seatblocks or whole customer hold sequences from the Customer Seat Holds page. You can
also release held seats using the Seat Fields form from the order line. When seats are released
their status is changed to open and they are available for other orders.

To release customer held seats for an event item within a sequence

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.
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The Customer Seat Holds page is displayed.

4. Select the sequence containing the held seats you want to release by doing one of the fol-
lowing:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .

If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.

l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.
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Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.

5. Select the event item row containing the seatblock you want to release, and then click the
delete event button.

An Attention dialog box is displayed warning you about releasing held seats.

6. Click the Yes buttonx . The event item row is deleted and any seats on counter
hold are released.

7. Click the Save button. Seats from the event item row that were on customer hold are
released, and the Order Management tab is redisplayed.
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To release customer held seats for a whole sequence

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Customer seat holds from the drop-down

list. If the Customer seat holds buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Customer Seat Holds page is displayed.

4. Select the sequence containing the held seats you want to release by doing one of the fol-
lowing:

l If you know the sequence number of the held seats, enter the number in the Sequence id

box, and then click the magnifying glass buttonx .
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If you enter a number for which there is no sequence, the Seat Holds Search form is dis-
played with all current sequences. Select the sequence row, and then click the Continue

buttonx . You can also just double-click the sequence row.

l To select a sequence from the list of available sequences for the patron, click the mag-

nifying glass buttonx . The Seat Holds Search form is displayed. Select the sequence

row, and then click the Continue buttonx . You can also just double-click the
sequence row.

Once you have selected a sequence, the current values are displayed in the Details group
and the Seat Holds table on the Customer Seat Holds form.
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5. In the Details group, click the Delete this sequence link.

An Attention dialog box displays.

6. Click the Yes buttonx . The counter hold and customer hold seats are released,
and the Order Management tab displays.

Viewing Previous Season Overviews in Order Management

The orders you manage for a patron are based on seasons. If the current order season has a pre-
vious season and the patron purchased items from the previous season, you can view a seasonal
search for order report from the Pac7 Order Management tab. This report includes an order sum-
mary, order totals, order history, and payment history for the previous season.

To view a summary of a patron's order information from a previous season

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Previous season overview from the

drop-down list. If the Previous season overview buttonx is also in the toolbar, you
can click the button instead of selecting the command from the drop-down list.

The Previous Season Overview report is displayed.

4. When you are finished viewing the report, click the Close buttonx to redisplay the
Order Management tab.

Generating the BOCA Sales Summary Report

The BOCA sales summary report tracks daily ticket sales for a user or terminal. The report shows
the amount of daily sales broken down for each paymode (for example, Visa, Mastercard, or
Cash). This report can be printed to ticket stock or viewed using a Web browser. It is available
through the Pac7 menu and from the Order Management tab.
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To generate a BOCA Sales Summary report from the Pac7 menu

1. In the Pac7 menu, click the Reporting link.

Pac7 displays the Reporting page.

2. Click the BOCA Sales Summary Report link. Pac7 displays the BOCA Sales Summary Report
version of the Report Criteria page.

3. Set the date range for the report:

l In From, enter the beginning date and time of the date range for the report.
l In To, enter the ending date and time of the date range for the report.

Note: This report can only show results for a 24-hour time period.

4. For the Show All Sales criteria, select one of the following options:

Pac7 Release 7.2



User Guide  296

l This User: Shows sales for the currently logged in user.
l This Terminal: Shows sales for the current terminal. This is useful to track sales if mul-
tiple users are selling from the same terminal.

5. If the view is selectable, select the view that you want to use to generate the report. For
more information, see Managing BOCA Sales Summary Report Views.

6. In the File Format list, select one of the following formats for the report:

l HTML: Outputs the report in HTML and displays the report in a Web browser.
l Print to Ticket Stock: Prints the report on ticket stock.

Note: If you do not have access to a BOCA printer, you cannot print the report on ticket
stock. You can print to a laser printer instead, by selecting HTML in the File Format list. When
you run (generate) the report, Pac7 will display the report in your default Web browser (for
example, Internet Explorer). You can then print the report using the Web browser's Print com-
mand, usually located in the File menu.

7. Click the Run button. Pac7 generates the BOCA Sales Summary Report. Totals are adjusted
for voids and returns.

To generate a BOCA Sales Summary report from the Order Management tab

1. Click the Order Management tab.

2. Select the patron, and then select the season.
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3. Click the Order actions button, and then select Print boca batch summary from the
drop-down list.

The BOCA Sales Summary Report form is displayed.

4. Set the date range for the report:

l In From, enter the beginning date and time of the date range for the report.
l In To, enter the ending date and time of the date range for the report.

Note: This report can only show results for a 24-hour time period.

5. For the Show All Sales criteria, select one of the following options:

l This User: Shows sales for the currently logged in user.
l This Terminal: Shows sales for the current terminal. This is useful to track sales if mul-
tiple users are selling from the same terminal.

6. If the view is selectable, select the view that you want to use to generate the report. For
more information, see Managing BOCA Sales Summary Report Views.

7. In the File Format list, select one of the following formats for the report:
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l HTML: Outputs the report in HTML and displays the report in a Web browser.
l Print to Ticket Stock: Prints the report on ticket stock.

Note: If you do not have access to a BOCA printer, you cannot print the report on ticket
stock. You can print to a laser printer instead, by selecting HTML in the File Format list. When
you run (generate) the report, Pac7 will display the report in your default Web browser (for
example, Internet Explorer). You can then print the report using the Web browser's Print com-
mand, usually located in the File menu.

8. Click the Run button. Pac7 generates the BOCA Sales Summary Report. Totals are adjusted
for voids and returns.

9. To close the report and return to the Order Management tab, click the X buttonx at the
upper right of the report form.

Reordering and Reallocating Items in Order Management

You can secure payment for future events and increase revenue by renewing items for your pat-
rons from season to season. Renewable items are usually single combo items, however patrons
may have more than one renewable item (for example, single events, multiple seat blocks, or park-
ing items). The renewal process includes both reordering and reallocating items, although you can
reorder items without reallocating the seats. If you also reallocate event items, the seats pur-
chased for the old season are added to the reordered events for the new season.

You can renew items for patrons in bulk using the TK.REORDER and TK.REALLOCATE processes in
tRes. However, if want to renew items for individual patrons, you can also use the reorder-
/reallocate feature during Pac7 order management. When you reorder an item in order man-
agement, it is added to an order line in the patron's order on the Order Management tab.

To reorder seats from a previous season to the new season, the items must be available in the both
seasons and the renewal process in tRes must also have been run for the previous season.

If you want to reallocate seats when you reorder in Pac7, reallocated seatblocks can also be
assigned for the new order line. You can also choose to reallocate seats after adding reordered
items to order lines. To reallocate reordered items, the event price level/price type combinations
that were purchased in the old season must also be available for the events in the new season.

If some of the event items from a renewable fixed combo item are no longer available, the missing
event items will be automatically prorated out during reordering. The reorder process will also add
autoload items to order lines. If a customer has more than one renewable item, all of them will be
added to order lines as part of this process. You can delete the order lines of any unwanted renew-
able items after they have been added to the Order Management tab.
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To reorder items from a previous season without reallocating seats

1. Click the Order Management tab.

2. Select the patron, and then select the season.

The order level options are displayed in the order level toolbar.

3. Click the Order actions button, and then select Reorder/Reallocate from the drop-down

list. If the Reorder/Reallocate buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Reorder/Reallocate form is displayed with the list of renewable items.

If you want to see the events in a combo item, you can click the link in the Name column to
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display the Event Details form. Click the Close buttonx on the Event Details
form to return to the Reorder/Reallocate form.

4. Click the Continue buttonx and then, when the Attention dialog box displays,
click the OK button.

The Order Management tab is redisplayed with an order line for each item in the renewal.
There will also be order lines for autoloaded items, if any of the renewable items have auto-
load items configured.

Note: No seats have been allocated yet for any of the event items.

To reorder and reallocate items from a previous season

1. Click the Order Management tab.

2. Select the patron, and then select the season.

The order level options are displayed in the order level toolbar.
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3. Click the Order actions button, and then select Reorder/Reallocate from the drop-down

list. If the Reorder/Reallocate buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Reorder/Reallocate form is displayed with the list of renewable items.

If you want to see the events in a combo item, you can click the link in the Name column to

display the Event Details form. Click the Close buttonx on the Event Details
form to return to the Reorder/Reallocate form.
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4. Click the Reallocate seats button.

The reallocated seats are added to the Seatblock column as linked seatblock description
text.

Note: The events in the new season must have the same price level/price type combinations
that were purchased for the events in the old season.

If you want to see the seat assignments for each event in a combo item, click its seatblock

link in the item row to display the Event Details form. Click the Close buttonx
to return to the Reorder/Reallocate form.

If you want to see the status of the seats that are allocated to a single event item, click its
seatblock link in the item row to display the Seat Fields form. Click the Close buttonx

on the Seat Fields form to return to the Reorder/Reallocate form.
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5. Click the Continue buttonx and then, when the Attention dialog box displays,
click the OK button.

The Order Management tab is redisplayed with an order line for each item in the renewal.
There will also be order lines for autoloaded items, if any of the renewable items have auto-
load items configured.

Seats have also been reallocated for the new combo and single event item order lines.

To reallocate previously reordered renewable items

1. Click the Order Management tab.

2. Select the patron, and then select the season.

The order level options are displayed in the order level toolbar.
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3. Make sure the renewable items have already been reordered into the Order Lines table. If
they have not been reordered, use one of the reorder procedures above.

4. Click the Order actions button, and then select Reallocate from the drop-down list.

The seatblocks are reallocated to the reordered order lines and the Order Management tab is
redisplayed.

Reprinting Prior Receipts in Order Management

Payment receipts may be reprinted by payment type after items are paid for and processed during
order management. When you reprint receipts for payment types, they include payments for all of
a patron's processed orders from a season. You can reprint receipts for multiple payment types at
the same time.

To reprint a payment receipt for a patron, you must have processed one or more order lines in the
season for the patron. An order line is considered processed after seats are assigned and one or
more payment types are used to purchase them. Reprinting can only be done for one patron in a
single season at a time.

You can reprint receipts for any of the system defined payment types (paymodes), including cash,
checks, gift certificates, gift cards, credit cards, and other defined types. Since all system payment
types are available, the payment types that can be reprinted may include ones that have not been
configured in the current selling control.

By default one copy will be reprinted for each payment type. However, the number of copies for a
payment type will be different if a receipt group is used for the selling control, the payment type is
in the receipt group, and the number of copies set for the payment type is greater than one.

You can reprint payment receipts from the order level options on the Order Management tab. You
can also reprint them from the end of sale confirmation when finishing an order with or without pro-
cessing payments.
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To reprint a receipt from the order level options on the Order Management tab

1. Click the Order Management tab.

2. Select the patron, and then select the season.

The order level options are displayed in the order management toolbar.

3. Click the Order actions button, and then select Reprint prior receipts from the drop-

down list. If the Reprint prior receipts buttonx is also in the toolbar, you can click the
button instead of selecting the command from the drop-down list.

The Reprint Prior Receipts form is displayed.

4. Select the rows containing the payment types for which you want to reprint receipts. You can
select all the payment types at once by selecting the heading row. In the example below,
receipts will print for purchases made with cash and a Visa credit card.
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5. Click the Print button. Receipts are printed for purchases made with the selected payment
types.

To reprint a receipt at the end of a sale when processing payments

1. Click the Order Management tab.

2. Select the patron, and then select the season.

Note: The patron must have previously processed orders before the reprint receipts option is
available through this procedure.

3. Click the Finish and pay buttonx . If the Sale Code form is displayed,

select the sale code, and then click the Continue buttonx .

The Payment Information page is displayed.
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4. In the Payment Methods table, enter any required information for the payment type rows.
You can also add more payment types.

5. Click the Purchase buttonx . The End of Sale - Confirmation form is dis-
played.

6. Click the Reprint prior receipts link.

The Reprint Prior Receipts form is displayed.

7. Select the rows containing the payment types for which you want to reprint receipts. You can
select all the payment types at once by selecting the heading row. In the example below,
receipts will print for purchases made with cash and a Visa credit card.
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8. Click the Print button. Receipts are printed for purchases made with the selected payment
types.

To reprint a receipt at the end of a sale when no payment processing is needed

1. Click the Order Management tab.

2. Select the patron, and then select the season.

Note: The patron must have previously processed orders before the reprint receipts option is
available through this procedure.

3. Click the Finish button.

Note: If the order has changes with a fiscal impact, the Payment Information page will display
and you will need to process payments before you can reprint the receipt.

4. If the Sale Code form is displayed, select the sale code, and then click the Continue

buttonx .
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5. When the End of Sale - Confirmation form is displayed, click the Reprint prior receipts
link.

The Reprint Prior Receipts form is displayed.

6. Select the rows containing the payment types for which you want to reprint receipts. You can
select all the payment types at once by selecting the heading row. In the example below,
receipts will print for purchases made with cash and a Visa credit card.

7. Click the Print button. Receipts are printed for purchases made with the selected payment
types.
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Editing Patron Information in Order Management
Once you've selected a patron for order management, you can edit the patron’s phone, email,
address, and comments information from the pages of the Order Management tab during order and
payment information entry. The address, email, and phone type fields available for editing are
determined by the patron policy that is assigned to your selling control. If you need to modify other
patron information, you will need to edit the full patron record instead.

To edit a patron's phone numbers and email addresses on the Order Management tab

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Phone/Email section of the customer information group, click the Edit link.

The Edit Phone/Email form is displayed.

4. Click in the Phone number and Email address columns to add, edit, or delete a number or
address.

5. When you finish editing, click the Save button. The Order Management tab is redisplayed
with your phone and email edits in the customer information.
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To edit a patron's geographic addresses on the Order Management tab

1. Click the Order Management tab.

2. Select the patron, and then select the season.

1. In the Address section of the customer information group, click the Edit link.

The Edit Address form is displayed.

2. Select the row containing the type of address you want to edit. If the address type has an
address entered already, the address information is displayed in the fields below the table.
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3. Add, edit, or delete the address information for each address type as required.

4. When you finish editing, click the Save button. The Order Management tab is redisplayed
with your address edits in the customer information.

Viewing the Patron Summary in Order Management
When working with a patron on the Order Management tab, you can choose to view a summary of
the information in the patron record at any time. In the patron summary general information is
always available. You can also view patron information that is specific to ticketing, if the patron is
a ticketing customer and your control allows you access to ticketing data. Similarly, you can view
fund development specific information if the patron is a donor and you have access to donor data.
If you are allowed to edit patron information, you can also access the full patron entry editing page
from the patron summary. The patron summary is not available if you are using a house customer.

To view the patron summary

1. Click the Order Management tab.

2. Select the patron whose record you want to edit.

3. Click the patron button.
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4. From the drop-down list, select Patron Summary.

The Patron Summary page is displayed.

Tip: On the Patron Summary page tabs (General Profile, Customer Profile, and Donor Pro-
file), you can expand and collapse each section by clicking the arrow button.

General Profile tab field descriptions

Pac7 Release 7.2



User Guide  314

The table below describes the fields on the General Profile tab. See an image of the tab.

Field Usage information

Patron status The status of the patron (for example, Active, Deceased, or Inactive). The
back office code and code name are combined in the field.

Patron source The source from which the patron was added to the system (for example,
Internet, phone sales, or print advertisement). The back office code and
code name are combined in the field.

VIP code These codes are used to mark special patrons, such as high value donors.
The back office code and code name are combined in the field.

External Id A record locator from a system other than the Paciolan back office.

Announcement This text will display in an Attention message when the patron is added to a
ticket order or donation. If no text is displayed here, the VIP code and name
will display in the Attention message instead.

Comments Additional information about the patron.

Keywords Click the link to display a popup with the list of the patron's keywords. If no
link is displayed, the patron does not have any keywords assigned. Key-
words are helpful for patron searches.

Tags Click the link to display a popup with the list of the patron's tags. If no link
is displayed, the patron does not have any tags assigned. Tags are useful
for reporting and request building.

Salutations Click the link to display a popup with the list of the salutation types asso-
ciated with the patron. For each salutation type, the salutation text (for
example, Mr.) is also displayed.

User Defined A popup link that displays the user defined field descriptions and values that
relate to the patron. This link is always displayed.

Address This section includes the address type and the address for the patron's
addresses. The address types displayed are determined by your control.

Names This section includes the names and basic personal information of Name
One and Name Two of the patron record. Depending on the available patron
information, Biographic, Institutions, Children, and Related Patrons links
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Field Usage information

may be displayed. Click these links to display popups with the information.

Phone This section includes the phone type and number for the patron's phone
numbers. The phone types displayed are determined by your control.

Email This section includes the email type and address for the patron's email
addresses. The email types displayed are determined by your control.

Customer Profile tab field descriptions

The table below describes the fields on the Customer Profile tab. See an image of the tab.

Field Usage information

Ticketing
Information

This section displays the relevant ticketing information for the patron.

Customer
type

The ticketing customer type.

Customer
status

The ticketing customer status of the patron (for example, Active, Deceased,
or Inactive).

Priority
points

The total number of priority points accumulated by the patron.

Department The ticketing department code associated with the patron.

Billing
address

The billing address of this patron.

Shipping
address

The shipping address of this patron.

Magstripe ID
(last 4 digits)

The last 4 numbers of the patron's magstripe ID. This field will only be dis-
played if it is allowed for your control.

Comments Comments about this patron.

Memberships Click this link to display a popup with the patron's ticketing membership
records. This link will not display if it is not allowed for your control or if no
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Field Usage information

membership information exists.

eVenue pro-
file

Click this link to display a popup with the patron's eVenue information. This
link may not display based on your control and whether any profile inform-
ation exists.

Tags A popup link that displays the ticketing tags associated with the patron. This
link will only display if the patron record has ticketing tags. Ticketing and
development tags are independent of one another. Tags are useful for report-
ing and request building.

User Defined A popup link that displays the user defined field descriptions and their values.
This link is always displayed. Ticketing and development user defined fields
are independent of one another.

Credit Status This section contains information about the patron's credit.

Status This is the credit status message that displays during the sales process. The
message can warn about a credit limit or deny a sale.

Limit If the Status message is set to warn about a credit limit, this is the dollar
amount of the limit.

Comments This section may contain additional information about the status of the pat-
ron’s credit.

Ticketing
Activities

This table displays the number of years a patron has purchased tickets by
activity. YOP stands for years of purchase. Wait list priority is based on you
box office's business practices.

Order His-
tory

This section is a table containing the patron's order history. Each row sum-
marizes all purchases for a single season. You can double-click a season row
to display a new window that details the patron's individual orders for that
season.

Attendance
History

Attendance history data is only relevant if you use Access Management. To
display the patron's attendance history, click the Retrieve history link. This is
necessary because the history does not load automatically. No data will dis-
play if the patron has no attendance history.
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Field Usage information

If you need to update the patron's data again, click the Back buttonx
, and then select the Patron Summary menu item. On the Patron Summary
page click the profile tab, and then click any one of the retrieve links.

Renewable
Seats

This table contains the patron's renewable seats by season. Each season has
its own row. Click the Retrieve data link to display the renewable seats for
the patron. This is necessary because the data does not load automatically.
No data will display if the patron has no attendance history.

If you need to update the patron's data again, click the Back buttonx
, and then select the Patron Summary menu item. On the Patron Summary
page click the profile tab, and then click any one of the retrieve links.

Donor Profile tab field descriptions
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The table below describes the fields on the Donor Profile tab. See an image of the tab.

Field Usage information

Donor Information The section displays the relevant development information for the pat-
ron.

Ranking This is the ranking of the patron based on the total number of priority
points accumulated.

Years of donating The number of years the patron has donated to your organization.

Priority points The total number of priority points accumulated by the patron.

Publish name The default name as it will appear in publications, such as an annual
report or a playbill.

Billing address The billing address for this patron.

Shipping address The shipping address selected for this patron.

Comments Additional comments about this patron.

Tags Click this link to display a popup with the development tags associated
with the patron. This link will only display if the patron record has devel-
opment tags. Development and ticketing tags are independent of one
another. Tags are useful for reporting and request building.

Mail codes Click this link to display a popup with the codes that determine what
mailings the donor will receive. This link will only display if the patron
record has mail codes assigned.

User Defined Click this link to display a popup with the user defined fields and their
values, as entered in the back office. Development and ticketing user
defined fields are independent of one another. This link will only display
if the patron record has entries in user defined fields.

Last Donation The data from the last donation and the lifetime donation amount for the
patron. If no data is displayed, click the Retrieve last donation link to
display the latest data. When you click this link, data is also retrieved
for the Pledges/Donation History, Programs, and Campaigns sections.
The displayed data includes the drive, date, payment amount, and
pledge amount for the patron's last donation. The patron's lifetime total
donation amount is also displayed.
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Field Usage information

Credit Status This section displays information about the status of the patron’s credit.

Status This is the credit status message that displays during pledge and dona-
tion entry for this patron. The message can warn about a preference to
use a credit card, for example.

Comments Additional comments about the patron's credit status.

Memberships This table displays the patron's membership information, including the
current and last membership names and dates.

Pledges/Donations
History

This section contains a table of the patron's donation history by drive. If
no data is displayed, click the Retrieve history link to display the latest
history for the patron. When you click this link, data is also retrieved for
the Last Donation, Programs, and Campaigns sections. No data will dis-
play if the patron has no pledge/donation history.

If you need to update the patron's data again, click the Back buttonx

, and then select the Patron Summary menu item. On the Patron
Summary page click the profile tab, and then click any one of the
retrieve links.

Programs This section contains a table of the patron's donation history by pro-
gram. If no data is displayed, click the Retrieve programs link to display
the programs to which the patron has contributed. When you click this
link, data is also retrieved for the Last Donation, Pledges/Donation His-
tory, and Campaigns sections. This necessary because the data does not
load automatically. No data will display if the patron has no donation his-
tory.
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Field Usage information

If you need to update the patron's data again, click the Back buttonx

, and then select the Patron Summary menu item. On the Patron
Summary page click the profile tab, and then click any one of the
retrieve links.

Campaigns This section contains a table of the patron's donation history by cam-
paign. If no data is displayed, click the Retrieve campaigns link to dis-
play the campaigns to which the patron has contributed. When you click
this link, data is also retrieved for the Last Donation, Pledges/Donation
History, and Programs sections. This necessary because the data does
not load automatically. No data will display if the patron has no donation
history.

If you need to update the patron's data again, click the Back buttonx

, and then select the Patron Summary menu item. On the Patron
Summary page click the profile tab, and then click any one of the
retrieve links.

5. When you are finished viewing the Patron Summary, click the Back button.
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The Order Management page is redisplayed.

Using Contact Entry in Order Management
Contact entry allows you to track your interactions, such as meetings, phone calls, and email mes-
sages, with your patrons. The contact entry feature allows operators with sufficient privileges to
create new contact records, as well as edit or delete existing ones. Contact entry also allows you to
keep track of which of your employees makes contact with a patron and the people who are con-
tacted when attempting to contact the patron. Contacts are not associated with seasons, and they
cannot be used for house customers.

To create a new contact record for a patron

1. Click the Order Management tab.

2. Select the patron for which you want to create a contact record.

3. Click the patron button.

4. From the drop-down list, select Contact Entry.

The Contact Entry form is displayed.
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5. Click the Add new button. Pac7 enters New in the Contact Id field.

6. If the contact with the patron is on a date other than today, enter it in the Date field, or click

the calendar buttonx to select it from the calendar. The format of a date entry must be
mm/dd/yyyy.

7. If the contact time is different than the current time, enter it in the Time field. A time entry
must be in hours and minutes using the format 00:00 AM or 00:00 PM.

8. From the Status drop-down list, select one of the status options (P - Pending, S - Scheduled,
I - Incomplete, F - Finished, C - Cancelled, or O - Other) for the contact entry.

9. Depending on your business practices, you may choose to enter additional contact inform-
ation using one or more of the following options:

l If your organization tracks the type of contact you make with patrons (for example, a
phone call or meeting), select it from the Type drop-down list.
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l If your organization tracks the operators that make contact with patrons and you know
which operators will be making contact, do the following:

i. Under the Persons making contact table, click the plus buttonx . An empty row is
added to the table.

ii. Click on the row, and then enter the name of the person making contact with the pat-
ron.

iii. Use the plus buttonx and the minus buttonx to add or delete other persons mak-
ing contact with the patron.

l If your organization tracks the people who are contacted when attempting to make con-
tact with patrons and you know who one or more of the contacts are, do the following:

i. Under the Persons contacted table, click the plus buttonx . An empty row is added
to the table.
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ii. Click on the row, and then enter the name of the person with whom you communicated
when attempting to make contact with the patron.

iii. Use the plus buttonx and the minus buttonx to add or delete other persons who
are contacted.

l If you have any comments to record about the contact, enter them in the Comments box.

Tip: You can restore the default settings of the Contact Entry form at any time by clicking

the Reset buttonx . All of your settings and entries will be lost.

10. Click the Save button.

An Attention dialog box is displayed with the new contact ID. The contact ID is composed of
the patron ID and the highest comment number plus one. The 2 numbers are separated by a
colon (:). See an example: If the patron ID is 4567 and the highest existing contact record
number for the patron is 3, the contact ID 4567:4 is created.

11. Click the OK button. The Contact Entry form is redisplayed. You can then choose to cre-

ate, edit, or delete another contact entry, or you can click the Close buttonx to
close the form and redisplay the Order Management page.

To edit a contact entry

1. Click the Order Management tab.

2. Select the patron with the contact record you want to edit.

3. Click the patron button.
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4. From the drop-down list, select Contact Entry.

The Contact Entry form is displayed.

5. Select the contact record by doing one of the following:

l If you know the contact ID number, enter it in the Contact Id field.

l If you do not know the contact ID, do the following:

i. In the Contact Id field, click the magnifying glass button.
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The Contact Search form is displayed.

ii. To find a record within the search results, scroll enter contact record information in the
Find box. Records that contain the text are highlighted as you enter the text.

You can the use the up and down arrows to move between the highlighted records.

You can also sort the contacts by column by clicking a column header. In this example, the contact
records are sorted by date.

iii. Double-click the contact record's row, or select the row and click the Continue button.
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The Contract Entry form is redisplayed with the selected record loaded.

6. Change the Contact Id, Date, Time, and Status entries and selections as required. The
contact ID number can be changed to a new number or to the number of a deleted contact
record. If you change the contact ID number to an existing contact ID number, the existing
contact record will be loaded in place of the record you are editing. If you have made
changes to any of the other contact entry fields (for example, Date or Time), the changes
are still saved to the edited record.

7. Enter or change the rest of the contact information using one or more of the following
options:

l If your organization tracks the type of contact you make with patrons (for example, a
phone call or meeting), select it from the Type drop-down list.

l If your organization tracks the operators that make contact with patrons and you know
which operators will be making contact, do the following:

i. Under the Persons making contact table, click the plus buttonx . An empty row is
added to the table.
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ii. Click on the row, and then enter the name of the person making contact with the pat-
ron.

iii. Use the plus buttonx and the minus buttonx to add or delete other persons mak-
ing contact with the patron.

l If your organization tracks the people who are contacted when attempting to make con-
tact with patrons and you know who one or more of the contacts are, do the following:

i. Under the Persons contacted table, click the plus buttonx . An empty row is added
to the table.

ii. Click on the row, and then enter the name of the person with whom you communicated
when attempting to make contact with the patron.

iii. Use the plus buttonx and the minus buttonx to add or delete other persons who
are contacted.

l If you have any comments to record about the contact, enter them in the Comments box.

Tip: You can restore the last saved version of the contact record by clicking the Reset

buttonx . All of your changes will be discarded.

8. Click the Save button.
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The changes to the contact are saved, and the Contact Entry form is redisplayed without a
contact record loaded.

To delete a contact entry

1. Click the Order Management tab.

2. Select the patron with the contact record you want to delete.

3. Click the patron button.

4. From the drop-down list, select Contact Entry.

The Contact Entry form is displayed.
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5. Select the contact record by doing one of the following:

l If you know the contact ID number, enter it in the Contact Id field.

l If you do not know the contact ID, do the following:

i. In the Contact Id field, click the magnifying glass button.

The Contact Search form is displayed.

ii. To find a record within the search results, scroll enter contact record information in the
Find box. Records that contain the text are highlighted as you enter the text.
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You can the use the up and down arrows to move between the highlighted records.

You can also sort the contacts by column by clicking a column header. In this example, the contact
records are sorted by date.

iii. Double-click the contact record's row, or select the row and click the Continue button.

The Contract Entry form is redisplayed with the selected record loaded.

6. Click the Delete this contact link.
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The contact is deleted, and the Contact Entry form is redisplayed without a contact record
loaded.

Using Order Charges in Order Management
You can add one or more order charges at the order level on the Order Management tab at any
time. Depending on the setup of your selling control, a default order charge may automatically be
applied to new orders. You can also edit or delete order charges after they have been added to an
order. Possible edits include changing the billing plan, charge date, or charge amount.

Depending on the configuration of the order charge, you may be able to change an order charge to
a different amount after adding it to an order. The new amount may also be negative if it is allowed
by the configuration.

You can also assign billing plans to individual order charges once they are added to an order. If you
do not assign a billing plan to an order charge, the order charge will be due when the order is pro-
cessed. See Using Billing Plans in Order Management for more information.

Order charges are separate from ticket charges, which are applied to individual order lines.
However, ticket charges can be moved to order charges and are treated somewhat differently than
normal order charges.

Ticket charges may be moved to order charges when performing various back office processes
(exchanges, deletions, reductions in quantity, online returns, back office returns, online trans-
fers, back office transfers, and voids). You can see the source and item code (for example,
Internet Transfer - F0903 is an online transfer of item F0903) for an order charge that was
a ticket charge when you display prior order charges from the Order Management tab.

Order charges that have been added by moving ticket charges cannot be deleted or changed to
another order charge. However, you can change the assigned billing plan and charge date. If the
order charge the ticket charge is moved to allows you to change amounts, you can only change
the amount to 0.

If a fee cap amount is set for a season, the fee cap order charge is automatically added to the
order when the order fees exceed the cap. You can always change the assigned billing plan and
charge date. The fee cap configuration in your selling control determines whether or not you can
change the selected order charge or amount.

To add a single order charge to a patron's seasonal order

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. In the Add Order Charge group, select an order charge from the Select a charge drop-
down list.

4. If you want to change the amount of the order charge, enter the new amount in the amount
box. If you cannot change the amount, the order charge is configured to not allow changes.

5. If you want the order charge to be included in a billing plan, select the plan from the Select
a bill plan drop-down list.

6. Finish order processing. The new order charge is saved for the patron's seasonal order.

To add multiple order charges to a patron's seasonal order

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Add Order Charge group, click the Prior order charges link.
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The Prior Order Charges form is displayed.

4. If there are already order charges in the Order charge column, click the plus buttonx to
add a new row.

5. In the Order charge column of the row, select the order charge from the drop-down list.

6. If you want to add the order charge to a billing plan, select it from the Billing plan column
drop-down list.

7. If you want to use a date other than today's date for the order charge, enter it in the Date

column or click the calendar buttonx to select it.
8. If the order charge amount is changeable and you need to use a different amount, enter it in
the Amount column.
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9. Add more order charges as required using the steps above.

10. Click the Continue buttonx . The order charges are added in the Add Order
Charge group to the Prior order charges and Total charges amounts.

11. Finish order processing. The new order charges are saved for the patron's seasonal order.

To edit order charges for a patron's seasonal order

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Add Order Charge group, click the Prior order charges link.

The Prior Order Charges form is displayed.

4. Edit order charges as required. Each table row is an order charge. For each order charge,
you can change the billing plan, charge date and, if it is configured to be changeable, the
charge amount.

5. Click the Continue buttonx . If you changed the amount of one or more order
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charges, the Prior order charges and Total charges amounts in the Add Order Charge
group will be changed by those amounts.

6. Finish order processing. The order charge changes are saved for the patron's seasonal order.

To delete an order charge from a patron's seasonal order

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Add Order Charge group, click the Prior order charges link.

The Prior Order Charges form is displayed.

4. Select the row of the order charge you want to delete, and then click the trash buttonx .
The order charge row is deleted.

5. Click the Continue buttonx . In the Add Order Charge group, the Prior order
charges and Total charges amounts will be decreased by the amount of the deleted order
charge.
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6. Finish order processing. The patron's seasonal order is changed without the deleted order
charge.

Changing Batches
A batch is a record of item transactions collected over a period of time to store item sales and
returns data. Batch information is used for reconciling sales and reports. For example, during the
renewal cycle, customers typically have several batches of renewal forms to process. Cash man-
agement personnel create batches of forms, assign batch numbers, and run an adding machine
tape on each batch. They may also edit a batch after records have been added.

Batches can be used in two states: permanent or temporary. Permanent batches are set up in the
back office for each operator code in the selling control. These batches are used by the operators
assigned these codes until the batches are changed in the control, expire, or are changed auto-
matically by the system. The majority of sales and returns transactions are written to permanent
batches.

Note: The system only stops a user from continuing due to an invalid batch at the start of trans-
actions. If a batch becomes invalid between the start and the end of a transaction, a new batch is
automatically created and the transaction is written to the new batch.

A batch is considered temporary when you switch from the permanent batch to a new batch in the
Paciolan interface during the sales or returns processes. To switch to a temporary batch, your
assigned operator code must have Batch Change access set up in the back office (tRes).

To change a batch, do one of the following:

l Change the permanent batch.
l Change to a temporary batch.

Viewing the Order Amount Breakdown in Order Management
When working with patron orders on the pages of the Order Management tab, you can easily view
the breakdown of monetary amounts for individual patron order totals. This is useful anytime you
want to see the components of the current order total. For example, you can see how much of the
order is due to item costs versus order charges or ticket fees.

The order amount breakdown includes the individual totals of all order lines for each of the fol-
lowing components:

l Item prices. The sum of all item price amounts. Each item price amount is the price of the
item multiplied by the quantity in the order line, with no fees or order charges included.

l Facility fee. The sum of all facility fee amounts.
l Discount. The sum of all discount amounts.
l Surcharge. The sum of all surcharge amounts.
l Item charge. The sum of the per ticket item charge amounts. This does not include item
charges that have been moved to order charges. On the Order Management tab this value is
referred to as the charge amount.

l Order charge. The sum of all order charges.
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You can display the order amount breakdown from the Order Management, Payment Information,
and Payment Application pages on the Order Management tab. The Payment Application page is
only available if you choose not to apply payments at the end of order processing. For more inform-
ation, see Applying Payments in Order Management.

To display the Order Amount Breakdown from the Order Management page

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Totals group, click the Order amount link.

The Order Amount Breakdown form is displayed.

4. To return to the Order Management tab, click the Close buttonx .

To display the Order Amount Breakdown from the Payment Information page

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Finish and pay button. The Payment Information page is displayed.
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4. In the Order Totals group, click the Order amount link.

The Order Amount Breakdown form is displayed.

5. To return to the Payment Information page, click the Close buttonx .

To display the Order Amount Breakdown from the Payment Application page

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Finish and pay button. The Payment Information page is displayed.

4. In the Payment Methods table, add a valid payment type. You do not need to enter an
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amount.

5. In the Payment Options group, select Do no apply payments from the Payment dis-
tribution drop-down list.

6. Click the Purchase buttonx . The End of Sale - Confirmation form is dis-
played.

7. Click the Apply Payments button. The Payment Application page is displayed.

8. In the Order Summary group, click the Order amount link.
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The Order Amount Breakdown form is displayed.

9. To return to the Payment Application page, click the Close buttonx .

Using Order Line Processes in Order Management
An order line is an order management element that contains one item and its quantity for a selec-
ted patron and season. If the item is allocatable, the order line will also contain a price level, a
price type, and seatblock information. The order line is represented by a single row in the Order
Lines table on the Order Management tab. You can add, insert, edit, delete, and cancel order line
rows.

The order lines in order management allow you to search for and select items for an order, just as
you would in item sales using the onsale, general sale, or promo sales paths. However, order line
sales also gives access to many other order sales processes, such as cancels and voids, that are
not part of the item sales paths.
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The processes you can use when working with order lines in Pac7include the following:

Search for order lines View combo event order details

Add order lines View facility fees

Select items for order lines View item details

Select events for designer combos Prorate combination items

Select seats for allocatable items Print items

Price split by item PL/PT Reprinting Items

Allocate seats Deallocate seats

Use seat fields Cancel order lines

View seat assignments Void order lines

Note: Pac7 order management currently includes only a subset of the back office selling pro-
cesses. The remaining processes, such as returns and exchanges, are available using the TK.SELL
order form in tRes.

Searching for Order Lines in Order Management
Pac7 includes a simple text search feature to help you locate individual order lines in orders with a
large number of them. When searching order lines, your search text is compared to the fields in
each of the order line rows, and then the matching rows are shaded to distinguish them from non-
matching rows. You can also move between the highlighted search results directly without
scrolling.

To search for an order line in the Order Lines table

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, enter the text for which you want to search in the Find text box.
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The matching order lines are shaded. In this example, typing 17 in the Find box shades the
two rows with 17 in their item codes (F9017 and F1117).

You can also use the up and down arrows to move between the shaded order lines. The cur-
rently selected order line has a darker shade (dark green in the example below).

4. When you locate the order line, you can use order line processes for it as you normally
would.

Adding Order Lines in Order Management
Once you have selected a patron and a season on the Order Management tab, you can add order
lines as requested by the patron. When adding an order line you can choose to insert it within exist-
ing order line rows or add it to the bottom of the order line table.

Once you've added an order line, you must select an item and then enter any other required inform-
ation, such as a quantity and price level. You may also enter information on the Order Line
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Additional pane as required. Both the order line and its associated order line additional fields may
be required or optional, depending on the configuration of the form selected in your selling control.

The new order lines you add use current pricing, ticket charges, and fees. Fee caps are not applied
to new order lines until you enter the required information for the selected items.

To add an order line after existing order lines

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, click the plus buttonx , and then select Add order line.

The new order line is added to the bottom of the Order Lines table.

4. Select an item for the order line, and then enter information in the order line and Order Line
Additional pane as required.

To insert an order line above an existing order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. In the Order Lines table, click the order line row above which you want to insert the new
order line.
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4. Click the plus buttonx , and then select Insert order line.

The new order line is added to the Order Lines table above the row you selected.

5. Select an item for the order line, and then enter information in the order line and Order Line
Additional pane as required.

Selecting Items for Order Lines in Order Management
All tRes item types can be added to an order line, including single event, combo, miscellaneous,
donation, gift certificate, and access pass items. You can select a single item of any type for an
order line or select multiple single event items and create multiple order lines at once. You may
also use the multiple event item selection function to view multiple items at once and then choose
only one of the items for an order line.

l Selecting Single Items for Order Lines
l Selecting Multiple Events for Order Lines

Selecting One Item for an Order Line

Once you have selected the patron and season for an order, you can adjust an existing order line or
add an item to a new order line. You add an order line by searching for and selecting an item. To
help you find items as quickly as possible, Pac7 includes a standard text search, an advanced
search, and a recently selected item option.

Tip: You can also search for and select two or more events at the same time.

Pac7 supports the sale of the following item types: single events, fixed and designer combination
items, miscellaneous items, donation items, gift certificate items, and access pass items. The item
search can be used to locate and select items for any of these item types. Item Packages are not
supported in Pac7.

Standard search

When searching using the standard search type, you enter text that describes the item for which
you are looking. You can enter more than one word at a time for a search, since the default
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operator between all words and terms is AND. For example, if you enter Basketball
February, the results will display only basketball games that take place in February. The item
fields whose values are searched include the following:

l Item code
l Item name
l Season code
l Facility code
l Facility name
l Keywords (defined in the back office)
l Day of the week
l Month of the year
l Year
l Item basis/item type
l Event date using mm/dd/yy or dd/mm/yy format

Prepositions, conjunctions or common verbs are ignored when performing a search (for example,
about, the, of, a, in, as, if, not, why, never, before, is, it). Search options you can use with your
search text include the following:

l AND operator. Use the AND operator between two words to only return events if their details
include both words.

l OR operator. Use the OR operator between two words to return events that include either
word in their details. This type of search typically returns more records than the default AND
search.

l NOT operator or - (minus sign). Use the NOT operator or the minus sign in front of a word to
exclude it from the search (for example, men's basketball NOT Thursday)

l Quotation marks. Use quotation marks around two or more words to search for an exact
term. You can use quotation marks in conjunction with operators, the minus sign, and wild-
cards.

l ? (question mark) and * (asterisk) wildcards. Use the question mark in place of a single char-
acter and the asterisk in place of zero or more characters. Wildcards cannot be used as the
first character or the only character in a search string.

To select an item using the standard search

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. Add an order line.

4. In the Item cell of the order line, click the magnifying glass button.
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The Search for Item form is displayed.

You can also enter search text in the Item cell, and then click the magnifying glass button to
run the search. Using this method, results will be loaded into the Search for Item form when
it displays.

5. Enter your search text in the Search box, and then click the Search button.

Tip: To display all the events in the season, click the Search button with the default
Advanced search options and no text in the search box. Click the Reset button to remove
any text from the search box and reset the Advanced search options to their defaults.

The search results are displayed in the results table.
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When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.

6. Select the item you want to add to the order line, and then click the Continue button. You
can also just double-click the item.

Note: If the item is a gift certificate that requires manual ID number entry, the Enter Gift
Certificate form will display. If so, enter the number, and then click the Continue buttonx

.

The item is added to the order line.

Advanced search

The item search function also includes advanced search options that allow you to further narrow
your search results. These include using a date range, facility, item type (single event, combo, mis-
cellaneous, gift certificate, access pass, or donation), event time (morning, afternoon, or evening),
and any combination of event days in conjunction with your search text. All of the parameters are
optional. See descriptions of the parameters.

Parameter Description

Date from For single event items, enter the date from which to begin the item search.
You can either enter the date in mm/dd/yyyy format, or you can click the cal-
endar icon and select one from the popup calendar. If no Date to date is
entered, all valid items from this date into the future will be searched. If no
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Parameter Description

date is entered here, all valid items with past dates will be searched, unless
your selling control is configured to drop past events. Multiple day events will
be included in the search if either the Date from or Date to falls within the
event date range.

Date to For single event items, enter the date through which you want to run the item
search. You can either enter the date in mm/dd/yyyy format, or you can click
the calendar icon and select one from the popup calendar. If no Date from
date is entered, all valid past items through this date will be searched, unless
your selling control is configured to drop past events. If no date is entered
here, all valid items in the future will be searched. Multiple day events will be
included in the search if either the Date from or Date to falls within the
event date range.

Facility Select the facility to which you want to limit the item search. Only facilities for
which the season is valid are available for selection.

Item type Select the item type (single event, combo, access pass, donation, gift cer-
tificate, or miscellaneous) of the item for which you are searching. By default,
Pac7 searches all item types.

Event time For single event items, select the start time of the items that you want to
search. The selections are time frames, including Morning (12:00 am to 11:59
am), Afternoon (12:00 pm to 4:59 pm), and Evening (5:00 pm to 11:59 pm).
Times are calculated using the facility time zone. Multiple day events are
included if any part of the time range falls within the selected time frame. TBA
events are included for all time frames.

Event day For single event and combo items, select the days of the week of the events
you want to include in the search. Multiple day events are included if any of
the days in the range match the selected days. If all days of the week are
cleared, the search results will include events that occur on any day of the
week.

To select an item using the advanced search

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. Add an order line.

4. In the Item cell of the order line, click the magnifying glass button.
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The Search for Item form is displayed.

5. If you want to use search text in addition to advanced parameter values, enter the text in the
search box.

6. Click Advanced search to display the advanced search parameters.

7. Configure one or more of the advanced search parameters. All of the parameters are
optional. See descriptions of the parameters.

Parameter Description

Date from For single event items, enter the date from which to begin the item search.
You can either enter the date in mm/dd/yyyy format, or you can click the cal-
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Parameter Description

endar icon and select one from the popup calendar. If no Date to date is
entered, all valid items from this date into the future will be searched. If no
date is entered here, all valid items with past dates will be searched, unless
your selling control is configured to drop past events. Multiple day events will
be included in the search if either the Date from or Date to falls within the
event date range.

Date to For single event items, enter the date through which you want to run the item
search. You can either enter the date in mm/dd/yyyy format, or you can click
the calendar icon and select one from the popup calendar. If no Date from
date is entered, all valid past items through this date will be searched, unless
your selling control is configured to drop past events. If no date is entered
here, all valid items in the future will be searched. Multiple day events will be
included in the search if either the Date from or Date to falls within the
event date range.

Facility Select the facility to which you want to limit the item search. Only facilities for
which the season is valid are available for selection.

Item type Select the item type (single event, combo, access pass, donation, gift cer-
tificate, or miscellaneous) of the item for which you are searching. By default,
Pac7 searches all item types.

Event time For single event items, select the start time of the items that you want to
search. The selections are time frames, including Morning (12:00 am to 11:59
am), Afternoon (12:00 pm to 4:59 pm), and Evening (5:00 pm to 11:59 pm).
Times are calculated using the facility time zone. Multiple day events are
included if any part of the time range falls within the selected time frame. TBA
events are included for all time frames.

Event day For single event and combo items, select the days of the week of the events
you want to include in the search. Multiple day events are included if any of
the days in the range match the selected days. If all days of the week are
cleared, the search results will include events that occur on any day of the
week.

8. Click the Search button. The results are displayed in the search results table.

Tip: You can clear the search results and reset the Advanced search settings by clicking
the Reset button.

When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.

9. Select the item you want to add to the order line, and then click the Continue button. You
can also just double-click the item.
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Note: If the item is a gift certificate that requires manual ID number entry, the Enter Gift
Certificate form will display. If so, enter the number, and then click the Continue buttonx

.

The item is added to the order line.

Search results

The items included in the search results are determined by your search criteria and some general
item filtering rules. The results are sorted by event date then item code. The filtering rules are:

l Items must be from the current season.
l Items must be available through the current selling control.
l Operators must have item price type permissions.
l Access pass, gift certificate, and donation items must not have a status of Inactive (I).
l If the selected patron is a house customer, access pass items will be excluded.
l If the control is configured to drop past events, events in the past will be excluded.
l External events will be excluded.

Once the search results are displayed, you can view the item details for individual items on the
right side of the search form. The item code is displayed for all item types. Depending on item
setup, any item type may have message text displayed. The other item details that are displayed
are determined by the item type.
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The item display rules are:

l The date and time are only available for single event items.
l The date range is only displayed for access pass items.
l The facility is only displayed for single event items and combo items with all events in the
same facility.

Availability is based on the percentage of items remaining and is indicated by text or a color coded
bar. This is only displayed for single event and miscellaneous items.

When you've located the item you want to add to the order line, you can add it to the order line on
the Order Management tab. If the item you are adding requires additional information (for
example, a gift certificate requires manual document number entry), Pac7 will prompt you for that
information before adding the item to the order line.

Recent item selection

Once you have begun selecting items for order lines or seat holds in your current Pac7 session, the
search function also allows you to select from the last 50 selected item codes. Items selected from
multiple event search results are not added to this list.

To select an item from a recent order

1. Click the Order Management tab.
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2. Select the patron, and then select the season.
3. Add an order line.

4. In the Item cell of the order line, click the magnifying glass button.

The Search for Item form is displayed.

5. Click the Recent Items tab.

The tab displays with the recently selected items in the search results table.

6. Select the item you want to add to the order line, and then click the Continue button. You
can also just double-click the item.
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Note: If the item is a gift certificate that requires manual ID number entry, the Enter Gift
Certificate form will display. If so, enter the number, and then click the Continue buttonx

.

The item is added to the order line.

Selecting Multiple Events for Order Lines

Note: If the Order/Pay Only option is selected for order management in the Paciolan 7 control, you
cannot use the multiple event search.

When you are searching for single event items for an order, you can choose to search for and
select more than one event item at the same time. This function is only available for single event
items.

The multiple event search method is useful when patrons know they want to attend a specific
event, but they are willing to go on whatever date or time has the best seats available. Multiple
event search can also be quicker than the single event search if you want to select and create order
lines for multiple single event items at the same time.

Single item and multiple event searches both include standard and advanced search functions. For
information about standard and advanced item searches, see Selecting Items for Order Lines. The
main differences between multiple and single item searches are the following:
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l Multiple event search allows you to select more than one item from the search results.
l Multiple event search can only be done for single event items, while single item search
allows searches for all item types.

l You cannot select from previous (recent) selections made using the multiple event search
function.

Once you select the event items in which you are interested, you enter the quantity and price level
of the seats you want to sell. Only price levels that are common to all the selected items are avail-
able for selection.

Same seat search is available, as long as all event items share the same facility. A search plan can
also be used, but only if the facility has one or more search plans configured, and one or more of
the search plans are allowed by the selling control. When selecting seats based on a search plan,
you can also indicate an aisle preference (no aisle, left aisle, right aisle, or any aisle) and the num-
ber of rows that the customer is willing to sit in (rows to stack). Stacking is useful if you are search-
ing for a large number of seats and are having trouble finding that many contiguous seats. See an
example If the number of rows to stack = 2, the system will attempt to find 10 seats across 2
rows. In this case, 10 seats may be assigned with 5 seats in row A and 5 seats in row B.

Once you enter seat search parameters, the system will select the best available seats, including
the seat number, row, section, and price level. You can then add one or more seatblocks to their
individual order lines. If you hold multiple seatblocks but do not select one or more of them, the
unselected seatblocks are released when you add the selected ones to order lines.

To search for and select multiple event items

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the order line toolbar, click Seats, and then selectMultiple event search. If the

Search for multiple events buttonx is also in the toolbar, you can click the button
instead of selecting the command from the drop-down list.

The Search for Multiple Events form is displayed.
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4. Using any combination of the standard search box and the Advanced search parameters,
set up your event item search.

See information about the standard search box.

When searching using the standard search type, you enter text that describes the item for
which you are looking. You can enter more than one word at a time for a search, since the
default operator between all words and terms is AND. For example, if you enter Bas-
ketball February, the results will display only basketball games that take place in
February. The item fields whose values are searched include the following:

l Item code
l Item name
l Season code
l Facility code
l Facility name
l Keywords (defined in the back office)
l Day of the week
l Month of the year
l Year
l Item basis/item type
l Event date using mm/dd/yy or dd/mm/yy format

Prepositions, conjunctions or common verbs are ignored when performing a search (for
example, about, the, of, a, in, as, if, not, why, never, before, is, it). Search options you can
use with your search text include the following:

l AND operator. Use the AND operator between two words to only return events if their
details include both words.

l OR operator. Use the OR operator between two words to return events that include
either word in their details. This type of search typically returns more records than
the default AND search.

l NOT operator or - (minus sign). Use the NOT operator or the minus sign in front of a
word to exclude it from the search (for example, men's basketball NOT Thursday)

l Quotation marks. Use quotation marks around two or more words to search for an
exact term. You can use quotation marks in conjunction with operators, the minus
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sign, and wildcards.
l ? (question mark) and * (asterisk) wildcards. Use the question mark in place of a
single character and the asterisk in place of zero or more characters. Wildcards can-
not be used as the first character or the only character in a search string.

See information about the Advanced search parameters.

The item search function also includes advanced search options that allow you to further nar-
row your search results. These include using a date range, facility, event time (morning,
afternoon, or evening), and any combination of event days in conjunction with your search
text. All of the parameters are optional. See descriptions of the parameters.

Parameter Description

Date from Enter the date from which to begin the item search. You can either
enter the date in mm/dd/yyyy format, or you can click the calendar
icon and select one from the popup calendar. If no Date to date is
entered, all valid items from this date into the future will be searched.
If no date is entered here, all valid items with past dates will be
searched, unless your selling control is configured to drop past events.
Multiple day events will be included in the search if either the Date
from or Date to falls within the event date range.

Date to Enter the date through which you want to run the item search. You can
either enter the date in mm/dd/yyyy format, or you can click the cal-
endar icon and select one from the popup calendar. If no Date from
date is entered, all valid past items through this date will be searched,
unless your selling control is configured to drop past events. If no date
is entered here, all valid items in the future will be searched. Multiple
day events will be included in the search if either the Date from or
Date to falls within the event date range.

Facility Select the facility to which you want to limit the item search. Only facil-
ities for which the season is valid are available for selection.

Item type Only the single event item type can be selected.

Event time Select the start time of the items that you want to search. The selec-
tions are time frames, including Morning (12:00 am to 11:59 am), After-
noon (12:00 pm to 4:59 pm), and Evening (5:00 pm to 11:59 pm).
Times are calculated using the facility time zone. Multiple day events
are included if any part of the time range falls within the selected time
frame. TBA events are included for all time frames.

Event day Select the days of the week of the events you want to include in the
search. Multiple day events are included if any of the days in the range
match the selected days. If all days of the week are cleared, the search
results will include events that occur on any day of the week.

5. Click the Search button.

Tip: To display all the events in the season, click the Search button with the default
Advanced search options and no text in the search box. Click the Reset button to remove
any text from the search box and reset the Advanced search options to their defaults.

The search results are displayed in the results table.
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When viewing the results in the table, you can scroll up and down the list using the scroll bar.
You can also sort the results by column by clicking the column headers.

6. Select the items whose availability you want to check, and then click the Continue button.

The Select Seats form is displayed with the selected events.

7. Enter the item quantity the Quantity box and then, from the Price level drop-down list,
select the price level. See an image.

8. If you want to find the same seats for all of the event items or if you want to use a search
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plan (if the facility has one configured), click Advanced search, and then configure the
options.

Search
option Description

Seating
type

For the Seating type options, select Find best seats for each event to hold
the best available seats per event. Select Find same seats for all events to
select and hold the same seats for all events.

By default the system finds the best available seats for each of the selected event
items, regardless of whether they are the same seats. You can only choose to find
the same seats for all events if all of them share the same facility. If the events
are in the same facility and a search plan is defined for that facility, you can also
select Use search plan to search for the same seats for each event item based
on the search plan. You must then configure the options in the Search plan group.

Search
plan

If you select Use search plan under Seating type, you need to configure the
options in the Search plan group. First, select a search plan from the Search
plan drop-down list. If the patron has a particular aisle preference (no aisle, left
aisle, right aisle, or any aisle), select the option from the Aisle seating drop-
down list. If the patron does not mind having the selected seats in more than one
row, enter the number in the Number rows to stack box. See an example It
may be difficult to find contiguous seats for a party of 10 people. Stacking across
rows allows the operator to search for 10 seats across rows. If # of rows to stack
= 2, the system will attempt to find 10 seats across 2 rows. For example, the 10
seats may be assigned 5 seats in row A and 5 seats in row B.

9. Click the Find seats button. The Select Seats form is redisplayed with the best available
seatblock information. These seatblocks are now held for your order.

You can release these seatblocks at any time by clicking the Release link.
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10. If you want to view or change a seatblock on the seat map, do the following:

a. Click the View seat map link.

The Seat Map form is displayed.

b. Use the seat map to view or change seats. For information about using the seat map, see
Using the Seat Map.

c. Click the Continue buttonx .

11. Select each event item for which you want to add an order line. You can also choose to
release the held event items and return to the Search for Multiple Events form by clicking
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the Select other events button.

12. Click the Continue button.

The items are added to the Order Management tab as order lines.

13. In the Price type column of each order line, enter a price type code.

Selecting Events for Designer Combos
In order management, you need to select events for designer combos when you add them to order
lines. You must select a quantity and price level before you select the events in the combo. Once
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you have selected the events for an order line, you can still change any unallocated selections later
on. You must unprint and deallocate an event before you can remove it from the combo, however.

To select events when adding a designer combo to an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. Add the order line, and then select the designer combination item.
4. Enter the quantity in the Qty column, and then select the price level in the Price level
column.

5. Press Tab on your keyboard. The Select Events for Combo form is displayed.

6. Select events by clicking on their rows. You must select the number of events indicated in
the Events remaining field.

Tip: The color coded bar in the Availability column indicates the level of availability for the
event. Availability is based on the percentage of items remaining.
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7. Click the Continue buttonx .
8. Complete any other order line processes as required.
9. Finish processing the order.

To change the selected events after adding a designer combo to an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Select the order line of the designer combination item for which you want to change event
selections.

4. Click the Line actions button, and then select Event list from the drop-down list. If the

Select events for combo buttonx is in the toolbar, you can click the button instead of
selecting the command from the drop-down list.
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The Select Events for Combo form is displayed.

5. Deselect and select events as required.

Tip: The color coded bar in the Availability column indicates the level of availability for the
event. Availability is based on the percentage of items remaining.

6. Click the Continue buttonx .
7. Complete any other order line processes as required.
8. Finish processing the order.

Selecting Seats for Allocatable Items in Order Management
Once you've added an order line with an allocatable item on the Order Management tab, you need
to locate and assign seats for the item. You can then allocate and print the seats for the item before
finishing the order.

To select seats for an allocatable item, use one or more of the following methods:

l Assigning best available
l Using area search
l Using search plans
l Using the seat map
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Assigning Best Available Seats in Order Management

You can use the Pac7 best available seat assignment feature to let the system locate and hold the
best available seats for you. The system locates the best available seats based on the preferences
your ticket manager has set for the facility (venue) and the seat gap.

If the same seats are not available for one or more events in a combination item, seat assignments
will only be made for the available event items. For the remaining (without seat assignments)
items, you will have the following seat assignment options:

l Do not make seat assignments for the events with no seat assignments. You can always go
back and assign seats later, if necessary.

l Select primary events and use the seat map to make seat assignments. For more inform-
ation, see Selecting Combo Item Seats Using the Seat Map.

l Find the best available seats in the selected price level for each remaining item. Each item
may have a different seat assignment, depending on what the best available seats are for
each item.

l Find the same best available seats for the remaining items. All remaining items with the next
best available seats will be assigned those seats. If there are items that do not have the next
best available seats, they are not assigned seats. You can run this process as many times as
it takes to find best available seats for all the remaining items.

Once the best available seats are located, they are placed on customer hold for the order line.

To assign the best available seats to an order line during order management

1. Select an unallocated order line, and then click the Assign best seats button. Unallocated
order lines are those with no entry in the Seatblocks column.

The best available seats are assigned to the order line and placed on customer hold.

If the Review Seat Search Results form is displayed, do one of the following:
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l To add the assigned seat blocks to the order line, click the Continue button. You can
assign seats to the unassigned items later using the seat map.

l To select seats using the seat map, click the Go to seat map button. The Select Primary
Event form is displayed. For information about using this form, see Selecting Combo Item
Seats Using the Seat Map.

l To find the best available seats from the price level for the remaining (without assigned
seats) items, click the Find best seats button. Based on seat availability, one or more of
the remaining items may have different seat assignments.

l To find the same best available seats for all of the remaining items, click the Find same
seats button. All remaining items with the next best available seats will be assigned
those seats. If there are items that do not have the next best available seats, they are not
assigned seats. You can click the Find same seats button again as many times as it
takes to find best available seats for all the remaining items, if they have available seats
within the price level.

2. Do one of the following:

l To allocate the customer held seats, click the Finish buttonx . For more inform-
ation, see Allocating Seats in Order Management.

l To allocate and print the customer held seats, select the check box in the Print Tickets

column, and then click the Finish buttonx . For more information, see Finishing
Orders in Order Management.
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Using Area Search in Order Management

Area search allows you to select the best available seats for a single event item from multiple facil-
ity areas and place them on counter hold. You can then present held seats from different areas to
patrons and allow them to choose where they want to sit based on location and price. Once they
choose their seats, you can add their selections to order lines. Area search is not available for com-
bination items.

To use area search to select seats for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. In the Order Lines table, add an order line with a single event item. You do not need to
enter a price level, although you may choose to do so if the price level contains all the areas
within which you want to search.

4. Click the Seats button, and then select Area search from the drop-down list. If the Area

search buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

The Area Search form is displayed.
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5. Expand the price levels containing the areas in which you want to search, and then select the
areas. In the example image, the GRAY area in Price Level 1, GREEN area in Price Level 3,
and TAN area in Price Level 5 are selected.

The Availability column contains a graphical representation of the number of seats remain-
ing in each area. The graphical representation is a color coded bar that is based on the per-
centage of the item that is available in the area.
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6. Click the Continue buttonx . The Select Seats form is displayed. The best avail-
able seats in each area are placed on counter hold and displayed by row.

7. Select the rows of the areas containing the seats that the patron wants to purchase, and then
click the Continue button. In the example image, the GREEN area row is selected.

Tip: Alternatively, you can click the Cancel buttonx to release the seats and

return to the Order Lines table, click the Select other areas buttonx
to release the seats and return to the Area Search form, or click the Go to seat map but-

tonx to view and select the seats on the seat map.

The Price Split form is displayed. The price levels containing the areas you selected are
included.
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8. In the Available Price Types table for each price level, split the held quantity among the
price types as required. In the example image, the held quantity of 6 is split into 2 Senior
and 4 Regular seats. For more information, see Price Splitting PL/PT Quantities in Order
Lines.

9. Click the Continue button. The Order Lines table is redisplayed with an order line added
for each price level/price type combination in which you have held seats. The held seatblock
has also been added for each order line.

Using Search Plans in Order Management

Search plans allow you to search for seats using parameters that are not directly related to the con-
figuration of a facility. They are often used to easily locate seats that are commonly requested. For
example, a search plan may allow you to find seats in the shade, near 3rd base, or on an aisle.
Search plans can be used for single event items and combo items. They are associated with a
single facility configuration.

To use a search plan to select seats for an order line

1. Click the Order Management tab.
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2. Select the patron, and then select the season.
3. In the Order Lines table, add an order line with the single event or combination item. You
do not need to enter a price level, although you may choose to do so if you want to limit the
search to a single price level.

4. Click the Seats button, and then select Search plan from the drop-down list. If the Search

plan buttonx is in the toolbar, you can click the button instead of selecting the command
from the drop-down list.

The Search Plan form is displayed.

5. From the first (facility name) drop-down list, select the search plan.

6. From the Aisle seating drop-down list, select the aisle seating option (No Aisle, Left Aisle,
Right Aisle, or Any Aisle).

7. If you want to split the seat assignments across 2 or more rows, enter the number in Num-
ber of rows to stack. If you do not enter a number, the system will attempt to assign
seats contiguously in a single row.

8. Click the Continue buttonx . The seat assignments are added to the Seatblocks
column for the order line.

If the Review Seat Search Results form is displayed, do one of the following:

Pac7 Release 7.2



User Guide  373

l To add the assigned seat blocks to the order line, click the Continue button. You can
assign seats to the unassigned items later using the seat map.

l To select seats using the seat map, click the Go to seat map button. The Select Primary
Event form is displayed. For information about using this form, see Selecting Combo Item
Seats Using the Seat Map.

l To find the best available seats from the price level for the remaining (without assigned
seats) items, click the Find best seats button. Based on seat availability, one or more of
the remaining items may have different seat assignments.

l To find the same best available seats for all of the remaining items, click the Find same
seats button. All remaining items with the next best available seats will be assigned
those seats. If there are items that do not have the next best available seats, they are not
assigned seats. You can click the Find same seats button again as many times as it
takes to find best available seats for all the remaining items, if they have available seats
within the price level.

Using the Seat Map in Order Management

The Paciolan seat map is a graphical representation of the seats in a facility as they are configured
for an event. You must add an item to an order line before you can use the seat map. You do not
need to select price level, price type, or order quantity for the order line before using the seat
map, since you can add or change them from within the map.

When using the seat map, the seats available for selection are determined by inventory availability
and your operator permissions. To locate seats the seat map has the following three views:

l An overview that shows the entire facility as configured for the event. You can display a
detailed view of any part of the facility by clicking it on the overview map.
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l A detailed view that shows only part of the facility, but with each seat graphically rep-
resented by its status. You must be in this view to select or deselect seats. You can navigate
incrementally around the detailed map using the arrows surrounding the map or by clicking
different areas on the MiniMap.
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l A MiniMap that is a separate window docked in the detailed view. The MiniMap shows a mini-
aturized version of the overview of the seat map that indicates the location of the current
detailed view and where you have seats selected. You can navigate to a detailed view of a dif-
ferent area of the map by clicking at that location on the MiniMap.

You can move the MiniMap anywhere in the seat map window, and you can minimize the MiniMap if
you do not want to see it.

If no seats are selected when you start the seat map, the overview map of the facility is opened. If
seats are already selected for an item, the detailed view of the map with the MiniMap is displayed.
The locations of the selected seats are indicated by an opaque rectangle on the overview map and
the MiniMap. The rectangle is sized proportionally over the seats selected for the order.

Seat information is displayed around the seat map when you point to any location on the overview,
detailed view, or MiniMap.

Using the seat map, you can do the following:

Note: The procedures below are the same for both item sales and order management, since they
use the same seat map functionality.

l Select single seats
l Select seats for combo items
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l Release seats
l Go to a specific seat location
l View seats from an order line
l View seat information
l Go to the Overview Map
l View the Legend

Using the Seat Map to Select Seats

Using the seat map, you can hold and release blocks of seats for an order. The seat map is avail-
able from order lines in order management and during item sales (onsales, general sales, and
promos). The price level sections within which you can hold seats may be limited by your selling
control.

The seat map has three views: overview, detailed view, and MiniMap (see Seat Map Views for
more information). If no seats are on hold when you start the seat map, the overview map of the
facility displays. If seats are already on hold for an item, the detailed view of the map displays
with the docked MiniMap.

The locations of seats that are on hold are indicated by gray marks on the overview map and the
MiniMap. The gray marks are sized proportionally to the number of seats on hold for the order. The
locations and status of individual on hold seats are indicated on the detailed map.

Seat information is displayed around both the overview and detailed versions of the seat map by
pointing to the location on either view or the MiniMap. You can also get seat information by right-
clicking the seat and selecting a command from the menu. For more information, see Viewing Seat
Information Using the Seat Map.

Note: Messages may be displayed when you attempt to put seats on hold. These messages are con-
figured by your ticket manager. For example, if you attempt to put on hold a greater seat quantity
than what you specified in your initial order, the system may display a warning that gives you the
option of adjusting the order quantity or escaping back to the seat map to change your selections
(see image below).

To select single seats during onsales

1. During an onsale on the Item Sales tab, click the Use Seat Map link or button on the Select
Onsale Items and Seats page.
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The system displays the overview version of the seat map page.

2. Click the area on the overview map where the requested seats are located. The seat map
redisplays with a detailed version of the area and the docked MiniMap window.
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3. Navigate around the facility map to find seats, using the following methods:

l Click the arrows on the navigation control x .

l Click any location on the MiniMap to navigate to the detailed view of that area.

l Clear the Lasso seats option, and then click and drag the map.

4. Select or deselect the seats for the order using either of the following methods:

l Select the Lasso seats option, and then drag the mouse pointer over the seats.

l Click the seats one at a time.
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Once you select an open (o)x seat, its seat status changes to on hold (*)x . The seat will
remain on hold until you complete the order or the order timeout configured by the ticket
manager is reached.

5. When you are finished selecting seats, click the Continue button. The Select Price Types page
displays.

6. Complete the order. For more information, see Completing an Onsale Transaction.

To select single seats during general or promo sales

1. During general or promo sales on the Item Sales tab, click the Use Seat Map link or button
on the Find Best Available Seats page.

The system displays the overview version of the seat map page.
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2. Click the area on the overview map where the requested seats are located. The seat map
redisplays with a detailed version of the area and the docked MiniMap window.

3. Navigate around the facility map to find seats, using the following methods:

l Click the arrows on the navigation control x .

l Click any location on the MiniMap to navigate to the detailed view of that area.
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l Clear the Lasso seats option, and then click and drag the map.

4. Select or deselect the seats for the order using either of the following methods:

l Select the Lasso seats option, and then drag the mouse pointer over the seats.

l Click the seats one at a time.

Once you select an open (o)x seat, its seat status changes to on hold (*)x . The seat will
remain on hold until you complete the order or the order timeout configured by the ticket
manager is reached.

5. When you are finished selecting seats, click the Continue button. The Select Price Types page
displays.

6. Complete the order. For more information, see Completing a General Sales Transaction.

To select single seats for an order line during order management

1. During order management on the Order Management tab, select an order line in the Order
Lines table, and then click the seat map button.
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The system displays the overview version of the seat map page.

2. Click the area on the overview map where the requested seats are located. The seat map
redisplays with a detailed version of the area and the docked MiniMap window.
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3. Navigate around the facility map to find seats, using the following methods:

l Click the arrows on the navigation control x .

l Click any location on the MiniMap to navigate to the detailed view of that area.

l Clear the Lasso seats option, and then click and drag the map.

4. Select or deselect the seats for the order using either of the following methods:

l Select the Lasso seats option, and then drag the mouse pointer over the seats.

l Click the seats one at a time.
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Once you select an open (o)x seat, its seat status changes to on hold (*)x . The seat will
remain on hold until you complete the order or the order timeout configured by the ticket
manager is reached.

5. When you are finished selecting seats, click the Continue button. The Price Split form dis-
plays.

6. Split the quantity among price level/price type (PL/PT) combinations as required. For more
information, see Price Splitting PL/PT Quantities in Order Lines.

7. Click the Continue buttonx . Order lines are added to the Order Lines table for
the PL/PT quantities.

8. Finish processing the order. For more information, see Finishing Orders in Order Man-
agement.

Selecting Combo Item Seats Using the Seat Map

In Pac7, you can sell fixed or designer combination items during order management and general
item sales using the seat map. Because combination items contain more than one event, the seat
map allows you to select (hold) or release seats for more than one event at the same time. For
example, you may want to assign the same seats for each event in a season ticket combo item. To
select seats simultaneously for multiple events, each event must have the following:

l The same facility and seat configuration.
l The same seats already selected at the time you want to assign seats. For example, each
event may have zero seats assigned or the same two seats assigned.

When selecting seats for multiple events, you choose one primary event with which to select seats
for all events in the combo item. If there are no events with matching configuration and seat selec-
tions, the system will only hold the seats you select for the primary event. You can always select or
release seats for single events after selecting seats for a primary event. Seats cannot be held in
more than one price level for an individual combo item, although seats in multiple price levels can
be assigned to different combo items.

To select seats for combination items during general item sales
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1. On the Item Sales tab, click General Sales, and then search for and select the combination
item. See Searching for Items for more information. You may be required or have the option
to search for and select a patron first.

2. When you reach the Find Best Available Seats page for the combo item, click the Use Seat
Map link or button.

The Select Primary Event for Seat Map page is displayed.

3. To simultaneously select the same seats for all the single event items in the combination
item, do the following:

a. Select the Primary Event option in the row of the single event item that you want to use
to make the seat map seat selections.

Pac7 Release 7.2



User Guide  386

b. Click the Map: All Events buttonx . The system displays the Seat
Map window.

c. Use the seat map to select seats for the primary event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

d. When you are finished selecting seats, click the Continue buttonx . The
Select Primary Event for Seat Map page redisplays with the seatblock, price level, and
quantity information for each event item.

4. To select seats by individual event in the combination item, do the following:

a. Select the Primary Event option in the row of the single event item for which you want to
select seats. In this example image, the event item UCLA is configured to be the primary
event.

b. Click the Map: Single Event buttonx .
c. Use the seat map to select seats for the single event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

d. When you are finished selecting seats, click the Continue buttonx . The
Select Primary Event for Seat Map page redisplays with the seatblock, price level, and
quantity information for the single event item.
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e. Repeat these steps for each remaining event in the combination item. You can also map
all the remaining events by making one of them the primary item and clicking the Map:

All Events buttonx . This will not change the individual event seat
assignments that you have already made. However, all the remaining event item seats
must be in the same price level that you selected for the primary item.

5. Once you have assigned seats for all the events in the combination item, click the Continue
button.

The Select Price Types page displays.

6. In the Total to Assign group, select the quantity to assign to each price type. The sum of
the quantities you assign to price types must equal the Total to Assign number. In this
example image, 4 seats need to be assigned, and 2 seats are assigned to the Adult and Regu-
lar price types. For more information, see Selecting Price Types.
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7. Click the Continue buttonx . The Review Items in the Cart page displays with
the order items added to the cart. For more information about adding items to the cart, see
the general sales procedure in Adding Items.

8. From the Review Items in the Cart page, complete the order. For more information, see Com-
pleting a General Sales Transaction.

To select seats for combination items during order management

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. If the combination item has not yet been added to an order line, add an order line, and then
select the combination item.

Note: Unless you are selecting seats for a designer (flex) combo, you do not need to enter
the quantity or price level. Flex combos require that you enter the quantity and price level,
and then select the single events to include for the combo item before opening the seat map.

4. In the Order Lines table, click the seat map button.
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The Select Primary Event form is displayed.

5. To simultaneously select the same seats for all the single event items in the combination
item, do the following:

a. Click the row of the primary event, and then click the Map: All events button.

The Seat Map window is displayed. The primary event's inventory will be displayed in the
seat map when you are selecting seats for all the events.

b. Use the seat map to select seats for the single event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

c. When you are finished selecting seats, click the Continue buttonx
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. The Select Primary Event form redisplays with the price level, seat-
block, and quantity information for each event item.

6. To select seats by individual event in the combination item, do the following:

a. Click the row of the primary event, and then click the Map: Single event button.

The Seat Map window is displayed.

b. Use the seat map to select seats for the single event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

c. When you are finished selecting seats, click the Continue buttonx . The
Select Primary Event form redisplays with the price level, seatblock, and quantity
information for the primary event item.

d. Repeat these steps for each remaining event in the combination item. You can also map
all the remaining events by making one of them the primary item and clicking the Map:

All Events buttonx . This will not change the individual event seat
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assignments that you have already made. However, all the remaining event item seats
must be in the same price level that you selected for the primary item.

7. Once you have assigned seats for all the events in the combination item, click the Close but-
ton.

The Price Split form displays.

8. In the Available Price Types table, split the quantity among the price types as required.
For more information, see Price Splitting PL/PT Quantities in Order Lines.

9. Click the Continue buttonx . An order line is added to the Order Lines table for
each unique price level/price type (PL/PT) combination with a quantity.
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10. Finish processing the order. For more information, see Finishing Orders in Order Man-
agement.

Releasing Seats Using the Seat Map

Note: This procedure is only applicable to releasing seats on counter hold during item sales. In
order management, you release seats by deallocating them. During deallocation you have the
option of using the seat map to release seats. For more information, see Deallocating Seats in
Order Management.

After you have placed seats on hold (selected them) for an item, you can release them at any time
until you complete the order. When you release a seat, the system changes its status to open and
other ticket operators will be able to sell the seat.

Using the seat map you can release multiple seats by adjacent groups called seat blocks. This
allows you to release individual seat blocks within single events and across multiple item combo
events.

Note: You can view seat blocks for individual order line items using the seat map. On the Review
Items in the Cart page, though, you must release or hold all seat blocks for an item as a group. For
more information, see Releasing Seats in the Shopping Cart.

To release seat blocks within an event in Item Sales

1. For the event with the held seats you want to release, click the View Seat Map link or iconx

. The Seat Map page is displayed.
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2. From the seat map toolbar, click the View or Release Held Seats buttonx . The sys-
tem displays the View or Release Held Seats window with all the held seat blocks for the
event listed.

Note: If you are releasing seat blocks from an event that is part of an item combo, you will
need to use the Select Primary Event for Seat Map page to access the seat map for the event.
To make sure that you only release seat blocks from that one event, use the Map: Single
Event button—not the Map: All Events button.
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3. Select the held seat that you want to release, and then click OK. The window is closed, and
then the current seat map view is displayed with the released seats' status changed to open
(o)x .

To release seat blocks across events in a combo item

1. For the combo item event from which you want to release seats, click the View Seat Map

link or iconx . The Select Primary Event for Seat Map page is displayed.

2. Select a combo item event from which you want to release held seats.
3. Do one of the following:

l If you want to release seats from all similar events in the combo item, click the Map: All
Events button. To release seats simultaneously for multiple events, each event must have
the same:

l Facility and seat configuration.
l Seats already selected at the time you want to release seats. For example, each event
may have zero seats assigned or the same two seats assigned.

l If you want to release seats from the selected event only, click the Map: Single Event but-
ton.

The system displays the detailed version of the seat map page.
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4. Click the Held Seat Blocks button. The system displays the Seat Map window with all the held
seat blocks for the event listed.

5. Select the seats that you want to release, and then click OK. The system closes the window,
and then redisplays the seat map view with the released seats' status changed to open (o)x
.

Going to a Seat Location on the Seat Map

When selling tickets, customers may already know the seat numbers they want or you may want to
go to a seat block you know is open without going through the search process. When using the seat
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map, you can enter the level:section, level:section and row, or level:section, row and seat to go
directly to the location.

To go to a seat in the seat map

1. Click the Go to Seat buttonx .

The Go To Seat form is displayed in a new window.

Select Level:Section, Row, and Seat values, and then click the Continue buttonx . The
system displays the detailed version of the Seat Map with the seat you specified in the center of the
map and blinking.

Viewing Seats on the Seat Map from an Order Line

Once you select, put on counter hold, or allocate seats for an order line, you can view the location
of the seat block on the seat map at any time.

To view selected, counter held, or allocated seats for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the order line with the seats that you want to view.

4. Use any of the following methods:

l Click the seat map button.
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The detailed view of the seat map displays with the selected seats marked by their status
character. In this example image, the detailed part of the map containing the 4 counter
held seats is displayed.

l Click the Seats button, and then select View seat map from the drop-down list.

The detailed view of the seat map displays with the selected seats marked by their status
character. In this example image, the detailed part of the map containing the 4 counter
held seats is displayed.
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l Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

When the Seat Fields form displays, click the Map button.

The detailed view of the seat map displays with the selected seats marked by their status
character. In this example image, the detailed part of the map containing the 4 counter
held seats is displayed.
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5. To return to the Order Lines table, click the Continue buttonx in the upper-
right corner of the Seat Map window.

Viewing Seat Information Using the Seat Map

Using the Paciolan seat map, you can view a seat's details, status, and history. Depending on the
seat map view displayed, you can mouse over seats to display a combination of the seat location,
price level, and price range. In the overview and MiniMap views, you can display the level:section
and, in the detailed view, you can view an individual seat's location, price level, and price range.

All seat map information is available if you are accessing the seat map during order management
(from the Order Management tab). Depending on the selling control settings, you may also be able
to access the current status and history of transactions for a seat during item sales (from the Item
Sales tab). The selling control may also allow you to view more detailed information for individual
seats, including information about the patron who owns the seat, the seat's row, and any ticket
manager-defined seat hold status.

Tip: You can use the seat transaction history as a troubleshooting tool and the seat status for quick
status and navigation.

To view on-screen tip information for seats and sections

1. On the Seat Map page or MiniMap window, move the mouse pointer to the seat or level:sec-
tion about which you want information.

For the overview version of the Seat Map page or the MiniMap, the system displays the
level:section on the Seat Map page above and below the seat map graphic.
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For the detailed version of the Seat Map page, the seat location, price level, and price range
are displayed.
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To view seat details

Note: The current selling control must be configured to allow use of this functionality. See your
ticket manager for more information.

1. On the detailed version of the Seat Map page, move the mouse pointer to the seat for which
you want information.

2. Right-click the seat, and then select Seat Details.
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The system displays the Seat Details window.

To view seat status

Note: The current selling control must be configured to allow use of this functionality. See your
ticket manager for more information.

1. On the detailed version of the Seat Map page, move the mouse pointer to the seat for which
you want information.
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2. Right-click the seat, and then select Seat Status.

The system displays the Seat Status window.
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3. If you want to check the status of adjacent seats, use the Previous Seat, Next Seat, Previous
Row, and Next Row buttons.

To view seat history

Note: The current selling control must be configured to allow use of this functionality. See your
ticket manager for more information.

1. On the detailed version of the Seat Map page, move the mouse pointer to the seat for which
you want information.

2. Right-click the seat, and then select Seat History.
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The system displays the Seat History window.

Seat Map Views

When using the seat map, the seats available for selection are determined by inventory availability
and your operator permissions. To locate seats the seat map has the following three views:

l An overview that shows the entire facility as configured for the event. You can display a
detailed view of any part of the facility by clicking it on the overview map.
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l A detailed view that shows only part of the facility, but with each seat graphically rep-
resented by its status. You must be in this view to select or deselect seats. You can navigate
incrementally around the detailed map using the arrows surrounding the map or by clicking
different areas on the MiniMap.
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l A MiniMap that is a separate window docked in the detailed view. The MiniMap shows a mini-
aturized version of the overview of the seat map that indicates the location of the current
detailed view and where you have seats selected. You can navigate to a detailed view of a dif-
ferent area of the map by clicking at that location on the MiniMap.

You can move the MiniMap anywhere in the seat map window, and you can minimize the MiniMap if
you do not want to see it.

If no seats are selected when you start the seat map, the overview map of the facility is opened. If
seats are already selected for an item, the detailed view of the map with the MiniMap is displayed.
The locations of the selected seats are indicated by an opaque rectangle on the overview map and
the MiniMap. The rectangle is sized proportionally over the seats selected for the order.

Seat information is displayed around the seat map when you point to any location on the overview,
detailed view, or MiniMap.

Going to the Overview Version of the Seat Map

If you are working in the detailed view of the seat map and you need to see the entire facility, you
can return to the overview version at any time. When you switch to the overview, the system auto-
matically saves any seat selection changes you made while in the detailed view.

Pac7 Release 7.2



User Guide  408

Detailed view of the seat map

Overview version of the seat map
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To go to the overview version of the seat map

1. In the detailed view of the Seat Map page, click the dot in the center of the navigation control

x . The overview version of the Seat Map page is displayed. To go back to
the detailed view, click the location on the overview page.

Displaying Specific Seat Statuses

You can limit the seat map display to any subset of the seat statuses that you have permissions to
view.

To display specific seat status

1. In the seat map toolbar, click the Display Specific Seat Status buttonx . The Display
Specific Seat Status form displays.
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2. Select the seat statuses that you want to display, and then click the Continue buttonx

. The seat map redisplays with only the seat statuses you selected.

Price Splitting by Item PL/PT in Order Management
Once a single event or combination item is added to an order line, you can enter the quantity and
price level/price type (PL/PT) for the item. You can also choose to distribute the quantity of the
item among more than one PL/PT combination. This distribution is called price splitting. The result
is an order line for each item PL/PT combination.

Note: The price splitting process is also available during area searches, when selecting seats for
single events using the seat map, and when choosing a primary event to select seats for a com-
bination item.

The price splitting options that are available for an order line item are determined by the PL/PT
combination and seat assignments that have already been entered for the order line. If the order
line item has no held or allocated seats, the following price splits are available:

l If you have not yet selected either a price level or a price type, you can distribute any quant-
ity among any of the available PL/PT combinations. Each PL/PT combination to which you add
a quantity will be split into its own order line.

l If you have selected a price level or a price level/price type, you can distribute any quantity
among the price types available for the price level. Each price type to which you add a quant-
ity will be spit into its own PL/PT combination order line.

If assigned seats are held but not allocated, you can still change price types and quantities by price
splitting. However, if seats have been allocated or deallocated, you cannot price split the order
line.

To price split the quantity of an item among its PL/PT combinations

1. Click the Order Management tab.
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2. Select the patron, and then select the season.
3. Select the order line that you want to price split. If necessary, add the order line.

4. Click the Line actions button, and then select Price split from the drop-down list. If the

Price split buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

The Price Split form displays.

5. From the Price level drop-down list, select the price level and then, in the Available Price
Types table, enter the desired quantity of seats by price type.

Tip: The color coded bar next to the Price level drop-down list indicates the level of avail-
ability. Availability is based on the percentage of items remaining. The availability of a com-
bination item is determined by the event in the combination with the lowest percentage of
items remaining.
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6. If you want to split the quantity with another price level, select a new price level from the
Price Level drop-down list, and then enter price type quantities. The price type quantities
for the first price level are retained when you change to the new price level. You can split the
quantities among as many price levels as you want. The quantity of price types assigned by
price level is displayed in the adjacent Summary table.

7. Click the Continue buttonx . The PL/PT quantities you selected are added to the
Order Lines table. If you split the quantity between PL/PT combinations, a new row is added
for each combination. The example below contains a quantity of 8 that is split into 2 rows
with a quantity of 4 for both the 1:R and 2:R PL/PT combinations.

Allocating Seats in Order Management
Allocation is the assignment of held seats to a single event or combination item (also called alloc-
atable items) in an order line. Allocation is a required step in the basic order management process,
after you have placed seats on customer hold by selecting an allocatable item and assigning seats
to it in the order line. These customer held seats are then allocated when you finish or pay the cus-
tomer order. You may also choose to print the seats at the same time.

To allocate seats from an order line

1. Click the Order Management tab.
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2. Select the patron, and then select the season.
3. If you have not already added the order line, add the order line.
4. If you have not already selected an allocatable item for the order line, select the item.
5. If you have not already assigned seats to the order line, select seats for the allocatable item.

6. If you also want to print the tickets, select the option in the Print tickets column. For more
information, see Printing Seats in Order Management.

7. Click the Finish buttonx or Finish and pay buttonx . For more
information, see Finishing Orders in Order Management.

Using Seat Fields in Order Management
Depending on the status of an order line, you may be able to use seat fields for the order line to
place holds, release holds, allocate seats, or deallocate seats. You can always use the form to view
the seat assignments for the order line. The form is available from the order lines of both single
event and combination (allocatable) items.

Note: Placing or releasing customer holds using seat fields from the order line is independent of
working with customer seat holds at the order level. For more information about using customer
holds at the order level, see Using Customer Seat Holds in Order Management.

The Seat Fields form is read-only when triggered from an order line that was created via Order
Holds or has been marked as an exchange or return. The form will also be read-only if your selling
control is configured for order/pay only.

When using seat fields, you can do the following:

l View seat assignments
l Place and release holds
l Deallocate items

Viewing Seat Assignments in Order Management

Once you've assigned seats to a single event or combination item order line, you can view the
seats and their allocation status at any time using seat fields. When viewing seat status, you can
also choose to release held seats, deallocate unprinted seats, or change seat assignments using
the seat map.

Tip: In addition to using seat fields, combination items can be viewed using the event details line
item process. However, you cannot use this process to launch the seat map, release seats, or deal-
locate seats.

To view single event item order line seat assignment details
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1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the combination item with the seat assignments
you want to view.

4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

The Seat Fields form displays.

5. To return to the Order Management tab, click the Continue buttonx .

To view combination item order line seat assignment details
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1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the item with the seat assignments you want to
view.

4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

The Select Primary Event form displays.

5. Click the Seat Fields buttonx . The Select Primary Event form redisplays
with the Seat Fields form embedded.
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6. Select an event item to see its seat assignments in the embedded Seat Fields form.

7. To return to the Order Management tab, click the Continue buttonx .

Using Seat Fields for Holds in Order Management

When an order contains an allocatable order line, you can use seat fields to place or release holds
until the order line is allocated. You can also use the form to view the seat assignments for the
order line at any time. The form is available from the order lines of both single event and com-
bination (allocatable) items.

Note: Placing or releasing customer holds using seat fields from the order line is independent of
working with customer seat holds at the order level. For more information about using customer
holds at the order level, see Using Customer Seat Holds in Order Management.

The Seat Fields form is read-only when accessed from an order line that was created via Order
Holds or when it has been marked as an exchange or return. The form will also be read-only if your
selling control is configured for order/pay only.

To use seat fields to place seats on hold for a single event order line item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the item for which you want place seats on hold.

4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat
fields buttonx
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is in the toolbar, you can click the button instead of selecting the command from the
drop-down list.

The Seat Fields form is displayed.

5. If you want to enter seatblocks using the level, section, row, and seat numbers, do the fol-
lowing:

a. Click the plus button at the bottom of the Held Seats table. A new row is added to the
table.

b. In the new row, enter the level, section, row, seat numbers in the seatblock in level:sec-
tion:row:seat format. To enter a range of seats, type the first and last seat numbers sep-
arated by a comma. In the example below, seats 16, 17, 18, and 19 in row 1 of section
201, level FH have been added to the table.
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c. If you have more seatblocks to enter for the order line, click the plus button to add a row
and enter the level:section:row:seat for each additional seatblock.

6. If you want to enter seatblocks using the seat map, click the Map button to display and use
the seat map for seat selection.

7. Click the Continue buttonx . If you are adding one or more seatblocks that are
in different price levels, an Attention dialog box will be displayed.

8. If the Attention dialog box is displayed, click one of the following buttons:

l Keep Seats. Click this button to add a new order line to the Order Lines table for each
additional price level. If you have added more than one seatblock for a single price level,
the seatblocks will be combined in a single order line for the price level.

l Modify Seats. Click this button to redisplay the Seat Fields form without changing any
of the seatblocks in the Held Seats table.

l Clear Held. Click this button to release all the held seatblocks and redisplay the Order
Management tab without changes.

9. If the Price Split form is displayed, do the following:

Pac7 Release 7.2



User Guide  419

a. Split quantities between price types as required. If you are adding seatblocks in more
than one price level, change between them using the Price level drop-down list. For
more information, see Price Splitting by Item PL/PT in Order Management.

b. Click the Continue button.

When the Order Management tab redisplays, a seatblock is added to the Seatblocks column
for the original order line. If order lines have been added for seats held in additional price
levels, a seatblock is added to each new order line as well.

10. To apply the changes to the order line, click the Finish buttonx , and then complete
the process. For more information, see Finishing Orders in Order Management.

To use seat fields to place seats on hold for a combination order line item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the item for which you want place seats on hold.

4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.
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The Select Primary Event form is displayed.

5. Click the Seat Fields buttonx . The Select Primary Event form redisplays
with the Seat Fields form embedded.

6. In the combo events table, select the primary event for which you want to place a hold.
Depending on how you add seatblocks, the primary event is either the single event for which
you will select seats or is used to select the seats that will be assigned to each of the single
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events in the combination item.

7. If you want to enter seatblocks for all the events using the same level, section, row, and seat
numbers, do the following:

a. Click the plus button at the bottom of the Held Seats table. A new row is added to the
table.

b. In the new row, enter the level, section, row, and seat numbers in the seatblock in
level:section:row:seat format. To enter a range of seats, type the first and last seat num-
bers separated by a comma. In the example below, seats 16, 17, 18, and 19 in row 1 of
section 201, level FH have been added to the table.

Note: When you enter a seatblock for the primary event, the system will hold whatever
seats are available for each of the events in the combination item. If an event has some
or none of the seats available, only the available seats will be put on hold for that item. In
the example image, you see the result of adding the FH:201:1:16,19 seatblock to the
Held Seats table when the Arizona State game has only seat 19 available and the Utah
game has none of the seats available.
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c. If you have more seatblocks to enter for the order line, click the plus button to add a row
and enter the level:section:row:seat for each additional seatblock.

8. If you want to assign seats using the seat map, do one of the following:

l To select seats for more than one of the single events in the combination item at once,

click the Map: All Events buttonx to display the seat map for the selec-
ted primary event, and then select seats. For more information, see Selecting Combo
Item Seats Using the Seat Map.

l To select seats for one single event from the combination item, select the row of the

event, and then click the Map: Single event buttonx to display the
seat map and select the seats. For more information, see Selecting Combo Item Seats
Using the Seat Map.
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When you have finished selecting seats on the seat map, click the Continue buttonx
. The Select Primary Event form is redisplayed with the selected seats

added to the Held Seats table.

9. Click the Close buttonx . If the quantity in the order line and the quantity you
are placing on hold are not equal, an Attention! dialog box will prompt you to adjust the quant-
ity in the order line to match the held quantity. If displayed, click the Adjust Ord Qty

buttonx .

10. If the Price Split form is displayed, split quantities between price types in the Available
Price Types table, and then click the Continue button.
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The Order Management tab is redisplayed with the seatblock added to the Seatblocks
column in the combination item's order line.

11. To apply the changes to the order line, click the Finish buttonx , and then complete
the process. For more information, see Finishing Orders in Order Management.

To use seat fields to release held seats from a single event item order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the item with the held seats that you want to
release.
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4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list. The Seat Fields form is displayed.

Tip: You can also click the link in the Seatblocks column for the row.

5. In the Held Seats table, click to select the row containing the block of held seats that you
want to release.

Note: If the seats are in the Allocated Seats table, you cannot release them. However, you
can deallocate them. See Using Seat Fields for Deallocation in Order Management for more
information.

6. Click the minus button to remove the row. You can use the same method to remove other
held seatblock rows from the Held Seats table if necessary.
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7. Click the Continue buttonx . You are returned to the Order Management tab. If
you removed all held seat rows from the Held Seats table, the link is removed from Seat-
blocks column for the order line.

8. To apply the changes to the order line, click the Finish buttonx , and then complete
the process. For more information, see Finishing Orders in Order Management.

To use seat fields to release held seats from a combination item order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the combination item with the held seats that you
want to release.

4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list. The Select Primary Event form is displayed.

Tip: You can also click the link in the Seatblocks column for the row.
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5. Click the Seat Fields button.

The Select Primary Event form redisplays with the Seat Fields form embedded.

6. In the combo events table, select the event with the held seats that you want to release.
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7. In the Held Seats table, click to select the row containing the block of held seats that you
want to release, and then click the minus button to remove the row. You can use the same
method to remove other held seatblock rows from the Held Seats table if necessary.

Note: If the seats are in the Allocated Seats table, you cannot release them. However, you
can deallocate them. See Using Seat Fields for Deallocation in Order Management for more
information.

8. Click the Close buttonx . An Attention dialog box is displayed, because the
ordered quantity is now greater than the held quantity.

9. Do one of the following:

l If you want to reduce the order quantity by the number of held seats you're releasing,

click the Adjust Ord Qty buttonx . You are returned to the Order Man-
agement tab.

l If you want to leave the order quantity unchanged, click the Continue buttonx

. You are returned to the Order Management tab.

10. To apply the changes to the order line, click the Finish buttonx , and then complete
the process. For more information, see Finishing Orders in Order Management.
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Using Seat Fields for Deallocation in Order Management

Seat fields allow you to view and manage seat assignments from single event or combination item
order lines. Once you have allocated seats for an order line, you can use seat fields to deallocate
the seats at any time until they are printed. Deallocation removes the seat assignments from the
order line.

Note: You can also use the cancel process for deallocation. However, if seats have already been
printed, you should use the void process or the return and exchange processes in tRes instead.

To deallocate single event item seatblocks for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the item with the allocated seats.

4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

The Seat Fields form displays.
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Tip: You can also display the Seat Fields form for an item by clicking the seat assignment
link for its row in the Seatblocks column.

5. In the Allocated Seats box, select the seatblock you want to deallocate, and then click the
minus button.

The seatblock is moved to the Deallocated Seats box.

Tip: You can also drag and drop seatblocks back and forth between the Allocated Seats box
and the Deallocated Seats box or click the Map button to use the seat map.

6. Click the Continue buttonx . The Attention! dialog box displays.
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7. Do one of the following:

l To reduce the order line quantity by the number of seats in the seatblock you are deal-

locating, click the Adjust Ord Qty buttonx .

l To leave the order line quantity unchanged, click the Continue buttonx .

The order line is redisplayed with the seats deallocated.

8. To apply the changes to the order line, click the Finish buttonx , and then complete
the process. For more information, see Finishing Orders in Order Management.

To deallocate combination item seatblocks for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the item with the allocated seats.

4. Click the Seats button, and then select Seat fields from the drop-down list. If the Seat

fields buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

The Select Primary Event form displays.
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5. Click the Seat Fields buttonx . The Select Primary Event form redisplays
with the Seat Fields form embedded.

6. In the combo events table, select the event for which you want to deallocate seats.

7. Select the seatblock you want to deallocate, and then click the minus button.
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Tip: You can also drag and drop seatblocks back and forth between the Allocated Seats box
and the Deallocated Seats box or click the Map button to use the seat map.

The seatblock is moved from Allocated Seats to Deallocated Seats for all the events with
the same seat assignments. You will need to repeat this step for events that have different
seat assignments.

8. Click the Close buttonx . The Order Management tab is redisplayed.

9. To apply the changes to the order line, click the Finish buttonx , and then complete
the process. For more information, see Finishing Orders in Order Management.

Viewing Combo Event Order Details in Order Management
Once you have added a combination item to an order line, you can view the details of the single
events items in the order at any time. The details include event information (name, event, day,
date, and time), seat assignments (price level, section, row, and seats), order quantity, and the
number of held and allocated seats.

Single event items that have been prorated out of fixed combination items are not included on the
form. For designer combination items, only the single events that you selected are included. This a
view-only process.

To view the details of the single events in combination item from an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the combination item for which you want to view
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event details.

4. Click the Line actions button, and then select Event details from the drop-down list. If the

Event details buttonx is in the toolbar, you can click the button instead of selecting the
command from the drop-down list.

The Event Details form is displayed.

5. When you're finished viewing the details, click the Close buttonx .

Viewing Facility Fees in Order Management
You can view the facility fees for all of the single events in a combination item from an order line.
The view lists the quantity of tickets, facility, per ticket facility fee, and total facility fee for each
single event.

To view facility fee information for the single events in a combination item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the combination item for which you want to view
facility fees.
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4. Click the Line actions button, and then select Facility fee inquiry from the drop-down

list. If the Facility fee inquiry buttonx is in the toolbar, you can click the button instead
of selecting the command from the drop-down list.

The Facility Fee Inquiry window is displayed.

5. When you're finished viewing the window, click the Close buttonx to redisplay
the Order Management tab.

Viewing Item Details During Order Management
You can view the availability and pricing details of single event items at any time during order man-
agement. This includes single event items that are part of a combination item. Single event item
details include ticket pricing and availability, item information messages, and effective dates. This
a view-only process.

To view the details of a single event item

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the single event item for which you want to view
details.

4. Click the Line actions button, and then select Item details from the drop-down list. If the

Item details buttonx is in the toolbar, you can click the button instead of selecting the
command from the drop-down list.

The Item Details window is displayed.

5. When you're finished viewing the details, click the Close buttonx .

To view the details of a combination item
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1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the combination item for which you want to view
details.

4. Click the Line actions button, and then select Item details from the drop-down list.

The Item Details window is displayed.

5. When you're finished viewing the details, click the Close buttonx .

Prorating Combination Items in Order Management
In Paciolan, prorating allows you to sell fixed combination item tickets without including all the
events in a customer's order. This feature is typically used to sell a combo package after one or
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more events are over. Prorating fixed combo items is useful because:

l You can sell more season tickets to increase your renewable customer base.
l You can keep items the same from one year to the next, without setting up extra season
items for all the variations of the combo item. (For example, you do not have to set up 81 dif-
ferent fixed combo items for an 81 event baseball item.)

The events of a fixed combo can be prorated out or back in. You cannot prorate a designer combo.
If the item you are prorating out has held or allocated seats, those seats are released or deal-
located as part of proration. You cannot prorate out printed seats, unless you unprint them first.

You can prorate out events that occur in the past or the future. Events can be prorated back in to a
combo item, regardless of whether they were manually or automatically prorated out.

When events are prorated out of a combo item, the price or item balance is adjusted to be the sum
of the remaining events’ prices and facility fees. If the combo price prior to proration was dis-
counted compared to purchasing the events individually, a prorated discount is applied to the sum
of the remaining events’ prices.

Discounts can be set up as a % of the fixed combo price, a flat amount, a per event amount, or a
per item amount. So, when you prorate events out of the combo, the following rules are used:

l If the discount is setup as a %, the discount amount will be adjusted using the new combo
price.

l If the discount is setup as an amount per event, the discount will be the new number of the
events multiplied by the discount amount.

l If the discount is setup as an amount per item, the discount changes once an item is part of
the order.

To prorate events out of a combination item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the combination item that you want to prorate.

4. Click the Line actions button, and then select Prorate events from the drop-down list. If

the Prorate events buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.
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The Prorate Events form is displayed.

5. Select the event in the Events included in the combo box, and then click the Prorate out

> buttonx . You can also just drag and drop events from the Events included
in the combo box to the Events prorated out of the combo box.

Tip: If you want to prorate more than one event at the same time, you can select multiple
events by pressing the Shift key and clicking each event. You can also select a range of
events by clicking the first event, pressing the Ctrl key, and then clicking the last event.

6. Click the Continue buttonx . If you are prorating out events with held or alloc-

ated seats, an Attention! dialog box will require you to click the Yes buttonx to
continue. The seats assigned to the events will be released or deallocated.

The Order Lines table redisplays with amount in the Item balance column adjusted for the
prorated events.

To prorate events back into a combination item

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. In the Order Lines table, select the row of the combination item that you want to prorate.

4. Click the Line actions button, and then select Prorate events from the drop-down list. If

the Prorate events buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

The Prorate Events form is displayed.

5. Select the event in the Events prorated out of the combo box, and then click the < Rein-

state buttonx . You can also just drag and drop events from the Events pro-
rated out of the combo box to the Events included in the combo box.

Tip: If you want to prorate more than one event at the same time, you can select multiple
events by pressing the Shift key and clicking each event. You can also select a range of
events by clicking the first event, pressing the Ctrl key, and then clicking the last event.

6. Click the Continue buttonx .

The Order Lines table redisplays with amount in the Item balance column adjusted for the
prorated events.

Pac7 Release 7.2



User Guide  441

Printing Items in Order Management
When managing orders in Pac7, you can choose to print items at the order line level. You can print
order lines at any time during order processing for non-allocatable item (miscellaneous, gift cer-
tificates, donations, and access passes) order lines. Allocatable (single event and combination)
items can be printed once seats have been allocated for their order lines.

The system considers an order line item printed when you select the print option in the order line
and finish the order process. For allocatable and some miscellaneous items, printing includes
assigning a barcode to each seat or item. The physical printing of an item or ticket (for example, to
a gift certificate card or Boca printer) is a separate action that may or may not be done when you
print the order line.

To print an order line item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the Print tickets option in the row of the item that you
want to print. The order of the columns is customizable so, if the Print tickets column is not
visible, try scrolling to the right in the Order Lines table.

4. To print the order line, click the Finish buttonx , and then complete the process. For
more information, see Finishing Orders in Order Management. When printing is complete the
End of Sale - Confirmation dialog box is displayed.

Reprinting Items in Order Management
When managing orders in Pac7, you can choose to reprint items at the order line level that have
already been printed. For allocatable and miscellaneous items that have been assigned barcodes,
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reprinting removes the existing barcodes and assigns new ones. For unallocatable items that have
not been assigned barcodes, reprinting just voids and then reprints the items.

You can reprint items immediately after you finish printing them (if enabled in your selling control)
or after you have printed them and begun other order management tasks (for example, adding
new order lines or working on another patron's order). You can reprint an unlimited number of
times. For auditing purposes, reprinted item quantities are stored in the transaction record.

Your Pac7 selling control must be configured to allow you to reprint items. Based on the con-
figuration, you may be allowed to reprint, not be allowed to reprint, or be required to enter a pass-
word to reprint.

Reprinting at the end of a sale
To reprint tickets for a single event item at the end of a sale

1. Print the item.

2. When the End of Sale - Confirmation form is displayed, click the Reprint current order
link.

Note: If the Reprint current order link is not displayed on the End of Sale - Confirmation
form, either no items have been printed or this option is disabled in your selling control.

The Reprint form is displayed.

3. To reprint all the assigned seats for a single event item, select the item's row, and then click
the Reprint button. The items are reprinted, and the End of Sale -Confirmation form is
redisplayed.
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4. To select the seats you want to reprint, do the following:

a. Select the item, and then click the Select Seat button.

The Reprint form is redisplayed with the assigned seats individually listed.

b. In the assigned seat list, select the seats you want to reprint using one or more of the fol-
lowing methods:

l Click each seat that you want to reprint. You can sort the seats by column (a com-
bination of the Section, Row, Seat, or Barcode columns, depending on seating type).
The number of seats selected is displayed in the Qty selected field. In this example,
seats 2 and 3 have been selected.

l Select all the seats by clicking the checkbox in the left column of the table heading
row. You can deselect all the seats by clearing the checkbox after it has been selec-
ted.
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l Select a set number of the rows from the top by entering the number in the Select
First text box and then clicking the Go button. If you have already selected seats,
they are deselected before the first seats are selected. Once the seats are selected
you can deselect them or select more seats as required. In this example, the 2
entered in the Select First text box selects the first 2 seats.

c. When you are finished selecting the seats you want to reprint, click the Reprint buttonx

. The Reprint form closes, and the End of Sale - Confirmation form is
redisplayed.

To reprint tickets for a combination item at the end of a sale

1. Print the item.

2. When the End of Sale - Confirmation form is displayed, click the Reprint current order
link.

Note: If the Reprint current order link is not displayed on the End of Sale - Confirmation
form, either no items have been printed or this option is disabled in your selling control.

The Reprint form is displayed.
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3. To reprint all the assigned seats for the single events in the combination item, select the com-
bination item's row, and then click the Reprint button. Events that have been prorated out of
the item are not reprinted. The items are reprinted, and the End of Sale -Confirmation
form is redisplayed.

4. To reprint some but not all of the assigned seats, do the following:

a. Select the combination item, and then click the Select Seat button.

The Reprint form is redisplayed with the single event items individually listed. Each
single event in the combination item, along with its seat assignments, is included in the
table.
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b. Select the seats you want to reprint by using one or more of the following methods:

l If you want to select seats for an event individually, click the event row to display its
seat assignments, and then click the individual seat rows to select them. In this
example, seats 13 and 14 have been selected for the Sacramento State event, and
seats 14 and 15 have been selected for the UCLA event.

l If you want to select all the seats for all of the single events, select the checkbox in
the left of the table heading row. You can also deselect all the seats by clearing the
checkbox.
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l If you want to reprint the same one or more first seats for each single event, enter

the number in the Select first box, and then click the Go buttonx . In this
example, the first 2 seats have been selected for each single event in the combination
item.

c. When you are finished selecting the seats you want to reprint, click the Reprint buttonx

. The Reprint form closes, and the End of Sale - Confirmation form is
redisplayed.

To reprint a miscellaneous item with barcodes at the end of a sale

1. Print the item.

2. When the End of Sale - Confirmation form is displayed, click the Reprint current order
link.
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Note: If the Reprint current order link is not displayed on the End of Sale - Confirmation
form, either no items have been printed or this option is disabled in your selling control.

The Reprint form is displayed.

3. To reprint the barcodes for the whole quantity of the miscellaneous item, select the item's
row, and then click the Reprint button. The item is reprinted, and the End of Sale -Con-
firmation form is redisplayed.

4. To reprint some but not all of the miscellaneous item's barcodes, do the following:

a. Select the miscellaneous item, and then click the Select Seat button.

The Reprint form is redisplayed with all of the barcodes listed.
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b. In the item list, select the rows of the items that you want to reprint using one or more of
the following methods:

l Select individual items by clicking their rows. You can sort the items by column (Item
or Barcode). The number of items selected is displayed in the Qty selected field. In
this example, 2 of the items have been selected.

l Select all the items by clicking the checkbox in the left column of the table heading
row. You can deselect all the seats by clearing the checkbox after it has been selec-
ted.

l Select a set number of the rows from the top by entering the number in the Select
First text box and then clicking the Go button. If you have already selected items,
they are deselected before the first items are selected. Once the items are selected
you can deselect them or select more items as required. In this example, the 2
entered in the Select First text box selects the first 2 seats.
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c. When you are finished selecting the items you want to reprint, click the Reprint buttonx

. The Reprint form closes, and the End of Sale - Confirmation form is
redisplayed.

To reprint a non-allocatable item with no barcodes at the end of a sale

1. Print the item.

2. When the End of Sale - Confirmation form is displayed, click the Reprint current order
link.

Note: If the Reprint current order link is not displayed on the End of Sale - Confirmation
form, either no items have been printed or this option is disabled in your selling control.

The Reprint form is displayed.

3. To reprint the whole quantity of the item, select the item's row, and then click the Reprint
button. The item is reprinted, and the End of Sale -Confirmation form is redisplayed.

Pac7 Release 7.2



User Guide  451

4. To reprint a partial quantity of the item, do the following:

a. Select the item, and then click the Select Seat button.

The Reprint form is redisplayed with a quantity text box. In this example, the Reprint
form is redisplayed for a donation item with a Donation qty text box.

b. Enter the quantity in the text box, and then click the Reprint buttonx . The
Reprint form closes, and the End of Sale - Confirmation form is redisplayed.

Reprinting from an order line
To reprint tickets for a single event item from an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Select the order line of the single event item with the tickets you want to reprint.
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4. Click the Line actions button, and then select Reprint tickets from the drop-down list. If

the Reprint tickets buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

The Reprint form is displayed.

5. In the assigned seat list, select the seats you want to reprint using one or more of the fol-
lowing methods:

l Click each seat that you want to reprint. You can sort the seats by column (a combination
of the Section, Row, Seat, or Barcode columns, depending on seating type). The number
of seats selected is displayed in the Qty selected field. In this example, seats 2 and 3
have been selected.

l Select all the seats by clicking the checkbox in the left column of the table heading row.
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You can deselect all the seats by clearing the checkbox after it has been selected.

l Select a set number of the rows from the top by entering the number in the Select First
text box and then clicking the Go button. If you have already selected seats, they are
deselected before the first seats are selected. Once the seats are selected you can
deselect them or select more seats as required. In this example, the 2 entered in the
Select First text box selects the first 2 seats.

6. When you are finished selecting the seats you want to reprint, click the Continue buttonx

. The Reprint form closes.

7. Click the Finish buttonx . If you have applied other order actions, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

.

8. When the End of Sale - Confirmation form is displayed, click the Next order buttonx

. The Order Management tab is redisplayed and ready for the next patron
order.

To reprint tickets for a combination item from an order line

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. Select the order line of the combination item with the tickets you want to reprint.

4. Click the Line actions button, and then select Reprint tickets from the drop-down list. If

the Reprint tickets buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

The Reprint form is displayed. Each single event in the combination item is listed in the
table.

5. In the single events list, select the seats you want to reprint by using one or more of the fol-
lowing methods:

l If you want to select seats for an event individually, click the event row to display its seat
assignments, and then click the individual seat rows to select them. In this example,
seats 13 and 14 have been selected for the Sacramento State event, and seats 14 and 15
have been selected for the UCLA event.
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l If you want to select all the seats for all of the single events, select the checkbox in the
left of the table heading row. You can also deselect all the seats by clearing the checkbox.

l If you want to reprint the same one or more first seats for each single event, enter the

number in the Select first box, and then click the Go buttonx . In this example, the
first 2 seats have been selected for each single event in the combination item.

6. When you are finished selecting the seats you want to reprint, click the Continue buttonx

. The Reprint form closes.
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7. Click the Finish buttonx . If you have applied other order actions, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

.

8. When the End of Sale - Confirmation form is displayed, click the Next order buttonx

. The Order Management tab is redisplayed and ready for the next patron
order.

To reprint a miscellaneous item with barcodes from an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Select the order line of the miscellaneous item with the barcodes that you want to reprint.

4. Click the Line actions button, and then select Reprint tickets from the drop-down list. If

the Reprint tickets buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

The Reprint form is displayed.
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5. In the item list, select the rows of the items that you want to reprint using one or more of the
following methods:

l Select individual items by clicking their rows. You can sort the items by column (Item or
Barcode). The number of items selected is displayed in the Qty selected field. In this
example, 2 of the items have been selected.

l Select all the items by clicking the checkbox in the left column of the table heading row.
You can deselect all the seats by clearing the checkbox after it has been selected.

l Select a set number of the rows from the top by entering the number in the Select First
text box and then clicking the Go button. If you have already selected items, they are
deselected before the first items are selected. Once the items are selected you can
deselect them or select more items as required. In this example, the 2 entered in the
Select First text box selects the first 2 seats.
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6. When you are finished selecting the items you want to reprint, click the Continue buttonx

. The Reprint form closes.

7. Click the Finish buttonx . If you have applied other order actions, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

.

8. When the End of Sale - Confirmation form is displayed, click the Next order buttonx

. The Order Management tab is redisplayed and ready for the next patron
order.

To reprint a non-allocatable item with no barcodes from an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Select the order line of the non-allocatable item (miscellaneous with no barcodes, donation,
gift certificate, or access pass) that you want to reprint.

4. Click the Line actions button, and then select Reprint tickets from the drop-down list. If

the Reprint tickets buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.
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The Reprint form is displayed. In the example below, a donation item is being reprinted.

5. Enter the quantity, and then click the Reprint buttonx .

6. Click the Finish buttonx . If you have applied other order actions, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

.

7. When the End of Sale - Confirmation form is displayed, click the Next order buttonx

. The Order Management tab is redisplayed and ready for the next patron
order.

Deallocating Seats in Order Management
In order management, deallocating seats means removing assigned seats from order lines. You
can deallocate items using the seat fields for an order line, or as part of the order line cancel or
void processes. If seats are printed, you must use the void process to unprint them before you can
deallocate them. Once seatblocks are deallocated, they are available for assignment to other order
lines.

Returning Seats in Order Management
The Pac7 return feature allows you to return seats from a single event item or an event from a
combo item and give the customer a refund or a donation credit. You can return any number of the
purchased seats. The return process is initiated from the order management order line. You can
search for the seats you want to return by customer name, patron ID, keyword, phone, address,
email, credit card, magstripe ID, or barcode.

A return is different than a cancel, because customers retain seat ownership, which allows them to
reorder the seats next season. Also you can track which seats were returned by specifying a unique
seat status for them. Returns can be done for individual patrons or house customers. The

Pac7 Release 7.2



User Guide  460

permissions that an operator has are the same as in the existing rules for the Order Management
tab.

To return single event item seats

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the singe event item you want to
return.

4. Click the Line actions button, and then select Return from the drop-down list. If the

Return buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .
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The Return form is displayed.

5. If there is a return fee, select the it from the Return fee drop-down list.

6. In the assigned seat list, click the seats you want to return. You can sort the seats by column
(a combination of the Section, Row, Seat, Barcode, and Scanned columns, depending on seat-
ing type). The number of seats selected is displayed in the Return qty field. In this
example, seats 3 and 4 have been selected.
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7. If you are allowed to change the status of the returned seats, select the new status from the
Return seat status drop-down list.

8. If the customer wants to donate the remainder of the balance, select the miscellaneous or
donation item from the Miscellaneous/Donation drop-down list. The remainder of the bal-
ance is automatically entered into the adjacent field, and Total due is changed to 0.00.

9. Click the Continue buttonx . The new balance due is in the Item balance
column for the item line. If the total due is 0.00, the balance will be unchanged.

10. Process the return by clicking the Finish button.
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Depending on the order actions you have applied, you may need to enter payment inform-
ation to finish processing. If this is the case, the Payment Information page is displayed.

Enter payment methods and options, and then click the Purchase buttonx to fin-
ish processing the return.

To return combo item seats

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the combo with the items you
want to return.
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4. Click the Line actions button, and then select Return from the drop-down list. If the

Return buttonx is in the toolbar, you can click the button instead of selecting the com-
mand from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .

The Return form is displayed with the list of events that are included in the combo item.
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5. Select an event, and then click the Continue buttonx . The Return form is redis-
played with the details of the event item.

6. If there is a return fee, select the it from the Return fee drop-down list.

7. In the assigned seat list, click the seats you want to return. You can sort the seats by column
(a combination of the Section, Row, Seat, Barcode, and Scanned columns, depending on seat-
ing type). The number of seats selected is displayed in the Return qty field. In this
example, seats 3 and 4 have been selected.
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8. If you are allowed to change the status of the returned seats, select the new status from the
Return seat status drop-down list.

9. If the customer wants to donate the remainder of the balance, select the miscellaneous or
donation item from the Miscellaneous/Donation drop-down list. The remainder of the bal-
ance is automatically entered into the adjacent field, and Total due is changed to 0.00.

10. Click the Continue buttonx . The new balance due is in the Item balance
column for the item line. If the total due is 0.00, the balance will be unchanged.

11. Process the return by clicking the Finish button.
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Depending on the order actions you have applied, you may need to enter payment inform-
ation to finish processing. If this is the case, the Payment Information page is displayed.

Enter payment methods and options, and then click the Purchase buttonx to fin-
ish processing the return.

Exchanging Seats in Order Management
The Pac7 exchange features allow you to exchange seats from a single event item or an event
within a combo item (exchange out) for seats in another event (exchange in). You can exchange
any number of the purchased seats. The exchange process can be initiated from within order man-
agement or from a standalone process (equivalent to Go Exchange in TK.SELL). In both order man-
agement and Go Exchange, you can search for the seats you want to exchange by customer name,
patron ID, keyword, phone, address, email, credit card, magstripe ID, or barcode.

This topic details procedures for exchanging items in Order Management. For information about
standalone exchanges, see Using Go Exchange.

To exchange single event item seats

1. Click the Order Management tab.

2. Select the patron, and then select the season.
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3. In the Order Lines group, select the order line containing the singe event item you want to
exchange.

4. Click the Line actions button, and then select Exchange from the drop-down list. If the

Exchange buttonx is in the toolbar, you can click the button instead of selecting the
command from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .

The Exchange form is displayed.
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5. In the assigned seat list, click the seats you want to exchange. You can sort the seats by
column (a combination of the Section, Row, Seats, Barcode, and Scanned columns, depend-
ing on seating type). The number of seats selected is displayed in the Exchange qty field. In
this example, seats 3 and 4 have been selected.

6. Click the Continue buttonx . The Exchange page displays.
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7. In the Exchange Out group, select the event with quantity you want to exchange.

8. If you are allowed to change the status of the exchanged seats, select the new status from
the Exchange seat status drop-down list in the Exchange Details group.

9. If there is an exchange fee, select it from the Exchange fee drop-down list.

10. If the customer wants to donate the remainder of the balance, select the miscellaneous or
donation item from the Miscellaneous/Donation drop-down list. The remainder of the bal-
ance is automatically entered into the adjacent field, and Total due is changed to 0.00.
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11. In the Exchange In group, enter the code of the item for which the exchange is being made
in the Item column. If you want to exchange the item quantity for more than one event, you
can add order lines to the Exchange In group.

12. Enter the quantity, price level, price type, and any other values in the exchange columns,
and then assign seats to the item using the Seat Map or by clicking the Assign best seats

buttonx .

13. Click the Continue button. The Order Management page displays.

14. On the Order Management page, click the Finish button.
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Depending on the order actions you have applied, you may need to enter payment inform-
ation to finish processing. If this is the case, the Payment Information page is displayed.

Enter payment methods and options, and then click the Purchase buttonx to fin-
ish processing the exchange.

To exchange combo item seats

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the combo item containing the
single event you want to exchange.
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4. Click the Line actions button, and then select Exchange from the drop-down list. If the

Exchange buttonx is in the toolbar, you can click the button instead of selecting the
command from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .

The Exchange form is displayed with the list of events that are included in the combo item.
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5. Select an event, and then click the Continue buttonx . The Exchange form is
redisplayed with the details of the event item.

6. In the assigned seat list, click the seats you want to exchange. You can sort the seats by
column (a combination of the Section, Row, Seats, Barcode, and Scanned columns, depend-
ing on seating type). The number of seats selected is displayed in the Exchange qty field. In
this example, seats 3 and 4 have been selected.

7. Click the Continue buttonx . The Exchange page displays.
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8. In the Exchange Out group, select the event with quantity you want to exchange.

9. If you are allowed to change the status of the exchanged seats, select the new status from
the Exchange seat status drop-down list in the Exchange Details group.

10. If there is an exchange fee, select it from the Exchange fee drop-down list.

11. If the customer wants to donate the remainder of the balance, select the miscellaneous or
donation item from the Miscellaneous/Donation drop-down list. The remainder of the bal-
ance is automatically entered into the adjacent field, and Total due is changed to 0.00.
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12. In the Exchange In group, enter the code of the item for which the exchange is being made
in the Item column. If you want to exchange the item quantity for more than one event, you
can add order lines to the Exchange In group.

13. Enter the quantity, price level, price type, and any other values in the exchange columns,
and then assign seats to the item using the Seat Map or by clicking the Assign best seats

buttonx .

14. Click the Continue button. The Order Management page displays.

15. On the Order Management page, click the Finish button.
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Depending on the order actions you have applied, you may need to enter payment inform-
ation to finish processing. If this is the case, the Payment Information page is displayed.

Enter payment methods and options, and then click the Purchase buttonx to fin-
ish processing the exchange.

Canceling Order Lines in Order Management
Within order management, canceling reduces the quantity of an item in an order line. The cancel
process may also include some combination of releasing counter held seats, deallocating seats,
unprinting items, and moving ticket charges. Any payments made toward the item are credited to
the patron's account when the item is canceled.

Tip: Cancels can also be done as part of the void process.

Access to the cancel process is configured in your selling control. If you have access and you can-
cel an order line, the system detects the item type, as well as the allocated state and the printed
state. The system also knows whether the order line is new or has already been processed.These
attributes determine what happens when you cancel an order line item.

Canceling non-allocatable order line items
Non-allocatable items include miscellaneous, donation, gift certificate, and access pass items. The
effect of canceling a non-allocatable item depends on whether or not it has been printed. If the
item is not printed, canceling the order line simply removes it from the order.

If the item has been printed, canceling the order line unprints the item, reduces the quantity to 0,
marks the order line void, and removes the order line from the order. If it is a miscellaneous item
with barcodes, unprinting also removes the barcodes.

Canceling allocatable order line items
Allocatable item types include single events, fixed combinations, and designer combinations. The
effect of canceling an allocatable item depends on if it has counter held, allocated, or printed seats.
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The table below details the effects of canceling an allocatable order line item based on the seat
status.

Item seat status Effect of cancel

Not counter held, allocated,
or printed

Reduces the item quantity to 0 and removes the order line

Counter held but not printed Reduces the item quantity to 0, releases the seats, and removes
the order line

Allocated but not printed Reduces the item quantity by 1 or more and deallocates the can-
celed seats

Allocated and printed Removes their barcodes and does one of the following:

l If you reduce the order line quantity to 0, unprints the
order, deallocates seats, and removes the order line

l If you partially reduce the order line quantity, voids the
selected seats. The void options include unprint, unprint
and deallocate, or unprint, deallocate and cancel).

A mixture of allocated, deal-
located, counter held, prin-
ted and unprinted

Cannot cancel

Cancel procedures
To cancel an unprinted non-allocatable order line item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the non-allocatable item, and then click the cancel button.
The order line is deleted from the table.

4. Click the Finish button.
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5. If the Payment Information page displays, enter any required payment information, and then
click the Purchase button.

6. When the End of Sale - Confirmation dialog box is displayed, click the Next Order button. The
Order Management tab is displayed and ready for the next patron order.

To cancel a printed non-allocatable order line item

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the non-allocatable item, and then click the cancel button.
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4. When the Attention dialog box displays, click the Yes button. The order line is removed from
the table. If the non-allocatable item is a miscellaneous item with barcodes, the barcodes
are also removed.

5. Click the Finish button.

6. If the Payment Information page displays, enter any required payment information, and then
click the Purchase button.

7. When the End of Sale - Confirmation dialog box is displayed, click the Next Order button. The
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Order Management tab is displayed and ready for the next patron order.

To cancel an allocatable order line item that has no counter held seats and is not alloc-
ated or printed

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the allocatable item, and then click the cancel button. The
order line is deleted from the table.

4. Click the Finish button.

5. If the Payment Information page displays, enter any required payment information, and then
click the Purchase button.
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6. When the End of Sale - Confirmation dialog box is displayed, click the Next Order button. The
Order Management tab is displayed and ready for the next patron order.

To cancel an allocatable order line item that has counter held seats but is not alloc-
ated or printed

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the allocatable item, and then click the cancel button.

4. When the Cancel dialog box displays, click the Continue button. The order line is deleted
from the Order Lines table.
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5. Click the Finish button.

6. If the Payment Information page displays, enter any required payment information, and then
click the Purchase button.

7. When the End of Sale - Confirmation dialog box is displayed, click the Next Order button. The
Order Management tab is displayed and ready for the next patron order.

To cancel an allocatable order line item that is allocated but not printed

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. In the Order Lines table, select the allocatable item, and then click the cancel button.

The Cancel dialog box is displayed.

4. If you want to reduce the quantity of the item to 0, click the Continue buttonx .

5. If you want to reduce the quantity to an amount greater than 0, do the following:

a. Select the On continue, allow selection of specific seats to cancel option, and then

click the Continue buttonx .

The Cancel form is displayed.

b. In the seatblock list, click the seats you want to cancel. You can sort the seatblocks by
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column (Section, Row, or Seat). The number of seats selected is displayed in the Qty
selected field. In this example, seats 4 and 5 have been selected so the quantity selected
is 2.

If you want to select all the seats, click the checkbox in the left column of the table head-
ing row. You can deselect all the seats by clearing the checkbox after it has been selected.

Or, you can select a set number of the rows from the top by entering the number in the
Select First text box and then clicking the Go button. If you have already selected seats,
they are deselected before the select first seats are selected. Once the seats are selected
you can deselect them or select more seats as required. In this example, the 2 entered in
the Select First text box selects the first 2 seats.

c. At the bottom of the form, click the Continue buttonx . The Order Lines table
redisplays with the selected seats removed from the order line. In this example, the
quantity has been reduced from 4 to 2.

6. Click the Finish button.
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7. If the Payment Information page displays, enter any required payment information, and then
click the Purchase button.

8. When the End of Sale - Confirmation dialog box is displayed, click the Next Order button. The
Order Management tab is displayed and ready for the next patron order.

To cancel an allocatable order line item that is allocated and printed

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines table, select the allocatable item, and then click the cancel button.
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The Cancel dialog box is displayed.

4. If you want to reduce the quantity of the item to 0, click the Continue buttonx .

Note: The quantity in the order line is not changed until you process the order. For example,
if the Qty column contains 4 and you cancel 2 seats, it will remain 4 in the Qty column until
you finish processing the order.

5. If you want to reduce the quantity to an amount greater than 0, do the following:

a. Select the On continue, allow selection of specific seats to cancel option, and then

click the Continue buttonx .

The Void form is displayed.

b. Select the void option you want to use for the order line. See descriptions of the options.

Unprint. When you unprint allocatable items (single events and combos), you are
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removing the barcode from them. The void process allows you to unprint one or more
seats from a seatblock. Miscellaneous items may also have barcodes that can be
removed by unprinting. When you unprint miscellaneous items without barcodes or other
non-allocatable items, they are simply marked as voided, since they have no barcodes
to be removed. If you unprint an item without canceling, the item quantity remains in the
order line.

Unprint and deallocate seats. (Allocatable items only) When you unprint and deal-
locate an allocatable item, barcodes are removed and seats are unassigned, making the
seats available for purchase by other customers. You cannot deallocate seats unless you
also unprint them. Since you are not canceling the seats, the deallocated item quantity
remains in the order line after processing. You can always reduce or remove the item
quantity by canceling them or using the void process again.

Unprint, deallocate seats and cancel. (Allocatable items only) When you unprint,
deallocate, and cancel an allocatable item, barcodes are removed, seats are unassigned,
and a quantity of the item is canceled. Canceling an item allows you to reduce the quant-
ity or set it to 0. If you reduce the quantity to 0 and finish processing the order, the order
line will be removed from the order. In a combo item, the quantity voided must be the
same for each event in the combo, although they may be different seats.

c. In the seatblock list, click the seats you want to void. You can sort the seatblocks by
column (a combination of Section, Row, Seat, and Barcode, depending on seating type).
The number of seats selected is displayed in the Qty selected field. In this example,
seats 4 and 5 have been selected so the quantity selected is 2.

If you want to select all the seats, click the checkbox in the left column of the table head-
ing row. You can deselect all the seats by clearing the checkbox after it has been selec-
ted.
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Or, you can select a set number of the rows from the top by entering the number in the
Select First text box and then clicking the Go button. If you have already selected
seats, they are deselected before the select first seats are selected. Once the seats are
selected you can deselect them or select more seats as required. In this example, the 2
entered in the Select First text box selects the first 2 seats.

d. At the bottom of the form, click the Continue buttonx . The Order Lines table
redisplays. The state of the order line depends on the void option you selected.

l If you selected Unprint, the barcodes have been removed, but the allocated seat block
and quantity remain unchanged.

l If you selected Unprint and deallocate, the barcodes have been removed and the
seat block has been deallocated, but the and quantity remain unchanged.

l If you selected Unprint, deallocate seats and cancel, the barcodes have been
removed, the seat block has been deallocated, the quantity has been reduced by the
number of selected seats.

Note: The quantity, seat block allocation, and barcodes are not changed until you process
the order. For example, if the Qty column contains 4 and you cancel 2 seats, it will
remain 4 in the Qty column until you finish processing the order.

6. Click the Finish button.
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7. If the Payment Information page displays, enter any required payment information, and then
click the Purchase button.

8. When the End of Sale - Confirmation dialog box is displayed, click the Next Order button. The
Order Management tab is displayed and ready for the next patron order.

Voiding Order Lines in Order Management
The void process in Pac7 allows you to unprint, deallocate, and cancel an item in an order line. At a
minimum the void will unprint the order line. Depending on the status of the order line, the fol-
lowing options may be available during the void process:

l Unprint. When you unprint allocatable items (single events and combos), you are removing
the barcode from them. The void process allows you to unprint one or more seats from a
seatblock. Miscellaneous items may also have barcodes that can be removed by unprinting.
When you unprint miscellaneous items without barcodes or other non-allocatable items, they
are simply marked as voided, since they have no barcodes to be removed. If you unprint an
item without canceling, the item quantity remains in the order line.

l Unprint and cancel. (Unallocatable items only) The selected items are marked as void and
the quantity is reduced by the number selected. If the whole quantity of the item is canceled,
the order line containing the item is deleted from the order.
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l Unprint and deallocate seats. (Allocatable items only) When you unprint and deallocate
an allocatable item, barcodes are removed and seats are unassigned, making the seats avail-
able for purchase by other customers. You cannot deallocate seats unless you also unprint
them. Since you are not canceling the seats, the deallocated item quantity remains in the
order line after processing. You can always reduce or remove the item quantity by canceling
them or using the void process again.

l Unprint, deallocate seats and cancel. (Allocatable items only) When you unprint, deal-
locate, and cancel an allocatable item, barcodes are removed, seats are unassigned, and a
quantity of the item is canceled. Canceling an item allows you to reduce the quantity or set it
to 0. If you reduce the quantity to 0 and finish processing the order, the order line will be
removed from the order. In a combo item, the quantity voided must be the same for each
event in the combo, although they may be different seats.

If an order line with an allocatable item has a combination of reserved, general admission, or sec-
tional general admission seats, all printed seat types are available for void actions. If there is a
ticket charge on the seats in a seatblock you are canceling, you will have the option to cancel
(refund) the ticket charges or move them to the order charge.

To void a single event item order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the singe event item you want to
void.

4. Click the Line actions button, and then select Void order line from the drop-down list. If

the Void order line buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue
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buttonx .

The Void form is displayed. Only printed seats are displayed on the form.

Note: The value in the Qty printed field does not include unprinted items, so it may be less
than the value in the Order qty field.

5. Select the void option you want to use for the order line. The Unprint, deallocate seats
and cancel option will only be displayed if your selling control allows you to cancel items.

6. In the assigned seat list, click the seats you want to void. You can sort the seats by column
(a combination of the Section, Row, Seat, and Barcode columns, depending on seating type).
The number of seats selected is displayed in the Qty selected field. In this example, seats 4
and 5 have been selected.
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If you want to select all the seats, click the checkbox in the left column of the table heading
row. You can deselect all the seats by clearing the checkbox after it has been selected.

Or, you can select a set number of the rows from the top by entering the number in the
Select First text box and then clicking the Go button. If you have already selected seats,
they are deselected before the select first seats are selected. Once the seats are selected
you can deselect them or select more seats as required. In this example, the 2 entered in
the Select First text box selects the first 2 seats.

7. At the bottom of the form, click the Continue buttonx . The selected void actions
are applied to the order line. You can repeat this procedure to change your selections at any
time until you process the void.

Note: You may need to enter a password to cancel a quantity of allocatable or miscellaneous
items, depending on the configuration of the item and your selling control.

Note: If you are canceling allocatable items with ticket charges and you have permissions to
cancel ticket charges, a Ticket charge prompt will require you to cancel the ticket charges or
move them to the order charges.
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8. Process the void by clicking the Finish button.

Depending on the void action and any other order actions you have applied, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

to finish processing the void.

To void a combination item order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the combination item you want to
void.
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4. Click the Line actions button, and then select Void order line from the drop-down list. If

the Void order line buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .

The Void form is displayed. Only printed seats are displayed on the form. Single event items
that have been prorated out of the combination item are not included.

Note: The value in the Order qty field is the number of seats in each single event item of
the combination item, while the value in the Qty printed field is the sum of the printed seats
for all single event items. See an example (If the combination item has an order quantity of
4, includes 5 single events, and has all of its seats printed, the quantity printed is 20).

5. Select the void option you want to use for the order line. The Unprint, deallocate seats
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and cancel option will only be displayed if your selling control allows you to cancel items.

6. In the list of seats for each combination item, click the seats you want to void. You can sort
the seatblocks by column (a combination of the Facility, Price level, Section, Row, Seats, and
Barcode columns, depending on seating type). To deselect a selected item, click it again. The
number of seats selected is displayed in the Qty selected field. In this example, seats 9 and
10 have been selected for the Sacramento State, UCLA, and Arizona State items.

Note: You must select the same number of seats for each single event in the combination
item.

If you want to select all the seats for all of the combination items, click the checkbox in the
left column of the table heading row. You can deselect all the seats by clearing the checkbox
after it has been selected.
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Or, you can select a set number of the rows from the top for each item by entering the num-
ber in the Select First text box and then clicking the Go button. If you have already selec-
ted seats, they are deselected before the select first seats are selected. Once the seats are
selected you can deselect them or select more seats as required. In this example, the 2
entered in the Select First text box selects the first 2 seats for each single event item.

7. At the bottom of the form, click the Continue buttonx . The selected void actions
are applied to the order line. You can repeat this procedure to change your selections at any
time until you process the void.

Note: You may need to enter a password to cancel a quantity of allocatable or miscellaneous
items, depending on the configuration of the item and your selling control.

Note: If you are canceling allocatable items with ticket charges and you have permissions to
cancel ticket charges, a Ticket charge prompt will require you to cancel the ticket charges or
move them to the order charges.
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8. Process the void by clicking the Finish button.

Depending on the void action and any other order actions you have applied, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

to finish processing the void.

To void a miscellaneous item order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the miscellaneous item you want
to void.
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4. Click the Line actions button, and then select Void order line from the drop-down list. If

the Void order line buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .

The Void form is displayed. Only printed items are displayed on the form. The Unprint and
cancel option will only be displayed if your selling control allows you to cancel items.

Note: The value in the Qty printed field does not include unprinted items, so it may be less
than the value in the Order qty field.
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5. If you have a choice, select the void option you want to use for the order line.

6. In the item list, click the items you want to void. You can sort the items by column (Item or
Barcode). The number of items selected is displayed in the Qty selected field. In this
example, 2 of the miscellaneous items have been selected.

If you want to select all the miscellaneous items, click the checkbox in the left column of the
table heading row. You can deselect all the items by clearing the heading row checkbox after
it has been selected.

Or, you can select a set number of the rows from the top by entering the number in the
Select First text box and then clicking the Go button. If you have already selected items,
they are deselected before the select first items are selected. Once the items are selected
you can deselect them or select more items as required. In this example, the 3 entered in
the Select First text box selects the first 3 seats.
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7. At the bottom of the form, click the Continue buttonx . The selected void actions
are applied to the order line. You can repeat this procedure to change your selections at any
time until you process the void.

Note: You may need to enter a password to cancel a quantity of allocatable or miscellaneous
items, depending on the configuration of the item and your selling control.

8. Process the void by clicking the Finish button.

Depending on the void action and any other order actions you have applied, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

to finish processing the void.

To void a donation item order line

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the donation item you want to
void.

4. Click the Line actions button, and then select Void order line from the drop-down list. If

the Void order line buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .

The Void form is displayed. The Unprint and cancel option will only be displayed if your
selling control allows you to cancel items.
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Note: The value in the Qty printed field does not include unprinted items, so it may be less
than the value in the Order qty field.

5. If you have a choice, select the void option you want to use for the order line.

6. In Void Qty, enter the quantity of the item that you want to void. If you choose to void the
whole quantity, the order line will be removed when you process the void.

7. At the bottom of the form, click the Continue buttonx . The selected void actions
are applied to the order line. You can repeat this procedure to change your selections at any
time until you process the void.

8. Process the void by clicking the Finish button.

Depending on the void action and any other order actions you have applied, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

to finish processing the void.
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To void a gift certificate or access pass item order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Lines group, select the order line containing the gift certificate or access pass
item you want to void.

4. Click the Line actions button, and then select Void order line from the drop-down list. If

the Void order line buttonx is in the toolbar, you can click the button instead of select-
ing the command from the drop-down list.

If the Password Required form displays, enter the password and then click the Continue but-

tonx .
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The Void form is displayed. The Unprint and cancel option will only be displayed if your
selling control allows you to cancel items.

5. If you have a choice, select the void option you want to use for the order line.

6. At the bottom of the form, click the Continue buttonx . The selected void actions
are applied to the order line. You can repeat this procedure to change your selections at any
time until you process the void.

7. Process the void by clicking the Finish button.

Depending on the void action and any other order actions you have applied, you may need to
enter payment information to finish processing. If this is the case, the Payment Information
page is displayed. Enter payment methods and options, and then click the Purchase buttonx

to finish processing the void.
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Using Go Exchange
Go Exchange is a standalone process accessible as the Exchange tab in Paciolan 7. If enabled in
your Paciolan 7 control, you will be able to exchange items on the tab without going through the
order line on the Order Management tab. This process is analogous to the Go Exchange process in
tRes.

In addition to processing an exchange, Go Exchange allows operators to take advantage of the fol-
lowing features:

l Multiple Exchange In items. Operators can exchange multiple Exchange In and Exchange Out
items during one transaction.

l Barcode search. Operators can enter a barcode number to identify the customer that owns
the ticket. Barcodes can also be scanned using the barcode on a ticket.

l Patron display. If an operator searches for a patron, all exchangeable inventory for the given
patron will be displayed, including the name of any combo items to which an individual event
belongs.

Note: Go Exchange is separate from Order Management so the Order/Pay Only option that is con-
figured on the Order Management Order Options subscreen of the Paciolan 7 Controls screen. If
you have access to Go Exchange tab in your control, you can process exchanges on the tab without
the limitation of the Order/Pay Only option.

To use Go Exchange

1. Click the Exchange tab.
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2. In Barcode, enter or scan a ticket barcode, and then click the Go buttonx . The patron
name/number and the season the event belongs to are displayed in Patron and Season, and
the event displays in the Exchange Out group table.

3. If you want to add or update the tickets for exchange, do the following:

a. Click Add/Updatex . The Add/Update seats to exchange out form dis-
plays. This form includes all current event items from the patron's order lines for the sea-
son.

b. Select additional seats to exchange, or deselect seats to remove from the exchange.
Seats for event items that are part of a combo item order line include the season name in
parenthesis.
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c. Click the Continue buttonx .

4. If you want to remove an event from the Exchange Out table, select the row and then click

the trash buttonx .

5. If you are allowed to change the status of the exchanged seats, select the new status from
the Exchange seat status drop-down list in the Exchange Details group.

6. If you want to cancel the ticket charge from the original purchase, select Cancel ticket
charge from the Ticket charge drop-down list. If you do not want to cancel ticket charges,
the defaultMove to order charge selection will apply to ticket charges for the season.

7. If there is an exchange fee, select it from the Exchange fee drop-down list.

8. If the customer wants to donate part or all of the balance, do the following:

a. Click the Miscellaneous/Donation link.
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The Miscellaneous/Donation form displays.

b. Select an item from the drop-down list in the Miscellaneous/Donation column, and
then enter the quantity and price for the item in the Qty and Price columns. See an
example.

c. If you want to move part of the balance to other items, click the plus buttonx to add the
items to the table, and then enter the quantity and price for each.

d. Click the Continue buttonx . The total miscellaneous/donation amount is dis-
played below the Subtotal and automatically added to the Total due. See an example.
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9. In the Exchange In group, enter the code of the item for which the exchange is being made in
the Item column. If you want to exchange the item quantity for more than one event, you
can add order lines to the Exchange In group.

10. Enter the quantity, price level, price type, and any other values in the exchange columns,
and then assign seats to the item using the Seat Map or by clicking the Assign best seats

buttonx .

11. Click the Continue button. The Order Management page displays.

12. On the Order Management page, click the Finish button.
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Depending on the order actions you have applied, you may need to enter payment inform-
ation to finish processing. If this is the case, the Payment Information page is displayed.

Enter payment methods and options, and then click the Purchase buttonx to fin-
ish processing the exchange.

Using the Order Line Additional Pane
The Order Line Additional pane displays both standard and customizable information and entry
fields that apply to a single order line item. The pane is used to supplement the fields that are in
the order line, which is itself customizable. If any of the fields on the pane are required, you will
not be able to finish an order without making an entry for each order line.
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When you visit the Order Management tab, the Order Line Additional pane is displayed empty and
to the right of the Order Lines table. The fields and information in the pane are displayed once you
select a patron, season, and order line. You can hide the pane at any time to see more of the
columns of the Order Lines table. You can then display the pane again whenever you want.

To hide the Order Line Additional pane

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Management pane, click the hide button.
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The pane is hidden, and the Order Lines table is expanded in its place.

To show the Order Line Additional pane

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the show button.
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The Order Line Additional pane is shown.

Collecting Payment Information in Order Management
You may choose to enter or change payment information as part of the process of finishing orders
during order management. In fact, if you make fiscal changes to an order, you will be required to
enter payment information before finishing the order. Changes that require you to enter payment
information include the following:

l Changing the order amount.
l Adding one or more order lines.
l Selecting order line dispositions that require a credit card number or PAH email address.
l Carrying a negative balance.
l Having left pending payment information.
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You enter payment information on the Payment Information page of the Order Management tab. If
you make entries on the page, the system will temporarily save them if you go back to the main
Order Management page and then return to the Payment Information page without finishing and
paying first. The exception is if the Auto Add Pay option is configured in your selling control. In this
case, the payment entries are not saved because returning to the Payment Information page auto-
matically enters a single payment for the whole balance due.

When collecting payment information in order management, you can do any of the following:

Edit patron information Print mailers & receipts

View the order amount breakdown Use delivery methods

Use payment methods Re-swipe credit cards

Apply payments Reissue gift certificates

Send confirmation email Issue refunds

Use billing plans Submit payments

Use previous credit cards Reprint prior receipts

Use gift cards

Editing Patron Information in Order Management
Once you've selected a patron for order management, you can edit the patron’s phone, email,
address, and comments information from the pages of the Order Management tab during order and
payment information entry. The address, email, and phone type fields available for editing are
determined by the patron policy that is assigned to your selling control. If you need to modify other
patron information, you will need to edit the full patron record instead.

To edit a patron's phone numbers and email addresses on the Order Management tab

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. In the Phone/Email section of the customer information group, click the Edit link.

The Edit Phone/Email form is displayed.

4. Click in the Phone number and Email address columns to add, edit, or delete a number or
address.

5. When you finish editing, click the Save button. The Order Management tab is redisplayed
with your phone and email edits in the customer information.

To edit a patron's geographic addresses on the Order Management tab

1. Click the Order Management tab.

2. Select the patron, and then select the season.
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1. In the Address section of the customer information group, click the Edit link.

The Edit Address form is displayed.

2. Select the row containing the type of address you want to edit. If the address type has an
address entered already, the address information is displayed in the fields below the table.

3. Add, edit, or delete the address information for each address type as required.

4. When you finish editing, click the Save button. The Order Management tab is redisplayed
with your address edits in the customer information.
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Viewing the Order Amount Breakdown in Order Management
When working with patron orders on the pages of the Order Management tab, you can easily view
the breakdown of monetary amounts for individual patron order totals. This is useful anytime you
want to see the components of the current order total. For example, you can see how much of the
order is due to item costs versus order charges or ticket fees.

The order amount breakdown includes the individual totals of all order lines for each of the fol-
lowing components:

l Item prices. The sum of all item price amounts. Each item price amount is the price of the
item multiplied by the quantity in the order line, with no fees or order charges included.

l Facility fee. The sum of all facility fee amounts.
l Discount. The sum of all discount amounts.
l Surcharge. The sum of all surcharge amounts.
l Item charge. The sum of the per ticket item charge amounts. This does not include item
charges that have been moved to order charges. On the Order Management tab this value is
referred to as the charge amount.

l Order charge. The sum of all order charges.

You can display the order amount breakdown from the Order Management, Payment Information,
and Payment Application pages on the Order Management tab. The Payment Application page is
only available if you choose not to apply payments at the end of order processing. For more inform-
ation, see Applying Payments in Order Management.

To display the Order Amount Breakdown from the Order Management page

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Order Totals group, click the Order amount link.

The Order Amount Breakdown form is displayed.
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4. To return to the Order Management tab, click the Close buttonx .

To display the Order Amount Breakdown from the Payment Information page

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Finish and pay button. The Payment Information page is displayed.

4. In the Order Totals group, click the Order amount link.

The Order Amount Breakdown form is displayed.
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5. To return to the Payment Information page, click the Close buttonx .

To display the Order Amount Breakdown from the Payment Application page

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Finish and pay button. The Payment Information page is displayed.

4. In the Payment Methods table, add a valid payment type. You do not need to enter an
amount.

5. In the Payment Options group, select Do no apply payments from the Payment dis-
tribution drop-down list.

6. Click the Purchase buttonx . The End of Sale - Confirmation form is dis-
played.
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7. Click the Apply Payments button. The Payment Application page is displayed.

8. In the Order Summary group, click the Order amount link.

The Order Amount Breakdown form is displayed.

9. To return to the Payment Application page, click the Close buttonx .

Using Payment Methods in Order Management
When working on a patron's seasonal order on the Order Management tab, you can add or edit pay-
ment methods at any time. Each payment method includes a paymode (A paymode is a set of attrib-
utes that define methods of payment used by patrons, including the payment type. For example,
the Visa or MasterCard paymodes are assigned the Credit payment type) and its associated pay-
ment information.

The paymode types that can be assigned to each payment method include credit, cash, check,
other, gift certificate, and gift card. The available paymodes are configured in your selling control.
Each paymode type has its own set of information fields that you are required to set, including
some combination of payment type, amount, tendered, patron name, card number, month, year,
PIN/CVV number, and pre-authorization code.

Pac7 Release 7.2



User Guide  522

If you decide not to use a payment method after you've added it, you can remove the payment
method at any time until you submit the payment information. If the payment method is a credit
card and it has been authorized, the credit card is de-authorized when you remove it.

To add a payment method

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Finish and pay button.

The Payment Information page is displayed.

4. In the Payment Methods table, click the plus button.

A payment method row is added to the table.

5. In the Payment type drop-down list, select the paymode.
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6. Enter values for the remaining fields in the payment method row. See descriptions of the pay-
ment information fields.

Field
Name

Entry
Format Description

Payment
type

Drop-
down list

This list contains the paymodes configured in your selling control. Pay-
mode payment types include cash, check, credit, gift card, gift cer-
tificate, and other. The payment type, along with the control
configuration, determines whether the rest of the payment inform-
ation fields in the payment method row are read-only or editable.
If a credit card type is used and authorized successfully, none of the
payment information fields are editable for the method. After author-
ization you must delete the payment method and add a new one to
change the credit card information.

Amount Numerical
text entry
field

The dollar amount that the patron is paying with the selected payment
type. Note the following:

l This field is read-only for gift certificate and gift card payment
types. For gift card payment method rows, the read-only
redeemed value is displayed.

l This field remains editable for credit cards after authorization
fails, so that you can enter a lower amount to meet a credit
limit before resubmitting.

l This field is disabled after a successful credit card author-
ization, to avoid authorizing the same card twice for the same
amount.

l A balance due or refund order amount may be automatically
entered in the field, based on the configuration of your selling
control, the number of payment method rows, and the amounts
entered in other payment method rows.

l If you enter a negative amount for a refund, you may be
required to enter a password to continue.

l You may be able to enter an amount greater than the order
amount (that is, overpay), depending on the configuration of
your selling control.

Tendered Numerical
text entry
field

The amount provided by the patron. Note the following:

l This column may be hidden by your selling control con-
figuration.

l The amount in the Tendered field can never be less than the
Amount field.

l For credit cards, this amount is not editable and will always be
equal to the Amount field.

l For gift cards it displays the redeemed value and is not edit-
able.
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Field
Name

Entry
Format Description

l For gift certificates it displays the value retrieved and is not
editable.

l Depending on the paymode configuration, this field may be edit-
able for the cash, other, or check payment types.

Change Read-only
text field

The amount in this field is equal to the amount in the Tendered field
minus the amount in the Amount field. It is automatically calculated
and read-only for all payment types. The column may be hidden by
your selling control configuration.

Name Text entry
field

For the credit payment type only, enter the name on the patron's
credit card. By default the name of the primary patron for the account
is automatically entered. This field becomes read-only if you swipe a
credit card or a credit card authorization is successful. This field does
not apply to any non-credit card payment types.

Number Numerical
text entry
field

For credit card, gift card, and gift certificates, you are required to
enter the number. Depending on your the paymode configuration, you
may be required to enter a document number for the check payment
type. The field is optional for the "other" payment type, and disabled
for the cash type. Note the following:

l The number format is determined by the payment type, how-
ever, the number of digits for non-AMEX credit cards (16),
AMEX credit cards (15), and gift cards (18) is set. Gift cer-
tificates are limited to 14 digits or less.

l Depending on their paymode configuration, the credit cards and
gift certificates may be validated at the time you enter them in
Number field. Otherwise, validation will occur when the Pay-
ment Information page is processed.

l You cannot use the same credit card, gift card, or gift certificate
number in more than one row in the Payment Methods table.

l When swiping a credit card or selecting a previously used credit
card, the number may be masked based on your operator
access settings.

Month Drop-
down list

This field is for credit cards only. The field is a list with the 12 months
of the year. In the year selected for the Year field, the credit card
expires a the end of this month.

Year Drop-
down list

This field is for credit cards only. The field is a list with the current
and future years through which the card is valid. The credit card
expires in this year at the end of the selected month in the Month
field.

Pin/CVV Numerical
text entry
field

This field is for credit cards and gift cards only. The Pin number is
required for gift cards. The CVV number is enabled for new and pre-
viously used credit cards and may be required depending on the con-
figuration of your selling control. Note the following:

l The CVV number is printed on the back of the physical credit
card.

l AMEX credit card CVV values require 4 digits, while non-AMEX
credit cards require 3.
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Field
Name

Entry
Format Description

l The field becomes read-only for credit cards once they are suc-
cessfully authorized. The field remains enabled if authorization
fails.

l For gift cards, this field is disabled after you swipe the card or
once the card is redeemed. The field is re-enabled if you re-
swipe the card.

l This field is disabled for AMEX and Discover cards when selling
to a house customer.

PreAuth Numerical
text entry
field

This optional field is for pre-authorization numbers and is used for
credit cards only. Valid entries must begin with the letter P.

7. Set payment options as required, and then click the Purchase button. The End of Sale - Con-
firmation form is displayed.

To remove a payment method

1. Select the payment method row.

2. Click the trash button.
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Applying Payments in Order Management
Applying a payment in order management means associating money with an item or order charge
in a patron’s order record. Depending on your selling control configuration, payments may be
applied automatically by the system or manually by you at the end of a sale. The control may also
allow you to choose manual or automatic payment application.

The table below describes how your options for applying payments are determined by the payment
distribution options configured in your selling control.

Payment
Distribution
Option

Description

Do not apply
payments

Payments are not automatically applied. Any payments received in the order
will remain undistributed until you manually apply them.

Apply pay-
ment to cur-
rent order
only

The payment received at the completion of the order will be applied to the line
items in the current order only. They will not be applied to line items previously
added in the patron's order for the season.

Apply pay-
ment to all
line items

First, the payment received at the completion of the order is applied to the line
items in the current order. Then, if there is a remaining payment amount, the
amount is applied to any unpaid line items in the patron's order for the season.

Until payments are applied, money collected from a patron for an order is considered undis-
tributed. If you choose to manually apply payments, you can leave the payments undistributed if
you don't want to apply them immediately. You can then choose to apply the undistributed pay-
ments later on or at the end of a future sale. Payment transaction records are recorded in the cur-
rently assigned batch.

Note: The procedures below are only allowed if your selling control configuration allows you to
select payment application options. If you are not allowed to select options, the configured pay-
ment option (Do not apply payments, Apply payment to current order only, or Apply payment to all
line items) will be used automatically.

To manually apply a payment

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. Click the Finish and pay button.

The Payment Information page is displayed.

4. From the Payment distribution drop-down list select Do not apply payments, and then

click the Purchase buttonx .

5. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.
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6. When the End of Sale - Confirmation form is displayed, click the Apply payments
button.

The Payment Application page is displayed.

7. In the Transaction date field, enter the date or select one using the calendar, and then
select the sale code from the Sale code drop-down list. The selected date and sale code will
be applied to all your payment entries.

8. To apply payments to an order line, do the following:

a. In the Items table, select the order line to which you want to apply a payment.
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b. In the Payment Details table, click the plus button. A payment type row is added to the
table.

c. From the payment type drop-down list, select the payment type that you want to use to
apply a payment.

d. In the Apply amount column, enter the dollar amount that you want to apply.

e. To add more payment type rows, click the plus buttonx to add one below the current

row. You can remove a payment type row by selecting it and clicking the trash buttonx
. If you want to delete all the amounts entered in the Apply amount column, click the

Reset apply amount buttonx .

9. To apply payments to an order charge, do the following:

a. In the Order Charges table, select the order charge to which you want to apply a pay-
ment.

b. In the Payment Details table, click the plus button. A payment type row is added to the
table.
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c. From the payment type drop-down list, select the payment type that you want to use to
apply a payment.

d. In the Apply amount column, enter the dollar amount that you want to apply.

e. To add more payment type rows, click the plus buttonx to add one below the current

row. You can remove a payment type row by selecting it and clicking the trash buttonx
. If you want to delete all the amounts entered in the Apply amount column, click the

Reset apply amount buttonx .

10. Click the Apply payments button.

11. When the Attention dialog box displays, click the Yes button. The Order Management tab is
redisplayed empty.

To manually apply a payment to the current order

1. Click the Order Management tab.
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2. Select the patron, and then select the season.

3. Click the Finish and pay button.

The Payment Information page is displayed.

4. From the Payment distribution drop-down list select Apply payment to current order

only, and then click the Purchase buttonx .

5. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.
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6. When the End of Sale - Confirmation form is displayed, click the Next order buttonx

. The Order Management tab is redisplayed empty.

To manually apply a payment to all the order line items

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Finish and pay button.

The Payment Information page is displayed.

4. From the Payment distribution drop-down list select Apply payment to all line items,

and then click the Purchase buttonx .

Pac7 Release 7.2



User Guide  533

5. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.

6. When the End of Sale - Confirmation form is displayed, click the Next order buttonx

. The Order Management tab is redisplayed empty.

Sending Confirmation Email in Order Management
Depending on your Paciolan configuration, the system may allow you to send order confirmation
email messages to patrons or house customers when you finish and pay (finish and pay is used to
process changes to a patron's order that have payment implications, require entry of a magstripe
credit card number, or require entry of a print at home email address) an order. If the email
address to which you want to send a message is incorrect or not entered in the patron record, your
control configuration may also allow you to change or add it during the finish and pay process for
an order. In this case, the changed or added address will be added to the patron record. You can
also use an unsaved, one time only address for a patron or house customer.

The system may allow you to resend the order confirmation email message later, although you
must still send the message through the finish and pay process. You can resend order confirmation
messages multiple times. However, records are not kept for the delivery of sent or resent con-
firmation email messages.

To send or resend a confirmation email message

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

Pac7 Release 7.2



User Guide  534

2. In the Payment Options group, use the Confirmation Email options to do one of the fol-
lowing:

l If you want to send the confirmation email message to one of the email addresses in the
patron record, select the address from the Select email address drop-down list. This
option is not available when using a house customer.

If the email address you want to use is not entered or incorrect, add or edit it by doing the
following:

i. Click the Edit link.
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ii. When the Edit Phone/Email form displays, add or change the email address, and

then click the Save buttonx .

l If you want to send the email message to a one time only email address or to a house cus-
tomer, enter the email address in the Enter email address for this order text box.
This address will not be saved to a patron record.

3. To send the email message, click the Purchase button.
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4. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.

The End of Sale - Confirmation form is displayed. The confirmation email message is sent
to the patron.

5. Click the Next order buttonx .

Using Billing Plans in Order Management
Billing plans allow your patrons to pay for their orders in installments, instead of all at once when
they place the orders. When working on the Order Management tab, you can assign billing plans to
order lines and order charges, and then view or edit the plans at the order level or when entering
payment information.

Note: To assign a billing plan to an order line, the order form assigned to your selling control must
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include a billing plan column for the Order Lines table. See your box office manager for more
information.

You can assign a default payment type to all the installments of a billing plan or different payment
types to individual installments. If a billing plan is configured to be changeable, you can change
individual installment amounts. When you change the amount of individual installments, you can
immediately recalculate the distribution of the amount due across all installments in the plan.
However, an individual installment cannot be changed after it has been billed (invoiced), so it will
not be included in the recalculation.

To select a billing plan for a single order charge

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Add Order Charge group, select a billing plan from the Select a bill plan drop-down
list.

To select billing plans for orders with multiple order charges

1. Click the Order Management tab.

2. Select the patron, and then select the season.

Pac7 Release 7.2



User Guide  538

3. In the Add Order Charge group, click the Prior order charges link.

The Prior Order Charges form is displayed.

4. In the Billing plan column, select billing plans for order charge rows from the drop-down
lists.

5. Click the Continue buttonx .

To select a billing plan for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. If you haven't yet added the order items for which you want to select a billing plan, add the
order lines.

4. In each order line for which you want to select a billing plan, select the billing plan from the
Bill plan column. If the Bill plan column is not displayed, your selling control is not con-
figured with an order form that includes the column. See your box office manager for more
information.
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To edit a billing plan from the order level

1. Click the Order Management tab.

2. Select the patron, and then select the season.

To edit a billing plan, it must be assigned to one or more of the patron's order lines for the
season. The same billing plan may be assigned to multiple order lines, and individual order
lines may have different billing plans.

3. Click the Order actions button, and then select Bill plans from the drop-down list. If the

Bill plan buttonx is also in the toolbar, you can click the button instead of selecting the
command from the drop-down list.
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The Billing Plans form is displayed. The patron name and number (in parentheses) are in the
Patron field, and the season name is in the Season field.

4. To change the displayed billing plan, select one from the drop-down list. Only billing plans
that have been selected in an order line or an order charge are available. If you have made
changes to the currently displayed billing plan, you will be prompted to save the changes
when you switch to another plan.

5. If you want to add or change the default payment type for all the installments, do one of the
following:

Note: If you enter a payment type here, it will be used for any installments that do not have
a payment type specified in the Installments table below. If you don't enter a payment type
here or in the Installments table, payment type information can be added later.

l To select a new payment type, select the payment type from the Default payment type
drop-down list. Depending on the payment type, you may also need to enter additional
information, such as credit card number and expiration date.
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l If the patron has previously used one or more credit cards and you want to use one of
them, do the following:

i. Click the Use previous credit card link. This link is only displayed if the patron has
previously used a credit card for an order.

The Use Previous Credit Card form is displayed.

ii. Select the row of the card you want use, and then click the Continue buttonx

. The credit card information is loaded into the default payment type
fields.

l If a default payment type is selected and you do not want to use one for the billing plan,
select the blank menu option.

6. If you want to use a different payment type for an individual installment, do the following:

Note: This individual installment payment type setting will override the default payment
type, if you entered one above.

a. Select the row of the installment to which you want to assign a payment type by clicking
anywhere in the row.

b. Click the row in the Payment type column to display the drop-down list, and then select
the payment type.
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c. Depending on the payment type, you may also need to enter patron specific information in
the Number, Month, and Year columns. For example, a credit card may require the
credit card number, the expiration month, and the expiration year. See an example.

7. If the billing plan is configured to be changeable, you can also do one or more of the fol-
lowing:

Action Instructions

Add an install-
ment after the
last scheduled
installment.

Click the down arrow next to the plus button, and then select Add an
installment from the drop-down list.

A new installment row is added after the last scheduled installment.

Insert an
installment
between two
scheduled
installments.

Select the row above which you want to insert the new installment, click the
down arrow next to the plus button, and then select Insert an installment
from the drop-down list.
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Action Instructions

A new installment row is added above the selected installment.

Delete an
installment
row.

Select the row of the installment that you want to delete, and then click the
trash button.

Recalculate
installment
amounts after
changing the
installment
total.

Click the Recalculate button.

This recalculation is necessary if the sum of the installment amounts is not
equal to the total amount allotted to the billing plan (amount due). The total
allotted to the billing plan is the sum of the item and order charge balances
of all of the order lines that have been assigned the billing plan.
These totals will not match if you change the installment total by adding an
installment row with an amount, deleting an installment row that had an
amount, or changing the amount in an existing installment row.
The recalculation is done using the tRes recalculate algorithm (percentages
are recalculated for each installment based on the updated Amount values,
and then each amount is recalculated based on the updated percentages). If
invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.
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8. If the Installment total amount is not the same as the Total on plan amount, make them

equal by clicking the Recalculate buttonx . The recalculation is done using the
tRes recalculate algorithm (percentages are recalculated for each installment based on the
updated Amount values, and then each amount is recalculated based on the updated per-
centages). If invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.

9. To save changes and return to the Order Management tab, click the Continue button.

To view or edit a billing plan when finishing or paying an order

1. Click the Order Management tab.

2. Select the patron, and then select the season.

To edit a billing plan, it must be assigned to one or more of the patron's order lines for the
season. The same billing plan may be assigned to multiple order lines, and individual order
lines may have different billing plans.
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3. Click the Finish and pay buttonx . If an Attention dialog box prompts you
to go the billing plans page for the patron, click the No button. Or, you can click the Yes but-
ton to view or change billing plans without finishing and paying the order.

The Payment Information page is displayed.

4. In the Payment Methods group, click the Billing Plan button.

The Billing Plans form is displayed. The patron name and number (in parentheses) are in the
Patron field, and the season name is in the Season field.

Pac7 Release 7.2



User Guide  546

5. To change the displayed billing plan, select one from the drop-down list. Only billing plans
that have been selected in an order line or an order charge are available. If you have made
changes to the currently displayed billing plan, you will be prompted to save the changes
when you switch to another plan.

6. If you want to add or change the default payment type for all the installments, do one of the
following:

Note: If you enter a payment type here, it will be used for any installments that do not have
a payment type specified in the Installments table below. If you don't enter a payment type
here or in the Installments table, payment type information can be added later.

l To select a new payment type, select the payment type from the Default payment type
drop-down list. Depending on the payment type, you may also need to enter additional
information, such as credit card number and expiration date.

l If the patron has previously used one or more credit cards and you want to use one of
them, do the following:

i. Click the Use previous credit card link. This link is only displayed if the patron has
previously used a credit card for an order.
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The Use Previous Credit Card form is displayed.

ii. Select the row of the card you want use, and then click the Continue buttonx

. The credit card information is loaded into the default payment type
fields.

l If a default payment type is selected and you do not want to use one for the billing plan,
select the blank menu option.

7. If you want to use a different payment type for an individual installment, do the following:

Note: This individual installment payment type setting will override the default payment
type, if you entered one above.

a. Select the row of the installment to which you want to assign a payment type by clicking
anywhere in the row.

b. Click the row in the Payment type column to display the drop-down list, and then select
the payment type.

c. Depending on the payment type, you may also need to enter patron specific information in
the Number, Month, and Year columns. For example, a credit card may require the
credit card number, the expiration month, and the expiration year. See an example.
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8. If the billing plan is configured to be changeable, you can also do one or more of the fol-
lowing:

Action Instructions

Add an install-
ment after the
last scheduled
installment.

Click the down arrow next to the plus button, and then select Add an
installment from the drop-down list.

A new installment row is added after the last scheduled installment.

Insert an
installment
between two
scheduled
installments.

Select the row above which you want to insert the new installment, click the
down arrow next to the plus button, and then select Insert an installment
from the drop-down list.

A new installment row is added above the selected installment.
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Action Instructions

Delete an
installment
row.

Select the row of the installment that you want to delete, and then click the
trash button.

Recalculate
installment
amounts after
changing the
installment
total.

Click the Recalculate button.

This recalculation is necessary if the sum of the installment amounts is not
equal to the total amount allotted to the billing plan (amount due). The total
allotted to the billing plan is the sum of the item and order charge balances
of all of the order lines that have been assigned the billing plan.
These totals will not match if you change the installment total by adding an
installment row with an amount, deleting an installment row that had an
amount, or changing the amount in an existing installment row.
The recalculation is done using the tRes recalculate algorithm (percentages
are recalculated for each installment based on the updated Amount values,
and then each amount is recalculated based on the updated percentages). If
invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.

9. If the Installment total amount is not the same as the Total on plan amount, make them

equal by clicking the Recalculate buttonx . The recalculation is done using the
tRes recalculate algorithm (percentages are recalculated for each installment based on the
updated Amount values, and then each amount is recalculated based on the updated per-
centages). If invoices have been generated for any of the amounts, those amounts are
excluded from the recalculation.
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10. To save changes and return to the Order Management tab, click the Continue button.

Using Previous Credit Cards in Order Management
To save time during order entry, you can select a patron's previously used credit card, instead of
entering a new one or the same one again. (You may not have access to this feature, depending on
your selling control configuration.) If the selected patron has used more than one credit card
before, you can select any one of the previously used credit cards. To protect the customer's credit
card information, the system only displays the last four digits of the card number (for example,
XXXXXXXXXXXX9215).

To add a payment method row with a previously used credit card

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Finish and pay button.
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The Payment Information page is displayed.

4. In the Payment Methods table, click the plus button.

A payment method row is added to the table.

5. In the Payment type drop-down list, select a credit card type paymode. All previously used
credit cards will be available, regardless of which credit card type (Visa, MasterCard, AMEX,
etc.) you choose.

6. Click the Use previous CC button.

The Use Previous Credit Card form is displayed.
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7. Select the row of the credit card you want to use, and then click the Continue buttonx

. The credit card information is added to the payment method row.

8. Enter the amount in the Amount column and the CVV number in the Pin/CVV column, and
then click the Purchase button. The End of Sale - Confirmation form is displayed.

Using Gift Cards in Order Management
When adding a gift card payment method during payment collection, you can manually enter the
card information or swipe the card to enter it automatically. You manually enter gift cards like
other payment types when adding payment methods, or you can swipe the gift card when you have
the physical card available.

For either the manual or swipe method of entry, the gift card number and PIN are checked when
they are entered into a payment method row. If the numbers are invalid or mismatched when swip-
ing a card, you can attempt validation again by re-swiping the card. Once a gift card is validated,
you can choose to redeem all or part of the card value. You can also reverse the amount entered
for a redeemed gift card.

To re-swipe a gift card

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.
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2. In the Payment Methods table, select the gift card payment type row, and then click the
Reswipe button.

3. Swipe the physical card. The gift card number is automatically added to the Number field.

To redeem the whole value of a gift card

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

2. In the Payment Methods table, select the gift card payment type row, and then click the
Redeem button.
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To reverse the redeemed value of a gift card

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

2. In the Payment Methods table, select the gift card payment type row, and then click the
Reverse button.

Printing Mailers & Receipts in Order Management
Depending on the configuration of your selling control, you may be able to choose when to print
mailers and receipts for orders. Your ticket manager configures this option, as well as what is prin-
ted and when for the mailers and receipts. The configuration includes the types of printouts, as well
as how many copies of each type are printed. The configuration also includes the printer to which
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the items are sent. For example, the system may be configured to print two copies of each credit
card receipt to a laser printer. The system configuration also determines your options for printing
to multiple payment types (paymodes), if you've added more than one to the order.

Note: If the Payment distribution drop-down list is displayed, see Applying Payments in Order
Management for information about choosing an option.

To select mailer and receipt print options for an order

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

2. In the Payment Options group, select one of the Receipt print options.
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See descriptions of the receipt print options.

Option Description

Print
receipt
per
receipt
group
rules

This option will only display if a receipt group is configured in your selling con-
trol. If a receipt group is configured, select this option to only print receipts for
the payment types in the Payment Methods table that are in the configured
receipt group.

Print
receipts
for all pay-
modes

Select this option to print receipts for all payment types in the Payment Meth-
ods table.

Do not
print
receipts

Select this option to not print receipts for any of the payment types.

1. Select or clear the Print mailer option checkbox.
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2. Click the Purchase buttonx .

Using Delivery Methods in Order Management
Delivery methods (also called dispositions) represent the ways in which ticket ownership is trans-
ferred to patrons. The types of delivery methods include magstripe credit cards, magstripe student
IDs, print at home, mobile devices, and traditional. Traditional methods are those that physically
transfer tickets to patrons, for example, box office, will call, mail, or FedEx. Only the traditional
methods are available for house customers.

Within each patron's seasonal order, you assign delivery methods at the order line level. If you are
printing tickets, you do not need to assign a delivery method to finish and pay an order. You must
assign a delivery method to an order line if you want to transfer tickets to magstripe student IDs
and credit cards, deliver tickets to a mobile device, or to allow patrons to print tickets at home. To
assign a magstripe ID delivery method to an order line, the patron record must already include a
magstripe ID number.

To use a magstripe ID delivery method for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Disposition field of the order line row, select a magstripe ID delivery method from
the drop-down list. If you need to add the order line first, see Adding Order Lines in Order
Management.

4. Finish the order.

To use a magstripe credit card delivery method for an order line
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1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Disposition field of the order line row, select a magstripe credit card delivery
method from the drop-down list. If you need to add the order line first, see Adding Order
Lines in Order Management.

4. Click the Finish and pay buttonx . The Payment Information page is dis-
played.

5. In the Delivery area of the Payment Options group, click in the Magstripe CC number
text box.
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6. Do one of the following:

l Swipe the credit card. If the system does not read the card, click the Reswipe buttonx

, and then swipe the credit card again.
l Enter the credit card number.

7. Click the Purchase buttonx .

To use the print at home delivery method for an order line

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. In the Disposition field of the order line row, select a print at home delivery method from
the drop-down list. If you need to add the order line first, see Adding Order Lines in Order
Management.
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4. Click the Finish and pay buttonx . The Payment Information page is dis-
played.

5. In the Delivery area of the Payment Options group, verify that the Print at Home email
address is correct. If it is not correct click the Edit link to display the Edit Phone/Email
form, and then correct and save the address.

6. From the Phone drop-down list, select the contact number for the patron. If a phone number
needs to be added or corrected, click the Edit link to display the Edit Phone/Email form,
and then add or correct and save the phone number.

7. Click the Purchase buttonx .
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Re-Swiping Credit Cards in Order Management
If authorization fails when you first swipe a credit card during order management, you can swipe
the card again to check its validity. If the card is not authorized after re-swiping, you will need to
manually enter the card information. Credit card information that is read during card swiping
includes the holder's name, the card number, the expiration date and year, and the CVV number.

To re-swipe a credit card

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

1. In the Payment Methods table, select the payment method row with the credit card that
needs to be re-swiped, and the click the Reswipe button.

The Name, Number, Month, and Year fields are cleared.

2. Re-swipe the physical credit card. Values for the Name, Number, Month, Year, and Pin/CVV
fields are automatically entered in the payment method row. If the system still does not val-
idate the card, you can manually enter the information in the fields.
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Reissuing Gift Certificates in Order Management
Normally if a patron uses a gift certificate to pay for an order, the full amount of the gift certificate
is automatically applied to the order. However, if the order amount is less than the gift certificate
amount, you can reissue the gift certificate with the unredeemed balance or apply the balance to
the patron's account. This applies only to Paciolan, not 3rd party, generated gift certificates.

To reissue a gift certificate with an unredeemed amount

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

2. Add a gift certificate payment type row to the Payment Methods table. For more inform-
ation, see Adding Payment Methods in Order Management.

3. In the Number field, enter the gift certificate number, and then press the Tab key.

The Gift Certificate Reissue form is displayed. The amount to be reissued or applied to the
patron account is in the Balance field.
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4. Select the Reissue full balance option.
5. From the Season drop-down list, select the season with the order to which you want to issue
the gift certificate.

6. From the Reissue as drop-down list, select the gift certificate payment type of the gift cer-
tificate that you are issuing. All the gift certificate payment types for the selected season are
available.

7. If the Doc # field is editable, enter a number for the gift certificate you are issuing. If the
field is not editable, the gift certificate payment type is configured to automatically assign
numbers to new gift certificates, so you do not need to enter a number.

8. If you want to print the reissued gift certificate, select the Print option. The gift certificate
will print on your configured Boca or laser printer.

9. Click the Continue buttonx . The Payment Information page redisplays with the
Due after payment field set to $0.00.
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10. Click the Purchase buttonx .

11. If the Sale Code form is displayed, select the sale code, and then click the Continue

buttonx .

12. When the End of Sale - Confirmation form is displayed, click the Next order button. The
Order Management page is redisplayed empty.

To apply the unredeemed amount from a gift certificate to a patron order

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

2. Add a gift certificate payment type row to the Payment Methods table. For more inform-
ation, see Adding Payment Methods in Order Management.
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3. In the Number field, enter the gift certificate number, and then press the Tab key.

The Gift Certificate Reissue form is displayed. The amount to be reissued or applied to the
patron account is in the Balance field.

4. Select the Apply balance to account option, and then click the Continue buttonx

. The Payment Information page redisplays with the balance transferred to the
patron's account.
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5. Click the Purchase buttonx .

6. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.

7. When the End of Sale - Confirmation form is displayed, click the Next order button. The
Order Management page is redisplayed empty.

Issuing Refunds in Order Management
In order management, you can issue refunds by making negative payments for patron orders. You
may need to refund payments to patrons because their orders have been overpaid by canceled
order lines or when using payment methods.

Depending on your selling control configuration, refunding overpayments will be optional or
required when you submit orders. If refunding is optional, you will be allowed to submit overpaid
orders without issuing refunds. Your configuration may also require you to enter a password to
issue a refund. Regardless of your configuration, you cannot refund discounts or issue refunds to
gift cards.

Note: If your configuration requires you to issue refunds for overpayments, the following pro-
cedure is not necessary unless you want to refund an amount to a payment type other than the
default. For example, if the default payment type is cash, but you want to refund to a credit card,
you can add a credit card payment method row and add the negative amount in that row.

To issue a refund
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1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.

2. If you want to issue a refund for a payment type other than the default, add the payment
method row.

3. In the Amount field, enter the negative of the amount you're refunding. For example, if you
want to refund $100, enter -100. If you want to refund the whole overpayment amount, use
the Balance due amount. If the negative amount is already entered in the correct payment
method row, you don't need to do anything.

4. Click the Purchase buttonx .

5. If the Password Required form displays, enter the password, and then click the Continue

buttonx .

6. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.
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7. When the End of Sale - Confirmation form displays, click the Next order buttonx

.

Submitting Payments in Order Management
To save and apply payments during order management, you enter and submit information on the
Payment Information page. The submission process validates the payment information before sav-
ing it for the order. If you have chosen to distribute payments, print receipts, print mailers, send a
confirmation email message, or send print at home tickets, those actions will be performed auto-
matically once you submit the payment information and all fields have been validated.

To submit payments

1. On the Order Management tab, click the Finish and pay buttonx . The Pay-
ment Information page is displayed.
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2. Enter payment information as required.

3. Click the Purchase buttonx .

4. If the Sale Code form is displayed, select the sale code, and then click the Continue buttonx

.

5. When the End of Sale - Confirmation form displays, click the Next order buttonx

.

The Order Management page is displayed empty.

Reprinting Prior Receipts in Order Management
Payment receipts may be reprinted by payment type after items are paid for and processed during
order management. When you reprint receipts for payment types, they include payments for all of
a patron's processed orders from a season. You can reprint receipts for multiple payment types at
the same time.
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To reprint a payment receipt for a patron, you must have processed one or more order lines in the
season for the patron. An order line is considered processed after seats are assigned and one or
more payment types are used to purchase them. Reprinting can only be done for one patron in a
single season at a time.

You can reprint receipts for any of the system defined payment types (paymodes), including cash,
checks, gift certificates, gift cards, credit cards, and other defined types. Since all system payment
types are available, the payment types that can be reprinted may include ones that have not been
configured in the current selling control.

By default one copy will be reprinted for each payment type. However, the number of copies for a
payment type will be different if a receipt group is used for the selling control, the payment type is
in the receipt group, and the number of copies set for the payment type is greater than one.

You can reprint payment receipts from the order level options on the Order Management tab. You
can also reprint them from the end of sale confirmation when finishing an order with or without pro-
cessing payments.

To reprint a receipt from the order level options on the Order Management tab

1. Click the Order Management tab.

2. Select the patron, and then select the season.

The order level options are displayed in the order management toolbar.

3. Click the Order actions button, and then select Reprint prior receipts from the drop-

down list. If the Reprint prior receipts buttonx is also in the toolbar, you can click the
button instead of selecting the command from the drop-down list.

The Reprint Prior Receipts form is displayed.
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4. Select the rows containing the payment types for which you want to reprint receipts. You can
select all the payment types at once by selecting the heading row. In the example below,
receipts will print for purchases made with cash and a Visa credit card.

5. Click the Print button. Receipts are printed for purchases made with the selected payment
types.

To reprint a receipt at the end of a sale when processing payments

1. Click the Order Management tab.

2. Select the patron, and then select the season.

Note: The patron must have previously processed orders before the reprint receipts option is
available through this procedure.

3. Click the Finish and pay buttonx . If the Sale Code form is displayed,

select the sale code, and then click the Continue buttonx .
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The Payment Information page is displayed.

4. In the Payment Methods table, enter any required information for the payment type rows.
You can also add more payment types.

5. Click the Purchase buttonx . The End of Sale - Confirmation form is dis-
played.

6. Click the Reprint prior receipts link.

The Reprint Prior Receipts form is displayed.
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7. Select the rows containing the payment types for which you want to reprint receipts. You can
select all the payment types at once by selecting the heading row. In the example below,
receipts will print for purchases made with cash and a Visa credit card.

8. Click the Print button. Receipts are printed for purchases made with the selected payment
types.

To reprint a receipt at the end of a sale when no payment processing is needed

1. Click the Order Management tab.

2. Select the patron, and then select the season.

Note: The patron must have previously processed orders before the reprint receipts option is
available through this procedure.

3. Click the Finish button.

Note: If the order has changes with a fiscal impact, the Payment Information page will display
and you will need to process payments before you can reprint the receipt.

4. If the Sale Code form is displayed, select the sale code, and then click the Continue

buttonx .
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5. When the End of Sale - Confirmation form is displayed, click the Reprint prior receipts
link.

The Reprint Prior Receipts form is displayed.

6. Select the rows containing the payment types for which you want to reprint receipts. You can
select all the payment types at once by selecting the heading row. In the example below,
receipts will print for purchases made with cash and a Visa credit card.

7. Click the Print button. Receipts are printed for purchases made with the selected payment
types.
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Finishing Orders in Order Management
After making changes to a patron's order, you can save the changes by finishing the order.
However, you must first enter all required fields for each order line, including required fields both
in the Order Lines table and on the Order Line Additional pane. Required fields on the Order Line
Additional pane must be completed even if the pane is hidden. Finishing the order still allows you to
make changes later on.

You may choose to enter or change payment information as part of the process of finishing orders
during order management. In fact, if you make fiscal changes to an order, you will be required to
enter payment information before finishing the order. Changes that require you to enter payment
information include the following:

l Changing the order amount.
l Adding one or more order lines.
l Selecting order line dispositions that require a credit card number or PAH email address.
l Carrying a negative balance.
l Having left pending payment information.

If your selling control is configured with more than one sale code, you will be required to select one
when you finish the order. Once valid payment information is entered and the sale code selection is
made, the order is placed, any required printing is begun, order information is recorded in the cur-
rent batch, and end of sale options become available. End of sale options include reprinting the
order or receipts, manually applying payments, and navigating back to the main order man-
agement page.

To finish an order on the Order Management tab

1. Create or make changes to an order on the Order Management tab.

2. Click the Finish button.

3. Do one of the following:
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l If the End of Sale - Confirmation form is displayed, click the Next order buttonx

. The Order Management tab is redisplayed empty.

l If the Sale Code form is displayed, select the sale code, and then click the Continue but-

tonx . When the End of Sale - Confirmation form is displayed, click the

Next order buttonx . The Order Management tab is redisplayed empty.

l If the Payment Information page is displayed, enter payment information, and then click

the Purchase buttonx . If the Sale Code form is displayed, select the sale

code, and then click the Continue buttonx . When the End of Sale - Con-

firmation form is displayed, click the Next order buttonx . The Order Man-
agement tab is redisplayed empty.

If the Payment Application page is displayed, click the Apply payments buttonx

.
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Canceling Order Changes in Order Management
Note: This topic describes canceling changes at the page level in order management. This process
is not the same as canceling order lines, which reduces the quantity of items at the order line level.

At any time during order management, you can discard (cancel) the changes you've made since
you last finished the order. On the main Order Management page and the Patron Information page,
this includes order management changes (for example, changes to order lines, billing plans, or
order charges), as well as payment detail changes (for example, added payment methods or print
and processing option selections). On the Payment Application page, the discarded changes are any
item level payment details you have added. However, changes to patron records, including both
editing existing patron information and adding new patrons, are not discarded.

To cancel changes on the main page of the Order Management tab

1. On the Order Management page, click the Cancel changes button.

2. When the Attention! dialog box is displayed, click the Yes buttonx .

Note: This dialog will not display if you have not modified the order or have only modified
the patron record.

The changes are discarded and the Order Management page is displayed empty.

To cancel changes on the Payment Information page of the Order Management tab

1. On the Payment Information page, click the Cancel order button.
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2. When the Attention! dialog box is displayed, click the Yes buttonx .

Note: This dialog will not display if you have not modified the order or have only modified
the patron record.

The changes are discarded and the Order Management page is displayed empty.

To cancel changes on the Payment Application page of the Order Management tab

1. On the Payment Application page, click the Cancel button.

2. When the Attention! dialog box is displayed, click the Yes buttonx .
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Note: This dialog will not display if you have not modified the order or have only modified
the patron record.

The changes are discarded and the Order Management page is displayed empty.
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Chapter 4 Item Sales

Note: Depending on the type and configuration of the control you use to access the Item Sales tab,
your access to selling and patron functionality will differ. If you are using a patron management
control, you will have access to patron functionality but not to selling. If you are using a selling con-
trol, you will have access to selling functionality, and you may have access to all or none of the pat-
ron functionality. See your ticket manager for more information.

Selling is the process by which you sell items from your inventory to your customers. Item sales
are a method of selling that guide you through the sales process using predefined sales paths.
Depending on the configuration of your selling control, you can use some combination of the
onsale, general sales, or promotion sales paths to sell inventory.

For item sales, use one of the following procedures:

l Completing an Onsale Transaction
l Completing a General Sales Transaction
l Selling Promotion Items

Onsale
The onsale path streamlines the selling process for high demand events. This process is typically
used during a heavy onsale or on the night of an event at the ticket windows. It is intended for situ-
ations where the same event is being sold continuously.

Due to the high volume, selling tickets to an onsale event requires different steps than selling tick-
ets to a non-onsale event. The onsale path contains a short list of events so that users can quickly
find the events they need to sell. Users also assign seats in the same step. Onsale is limited to
single event and miscellaneous items only, since they are the most frequently sold items when the
event first goes onsale or on the night of the event. If an item that a customer wants to buy is not
in the onsale list, the item is probably listed in a general sales group.

Events are classified as onsale events by the data account owner. Generally, onsale events are
high-demand events that have recently gone on sale. The amount of time for which an event is con-
sidered an onsale event is set by the data account owner.

General Sales
Use the general sales path to sell all non-onsale allocatable items and all non-allocatable item
types. Allocatable item types include single event items and combo items. Non-allocatable types
include miscellaneous items, gift certificate items, access pass items, donation items, parking
passes, vouchers, and credits. The general sales path allows you to use all of your configured fea-
tures, including the following:

l Sell all item types.
l Prorate events out of combo items.
l Search for items.
l Assign additional information to an order line.
l Access full or quick patron data.
l Place an order.

If an item that a customer wants to buy is not in a general sales group, the item is likely in the
Onsale list.

Promotion Sales
Use the promotion sales path if the data account includes promotions and a customer gives you a
promotion code or password. Promotions can include single, combination, or miscellaneous items.
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Items available in promotions may also be available through the onsale or general sales paths, but
the promotion discount is only applicable to items sold through the promotion sales path.

Navigating the Item Sales Tab
There are several elements on the Item Sales tab pages to aid you in navigating in the application.
The table below describes the basic elements of an Item Sales tab page. For descriptions of the
navigational elements that apply throughout the Paciolan application, see Navigating in Paciolan.

Note: Do not use your browser's back button when navigating in the application. Clicking the Back
button can cause data to be lost. Navigate using the buttons and links on each page. In particular,

the Previous buttonx will take you back one step in the process, similar to the
browser back button.

Element Description

Alert Mes-
sages

Messages from the inventory owner about the inventory.

Page
name

The name of the page on which you are working.

Sales
path links

Give access to groups of tasks in item sales, including onsales, general sales,
and promotional sales.

Task path Shows your current location in the overall sales path. The current page is blue in
color, and the other pages in the task path are grey. To know exactly where you
are in the path, note the current page name.

Current
patron

The patron that you are currently editing or selling to.

Batch The batch number. Batch information is useful for reconciling sales and reports.

Order
total

The total price of the items in the shopping cart.
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Back-
ward nav-
igation
buttons

All Paciolan pages have their own navigation buttons that return you to the pre-
vious step in the task path. For example, on the Select Seats on Seat Map page
during onsale selling, a Select Onsale Items and Seats button is included to move
you back to the first page in the onsale path.

I'd Like
To links

Links for navigation between the pages used to complete the current step in the
selling process.

In addition to the page elements described above, some elements of the Paciolan interface are
color-coded to help you identify the function and importance of the element.

Color Section

Green Green is used for Selling buttons that move an order toward
completion (Checkout, Continue with Purchase, and Place
Order) or start a new order (Next Sale). Green is also used
for the Save Record and Hold Updates buttons on the Patron
pages.

Red Red type is used for alert messages, and red coloring is used
for deletion controls (for example, a trash can or an X
graphic) and the Cancel button. Red is used for a severe
error, such as a credit card not being authorized, or a sys-
tem error message.

Blue Various shades of blue background and text are used to sep-
arate functional groups of the Paciolan interface. Blue under-
lined text is a link to another page.
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Completing an Onsale Transaction
The onsale path is the quickest way to sell high demand events. The onsale path contains a short
list of events (maximum of 10 items) so that you can quickly find the events you need to sell. The
path also allows you to assign seats in the same step. Onsale is limited to single event and mis-
cellaneous items only, since they are the most frequently sold items when the event first goes
onsale or on the night of the event. If an item that a customer wants to buy is not in the onsale list,
the item is probably listed in a general sales group. See Completing a General Sales Transaction.

Note: The onsale path will be different depending on the type of customer you sell to: house cus-
tomers, individual customers, or both house and individual customers.

To complete an onsale transaction

1. On the Item Sales tab, click the Onsale link. The Select Onsale Items and Seats page of the
Onsale path is displayed.

2. If the onsale item you are selling is not the current item detailed in the Table View, in the
Onsale Items group click the item that you want to sell.

The current onsale item is replaced with the item you selected.
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Here is an example.

Tip: If you need to update the displayed onsale items on the Select Onsale Items and Seats

page, click the Refresh Onsale Items buttonx .

3. In the Table View, enter quantities for the price types, and then select the price level for
each price type that has a quantity. If the event has only one price level, no selection is
necessary.
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4. To select seats for the order, do one of the following:

l Click the Find Seats buttonx . The best seats available are found, according
to the options set in the back office (tRes), and the Review Items in the Cart page is dis-
played. However, if you are adding an item that includes autoload miscellaneous items,
you may be prompted to select the items and quantities to be autoloaded before the cart
page is displayed (see the onsale procedure in Adding Items for more information).

l Click the View Seat Map link or iconx and then, after the Seat Map page
is displayed, select the seats for the order. For information about selecting seats using the
Seat Map, see Using the Seat Map.
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Once you have selected seats,the Review Items in the Cart page is displayed. However, if
you are adding an item that includes autoload miscellaneous items, you may be prompted
to select the items and quantities to be autoloaded before the cart page is displayed (see
the onsale procedure in Adding Items for more information).

5. On the Review Items in the Cart page, verify that the order information is correct. If neces-
sary, modify the fees, delivery method, or charges. For more information, see Modifying
Items and Using Order Charges. If you make changes on the page, click the Update button to
display the updated order information.

Tip: To display the order total breakdown in a popup window, click the Order Total Break-
down link in the Charge Summary group.
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6. Click the Checkout buttonx . The Search for Patron page is displayed.

7. Choose a customer by doing one of the following:

l Search for an existing patron by entering search criteria, and then clicking a Search but-
ton.

l Create a new patron for the order by clicking the Create a New Patron button. If the
Create a New Patron button is not displayed, enter the patron's information (usually Last
Name and First Name), and then click the Search button. If the patron does not already
have a record, the Create a New Patron button will now be displayed.

l Continue with the current house customer by clicking the Skip this Step button. Up until
you have completed the sale, you will be able to change to a new house customer type or
to an individual customer.

8. If you are not already at the Enter Payment Information page, click the Continue with
Purchase button. The page is displayed.
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9. From the Payment Type list in the Payments group, select the payment type. Depending on
the type you select, the required fields in the Payments group are displayed. For more
information, see Setting the Payment Type.

Note: The available payment types and their required fields depend on your Paciolan con-
figuration.

10. Complete the payment type's required fields, and then, from the Options group, select the
Sale Code. For more information, see Selecting an Order Sales Code.

11. Click the Place Order buttonx . The Order Confirmation page is dis-
played.
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Completing a General Sales Transaction
You can sell all item types using the General Sales path, including single event items, combo items,
miscellaneous items, gift certificate items, access pass items, and donation items. This path allows
you to search for and sell all non-onsale item types. If an item you want to sell is not in a General
Sales group, then the item is likely in the Onsale list. See Completing an Onsale Transaction.

To complete a general sale transaction

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.

Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.
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Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. Select an item for this transaction. For information about searching for and selecting items
for a transaction, see Searching for Items. After you select an item, the Find Best Available
Seats page is displayed.

Note: If you select an access pass item, you will be required to select an individual patron
before you select quantities, price levels/types, or any other order information. This is not
configurable by the ticket manager.

Tip: You can also select a set of items for your order using the Search for Multiple Events fea-
ture.

3. On the Find Best Available Seats page, select seats for the order using one of the following:

l Quick Entry
l Best Available (Table View or List View)
l Seat Map

In addition to seat selection, this process includes entering the quantity, price level, price
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type, and delivery method for the order item. When you've completed the process, the
Review Items in the Cart page is displayed (see image below). However, if you are adding an
item that includes autoload items, you may be prompted for order-specific information about
these items before Paciolan displays the cart page (see the general sales procedure in
Adding Items for more information).

4. On the Review Items in the Cart page, verify that the order information is correct. If neces-
sary, change the fees, delivery method, or charges. If you make changes on the page, click
the Update buttonx to update the order information. For more information, see
Using the Shopping Cart.

Tip: To display the order total breakdown in a popup window, click the Order Total Break-
down link in the Charge Summary group.

5. Click the Checkout buttonx . If you have already selected a customer, the
Enter Payment Information page is displayed. If so, go to the payment step below.
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Or, if you have not selected a customer, the Search for Patron page is displayed. Depending
on your Paciolan configuration, you will have the option of searching for an individual cus-
tomer or clicking the Skip this Step button.

Note: You can also choose to create a new patron (customer) for the order. In addition, up
until you have completed the sale, you can change to a new house customer or individual cus-
tomer.

6. Once you select a customer, click the Continue with Purchase buttonx
. The Enter Payment Information page is displayed.

7. From the Payment Type list in the Payment group, select the payment type. Depending on
the type you select, the required fields in the Payment group are displayed. For more inform-
ation, see Setting the Payment Type.

Pac7 Release 7.2



User Guide  593

Note: The available payment types and their required fields depend on your Paciolan con-
figuration.

8. Complete the payment type's required fields.

9. If the Sale Code list is displayed, select the appropriate Sale Code. If your control includes
only one sale code, the code is selected automatically and you will skip this step. For more
information, see Selecting an Order Sales Code.

10. Click the Place Order buttonx . The Order Confirmation page is dis-
played.
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Note: You can cancel the transaction you just made from this page, by clicking the Void this

Order buttonx . This is the only time you can cancel the transaction.
Once you leave this Order Confirmation page or the page times out, you can no longer cancel
this transaction.

Selling Promotion Items
Sales of promotion items are made through the promotion sales path and are limited to customers
that have valid promotion codes or promotion code:password pairs. The ticketing office supplies
these codes and passwords to customers so that they can take advantage of promotional offers.
Promotions can include single event or combination items. If proration is allowed in the general
sales path, you can also prorate promotion combination items. Promotion items may also be avail-
able through the onsale path or general sales path, but only items sold through the promotion sales
path will include promotional discounts.

To sell a promotion item

1. On the Item Sales tab, click the Promo Sales link. The first page of the Promo Sales path is
displayed.
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Note: If the Promo Sales tab is not displayed, the current selling control is not configured for
access to promotions. If you need access, see your ticketing manager.

2. Enter a promotion code or promotion code:password pair, and then click the Enter but-
ton.The Select Promotion Item page is displayed.

Note: Depending on your configuration, the Search for Patron page may be displayed first. If
this page displays, select a customer (patron) before continuing. Depending on your Paciolan
configuration, you will have the option of searching for an individual customer or skipping the
step to continue with the default patron (house customer).

3. Locate the item you want to add to the order, and then, in the Item Information column, click
the linked item name. The Find Best Available Seats page is displayed for the item.

4. In the Table View, enter quantities in the Qty column for the adjacent price types, and then
select the price levels for price types.
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5. Select the Delivery Method, and then click the either the Find Seats buttonx
or Assign Seats Later buttonx . The Review Items in the Cart
page is displayed.

6. On the Review Items in the Cart page, verify that the order information is correct. If neces-
sary, change the fees, delivery method, or charges. If you make changes on the page, click
the Update buttonx to update the order information. For more information, see
Using the Shopping Cart.

Tip: To display the order total breakdown in a popup window, click the Order Total Break-
down link in the Charge Summary group. If the link is not displayed, your selling control is
not configured for the option. See your ticketing manager for information about custom
forms.
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7. Click the Checkout buttonx . If you have already selected a customer, the
Enter Payment Information page is displayed. If so, go to the payment step below.

If you have not selected a customer, the Search for Patron page is displayed. Depending on
your Paciolan configuration, you will have the option of searching for an individual customer
or clicking the Skip this Step button.
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Note: You can also choose to create a new patron (customer) for the order. In addition, up
until you have completed the sale, you can change to a new house customer or individual cus-
tomer.

8. Once you select a customer, click the Continue with Purchase buttonx
. The Enter Payment Information page is redisplayed.

9. From the Payment Type list in the Payment group, select the payment type. Depending on
the type you select, the required fields in the Payment group are displayed. For more inform-
ation, see Setting the Payment Type.

The available payment types and their required fields depend on your Paciolan configuration.

10. Complete the payment type's required fields.

11. If the Sale Code list is displayed, select the appropriate Sale Code. If your control includes
only one sale code, the code is selected automatically and you will skip this step. For more
information, see Selecting an Order Sales Code.

12. Click the Place Order buttonx . The Order Confirmation page is dis-
played.
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Note: If you have the permissions, you may be allowed to cancel the completed transaction

by clicking the Void this Order buttonx on the Order Confirmation
page. This is the only time you can cancel a transaction. Once you leave the transaction's
Order Confirmation page or the page times out, you can no longer cancel this transaction. If
you entered a promotion code:password pair to complete this order, the password usage will
be reset when the order is voided.

Prorating Combination Items in Item Sales
In Paciolan, prorating allows you to sell fixed combination item tickets without including all the
events in a customer's order. This feature is typically used to sell a combo package after one or
more events are over. Prorating fixed combo items is useful because:

l You can sell more season tickets to increase your renewable customer base.
l You can keep items the same from one year to the next, without setting up extra season
items for all the variations of the combo item. (For example, you do not have to set up 81 dif-
ferent fixed combo items for an 81 event baseball item.)

The events of a fixed combo can be prorated out or back in. You cannot prorate a designer combo.
If the item you are prorating out has held or allocated seats, those seats are released or deal-
located as part of proration. You cannot prorate out printed seats, unless you unprint them first.

You can prorate out events that occur in the past or the future. Events can be prorated back in to a
combo item, regardless of whether they were manually or automatically prorated out.

When events are prorated out of a combo item, the price or item balance is adjusted to be the sum
of the remaining events’ prices and facility fees. If the combo price prior to proration was dis-
counted compared to purchasing the events individually, a prorated discount is applied to the sum
of the remaining events’ prices.

Discounts can be set up as a % of the fixed combo price, a flat amount, a per event amount, or a
per item amount. So, when you prorate events out of the combo, the following rules are used:
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l If the discount is setup as a %, the discount amount will be adjusted using the new combo
price.

l If the discount is setup as an amount per event, the discount will be the new number of the
events multiplied by the discount amount.

l If the discount is setup as an amount per item, the discount changes once an item is part of
the order.

To prorate a combination item in item sales

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.

Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.

Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).
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Note: If proration is allowed in your general sales path and you have access to promotion
sales, proration is also allowed in the promotion sales path.

2. Search for and select the fixed combo you want to sell as prorated. (For more information,
see Searching for Items.) The Find Best Available Seats page is displayed.

3. In the I'd Like To links, click the Prorate link.

The Prorate Events page is displayed.

4. Select the events that you want to prorate out of the combo, and then click the Prorate Out
button.The Prorate Events page is displayed with the combo events split into Prorate Out and
Prorate In groups. If you need to change which events are prorated in or out of the combo,
do so by selecting events and clicking either the Prorate In or Prorate Out button.

5. Click the Continue button. The Find Best Available Seats page is displayed, with the prorated
per ticket price levels now in effect.

6. Use one of the following methods to choose item quantities, price levels, price types, and
seat assignments:
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l Assign Seats Later
l Assign Seats Using Best Available
l Assign Seats Using Quick Entry
l Use the Seat Map

Viewing Order Item Details in Item Sales
While the details that display in the Paciolan Review Items in the Cart page will vary by con-
figuration, more information about the items in your order is always available through links on the
page.

Tip: To display the order total breakdown in a popup window, click the Order Total Breakdown link
in the Charge Summary group.

On the Review Items in the Cart page, you can view the following details:

l Item Order
l Item Additional Details
l Multiple Price Level
l Seat Block
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Viewing Item Details in Item Sales
You can view the details of an item at any time during the selling process. The item details are dis-
played in a new window, so you do not lose your place in the order. Item details include inform-
ation such as ticket pricing and availability, item information messages, and effective dates. This a
view-only process.

To view details for an item

1. Go to the Review Items in the Cart page.

2. Click the Details link for the item. This link is always located next to the item name or some-
where in the item display row.

A new window is displayed with all of the item order details.

Viewing Item Additional Details
Although the shopping cart is configurable, space on the page should be preserved for usability. For
this reason, you view and update order line information that is not displayed in the cart on an addi-
tional page. You can also access a read-only version of this additional page when you are entering
payment information and when the order is confirmed.

Note: If the current selling control allows access, the editable version of this page will be access-
ible from the order line of each item on the Review Items in the Cart page. For information about
editing the Item Additional Details page, see Adding Item Additional Details.

To view item additional details for an order line item

1. Go to the Review Items in the Cart page.

2. Click the Item Additional icon for the item.
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The Enter Additional Information page is displayed.

Viewing Multiple Price Level Details
If you have combo items with events at different price levels in your shopping cart, you can view
all of the combo events simultaneously with their details and price levels.

To view multiple price level details for a combo item

1. Go to the Review Items in the Cart page.

2. In the Price Level column of a combo item order line, click the Multiple link.

A new window is displayed with the details, including price level, for each event in the combo
item.
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Viewing Multiple Seatblock Details
A seatblock is an adjacent group of seats in same row that are on hold for an event. Multiple seat-
blocks occur when you hold seats that are not next to each other. If you have an order line in your
shopping cart for a single item with multiple seatblocks, you can view the locations of all of the
seatblocks simultaneously.

To view multiple seatblocks for a single order item

1. Go to the Review Items in the Cart page.

2. In the Seatblock column of a single item order line row, click the more seats link.

The event's seatblocks are displayed on a new page.

Searching for Items
During general sales, you can search all of the available items for the policy (control) from which
you are selling. Search results will include all item types and all items as they have been set up for
an item group. Combo items are included in the search results if at least one of the events in the
combo matches your search criteria and has an event date in the future (Paciolan must also be con-
figured to allow prorating).

Flexible combination (flex combo) items with some event dates in the past will only display the
events with future dates. A flex combo will not display at all if the number of required events
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cannot be selected from the remaining events with future dates. When a flex combo is available,
you will be prompted to choose the individual events in the combo before adding items to the cart.

To search for items, you can use the following methods:

l Search using the text box
l Search by facility
l Search using item groups

You can also display the most recently viewed items.

Searching for Items Using the Text Box
The item search text box uses a search engine like those used on Yahoo and Google, so you can
search using any text string you want. The engine searches all information about every included
item, including the item codes, item keywords, item dates, item names, and facility names.

You can search using more specific text strings to limit your search results. You can also use wild-
cards (? or *) and operands (AND, OR, NOT). The default search uses AND, so you do not need add
AND between the words in your search string. For a complete list of search tips, click the Search
Tips link in the text box search group.

To search for items using the text box

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.
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Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.

Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. In the search text box, enter your search text, and then click the adjacent Search button.
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The search results are displayed on the Search for Item page.

Tip: If you are searching for a multi-day event item, you can enter a date or an element of a
date (for example, the day Monday, the month August, or the year 2008) of any of the event
days. However, you cannot enter a date range when using the search text box.

3. Locate the item you want to add to the order, and then, in the Item Information column, click
the linked item name. The Find Best Available Seats page is displayed for the item.

For information about completing an order, see Completing an Onsale Transaction or Com-
pleting a General Sales Transaction.

Note: If you need more detail about an item before you select it, click the item's Detail link.
A new window with additional item details will be displayed.
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Searching for Items by Facility
The system allows you to search for allocatable items by the facility at which the event is hosted.
To allow the search by facility, all the facilities used by the allocatable items included in the sea-
sons configured for sale are listed in the user's selling control. This search only returns single
events. To search for combos or non-allocatable items, use the search by text box feature.

To search for items by facility

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.

Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.
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Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. From the Facility list, select the facility used by the items for which you are searching, and
then click the adjacent Search button.

The search results are displayed on the Search for Item page.

3. Locate the item you want to add to the order, and then, in the Item Information column, click
the linked item name. The Find Best Available Seats page is displayed for the item.

Pac7 Release 7.2



User Guide  611

For information about completing an order, see Completing an Onsale Transaction or Com-
pleting a General Sales Transaction.

Note: If you need more detail about an item before you select it, click the item's Detail link.
A new window with additional item details will be displayed.

Searching for Items Using Item Groups
The item groups that display on the Item Sales tab have been previously configured in tRes. The
configuration includes how your ticket manager organizes items. Item groups on the tab are sim-
ilar to TK.SELL item groups. On the Item Sales tab, they are displayed on the Search for Item
page.

To search item groups

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.
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Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.

Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. In the Item Groups box, click the link for the item group that contains the item you want to
add to your order.
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The Search for Item page is redisplayed with the items in the group in the Search Results
group. In the Item Groups box, the selected item group is highlighted in yellow in the Item
Groups group.

3. Locate the item you want to add to the order, and then, in the Item Information column, click
the linked item name.The Find Best Available Seats page is displayed for the item.

For information about completing an order, see Completing an Onsale Transaction or Com-
pleting a General Sales Transaction.

Note: If you need more detail about an item before you select it, click the item's Detail link.
A new window with additional item details will be displayed.
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Displaying Recent Items
The items you have recently accessed during general sales item searches are recorded by the sys-
tem. You can access these items at any time during your search for items. The record of items is
only kept during your current Paciolan session— if you sign in and then sign out, the recently
accessed items from the previous session are not listed. However, the list of accessed items will
still be available if you switch data accounts without logging out.

Note: This list also does not include items accessed as part of a multiple event search.

To display recently accessed items

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.

Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.
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Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. In the Search Results group, click the View All Recent Items link. The recently accessed
items are displayed in the Search Results group.

Searching for Seats
You search for seats so that you can assign them for events in an order. You can make seat assign-
ments to hold seats for a customer while the order is completed. Only allocatable items require
seat assignments.

In addition to single items, during general sales you can search for seats for both fixed and flexible
combo items. Fixed combos must have at least one event in the combo that matches your search
criteria and has an event date in the future (item sales must also be configured to allow prorating).
Flexible combo items with some event dates in the past will only display the events with future
dates.

You can search for seats for events using the following methods:
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l Assigning Seats
l Using the Seat Map
l Searching for Multiple Events

Assigning Seats
During the selling process, you will need to assign seats for events from allocatable items with
reserved seating. The system holds assigned seats until you release them or the order times out.
Your ticket manager configures the length of the order timeouts.

To assign seats, do one of the following:

l Assigning Seats Later
l Assigning Seats Using Best Available
l Assigning Seats Using Quick Entry

Assigning Seats Later

Depending on your Paciolan configuration, you may be able to place an order for an item without
having specific seats assigned. The Assign Seats Later feature delays the assignment of seats until
seats are allocated after the sale. The onsale and general sales selling paths are configured sep-
arately, so this feature may be available in one, both, or neither of the paths.

Tip: This feature is often used to sell season tickets before the ticket manager has set up the sea-
son and its events.

To assign seats later

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.

Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.
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Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. Select an item for this transaction. For information about searching for and selecting items
for a transaction, see Searching for Items. After you select an item, the Find Best Avail-
able Seats page is displayed.

Depending on your configuration, the Table View, List View, or Quick Entry version is dis-
played. To help your search, you can switch to a different view.
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3. On the Find Best Available Seats page, complete the required fields. For information
about using these groups, see Assigning Seats Using Best Available and Assigning Seats
Using Quick Entry.

4. Click the Assign Seats Later button. The system does one of the following:

l Displays the Review Items in the Cart page.

l If you used Quick Entry and did not enter the optional Price Type Code, displays the
Select Price Types page. Enter a price type, and then click the Continue button. The
Review Items in the Cart page is displayed.

l If the selected item includes autoload items, the system may display pages that prompt
you for order-specific information about these items (see the general sales procedure in
Adding Items for more information). Once complete, the Review Items in the Cart
page is displayed.

5. On the Review Items in the Cart page, verify that the order information is correct. If
necessary, change the fees, delivery method, or charges. If you make changes on the page,
click the Update buttonx to update the order information. For more information, see
Using the Shopping Cart.

At this point, you can either continue shopping or checkout. When you do checkout, the
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system will display the Search for Patron page.

Or, if you have already selected a patron, the Enter Payment Information page.

6. If the Search for Patron page is displayed, do one of the following:

l Search for and select a patron.

l Click the Skip this Step buttonx .

The Enter Payment Information page is displayed.

7. Complete the Enter Payment Information page, and then click the Place Order button.
(For information about using the Enter Payment Information page, see Collecting Pay-
ment Information.) The Order Confirmation page is displayed.

Assigning Best Available Seats in Item Sales

You can use the Pac7 best available seat assignment feature to let the system locate and hold the
best available seats for you. The system locates the best available seats based on the preferences
your ticket manager has set for the facility (venue) and the seat gap.
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To assign the best available seats in the item sales process

1. Do one of the following:

l For an onsale item, follow the Completing an Onsale Transaction process, making sure to
click the Find Seats button when completing the Select Onsale Items and Seats page.

l For a general sale item, follow the Completing a General Sales Transaction process, mak-
ing sure to click the Find Seats button when completing the Find Best Available Seats
page.

Note: If some of the event dates are in the past for a combo item, you will not be allowed to
use the best available seat search until you have prorated past events from the combo item.

Note: If the system displays the Review Seat Search Results page with a "could not find
seats" error while assigning the best available seats for a combo item, it means the item has
been set up to provide the same seats for all events, but the system could not assign the
same seats for all of them. You can either assign the same seats for all remaining events
(select the Same Seat for Remaining Events option) or assign the best available seats for
each remaining event (select the Best Seat for Each Event button option).
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Tip: When you first open the Find Best Available Seats page, the Table View, List View,
or Quick Entry version is displayed. (The default view is set by your ticket manager during
item sales setup.) To help your search, you can switch to a different view. The Table View
and List View contain the same information, but present it in a different format. Use Table
View if the events you sell have few price levels and types; use List View if you use many
price levels and types.

Assigning Seats Using Quick Entry

The Quick Entry feature allows you to complete an order more quickly than using the Table View or
List View. The feature is designed for people who prefer to enter orders using a keyboard, usually
because they know the price level or price type codes for items. Quick Entry is available in the gen-
eral sales selling path only.

To assign seats using the Quick Entry feature
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Note: During Quick Entry, you can only display event information in a tabular layout. If your
selling organization uses many price levels and types, assign seats using the Best Available fea-
ture and use the List View.

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.

Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.

Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. Select an item for this transaction. For information about searching for and selecting items
for a transaction, see Searching for Items. After you select an item, the Find Best Avail-
able Seats page displays.

3. Select the Quick Entry option.
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The system displays the Quick Entry version of the Find Best Available Seats page.

4. Enter the Qty (quantity), Price Level Code, Price Type Code, and Delivery Method for the
item.

5. Click the Assign Seats Later button or the Find Seats button. (For more information, see
Assigning Seats Later or Assigning Seats Using Best Available.) The Review Items in the
Cart page is displayed. However, if you are adding an item that includes autoload items, you
may be prompted for order-specific information about these items before the system will dis-
play the cart page (see the general sales procedure in Adding Items for more information).

Note: If you did not enter the optional Price Type Code, the system displays the Select
Price Types page. Enter a price type, and then click the Continue button.
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6. Click the Checkout button. The system displays the Search for Patron page.

Or, if you have already selected a patron, the Enter Payment Information page is dis-
played.

7. If the Search for Patron page is displayed, search for and select a patron or click the Skip

this Step buttonx , and then click the Continue with Purchase button.
The Enter Payment Information page displays.

Note: Depending on your configuration, from the Search for Patron page you may also
have the option to create a new patron.
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8. Complete the Enter Payment Information page, and then click the Place Order button.
(For information, see Collecting Payment Information.) The Order Confirmation page is
displayed.

Using the Seat Map in Item Sales
Note: Access to the seat map is configurable by selling control, so you may not have access to this
feature.

The Paciolan seat map is a graphical representation of the seats in a facility as they are configured
for an event. You must select an item before you can use the seat map. You do not need to select
price level, price type, order quantity, or held seat codes beforehand.

When using the seat map, the seats available for selection are determined by inventory availability
and your operator permissions. To locate seats the seat map has the following three views:

l An overview that shows the entire facility as configured for the event. You can display a
detailed view of any part of the facility by clicking it on the overview map.
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l A detailed view that shows only part of the facility, but with each seat graphically rep-
resented by its status. You must be in this view to select or deselect seats. You can navigate
incrementally around the detailed map using the arrows surrounding the map or by clicking
different areas on the MiniMap.

l A MiniMap that is a separate window docked in the detailed view. The MiniMap shows a mini-
aturized version of the overview of the seat map that indicates the location of the current
detailed view and where you have seats selected. You can navigate to a detailed view of a dif-
ferent area of the map by clicking at that location on the MiniMap.

You can move the MiniMap anywhere in the seat map window, and you can minimize the MiniMap if
you do not want to see it.

If no seats are selected when you start the seat map, the overview map of the facility is opened. If
seats are already selected for an item, the detailed view of the map with the MiniMap is displayed.
The locations of the selected seats are indicated by an opaque rectangle on the overview map and
the MiniMap. The rectangle is sized proportionally over the seats selected for the order.

Seat information is displayed around the seat map when you point to any location on the overview,
detailed view, or MiniMap.

Using the seat map, you can do the following:
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l Select single seats
l Select seats for combo items
l Release seat blocks
l Go to a specific seat location
l View seat information
l Go to the Overview Map
l View the Legend

Using the Seat Map to Select Seats

Using the seat map, you can hold and release blocks of seats for an order. The seat map is avail-
able from order lines in order management and during item sales (onsales, general sales, and
promos). The price level sections within which you can hold seats may be limited by your selling
control.

The seat map has three views: overview, detailed view, and MiniMap (see Seat Map Views for
more information). If no seats are on hold when you start the seat map, the overview map of the
facility displays. If seats are already on hold for an item, the detailed view of the map displays
with the docked MiniMap.

The locations of seats that are on hold are indicated by gray marks on the overview map and the
MiniMap. The gray marks are sized proportionally to the number of seats on hold for the order. The
locations and status of individual on hold seats are indicated on the detailed map.

Seat information is displayed around both the overview and detailed versions of the seat map by
pointing to the location on either view or the MiniMap. You can also get seat information by right-
clicking the seat and selecting a command from the menu. For more information, see Viewing Seat
Information Using the Seat Map.

Note: Messages may be displayed when you attempt to put seats on hold. These messages are con-
figured by your ticket manager. For example, if you attempt to put on hold a greater seat quantity
than what you specified in your initial order, the system may display a warning that gives you the
option of adjusting the order quantity or escaping back to the seat map to change your selections
(see image below).

To select single seats during onsales

1. During an onsale on the Item Sales tab, click the Use Seat Map link or button on the Select
Onsale Items and Seats page.
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The system displays the overview version of the seat map page.

2. Click the area on the overview map where the requested seats are located. The seat map
redisplays with a detailed version of the area and the docked MiniMap window.
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3. Navigate around the facility map to find seats, using the following methods:

l Click the arrows on the navigation control x .

l Click any location on the MiniMap to navigate to the detailed view of that area.

l Clear the Lasso seats option, and then click and drag the map.

4. Select or deselect the seats for the order using either of the following methods:

l Select the Lasso seats option, and then drag the mouse pointer over the seats.

l Click the seats one at a time.
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Once you select an open (o)x seat, its seat status changes to on hold (*)x . The seat will
remain on hold until you complete the order or the order timeout configured by the ticket
manager is reached.

5. When you are finished selecting seats, click the Continue button. The Select Price Types page
displays.

6. Complete the order. For more information, see Completing an Onsale Transaction.

To select single seats during general or promo sales

1. During general or promo sales on the Item Sales tab, click the Use Seat Map link or button
on the Find Best Available Seats page.

The system displays the overview version of the seat map page.
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2. Click the area on the overview map where the requested seats are located. The seat map
redisplays with a detailed version of the area and the docked MiniMap window.

3. Navigate around the facility map to find seats, using the following methods:

l Click the arrows on the navigation control x .

l Click any location on the MiniMap to navigate to the detailed view of that area.
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l Clear the Lasso seats option, and then click and drag the map.

4. Select or deselect the seats for the order using either of the following methods:

l Select the Lasso seats option, and then drag the mouse pointer over the seats.

l Click the seats one at a time.

Once you select an open (o)x seat, its seat status changes to on hold (*)x . The seat will
remain on hold until you complete the order or the order timeout configured by the ticket
manager is reached.

5. When you are finished selecting seats, click the Continue button. The Select Price Types page
displays.

6. Complete the order. For more information, see Completing a General Sales Transaction.

To select single seats for an order line during order management

1. During order management on the Order Management tab, select an order line in the Order
Lines table, and then click the seat map button.
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The system displays the overview version of the seat map page.

2. Click the area on the overview map where the requested seats are located. The seat map
redisplays with a detailed version of the area and the docked MiniMap window.
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3. Navigate around the facility map to find seats, using the following methods:

l Click the arrows on the navigation control x .

l Click any location on the MiniMap to navigate to the detailed view of that area.

l Clear the Lasso seats option, and then click and drag the map.

4. Select or deselect the seats for the order using either of the following methods:

l Select the Lasso seats option, and then drag the mouse pointer over the seats.

l Click the seats one at a time.
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Once you select an open (o)x seat, its seat status changes to on hold (*)x . The seat will
remain on hold until you complete the order or the order timeout configured by the ticket
manager is reached.

5. When you are finished selecting seats, click the Continue button. The Price Split form dis-
plays.

6. Split the quantity among price level/price type (PL/PT) combinations as required. For more
information, see Price Splitting PL/PT Quantities in Order Lines.

7. Click the Continue buttonx . Order lines are added to the Order Lines table for
the PL/PT quantities.

8. Finish processing the order. For more information, see Finishing Orders in Order Man-
agement.

Selecting Combo Item Seats Using the Seat Map

In Pac7, you can sell fixed or designer combination items during order management and general
item sales using the seat map. Because combination items contain more than one event, the seat
map allows you to select (hold) or release seats for more than one event at the same time. For
example, you may want to assign the same seats for each event in a season ticket combo item. To
select seats simultaneously for multiple events, each event must have the following:

l The same facility and seat configuration.
l The same seats already selected at the time you want to assign seats. For example, each
event may have zero seats assigned or the same two seats assigned.

When selecting seats for multiple events, you choose one primary event with which to select seats
for all events in the combo item. If there are no events with matching configuration and seat selec-
tions, the system will only hold the seats you select for the primary event. You can always select or
release seats for single events after selecting seats for a primary event. Seats cannot be held in
more than one price level for an individual combo item, although seats in multiple price levels can
be assigned to different combo items.

To select seats for combination items during general item sales
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1. On the Item Sales tab, click General Sales, and then search for and select the combination
item. See Searching for Items for more information. You may be required or have the option
to search for and select a patron first.

2. When you reach the Find Best Available Seats page for the combo item, click the Use Seat
Map link or button.

The Select Primary Event for Seat Map page is displayed.

3. To simultaneously select the same seats for all the single event items in the combination
item, do the following:

a. Select the Primary Event option in the row of the single event item that you want to use
to make the seat map seat selections.
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b. Click the Map: All Events buttonx . The system displays the Seat
Map window.

c. Use the seat map to select seats for the primary event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

d. When you are finished selecting seats, click the Continue buttonx . The
Select Primary Event for Seat Map page redisplays with the seatblock, price level, and
quantity information for each event item.

4. To select seats by individual event in the combination item, do the following:

a. Select the Primary Event option in the row of the single event item for which you want to
select seats. In this example image, the event item UCLA is configured to be the primary
event.

b. Click the Map: Single Event buttonx .
c. Use the seat map to select seats for the single event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

d. When you are finished selecting seats, click the Continue buttonx . The
Select Primary Event for Seat Map page redisplays with the seatblock, price level, and
quantity information for the single event item.
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e. Repeat these steps for each remaining event in the combination item. You can also map
all the remaining events by making one of them the primary item and clicking the Map:

All Events buttonx . This will not change the individual event seat
assignments that you have already made. However, all the remaining event item seats
must be in the same price level that you selected for the primary item.

5. Once you have assigned seats for all the events in the combination item, click the Continue
button.

The Select Price Types page displays.

6. In the Total to Assign group, select the quantity to assign to each price type. The sum of
the quantities you assign to price types must equal the Total to Assign number. In this
example image, 4 seats need to be assigned, and 2 seats are assigned to the Adult and Regu-
lar price types. For more information, see Selecting Price Types.
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7. Click the Continue buttonx . The Review Items in the Cart page displays with
the order items added to the cart. For more information about adding items to the cart, see
the general sales procedure in Adding Items.

8. From the Review Items in the Cart page, complete the order. For more information, see Com-
pleting a General Sales Transaction.

To select seats for combination items during order management

1. Click the Order Management tab.

2. Select the patron, and then select the season.
3. If the combination item has not yet been added to an order line, add an order line, and then
select the combination item.

Note: Unless you are selecting seats for a designer (flex) combo, you do not need to enter
the quantity or price level. Flex combos require that you enter the quantity and price level,
and then select the single events to include for the combo item before opening the seat map.

4. In the Order Lines table, click the seat map button.
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The Select Primary Event form is displayed.

5. To simultaneously select the same seats for all the single event items in the combination
item, do the following:

a. Click the row of the primary event, and then click the Map: All events button.

The Seat Map window is displayed. The primary event's inventory will be displayed in the
seat map when you are selecting seats for all the events.

b. Use the seat map to select seats for the single event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

c. When you are finished selecting seats, click the Continue buttonx
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. The Select Primary Event form redisplays with the price level, seat-
block, and quantity information for each event item.

6. To select seats by individual event in the combination item, do the following:

a. Click the row of the primary event, and then click the Map: Single event button.

The Seat Map window is displayed.

b. Use the seat map to select seats for the single event. For information about selecting
single seats using the seat map, see Using the Seat Map to Select Seats.

c. When you are finished selecting seats, click the Continue buttonx . The
Select Primary Event form redisplays with the price level, seatblock, and quantity
information for the primary event item.

d. Repeat these steps for each remaining event in the combination item. You can also map
all the remaining events by making one of them the primary item and clicking the Map:

All Events buttonx . This will not change the individual event seat
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assignments that you have already made. However, all the remaining event item seats
must be in the same price level that you selected for the primary item.

7. Once you have assigned seats for all the events in the combination item, click the Close but-
ton.

The Price Split form displays.

8. In the Available Price Types table, split the quantity among the price types as required.
For more information, see Price Splitting PL/PT Quantities in Order Lines.

9. Click the Continue buttonx . An order line is added to the Order Lines table for
each unique price level/price type (PL/PT) combination with a quantity.
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10. Finish processing the order. For more information, see Finishing Orders in Order Man-
agement.

Releasing Seats Using the Seat Map

Note: This procedure is only applicable to releasing seats on counter hold during item sales. In
order management, you release seats by deallocating them. During deallocation you have the
option of using the seat map to release seats. For more information, see Deallocating Seats in
Order Management.

After you have placed seats on hold (selected them) for an item, you can release them at any time
until you complete the order. When you release a seat, the system changes its status to open and
other ticket operators will be able to sell the seat.

Using the seat map you can release multiple seats by adjacent groups called seat blocks. This
allows you to release individual seat blocks within single events and across multiple item combo
events.

Note: You can view seat blocks for individual order line items using the seat map. On the Review
Items in the Cart page, though, you must release or hold all seat blocks for an item as a group. For
more information, see Releasing Seats in the Shopping Cart.

To release seat blocks within an event in Item Sales

1. For the event with the held seats you want to release, click the View Seat Map link or iconx

. The Seat Map page is displayed.
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2. From the seat map toolbar, click the View or Release Held Seats buttonx . The sys-
tem displays the View or Release Held Seats window with all the held seat blocks for the
event listed.

Note: If you are releasing seat blocks from an event that is part of an item combo, you will
need to use the Select Primary Event for Seat Map page to access the seat map for the event.
To make sure that you only release seat blocks from that one event, use the Map: Single
Event button—not the Map: All Events button.
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3. Select the held seat that you want to release, and then click OK. The window is closed, and
then the current seat map view is displayed with the released seats' status changed to open
(o)x .

To release seat blocks across events in a combo item

1. For the combo item event from which you want to release seats, click the View Seat Map

link or iconx . The Select Primary Event for Seat Map page is displayed.

2. Select a combo item event from which you want to release held seats.
3. Do one of the following:

l If you want to release seats from all similar events in the combo item, click the Map: All
Events button. To release seats simultaneously for multiple events, each event must have
the same:

l Facility and seat configuration.
l Seats already selected at the time you want to release seats. For example, each event
may have zero seats assigned or the same two seats assigned.

l If you want to release seats from the selected event only, click the Map: Single Event but-
ton.

The system displays the detailed version of the seat map page.
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4. Click the Held Seat Blocks button. The system displays the Seat Map window with all the held
seat blocks for the event listed.

5. Select the seats that you want to release, and then click OK. The system closes the window,
and then redisplays the seat map view with the released seats' status changed to open (o)x
.

Going to a Seat Location on the Seat Map

When selling tickets, customers may already know the seat numbers they want or you may want to
go to a seat block you know is open without going through the search process. When using the seat
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map, you can enter the level:section, level:section and row, or level:section, row and seat to go
directly to the location.

To go to a seat in the seat map

1. Click the Go to Seat buttonx .

The Go To Seat form is displayed in a new window.

Select Level:Section, Row, and Seat values, and then click the Continue buttonx . The
system displays the detailed version of the Seat Map with the seat you specified in the center of the
map and blinking.

Viewing Seat Information Using the Seat Map

Using the Paciolan seat map, you can view a seat's details, status, and history. Depending on the
seat map view displayed, you can mouse over seats to display a combination of the seat location,
price level, and price range. In the overview and MiniMap views, you can display the level:section
and, in the detailed view, you can view an individual seat's location, price level, and price range.

All seat map information is available if you are accessing the seat map during order management
(from the Order Management tab). Depending on the selling control settings, you may also be able
to access the current status and history of transactions for a seat during item sales (from the Item
Sales tab). The selling control may also allow you to view more detailed information for individual
seats, including information about the patron who owns the seat, the seat's row, and any ticket
manager-defined seat hold status.

Tip: You can use the seat transaction history as a troubleshooting tool and the seat status for quick
status and navigation.

To view on-screen tip information for seats and sections

1. On the Seat Map page or MiniMap window, move the mouse pointer to the seat or level:sec-
tion about which you want information.

For the overview version of the Seat Map page or the MiniMap, the system displays the
level:section on the Seat Map page above and below the seat map graphic.
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For the detailed version of the Seat Map page, the seat location, price level, and price range
are displayed.
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To view seat details

Note: The current selling control must be configured to allow use of this functionality. See your
ticket manager for more information.

1. On the detailed version of the Seat Map page, move the mouse pointer to the seat for which
you want information.

2. Right-click the seat, and then select Seat Details.
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The system displays the Seat Details window.

To view seat status

Note: The current selling control must be configured to allow use of this functionality. See your
ticket manager for more information.

1. On the detailed version of the Seat Map page, move the mouse pointer to the seat for which
you want information.
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2. Right-click the seat, and then select Seat Status.

The system displays the Seat Status window.
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3. If you want to check the status of adjacent seats, use the Previous Seat, Next Seat, Previous
Row, and Next Row buttons.

To view seat history

Note: The current selling control must be configured to allow use of this functionality. See your
ticket manager for more information.

1. On the detailed version of the Seat Map page, move the mouse pointer to the seat for which
you want information.

2. Right-click the seat, and then select Seat History.
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The system displays the Seat History window.

Seat Map Views

When using the seat map, the seats available for selection are determined by inventory availability
and your operator permissions. To locate seats the seat map has the following three views:

l An overview that shows the entire facility as configured for the event. You can display a
detailed view of any part of the facility by clicking it on the overview map.
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l A detailed view that shows only part of the facility, but with each seat graphically rep-
resented by its status. You must be in this view to select or deselect seats. You can navigate
incrementally around the detailed map using the arrows surrounding the map or by clicking
different areas on the MiniMap.
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l A MiniMap that is a separate window docked in the detailed view. The MiniMap shows a mini-
aturized version of the overview of the seat map that indicates the location of the current
detailed view and where you have seats selected. You can navigate to a detailed view of a dif-
ferent area of the map by clicking at that location on the MiniMap.

You can move the MiniMap anywhere in the seat map window, and you can minimize the MiniMap if
you do not want to see it.

If no seats are selected when you start the seat map, the overview map of the facility is opened. If
seats are already selected for an item, the detailed view of the map with the MiniMap is displayed.
The locations of the selected seats are indicated by an opaque rectangle on the overview map and
the MiniMap. The rectangle is sized proportionally over the seats selected for the order.

Seat information is displayed around the seat map when you point to any location on the overview,
detailed view, or MiniMap.

Going to the Overview Version of the Seat Map

If you are working in the detailed view of the seat map and you need to see the entire facility, you
can return to the overview version at any time. When you switch to the overview, the system auto-
matically saves any seat selection changes you made while in the detailed view.
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Detailed view of the seat map

Overview version of the seat map
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To go to the overview version of the seat map

1. In the detailed view of the Seat Map page, click the dot in the center of the navigation control

x . The overview version of the Seat Map page is displayed. To go back to
the detailed view, click the location on the overview page.

Displaying Specific Seat Statuses

You can limit the seat map display to any subset of the seat statuses that you have permissions to
view.

To display specific seat status

1. In the seat map toolbar, click the Display Specific Seat Status buttonx . The Display
Specific Seat Status form displays.
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2. Select the seat statuses that you want to display, and then click the Continue buttonx

. The seat map redisplays with only the seat statuses you selected.

Searching for Multiple Events
Note: This search can only be used for single event items that have seats created (in other words,
the events must have seats from which to choose).

The purpose of a multiple event seat search is to get the best available seats for patrons who are
flexible about the day, time, or the event itself. For example, they may want to go to a show on
any Friday, or go to a specific show on any day of the week.

When searching for multiple events, you can select more than one event to add to an order to save
time during the order process. However, you must select the same number of seats for each event.
You cannot use the seat map for this feature without first assigning the best available seats.

To search for multiple events

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.
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Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.

Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).

2. Click the Search Multiple Events link. The Search for Multiple Events page is displayed.
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3. Enter search criteria values, and then click the Search button. The search results are dis-
played under the search criteria.

4. Select the items you want to add to your shopping cart, and then click Continue. The Find
Best Seats Across Multiple Events page is displayed.

5. Select the Qty (quantity) and Price Level Code for all items, and then select the Delivery
Method for each item.

6. Click the Find Seats button. The Select an Event for Purchase page is displayed.

7. Select the Event that the patron wants to purchase, and then click the Continue button. The
Select Price Types page is displayed.
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8. Enter price type quantities for the seats you hold, and then click the Continue button. The
Review Items in the Cart page is displayed. However, if you are adding an item that includes
autoload items, you may be prompted for order-specific information about these items
before the cart page displays (see the general sales procedure in Adding Items for more
information). For information about completing an order, see Checking Out from the Shop-
ping Cart.

Tip: If you want to select all the items in the search results, select the heading row of the res-
ults.

Processing Non-Allocatable Items
Non-allocatable items include items that are not tickets and to which you cannot allocate seats (for
example, a promotional hat or a donation). When including non-allocatable items in item sales
orders, you add them the same way you add allocatable items, except that you do not need to
search for or assign seats.

Non-allocatable items can be returned, if your operator code has return permissions. You can also
reprint any items that are configured for printing when you place the order.

When creating a customer order, you can include the following non-allocatable items:

l Miscellaneous Items
l Gift Certificates
l Donations
l Access Passes

Processing Miscellaneous Items
Miscellaneous items are not covered by the normal ticketing process. For example, an item may
represent away game events (attached to your external events), parking for an event, or hats and
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T-shirts. You can process a miscellaneous item by setting the quantity, price, or delivery method,
and then adding the item to your shopping cart. If the miscellaneous item is non-traditional
(requires a barcode), the system will automatically generate its barcode as it is printed or
delivered electronically.

To process miscellaneous items

1. Locate and select the miscellaneous item. For more information, see Searching for Items.
The Enter Item Details page is displayed.

Tip: On the Search for Item page, you can identify miscellaneous items by checking the Item
Type column in the Search Results group.

2. Set the Qty (quantity), Price, and Delivery Method values. Depending on your configuration,
the price may not be editable.

Note: Electronic delivery methods (print at home, magstripe credit card, magstripe ID) are
not available for house customers.

3. Click the Add to Cart button. The Review Items in the Cart page is displayed.
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4. Continue shopping or check out. See Searching for Items or Checking Out.

Processing Gift Certificates
Gift certificate items are not covered by the normal ticketing process. Depending on your Paciolan
configuration, you can process a gift certificate item by setting quantity, price (amount), and deliv-
ery method, and then adding the item to your shopping cart.

You may also need to assign a document number to the certificate, or the system may assign the
number automatically. If the document number is set manually, then the quantity of gift cer-
tificates is fixed. Also, if the gift certificate number is set manually, you will be prompted for the
number before adding it to the cart. If the document number is assigned automatically, you can
change the quantity.

To process gift certificates

1. Locate and select the gift certificate item. For more information, see Searching for Items.
The Enter Gift Certificate Details page is displayed.

Tip: On the Search for Item page, you can identify gift certificates by scanning the Item
Type column in the Search Results group.
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2. Set the Qty (quantity), Price, and Delivery Method values. Depending on your configuration,
the price may not be editable.

3. Click the Add to Cart button. The Review Items in the Cart page is displayed.

4. Continue adding items or check out of the shopping cart. See Searching for Items or Check-
ing Out of the Shopping Cart.

Processing Donations
Donation items are not covered by the normal ticketing process. You can process a donation item
by setting quantity, price (amount), and delivery method, and then adding the item to your shop-
ping cart.
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To process donations

1. Locate and select the donation item. For more information, see Searching for Items. The
Enter Donation Details page is displayed.

Tip: On the Search for Item page, you can identify donations by scanning the Item Type
column in the Search Results group.

2. Set the Qty (quantity), Price, and Delivery Method values. Depending on your configuration,
the price may not be editable.

3. Click the Add to Cart button. The Review Items in the Cart page is displayed.

4. Continue adding items or check out of the shopping cart. See Searching for Items or Check-
ing Out of the Shopping Cart.

Processing Access Passes
Access pass items allow entrance to events but are not covered by the normal ticketing process.
You must select a patron (not a house customer) to sell an access pass, and the system only allows
one access pass per patron for each season.

Depending on your Paciolan configuration, you can process an access pass item by setting the
access pass card number, price (amount), and delivery method, and then adding the item to your
shopping cart. You will be prompted for the access pass number before adding it to the cart. The
quantity is always fixed, and the access pass card number is always manually entered. The system
will accept any unique number for the access pass card.

To process access passes

1. Locate and select the access pass item. For more information, see Searching for Items. The
Enter Access Pass Details page is displayed.
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Note: If you have not selected a patron for the current order, the Search for Patron page is
displayed. Before you can continue processing the access pass, you must locate and select a
patron for the order. For more information, see Selling to Patrons.

Tip: On the Search for Item page, you can identify access passes by scanning the Item Type
column in the Search Results group.

2. Set the Price, Access Pass Card #, and Delivery Method values. Depending on your con-
figuration, the price may not be editable.

3. Click the Add to Cart button. The Review Items in the Cart page is displayed.

4. Continue adding items or check out of the shopping cart. See Searching for Items or Check-
ing Out of the Shopping Cart.
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Selecting Price Types
The Item Sales tab displays the Select Price Types page whenever you attempt to go to the Review
Items in the Cart page without having selected a price type. When selling items, the Select Price
Types page is displayed when you select seats using the seat map and then attempt to continue on
to the shopping cart.

During a general sales transaction, the Select Price Types page is displayed when you leave the
Find Best Available Seats page without entering a price type. The conditions under which the sys-
tem displays the Select Price Types page during general sales include:

Note: If there is only one price type associated with the selected price level, the Select Price
Types page is skipped, regardless of the conditions listed below.

l Selecting quantity and price level, but not price type, while assigning seats using the Quick
Entry page, and then clicking the Assign Seats Later or Find Seats button.

l Using the seat map instead of assigning seats by best available, and then attempting to con-
tinue on to the shopping cart.

l Launching the seat map from an item line in the shopping cart, using the Seat Map to add
seats, and then attempting to continue on to the shopping cart.

To select price types

1. In the Price Types fields, distribute the total quantity of tickets.
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2. Click the Continue button. The Review Items in the Cart page is displayed. However, if you
are adding an item that includes autoload items, you may be prompted for order-specific
information about these items before the system displays the cart page (see the general
sales procedure in Adding Items for more information).

3. From the Review Items in the Cart page, complete the order. For the remainder of the pro-
cedure, see Completing a General Sales Transaction.

Selling to Patrons
During the onsale or general sales selling processes, you need to associate patrons in the system
with their orders. Patrons can be house or individual customers, depending on what type of inform-
ation your system is configured to collect.

You can sell to patrons in item sales using the following methods:

l Search for Patrons
l Create a Quick Patron Entry
l Use Full Patron Entry
l Change Patrons
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Searching for Patrons During Item Sales
You will often need to search for existing patrons to assign to your item sales orders. You can
search for patrons at any time during the onsale or general sales selling process. When searching
for patrons, you have the following choices:

l Searching for Individual Patron Records
l Searching for House Customers

Searching for Patrons During Item Sales

During item sales you will need to choose either a house customer or an individual patron record.
Patron records include both individual organizations and individual customers. Searches of these
records are conducted using the same process. When you search for individual patron records, you
use the some combination of the fields on the Search for Patron page.

For the shortest search time, use the Patron ID field or Keyword field instead of searching by Last
Name and First Name. In general, the fastest searches use the Search Word/Search By fields
(including Patron ID, Phone, Magstripe ID, Barcode, and Credit Card #, if configured), because
they usually yield single results.

Note: If you want to search with keywords, ask your ticket manager for the list of keywords your
data account uses for patron searches. Keywords are created and managed by the ticket manager
of the data account. For example, many ticket managers use nicknames like SmithJ, which
includes the first five letters of the patron's last name and first initial of the first name.

The search page fields are not case-sensitive, and the default operation between the search fields
is AND. The only field in which you can use wildcards is the First Name field. Use the asterisk (*)
wildcard at the end of name to represent zero to many characters when searching.

If your search yields only one result (an exact hit), the system displays a patron entry page. If
your search yields more than one result, the system redisplays the Search for Patron page with the
search results. If your search produces more than 50 results, the system displays only the first 50
results on the page and includes links to the rest of the results.

How the search results display may be customized by your control settings. If your control is set to
use Basic Quick Patron, the search results are always displayed with the following fields: Patron
ID, Patron Name, Phone, Shipping and Billing Addresses. If your control is set to use Advanced
Quick Patron or Full Patron, the search results columns are configured by the ticket manager,
although the first two columns will always be ID (patron) and Patron Name. The ticket manager
must configure which of the other results columns to display.

l Patron Names Suffix
l Secondary Patron Name
l Phone Number
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l Email Address
l Shipping Address
l Billing Address
l Ticketing Type
l Ticketing Status
l Last Season Ordered

To search for individual patron records

1. On the Search for Patron page, enter search information in the appropriate fields.
2. Click the Search button. Do one of the following:

l If the search results display on the Search for Patron page, click the correct patron ID.

The system displays the full or quick version (depending on configuration) of the Enter Pat-
ron Information page for the patron. Proceed to the next step.

l If there is a single patron matching your search criteria, the system displays the full or
quick version (depending on configuration) of the Enter Patron Information page for the
patron. Proceed to the next step.
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l If you cannot find the patron, click the Create a New Patron buttonx
, and use the Enter Patron Information page to submit a

new patron. For more information see, Creating a Quick Patron Entry or Using Full Patron
Entry.

3. Complete the selling process for the order. For more information, see Completing an Onsale
Transaction or Completing a General Sales Transaction.

Searching for House Customers

The house customer represents a group of customers about which no information, including
address, is gathered or stored. You can use the house customer for sales to walk up customers.
Often, this category is used for onsale selling situations.

More than one house customer is necessary because performance slows down as the size of trans-
action files increases. Ticket operators will generally be assigned the house customer as a default
after log in. However, operators may need to change to a new house customer if there is an onsale
with enough transactions to slow system performance. For information, see Changing House Cus-
tomers.

Different house customers can also be used by the ticket manager to track operator transactions
over time. For example, if the manager wants to track operator transactions daily, operators may
have a new house customer set as the default each day when they log in.

Note: In item sales, one house customer is always the default. The system uses the default house
customer for all selling orders, until an operator switches to a different house customer or an indi-
vidual customer.

To search for a house customer during selling

1. After you have added at least one item to the shopping cart, click the patron Change button.
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The system displays the Change Patron page.

2. Select the Change to a Different House Customer option, and then click the Change button.
The Search for House Customer page is displayed.

Tip: You can change to the default house customer without searching, by selecting the
Change to the Default House Customer option.

3. Do one of the following:

l Enter the house customer Patron ID, and then click the Search button. The system
changes to the house customer with the Patron ID you entered, and then returns you to
your previous place in the selling process.

l Enter any combination of values for the Name and Keyword fields, and then click the
Search button. The system displays the search results page listing the house customer.
Select a house customer from the results list. The system returns you to your previous
place in the selling process.

Creating a Quick Patron Entry
Use quick patron entry during selling when you need to assign a new customer to an order or order
line. Quick patron entry may be configured as either basic or advanced. The basic quick patron
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entry version of the Enter Patron Information page has the standard Shipping and Billing address
entry fields along with standard phone/email fields, including day phone, evening phone, and
email.

In addition to the basic patron entry information, the advanced quick patron entry version of the
Enter Patron Information page displays the following:

l Multiple phone/email types
l Multiple shipping and billing address types
l The names of the ticketing status and type codes
l Ticketing comments associated with the patron

Note: If the ticket manager has configured item sales for duplicate name checking, the system will
not allow you to create patrons before searching for them. This option is used to avoid duplicate
patron records.

Note: You may not have quick patron entry available. The ticket manager may configure item
sales for full patron entry instead. For more information, see Using Full Patron Entry.

To create a quick patron entry

Tip: If your control has the appropriate permissions, you can create a new patron at any time
using the Patron tab. For more information, see Creating Patrons.

1. If you are on the Search for Patron page, click the Create a New Patron button.
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2. If you are on the Review Items in the Cart or Enter Payment Information pages, do the fol-
lowing:

a. Click the patron Change button.

b. If the system displays the Change Patron page, select the Change to Another Patron
option, and then click the Change button.

The Search for Patron page is displayed.

c. Click the Create a New Patron button, and then go to the next step.

3. Verify that you are on the quick version of the Enter Patron Information page. If you are on
the full version instead, see Using Full Patron Entry.
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4. On the Enter Patron Information page, enter or select values for all required fields. The sys-
tem displays an asterisk (*) in front of the name of each required field.

5. Enter or select values for any optional (no asterisk) fields, and then click the Continue with

Purchase buttonx . The system returns you to your
previous place in the selling process.

Using Full Patron Entry During Item Sales
Use full patron entry if you have the correct permissions and you need to assign a new customer to
an order or order line during item sales. Full patron entry during selling will begin either before or
after you select items for the shopping cart, depending on your Paciolan configuration.

Note: If the ticket manager has configured the system for duplicate name checking, you will not
be allowed to create patrons before searching for them. This option is used to avoid duplicate pat-
ron records.

Note: You may not have full patron entry available— the ticket manager may configure the system
for quick patron entry instead. For more information about quick entry, see Creating a Quick Pat-
ron Entry.

Full patron entry includes all the entry fields of quick patron entry, but also includes many more
fields for personal and biographical information, related patrons, affiliated institutions, and any
other information your manager wants collected.

To create a full patron entry

Tip: If your control has the correct permissions, you can create a new patron at any time using
the Patron tab. For more information, see Creating Patrons.

1. If you are not on the Enter Patron Information page, click the Create a New Patron button on
the Search for Patron page.
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2. If you want to add a patron using full patron entry from the Review Items in the Cart or Enter
Payment Information pages, do the following:

a. Click the patron Change button.

The Change Patron page is displayed.

b. Select the Change to Another Patron option, and then click the Change button. The Search
for Patron page is displayed.

c. Click the Create a New Patron button.

3. On the Home tab of the Enter Patron Information page, enter or select values for all required
fields. The system displays an asterisk (*) in front of the name of each required field.

Normally, the system only requires fields in the Patron Information and Primary Patron
groups.
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4. If you need to contact the patron whose record you are creating, you can send an email from
the Enter Patron Information page. To start a new email for the patron, select an address
from the email address drop-down list, and then click the Send Email buttonx

.

If the email address list is not displayed or the required address is not in the list, you can add
email addresses to the patron record by doing the following:

a. Click the Home tab, and then locate the Phone/Email group.

b. In the Email section, enter the email address in the text box adjacent to the email type.

c. Click the Hold Updates buttonx . Pac7 redisplays the Enter Patron
Information page with the email address drop-down list.

5. On the Patron Information page, enter information in the fields on one or more of the patron
record tabs, as required.

Depending on your selling control, some tabs and data fields may not be displayed. Some
fields allow you to enter more than one value (multi-value fields).
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Use these multi-value fields as follows:

l For a multi-value text box, enter text in the text box, and then click the add more buttonx

.

The system adds a text box below the original one, allowing you to make another text
entry. You can repeat this process to add as many entries as required.

l For a multi-value drop-down list, select an option from the drop-down list, and then click

the add more buttonx .

The system displays your selection in static text above the drop-down list, allowing you to
add another selection. You can repeat this process to add as many selections as required.

l For a multi-value drop-down list with a text box, select an option from the drop-down list,

enter text in the adjacent text box, and then click the add more buttonx .

The system displays another line with a drop-down list and a text box, allowing you to
make an additional entry.
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Note: To delete a multi-value line, click its delete buttonx . The system redisplays the
page with the line removed.

Note: If you enter information on a patron record tab and then click one of the other tabs
before saving the record, Pac7 will display a dialog box (for example, in Internet Explorer)
that requires you to either hold (temporarily save) or discard the information you entered.
To hold the information without getting this dialog box, click the Hold Updates buttonx

before you click another tab.

6. If you want to enter fund development information for a patron and you have the per-
missions, use the Development tab. If you have permissions and the tab is not displayed for
the patron, do the following:

a. Click the Home tab, and then select the Donor option.

b. Click the Hold Updates buttonx , and then click the Development tab.
The system displays the Development tab.

7. If you want to enter ticketing information for a patron and you have the permissions, use the
Ticketing tab.

If the tab is not displayed for the patron, do the following:
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a. Click the Home tab, and then select the Customer option.

b. Click the Hold Updates buttonx , and then click the Ticketing tab. The
system displays the Ticketing tab.

8. If you want to enter organization information for a patron and you have the permissions, do
the following:

a. Click the Home tab, and then select the Organization patron type.

b. Enter the organization name, and then select the organization type.
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c. Click the Hold Updates buttonx . The system adds the Organization
tab for the patron. You can now click the tab to display the organization data fields.

d. Enter organization information as required.

9. On each of the remaining tabs, enter or select values for any optional (no asterisk) fields,

and then click the Continue with Purchase buttonx .
The system returns you to your previous place in the selling process.

Changing Patrons During Selling
You can change the patron to whom you are selling during the sales process, as long as it is before
you complete the order. During the selling process, you can switch from a house or individual cus-
tomer to another house or individual customer for an order after you have added items to the shop-
ping cart. Depending on your configuration, you can switch patrons at any time before or after the
system requires you to select a patron.

To change customers during selling, do one of the following:

l Change Individual Patrons
l Change House Customers

Changing Individual Patrons During Selling

An individual (or public) customer is a single patron about which the system keeps a record of per-
sonal information. The customer's address and phone number is stored in this record, as well as
many other types of pertinent information.

During the selling process, you can switch from a house or individual customer to an individual cus-
tomer for an order after you have added items to the shopping cart, until you complete the order.
Depending on your configuration, you can switch patrons at any time before or after the system
requires you to select a patron.

To change individual patrons during selling
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1. After you have added at least one item to the shopping cart, click the patron Change button.

The Change Patron page is displayed.

2. Make sure the Change to Another Patron option is selected, and then click the Change button.
The Search for Patron page is displayed.

3. Search for and select an individual patron. (See Searching for Individual Patrons.) Once you
select a patron, the system displays the full or quick version (depending on configuration) of
the Enter Patron Information page with the selected patron's information in the fields.

Tip: If you need to update the patron's information, you can make changes on this page
before continuing with the order. Note, however, that some Paciolan configurations do not
allow you to update patron data in the onsale selling path.

4. Click the Continue with Purchase buttonx , and then
complete the selling process for the order. For more information, see Completing an Onsale
Transaction or Completing a General Sales Transaction.
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Changing House Customers During Selling

More than one house customer is necessary because performance slows down as the file size
increases with the number of transactions. As a ticket operator, you will generally use the house
customer set up as a default for your log in. However, you may need to change to a new house cus-
tomer if you have an onsale with so many transactions that system performance suffers.

Note: For item sales, one house customer is always the default, unless your configuration allows
individual patrons only. Paciolan uses the default house customer for all selling orders, until you
switch to a different house customer or an individual customer for an order.

During the selling process, you can switch from a house or individual customer to a house cus-
tomer for an order at any time, until you complete the order. You can also change to a particular
house customer at any time before or after you are required you to select a patron.

To change to the default house customer during selling

1. After you have added at least one item to the shopping cart, click the patron Change button.

The Change Patron page is displayed.

2. Select the Change to the Default House Customer option, and then click the Change button.
The system returns you to your previous place in the selling process.

To change to a non-default house customer during selling

1. After you have added at least one item to the shopping cart, click the patron Change button.
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The Change Patron page is displayed.

2. Select the Change to a Different House Customer option, and then click the Change button.
The system displays the Search for House Customer page.

3. Do one of the following:

l Enter the house customer Patron ID, and then click the Search button. The system
changes to the house customer with the Patron ID you entered, and then returns you to
your previous place in the selling process.

l Enter any combination of values for the Name and Keyword fields, and then click the
Search button. The system displays a list of house customers. Select a house customer
from the results list. The system returns you to your previous place in the selling process.

Using the Shopping Cart
Use the Review Items in the Cart page to gather all the items a customer wants to purchase. This
page allows you to review selections, make necessary modifications or additions, and then com-
plete orders.
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Note: The set of data fields displayed on the Review Items in the Cart page is customizable, so
your page may look slightly different than those shown in the procedures referenced below.

When using the shopping cart, you can do the following:

l Add Items
l Go to the Cart
l View Item Details
l Modify Items
l Check Out

Adding Items to the Shopping Cart
You can add an item to the shopping cart at any time during order processing, until you have
checked out. You can add items to the cart during item sales using the onsale or the general sales
process. The items you add to the cart are all displayed as line items on the Review Items in the
Cart page. Once you have added an item to the cart, you can continue shopping, cancel the order,
or check out. If you continue shopping, you can add more items to the cart at any time.

To add an item to the shopping cart using the onsale process

1. On the Item Sales tab, click the Onsale link. The Select Onsale Items and Seats page of the
Onsale path is displayed.

Pac7 Release 7.2



User Guide  686

2. Locate the onsale item you want to add to the order. For more information, see the detailed
procedure for onsale selling. If you can't find an item on this page, it may be selling as a gen-
eral sale item. For more information, see Completing a General Sales Transaction.

3. Enter the quantity and, if necessary, select the price level for the item.
4. To select seats for the order, do one of the following:

l Click the Find Seats button. The system finds the best seats left available, according to
the options set in your back office (tRes), and then displays the Review Items in the
Cart page.

l Click the View Seat Map link or iconx . Once the Seat Map page is dis-
played, select the seats for the order. For information about selecting seats using the Seat
Map, see Using the Seat Map. Once you have selected seats, the Review Items in the
Cart page is displayed.

Note: Items can be configured so that additional miscellaneous items automatically load
when you add them to the cart. If the item you are adding to the cart includes autoload
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miscellaneous items, the system may display a page that prompts you to select the items
and quantities to be autoloaded before displaying the Review Items in the Cart page.
However, depending on your selling control's order option configuration, the system may
instead automatically add a set quantity of autoload miscellaneous items to the cart and dir-
ectly display the Review Items in the Cart page. Regardless of configuration, autoloaded
items are treated the same as manually loaded items once they are in the cart.

To add an item to the shopping cart using the general sales process

1. On the Item Sales tab, click the General Sales link. The first page of the General Sales path
is displayed.

Depending on the configuration of your control, the Search for Item page may be displayed
instead of the Search for Patron page.

Note: Depending on your configuration, Paciolan may display the Search for Patron page
first. If this page displays, select a customer (patron) before continuing. Depending on your
Paciolan configuration, you will have the option of searching for an individual customer or
skipping the step to continue with the default patron (house customer).
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2. Select an item for this transaction. For information about searching for and selecting items
for a transaction, see Searching for Items. After you select an item, the Find Best Avail-
able Seats page is displayed.

Note: If you select an access pass item, you will be required to select an individual patron
before you select quantities, price levels/price types, or any other order information. This is
not configurable by the ticket manager.

Tip: You can also select a set of items by searching for multiple events.

3. On the Find Best Available Seats page, select seats for the order using one of the fol-
lowing procedures:

l Quick Entry
l Best Available (Table View or List View)
l Seat Map

In addition to seat selection, the process includes entering the quantity, price level, price
type, and delivery method for the order item. When you've completed the process, the
Review Items in the Cart page is displayed.

Note: Items can be configured so that additional items automatically load when you add
them to the cart. If the item you are adding to the cart includes any of these autoload items,
the system may display additional pages that prompt you for order-specific information
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about these items before displaying the Review Items in the Cart page. However, depend-
ing on your control's order option configuration and the autoload item types, the system may
instead directly display the Review Items in the Cart page with the autoload items
already added. Regardless of configuration, autoloaded items are treated the same as manu-
ally loaded items once they are in the cart.

Going to the Shopping Cart
Once you have added an item to an order during the onsale or general sales selling process, you
can go to the shopping cart at any time. However, if you have located an item and go to the cart
without adding the item to the order, you will have to find the item again if you continue shopping
(general sales path only). You cannot use the continue shopping feature from the onsales path.

To go to the shopping cart

1. In the I'd like to: area of the current item sales page, click the View Cart link or iconx

.

The Review Items in the Cart page is displayed for the current order.

Viewing Order Item Details in Item Sales
While the details that display in the Paciolan Review Items in the Cart page will vary by con-
figuration, more information about the items in your order is always available through links on the
page.
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Tip: To display the order total breakdown in a popup window, click the Order Total Breakdown link
in the Charge Summary group.

On the Review Items in the Cart page, you can view the following details:

l Item Order
l Item Additional Details
l Multiple Price Level
l Seat Block

Modifying Items in the Shopping Cart
The shopping cart is created when you add the first item to an order. The cart contains all the items
you have added to the current order. Each order line (row) in the cart contains one item of any type
(allocatable, non-allocatable, or combo item). You can modify any order line in the shopping cart
up until you check out of the cart. To modify an order line item in the shopping cart, you can do any
of the following:

l Change Seat Assignments
l Modify Discounts and Surcharges
l Change the Quantity and Price
l Enter Additional Information for Items
l Change Delivery Methods

Pac7 Release 7.2



User Guide  691

l Change Delivery Charges
l Release Seats
l Delete Items

Checking Out from the Shopping Cart
When you are finished adding a customer's order to the shopping cart, you will need to check out of
the cart to complete the order. Once the order is complete, the system stores the order inform-
ation in the database and processes the order (allocates tickets according to the delivery methods,
charges the customer's credit card, etc.).

Note: You can also Cancel an Order without processing it. Or, you can cancel the order imme-
diately following checkout.

To checkout from the shopping cart

1. On the Review Items in the Cart page, click the Checkout buttonx .

The system displays the Search for Patron page or the Enter Payment Information page.
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2. If the Search for Patron page is displayed, search for and select an individual patron or click

the Skip this Step buttonx . (For more information about selecting
individual patrons, see Searching for Patrons.) The system displays the Enter Payment
Information page.

3. On the Enter Payment Information page, select values for the Payment and Options groups,

and then click the Place Order buttonx . The Order Confirmation page is
displayed.

Modifying Items in the Shopping Cart
The shopping cart is created when you add the first item to an order. The cart contains all the items
you have added to the current order. Each order line (row) in the cart contains one item of any type
(allocatable, non-allocatable, or combo item). You can modify any order line in the shopping cart
up until you check out of the cart. To modify an order line item in the shopping cart, you can do any
of the following:

l Change Seat Assignments
l Modify Discounts and Surcharges
l Change the Quantity and Price
l Enter Additional Information for Items
l Change Delivery Methods
l Change Delivery Charges
l Release Seats
l Delete Items
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Changing Seat Assignments in the Cart
You assign seats to allocatable items using the seat map or the best available function. Once you
have assigned seats to an item, you can change the seat assignments at any time until you check
out of the shopping cart. You change seat assignments using the seat map.

To change seat assignments in the cart using the seat map

1. On the Review Items in the Cart page, locate the item order line, and then click the seat map

buttonx .

The Select Seats on Seat Map page is displayed with the assigned seats centered.

2. Release the assigned seats by clicking them individually or drawing a bounding outline (dot-
ted rectangle) around them. For more information, see Releasing Seats.

3. Select new open seatsx as required. For more information, see Selecting Single Item
Seats.

4. When you are finished selecting seats, click the Continue buttonx . The
Review Items in the Cart page is displayed with the new seat assignments listed in the Seat-
block column.

Modifying Item Discounts and Surcharges
Discounts include any deduction from the normal item price. Surcharges are a percentage of a
fixed amount that are added to the item price and any per item fees (for example, surcharges are
used in Canadian markets to represent tax). Whether discounts and surcharges are included and
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what types and amounts are available is configured by the ticket manager in tRes. The types and
amounts vary by the each season (for example, football and baseball). Also configurable is
whether discounts and surcharges are displayed in the cart or the additional items pages.

To modify item discounts and surcharges in the cart

1. On the Review Items in the Cart page, locate the item order line.

2. From the lists in the Discount and Surcharge columns, select different discount and sur-
charge types.

3. Click the Update button to recalculate the subtotal.

To modify item discounts and surcharges on the additional information page

1. On the Review Items in the Cart page, locate the item order line, and then click the item addi-

tional buttonx . The Enter Additional Information page is displayed.

2. From the lists in the Discount and Surcharge columns, select different discount and sur-
charge types.

3. Click the Update button to recalculate the Item Total.
4. Click the Continue button to return to the Review Items in the Cart page.

Changing the Quantity and Price of Items
Depending on the item type, you can modify the quantity and price of both allocatable and non-
allocatable items. The defaults and configuration of item sales in tRes determines whether an item
type's price and quantity are changeable.

For information about modifying price or quantity for an item, go to the Review Items in the Cart
page, and then click the item type below:

Pac7 Release 7.2



User Guide  695

l Allocatable

The ticket manager sets whether the price can be modified for an allocatable item. The sys-
tem only allows you to change an item's quantity on the Review Items in the Cart page (see
image below) if no seats are currently assigned. (This can happen because you choose the
assign seats later function or because you have released seats while on the cart). After you
assign seats, you can use the seat map to change both the quantity of seats and the selected
seats.

l Gift Certificate

The price and quantity of a gift certificate are not editable on the Review Items in the Cart
page. However, the gift certificate number is editable if it is automatically assigned by the
system, instead of manually assigned by operator. The ticket manager configures in tRes
whether gift certificate numbers are automatically or manually assigned.

l Miscellaneous

You can always edit miscellaneous item quantity on the Review Items in the Cart page. You
may be able to change the price, depending on your Paciolan configuration.

l Donations

You can always edit donation items quantity on the Review Items in the Cart page. Item price
may be editable also, depending on your Paciolan configuration.

l Access Passes

Access pass items allow entrance to events but are not covered by the normal ticketing pro-
cess. The quantity for access passes is not editable on the Review Items in the Cart page.
You may be able to change the price, depending on your Paciolan configuration.
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Entering Additional Information for Items
Although the shopping cart is configurable, space on the page should be preserved for usability. For
this reason, the system allows you to enter additional order line information on the Enter Additional
Information page.

If the current selling control allows access, the editable version of this page is accessible from the
order line of each item on the Review Items in the Cart page. On the editable version, you can set
values for all the configured options that do not appear on the Review Items in the Cart page,
including the following commonly required options:

l Assigning Alternate Shipping Addresses
l Assigning an Associated Patron
l Assigning a Will Call Patron
l Assigning a Billing Plan

Note: If you access the Enter Additional Information page from the Enter Payment Information or
Order Confirmation pages, the system will display a view-only version of the Enter Additional
Information page.
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Also, on the editable Enter Additional Information page, you can set the following options:

l Mark
l Special Handling
l Notes
l Item Preference
l Location Preference
l Order-Line Priority
l Group #
l Order Date

Note: The options displayed on this page vary depending on the display configuration and the item
type in an order line.

If you are adding information to an order item for which you have multiple order lines (for
example, 2 adult and 2 child tickets), you can choose to apply the additional information for all the
item's order lines.
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Using Alternate Shipping Addresses for Order Items

You can ship a customer order to an address that is different than the primary patron's order
default shipping address and billing address. For example, customers order tickets to be billed to
their home (primary) address, but need to receive some items from the order at work (an altern-
ate shipping address).

Once you have entered alternate addresses for patrons, the addresses will be available, along with
the primary (default) addresses, each time you process orders for them. You can also set an altern-
ate address to be the primary address for a patron.

To assign an existing alternate shipping address

Note: You must select a patron for the order before you can select an alternate shipping address.
You cannot use this function with house customers because they do not have shipping addresses.

1. On the Review Items in the Cart page, locate the order line item for which you want to assign
an alternate shipping address.

2. Click the item additional buttonx in the order line. The Enter Additional Information page
is displayed.
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3. From the Alternate Address Type list, select an alternate address.
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4. Click the Continue button. The Review Items in the Cart page is displayed.

To edit an existing address

1. On the Review Items in the Cart page, locate the order line item for which you want to assign
an alternate shipping address.

2. Click the item additional buttonx in the order line. The Enter Additional Information page
is displayed.
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3. In the Additional Details group, click the Alternate Address Type edit button.
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Depending on your configuration, the system displays either the Quick Patron Entry or the
Full Patron version of the Enter Patron Information page.

Quick Patron Entry

Full Patron

Pac7 Release 7.2



User Guide  703

4. Complete the page, and then click the Continue with Purchase button. (For more information
about patron entry, see Creating a Quick Patron Entry or Using Full Patron Entry.) The Item
Additional Details page is displayed with the new value in the Alternate Address Type list.

5. Click the Continue button. The Review Items in the Cart page is displayed.

Using an Associated Patron for Order Items

You can send any item in an order to a patron other than the primary patron who is paying for the
order. For example, the primary patron may be ordering the tickets as a gift for another patron
and also want the tickets mailed to that patron. You can add, change, or delete an associated pat-
ron at any time until you check out of the shopping cart.

To add or change the associated patron for an order line

1. On the Review Items in the Cart page, locate the order line item for which you want to assign
an associated patron.

2. Click the item additional buttonx in the order line. The Enter Additional Information page
is displayed.
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3. In the Associated Customer field of the Additional Details group, click the search buttonx .
The Search for Patron page is displayed.

4. Search for and select a patron. (For more information, see Searching for Patrons.) Depend-
ing on your configuration, the system displays either the Quick Patron Entry or the Full Pat-
ron version of the Enter Patron Information page.

Quick Patron Entry
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Full Patron

Note: You can also choose to create a new patron (customer) as the associated patron for
the order item.

5. Click the Continue with Purchase buttonx . The sys-
tem displays the Enter Additional Information page with the selected patron in the Associated
Customer field.
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6. Click the Continue buttonx . The Review Items in the Cart page is displayed.

To delete the associated patron from an order line

1. On the Review Items in the Cart page, locate the order line item for which you want to delete
the associated patron.

2. Click the item additional buttonx in the order line. The system displays the Enter Addi-
tional Information page with the associated customer selected.

3. In the Associated Customer field, click the delete buttonx . The system redisplays the
Enter Additional Information page with the associated patron removed.

Using Will Call Patrons

You can allocate any item in an order to another patron for pickup at will call, besides the primary
patron who is paying for the order. For example, the primary patron may be ordering the tickets as
a gift for another patron and want that patron to be able to pick up the tickets at the event. You can
add, change, or delete a will call patron at any time until you check out of the shopping cart.

To add or change the will call patron

1. On the Review Items in the Cart page, locate the order line item for which you want to assign
a will call patron.

2. Click the item additional buttonx
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in the order line. The Enter Additional Information page is displayed.

3. In the Will Call Customer field of the Additional Details group, click the search buttonx .
The Search for Patron page is displayed.

4. Search for and select a patron. (For more information, see Searching for Patrons.) Depend-
ing on your configuration, the system displays either the Quick Patron Entry or the Full Pat-
ron version of the Enter Patron Information page.

Quick Patron Entry
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Full Patron

Note: You can also choose to create a new patron (customer) as the will call patron for the
order item.

5. Click the Continue with Purchase buttonx . The sys-
tem displays the Item Additional Details page with the selected patron in the Will Call Cus-
tomer field.
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6. Click the Continue buttonx . The Review Items in the Cart page is displayed.

To delete the will call patron

1. On the Review Items in the Cart page, locate the order line item for which you want to delete
the will call patron.

2. Click the item additional buttonx in the order line. The system displays the Enter Addi-
tional Information page with a Will Call Customer selected.

3. In the Will Call Customer field, click the delete buttonx . The system redisplays the Enter
Additional Information page with the will call patron removed.

4. Click the Continue buttonx . The Review Items in the Cart page is displayed.

Assigning Billing Plans to Order Items

Billing plans allow customers placing expensive orders (for example, season tickets) to pay for
them over time. While you are putting together an order in the shopping cart, you can specify any
configured billing plan for an order item. To assign a billing plan, the ticket manager must have con-
figured the item to include billing plans. You can only assign one billing plan per order item.

To assign a billing plan to an order item

Note: Depending on your configuration, the Billing Plan option may be displayed on the Review
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Items in the Cart page. If it is displayed on the page, select a billing plan from the list. You do
not need to use the procedure below.

1. On the Review Items in the Cart page, locate the order line item to which you want to
assign a billing plan.

2. In the item order line, click the item additional buttonx . The Enter Additional Inform-
ation page is displayed.

3. From the Billing Plan list in the Additional Details group, select the billing plan option.
4. Click the Continue button. The Review Items in the Cart page is displayed.
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Changing Delivery Methods in Item Sales
You must select a delivery method (mail, will call, magstripe ID, print at home, or print tickets) for
each order line item in the item sales shopping cart. The item sales cart will only allow one deliv-
ery charge for all the items that use the same delivery method, unless the items are from different
seasons. The system charges once for each different season for items with the same delivery
method.

To change the delivery method for an order line item in the shopping cart

1. In the item's Delivery Method list, change the method selection.

2. To update the delivery method charges for the shopping cart, click the Update button.

Changing Delivery Charge Details from the Cart
By accessing order charge details, you can enter the date that you received the charge. You make
this date different from the date on which the order was entered, if the difference is important for
the data account bookkeeping. You can also select one of the billing plans available for the season
for an order line item. A season's billing plans are configured and processed in tRes.

To change delivery method details from the shopping cart

1. In the Charge Summary group of the Review Items in the Cart page, click the Change
buttonx . The Review Charge Details page displays.
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2. In the Delivery Charge Details group, change the Order Date and Billing Plan as required.

3. Click the Continue buttonx . The Review Items in the Cart page is displayed.
Since Order Date and Billing Plan do not display on the Review Items in the Cart page, the
order line display will not change.

Releasing Seats in the Shopping Cart
After you have placed seats on hold (selected them) for an item, you can release them at any time
until you complete the order. When you release seats, the system changes their status to open and
allows other ticket operators to sell the seats. You must release or hold all seat blocks for an order
line item as a group, both within single events and across multiple item combo events.

Note: Using the seat map, you can release multiple seats by adjacent groups called seat blocks.
This allows you to release individual seat blocks within single events and across multiple item
combo events. The seat map only allows you to adjust the seatblocks for one order line at a time.
For more information, see Releasing Seats Using the Seat Map.

To release seats in the shopping cart

1. Go to the Review Items in the Cart page.

2. Locate the order line item that includes the seats, and then click the Release Seats button.

The system redisplays the Review Items in the Cart page with both the seats in the item's
Seatblock column and the Release Seats button removed.
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Deleting Items from the Shopping Cart
You can delete line items from the shopping cart at any time until you complete the order. When
you delete an allocatable item, the system changes the status of any held seats to open and allows
other ticket operators to sell them.

To delete an order line item from the shopping cart

1. Go to the Review Items in the Cart page.

2. In the order line of the item that you want to delete, click the Delete button.

The system redisplays the Review Items in the Cart page with the item order line removed
and the order total recalculated.

Using Delivery Methods in Item Sales
A delivery method is the way in which a ticket order is delivered, such as will call, mail, or FedEx.
Delivery method charges apply to the season with which they are grouped (see image below) and
are a one-time only charge for that order. The system will not automatically apply them to those
seasons in subsequent orders.
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Note: If a delivery method is configured with a cutoff date and that date has passed for a selected
event, the delivery method will not be displayed during the order process.

You are required to select a delivery method during the selling process. However, you can change
the delivery method once you reach the shopping cart. Depending on your configuration, you may
also be able to change the order date or add a billing plan of delivery charges. Use either of the fol-
lowing procedures:

l Changing Delivery Methods
l Changing Delivery Charge Details

Changing Delivery Methods in Item Sales
You must select a delivery method (mail, will call, magstripe ID, print at home, or print tickets) for
each order line item in the item sales shopping cart. The item sales cart will only allow one deliv-
ery charge for all the items that use the same delivery method, unless the items are from different
seasons. The system charges once for each different season for items with the same delivery
method.

To change the delivery method for an order line item in the shopping cart

1. In the item's Delivery Method list, change the method selection.

2. To update the delivery method charges for the shopping cart, click the Update button.
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Changing Delivery Charge Details from the Cart
By accessing order charge details, you can enter the date that you received the charge. You make
this date different from the date on which the order was entered, if the difference is important for
the data account bookkeeping. You can also select one of the billing plans available for the season
for an order line item. A season's billing plans are configured and processed in tRes.

To change delivery method details from the shopping cart

1. In the Charge Summary group of the Review Items in the Cart page, click the Change
buttonx . The Review Charge Details page displays.

2. In the Delivery Charge Details group, change the Order Date and Billing Plan as required.

3. Click the Continue buttonx . The Review Items in the Cart page is displayed.
Since Order Date and Billing Plan do not display on the Review Items in the Cart page, the
order line display will not change.

Using Order Charges
Order charges are the total handling or service charges for an order. You can use order charges to
represent any charge that is applied to every order. If configured, the system automatically adds
order charges to the ticket prices, discounts, surcharges, and delivery charges for the order. In the
Charge Summary group on the Review Items in the Cart page, they are grouped by season.

When using order charges, you can do the following:
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l Add Order Charges
l Change Order Charges
l Delete Order Charges

Adding Order Charges
Depending on your Paciolan configuration, you may be able to add order charges to a season, after
you have added a season event to the shopping cart. The system adds these charges only once for
each season, regardless of how many events you add to the cart from a season. Also, the order
charges you add to seasons in the cart are one-time charges for that order. The system will not
apply them to those seasons in subsequent orders.

To add an order charge to a season in the shopping cart

1. In the Charge Summary group on the Review Items in the Cart page, locate the group of
order charges for the season to which you want to add an order charge.

2. From the Order Charge list at the bottom of the season's order charge group, select the

order charge you want to add, and then click the add more buttonx .
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The system redisplays the Review Items in the Cart page with the selected order charge
added to the season's order charges and recalculates the order total.

Changing Order Charges
Depending on your Paciolan configuration, you may be able to change the amount of the order
charges for each season with items in the shopping cart. The charges apply to the season with
which they are grouped (see image below) and are a one-time only charge for that order. The sys-
tem will not automatically apply them to those seasons in subsequent orders.

By accessing order charge details, you can also enter the date that you received the charge. You
may choose to make this date different from the date on which the order was entered, if the dif-
ference is important for the data account bookkeeping.

Finally, with order charge details, you can select one of the billing plans available for the season
for an order line item. A season's billing plans are configured and processed in tRes.

To change the order charge amount only

1. In the Charge Summary group of the Review Items in the Cart page, locate the order charge
amount, and then change the amount.
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The order charge can be set up as either changeable or static. You cannot change a static
order charge amount.

2. Click the Update buttonx . The system redisplays the Review Items in the Cart page
with the changed order charge amount and the new order total.

To change the order charge details

Note: You must have access to the Order Charge Details page to change the order charge
details using this procedure.

1. In the Charge Summary group of the Review Items in the Cart page, click the Change
buttonx . The Review Charge Details page is displayed.
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2. In the Order Charge Details group, change the Order Date, Billing Plan, and Amount as
required.

Note: Changing the order charge amount here is the same as changing the amount in the
Charge Summary group on the Review Items in the Cart page.

3. Click the Continue buttonx . The system displays the Review Items in the
Cart page, reflecting the new order charge amount. (Order Date and Billing Plan do not dis-
play on the Review Items in the Cart page.)

Deleting Order Charges
Depending on your Paciolan configuration, you may be able to remove order charges from seasons
in the shopping cart. The system removes the order charges from the season with which they are
grouped (see image below). This is a one-time only change for the current order—the system will
redisplay the order charges for those seasons in subsequent orders.
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To delete an order charge from a season in the current order

1. In the Charge Summary group of the Review Items in the Cart page, locate the order charge,
and then click the adjacent Delete button.

The system redisplays the Review Items in the Cart page with the order charge removed
from the Charge Summary group.

Collecting Payment Information in Item Sales
Once you have set the item details and selected a patron for an order, you must collect payment
information before you can place the order. Customer payments can be cash, credit card, check,
gift certificate, gift card, or any other configured type. The system also allows multiple forms of
payment for order items. For instance, two couples want to sit together, but each wants to pay
their portion of the ticket charge. Depending on the settings in the current control, various pro-
cesses can occur after a sale is complete and prior to going to the next sale or exiting the sale pro-
cess.

When collecting payment information for an order, you must set the payment type and select an
order sale code. You can also do the following:

l Add payment types for an order.
l Select a payment distribution option.
l Select mailer/receipt printing options.
l Get the value of a gift certificate.
l Re-scan a gift certificate.
l Re-swipe a credit card.
l Use previous credit card numbers.
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Setting the Payment Type
Before you can accept a payment for an order, you must select the payment type for the order
items (unless full payment is not required and the customer decides not to make a payment.) Typ-
ical payment types include cash, credit card, check, and gift certificate. Your ticket manager con-
figures which payment types are accepted in item sales.

In addition, for some payment types, the required fields may differ depending on your Paciolan con-
figuration. For the check payment type, a document ID number may or may not be required. And,
for the credit card payment type, a CV# may be required.

To set order payment types

1. Add items to your shopping cart, and then click the Checkout buttonx . The
system may display the Search for Patron page.

However, if you have already selected a patron, the Enter Payment Information page will dis-
play instead.

2. If the Search for Patron page is displayed, do one of the following:

l Search for and select a patron.

l Click the Skip this Step buttonx to continue with the current pat-
ron.
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The Enter Payment Information page is displayed.

3. In the Payment group of the Enter Payment Information page, select a payment type from
the Payment Type list.

Depending on the payment type you select, the system will display the payment type's
required fields. Depending on the selected payment type, there may be some extra func-
tionality for you to use, including the following:

l For gift certificates, you can get the value or re-scan the certificate.
l For credit cards, you can re-swipe the card or get the customer's previously used credit
card information.

4. Enter values for the payment type's active fields.

5. In the Options group, make selections or enter customer information as required.
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The available options depend on your configuration, and may include one or more of the fol-
lowing:

l If there is a Sale Code list, select a sale code.

l If there Send Email Confirmation options, select one. You may be allowed to enter a new
email address.

l If there is magstripe information displayed, you may be able to enter or change the asso-
ciated magstripe credit card number.

l If you are using a print at home delivery method, you will be required to enter the cus-
tomer's print at home email address and phone number.

l If there are mailer/receipt options, select the options.
l If there is a Payment Distribution list, select a distribution option.

6. Enter any other payment information you need for the order, and then click the Place Order

buttonx . The Order Confirmation page is displayed.
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Selecting an Order Sale Code
Order sale codes are used to track the sales channels (for example, outlet or phone) through which
you place orders. Typically, your ticket manager only allows one channel. In this case, you cannot
choose another sale code because the sale code option is not displayed.

To select an order sale code

1. On the Collect Payment page, set the payment type. For more information, see Setting the
Payment Type.

2. In the Options group of the Enter Payment Information page, select a sale code from the
Sale Code list.

3. Enter any other payment information you need for the order, and then click the Place Order

buttonx . The Order Confirmation page is displayed.
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Adding Payment Types for an Order
If a customer wants to use multiple payment types to pay for an order, you can add payment types
one at a time. For example, a customer may want to use two different credit cards to pay for an
order.

You can use any number and combination of types of payment types. You must complete the
information for the first payment type before you can add another type. The system does not limit
the number of payment types you can use for an order.

To add a payment type row to an order

1. On the Enter Payment Information page, set the first payment type. For more inform-
ation, see Setting the Payment Type.

2. In the Payment group, click the Additional Payment buttonx .
The Enter Additional Payment page is displayed.
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3. Enter the required information for the payment type, and then click the Continue buttonx
. The system redisplays the Enter Payment Information page with the

new payment type added.

4. To add another payment type, click the Additional Payment button, and then complete the
Additional Payment page as in the previous steps.

5. Using the Sale Code list in the Options group, select a sale code for the order.

6. Enter any other payment information you need for the order, and then click the Place Order

buttonx . The Order Confirmation page is displayed.
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Selecting a Payment Distribution Option
This option defines, on a seasonal basis, how payments for the current order are distributed to the
back office (tRes). The system requires a value for this option but, most often, your ticket manager
configures the selling controls for only one. If only one option is configured, the system selects the
option automatically and this procedure is not applicable. If your ticket manager has set the apply
payment option to be changeable, you will be able to choose any one of the following:

l Do Not Distribute Current Payments
l Distribute Current Payments to Current Order
l Distribute All Undistributed Payments

To select a payment distribution option

1. In the Options group on the Enter Payment Information page, select an option from the Pay-
ment Distribution list. If only one option is configured, the system automatically selects the
option for you and does not display this list.

2. Enter any other payment information you need for the order, and then click the Place Order

buttonx . The Order Confirmation page is displayed.
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Printing Mailers & Receipts in Item Sales
Depending on the configuration of your selling control, you may be able to choose when to print
mailers and receipts for orders. Your ticket manager configures this option, as well as what is prin-
ted and when for the mailers and receipts. The configuration includes the types of printouts, as well
as how many copies of each type are printed. The configuration also includes the printer to which
the items are sent. For example, the system may be configured to print two copies of each credit
card receipt to a laser printer. The system configuration also determines your options for printing
to multiple payment types (paymodes), if you've added more than one to the order.

To select the mailer and receipt print options

1. In the Options group on the Enter Payment Information page, select a Mailer Option.

2. Select a Receipt Option.

3. Enter any other payment information you need for the order, and then click the Place Order

buttonx . The Order Confirmation page is displayed.
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Getting the Value of a Gift Certificate
When you collect payment information for a gift certificate payment type, you must get the value
of the gift certificate before you process the order by clicking the Place Order button. Your cus-
tomer may also want to know the remaining value of the certificate. The system allows you to get
the value of a gift certificate when you use it as a payment method for an order.

Note: If patrons do not use the full value of their gift certificates in an order, you will need to issue
a new certificate for the remaining amount. You do this by adding a gift certificate item to the order
and paying for it using the remaining value of the original gift certificate.

To get the value of a gift certificate

1. In the Payment group of the Enter Payment Information page, select Gift Certificate from the
Payment Type list.

Next to the Payment Type list, the system displays the fields specific to gift certificates.

2. To scan the gift certificate, insert your cursor in the Number field, and then scan the gift cer-
tificate or enter its number.
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3. Click the Get Value button. The system displays the gift certificate's value in the Amount
field.

4. Use the gift certificate as a payment type for the order, as required.
5. Set the sale code for the order.

6. Enter any other payment information you need for the order, and then click the Place Order

buttonx . The Order Confirmation page is displayed.

Re-Scanning a Gift Certificate
If you do not get a number when you first scan a gift certificate in item sales, you can scan the cer-
tificate again to check its validity. You may also re-scan a gift certificate to confirm its number. If
the re-scan does not produce a number, you can manually enter the gift certificate number to
check or use its value.
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To re-scan a gift certificate

1. In the Payment group of the Enter Payment Information page, select Gift Certificate from the
Payment Type list. Next to the Payment Type list, the system displays the fields specific to
gift certificates.

2. To scan the gift certificate, insert your cursor in the Number field, and then scan the gift cer-
tificate or enter its number.

3. Click the Re-Scan button. The system will clear the CC #/Doc ID/GC # field.

4. Click in the CC #/Doc ID/GC # field, and then swipe the gift certificate or enter its number.
5. Click the Get Value button. The system displays the gift certificate's value in the Amount
field.

6. Use the gift certificate as a payment type for the order, as required.
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Re-Swiping Credit Cards in Item Sales
If you get an invalid number error when you first swipe a credit card, you can swipe the card again
to check its validity. If the re-swipe does not produce a number, you can always manually enter
the credit card information.

To re-swipe a credit card

1. In the Payment group of the Enter Payment Information page, select a credit card payment
type (for example, Visa or MasterCard) from the Payment Type list. Next to the Payment
Type list, the system displays the fields specific to that credit card.

2. Insert your cursor in the CC Name field, and then swipe the credit card.

3. Click the Re-Swipe button. The system will clear the CC Name and CC #/Doc ID/GC # fields.

4. Click in the CC Name field, and then swipe the credit card. The system displays the credit
card's information in the other fields. If the system still does not validate the card, you can
manually enter its number in the CC #/Doc ID/GC # field.

5. Use the validated credit card as a payment type for the order, as required.
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Using Previous Credit Cards in Item Sales
To save time during order entry, you can select a patron's previously used credit card, instead of
entering a new one or the same one again. (You may not have access to this feature, depending on
your selling control configuration.) If the selected patron has used more than one credit card
before, you can select any one of the previously used credit cards. To protect the customer's credit
card information, the system only displays the last four digits of the card number (for example,
XXXXXXXXXXXX9215).

To pay with a previously used credit card

1. In the Payment group of the Enter Payment Information page, select a credit card payment
type (for example, Visa or MasterCard) from the Payment Type list. Next to the Payment
Type list, the system displays the fields specific to that credit card.

2. Click the Use Previous CC button.

The Select Credit Card page is displayed.

Note: The Use Previous CC button is enabled only if the patron has previously used a credit
card to pay for an order.
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3. Select a credit card, and then click the Continue buttonx . The system redis-
plays the Enter Payment Information page with the credit card's information in the Payment
group.

4. Use the selected credit card as a payment type for the order, as required.

Checking Out from the Shopping Cart
When you are finished adding a customer's order to the shopping cart, you will need to check out of
the cart to complete the order. Once the order is complete, the system stores the order inform-
ation in the database and processes the order (allocates tickets according to the delivery methods,
charges the customer's credit card, etc.).

Note: You can also Cancel an Order without processing it. Or, you can cancel the order imme-
diately following checkout.

To checkout from the shopping cart

1. On the Review Items in the Cart page, click the Checkout buttonx .

The system displays the Search for Patron page or the Enter Payment Information page.
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2. If the Search for Patron page is displayed, search for and select an individual patron or click

the Skip this Step buttonx . (For more information about selecting
individual patrons, see Searching for Patrons.) The system displays the Enter Payment
Information page.

3. On the Enter Payment Information page, select values for the Payment and Options groups,

and then click the Place Order buttonx . The Order Confirmation page is
displayed.

Canceling an Order
You can cancel the current order from any page in the selling flow (Onsale or General Sales tab) at
any time until you place the order. If you go to a different Paciolan tab (Inquiry, Adjustments, Pat-
ron, or Order Management), the system will also ask you to cancel the current order. (In addition,
you can cancel an order immediately following checkout.) When you cancel an order before placing
it, the system does not keep any record of the order.

To cancel the current order before placing the order

Do one of the following:

l At the bottom-left of the page, click the Cancel Order button.
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Click OK when the system displays a dialog box asking for confirmation of the cancellation.

l Click another Paciolan navigation tab (Order Management, Inquiry, Adjustments, or Patron).
Click OK when the system displays a dialog box asking for confirmation of the cancellation.

l In the Paciolan 7 menu, click Select, Log out, My Account, Reporting, or Admin.
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Click OK when the system displays a dialog box asking for confirmation of the cancellation.

After completing once of the above options, the system displays the Search for Item page with
the search results from which you selected the last item for the canceled order.

Placing an Order
You place an order to complete the selling process for that order. When you place the order, the
system validates the order information, including order item availability and credit card author-
ization. The system must check item availability because, although an item was available when
you added it to the shopping cart, the item may no longer be on sale.

When you place an order, the system automatically completes the following processes:

Credit Card Authorization

When you place an order using a credit card, the system checks for authorization before validating
any other order information. If a credit card fails authorization, the system redisplays the Enter
Payment Information page and prompts you to enter new credit card information. If credit card
authorization is successful, the system sends the credit card information to the back office (tRes)
for processing.

Note: If credit card authorization fails, the system redisplays Enter Payment Information page
with an error and the credit card information in editable form. You can fix the cause of the error by
editing the information. Depending on the situation, you may need to reduce or eliminate the
amount billed to the credit card. Or, you may need to call the issuing bank for a pre-authorization
code.

If tRes can process the credit card information, the system displays the Order Confirmation page.
If tRes is unable to process the information, the system displays the same page, except with a sys-
tem error that contains troubleshooting information for tRes. (For example, a file is locked, and the
message directs you to unlock the file.) Once the Order Confirmation page is displayed, however,
the system has already accepted the credit card information, and you cannot remove the card
information from the system. You can, however, cancel the order.
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Item Printing

When you place an order, the system will automatically open a new window that shows the print
queue for all configured printable items. Configured printable items include mailers, receipts, tick-
ets, and non-allocatables (for example, a donation receipt or parking pass).

Note: If the system does not display the print queue window when you place an order, you may
have popup blocking enabled for your browser. If you need to see the print queue window, turn off
popup blocking.

Order Confirmation Page Display

The Order Confirmation page displays a summary of the order you just placed, including how much
the customer paid, what payment types you used, and how much change you gave the customer.
For each placed order, Pac7 assigns a unique order number. Typically, you will give customers the
number, so that they can assist you with locating the order if they have questions about it later.

The Order # contains two parts: The first part is the order number in Paciolan (none in tRes), and
the second part (after the dash) is the patron #. There is no equivalent to the Order # in the back
office (tRes), because tRes tracks orders by season instead of unique number.

If you need more detailed information about the order, you can click the item additional buttonx
to display the Additional Information page. If an order contains combo items, they have event
details links to go to view-only details of each event in the combo.

From the Order Confirmation page, you can also do the following:

l Cancel the order you just placed.
l Reprint the items that the ticket manager has configured to print.

l Begin selling another order.

You can choose between selling for the event in the completed order and selling a different
item. Once you place the order, you can choose to place another order for the same event or
return to the item group/item list page for the same control. The previous order and cus-
tomer information is no longer part of the session.

On the Order Confirmation page, click the Next Sale button. The system displays the Select
Onsale Items and Seats page or the Search for Item page, depending on whether you are
using the Onsale or General Sales tab. Start selling the next order.

l Select another policy. If you are finished selling in the current data account, you can switch
to another data account to resume selling.

a. In the Pac7 menu, click the Select link.
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Pac7 displays the Select a Data Account page.

b. Under the data account for which you want to sell, click the link for the desired poli-
cy/selling control. The system displays the default page configured in the control.

To place an order

1. On the Enter Payment Information page, click the Place Order buttonx .

If the order information is valid, the Order Confirmation page is displayed. If not all the
information is valid, the system redisplays the Collect Payment page, with messages detail-
ing what information is missing or invalid.
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2. If there are problems with the order information, fix the problems, and then click the Place
Order button. The Order Confirmation page is displayed.

Reprinting Order Items
If you have problems printing items (for example, the printer jams or is out of stock), you can fix
the problem and reprint the last order you placed. The reprint is only available for items (including
allocatable, non-allocatable, receipt, or mailer) that were configured for printing when you placed
the order. Your ticket manager may limit access to this feature with password protection.

This function allows you to reprint any combination of printable items, including mailers, receipts,
tickets, and non-allocatables (for example, a donation receipt or parking pass). After you reprint
order items, the system redisplays the same version of the Order Confirmation page. You can
reprint the order as many times as needed.

To reprint order items

1. On the Order Confirmation page, click the Reprint button.

If configured for password protection, the system displays the Password Verification page.
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Otherwise, the Select Items to Reprint page displays.

2. If you are on the Password Verification page, enter the password, and then click the Continue
button. The Select Items to Reprint page displays.

3. On the Select Items to Reprint page, select the items you want to reprint, and then click the
Reprint button. The system displays a new window with print queue status. When printing is
complete, the system closes the print queue status window and redisplays the Order Con-
firmation page.

Voiding the Last Order in Item Sales
Note: Voiding during item sales and order management are not equivalent. For information about
voids in order management, see Voiding Order Lines in Order Management.

Depending on your Paciolan configuration, you may be able to void the last order you placed
through the onsale, general sales, or promotion sales paths. If your configuration allows voiding
orders, you may be required to enter a password to complete the process. You may want to void
the last order if you were using it to test the system or if you allow customers change their placed
orders.

Voiding orders reverses credit card and gift certificate payments, and returns sold seats to open
status. Once you have voided an order, the order number that the system originally assigned to it
is obsolete. However, the system records the sale and the order voiding for reporting purposes.

To void the last order

1. On the Order Confirmation page, click the Void this Order button.

Your browser prompts you to confirm voiding the order.
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2. Click OK at the prompt. If configured for password protection, they system displays the Pass-
word Verification page. Otherwise, the Order Void Confirmation page is displayed.

Note: If the item you are trying to void is open in the back office (tRes), the system will dis-
play an error on the Order Confirmation page. Contact your ticket manager for further assist-
ance.

3. If you are on the Password Verification page, enter the password, and then click the Continue
button. The Order Void Confirmation page is displayed.

4. Do either of the following:

l Begin selling another order. You can choose between selling for the event in the com-
pleted order and selling a different item. Once you place the order, you can choose to
place another order for the same event or return to the item group/item list page for the
same control. The previous order and customer information is no longer part of the ses-
sion.

On the Order Confirmation page, click the Next Sale button. The system displays the
Select Onsale Items and Seats page or the Search for Item page, depending on whether
you are using the Onsale or General Sales tab. If the Search for Item page is displayed,
the system displays the search results from which you selected the last item for the
voided order. Start selling the next order.

l Select another policy. If you are finished selling in the current data account, you can
switch to another data account to resume selling:

i. In the Paciolan menu, click the Select link.
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The system displays the Select a Data Account page.

ii. Under the data account for which you want to sell, click the link for the desired policy.
The system displays the Select Onsale Items and Seats page of the Onsale tab.

Changing Batches
A batch is a record of item transactions collected over a period of time to store item sales and
returns data. Batch information is used for reconciling sales and reports. For example, during the
renewal cycle, customers typically have several batches of renewal forms to process. Cash man-
agement personnel create batches of forms, assign batch numbers, and run an adding machine
tape on each batch. They may also edit a batch after records have been added.

Batches can be used in two states: permanent or temporary. Permanent batches are set up in the
back office for each operator code in the selling control. These batches are used by the operators
assigned these codes until the batches are changed in the control, expire, or are changed auto-
matically by the system. The majority of sales and returns transactions are written to permanent
batches.

Note: The system only stops a user from continuing due to an invalid batch at the start of trans-
actions. If a batch becomes invalid between the start and the end of a transaction, a new batch is
automatically created and the transaction is written to the new batch.

A batch is considered temporary when you switch from the permanent batch to a new batch in the
Paciolan interface during the sales or returns processes. To switch to a temporary batch, your
assigned operator code must have Batch Change access set up in the back office (tRes).

To change a batch, do one of the following:
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l Change the permanent batch.
l Change to a temporary batch.

Changing a Permanent Batch
Note: This procedure only applies if your assigned operator code has unrestricted batch per-
missions set up in the back office (tRes) and the selling control is not configured to automatically
create new batches. Otherwise, the system will automatically update the batch, alert you that the
batch has been updated, and display the new batch number.

You can change the permanent batch for sales and returns if an invalid batch is assigned when you
select your policy. At that point, you will be prompted by the display of the Select/Create Batch
page. You cannot initiate the change of a valid permanent batch in the Paciolan interface—a non-
expired permanent batch can only be changed to a new permanent batch in the back office. You
can, however, temporarily change the batch.

A batch expires when it has recorded the configured maximum number of item transactions or
when the configured expiration date arrives. If you select a policy with your operator code's
assigned batch already expired, the system will prompt you to change the batch. If your current
batch expires during selling, a new batch will automatically be created. The system also updates
the batch number in the control.

When the system displays the Select/Create Batch page, do one of the procedures below.

To change to an existing permanent batch

Note: This procedure is only required if the current batch has expired, the system is configured
to allow operator batch changes, and your assigned operator code has unrestricted batch cre-
ation permissions. If these conditions are not met, the system will create a batch automatically
or you will get an error message and not be able to continue without assistance from a ticket
manager.

1. On the Select/Create Batch page, click the Use Existing Batch link.

The system displays the Select Existing Batch page.

2. Do one of the following:

l If you know the number of the existing batch, select the Change Batch Number option,
enter the batch number in the adjacent text box, and then click the Continue buttonx

. The system redisplays the selling or returns page that you were on when
the batch expired.

l To select a batch from a list, select the Select from a List of Existing Batches option, and
then click the Continue buttonx . When the Select Existing Batch page
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displays, locate the batch you want to use in the Batch column, and then click the linked
batch name.

The system redisplays the selling or returns page you were on when the batch expired.

To change to a new permanent batch

Note: This procedure is only required if the current batch has expired, the system is configured
to allow operator batch changes, and your assigned operator code has unrestricted batch cre-
ation permissions. If these conditions are not met, the system will create a batch automatically
or you will get an error message and not be able to continue without assistance from the ticket
manager.

1. On the Select/Create Batch page, click the Create New Batch link.

The system displays the Create New Batch page.

2. In the Batch Name text box, enter the name of the new batch or leave the default name.

3. (Optional) In the Expires text box, enter an expiration date for the batch. The new batch will

expire at midnight on that date. You can also click the calendar buttonx to display the cal-
endar window, and then locate and select the expiration date. The system will enter the selec-
ted date in the Expires text box.
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4. Click the Create Batch buttonx . The system redisplays the Search
for Order to Return page with the new batch number.

Changing to a Temporary Batch
If the ticket manager has assigned batch change access to your operator code, you can change to a
temporary batch during the sales and returns processes. When you change batches, the system
treats the newly assigned batch as a temporary batch, regardless of whether the batch is per-
manent for you when using other policies (controls).

Note: You can only change to a different permanent batch from within the Paciolan interface when
the current permanent batch expires.

A common situation for changing batches is when a supervisor is returning items sold by a sub-
ordinate operator. In this case, the supervisor may change to the batch the subordinate used when
selling the items, so that the subordinate operator's batch balances for the day.

After you make a temporary batch change, the system will revert back to your original batch (as
defined by your selling control) when you log out, select a new policy, or manually change back to
the permanent batch.

You can change batches by doing any of the following:

To change to an existing temporary batch

1. Click the Adjustments tab.
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The system displays the Search for Orders to Return page or Password Verification page,
depending on your Paciolan configuration.

2. If the Password Verification page is displayed, enter your password, and then click the
Continue button. The system will then display the Search for Orders to Return page.

3. On the Search for Orders to Return page, click the Change Batch link.
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The system displays the Select/Create Batch page.

4. Click the Use Existing Batch link. The system displays the Select Existing Batch page.

5. To change to an existing batch if you already know the number, do the following:
a. Select the Change Batch Number option, and then enter the existing batch number in the
adjacent text box.

b. Click the Continue buttonx . The system redisplays the Search for Order
to Return page with the new batch number.

6. To choose a temporary batch from a list of existing batches, do the following:

7. Select the Select from a List of Existing Batches option, and then click the Continue buttonx
. The system displays the Select Existing Batch page.

a. Locate the batch you want to use in the Batch column, and then click the linked batch
name. The system redisplays the Search for Order to Return page with the new batch num-
ber.

Note: To get the batch number for an operator that does not have access to the return
items feature, have the operator click the Adjustments tab and give you the number from
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the Batch column of the Select Existing Batch group. Also, if you are temporarily changing
to an existing batch in selling, ask the operator to read the batch number from the batch
field in the upper right-hand corner of the page.

To change to a new temporary batch

1. Click the Adjustments tab.

The system displays the Search for Orders to Return page or Password Verification page,
depending on your Paciolan configuration.

Pac7 Release 7.2



User Guide  750

2. If the Password Verification page is displayed, enter your password, and then click the
Continue button. The system will then display the Search for Orders to Return page.

3. On the Search for Orders to Return page, click the Change Batch link.

The system displays the Select/Create Batch page.

4. Click the Create New Batch link. The Create New Batch page displays.

5. In the Batch Name text box, enter the name of the new batch or leave the default name.

6. (Optional) In the Expires text box, enter an expiration date for the batch. The new batch will

expire at midnight on that date. You can also click the calendar buttonx to display the cal-
endar window, and then locate and select the expiration date. The system will enter the selec-
ted date in the Expires text box.
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7. Click the Create Batch buttonx . The system redisplays the Search for
Order to Return page with the new batch number.

To change back to the permanent batch
1. Click the Adjustments tab.

The system displays the Search for Orders to Return page or Password Verification page,
depending on your Paciolan configuration.
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2. If the Password Verification page is displayed, enter your password, and then click the
Continue button. The system will then display the Search for Orders to Return page.

3. On the Search for Orders to Return page, click the Change Batch link.

The system displays the Select/Create Batch page.

4. Click the Use Existing Batch link. The Select Existing Batch page displays.
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5. To change the batch to the one that was assigned by the selling control, select the Change to
Original Batch: Batch Name option, and then click the Continue buttonx . The
system redisplays the Search for Order to Return page with the new batch number.
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Chapter 5 Order Inquiry

Note: Depending on the selling control used, the Inquiry tab may be disabled or password pro-
tected.

The Inquiry tab allows you to get information about orders placed by their patrons through Paciolan
systems. This feature also allows you to search for both complete or incomplete orders, and to
resend order confirmation email messages.

There are three types of searches for Paciolan order inquiry:

l Search Paciolan 7 only. This search type allows you to locate a patron’s Paciolan 7 orders by
transaction order number, as well as by patron information and item barcode. You can also
view additional information about items in the order by order line.

l Search all Paciolan systems. This search type locates orders from all sales channels (Paci-
olan 7, TK.SELL, and eVenue) by season. Because this search includes the back office, it will
always return the most up-to-date order information. Since it is a seasonal inquiry, however,
you cannot view additional information about order lines.

l Search for incomplete orders. This search type locates orders with unconfirmed customer
payments (usually caused by a record lock on an item or patron).

For information about using order inquiry features, see the following:

l Search for orders in Paciolan 7 only
l Search for orders in all Paciolan systems
l Search for incomplete orders
l Resend order confirmation email

Searching for Orders in Pac7 Only
Information about each Paciolan 7 transaction is stored with an order number. The Paciolan 7-only
search allows you to locate these transactions by their order numbers. (Since orders placed in
TK.SELL and eVenue are stored by season, they require a different search process.) You can also
search for Paciolan 7 orders using a patron name, patron ID, phone number, email address,
keyword, credit card number, magstripe ID, or item barcode.
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Once you locate an order, you can display the order details, including the order items, item details,
charge summary, contact information, payments, and delivery details. You can also view addi-
tional information about items in the order by order line. If the feature is enabled for your selling
control, you can resend the order confirmation email to the patron who placed the order.

Depending on your Paciolan configuration, your search may include orders from multiple business
accounts. However, you can only search for orders placed through Paciolan 7 for the current data
account. If you need to find orders from a different data account, you must switch data accounts by
doing the following:

1. In the Paciolan 7 menu, click the Select link.

The Select a Data Account page is displayed.

2. Locate the data account you want to search, and then click the data account name to display
its policies.

Pac7 Release 7.2
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3. Click the policy you want to use to find orders. The Item Sales tab is displayed.

To work more efficiently, use the following basic search techniques:

l For the quickest search times, use the Order #. If you are looking for all the orders from an
individual patron, the fastest searches are from the following search fields:

l Patron ID
l Last Name AND First Name
l Phone
l Credit Card #
l Email Address
l Magstripe ID

Note: If you want to search with keywords, ask your manager for the list of keywords your
data account uses for patron searches. Keywords are created and updated by the manager of
the data account. Many ticket managers use nicknames like SmithJ, for example, which
includes the first five letters of the patron's last name and first initial of the first name.

l The search page fields are not case-sensitive, and the default operation between the search
fields is AND. The only field in which you can use wildcards is the First Name field. Use the
asterisk (*) wildcard at the end of a partial first name to represent zero to many characters
when searching.

Note: To locate incomplete orders, you must use the search for incomplete orders process. The
Paciolan 7-only search and the search of all Paciolan systems only locate fully processed orders.

To search for orders in Paciolan 7 only

1. Click the Inquiry tab.
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Depending on your configuration, the system either displays the Password Verification page
or the Search for Orders page.

2. If the Password Verification page is displayed, enter your password, and then click the

Continue buttonx . The system then displays the Search for Orders page.

Note: When you search by patron or organization and the system does not find any orders, a
No Orders Found message is displayed on the Select an Order to View page. If this page
is displayed, click the Previous button to modify your search.

3. If you want to search using information other than the patron name or organization name, do
the following:
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a. In the Search Word text box, enter the patron or order information by which you want to
search.

b. For the Search By option, select the type of information you have entered (Order #, Pat-
ron ID, Phone, Email Address, Keyword, Credit Card #, Barcode, or Magstripe ID).

c. Click the Search button. If the patron has only one order that matches your search cri-
teria, the system displays the Order Details page.

If the patron has multiple orders, the Select an Order to View page is displayed.

d. If the Select an Order to View page is displayed, click an Order # to display the Order
Details page for that order.

4. To search for a patron by first and last name, do the following:

a. In the Last Name text box, enter the full Last Name.
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b. In the First Name text box, enter the full first name, or enter the beginning of the first
name, followed by an asterisk (*). A search with a partial first name will return all pat-
rons with the last name entered above and a first name that begins with the partial first
name. For example, D* will return the first names Dave, Denise, and Don.

c. Click the Search button. If there is only one patron with the name you entered, the system
displays the Order Details page or the Select an Order to View page .

If there are multiple patron matches, the system redisplays the Search for Orders page
with the patron search results.
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l If the Select an Order to View page is displayed, click an Order # to display the
Order Details page.

l If patron search results are displayed, click the linked ID number of the patron for
which you want to view order details. If the patron has only one order available to
view, the Order Details page is displayed. If the patron has multiple orders, the
Select an Order to View page is displayed. If the Select an Order to View page is
displayed, click an Order # to display the Order Details page.

5. To search for an organization, do the following:

a. In the Organization Name text box, enter the full organization name.

b. Click the Search button. If there is only one organization with the name you entered, the
system displays the Order Details page or the Select an Order to View page.
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If there are multiple organization matches, the system redisplays the Search for Orders
page with the organization search results.

l If the Select an Order to View page is displayed, click an Order # to display the
Order Details page.

l If organization search results are displayed, click the linked ID number of the organ-
ization for which you want to view order details. If the organization has only one order
available to view, the Order Details page is displayed. If the organization has mul-
tiple orders, the Select an Order to View page is displayed. If the Select an Order
to View page is displayed, click an Order # to display the Order Details page.

Searching for Orders in All Paciolan Systems
Orders placed through back office sales channels (TK.SELL and eVenue) are stored by season,
instead of by transaction as they are in Paciolan 7. For this reason, a seasonal search process is
required to locate these orders. This seasonal search allows you to access all of the orders that pat-
rons have placed for a specific season, not just their Paciolan 7 orders.

This seasonal search is also required to see changes have been made (by your organization or a dif-
ferent one) in the back office to an order that was originally placed through Paciolan 7. These back
office changes will not be reflected in the Paciolan 7-only search.

The information in a seasonal order inquiry does not include unique order numbers, because the
information is pulled directly from tRes. tRes tracks orders primarily by season (and also by date,
time, and item)—not by order number. To search for orders placed in Paciolan 7 by order number,
use the Paciolan 7-only search.

Note: To locate incomplete orders, you must use a special search process. Seasonal and Paciolan
7-only searches locate fully processed orders only.
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To search for an order in all systems

1. Click the Inquiry tab.

Depending on your configuration, the system either displays the Password Verification page
or the Search for Orders page.

2. If the Password Verification page is displayed, enter your password, and then click the

Continue buttonx . The system then displays the Search for Orders page.

3. Click the Search for Orders in All Systems link.

Pac7 Release 7.2



User Guide  763

The Search for Order in All Systems page is displayed.

Note: When you search by patron or organization and the system does not find any orders, a
No Orders Found message is displayed on the Select an Order to View page. If this page
is displayed, click the Previous button to modify your search.

4. To search using information other than the patron name or organization name, do the fol-
lowing:

a. In the Search Word text box, enter the patron information by which you want to search.
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b. For the Search By option, select the type of information you have entered (Patron ID,
Phone, Email Address, Keyword, Credit Card #, or Magstripe ID).

c. Click the Search button. The Select Season page is displayed.

d. In the Seasons drop-down list, select the season for which you want the patron's order

information, and then click the Display Order buttonx . The sys-
tem opens a new window and displays the Seasonal Search for Order report.

5. To search for a patron by first and last name, do the following:

a. In the Last Name text box, enter the full Last Name.
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b. In the First Name text box, enter the full first name, or enter the beginning of the first
name, followed by an asterisk (*). A search with a partial first name will return all pat-
rons with the last name entered above and a first name that begins with the partial first
name. For example, D* will return the first names Dave, Denise, and Don.

c. Click the Search button. If there is only one patron with the name you entered, the system
displays the Select Season page.

If there are multiple patron matches, the system redisplays the Search for Order in All
Seasons page with the patron search results.

d. If patron search results are displayed, click the linked ID number of the patron for which
you want to view order details. The Select Season page is displayed.

e. In the Seasons drop-down list, select the season for which you want the patron's order

information, and then click the Display Order buttonx . The sys-
tem opens a new window and displays the Seasonal Search for Order report.
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6. To search for an organization, do the following:

a. In the Organization Name text box, enter the full organization name.

b. Click the Search button. If there is only one organization with the name you entered, the
system displays the Select Season page.

If there are multiple organization matches, the system redisplays the Search for Order
in All Systems page with the organization search results.

c. If there are multiple organization matches, click the linked ID number of the organization
for which you want to view order details. The Select Season page is displayed.

d. In the Seasons drop-down list, select the season for which you want the patron's order

information, and then click the Display Order buttonx . The
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system opens a new window and displays the Seasonal Search for Order report.

Searching for Incomplete Orders
Orders are incomplete until customer payment is confirmed. Incomplete orders occur when you
attempt to place an order in item sales, but tRes does not accept the order. This is usually caused
by a record lock on an item or a patron. Order data will be unbalanced if orders are only partially
placed in tRes after a record lock stops order processing.

You can search for incomplete orders so that you can reconcile imbalances and data discrepancies
between sales reports in item sales and tRes. You can also view incomplete order data to see the
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order information as it was entered in item sales before being sent to tRes. The order in item sales
has the entire order information, when none or part of the order information was transferred to
tRes.

To search for incomplete orders

1. Click the Inquiry tab.

Depending on your configuration, the system either displays the Password Verification page
or the Search for Orders page.

2. If the Password Verification page is displayed, enter your password, and then click the

Continue buttonx . The system then displays the Search for Orders page.

3. Click the Search for Incomplete Orders link.

Pac7 Release 7.2



User Guide  769

The Search for Incomplete Orders page is displayed.

4. Do one of the following:

l In the Order # text box, enter the number of the incomplete order, and then click the
Search button. The Order Details page is displayed.

l In the From and To fields, enter the beginning and end dates of the period from which you
want to view incomplete orders, and then click the Search button. The search results are
displayed at the bottom of the page.
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Locate the incomplete order whose details you want to view, and then click the Order #
link. The Order Details page is displayed.

Resending Confirmation Email in Item Sales
Note: This feature is only available in item sales for orders placed through item sales—not
TK.SELL or eVenue.

Depending on your Paciolan configuration, the system will send order confirmation email messages
to the customer at order completion. The system also allows you to resend the order confirmation
later through the order process. You can resend order confirmations multiple times, and no record
of the confirmation email deliveries are kept.

If a required email address is not part of the patron record, you can add or edit the address during
the resend process, and the new or changed address will be added to the record. Order con-
firmation messages cannot be sent to house customers or for incomplete orders.

To resend an order confirmation email message

1. Locate the order using the Searching in Paciolan 7-Only procedure.

2. On the Order Details page , click the Email Order Confirmation link.

The system displays the Select Email to Send Order Confirmation page.

3. Do one of the following:

l If the email address to which you want to send the confirmation is listed in the upper
drop-down list, select the address from that list.
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l If the email address is not already listed, select the lower drop-down list option, choose
one of the address types from the list, and then enter or edit the address in the adjacent
text box.

The system will save the new or changed email address to the patron record.

4. Click the Send Email buttonx . The system redisplays the Order Details page
with a message that the order confirmation email has been sent.
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Chapter 6 Order Adjustments

After item sales orders have been placed, you can still make adjustments to them in Paciolan 7.
Adjustments include returning order items and processing will call order pickups. Processing order
returns requires locating and canceling order items, and then refunding the order item totals and
fees. Will call pickups are processed when patrons place orders to be picked up at will call and then
attempt to pick up the order items at the event facility.

All item sales post sale order adjustments are processed through the Adjustments tab.

For information about these processes, see the following topics:

l Returning Items
l Processing Will Call Pickups

Returning Item Sales Items
Note: This procedure is for returning items that were sold via the Paciolan Item Sales tab only.
Items sold in TK.SELL, order management, or eVenue can be returned in the back office (tRes). If
you do not have tRes access, see your ticket manager.

The purpose of the returns process is to allow operators to return and refund payments for items
that were originally purchased through Paciolan (browser-based) item sales. For different users,
access to the returns feature can be turned off entirely, restricted so that printed tickets must be
present to be returned, or set up to allow ticket returns with the customer or order information
only.

Item sales adjustments can also assist outlets with a return by allowing supervisors in a remote
support location to process returns for other users. Payments refunded through the Paciolan Adjust-
ments tab will then be reflected on item sales reports so that users at your outlets, remote phone
centers, and box office can balance at the end of the day.

This feature allows you to process returns for any item that was purchased through the Paciolan
Item Sales tab, including non-traditional miscellaneous item types (items with barcodes), items
without barcodes, and comp ticket items. Each of these items can be returned to both house cus-
tomers and individual patrons. Item returns are subject to the following rules:

l If the return quantity is less than the order quantity for reserved ticket items (single and
combo), the operator will be required to specify the seats to be canceled.

l For a combo item, the operator must select the return quantity of seats to cancel from each
event in the combo. You cannot return seats from just one event out of a combo in Paciolan
item sales — this can only be done through the Paciolan Order Management tab or TK.SELL in
tRes.
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l Only items defined as returnable in the back office item setup can be returned.
l Items can be returned if they have been partially paid for or not paid for at all. If they are
not paid for, no refund is allowed. If they are partially paid, partial refunds are allowed.

l The system will not allow ticket items to be returned if they have already been scanned for
entrance to an event.

Tip: Only orders that were originally placed through Paciolan Item Sales tab can be returned
through the Paciolan Adjustments tab. If you cannot find an order by searching through the returns
process, you can search all Paciolan systems for the order using order inquiry. If you locate the
order by searching all systems and it is still available to be returned, you will need to contact your
supervisor to process the return through tRes.

The return process includes searching for the order, canceling the sale of items in the order, and
refunding item payment. The search criteria may be restricted to allow you to search for orders by
barcode only, or you may be able to locate the order by entering an order number, patron ID,
phone number, email address, patron keyword, credit card number, item barcode, or magstripe
ID. When canceling the sale of an item, you may also be allowed to choose whether to return the
item fees and order charges. Once the total refund amount has been calculated by selecting the
items and fees to cancel, payment can be refunded to one or more paymodes. Depending on your
Paciolan configuration, item return functionality may include the following:

l Passwords required to access Return Items tab.
l Search criteria limited to barcodes only.
l Order and item charge cancellations allowed. Cancellations can also be made automatic.
l Processing returns for another user.
l Refunds to more than one paymode (for example, Visa and cash).

The system records the return transaction to a batch. By default, the batch will be the operator’s
current batch as defined in the selling control. However, the system also allows you to temporarily
change to a new or existing batch.

During the return process, the system will display the details of the original orders, including cus-
tomer information, order dates, order totals, and payments on orders summarized by paymode
and amount. When viewing order details, note the following:

l The order information does not include any changes made in the back office (tRes).
l Only the latest information on the order will be displayed. If an item has already been
returned through the Adjustments tab, it will not display in the order details.

l If an item fee or order charge is returned, it will not display in the order details.
l If an item has been printed or processed, the date the item was printed or processed will be
displayed.

To return order items

1. Click the Adjustments tab.
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The system displays the Search for Orders to Return page or Password Verification
page, depending on your Paciolan configuration.

2. If the Password Verification page is displayed, enter your password, and then click the

Continue buttonx . The system then displays the Search for Orders to
Return page.

3. If the Search for Orders to Return page only includes the Barcode text box, enter a bar-
code from the order to be returned, and then click the Search button.
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The Select Items to Return page is displayed.

4. If the full version of the Search for Orders to Return page is displayed (see image
below), do one the following:

Note: When you search by patron or organization for orders to be returned, the system only
displays orders that are eligible for return. If the patron or organization has no items avail-
able for return, Pac7 displays a No Orders Found message on the Select Order to Return
page. If this page is displayed, click the Previous button and modify your search.

l Search using information other than the patron name or organization name.

i. In the Search Word text box, enter the information about the patron.
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ii. For the Search By option, select the type of information you have entered (Order #,
Patron ID, Phone, Email Address, Keyword, Credit Card #, Barcode, or Magstripe ID).

iii. Click the Search button. If the patron has only one order that is eligible for return, the
Select Items to Return page is displayed.

If the patron has multiple orders eligible for return, the Select Order to Return page is dis-
played.

iv. If the Select Order to Return page is displayed, locate the order for which you are
processing the return, and then click the order number in the Order # column. The
Select Items to Return page displays.

l To search for a patron by first and last name, do the following:

i. In the Last Name text box, enter the full Last Name.
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ii. In the First Name text box, enter the full first name, or enter the beginning of the
first name, followed by an asterisk (*). A search with a partial first name will return all
patrons with the last name entered above and a first name that begins with the partial
first name. For example, D* will return Dave, Denise, and Don.

iii. Click the Search button. If there is only one patron with the name you entered, the
Select Order to Return page is displayed.

If there are multiple matches, the system redisplays the Search for Orders to Return page with
the patron search results.

iv. If patron search results are displayed, click the linked ID number of the patron for
which you want to process the return. If the patron has only one order that is eligible
for return, the Select Items to Return page is displayed.
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If the patron has multiple orders eligible for return, the Select Order to Return page is dis-
played.

v. If the Select Order to Return page is displayed, locate the order for which you are
processing the return, and then click the order number in the Order # column. The
Select Items to Return page is displayed.

l To search for an organization, do the following:

i. In the Organization Name text box, enter the full organization name.

ii. Click the Search button. If there is only one organization with the name you entered,
the Select Items to Pickup page is displayed.
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If there are multiple matches, the system redisplays the Search for Order to Pickup page with
the search results.

iii. If search results are displayed, click the linked ID number of the organization for
which you want to process the return. If the organization has only one order that is eli-
gible for return, the Select Items to Return page is displayed.
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If the organization has multiple orders eligible for return, the system displays the Select Order to
Return page.

iv. If the Select Order to Return page is displayed, locate the order for which you are
processing the return, and then click the order number in the Order # column. The
Select Items to Return page is displayed.

5. On the Select Items to Return page, enter the quantity to be returned in the Return Qty

text boxes of the order items, and then click the Continue buttonx .

The Select Fees to Return page is displayed.
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Note: If you enter a return quantity that is less than the order quantity for a reserved seat
item, the system will display the Select Seats to Return page, before displaying the
Select Fees to Return page. In the Seats Available to Return group on this page, select
seats in the Seat column equal to the return quantity.

Note: If the reserved seat item is a combo, select seats equal to the return quantity for each
event that is included in the item. If all events within the same facility have the same seats,
you can use the facility view to select the seats to return within each facility. This is a faster
way to select the seats to return if you have a combo with many events.
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6. In the Fee column, select the fees that you want to return to the patron, and then click the
Continue button.

The Summary of Items to Return page is displayed.
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Tip: Using the Summary of Items to Return page, you can edit the items and fees in the
return by clicking the edit icon.

7. Verify that the return items and fees are what the patron has requested, and then click the
Continue button. The Enter Refund Payment page is displayed.

Tip: The Payment History group identifies the paymode on the original order. You can use
this paymode information to verify with the customer that the paymode to which you are
refunding is correct.

8. In the Refund Payment group, enter the information required to credit the refund to the pat-
ron. The available payment types (for example, Visa or cash) will vary, depending on your
Paciolan configuration.
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9. In the Options group, set the payment options as required. The available options will vary,
depending on your Paciolan configuration.

Note: The sales codes listed are setup by your supervisor to track the sales channel for the
return. If the sales code you need is not listed, contact your supervisor for assistance.

10. Click the Process Return buttonx . The Return Confirmation
page is displayed.

Note: The return may not be successful if the order has been modified through another sales
channel (TK.SELL, eVenue, or TMP). If the return fails, contact your supervisor to have it pro-
cessed in tRes.

Changing to a Temporary Batch
If the ticket manager has assigned batch change access to your operator code, you can change to a
temporary batch during the sales and returns processes. When you change batches, the system
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treats the newly assigned batch as a temporary batch, regardless of whether the batch is per-
manent for you when using other policies (controls).

Note: You can only change to a different permanent batch from within the Paciolan interface when
the current permanent batch expires.

A common situation for changing batches is when a supervisor is returning items sold by a sub-
ordinate operator. In this case, the supervisor may change to the batch the subordinate used when
selling the items, so that the subordinate operator's batch balances for the day.

After you make a temporary batch change, the system will revert back to your original batch (as
defined by your selling control) when you log out, select a new policy, or manually change back to
the permanent batch.

You can change batches by doing any of the following:

To change to an existing temporary batch

1. Click the Adjustments tab.

The system displays the Search for Orders to Return page or Password Verification page,
depending on your Paciolan configuration.
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2. If the Password Verification page is displayed, enter your password, and then click the
Continue button. The system will then display the Search for Orders to Return page.

3. On the Search for Orders to Return page, click the Change Batch link.

The system displays the Select/Create Batch page.

4. Click the Use Existing Batch link. The system displays the Select Existing Batch page.

5. To change to an existing batch if you already know the number, do the following:
a. Select the Change Batch Number option, and then enter the existing batch number in the
adjacent text box.

b. Click the Continue buttonx . The system redisplays the Search for Order
to Return page with the new batch number.

6. To choose a temporary batch from a list of existing batches, do the following:

7. Select the Select from a List of Existing Batches option, and then click the Continue buttonx
. The system displays the Select Existing Batch page.

Pac7 Release 7.2



User Guide  787

a. Locate the batch you want to use in the Batch column, and then click the linked batch
name. The system redisplays the Search for Order to Return page with the new batch num-
ber.

Note: To get the batch number for an operator that does not have access to the return
items feature, have the operator click the Adjustments tab and give you the number from
the Batch column of the Select Existing Batch group. Also, if you are temporarily changing
to an existing batch in selling, ask the operator to read the batch number from the batch
field in the upper right-hand corner of the page.

To change to a new temporary batch

1. Click the Adjustments tab.

The system displays the Search for Orders to Return page or Password Verification page,
depending on your Paciolan configuration.
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2. If the Password Verification page is displayed, enter your password, and then click the
Continue button. The system will then display the Search for Orders to Return page.

3. On the Search for Orders to Return page, click the Change Batch link.

The system displays the Select/Create Batch page.

4. Click the Create New Batch link. The Create New Batch page displays.
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5. In the Batch Name text box, enter the name of the new batch or leave the default name.

6. (Optional) In the Expires text box, enter an expiration date for the batch. The new batch will

expire at midnight on that date. You can also click the calendar buttonx to display the cal-
endar window, and then locate and select the expiration date. The system will enter the selec-
ted date in the Expires text box.

7. Click the Create Batch buttonx . The system redisplays the Search for
Order to Return page with the new batch number.

To change back to the permanent batch
1. Click the Adjustments tab.
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The system displays the Search for Orders to Return page or Password Verification page,
depending on your Paciolan configuration.

2. If the Password Verification page is displayed, enter your password, and then click the
Continue button. The system will then display the Search for Orders to Return page.

3. On the Search for Orders to Return page, click the Change Batch link.
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The system displays the Select/Create Batch page.

4. Click the Use Existing Batch link. The Select Existing Batch page displays.

5. To change the batch to the one that was assigned by the selling control, select the Change to
Original Batch: Batch Name option, and then click the Continue buttonx . The
system redisplays the Search for Order to Return page with the new batch number.

Processing a Return for Another User
If this feature is enabled in the current selling control, users (usually managers) are allowed to
assign alternate user information to themselves while returning items. This may be done so that
the cash card of another user (usually a subordinate operator) can be adjusted to include the return
transaction. In this case, the transaction will not appear on the manager's cash card.

Users that are not allowed to return items can still be assigned as alternate users. However, to be
assigned as alternates, they must be active users.

Note: Information about alternate user transactions, including who processed the return as
another user, is included on the BOCA Sales Summary and Return Authorization reports. The altern-
ate user attribute is not available in the back office, so tRes reports will not differentiate between
alternate user and normal operator return transactions.

To process a return for another user

1. Click the Adjustments tab.
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The system displays the Search for Orders to Return page or Password Verification
page, depending on your Paciolan configuration.

2. If the Password Verification page is displayed, enter your password, and then click the

Continue buttonx . The system then displays the Search for Orders to
Return page.

3. Click the Process a Return for Another User link. The Search for User to Assign Return
page is displayed.

Tip: The fastest way to assign the return to an alternate user is by entering the User ID. You
can get User IDs from subordinate operators by having them log in to Paciolan, click the
Adjustments tab, and locate the number in the User ID field.
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4. To search for the alternate user by given name or user name, do the following:

5. If you have a drop-down list for the Business Organization option, select the business organ-
ization to which the user belongs.

Note: The list of business organizations is set by the configuration of the business
account. If a business organization you need is not listed, contact your supervisor to con-
firm the setup.

a. In the User Name, Last Name, or First Name text boxes, enter the name information by
which you want to search. If you only know the beginning of a name or are unsure of the
spelling, enter the beginning of the name followed by an asterisk. For example, you could
enter Mat* to find users with the name Matthew or Matt.

b. Click the Search button.
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If there is only one match for your search, the system displays the Search for Orders
to Return page with a Note specifying for whom the return will be processed.

If there are multiple matches, the system displays the search results at the bottom of the
Search for User to Assign Return page. Click the user's name in the Name column to
display the Search for Orders to Return page and process a return for that user.

6. To assign the alternate user by user ID, enter the number in the User ID text box, and then
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click the Assign User buttonx .

The system displays the Search for Orders to Return page with a Note specifying for
whom the return will be processed.

Note: To get the user ID for an operator that does not have access to return items, ask the
operator to click the Adjustments tab and locate the number in the User ID field.

7. Return the order items for the alternate user.

Processing Will Call Pickups
The purpose of the will call pickup process is to allow immediate printing of tickets for patrons at
the will call window. If tickets are already printed in bulk, you can not use the will call pickup pro-
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cess. Items purchased through any sales channel (Pac7, TK.SELL, eVenue, and TMP orders) can be
picked up using will call pickup.

Will call tickets are located by searching for the patron who is assigned to pickup the tickets. This
can either be the patron who ordered the tickets or a different patron who is assigned on the order
to pick up the tickets. All items eligible for that patron will be available for pickup.

Note: Order numbers are not used to locate orders because TK.SELL, eVenue, and TMP orders can
also be picked up, and orders placed in those system are not assigned order numbers.

Depending on your Paciolan configuration, combo and miscellaneous items may be eligible for will
call pickup, in addition to single event tickets. You may also limit eligibility to nonrenewable items.
Gift certificates and access passes are not eligible for will call pickup. Whether items with different
dispositions are available for pickup also depends on your Paciolan configuration.

Immediately after printing will call items, you can begin processing another will call pickup.
Depending on your Paciolan configuration, you may also be able to reprint the items or void the
printing. Accessing the reprint and void functions may require a password.

If tickets that should be available for will call pickup are not available, make sure of the following:

l The tickets have not already been printed. Tickets that have already been printed cannot be
printed again through the will call pickup process.

l The season from which the will call items were purchased is accessible in the item sales con-
trol. Items purchased in TK.SELL, eVenue, or TMP orders will not be available if the season
from which the will call items were purchased is not available in the item sales control.

l The patron does not have a balance due on the season from which the will call items were
purchased. If patrons have a balance due on their order, then tickets will not be available to
pick up. To confirm why a patron's tickets are not available for pickup, check the patron's
order for the season from which the tickets were purchased for a balance due on the account.
The balance will need to be paid to pick up tickets from that season.

To process a will call pickup

1. Click the Adjustments tab, and then click the Will Call Pickup tab.

The Search for Order to Pickup page is displayed.
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2. Find the patron or organization who is picking up the tickets by doing one of the following:

Note: If the patron has no items available for pickup, the system displays a message on the
Select Items to Pickup page.

l To search using information other than the patron or organization name, do the following:

i. In the Search Word text box, enter the information about the patron.

ii. For the Search By option, select the type of information you have entered (Patron ID,
Phone, Magstripe ID, Barcode, Keyword, or Email address).

iii. Click the associated Search button. If there is only one patron that matches your
search criteria, the Select Items to Pickup page is displayed.
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If there are multiple matches, the system redisplays the Search for Order to Pickup page with
the search results.

l To search for a patron by first and last name, do the following:

i. In the Last Name text box, enter the full Last Name.

ii. In the First Name text box, enter the full first name, or enter the beginning of the first
name, followed by an asterisk (*). A search with a partial first name will return all pat-
rons with the last name entered above and a first name that begins with the partial
first name. For example, D* will return Dave, Denise, and Don.
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iii. Click the Search button. If there is only one patron with the name you entered, the
Select Items to Pickup page is displayed.

If there are multiple matches, the system redisplays the Search for Order to Pickup page with
the search results.

l To search for an organization, do the following:

i. In the Organization Name text box, enter the full organization name.

Pac7 Release 7.2



User Guide  800

ii. Click the Search button. If there is only one organization with the name you entered,
the Select Items to Pickup page is displayed.

If there are multiple matches, the system redisplays the Search for Order to Pickup page with
the search results.
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3. On the Select Items to Pickup page, make sure that the contact information matches the
patron you have selected, select the line items you want to print for the patron, and then

click the Print buttonx .

The system prints the line items and then displays the Pickup Confirmation page. If
enabled in your item sales control, mailers may be printed automatically.
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Tip: To void the printing of the will call items, click the Void this Print button and then, when
the confirmation dialog is displayed, click OK. The Pickup Void Confirmation page is dis-
played. However, depending on your Paciolan configuration, the Void this Print button may
not be available.
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Chapter 7 Working with Patrons

Note: Depending on the type and configuration of the control you use to access the Paciolan soft-
ware, your access to patron and item sales functionality will differ. If you are using a patron man-
agement control, you will have access to patron functionality but not to selling. If you are using a
selling control, you will have access to selling functionality, and you may have access to all or none
of the patron functionality. See your ticket manager for more information.

Paciolan patron functionality allows you to capture and maintain extensive ticket-buying and fund
development patron data. Patrons include both organizations and individual customers, and the sys-
tem treats these records similarly. Once patron data is entered, it can be searched to locate pat-
rons during the ticket selling, order inquiry, and order adjustment processes.

When working with patrons, you can do the following:

l Search for patrons
l Create patrons
l Edit patrons
l Tag patrons
l Display recent patrons

Searching for Patrons on the Patron Tab
If you need to edit or reference data about a patron outside of item sales and order management,
you can locate the patron using the search for patron function on the Patron tab. You can also cre-
ate a new patron record on the tab, but you should first use the search function to make sure the
patron does not already exist (this may be required by your configuration).

Tip: For the quickest search time, use the Patron ID. Otherwise, the fastest searches are from
using search criteria that are likely to yield single results are Patron ID, Phone, Magstripe ID, Bar-
code, Keyword, Email Address, and Credit Card #.

If you want to search with keywords, ask your ticket manager for the list of keywords your data
account uses for patron searches. Keywords are created and managed by the ticket manager of the
data account. For example, many ticket managers use keywords like SmithJ, which includes the
first five letters of the patron's last name and first initial of the first name.

Search page entries are not case-sensitive. The only criteria for which you can use wildcards is
First Name. Use the asterisk (*) wildcard at the end of the first name text you enter to represent
zero to many characters when you are searching by patron name.

To search for patrons

1. Click the Patron tab.
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The Search for Patron page is displayed.

2. To search using information other than the patron name or organization name, do the fol-
lowing:

a. In the Search Word text box, enter the patron information by which you want to search.

b. For the Search By option, select the type of information you have entered (Patron ID,
Phone, Magstripe ID, Barcode, Keyword, Email Address, or Credit Card #).

c. Click the Search button. The Enter Patron Information page is displayed. For information
about using this page, see Editing Patrons.
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3. To search for a patron by first and last name, do the following:

a. In the Last Name text box, enter the full Last Name.

b. In the First Name text box, enter the full first name, or enter the beginning of the first
name followed by an asterisk (*). A search with a partial first name will return all patrons
with the last name entered above and a first name that begins with the partial first name.
For example, D* will return the first names Dave, Denise, and Don.

c. Click the Search button. If there is only one patron with the name you entered, the Enter
Patron Information page is displayed.

If there are multiple patron matches, the system redisplays the Search for Patron page
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with the search results.

d. If search results are displayed, click the linked ID number of the patron you want to view.
The Enter Patron Information page is displayed.

e. If required, edit the patron information on the Enter Patron Information page.
4. To search for an organization, do the following:

a. In the Organization Name text box, enter the full organization name.

b. Click the Search button. If there is only one organization with the name you entered, the
Enter Patron Information page is displayed.
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If there are multiple organization matches, the system redisplays the Search for Patron
page with the search results.

c. If search results are displayed, click the linked ID number of the organization you want to
view. The Enter Patron Information page is displayed.

d. If required, edit the patron information on the Enter Patron Information page.

Note: If you cannot find a patron, click the Create a New Patron button
, and then fill out the patron information to submit a new patron

into the system. For more information, see Creating Patrons.

Creating Patrons on the Patron Tab
You can create new patrons during item sales, during order management, and from the Patron tab,
depending on the patron access settings in your control. This topic describes creating patrons on
the Patron tab. Patrons can be either organizations or individual customers. Both are created using
the same basic functionality.

When you create patrons on the Patron tab, you will be required to search the patron database for
duplicates first if your patron policy is configured for duplicate name checking. Your box office man-
ager may choose to disable duplicate checking if you need to create multiple patrons and you are
sure none of the new patrons already have a patron record.

Creating patrons outside the selling process always gives you access to full patron entry. Creating
patrons during the selling process may not give you access to full patron entry, depending on your
system configuration.
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To create a patron outside the selling process

1. Click the Patron tab.

The Search for Patron page is displayed. If you are not sure the patron you want to enter is
new, search for the patron on this page.

2. Click the Create a New Patron buttonx . (If the button is not
displayed on this page, you are required to search for the patron first. Once you attempt a
search, the button will be displayed.) The Enter Patron Information page is displayed.

3. On the Home tab of the Enter Patron Information page, enter or select values for all required
fields. The system displays an asterisk (*) in front of the name of each required field.
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Normally, the system only requires fields in the Patron Information and Primary Patron
groups.

4. If you need to contact the patron whose record you are creating, you can send an email from
the Enter Patron Information page. To start a new email for the patron, select an address
from the email address drop-down list, and then click the Send Email buttonx

.

If the email address list is not displayed or the required address is not in the list, you can add
email addresses to the patron record by doing the following:

a. Click the Home tab, and then locate the Phone/Email group.

b. In the Email section, enter the email address in the text box adjacent to the email type.

c. Click the Hold Updates buttonx . Pac7 redisplays the Enter Patron
Information page with the email address drop-down list.

5. On the Enter Patron Information page, enter information in the fields on one or more of the
patron record tabs, as required.
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Depending on your selling control, some tabs and data fields may not be displayed. Some
fields allow you to enter more than one value (multi-value fields).

Use these multi-value fields as follows:

l For a multi-value text box, enter text in the text box, and then click the add more buttonx

.

The system adds a text box below the original one, allowing you to make another text
entry. You can repeat this process to add as many entries as required.

l For a multi-value drop-down list, select an option from the drop-down list, and then click

the add more buttonx .

The system displays your selection in static text above the drop-down list, allowing you to
add another selection. You can repeat this process to add as many selections as required.
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l For a multi-value drop-down list with a text box, select an option from the drop-down list,

enter text in the adjacent text box, and then click the add more buttonx .

The system displays another line with a drop-down list and a text box, allowing you to
make an additional entry.

Note: To delete a multi-value line, click its delete buttonx . The system redisplays the
page with the line removed.

Note: If you enter information on a patron record tab and then click one of the other tabs
before saving the record, Pac7 will display a dialog box (for example, in Internet Explorer)
that requires you to either hold (temporarily save) or discard the information you entered.
To hold the information without getting this dialog box, click the Hold Updates buttonx

before you click another tab.

6. If you want to enter fund development information for a patron and you have the per-
missions, use the Development tab. If you have permissions and the tab is not displayed for
the patron, do the following:

a. Click the Home tab, and then select the Donor option.
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b. Click the Hold Updates buttonx , and then click the Development tab.
The system displays the Development tab.

7. If you want to enter ticketing information for a patron and you have the permissions, use the
Ticketing tab.

If the tab is not displayed for the patron, do the following:

a. Click the Home tab, and then select the Customer option.

b. Click the Hold Updates buttonx , and then click the Ticketing tab. The
system displays the Ticketing tab.
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8. If you want to enter organization information for a patron and you have the permissions, do
the following:

a. Click the Home tab, and then select the Organization patron type.

b. Enter the organization name, and then select the organization type.

c. Click the Hold Updates buttonx . The system adds the Organization
tab for the patron. You can now click the tab to display the organization data fields.
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d. Enter organization information as required.

9. Click the Save Record buttonx . Pac7 displays the Search for Patron page
with a message that includes the patron ID number and name.

Editing Patrons on the Patron Tab
You can edit patron records when additions or changes are required, if you have patron access.
Within the item sales and order management processes, the edit patron feature gives you access
to full patron data, including configurable ticketing and donor (fund development) tabs. However,
depending on the configuration of your control, you may also choose to edit a patron record by
going directly to the Patron tab.

To edit a patron record on the Patron tab, you must first locate the record using the Pac7 search
functionality. (If you cannot find the patron record, you can create a new patron instead.)

To edit a patron

1. Click the Patron tab.
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Pac7 displays the Search for Patron page.

2. Locate the patron you want to edit. For more information, see Searching for Patrons.

3. On the Home tab of the Enter Patron Information page, enter or select values for all required
fields. The system displays an asterisk (*) in front of the name of each required field.

Normally, the system only requires fields in the Patron Information and Primary Patron
groups.

4. If you need to contact the patron whose record you are editing, you can send an email from
the Enter Patron Information page. To start a new email for the patron, select an address
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from the email address drop-down list, and then click the Send Email buttonx

.

If the email address list is not displayed or the required address is not in the list, you can add
email addresses to the patron record by doing the following:

a. Click the Home tab, and then locate the Phone/Email group.

b. In the Email section, enter the email address in the text box adjacent to the email type.

c. Click the Hold Updates buttonx . Pac7 redisplays the Enter Patron
Information page with the email address drop-down list.

5. On the Enter Patron Information page, edit the fields on one or more of the patron record
tabs, as required.

Depending on your selling control, some tabs and data fields may not be displayed. Some
fields allow you to enter more than one value (multi-value fields).

Use these multi-value fields as follows:
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l For a multi-value text box, enter text in the text box, and then click the add more buttonx

.

The system adds a text box below the original one, allowing you to make another text
entry. You can repeat this process to add as many entries as required.

l For a multi-value drop-down list, select an option from the drop-down list, and then click

the add more buttonx .

The system displays your selection in static text above the drop-down list, allowing you to
add another selection. You can repeat this process to add as many selections as required.

l For a multi-value drop-down list with a text box, select an option from the drop-down list,

enter text in the adjacent text box, and then click the add more buttonx .

The system displays another line with a drop-down list and a text box, allowing you to
make an additional entry.

Note: To delete a multi-value line, click its delete buttonx . The system redisplays the
page with the line removed.

Note: If you enter information on a patron record tab and then click one of the other tabs
before saving the record, Pac7 will display a dialog box (for example, in Internet Explorer)
that requires you to either hold (temporarily save) or discard the information you entered.
To hold the information without getting this dialog box, click the Hold Updates buttonx

before you click another tab.
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6. If you want to enter fund development information for a patron and you have the per-
missions, use the Development tab. If you have permissions and the tab is not displayed for
the patron, do the following:

a. Click the Home tab, and then select the Donor option.

b. Click the Hold Updates buttonx , and then click the Development tab.
The system displays the Development tab.

7. If you want to enter ticketing information for a patron and you have the permissions, use the
Ticketing tab.

If the tab is not displayed for the patron, do the following:

a. Click the Home tab, and then select the Customer option.
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b. Click the Hold Updates buttonx , and then click the Ticketing tab. The
system displays the Ticketing tab.

8. If you want to enter organization information for a patron and you have the permissions, do
the following:

a. Click the Home tab, and then select the Organization patron type.

b. Enter the organization name, and then select the organization type.
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c. Click the Hold Updates buttonx . The system adds the Organization
tab for the patron. You can now click the tab to display the organization data fields.

d. Enter organization information as required.

9. Click the Save Record button. Pac7 displays the Search for Patron page.

Tagging Patron Records
The tag feature allows you to select a subset of patron records from your search results list, so that
you can view the selected records as a group. You can also tag records from a list of the 20 most
recently viewed patrons. Then, when you display your tagged records list, you can view or edit the
details of each of the patron records in the list.

To tag patron records from search results

1. Go to a patron record list by doing either of the following:

l Generate a search results list, using the search for patrons procedure.
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l Display the most recently accessed patron records, using the displaying recent patrons
procedure.

Note: When you tag patrons on either list, any patrons you have tagged on the other list
remain on the tag list. If you tag a patron record that is in both the search results and most
recent patrons lists, the record is automatically selected in both lists.

2. Select the patron records that you want to be in the tag list, and then click the Save buttonx
.

Pac7 Release 7.2



User Guide  822

Pac7 displays the View Tag List link.

When selecting (tagging) records, note the following:

l To select all the records on the results page, click the select all box under the Save but-
ton. If your results list has more than one page, this box only selects all on the current
page.

l If your search results list has more than one page, tagged patrons remain tagged when

you navigatex to a different page.
l You can also remove records from the tag list. To remove a record, clear the record selec-
tion box, and then click the Save button.

To view the tag list

Note: You cannot view the tag list until you have tagged (selected and saved) records to the
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list. The View Tag List link is not displayed.

1. Click the View Tag List link.

Pac7 displays the View Tag List page.

2. To view or edit the details of a patron record, click its ID number.

Pac7 displays the Enter Patron Information page. If you want to make changes to the record,
see Editing Patron Records.

To clear the tag list

You can clear the tag list by doing one of the following:
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l Deselect all the selected patron records, and then click the Save buttonx . This is unne-
cessary if you are running a new search, since the new search automatically clears the tag
list. If you deselect the selected patrons but do not click the Save button, the patron records
are not cleared from the tag list.

l Run a new search from the Search for Patron page.

l Leave the Patron tab by clicking the Order Management, Item Sales, Inquiry, or Adjustments
tab.

l Sign out of Pac7.

Displaying Recent Patrons
When you create, view, or edit a patron record, Pac7 adds the record to a list of up to 20 of the
most recently accessed records. To reduce the time it takes to access these records again, you can
access this list in a table of records that is linked to the detailed record of each patron. From this
list, you can also tag patron records. The list is cleared when you leave the Patron tab by clicking
the Selling, Inquiry, or Adjustments tab, or when you log out of Pac7.
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To display the most recently accessed patrons list

Note: You cannot display this list until you have accessed at least one patron record. Until then,
the Recall Last 20 Patrons link is not displayed.

1. Click the Recall Last 20 Patrons link.

Pac7 displays the Recall Last 20 Patrons page.

2. To view or edit the details of a patron record, click its ID number.
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Pac7 displays the Enter Patron Information page. See information about editing patron
records.

3. To tag patron records, select them, and then click the Save buttonx . See more inform-
ation about tagging patron records.
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Chapter 8 Reporting

The following reports are included with Pac7:

l BOCA sales summary report (Generating the BOCA Sales Summary Report)
l Sales summary reports (Generating Sales Summary Reports)
l Detailed transaction report by batch (Generating a Detailed Transaction Report by Batch)
l Balancing report by item fee (Generating a Balancing Report by Item Fee)

Tip: For the BOCA sales summary report, you can create views to control the content that prints
for users by associating the views with user roles (usually assigned by location). Views can elim-
inate the need for users to set up their reports each time they run them.

Note: The available reports vary according to your permissions. Contact your system admin-
istrator for more information.

Generating the BOCA Sales Summary Report
The BOCA sales summary report tracks daily ticket sales for a user or terminal. The report shows
the amount of daily sales broken down for each paymode (for example, Visa, Mastercard, or
Cash). This report can be printed to ticket stock or viewed using a Web browser. It is available
through the Pac7 menu and from the Order Management tab.

To generate a BOCA Sales Summary report from the Pac7 menu

1. In the Pac7 menu, click the Reporting link.

Pac7 displays the Reporting page.
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2. Click the BOCA Sales Summary Report link. Pac7 displays the BOCA Sales Summary Report
version of the Report Criteria page.

3. Set the date range for the report:

l In From, enter the beginning date and time of the date range for the report.
l In To, enter the ending date and time of the date range for the report.

Note: This report can only show results for a 24-hour time period.

4. For the Show All Sales criteria, select one of the following options:

l This User: Shows sales for the currently logged in user.
l This Terminal: Shows sales for the current terminal. This is useful to track sales if mul-
tiple users are selling from the same terminal.

5. If the view is selectable, select the view that you want to use to generate the report. For
more information, see Managing BOCA Sales Summary Report Views.
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6. In the File Format list, select one of the following formats for the report:

l HTML: Outputs the report in HTML and displays the report in a Web browser.
l Print to Ticket Stock: Prints the report on ticket stock.

Note: If you do not have access to a BOCA printer, you cannot print the report on ticket
stock. You can print to a laser printer instead, by selecting HTML in the File Format list. When
you run (generate) the report, Pac7 will display the report in your default Web browser (for
example, Internet Explorer). You can then print the report using the Web browser's Print com-
mand, usually located in the File menu.

7. Click the Run button. Pac7 generates the BOCA Sales Summary Report. Totals are adjusted
for voids and returns.

To generate a BOCA Sales Summary report from the Order Management tab

1. Click the Order Management tab.

2. Select the patron, and then select the season.

3. Click the Order actions button, and then select Print boca batch summary from the
drop-down list.
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The BOCA Sales Summary Report form is displayed.

4. Set the date range for the report:

l In From, enter the beginning date and time of the date range for the report.
l In To, enter the ending date and time of the date range for the report.

Note: This report can only show results for a 24-hour time period.

5. For the Show All Sales criteria, select one of the following options:

l This User: Shows sales for the currently logged in user.
l This Terminal: Shows sales for the current terminal. This is useful to track sales if mul-
tiple users are selling from the same terminal.

6. If the view is selectable, select the view that you want to use to generate the report. For
more information, see Managing BOCA Sales Summary Report Views.

7. In the File Format list, select one of the following formats for the report:

l HTML: Outputs the report in HTML and displays the report in a Web browser.
l Print to Ticket Stock: Prints the report on ticket stock.
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Note: If you do not have access to a BOCA printer, you cannot print the report on ticket
stock. You can print to a laser printer instead, by selecting HTML in the File Format list. When
you run (generate) the report, Pac7 will display the report in your default Web browser (for
example, Internet Explorer). You can then print the report using the Web browser's Print com-
mand, usually located in the File menu.

8. Click the Run button. Pac7 generates the BOCA Sales Summary Report. Totals are adjusted
for voids and returns.

9. To close the report and return to the Order Management tab, click the X buttonx at the
upper right of the report form.

Generating Sales Summary Reports
You can generate different types of sales summary reports:

l A summary of sales for a business organization (see Generating the Sales Summary Report)
l A summary of sales by item for a business organization (see Generating the Sales Summary
by Item Report)

l A summary of sales by user for a business organization (see Generating the Sales Summary
by User Report)

l A summary of sales by paymode for a business organization (see Generating the Sales Sum-
mary by Paymode Report)

l A summary of returns made by alternate users (see Generating the Return Authorization
Report)

Generating the Sales Summary Report
The sales summary report contains a summary of sales for a business organization. This report
shows, for the specified time frame, the number of items sold, the number of orders, and the total
sales. It can be downloaded for access by a data program (for example, Microsoft Excel) or viewed
though the browser.

To generate a Sales Summary report

1. In the Pac7 menu, click the Reporting link.
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Pac7 displays the Reporting page.

2. Click Sales Summary Report to display the Sales Summary Report version of the Report Cri-
teria page.

3. Set the date range for the report:
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l In From, enter the beginning date and time of the report date range.
l In To, enter the ending date and time of the date range for the report.

Note: The dates entered for the beginning and ending of the range must be within 30 days of
each other.

4. In Location, select the location for which you are generating the report.
5. In Data Account, select the data account for which you are generating the report.
6. In File Format, select the format for the report:

l HTML outputs the report in HTML and displays the report in a Web browser.
l CSV (ZIP) outputs the report to a Comma Separated Values file that can be imported into
a data program (for example, Microsoft Excel).

7. Click Run to generate the Sales Summary Report.

Generating the Sales Summary by Item Report
The sales summary by item report contains a summary of sales by item for a business organ-
ization. This report shows, for the specified time frame, the number of items sold, the number of
orders, and the total sales of each item. It can be downloaded for easy access by a data program
(for example, Microsoft Excel) or viewed though the browser.

To generate a Sales Summary by Item report

1. In the Pac7 menu, click the Reporting link.

Pac7 displays the Reporting page.
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2. Click Sales Summary by Item Report to display the Sales Summary by Item Report version
of the Report Criteria page.

3. Set the date range for the report:

l In From, enter the beginning date and time of the report date range.
l In To, enter the ending date and time of the date range for the report.

Note: The dates entered for the beginning and ending of the range must be within 30 days of
each other.

4. In Location, select the location for which you are generating the report.
5. In Data Account, select the data account for which you are generating the report.
6. In File Format, select the format for the report:
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l HTML outputs the report in HTML and displays the report in a Web browser.
l CSV (ZIP) outputs the report to a Comma Separated Values file that can be imported into
a data program (for example, Microsoft Excel).

7. Click Run to generate the Sales Summary by Item Report.

Generating the Sales Summary by User Report
The sales summary by item report contains a summary of sales by user for a business organ-
ization. This report shows, for the specified time frame, the number of items sold, the number of
orders, and the total sales of each user. It can be downloaded for easy access by a data program
(for example, Microsoft Excel) or viewed though the browser.

To generate a Sales Summary by User report

1. In the Pac7 menu, click the Reporting link.

Pac7 displays the Reporting page.
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2. Click Sales Summary by User Report to display the Sales Summary by User Report version
of the Report Criteria page.

3. Set the date range for the report:

l In From, enter the beginning date and time of the report date range.
l In To, enter the ending date and time of the date range for the report.

Note: The dates entered for the beginning and ending of the range must be within 30 days of
each other.

4. In Location, select the location for which you are generating the report.
5. In Data Account, select the data account for which you are generating the report.
6. In File Format, select the format for the report:
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l HTML outputs the report in HTML and displays the report in a Web browser.
l CSV (ZIP) outputs the report to a Comma Separated Values file that can be imported into
a data program (for example, Microsoft Excel).

7. Click Run to generate the Sales Summary by User Report.

Generating the Sales Summary by Paymode Report
The sales summary by paymode report contains a summary of sales by paymode for a business
organization. This report shows, for the specified time frame, the number of items sold, the num-
ber of orders, and the total sales for each paymode used to place an order. It can be downloaded
for easy access by a data program (for example, Microsoft Excel) or viewed though the browser.

To generate a Sales Summary by Paymode report

1. In the Pac7 menu, click the Reporting link.

Pac7 displays the Reporting page.
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2. Click Sales Summary by Paymode Report to display the Sales Summary by Paymode Report
version of the Report Criteria page.

3. Set the date range for the report:

l In From, enter the beginning date and time of the report date range.
l In To, enter the ending date and time of the date range for the report.

Note: The dates entered for the beginning and ending of the range must be within 30 days of
each other.

4. In Location, select the location for which you are generating the report.
5. In Inventory, select the data account for which you are generating the report.
6. In File Format, select the format for the report:
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l HTML outputs the report in HTML and displays the report in a Web browser.
l CSV (ZIP) outputs the report to a Comma Separated Values file that can be imported into
a data program (for example, Microsoft Excel).

7. Click Run to generate the Paymode Report.

Generating a Return Authorization Report
This report shows order returns that have been processed with an alternate user assigned, as well
as the users that made the alternate user assignment. The report is used to help business organ-
izations track who has authorized returns over a specific period.

To generate a Return Authorization report

1. In the Pac7 menu, click the Reporting link.

Pac7 displays the Reporting page.
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2. Click Return Authorization Report to display the Return Authorization Report version of the
Report Criteria page.

3. Set the date range for the report:

l In From, enter the beginning date and time of the report date range.
l In To, enter the ending date and time of the date range for the report.

Note: The dates entered for the beginning and ending of the range must be within 30 days of
each other.

4. In Data Account, select the data account for which you are generating the report.
5. In File Format, select the format for the report:

l HTML outputs the report in HTML and displays the report in a Web browser.
l CSV (ZIP) outputs the report to a Comma Separated Values file that can be imported into
a data program (for example, Microsoft Excel).

6. Click Run to generate the Return Authorization Report.

Pac7 Release 7.2



User Guide  841

Generating a Detailed Transaction Report by Batch
The Detailed Transaction Report by Batch contains detailed information about the transactions in a
batch for a specific data account. This report lists all transactions that were recorded to a specific
batch for one data account. It can be downloaded to a data program (for example, Microsoft Excel)
or viewed through the browser.

To generate a Detailed Transaction Report by Batch

1. In the Pac7 menu, click the Reporting link.

Pac7 displays the Reporting page.
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2. Click Detailed Transaction Report by Batch to display the Detailed Transaction Report by
Batch version of the Report Criteria page.

3. In Batch, enter the batch number for which you are generating the report.
4. In Data Account, select the data account for which you are generating the report.
5. In File Format, select the format for the report:

l HTML outputs the report in HTML and displays the report in a Web browser.
l CSV (ZIP) outputs the report to a Comma Separated Values file that can be imported into
a data program (for example, Microsoft Excel).

6. Click Run to generate the Detailed Transaction Report by Batch.

Generating a Balancing Report by Item Fee
The balancing report by item fee tracks sales per data account by item fee. This report can be used
to settle fees between a data account and a selling organization. This report shows, for each user in
a location, the items that were ordered from cash data account, the number of tickets ordered, the
face value of the tickets, the total fee charged for the tickets, and the amount the selling organ-
ization keeps from each sale. You can only run the report for inventories in which this report is
defined. This report can be downloaded to a data program (for example, Microsoft Excel) or viewed
through the browser.

To generate a Balancing Report by Item Fee

1. In the Pac7 menu, click the Reporting link.
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Pac7 displays the Reporting page.

2. Click Balancing Report by Item Fee to display the Balancing Report by Item Fee version of
the Report Criteria page.

3. Set the date range for the report:
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l In From, enter the beginning date and time of the report date range.
l In To, enter the ending date and time of the date range for the report.

Note: The dates entered for the beginning and ending of the range must be within 30 days of
each other.

4. In Location, select the location for which you are generating the report.
5. In Data Account, select the data account for which you are generating the report.

Note: Only inventories in which this report is defined are displayed.

6. In File Format, select the format for the report:

l HTML outputs the report in HTML and displays the report in a Web browser.
l CSV (ZIP) outputs the report to a Comma Separated Values file that can be imported into
a data program (for example, Microsoft Excel).

7. Click Run to generate the Balancing Report by Item Fee.
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Chapter 9 Utilities

The Utilities menu in Pac7 provides basic ticket administration functionality, including the ability to
print tickets, manage seat inventory, and view event details. Operators will have access to the util-
ities under the following conditions:

l They have selected their data account, or they only sell out of 1 data account.

l They have access to at least one of the tRes utility processes. The utilities available in the
Utilities sidebar menu depend on the processes allowed for the operator in SYS.OP.E. For
more information, see the table below.

Utility Process required

Event Inquiry Season Event Inquiry (TK.EVENT.I)

Print Tickets Print Allocated Tickets (TK.PRINT.F)

Seat Hold Management Seat Status Change (TK.HOLD)

Counter Seat Hold Management Seat Status Change/Counter Hold (TK.CHOLD)

All of the utilities are based on individual seasons, and only open seasons are available. However,
each operator's access to seasons may be limited by the season activity setups. See Limiting Oper-
ator Access Using Activities for more information.

From the Utilities page you can perform the following procedures:

l Using the Event Inquiry Utility
l Using the Print Tickets Utility
l Using the Seat Hold Management Utility
l Using the Counter Seat Hold Management Utility

Using the Event Inquiry Utility
The Event Inquiry utility page displays order sales and seat totals information for a single event
within a season (not combo items). You can switch between a table view of the inquiry data and a
graphics view of the event information. You can also drill into user and operator seat hold details
as well as counter hold totals.

The utility displays the top level information that is used for the Season Event Inquiry (TK.EVENT.I)
tRes process. The images below map how the information from the tRes Season Event Inquiry
screen is displayed on the tabular and graphical versions of the Pac7 Event Inquiry page. For

http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/allocations/seat_event_inquiry.htm
http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/print/Print_Allocated_Tickets.htm
http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/allocations/seat_status_change.htm
http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/allocations/seat_status_change_counter_hold.htm
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information about the fields on this screen, see the Season Event Inquiry (TK.EVENT.I) reference
topic.
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Season activity operator restrictions apply to this utility, so operators must have TK.EVENT.I
access permission allowed in the System Functions Operator Access (SYS.OP.E) process. The
Event Inquiry option will not be in the Utilities sidebar menu if operator is not configured for
TK.EVENT.I in SYS.OP.E.
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To use the Event Inquiry utility in the table view

1. In the Pac7 navigation menu, click the Utilities link.

If the operator has access to TK.EVENT.I in SYS.OP.E, the Utilities > Event Inquiry page will
display.

2. In the Season drop-down list, select the season that contains the event about which you
want information.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more
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seasons have the same Sort Order value, they are sorted in ascending order by their season
codes.

3. In the Event text box, locate the event by entering a search term (for example, all or part of
the event code, event name, a keyword, date, or facility), and then clicking the Go buttonx

. To see all of the events in the season, leave the text box empty, and then click the Go

buttonx .

4. If the Multiple events found form displays, click the event you want.

The Utilities > Event Inquiry page redisplays in table view with item information for the

event. You can click the Refresh buttonx at any time to update the data in the
view.
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For descriptions of the content in different areas of the page, see the table below.

Page
area Content information

Items
table

Each row in the table represents an item from which this event has been sold. If
no sales have been made yet, the table will be empty. The table includes sales of
singles, combos, donation items, and miscellaneous items from all sales channels.

Item
Detail
table

Includes one row for each Item PL/PT of the item selected in the Items table. The
table is empty if a non-allocatable item is selected.

Order
Totals Includes information from both allocatable and non-allocatable items.

Seat
Totals Includes information from allocatable items only.

5. To view the total counter holds and user and operator holds, click the View Counter Holds
link in the Seat Totals group.
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The Counter Holds form displays. This information is taken from the Pac7 inventory (avail-
ability server), so the totals may be different from those on the main inquiry screen, which
gets information from the back office. The Remaining value is different here than in the
back office, because the back office does not break out counter holds separately. For that
reason, counter holds are added to the Remaining value here. Click the Close buttonx

to redisplay the Utilities > Event Inquiry page.

6. To view the details of the user and operator holds, click the User and Operator Holds link
in the Seat Totals group.
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The User and Operator Holds form displays.

By default, only the seats with the selected status are displayed in the Seat Locations
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table. If you want to see all seat statuses, click the Off button for the Show selected
status only option.

After clicking the Off button, the Seat Locations table redisplays with extra rows for unse-
lected statuses.

7. To print the seat locations table, click the Print buttonx .

8. Click the Close buttonx to redisplay the Utilities > Event Inquiry page.

To use the Event Inquiry utility in the graphical view

1. In the Pac7 navigation menu, click the Utilities link.
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If the operator has access to TK.EVENT.I in SYS.OP.E, the Utilities > Event Inquiry page will
display.

2. In the Season drop-down list, select the season that contains the event about which you
want information.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

3. In the Event text box, locate the event by entering a search term (for example, all or part of
the event code, event name, a keyword, date, or facility), and then clicking the Go buttonx

. To see all of the events in the season, leave the text box empty, and then click the Go

buttonx .

4. If the Multiple events found form displays, click the event you want.
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The Utilities > Event Inquiry page redisplays in table view with item information for the

event. You can click the Refresh buttonx at any time to update the data in the
view.
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5. Click the Graphics option On button.

The Utilities > Event Inquiry page redisplays in the graphical view.

6. To see another seat view (Ordered, Allocated, Extension ($), or Printed) of the Items pie
chart, select it from the drop-down list. The pie chart includes a slice for each item from
which this event has been sold. Hover over a slice for more information about the block of
seats.

7. To view the total counter holds and user and operator holds, click the View Counter Holds
link in the Seat Totals group.
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The Counter Holds form displays. The data is taken from the Pac7 inventory server.

8. To view the details of the user and operator holds, click the View User/Operator Holds
link in the Seat Totals group.

The User and Operator Holds form displays. The data is taken from the Pac7 inventory
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server.

9. To filter the results in the Item Detail form bar chart, select the desired options (Detail by
PL/PT or PL Audit, Seats/Extension ($), and item name) from the drop-down lists .

If you choose the Detail by PT Audit Type option, you can also select a PT Audit Type
drop-down list option. This allows you to see item PL/PT comparisons of the selected meas-
ure or to see a chart with data summarized by PT audit kind.

If you select Seats from the far right drop-down list, the graph displays ordered, allocated,
and print quantity comparisons. If you select Extension ($), the graph displays extended
dollar amounts for the selected item. This graph includes allocatable items only.
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Limiting Operator Access Using Activities
An activity is a seasonal attribute that can be used to limit access to a season. Within the activity
setup (TK.ACTIVITY.E), you can specify the operators that you want to have access to that activity.
Access is configured by the following:

l Each season has an assigned activity code.
l Each Pac7 user is mapped to a TK operator.
l Each TK operator may or may not have access to an activity.
l If thePac7 user's assigned TK operator does not have access to an activity, that user cannot
sell items or view data for any season with that activity assigned.

Activity restrictions will impact what items are displayed within Pac7. All Pac7 paths, including
Order Management, Item Sales, Inquiry, Adjustments, Go Exchange, and Patron, obey the oper-
ator activity restrictions.

Activity restrictions are set in the back office using the TK.ACTIVITY.E process. Using this process
you can list the operators that are eligible for the activity. You can then specify which processes
are allowed or disallowed for each eligible operator. For the Pac7 paths, use the TK.SELL process to
control sales and adjustments and the TK.ORDER.I process to control access to read-only data.
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See a permissions table.

Permissions OM Item
Sales Adjustment Inquiry Patron Promos

Operator not listed & no other
operators listed Yes Yes Yes Yes Yes Yes

Operator not listed & other oper-
ators are listed No No No No No Yes

Operator listed & no processes
defined Yes Yes Yes Yes Yes Yes

Operator listed & Allowed =
TK.SELL Yes Yes Yes No No Yes

Operator listed & Allowed =
TK.ORDER.I No No No Yes Yes Yes

Operator listed & Allowed =
TK.SELL & TK.ORDER.I Yes Yes Yes Yes Yes Yes

Operator listed & Disallowed =
TK.SELL No No No Yes Yes Yes

Operator listed & Disallowed =
TK.ORDER.I Yes Yes Yes No No Yes

Operator listed & Disallowed = No No No No No No
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TK.SELL & TK.ORDER.I

Item Sales tab

Activity restrictions for Item Sales

Activity restrictions determine the items that are available for selling within Pac7. Item Sales are
affected as follows:

l The restrictions override the settings in the Paciolan 7 control. So, even though a season and
its items may be listed as available within the control, none of the items in that season will
be displayed within Pac7 if the user does not have access to the season activities.

l In the Onsale and General Sales paths, items will not be displayed if the user does not have
access to TK.SELL for the season activity.

l If a General Sales item group contains items from multiple seasons, an individual item will
not be displayed in the item group if the user does not have TK.SELL access to its season
activity. If users select an item group that contains no items for which they have season
activity TK.SELL access, a “No results found” message will be displayed.

l For text and facility item searches, the search results will not include items for which the
user does not have access to TK.SELL for the season activities.

l Having a promo code will allow operators to bypass any activity restrictions and sell all the
inventory that is listed for that promotion.

Inquiry tab

Search for Orders in this System Only

Pac7 orders can include items from multiple seasons. Season activity restrictions impact the dis-
played items within the order and the display of the order itself. The restrictions affect the fol-
lowing:

l The summary data on the Select an Order to View page.

l An item will not be displayed within an order if the user does not have access to
TK.ORDER.I for the season activity (order line A).

l The order will not be displayed if the user does not have access to TK.ORDER.I for all of
its season activities (order line B).

l The Item modules and the Charge Summary module on the Order Details page.
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l The entire Item module will be hidden if the user does not have access to TK.ORDER.I for
the item’s season activity.

l An order charge will not be displayed within the Charge Summary module if the user does
not have access to TK.ORDER.I for the charge’s season activity.

Note: No other Order Details page modules are affected, so they may display incorrect
order totals and payment amounts.

Search for Orders in All Systems

You can update values using the Seasons drop-down list on the Select Season page. Seasons will
only be listed in the drop-down list if the patron has placed an order within that season and has
access to TK.ORDER.I for the season activity.

Adjustments tab

Return Items

Pac7 orders can include items from multiple seasons. Season activity restrictions impact the dis-
played items within the order and the display of the order itself. The restrictions affect the fol-
lowing:

l The summary data on Select Order to Return page.
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l An item will not be displayed within an order if the user does not have access to TK.SELL
for the season activity (order line A).

l The order will not be displayed if the user does not have access to TK.SELL for all of its
season activities (order line B).

l The Item modules and the Charge Summary module on the Select Items to Return page.

l The entire Item module will be hidden if the user does not have access to TK.SELL for the
item’s season activity.

l An order charge will not be displayed within the Charge Summary module if the user does
not have access to TK.SELL for the charge’s season activity.

Will Call Pickup

On the Select Items to Pickup page, items available for pickup are grouped by season. If the user
does not have access to TK.SELL for the season activity, that season’s module will be hidden and
none of the items in that season will be displayed for pickup.

Patron tab

Overview

Within full patron, the user may be able to see and update activity data, as well as view seasonal
summary information. To view activity and seasonal data within full patron, the user’s operator
must be allowed to access TK.ORDER.I for the appropriate activity.

These changes will impact the Ticketing Activities module and the Ticketing Order History module.
These modules can be seen on the full patron Ticketing Data tab. These modules may also be dis-
played on the Patron Home Page. The module display is configured in the Patron Policy
(TK.PPOLICY.E) on the Data Access Options subscreen.
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Ticketing Activities module

l Update values within Activity Name drop-down list. Activities will only be in the list if the
user's operator has access to TK.ORDER.I for the activity.

l Update display rules for the patron’s assigned activities. A previously assigned activity (activ-
ity name is in read-only format) will only be displayed if the user has access to TK.ORDER.I
for the activity. If the user does not have access to a patron’s previously assigned activity,
the entire row will be hidden.

Ticketing Order History module

l Update display rules for the patron’s seasonal information. Seasonal data will only be dis-
played if the user has access to TK.ORDER.I for the season activity. If the user does not have
access to the season activity, the entire row will be hidden.

Using the Print Tickets Utility
The Print Tickets utility is a scaled down and combined version of the Print Allocated Tickets
(TK.PRINT.F) and Non-Ticket Processing (TK.PROCESS.F) processes in tRes. (See the combined
image.) The utility allows operators to bulk print allocatable and non-allocatable items in Pac7 with
fewer sorting and selection options than are in the tRes processes.
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Click here to see a table that maps tRes TK.PRINT.F process fields to the Pac7 Print Tickets page.

tRes process (TK.PRINT.F) Pac7 Print Tickets page
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tRes process (TK.PRINT.F) Pac7 Print Tickets page
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tRes process (TK.PRINT.F) Pac7 Print Tickets page

As for the Print Allocated Tickets process (TK.PRINT.F), in Pac7 the tickets are printed directly onto
the ticket stock for a ticket printer, print at home (PAH), mobile delivery, or laser printer.

To use the Print Tickets utility

1. In the Pac7 navigation menu, click the Utilities link.

The page of the top utility in the Utilities sidebar is displayed. For example, if the operator
has access to TK.EVENT.I, the Utilities > Event Inquiry page will display. The utilities avail-
able in the Utilities sidebar menu depend on the processes allowed for the operator in the
System Functions version of the Operator Access screen (SYS.OP.E).

2. In the Utilities sidebar menu, click Print Tickets.
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The Utilities > Print Tickets page displays. If you have not used the Print Tickets utility
before, you may be prompted to enter a Print Agent Host Name and select a Ticket Printer
and Laser Printer. This is similar to using the Change Terminal Ticket Printer administration
procedure.

3. Select the Season, Stock, and Device codes. If you select Laser Printer or Ticket Printer as
the device, you can also select a Mailer code.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

4. In the Sort by drop-down list, select the sort method to use when you print the tickets. In
the drop-down options, (A) means ascending and (D) means descending.

5. In the Select Items group, select the item PL/PT combinations that you want to print. In
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addition to searching for items using the item search box, you can add items from an existing
item set using the Item Set drop-down list.

6. Once you add item PL/PT combinations to the Item table, you can delete or edit the PL/PT of
any of the items in the table.

7. Use the Selection Criteria to limit the order items to include from the Select Items res-
ults by doing one or more of the following:

l To exclude order items based on their remaining balances, use the Balance Limit selection
criteria group by doing the following:

i. Enter the amount in the Balance Limit box.
ii. From the Evaluation drop-down list, select an order balance limit evaluation option.
This setting determines the totals the system will evaluate with the balance limit. You
can choose to evaluate On Account total order value less total payments for each cus-
tomer account, On Line Item extension minus the order line payment for each line item
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for each customer, or Apply to All Line Items no order lines will be included unless all
eligible tickets meet the order line balance limit.

iii. To Print tickets for all orders, including those with a balance due, select the
option. If you select this option, you cannot set a balance limit or an evaluation option.

l To select order items based on disposition code, use the Disposition Code selection cri-
teria. In the Options drop-down list, you can choose whether to Include or Exclude the
list of dispositions that you add to the Disposition table.

l To use individual customers as a basis for order item selection, use the Customer selec-
tion criteria.

l To use customer types as a basis for order item selection, use the Customer Type selec-
tion criteria. In the Options drop-down list, you can choose whether to Include or
Exclude the list of customer types that you add to the Customer Type table.
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8. Use the Additional Options as required.

The options include the following:

l Complete Allocation. Select this option to limit printing to completely allocated
order lines.

l AM Immediate Mode. Select this option to immediately upload data to the Access
Management system.

l Include Package Items. Select this option to include package items events as print-
able. If this option is cleared,the process will not print event items purchased within an
item package.

l Order Tag. Enter a one word tag to be added to the order records tag field during
ticket printing.

9. If you want to select only order items for customers that have items on will call, select the
Will Call Customer option.

10. Click the Print buttonx .

Using the Seat Hold Management Utility
Note: The Seat Hold Management utility and the Counter Seat Hold Management utility are the
same except that the Counter Seat Hold Management utility allows you to change the counter hold
(C) seat status to another status.

The Seat Hold Management utility allows you to change the seat statuses of unallocated seats for
one or more events within a season. Seat statuses are used to control which seats are available for
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sale. The Seat Hold Management utility enables you to change the status of seats with the following
statuses:

l O = Open
l H = Hold
l K = Killed
l User Defined

You cannot allocate or deallocate seats using this utility. Only the statuses of unallocated seats can
be changed. You can change seat statuses for one or more seats at the same time on the seat map,
individual seats for one or more events, and sets of rows and seats by level:section. You can also
put seats in the manifest or seat file on hold by giving them a user-defined seat status.

Access to the Seat Hold Management utility is restricted to operators with access to the TK.HOLD
tRes process. (To see how the process is used in TK.SELL, see the Seat Status Change (TK.HOLD)
reference topic) The Pac7 interface for the Seat Hold Management utility is also used for the
Counter Seat Hold Management utility interface, except that the counter version allows you to
change seat status C (counter hold) to another status. The two utilities also record operator input in
different logs.

To change seat statuses directly on the seat map

Note: If you use this method, you can only change seat statuses for the primary event. If you
want to change other events at the same time, use the change individual seat status and change
seat status by level:section procedures.

1. In the Pac7 navigation menu, click the Utilities link.

The page of the top utility in the Utilities sidebar is displayed. For example, if the operator
has access to TK.EVENT.I, the Utilities > Event Inquiry page will display. The utilities avail-
able in the Utilities sidebar menu depend on the processes allowed for the operator in the
System Functions version of the Operator Access screen (SYS.OP.E).
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2. In the Utilities sidebar menu, click .

Note: If you do not have access to counter holds, the Counter Seat Hold Management
option will not appear in the Utilities sidebar menu.

The Utilities > Seat Hold Management page displays.

3. In the Season drop-down list, select the season that contains the event for which you want
seat status changes.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

4. In the Event text box, find the event code or the event name by entering a search term (for
example, all or part of the event code, event name, a keyword, a date, or a facility) and then

clicking the Go buttonx .

5. If the Multiple events found form displays, click the primary event.
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The Utilities > Seat Hold Management page redisplays with the seat map for the event.

The seat map is functionally the same one that is used for Item Sales, except for several
options that are specific to the Seat Hold Management utility.

6. In the Change to new seat status drop-down list, select the status to which you want to
change the seats. The table below details the current seat statuses that you can change.

Current seat status If you select a seat with that
status...
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Reserved seat statuses: 0-9, A, D,M,N, X,-,*,
T, S Do not change to new seat status

K (killed) Change to new seat status

H (held) Change to new seat status

User-defined seat statuses: !, @, #, $, %, (, ),
=, +, [, ], {, >, <, B, E, F, G, I, J, L, P, Q, R, Y,
Z, a, b, c, d, e, f, g, h, i, j, k, l, m, n, o, p, q, r,
s, t, u, v, w, x, y, z

Change to new seat status process
All user-defined statuses can be changed
even if they are not in the Valid Item
table of the Season Seat Statuses
(TK.SSTAT.SEA.E) process

O (open) Change to new seat status

C (counter held) Change to new seat status only if using
the Counter Seat Hold Management utility

7. Locate the seats whose statuses you want to change. Some of the methods are included in
the following table:

To do this... Do this...

Go directly to a seat
Click the Go to Seat buttonx

Display only selected seat
statuses Click the Display Specific Seat Statuses buttonx

View information for a specific
seat

Right-click on a seat and select from the menu

Go to the seat map overview
Click the center of the navigation control x

8. Select seats whose statuses you want to change using either of the following methods:

l Click the seats one at a time.

l Select more than one seat using the lasso (dragging a selection rectangle). To use the
lasso, you must first select the Lasso seats option.
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The seat statuses will immediately change to the selected seat status. For more information
about selecting seats using the seat map, see Using the Seat Map to Select Seats.

To change a single seat status for one or more events using a form

1. In the Pac7 navigation menu, click the Utilities link.

The page of the top utility in the Utilities sidebar is displayed. For example, if the operator
has access to TK.EVENT.I, the Utilities > Event Inquiry page will display. The utilities avail-
able in the Utilities sidebar menu depend on the processes allowed for the operator in the
System Functions version of the Operator Access screen (SYS.OP.E).

2. In the Utilities sidebar menu, click .

Note: If you do not have access to counter holds, the Counter Seat Hold Management
option will not appear in the Utilities sidebar menu.
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The Utilities > Seat Hold Management page displays.

3. In the Season drop-down list, select the season that contains the event for which you want
seat status changes.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

4. In the Event text box, find the event code or the event name by entering a search term (for
example, all or part of the event code, event name, a keyword, a date, or a facility) and then

clicking the Go buttonx .

5. If the Multiple events found form displays, click the primary event.

The Utilities > Seat Hold Management page redisplays with the seat map for the event.
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The seat map is functionally the same one that is used for Item Sales, except for several
options that are specific to the Seat Hold Management utility.

6. Right-click on the seat and select Change seat status from the menu.

The Change seat status form displays.
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7. In the Change To group, select a status from the New seat status drop-down list.

8. If you want to change the status of the same seat for other events from the current season,
enter a search term in the Select other events to update (optional) box, and then click

the plus buttonx . The Items Found form displays with the results of your search.
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9. Select one or more events, and then click the Continue buttonx . If the seat
status cannot be changed for one or more of the selected events, an Attention dialog box will
be displayed. The seat statuses will not be changed for the events listed in the Attention dia-

log box. Click the OK buttonx . The statuses will be changed for the rest of the selected
events.

To change seat statuses by level:section

1. In the Pac7 navigation menu, click the Utilities link.
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The page of the top utility in the Utilities sidebar is displayed. For example, if the operator
has access to TK.EVENT.I, the Utilities > Event Inquiry page will display. The utilities avail-
able in the Utilities sidebar menu depend on the processes allowed for the operator in the
System Functions version of the Operator Access screen (SYS.OP.E).

2. In the Utilities sidebar menu, click .

Note: If you do not have access to counter holds, the Counter Seat Hold Management
option will not appear in the Utilities sidebar menu.

The Utilities > Seat Hold Management page displays.
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3. In the Season drop-down list, select the season that contains the event for which you want
seat status changes.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

4. In the Event text box, find the event code or the event name by entering a search term (for
example, all or part of the event code, event name, a keyword, a date, or a facility) and then

clicking the Go buttonx .

5. If the Multiple events found form displays, click the primary event.

The Utilities > Seat Hold Management page redisplays with the seat map for the event.
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The seat map is functionally the same one that is used for Item Sales, except for several
options that are specific to the Seat Hold Management utility.

6. In the seat map toolbar, click the Change seat status by Level:Section buttonx . The
Change seat status by Level:Section form is displayed.

Note: If you want to view the seat map temporarily while completing this form, click the
minus buttonx on the right side of the title bar. The form will minimize to the title bar
only. Click the plus buttonx to redisplay the form.
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7. In the Change From group, enter the name or code of a status you want to change in the

Current seat status box, and then click the plus buttonx . If the Multiple seat
statuses found form displays, select the statuses you want to change, and then click the

Continue buttonx .

The Change seat status by Level:Section form redisplays with the selected statuses
added to the Current status table.

8. From the Level:Section drop-down list, select a level:section. You will be able to add more
level:section combinations as you complete the entries in the Lev:Sec table.
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9. Use the RFrom, RTo, SFrom, and STo boxes to add entries to the Lev:Sec table. To add
entries for another level:section, select it from the Level:Section drop-down list, and then
repeat this step. You can also add subsets of rows and seats from the same level:section in
this table. The Qty column contains the number of seats in the Level:Section that have the
statuses listed in the Current status table. This column is not editable.

The methods you can use to configure a level:section in the Lev:Sec table are demonstrated
in the following example.

The table below shows an example of how to set the RFrom, RTo, SFrom, and STo box
values when adding rows to the Lev:Sec table.
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If you
want
this
selec-
tion...

Use this text box con-
figuration... And you will get this result...

All seats
& rows

Same
seat sub-
set for all
rows

All seats
in a sub-
set of
rows

A subset
of seats
in a sub-
set of
rows

10. In the Change To group, select the new status from the New seat status drop-down list.
This status will be assigned to all the seats that are selected by the configuration of the Cur-
rent status and Lev:Sec tables in the Change From group.

To make it easier to work in the Change To group, minimize the Change From group by
clicking Change From. Click Change From again to maximize the Change From group.
You can also minimize and maximize the Change To group by clicking Change To.
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11. If you want to change the statuses of the same seats for other events from the current sea-
son, enter a search term in the Select other events to update (optional) box, and then

click the plus buttonx . The Items Found form displays with the results of your search.

12. Select one or more events, and then click the Apply buttonx . There is no noti-
fication if one or more seat statuses cannot be changed for any of the selected events. The
statuses will be changed whenever applicable for each of the selected events.
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Using the Counter Seat Hold Management Utility
Note: The Seat Hold Management utility and the Counter Seat Hold Management utility are the
same except that the Counter Seat Hold Management utility allows you to change the counter hold
(C) seat status to another status.

The Counter Seat Hold Management utility allows you to change the seat statuses of unallocated
seats for one or more events within a season. Seat statuses are used to control which seats are
available for sale. The Counter Seat Hold Management utility enables you to change the status of
seats with the following statuses:

l O = Open
l H = Hold
l K = Killed
l C = Counter
l User Defined

You cannot allocate or deallocate seats using this utility. Only the statuses of unallocated seats can
be changed. You can change seat statuses for one or more seats at the same time on the seat map,
individual seats for one or more events, and sets of rows and seats by level:section. You can also
put seats in the manifest or seat file on hold by giving them a user-defined seat status.
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Access to the Counter Seat Hold Management utility is restricted to operators with access to the
TK.CHOLD tRes process. (To see how the process is used in TK.SELL, see the Seat Status
Change/Counter Hold (TK.CHOLD) reference topic) The Pac7 interface for the Seat Hold Man-
agement utility is also used for the Counter Seat Hold Management utility interface, except that the
counter version allows you to change seat status C (counter hold) to another status. The two util-
ities also record operator input in different logs.

To change seat statuses directly on the seat map

Note: If you use this method, you can only change seat statuses for the primary event. If you
want to change other events at the same time, use the change individual seat status and change
seat status by level:section procedures.

1. In the Pac7 navigation menu, click the Utilities link.

The page of the top utility in the Utilities sidebar is displayed. For example, if the operator
has access to TK.EVENT.I, the Utilities > Event Inquiry page will display. The utilities avail-
able in the Utilities sidebar menu depend on the processes allowed for the operator in the
System Functions version of the Operator Access screen (SYS.OP.E).

2. In the Utilities sidebar menu, click Counter Seat Hold Management.
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The Utilities > Counter Seat Hold Management page displays.

3. In the Season drop-down list, select the season that contains the event for which you want
seat status changes.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

4. In the Event text box, find the event code or the event name by entering a search term (for
example, all or part of the event code, event name, a keyword, a date, or a facility) and then

clicking the Go buttonx .

5. If the Multiple events found form displays, click the primary event.

The Utilities > Counter Seat Hold Management page redisplays with the seat map for the
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event.

The seat map is functionally the same one that is used for Item Sales, except for several
options that are specific to the Counter Seat Hold Management utility.

6. In the Change to new seat status drop-down list, select the status to which you want to
change the seats. The table below details the current seat statuses that you can change.

Current seat status If you select a seat with that
status...

Reserved seat statuses: 0-9, A, D,M,N, X,-,*,
T, S Do not change to new seat status

K (killed) Change to new seat status

H (held) Change to new seat status

User-defined seat statuses: !, @, #, $, %, (, ),
=, +, [, ], {, >, <, B, E, F, G, I, J, L, P, Q, R, Y,
Z, a, b, c, d, e, f, g, h, i, j, k, l, m, n, o, p, q, r,
s, t, u, v, w, x, y, z

Change to new seat status process
All user-defined statuses can be changed
even if they are not in the Valid Item
table of the Season Seat Statuses
(TK.SSTAT.SEA.E) process

O (open) Change to new seat status

C (counter held) Change to new seat status only if using
the Counter Seat Hold Management utility
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7. Locate the seats whose statuses you want to change. Some of the methods are included in
the following table:

To do this... Do this...

Go directly to a seat
Click the Go to Seat buttonx

Display only selected seat
statuses Click the Display Specific Seat Statuses buttonx

View information for a specific
seat

Right-click on a seat and select from the menu

Go to the seat map overview
Click the center of the navigation control x

8. Select seats whose statuses you want to change using either of the following methods:

l Click the seats one at a time.

l Select more than one seat using the lasso (dragging a selection rectangle). To use the
lasso, you must first select the Lasso seats option.

The seat statuses will immediately change to the selected seat status. For more information
about selecting seats using the seat map, see Using the Seat Map to Select Seats.

To change a single seat status for one or more events using a form

1. In the Pac7 navigation menu, click the Utilities link.
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The page of the top utility in the Utilities sidebar is displayed. For example, if the operator
has access to TK.EVENT.I, the Utilities > Event Inquiry page will display. The utilities avail-
able in the Utilities sidebar menu depend on the processes allowed for the operator in the
System Functions version of the Operator Access screen (SYS.OP.E).

2. In the Utilities sidebar menu, click Counter Seat Hold Management.

The Utilities > Counter Seat Hold Management page displays.
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3. In the Season drop-down list, select the season that contains the event for which you want
seat status changes.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

4. In the Event text box, find the event code or the event name by entering a search term (for
example, all or part of the event code, event name, a keyword, a date, or a facility) and then

clicking the Go buttonx .

5. If the Multiple events found form displays, click the primary event.

The Utilities > Counter Seat Hold Management page redisplays with the seat map for the
event.
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The seat map is functionally the same one that is used for Item Sales, except for several
options that are specific to the Counter Seat Hold Management utility.

6. Right-click on the seat and select Change seat status from the menu.

The Change seat status form displays.
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7. In the Change To group, select a status from the New seat status drop-down list.

8. If you want to change the status of the same seat for other events from the current season,
enter a search term in the Select other events to update (optional) box, and then click

the plus buttonx . The Items Found form displays with the results of your search.

Pac7 Release 7.2



User Guide  898

9. Select one or more events, and then click the Continue buttonx . If the seat
status cannot be changed for one or more of the selected events, an Attention dialog box will
be displayed. The seat statuses will not be changed for the events listed in the Attention dia-

log box. Click the OK buttonx . The statuses will be changed for the rest of the selected
events.

To change seat statuses by level:section

1. In the Pac7 navigation menu, click the Utilities link.
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The page of the top utility in the Utilities sidebar is displayed. For example, if the operator
has access to TK.EVENT.I, the Utilities > Event Inquiry page will display. The utilities avail-
able in the Utilities sidebar menu depend on the processes allowed for the operator in the
System Functions version of the Operator Access screen (SYS.OP.E).

2. In the Utilities sidebar menu, click Counter Seat Hold Management.

The Utilities > Counter Seat Hold Management page displays.
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3. In the Season drop-down list, select the season that contains the event for which you want
seat status changes.

Note: The default season is the operator's default season which is set in the Season field of
the tRes Operator Access (TK.OP.E) setup. If the operator has no default season, the default
will be the first season in the season list. The seasons are listed in descending order by the
Sort field values in their Season Status (TK.SEASON.E) configurations. If two or more sea-
sons have the same Sort Order value, they are sorted in ascending order by their season
codes.

4. In the Event text box, find the event code or the event name by entering a search term (for
example, all or part of the event code, event name, a keyword, a date, or a facility) and then

clicking the Go buttonx .

5. If the Multiple events found form displays, click the primary event.

The Utilities > Counter Seat Hold Management page redisplays with the seat map for the
event.

Pac7 Release 7.2

http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/maintenance/Season_Status.htm


User Guide  901

The seat map is functionally the same one that is used for Item Sales, except for several
options that are specific to the Counter Seat Hold Management utility.

6. In the seat map toolbar, click the Change seat status by Level:Section buttonx . The
Change seat status by Level:Section form is displayed.

Note: If you want to view the seat map temporarily while completing this form, click the
minus buttonx on the right side of the title bar. The form will minimize to the title bar
only. Click the plus buttonx to redisplay the form.

Pac7 Release 7.2



User Guide  902

7. If you want to change seats that are on counter hold, for Counterhold click the Yes option.

If you click No, the form will redisplay to allow you to change multiple seat statuses. The util-
ity will then function the same as the Seat Hold Management utility. For more information,
see this section in Using the Seat Hold Management Utility.

8. In Current seat status, enter the counter hold seat status.

9. From the Level:Section drop-down list, select a level:section. You will be able to add more
level:section combinations as you complete the entries in the Lev:Sec table.
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10. Use the RFrom, RTo, SFrom, and STo boxes to add entries to the Lev:Sec table. To add
entries for another level:section, select it from the Level:Section drop-down list, and then
repeat this step. You can also add subsets of rows and seats from the same level:section in
this table. The Qty column contains the number of seats in the Level:Section that have the
counter hold status you entered in Current seat status above. This column is not editable.

The methods you can use to configure a level:section in the Lev:Sec table are demonstrated
in the following example.

The table below shows an example of how to set the RFrom, RTo, SFrom, and STo box
values when adding rows to the Lev:Sec table.
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If you
want
this
selec-
tion...

Use this text box con-
figuration... And you will get this result...

All seats
& rows

Same
seat sub-
set for all
rows

All seats
in a sub-
set of
rows

A subset
of seats
in a sub-
set of
rows

11. In the Change To group, select the new status from the New seat status drop-down list.
This status will be assigned to all the seats that are selected by the configuration of the Cur-
rent status and Lev:Sec tables in the Change From group.

To make it easier to work in the Change To group, minimize the Change From group by
clicking Change From. Click Change From again to maximize the Change From group.
You can also minimize and maximize the Change To group by clicking Change To.
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12. If you want to change the statuses of the same seats for other events from the current sea-
son, enter a search term in the Select other events to update (optional) box, and then

click the plus buttonx . The Items Found form displays with the results of your search.
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13. Select one or more events, and then click the Apply buttonx . There is no noti-
fication if one or more seat statuses cannot be changed for any of the selected events. The
statuses will be changed whenever applicable for each of the selected events.
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Chapter 10 Administration

If you have the correct permissions, you can perform any of the following administrative tasks:

l Manage users—Create and maintain individual users, roles, groups, and report views.
l Manage business organizations—Set up, edit, and view business organization locations,
users, and status. You can also setup and change your password policy.

l Manage terminals—Configure which terminals print tickets, analyze network connection
speed, assign terminals to new locations, reset/disable terminals, and activate terminals in a
location.

l Prepare for an onsale and conduct an onsale.

Managing Users
Both data account permissions and roles must be assigned to users before they can use Pac7. Data
Account permissions determine a user’s permissions for a particular data account and can vary
between inventories. (For example, a user may be able to reprint tickets in one data account, but
not in another.) These permissions are granted by assigning users data account operator access
codes.

You can also set up user roles to assign users permissions that apply to Pac7 generally, regardless
of the data account used. (For example, the roles assigned to users determine whether or not they
can change their password or reset a terminal.) In addition, you can create and assign by role mul-
tiple views for the BOCA sales summary report.

For more information, see the following:

l To assign one or more roles to a user, see Managing Individual Users.
l To assign data account permissions to one or more users, see Managing Groups of Users.
l To create BOCA sales summary report views that can be assigned to user roles, see
Managing BOCA Sales Summary Report Views.

l To configure roles, see Managing User Roles.

Managing Individual Users
A user is any individual or group of individuals configured to use Pac7. The group of individuals
includes multiple people with the same user ID. To configure users, you configure their inform-
ation, roles and permissions. Once created, you can modify user settings or information. You can-
not, however, delete users— you can only inactivate them. To create or modify individual users,
use the procedure below.

When setting up user roles, you may also not allow users assigned a role to update their own pass-
words. (The assigned role does not have the Manage My Account Password permission enabled.)
When passwords expire for the users assigned a role without these permissions, they will be
locked out of the system. For these users, you must enter a new password.

When setting the password policy for your business organization, you are required to set the max-
imum number of failed logins users can attempt. If users enter an incorrect password the max-
imum number of times, they will be locked out of the system. If these users do not already have
accounts, you must create accounts for them. If users have accounts and you want them to have
access to the system, you can unlock their accounts.

To create or modify an individual user

1. In the Pac7 menu, click the Admin link.
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Pac7 displays the Administration page.

2. Click Manage Individual Users to display the Manage Individual Users page.

3. To create a new user, click the Create New User buttonx . Pac7
displays the Manage User page.
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4. To modify an existing user, do the following:

a. Enter any of the user's parameter values, and then click Search.

Parameter Description

User Name The name with which the users logs in.

Last Name The last name of the user.

First Name The first name of the user.

Phone # The phone number at which the user can be reached while using Pac7.

Email The email address at which the user can be reached while using Pac7.

Status The current status of the user:

l Active - the user can use Pac7
l Inactive - the user cannot use Pac7

Pac7 displays the Search Results.

b. In Name, click the name of the user that you want to modify. Pac7 displays the Manage
User page.
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5. In the Add/Update User box, enter or modify the user information, as required.

Parameter Description

First Name The first name of the user.

Last Name The last name of the user.

User Name The name used to login. Each name must be unique.

New Password The password for the user. The password must be between 8 and 20 char-
acters in length. Passwords expire after 90 days.

Confirm New
Password

The password for the user, entered a second time to ensure accuracy.

Days Until Pass-
word Expires

A read-only value representing the number of days until the user's pass-
word will expire.

User Status The current status of the user:

l Active - the user can use Pac7
l Inactive - the user cannot use Pac7

Phone The phone number at which the user can be reached when using Pac7.

Email The email address at which the user can be reached when using Pac7.

Language Select the language shown in Pac7 for this user.

6. In the Assign User Access Rights box, enter or modify the assigned roles and data account
permissions, as required.

Parameter Description

Role Select the roles to assign to the user Multiple roles can be assigned to the
same user. Click on a role to display the current permissions assigned to the
role. (For more information on roles, see Managing User Roles.)

Pac7 Release 7.2



User Guide  912

Parameter Description

Data
Account
Operator

Select the permissions the user has for each data account by selecting an Oper-
ator Code. (For more information on inventory permissions, see Managing
Groups of Users.) Inventory permissions determine what a user can access in
a data account.

7. Do one of the following:

l Click Admin Menu to return to the Administration page.
l Click Search for Another User to return to the Manage Individual Users page
without saving the user.

l Click Save & Create Another to save the user without leaving the page.
l Click Save to save the user and return to the Manage Individual Users page.

To enter a new password for a user whose password has expired

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.
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2. Click Manage Individual Users to display the Manage Individual Users page.

Tip: You can use the Pac7 user search to locate all users with a password that will soon
expire. To see a list of all users and their password expiration dates, leave the user para-
meter fields blank, and then click the Search button. In the search results, check the Days
Until Password Expires column.
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3. Enter any of the user's parameter values, and then click Search.

Parameter Description

User Name The name with which the users logs in.

Last Name The last name of the user.

First Name The first name of the user.

Phone # The phone number at which the user can be reached while using Pac7.

Email The email address at which the user can be reached while using Pac7.

Status The current status of the user:

l Active - the user can use Pac7
l Inactive - the user cannot use Pac7

Pac7 displays the Search Results with (Locked) displayed by the UserName.

4. In the Name column, click the linked name of the user for whom you would like to update the
password. Pac7displays the Manage User page.
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5. In New Password and Confirm New Password, enter a new password, and then click Save.

Note: New passwords are subject to different rules. For information, see Setting the Pass-
word Policy.

To unlock a locked out user

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.
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2. Click Manage Individual Users to display the Manage Individual Users page.

3. Enter any of the user's parameter values, and then click Search.

Parameter Description

User Name The name with which the users logs in.

Last Name The last name of the user.

First Name The first name of the user.

Phone # The phone number at which the user can be reached while using Pac7.

Email The email address at which the user can be reached while using Pac7.

Status The current status of the user:

l Active - the user can use Pac7
l Inactive - the user cannot use Pac7

Pac7 displays the Search Results with (Locked) displayed by the UserName.
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4. In the Name column, click the linked name of the locked out user. Pac7 displays the Unlock
User version of the Manage User page.

5. In both temporary password fields, enter the temporary password for the locked out user,
and then click the Save button.

6. Do one of the following:

l · If the user can change a password (is assigned a role with the Manage My Account Pass-
word permission enabled), send the user the temporary password. The user is no longer
locked out, but will be required to change the password at the next log in.

l If the user cannot change a password (is assigned a role that does not have the Manage
My Account Password permission enabled), modify the user with a new password, and
then send the user the new password.

Managing Groups of Users
Data Account permissions determine the information a user can access in a data account. When
you create a user in Pac7, the user is assigned permissions (operator access codes from tRes) for
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one or more data accounts. When managing groups of users, you can assign data account per-
missions to multiple users simultaneously. This is useful when reconfiguring permission levels or
adding a new data account from which to sell.

To manage groups of users

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.

Note: You can only access this page if your role grants you access. If you do not have
access, this page, or links on this page, are not displayed.

Tip: You can view a list of users who are active (currently logged in) for the business organ-
ization at any time.

2. Click Manage Groups of Users to display the Manage Groups of Users page.
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3. From the Data Account list, select the data account to which you want to assign users.
When you select a data account, Pac7 redisplays the Manage Groups of Users page with
the Operator field.

4. From the Operator list, select the operator code that defines the permissions the users have
for the selected data account. (These permissions are configured for the data account by cre-
ating operator access using TK.OP.E in tRes. Contact the data account owner for more inform-
ation.) When you select the operator permissions, Pac7 redisplays the Manage Groups of
Users page with the Users and Assigned to Operator fields.

5. Move users between the Users and Assigned to Operator fields until Assigned to Operator
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only contains users that are assigned to the operator selected above. Move users with the fol-
lowing buttons:

Button Description

Moves the selected user from Users to Assigned to Operator.

Moves all users from Users to Assigned to Operator.

Moves the selected user from Assigned to Operator to Users.

Moves all users from Assigned to Operator to Users.

6. Do one of the following:

l Click Admin Menu to return to the Administration page without saving your changes.
l Click Save & Create Another to save the permission assignment without closing the
page.

l Click Save to save the permission assignment and return to the Administration page.

Managing BOCA Sales Summary Report Views
Note: To manage report views, you must be assigned a role that is configured with the Manage
Boca Cash Summary Report Views permission selected on the Manage User Roles page.

You can create multiple report views for the BOCA Sales Summary Report and then assign different
views to individual user roles. Views allow you to control the content that prints in the report for
users by their role assignment (usually assigned by location), and thereby eliminate the need for
users to set up their reports each time they run them.

For each view, you can set whether the subtotal of each paymode is made by payment type or pay-
ment code. This allows you to separate payment modes from a common payment type. For
example, the payment type CK could include a variety of checks (personal, business, travelers,
etc.) that you need to subtotal separately. The view settings allow you to subtotal them individually
by their payment codes instead of in one subtotal by their common payment type (CK).

Views also allow you to decide whether to include item and order charge sales totals, in addition to
the listed paymode subtotals. This allows you to check your cash drawer balances by comparing
item and order charge totals to the paymode subtotals. This option is especially useful when you
have mandated full payment at the role location to which you are assigning the report view. The
item and order charge details include the following:

l Item quantity
l Surcharges
l Item subtotal
l Item amount
l Item charges
l Order charges/Delivery charges
l Discounts
l Facility fees
l Total

To create or edit a BOCA sales summary report view

1. In the Pac7 menu, click the Admin link.
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Pac7 displays the Administration page.

2. Click Manage Boca Sales Summary Report Views to display the Manage Boca Sales
Summary Report Views page.
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3. Using the View list, do one of the following:

l Select Create a New View to define a report view.
l Select an existing view to modify its settings. When you select a view, Pac7 redisplays the
page with the view's settings.

4. In View Name, enter or modify the name of the view.

Note: If you are creating a new view, you must enter a new name.

5. For each paymode type, select By Payment Type or By Payment Code.

6. Under Sales Report Options, select or clear the Include Item and Order Charge Sales Totals
option.

7. Do one of the following:
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l Click Save & Create Another to save the view without closing the page.
l Click Save to save the view and return to the Administration page.
l Click Admin Menu to return to the Administration page without saving your changes.

8. Assign views to user roles as required. For information about editing or creating user roles,
see Managing User Roles.

Managing User Roles
When a user is created, one or more roles must be assigned to that user. A role contains per-
missions specific to Pac7 that define what a user is able to do in the application. (For example,
whether or not a user can change their password or reset a terminal.) Pac7 includes a set of default
roles. You can use the default roles, create new roles, and modify both the default and created
roles.

Administration Options Reporting Options

Manage My Account Password

Allows users assigned the role to change
their passwords. If you do not allow them
to change passwords, they can still access
the My Account page to change other
account information, including name,
phone number, email address, and lan-
guage. For more information, see Updating
Your Account Information.

Manage User Access

Allows users assigned the role to configure
the information, roles, and permissions of
other users. Users assigned the role can
also inactivate (but not delete) other
users. For more information, see Managing
Individual Users.

Manage User Roles

Allows users assigned the role to modify
existing roles or create new roles. This
topic contains all the information about
managing user roles.

Manage Business Organization Locations

Allows users assigned this role to create or
edit the locations at which you are
installing ticketing terminals. For more
information, see Creating Business Organ-
ization Locations.

Manage Password Policy

Allows users assigned this role to cus-
tomize the password policy for the entire
business organization. For more inform-
ation, see Setting the Password Policy.

BOCA Sales Summary Report

Allows users assigned the role to generate a
BOCA Sales Summary Report. This report
tracks daily ticket sales for a user or terminal.
For more information, see Generating the
BOCA Sales Summary Report.

Select View

Sets the view used to generate the BOCA Sales
Summary Report. The BOCA Sales Summary
Report permission must be selected for this
option to be available. For more information,
see Managing BOCA Sales Summary Report
Views.

Allow this report to be printed on ticket stock

Allows users assigned the role to print the
BOCA Sales Summary Report on ticket stock.
BOCA Sales Summary Report must be selected
for this option to be available. For more inform-
ation, see the Reports Overview.

Sales Summary Report

Allows users assigned the role to generate a
sales summary report for a business organ-
ization. This report shows, for the specified
time frame, the number of items sold, the num-
ber of orders, and the total sales. For more
information, see Generating the Sales Sum-
mary Report.

Sales Summary by Item Report

Allows users assigned the role to generate a
sales summary by item report for a business
organization. This report shows, for the spe-
cified time frame, the number of items sold,
the number of orders, and the total sales of
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Administration Options Reporting Options

Manage Terminal Setup Password

Allows users assigned this role to change
the password used to activate the ter-
minals for your business organization.
Users assigned this role can also set when
the current password will expire. For more
information, see Changing the Terminal
Setup Password.

View Active Users

Allows users assigned this role to view a
list of currently logged on users. For more
information, see Viewing Active Users.

View Massload Status

Allows users assigned this role to monitor
the status of data massloads for the Pac7
system. For more information, see View-
ing Massload Status.

Analyze Network Connection Speed

Allows users assigned this role to compare
the current network connection speed to
typical network speeds. For more inform-
ation, see Analyzing Network Connection
Speed.

Change Terminal Ticket Printer

Allows users assigned this role to select
the ticket printer to which a terminal will
print. For more information, see Modifying
a Ticket Printer.

Change Terminal Location

Allow users assigned the role to change the
terminal location assigned to a ticketing
terminal. For more information, see
Changing the Terminal Location.

Reset Terminal

Allows users assigned the role to disable
ticket terminals. Once disable, you react-
ive the terminal by logging into the ter-
minal. For more information, see Resetting
Terminals.

each item. For more information, see Gen-
erating the Sales Summary by Item Report.

Sales Summary by User Report

Allows users assigned the role to generate a
sales summary by user report for a business
organization. This report shows, for the spe-
cified time frame, the number of items sold,
the number of orders, and the total sales of
each user. For more information, see Gen-
erating the Sales Summary by User Report.

Sales Summary by Paymode Report

Allows users assigned the role to generate a
sales summary by user report for a business
organization. This report shows, for the spe-
cified time frame, the number of items sold,
the number of orders, and the total sales for
each paymode used to place an order. For
more information, see Generating the Sales
Summary by Paymode Report.

Detailed Transaction Report by Batch

Allows users assigned the role to generate
detailed information about the transactions in a
batch for a specific data account. This report
lists all transactions that were recorded to a
specific batch for one data account. For more
information, see Generating a Detailed Trans-
action Report by Batch.

Balancing Report by Per Ticket Fee

Allows users assigned the role to generate a
report that tracks sales per data account by
item fee. This report can be used to settle fees
between a data account and a selling organ-
ization. For more information, see Generating
a Balancing Report by Item Fee.

Return Authorization Report

Allows users with the role to generate a report
that shows all returned orders that have been
assigned alternate user information and dis-
plays the users who assigned alternate data.
For more information, see Generating a Return
Authorization Report.

To modify or create user roles

1. In the Pac7 menu, click the Admin link.
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Pac7 displays the Administration page.

2. Click Manage User Roles to display the Manage User Roles page.
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3. In Role, do one of the following:

l Select Create a New Role to define a new user role.
l Select an existing role to modify its permissions. Once selected, Pac7 displays the role's
settings, including the users assigned to the role.

4. In Role Name, enter or modify the name of the role.

Note: If you are creating a new role, you must enter a name.

5. In Permissions, configure the permissions for this role:

Administration Options Reporting Options

Manage My Account Password

Allows users assigned the role to change
their passwords. If you do not allow them
to change passwords, they can still access
the My Account page to change other
account information, including name,
phone number, email address, and lan-
guage. For more information, see Updating
Your Account Information.

Manage User Access

Allows users assigned the role to configure
the information, roles, and permissions of
other users. Users assigned the role can
also inactivate (but not delete) other
users. For more information, see Managing

BOCA Sales Summary Report

Allows users assigned the role to generate a
BOCA Sales Summary Report. This report
tracks daily ticket sales for a user or terminal.
For more information, see Generating the
BOCA Sales Summary Report.

Select View

Sets the view used to generate the BOCA Sales
Summary Report. The BOCA Sales Summary
Report permission must be selected for this
option to be available. For more information,
see Managing BOCA Sales Summary Report
Views.

Allow this report to be printed on ticket stock
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Administration Options Reporting Options

Individual Users.

Manage User Roles

Allows users assigned the role to modify
existing roles or create new roles. This
topic contains all the information about
managing user roles.

Manage Business Organization Locations

Allows users assigned this role to create or
edit the locations at which you are
installing ticketing terminals. For more
information, see Creating Business Organ-
ization Locations.

Manage Password Policy

Allows users assigned this role to cus-
tomize the password policy for the entire
business organization. For more inform-
ation, see Setting the Password Policy.

Manage Terminal Setup Password

Allows users assigned this role to change
the password used to activate the ter-
minals for your business organization.
Users assigned this role can also set when
the current password will expire. For more
information, see Changing the Terminal
Setup Password.

View Active Users

Allows users assigned this role to view a
list of currently logged on users. For more
information, see Viewing Active Users.

View Massload Status

Allows users assigned this role to monitor
the status of data massloads for the Pac7
system. For more information, see View-
ing Massload Status.

Analyze Network Connection Speed

Allows users assigned this role to compare
the current network connection speed to
typical network speeds. For more inform-
ation, see Analyzing Network Connection
Speed.

Change Terminal Ticket Printer

Allows users assigned this role to select
the ticket printer to which a terminal will
print. For more information, see Modifying

Allows users assigned the role to print the
BOCA Sales Summary Report on ticket stock.
BOCA Sales Summary Report must be selected
for this option to be available. For more inform-
ation, see the Reports Overview.

Sales Summary Report

Allows users assigned the role to generate a
sales summary report for a business organ-
ization. This report shows, for the specified
time frame, the number of items sold, the num-
ber of orders, and the total sales. For more
information, see Generating the Sales Sum-
mary Report.

Sales Summary by Item Report

Allows users assigned the role to generate a
sales summary by item report for a business
organization. This report shows, for the spe-
cified time frame, the number of items sold,
the number of orders, and the total sales of
each item. For more information, see Gen-
erating the Sales Summary by Item Report.

Sales Summary by User Report

Allows users assigned the role to generate a
sales summary by user report for a business
organization. This report shows, for the spe-
cified time frame, the number of items sold,
the number of orders, and the total sales of
each user. For more information, see Gen-
erating the Sales Summary by User Report.

Sales Summary by Paymode Report

Allows users assigned the role to generate a
sales summary by user report for a business
organization. This report shows, for the spe-
cified time frame, the number of items sold,
the number of orders, and the total sales for
each paymode used to place an order. For
more information, see Generating the Sales
Summary by Paymode Report.

Detailed Transaction Report by Batch

Allows users assigned the role to generate
detailed information about the transactions in a
batch for a specific data account. This report
lists all transactions that were recorded to a
specific batch for one data account. For more
information, see Generating a Detailed Trans-
action Report by Batch.

Balancing Report by Per Ticket Fee
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Administration Options Reporting Options

a Ticket Printer.

Change Terminal Location

Allow users assigned the role to change the
terminal location assigned to a ticketing
terminal. For more information, see
Changing the Terminal Location.

Reset Terminal

Allows users assigned the role to disable
ticket terminals. Once disable, you react-
ive the terminal by logging into the ter-
minal. For more information, see Resetting
Terminals.

Allows users assigned the role to generate a
report that tracks sales per data account by
item fee. This report can be used to settle fees
between a data account and a selling organ-
ization. For more information, see Generating
a Balancing Report by Item Fee.

Return Authorization Report

Allows users with the role to generate a report
that shows all returned orders that have been
assigned alternate user information and dis-
plays the users who assigned alternate data.
For more information, see Generating a Return
Authorization Report.

l Select checkboxes to assign permissions to the role.
l Clear checkboxes to exclude permissions from the role.

6. Do one of the following:

l Click Save & Create Another to save the user role without closing the page.
l Click Save to save the user role and return to the Administration page.
l Click Admin Menu to return to the Administration page without saving your changes.

Managing Business Organizations
Business organizations are the entities through which you sell tickets. A business organization may
have multiple selling locations, each using one or more ticketing terminals. Each business organ-
izations can manage its terminal user (ticket seller) and sales reports separately from other busi-
ness organizations.

To manage business organizations, you can do the following:

l Create business organization locations.
l Set the password policy.
l Change the terminal setup password.
l View the currently active terminal users.
l View the status of data massloads.

Creating Business Organization Locations
Locations determine where sales are reported. You can create or edit locations for a selling organ-
ization to define each place you install a ticketing terminal. Each location must have a time zone
assigned, so that time stamps are correct.

To create a business organization location

1. In the Pac7 menu, click the Admin link.
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Pac7 displays the Administration page.

2. In the Business Organization group, click the Manage Business Organization Locations link.
Pac7 displays the Manage Business Organization Locations page.
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3. In Location, do one of the following:

l Select Create a new location to define a new location for your business organization.
l Select Default location to define the default location.

4. Enter or modify the following parameters for the selected location.

Parameter Description

Location Name Enter a unique name for the location (this field is required).

Location Status Select the current status of the location:

l Active - The location can sell tickets.
l Inactive - The location cannot sell tickets.

Phone Enter the phone number of the location.

Location
Address

Enter the address of the location.

Address Type Select the address type for the location:

l US/Canada
l International

City/Town Enter the city or town for the location.

State/Province Select the state or province for the location.

International
Province/Region

Enter the province or region for the location.

Zip/Postal Code Enter the Zip or postal code for the location.
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Parameter Description

Country Select the country for the location.

Time Zone Select the time zone for the location. The system needs to know the time
zone of the location to display for ticket sellers and to create time stamps,
since events in Pac7 can be sold from inventories in different time zones.

5. Do one of the following:

l Click Admin Menu to leave the page without creating a selling organization location.
l Click Save & Create Another to create the selling organization location without leaving
the page.

l Click Save to create the selling organization location and return to the Administration
page.

Setting the Password Policy
For security reasons, each Pac7 user must use a password to log into the system. While the basic
password requirements are built into the system, you can customize your policy by setting the fol-
lowing:

Note: To set the password policy, you must be assigned a role with the Manage Password Policy
permission enabled. See Managing User Roles for information about enabling permissions for
roles.

l The number of login failures a user can have before being locked out of the system (between
3 and 6). If a user is locked out, you will need to unlock the account.

l The number of days after it is created at which a password must be changed (30, 45, 60, 75,
or 90). At the end of this number of days, the system will require that users enter a new pass-
word by displaying the Change Password page. The new password may not be the same as
any of the last four passwords used.

l The number of days before their passwords expire that users are warned by the system (5,
7, or 10). If users log in after their password has expired, they will be automatically redir-
ected to a password change page.

l The minimum number of characters required for password length (between 7 and 10). Pass-
words must also contain at least one alphabetical and one numerical character.

These settings apply to your entire business organization. If you do not set the password policy,
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the system uses its default settings.

l Maximum number of login failures before being locked out is 6
l Password lifetime is 90 days
l Password warning period before expiration is 10 days
l Minimum password length is 7

Note: When you change a password, the new password cannot be the same as any of the last four
passwords used.

To set the password policy

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.

2. In the Business Organization group, click the Manage Password Policy link. Pac7 displays the
Manage Password Policy page.
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Note: If you do not see the Manage Password Policy link, your role is does not have the Man-
age Password Policy permission enabled. See Managing User Roles for information about
enabling permissions for roles.

3. For each of the password policy settings, accept the default setting or select a new value. For
more information about the settings, see the descriptions in the overview above.

4. Click the Save button. The settings saved, and Pac7 redisplays the Administration page.

Changing the Terminal Setup Password
Changing the terminal setup password enables you to manage the password used to activate ter-
minals for your selling organization. Users must know both the Terminal Setup ID and the Terminal
Password to activate the terminal. Once activated, users can log in without having to activate the
terminal.

To change the terminal setup password

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.
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2. In the Business Organization group, click the Manage Terminal Setup Password link.
Pac7 displays the Manage Terminal Setup Password page. This page displays the current
Terminal Setup ID for the terminal.

3. Enter values for the parameters on this page according to the following table:

Parameter Instructions

Terminal
Setup Pass-
word

Enter the new password for terminal setup. The new terminal setup password
cannot be the same as the last password.

Confirm
Password

Enter the same password you entered for the Terminal Setup Password.

Password
Expires In

(Optional) Enter the number of minutes until this password expires (not neces-
sary if you select Do Not Expire this Password).

Do Not
Expire this
Password

(Optional) Select this option to keep the password from expiring. If this
option is cleared, the password expires at the time entered for Password
Expires In above.

4. Do one of the following:
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l To return to the Administration page without changing the settings, click the Admin
Menu button.

l To modify the settings and return to the Administration page, click the Save button.

Viewing Active Users
You can view a list of all currently logged in users, as well as their business organization names
and the time each one logged in to the system.

To view active users

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.

2. In the Business Organization group, click the View Active Users link. Pac7 displays the View
Active Users page.
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Viewing Massload Status
This function allows you to see the status of data massloads for Pac7. Data account managers can
check this screen to find out why data changes made in tRes are not showing up in Pac7. When
viewing massload status, note the following:

l If a massload is in progress, all data syncs will be blocked until the massload completes.
l If a massload fails, try the same massload again. If it fails a second time, contact Paciolan
Customer Support.

l If a massload is successful, the status will be Completed.

For any massload in progress, the user can click on the ID of the massload to view the details of
the files that were loaded.

To view data massload status

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.
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2. In the Business Organization group, click the View Massload Status link. Pac7 displays the
View Massload Status page.

3. From the Data Account list, select the data account about which you want massload status
information.

4. From the Status list, select the status of the massloads you want to view, and then enter the
number of hours back for which you want to include massloads.

5. Click the Submit button. Pac7 displays the massloads and their details in a table below the
selection criteria. To monitor the progress of a massload from this page, click the Refresh
button periodically.
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Tip: For descriptions of all the massload terms and statuses, click the Massload Glossary
link.

6. To view the details of a massload and each of the files that were loaded, click the linked
entry in the Status column. Pac7 displays the View Massload Details page.

Managing Terminals
Terminals are the hardware on which ticket sellers use the Pac7 software. You install terminals at
each physical location where your business organization needs to sell tickets. To manage these ter-
minals, you can do the following:

l Configure terminals.
l Configure terminal ticket printers.
l Analyze terminal network connection speeds.
l Change terminal locations.
l Reset/disable terminals.

Configuring Terminals
Pac7 allows you to sell tickets for one or more data accounts. Data accounts are groups of tickets
controlled by a single data account owner that may or may not be associated with a single venue.

This web-based application has certain PC setup requirements to be able to access the application.
To configure terminals, you should do the following:

1. Make sure the terminal meets the system requirements. For more information, see the Pac7
release notes.
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2. Configure the browser application.
3. Activate the terminal.
4. Configure Application Access.
5. Test user logins.

Configuring Browsers

Disable Auto Complete

You should disable the auto password on the browser settings for security purposes so the pass-
word is not defaulted on the login page. For example, this may be an issue for an outlet where mul-
tiple users are logging into the same terminal.

For Internet Explorer, do the following to disable auto-filling password:

1. From the Tools menu, select Internet Options, and then click Content tab.
2. In the Personal Information group, click Auto Complete.
3. In the AutoComplete Settings dialog box, clear the User Names and Passwords on Forms
option.

Configure Toolbar

Note: Pac7 does not support the use of the Back, Forward and Refresh buttons. These buttons will
not function as they do for typical Web sites, and using them may result in Pac7 errors. (See an
example.)

Turn off the browser's Menu and Command toolbar, so the operators cannot see them. This will
help them avoid clicking unsupported buttons.

1. (Internet Explorer) From the View menu, point to Toolbars and clear the Menu Bar and Com-
mand Bar options.

Third Party Toolbars

Many web sites supply users with additional toolbars that can be installed on the browser. The most
common ones are from Yahoo!, MSN and Google. Those toolbars can cause issues with the applic-
ation because they have certain auto fill features which need to be disabled use the application as it
was designed. Issues have been identified with the Google and MSN toolbars, but others toolbars
could have similar problems.
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If possible, the terminal should be set up with no additional toolbars installed, but if they are
installed the auto fill needs to be disabled.

To disable Auto Fill in Google

1. In your browser's Google Toolbar Options, click Options.

2. Under Accessories, clear AutoFill and click OK.

To disable Auto Fill in MSN

1. In your browser's MSN Toolbar Options, click Options.

2. Under Form Fill, clear the Turn On Form Fill option.

3. Under Highlight, clear the Turn on Highlight option, and then click OK.

Popup Blockers

Popup blockers should be disabled. If your organization requires that you use one, please allow pop
ups from the URL that is running the application. If popups are blocked it will prevent tickets from
being printed and prevent some event detail content from being viewed.

Activating the Terminal

The terminal must be activated by specifying the terminal activation ID and password. The ter-
minal must have the printers setup to correctly activate the terminal (see Configuring Terminal
Ticket Printers).

Typically the terminal only needs to be activated one time, after this process is complete the user
will see the login screen when the shortcut or bookmark is accessed. The printer and location setup
can be modified in the Administration section if needed.

To activate the terminal

1. Open the Internet Explorer browser. Be sure that there is only one instance of the browser
open during terminal activation. Enter the URL for your organization that was provided by
Paciolan. (You will need to expose the address bar for this process, but once this step is com-
plete, that toolbar should be taken off of the browser by configuring the browser toolbar.)

2. The application will check the system to verify if the Java Runtime Environment needs to be
installed, and if yes, it will step through that process.

3. On the Please Activate the Terminal page, enter the Terminal Setup Id and Terminal
Setup Password (provided by Paciolan or the ticket manager), and then click the Activate
Terminal button.
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4. From the Select a Location list, select a location, and then click the Save button.
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5. From the select ticket printer lists, select a BOCA printer and a laser printer. If tickets are
not printed from this terminal for a printer type, select None in the applicable printer list
(BOCA or Laser or both lists).

Note: The printer type ticket operators print to is determined by the policy (control) in which
they are working.

6. Click the Save button.
7. If desired, test the print alignment of one or both printer types.

8. Click the Save button. Pac7 displays the Sign In page.
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Configuring Application Access

Once the terminal has been activated and the login page loads, it is recommend that the friendly
URL is saved as a bookmark by following the steps below. If you create a desktop shortcut it should
be created once the steps below are followed to assure that the application can function properly.

A unique URL will be assigned to each Business Organization. The friendly URL that was provided
by Paciolan should be bookmarked and added to the Favorites in the browser.

To add to Favorites

1. Click on URL that was provided by Paciolan. The login page should load if the terminal has
already been activated.

2. On the browser menu, click Favorites > Add to Favorites to display the Add Favorite dialog
box.
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3. Give the bookmark an easy-to-recognize name.

Note: A “friendly” URL must be saved for the application to function properly. You must
manually edit the URL because the URL that was saved from the login page is different. The
friendly URL will have the following format: http://www.en-
terpriseticketing.com/site/YourOrganization.

4. From the Favorites menu, right-click the saved URL, and then select Properties. The browser
displays the favorite's Property dialog box with the Web Document tab selected.

5. In the URL box, enter the friendly URL, and then click OK.

Testing User Logins

To test user logins

1. Click on the desktop shortcut or the bookmarked location. Your browser displays the Warning
- Security dialog box.
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2. Do one of the following:

l Click Yes to continue. The security warning will display each time you log in.
l Click Always to continue. The security warning will not display again.

Pac7 displays the sign in page.

3. Enter your user name and password. User names are case-sensitive. Passwords are case-
sensitive and must be a minimum of eight characters in length.

4. Click Sign In to login to Pac7. The Select Data Account page displays.
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5. Click the Data Account with which you will be working. To change Policies, click the Select
link in the Header to return to this page.

6. Verify that the time zone is correct for the location that you have selected. Look in the upper
right area next to the user name. If the time zone is incorrect, complete Assigning Location
Time Zone.

Configuring Terminal Ticket Printers
Note: This procedure is for configuring ticket printers in MS Windows. You must make sure this is
done before you can set printers up in Pac7.

To configure the terminal ticket printer, the printer must first be added to the terminal. You can
then configure the terminal ticket printer in the Change Terminal Ticket Printer page. A ter-
minal ticket printer only needs to be configured if tickets are printed at the time of order. If tickets
are batch printed at a later time, a terminal ticket printer does not need to be configured. Tickets
can be printed on either a BOCA or a laser printer.

To configure a terminal ticket printer

1. Verify that the BOCA or laser printer is either connected to the terminal’s serial port or to the
network.

2. Click Start Menu > Printers and Faxes, and then verify that the printer has been added to the
terminal in the Printers and Faxes window.

3. Do one of the following:

l If the printer has already been added, this process is complete and you can activate the
terminal.

l If the printer has not been added, go to Step 4.

4. In the Printers and Faxes window, double-click Add Printer to start the Add Printer Wizard
window.

Pac7 Release 7.2



User Guide  947

Note: Depending upon your Windows platform, the steps and windows in the Add Printer Wiz-
ard may vary.

5. Click Next to display the Local or Network Printer window.

6. Select one of the following:

l Select Local printer if the printer is directly attached to the terminal, then click Next to dis-
play the Select the Printer Port window (go to step 7).
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l Select Network printer if the printer is attached to another terminal or the network (go to
Step 13).

7. Click Next to open the Select the Printer Port window.

8. Select the Use the Following Port option, then, from the list, select the port to which the
printer is connected.
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9. Click Next to open the Add Printer Wizard window, and then do one of the following:

l For a BOCA printer, select Generic from the Manufacturers list. Then, select Generic/Text
Only in Printers list.

l For a laser printer, select the printer's manufacturer from the Manufacturers list. Then,
select the printer name from the Printers list.

10. Click Next to finish configuring the printer.

11. Enter the location of the printer, then click Next to display the Default Printer window.
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12. Select whether or not the printer is the default printer for Windows-based programs, then
click Next.

13. Click Finish to add the printer.

Modifying a Ticket Printer

To modify a ticket printer

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.
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2. In the Terminal Administration group, click the Change Terminal Ticket Printer link. Pac7 dis-
plays the Change Terminal Ticket Printer page.

3. In the select printer lists (BOCA or Laser), select the printer to which Pac7 prints tickets.
Select None if tickets are not printed to one or both printer types (BOCA or Laser).

Note: The printer type ticket operators print to is determined by the policy (control) in which
they are working.

4. If desired, test the print alignment of one or both printer types.
5. To Save the ticket printer modifications, click the Save button.

Testing Printer Alignment

To test printer alignment

1. If Pac7 is not already at the Change Terminal Ticket Printer page, do the following:
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a. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.

b. In the Terminal Administration group, click the Change Terminal Ticket Printer link. Pac7
displays the Change Terminal Ticket Printer page.
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2. Click the Test Print Alignment button. Pac7 displays the alignment version of the Change
Terminal Ticket Printer page.

3. Select the Data Account and the type of item (Ticket, Non-Allocatable, Mailer, or Receipt)
you want to test print.

4. Select the print form with which to test the item type. The print forms listed include forms
for both BOCA and laser printing. To test a BOCA printer, select a BOCA form (for example,
BOCA.10). To test a laser printer, select a laser form (for example, LASER.10). Both the
BOCA and laser print forms listed are specific to the type of item you selected (Ticket, Non-
Allocatable, Mailer, or Receipt).

Note: Laser forms will only be available if you have the laser printing option enabled for the
current data account. Contact Paciolan for more information about this option.

5. Click the Continue button. Pac7 displays a data selection version of the page.
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6. Select the season and the item that you want to use for test printing, and then click the Test
Print button. Pac7 prints the test page and displays a confirmation message.

7. In the confirmation window, click OK.

8. To redisplay the printer selection page, click the Select Ticket Printer button.

Analyzing Network Connection Speed
Pac7 allows you to see the current network connection speed at any time, by running a preset test
and displaying the result. For comparison, Pac7 also displays the typical network speeds for the
most common network connection types.

To analyze network connection speed
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1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.

2. In the Terminal Administration group, click the Analyze Network Connection Speed
link. Pac7 displays the Analyze Network Connection Speed page.

Pac7 Release 7.2



User Guide  956

Changing the Terminal Location
You can change the terminal location assigned to a ticketing terminal at any time. For example,
you may have physically moved the terminal to another location or the business organization loc-
ation name currently configured may become obsolete. In either case, you will need to set a valid
terminal location for the ticketing terminal.

To change the terminal location of a ticketing terminal

1. In the Pac7 menu, click the Admin link.

Pac7 displays the Administration page.
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2. In the Terminal Administration group, click the Change Terminal Location link. Pac7
displays the Change Terminal Location page.

3. From the Select a Location list, select the new terminal location. If the location you need is
not in the list, you can add a new business organization location.

4. Click the Save button. Pac7 saves the new location and displays the Administration page.

Resetting Terminals
You disable terminals from the Reset Terminal page. Once a terminal is disabled, you must react-
ivate it by logging in to sell tickets from that terminal. Terminals should be disabled if they are no
longer used to sell tickets using Pac7.

To reset/disable a terminal

1. In the Pac7 menu, click the Admin link.
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Pac7 displays the Administration page.

2. In the Terminal Administration group, click the Reset Terminal link. Pac7 displays the Reset
Terminal page.
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3. Click the Yes - Reset button. Once you disable a terminal, you must activate the terminal to
use it to sell tickets again.

Preparing for an Onsale
Note: Extensive event data changes should only be done during off-hours— not during onsales,
since they may trigger a massload that can slow system performance. The changes that will trigger
a data massload include the following:

l Altering the facility map

Process: Maintenance > Facility Templates > Facility Maps > Season

Avoid making changes on the Maintain Season Facility Maps screen during high volume
selling periods. This screen is commonly used when:

A new level:section is created and needs to be displayed on the seat map.
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The location of a level:section needs to be adjusted.

A level:section needs to be deleted from the seat map so that it is no longer displayed.

l Creating and modifying seat statuses

Process: TK.SSTAT.SEA.E or Maintenance > Facility Templates > Seat Statuses > Season

When a seat status is created or modified, every event file in that season is updated. For this
reason, seat statuses should only be created or adjusted during non-peak selling periods.

Adjustments that should not be made to a seat status using the Season Seat Statuses screen
include:

Display color

Display characteristic

Alert message

Valid items associated with the status

l Loading new seasons to Paciolan 7

Process: TK.ETSTAT.E or Pac7 > Massload Parameters > Massload Season Entry

When you massload a new season using the Paciolan 7 Season Status Entry screen, all sea-
sonal information is sent to Pac7 and all necessary tables for that season are created. For
this reason, new seasons should only be massloaded during non-peak selling periods.
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l Creating or recreating seats

Process: TK.SEAT.CREATE or Allocations > Seat Processing > Create Seats

Do not use the Create Seats screen to create or recreate entire facilities or specific level:sec-
tions during high volume selling periods.
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l Altering facility configuration

Process: TK.CONFIG.SEA.E or Maintenance > Facility Templates > Configurations > Season

During high volume selling periods, users should not use the Season Configurations screen to
make the following adjustments to a configuration:

Add a new area to a price level

Remove an area from a price level

Change the display color of a price level

To prepare for an onsale

1. From Internet Explorer's View menu, point to Toolbars, and then clear the check mark from
Standard Buttons. Do this for all venues. Removing the Standard buttons toolbar minimizes
the risk that users will click the Refresh button. If users click the Refresh button or type F5,
they will be redirected to an error page.

2. In the tRes Pac7 controls (TK.ETCONTROL.E), setup items in the correct path for the onsale:

l For high-volume onsale situations for items with less than 10 Price Levels and 10 Price
Types setup at the item level, set up the items as onsale items for all Pac7 In the Pac7
Control (TK.ETCONTROL.E), use the Display Options subscreen controls.
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l For onsales of items with greater than 10 Price Levels and 10 Price Types setup at the
item level, set up the items as general sales items for all Pac7 In the Pac7 Control
(TK.ETCONTROL.E), use the Display Options subscreen controls.

l For onsales with more than 10 items being sold, set up the items as general sales items
for all Pac7 In the Pac7 Control (TK.ETCONTROL.E), use the Display Options subscreen con-
trols.

Note: Use the TK.EVENT.SEA.E screen in tRes to determine how many PLs and PTs are setup
for an item. Even if you are only selling a few PLs and PTs during the onsale, the system per-
formance is affected by the total number of PLs and PTs for the item.

3. Turn off the display of availability for all Pac7 In the Pac7 Control (TK.ETCONTROL.E), use
the Display Options subscreen controls. Turning availability off reduces the load on servers
and increases the application speed during the onsale. Users can view availability via the
Details link when necessary.

4. Using TK.IGROUP.E in tRes, minimize the number of items assigned to each item group
(recommendation is 30 or less). This will speed up the load time of the Search for Item
page of the Pac7 General Sales tab.

5. Pre-check the item that is going to be onsale before the sale time. Pre-checking loads the
item into the server's cache, reducing the slowness caused by loading the item for the first
time when the onsale begins. To pre-check an item, do the following:

a. If you have not yet created the administrative operator groups, do the following:

i. Using the tRes Operator Groups screen (select Maintenance > System > TK Operator
Groups or use the TK.OPGRP.E process), create an operator group for the admin-
istrative users who will be performing the pre-check.

ii. Using the tRes Operator Access screen (select Maintenance > System > Operator
Access or use the TK.OP.E process), assign the operators who will be doing the pre-
check to the new operator group. Make sure that PSI is also assigned to that group so
that Paciolan support can assist you when necessary with the pre-check.

b. Using the tRes Item Sale Dates subscreen of the Season Events screen (select Main-
tenance > Event Templates > Events > Season > Internal or use the TK.EVENT.SEA.E pro-
cess), add the administrative group with earlier sell From and To dates than the regular
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item's sell From and To dates.

c. Add the Item to the Pac7 onsale event list in the Pac7 control.

Tip: You can also pre-check the item by adding it to the General Sales event list. To have
the item show up in the Item Group list, make sure that the item is added to the Item
Group outside of the Pac7 control.

d. To confirm that the item is available in the Onsale (or General Sales) path, log into Pac7.
Your user login must be mapped to an operator code in the administrator operator group.

Tip: When you view the item with its available PLs and PTs, the information is cached on
the server and helps reduce load during the onsale.

6. Before the onsale begins, review the guidelines for conducting an onsale.

Conducting an Onsale
Once you have finished preparing for an onsale, use the following guidelines to start and efficiently
conduct the onsale.

To conduct an onsale

1. Fifteen minutes before the start of the onsale, have all users login and select the data
account and policy from which they are going to sell. You should stagger the user logins over
a 10 minute period.

Note: If you are not selling using "sell from" dates to control when the item can go on sale,
the item will already be displayed, and the rest of this topic does not apply to you.

2. If you are using "sell from" dates to control when the item goes on sale, make sure of the fol-
lowing:

l Users understand that, when they need to refresh the onsale page, they should click the

Refresh Onsale Items buttonx .
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l Users understand they should not use the browser Refresh button or press the F5 key. If
the Refresh button is clicked, an error page will be displayed.

l If you have onsales in one data account, users can select the data account and policy
before the item is onsale. They can then wait for the item to go onsale on either the
Onsale or General Sales tab.

In the Onsale path, users should be instructed to refresh the page by clicking the Refresh

Onsale Items buttonx displayed at the top and bottom of
the Select Onsale Items and Seats page.

In the General Sales path, users should be instructed to refresh the page by clicking the
Item Group link.

l If you have onsales in multiple data accounts at the same time, stay on the Select a
Data Account page until the item goes onsale. Then the users can click on the data
account and policy to see the item onsale. The onsale item will not be displayed until the
"sell from" time is reached.
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Chapter 11 Back Office Reference

This section contains descriptions of tRes or System Functions setup screens that are used to set up
the Pac7 system. The screens are organized by their SBClient menu locations. Use the Reference
section in the Contents pane on the left to locate screens, or switch to the Index pane and find
screens by screen name or process name.

Note: Only a subset of tRes setup screens are covered in this section. For all other tRes screen
descriptions, go to the tRes Documentation.

Paciolan 7 tRes Menu
This section contains descriptions of the Paciolan 7 menu items in tRes. This menu is used to set up
the Pac7 system. The menu is organized as follows:

l General Setups
l Patron Setup
l Selling Setups
l Massload Parameters

General Setups Overview
This section contains descriptions of the Paciolan 7 > General Setups menu items in tRes. This
menu is used to set up the Pac7 system. The menu is organized as follows:

l Data Account
l Business Accounts
l Item Sales Alert Messages

Paciolan 7 Data Account Setup Screen

Paciolan 7 > General Setups > Data Account

TK.TSETUP.E
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Use the Paciolan 7 Data Account Setup screen to configure Pac7 parameters, including address
mapping and default types, for the data account (the owner of the database or the supplier). The
values are global for all Pac7 business accounts.

Control Descriptions
Description

In this field, enter the data account description text to be displayed on the Select a Data Account
page. Operators will read this description to understand what type of tickets and items are in a
data account. The description can be up to 512 characters long.

Time Zone

Use this to set the time zone for the data account users. Order information entered in Pac7 will be
stored according to the time zone of the data account owner.

Press F3 in this field to display a list of all the time zones with descriptions. When you enter a valid
time zone, tRes displays the time zone description in the adjacent column. This is a mandatory
field.

Default Country Code

This is the default country code used when creating an address. For new patron entries in Pac7, the
Country Code drop-down list will default to this country.

Press F3 to display a list of all available country codes. The country code will always default to the
US for new patrons. This is a mandatory field.

Log Format

This control sets how the transaction log will be stored (formatted) in tRes. This is a mandatory
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field. Values include:

l N = None
l C = Columnar
l F = formatted

Address Mapping Options

Care of Map to PD Addr Line

This is the business organization address line (integer number from 1-4) that is retrieved from the
Patron Database (PD) and stored in the In the Care of line of Pac7.

If the PD does not have an address in the Care of address line, this control does not display. If the
control does display, you must enter a value.

Addr 1 Map to PD Addr

Note: You must enter a value in this field.

This is the business organization address line (integer number from 1-4) that is retrieved from the
Patron Database (PD) and stored in address line 1 of Pac7. This allows Pac7 to map to the correct
address lines in the data account for creating new patrons and pulling data for existing patrons.

Addr 2 Map to PD Addr

Note: You must enter a value in this field.

This is the business organization address line (integer number from 1-4) that is retrieved from the
Patron Database (PD) and stored in address line 2 of Pac7. This allows the Pac7 to map to the cor-
rect address lines in the data account for creating new patrons and pulling data for existing pat-
rons.

Save International Address To

This setting determines where operators will enter international addresses and where this inform-
ation is stored in tRes. You must choose one of the following:

l SYS.ZIP Entry. Select this option to store international addresses in the Zip file and make
City, International State/Province, Zip Code/Postal Code, and Country Code active fields.

l Address Line. Select this option to store international addresses in an address line and make
the International City, Province, Postal Code and Country Code fields active. This option also
makes the City, International State/Province and Zip Code/Postal Code fields inactive.

Map to PD Address Line Number

If you selected the Address Line option for Save International Address To, the system will map
the international address to the Patron Database (PD) address line you enter in the Map to PD
Address Line Number field. You must enter an integer from 1 to 4.

Default Types

Day Phone Type

This is the phone type that must be found and stored in the Pac7 Day Phone. Press F3 for a list of
available types. This is a mandatory field.

Evening Phone Type

This is the phone type that must be found and stored in the Pac7 Evening Phone. Press F3 for a list
of available types. This is a mandatory field.

Email Type
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This is the email type that must be found and stored in the Pac7 Email Address. Press F3 for a list
of available types. This is a mandatory field.

Shipping Address Type

This is the address type that must be found and stored in the Pac7 shipping address. The Shipping
Address Type is used as the primary address type. Press F3 for a list of available types. This is a
mandatory field.

Billing Address Type

This is the address type that must be found and stored in the Pac7 billing address. The Billing
Address Type is a secondary address. The system treats the Shipping Address Type as a cus-
tomer's primary address. Press F3 for a list of available types. This is a mandatory field.

Temp Shipping Address Type

This is the address type that must be found and stored in the Pac7 Temporary Shipping Address.
This is a mandatory field. Press F3 for a list of available types.

For existing tRes customers only, add a flag to indicate if an address change is a temporary or per-
manent change.

If a customer in tRes already has a billing or shipping address and they indicate that the new
address they are entering should not update their file, then the shipping address entered on the
order will be saved to the Temp Shipping Address Type.

Temp Billing Address Type

This is the address type that must be found and stored in the Pac7 Temporary Billing Address. This
is a mandatory field. Press F3 for a list of available types.

For existing tRes customers only, add a flag to indicate if an address change is a temporary or per-
manent change.

If a customer in tRes already has a billing or shipping address and they indicate that the new
address they are entering should not update their file, then the Billing address entered on the order
will be saved to the Temp Billing Address Type.

Print at Home Email Type

The Print At Home Email Type is the type of email address (regular or StubHub email type) to
which print at home items are delivered. This is a read-only value.

Paciolan 7 Business Accounts Screen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

Use the Paciolan 7 Business Accounts screen to define valid business accounts for a venue or dis-
tributor. Business accounts are the business organizations through which you sell tickets.
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Control Descriptions
Business Account

Enter a Business Account code to map a Business Organization site to a Business Account. The code
must be 32 characters or less. Each Business organization site (URL) can be mapped to only one
business account within a data account. However, a client or distributor can have multiple business
accounts (multiple sites).

Name

Enter a descriptive name for the Business Account. The name must be 128 characters or less.

Status

Only Pac7 selling organizations that are mapped to an active business account in tRes will be able
to access and sell tickets from that data account. Status field values include the following:

l A = Active
l I = Inactive
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On the Manage Business Organization Locations page, only business organizations with an Active
status will be listed. If ticket managers no longer want a business account to be able to sell their
tickets, they can change the business account to Inactive status.

When you enter a valid status code in this field, tRes displays its description in the right column.

CA TID

Enter a Credit Authorization Terminal ID (CA TID) to place an order from Pac7 during the credit
authorization process.

The CA TID you enter here is used for all controls assigned to this business account. CA TIDs set at
the Paciolan 7 control level override the CA TID set on this screen.

This field must have a valid entry if CA is online. tRes checks the validity of the entry when you
click Save on the Paciolan 7 Business Accounts Screen .

Buttons

Operators

Click this button to display the Operators subscreen. Use this subscreen to add to the operators
available from the Manage User page. This setup is mandatory.

Report Options

Click this button to display the Report Options subscreen. Use this subscreen to set the amount per
ticket that a third party can retain for ticket fees.

Access Pass Options

Click this button to display the Access Pass Options subscreen. Use this subscreen to set the dollar
amount required to activate an access pass.

Passwords

Click this button to display the Passwords subscreen. Use this subscreen to create passwords for
some of the Pac7 operations.

Adjustment Options
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Click this button to display the Adjustment Options subscreen. Use this subscreen to set the busi-
ness account orders that can be viewed or adjusted using this business account.

Item Sales Only

Instructions when Manager must return items for operators in Item Sales

This is the optional Return Instruction Text that can be displayed as note on the Return Items tab
when the control does not allow returns. The text must be 256 characters or less.

Email Confirmation Template

Enter the code of the email template used to send the email order confirmation of End of Sale and
Order Inquiry.

PAH Email Template

Enter the code of the email template used when Print-at-Home (PAH) is selected as the delivery
method. PAH tickets are attached to this email template.

Fee Cap Setting

Select one of the following options from the drop-down list:

Option Description

Do NOT Enable Fee Cap
Savings

No fee cap is applied to orders.

Enabled Fee Capping If the item charges for a single event item exceed the cap amount, the

Pac7 Release 7.2



User Guide  973

Option Description

(Savings Amount is NOT
Changeable)

system will refresh the Review Items in the Cart page with an order
charge for a negative amount.

Enabled Fee Capping
(Savings Amount is
Changeable)

The user will be able to change the amount of the order charge added to
the cart for fee capping.

Order Management Only

Note: Order Management uses templates defined at ERES.EMAIL.E, while Item Sales uses
TK.ET.EMAIL.E.

Email Confirmation Template

Enter the code of the email template used to send the email order confirmation that is selected on
the Payment Information page. If you leave this field empty, the system will use the Confirmation
Email Template set on the Email Templates subscreen of the System Setup (TK.SETUP.E).

Mobile Email Template

Enter the code of the email template used to send email messages to mobile devices at the end of
sale when using a mobile disposition. If you leave this field empty, the system will use the Mobile
Template set on the Email Templates subscreen of the System Setup (TK.SETUP.E).
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PAH Email Template

Enter the code of the email template used to send email messages with print at home tickets from
the Payment Information page. If you leave this field empty, the system will use the P@H Tem-
plate set on the Email Templates subscreen of the System Setup (TK.SETUP.E).

Operators Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Paciolan 7 Business Accounts screen, click the Operators button to display the Operators
subscreen.

Use the Operators subscreen to add to the available operator codes for this business account on the
Pac7User Administration pages.

Note: To create operator codes, use the system level Operator Access Screen. To set up operator
code customer and batch access, use the tRes Operator Access Screen.

Control Descriptions
Operators

Only the operators listed here will be available to be assigned to users on the Pac7 User Admin-
istration pages for this business account. Press F3 in this field to display a list of operator codes
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and names.

Report Options Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Paciolan 7 Business Accounts screen, click the Report Options button to display the Report
Options subscreen. Use the Report Options subscreen to set the amount per ticket that a 3rd party
can retain for ticket fees.

Control Descriptions
Ticket Fee >=

The minimum ticket fee amount used to calculate the retained amount for the Balancing Report.
You must enter a value in this field.

Ticket Fee <=

The maximum ticket fee amount used to calculate the retained amount for the Balancing Report.
You must enter a value in this field.

Retain Amount

Enter the amount per ticket that a 3rd party can retain for Ticket Fees. You must enter an amount
in this field, and the amount must be between or equal to the amounts you entered in the Ticket
Fee >= and Ticket Fee <= fields. This value displays in the Per Ticket Retained column on the
Balancing Report by Per Ticket Fee.

Access Pass Options Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Paciolan 7 Business Accounts screen, click the Access Pass Options button to display the
Access Pass Options subscreen. Use the Access Pass Options subscreen to set the dollar amount
required to activate an access pass.
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Control Descriptions
Access Pass Activation Basis

These options control when tRes activates access passes after they are purchased. Access passes
will be activated based on which of the following is selected:

l Order Line Amount Due. The access pass will be activated if the access pass item total pay-
ment amount is >= maximum amount due.

l Order Amount Due. The access pass will be activated if the order total payment amount >=
maximum amount due.

Maximum Amount Due

The order line or order amount due that controls access pass activation.

Passwords Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Paciolan 7 Business Accounts screen, click the Passwords button to display the Passwords
subscreen. Use the Passwords subscreen to set up password requirements for some of the func-
tionality on the Pac7 tabs (Order Management, Items Sales, Inquiry, Adjustments, and Patron).
Passwords must be between 8 and 20 characters long.
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Item Sales, Inquiry, and Adjustments Passwords

Use same password for all

If you want to use the same password for all of the controls in this section, select Use same pass-
word for all, and then enter the password in the adjacent text box.

Item Sales Passwords

Click this button to display the Item Sales, Inquiry, and Adjustments Passwords Subscreen. Use
this subscreen to set unique passwords for item sales functions.

Go Exchange Passwords

Use same password for all

If you want to use the same password for all of the controls in this section, select Use same pass-
word for all, and then enter the password in the adjacent text box.

Go Exchange Passwords

Click this button to display the Go Exchange Passwords Subscreen. Use this subscreen to set unique
passwords for Go Exchange functions.

Order Management Passwords
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Use same password for all

If you want to use the same password for all of the controls in this section, select Use same pass-
word for all, and then enter the password in the adjacent text box.

Order Management Passwords

Click this button to display the Order Management Passwords Subscreen. Use this subscreen to set
unique passwords for order management functions.

Patron Passwords

Use same password for all

If you want to use the same password for all of the controls in this section, select Use same pass-
word for all, and then enter the password in the adjacent text box.

Patron Passwords

Click this button to display the Patron Passwords Subscreen. Use this subscreen to set unique pass-
words for patron functions.

Password Instructions

In this box, enter the text (maximum length of 256 characters) that will be displayed for the user
on the Password Verification page in Pac7. For example, since inventories can require a different
passwords, you may need to instruct Pac7 users how to contact their data accounts to get pass-
words. This is an optional field.

Item Sales, Inquiry, and Adjustments Passwords Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Paciolan 7 Business Accounts screen, click the Passwords button to display the Passwords
subscreen, and then click the Item Sales Passwords button to display the Item Sales, Inquiry, and
Adjustments Passwords subscreen. Use this subscreen to set up password requirements for some
of the functionality on the Pac7 tabs (Items Sales, Inquiry, and Adjustments). Passwords must be
between 8 and 20 characters long.
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End of Sale Reprint

Enter the required password for operators to use the Reprint process from the Order Confirmation
page in Pac7. This password only restricts users that are assigned a control that requires a pass-
word for this process. This is a mandatory field.

Order Inquiry

Enter the required password for operators to use the order inquiry process through the Inquiry tab
in Pac7. This password only restricts users that are assigned a control that requires a password for
this process. This is a mandatory field.

Return

The Return process is accessed through the Adjustments/Return Items tab in Pac7. Enter the
required password for operators to use the Return Tickets process in Pac7. This password only
restricts users that are assigned a control that requires a password for this process. This is a man-
datory field.

Void Last Order

Enter the required password for operators to use the Void Last Order process on the Order Con-
firmation page in Pac7. This password only restricts users that are assigned a control that requires
a password for this process. This is a mandatory field.

Go Exchange Passwords Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Pac7 Business Accounts screen, click the Passwords button to display the Passwords sub-
screen, and then click the Go Exchange Passwords button to display the Go Exchange Passwords
subscreen. Use this subscreen to set up password requirements for some of the functionality on the
Pac7 Exchange tab. Passwords must be between 8 and 20 characters long.
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Exchange

Users must enter this password to access the Exchange tab. This password only restricts users that
are assigned a control that requires a password for this process. This is a mandatory field.

Exchange Seat Status Changeable

Users must enter this password to change the exchange out seat status on the Exchange tab. This
only applies if the selling control that the operator is using allows exchanges and requires a pass-
word for this process for Go Exchange.

Order Management Passwords Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Pac7 Business Accounts screen, click the Passwords button to display the Passwords

Pac7 Release 7.2



User Guide  981

subscreen, and then click the Order Management Passwords button to display the Order Man-
agement Passwords subscreen. Use this subscreen to set up password requirements for some of
the functionality on the Pac7 Order Management tab. Passwords must be between 8 and 20 char-
acters long.

Cancel

Users must enter this password to break the item order quantity rules (min/max/multiple), if the
selling control allows it and requires an override password. The password requirement is con-
figured on the Order Management Order Options subscreen of the selling control
(TK.ETCONTROL.E). For more information about item order quantity rules, see the Order Quantity
Rules topic in the tRes Help.

Customer Limit

Users must enter this password to exceed the seasonal customer item quantity limit, if the selling
control allows it and requires an override password. The password requirement is configured on
the Order Management Order Options subscreen of the selling control (TK.ETCONTROL.E). For
more information about customer limits, see the Setting Seasonal Customer Item Limits topic in
the tRes Help.

Customer Seat Hold

Users must enter this password to create sequences of customer seat holds for single event items,
if the event set up requires a password to allow seat holds. The requirement is configured using the
Allow Seat Holds option on the Event Miscellaneous subscreen of the Season Events process
(TK.EVENT.SEA.E) in tRes. For more information, see the Event Miscellaneous Subscreen topic in
the tRes Help.

Exchange

Enter the password that operators must enter to access the Exchange tab from the order man-
agement order line. This password only restricts users that are assigned a control that requires a
password for this process. This is a mandatory field.
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Exchange Seat Status Changeable

Enter the password that operators must enter to change the exchange out seat status on the
Exchange tab. This only applies if the selling control that the operator is using allows exchanges
and requires a password to make exchanges. This is a mandatory field.

Item Sale Date/Time

Users must enter this password to sell an item before or after the configured sale date and time
range, if the selling control allows it and requires an override password. The password requirement
is configured on the Order Management Order Options subscreen of the selling control
(TK.ETCONTROL.E). The date range is configured using the Item Sale Dates subscreen of the
Season Events process (TK.EVENT.SEA.E) in tRes. For more information about item sale dates, see
the Item Sale Dates Subscreen topic in the tRes Help.

Refund

Users must enter this password to refund previous payments for an order. On the Order Man-
agement tab, you can make refunds by entering a negative payment amount. For more inform-
ation, see Issuing Refunds in Order Management.

Reprint

Users must enter this password to reprint prior receipts, if the selling control allows it and requires
an override password. The password requirement is configured on the Order Management Order
Options subscreen of the selling control (TK.ETCONTROL.E) setup. For more information about
reprinting receipts, see Reprinting Prior Receipts in Order Management.

Return
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Users must enter this password to return tickets for customers, if the selling control allows it and
requires an override password. Authorization to allow returns and the password requirement are
set on the Order Management Order Options subscreen of the selling control (TK.ETCONTROL.E)
setup.

Return Seat Status Changeable

Users must enter this password to change the return seat status from the order management order
line. This only applies if the selling control that the operator is using allows returns and requires a
password for changing seat statuses.

Used Barcode

If users are allowed to perform returns, they will be required to enter this password before they
can return seats with used barcodes. The system checks every seat from all the events in the sea-
son.

Void

Users must enter this password to void (unprint, deallocate, and cancel an item in an order line) an
order line, if the selling control allows it and requires an override password. The password require-
ment is configured on the Order Management Order Options subscreen of the selling control
(TK.ETCONTROL.E) setup. For more information about voiding order lines, see Voiding Order Lines
in Order Management.

Patron Passwords Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E
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From the Pac7 Business Accounts screen, click the Passwords button to display the Passwords sub-
screen, and then click the Patron Passwords button to display the Patron Passwords subscreen. Use
this subscreen to set up password requirements for some of the functionality on the Pac7 Patron
tab. Passwords must be between 8 and 20 characters long.

Credit Deny

This is the password to access the patron record if the credit status is set to Deny. Users are promp-
ted for the password when they select Continue on the Credit Warning page. This is a mandatory
field.

Credit Warn

This is the password to access the patron record if the credit status is set to Warn. Users are promp-
ted for the password when they select Continue on the Credit Warning page. This is a mandatory
field.

Credit Warn/Limit

This is the password to access the patron record if the credit status is set to Warn/Limit. Users are
prompted for the password when they click Place Order on the Collect Payment page and the pat-
ron's credit limit is exceeded. This is a mandatory field.

Item Sales Adjustment Options Subscreen

Paciolan 7 > General Setups > Business Accounts

TK.BA.E

From the Paciolan 7 Business Accounts screen, click the Adjustment Options button to display the
Item Sales Adjustment Options subscreen. Use this subscreen to set the business account orders
that can be viewed or adjusted using the business account you are setting up. You can view these
orders using Order Inquiry. Adjustments include returning orders.

Control Descriptions
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From the drop-down list, select one of the following:

l This Business Account Only. Select this option to limit the orders that can be viewed or adjus-
ted to only those placed through the business account you are setting up. For example, if all
outlets use the same business account and they are allowed to use the order inquiry process,
they can only look up orders that were originally placed at an outlet.

l Specific Business Accounts (listed below). Select this option to limit the orders that can be
viewed or adjusted to those placed through the business accounts in the Business Acct list
below. For example, if a student union outlet is allowed to process returns, you can limit
them to returning items that were originally placed at the student union or at the main
venue— they would not be allowed to return orders that were purchased at other outlets.

l All Business Accounts. Select this option to allow viewing and adjusting of orders placed
through any business account. For example, you can allow the main venue to view order
inquiry and process returns for all Paciolan 7 orders, regardless of where they were ori-
ginally placed.

Business Acct

Add the business accounts that can be viewed or adjusted using the business account you are set-
ting up. Press the F3 key for a complete list of business accounts.

Note: This list of business accounts is only applicable if you select the Specific Business Accounts
(listed below) option from the drop-down list above.

Paciolan 7 Alert Messages Screen (Item Sales Only)

Paciolan 7 > General Setups > Item Sales Alert Messages

TK.TALERT.E

Note: Alert messages are defined for each data account and limited to the specified business
account. If no business accounts are listed, no users will be able to see the alert message.

Alert messages provide a means for a ticket manager to readily communicate with users of a spe-
cific business account or group of business accounts during item sales. Alert messaging are useful
when business accounts are geographically dispersed, so the ticket manager has a way to com-
municate effectively with ticket sellers in remote locations.

Ticket managers can send messages to the operators selling from their business accounts (for
example, box office, phone center, or outlet operators) using item sales. Common messages may
be that an event is selling out, that a big onsale will be starting, or that new price types are avail-
able for an event.

You create item sales alert messages using the Paciolan 7 Alert Messages screen. Once you create
messages, you can update or delete them, or they can expire. Pac7 will display messages for
users, however users do not need to respond to the messages. Messages only display on the Item
Sales tab.
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Control Descriptions
Alert Code

Use this field to enter the unique ID for the message. If you press F3 in this field, the Paciolan 7
Alert Message Selection screen displays, allowing you to narrow the selection of existing messages
to any date range. The code cannot exceed 32 characters.

Name

This is the message name that will be displayed next to the alert message date links on the Pac7
item sales pages. The name cannot exceed 64 characters.

Start Date
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The Start Date for a message is the day that ticket operators will first see the message. If today’s
date is equal to or between the Start Date and End Date, the message should be displayed for the
Pac7 user. The message dates are linked to an Alerts messages window that contains codes,
names, and the complete message text of all current messages.

See an example Alerts messages window.

Once a message's end date has passed, the message is no longer displayed in Pac7. If the start
date for the message is in the future, the message is not displayed until that date.

Press F3 in the Start Date field to select a date using a graphical calendar.

End Date

The End Date for a message is the last day it will be seen by users. If today’s date is equal to or
between the Start Date and End Date, the message should be displayed for the Pac7 user. Once a
message's End Date has passed, the message is no longer displayed.

Press F3 in the End Date field to select a date using a graphical calendar.

Message Text
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This is the text of the alert message and is displayed when a user clicks on the date link to see the
complete message. All active messages will be displayed for the user in the Alerts messages win-
dow. Message links are listed at the top of Pac7 the Item Sales tab in descending chronological
order by date. The message text cannot exceed 1064 characters.

Business Account

This is the list of business accounts for which the alert message will be displayed on the Item Sales
tab. Only users selling through those business accounts will be able to see the message from that
data account owner. If you leave this field empty, no users will be able to view the message.

If a user is logging into a Pac7 business organization that is not assigned to a business account lis-
ted here, those users will not see the message.

For a list of existing business accounts, click in a row and press F3. Once you have entered a valid
business account, tRes displays a description in the right column.

Patron Setup Overview
This section contains descriptions of the Paciolan 7 > Patron Setup menu items in tRes. This menu
is used to set up the Pac7 system. The menu is organized as follows:

l Patron Policy
l Patron Management Control
l Shortcut to Operator Access

Patron Policy Screen

Paciolan 7 > Patron Setup > Patron Policy

TK.PPOLICY.E
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The Patron Policy screen is used to define patron permissions for Pac7 operators. A patron policy
may be shared and assigned to one or more selling or patron management controls. Conversely,
each selling and patron management control must be linked to only one patron policy.

A patron policy is mainly composed of the following:

l Default attributes for a new patron record.
l Settings to enable or disable duplicate name checking and automatic generation of patron
IDs.

l Settings to use the basic or advanced quick patron mode during item sales.
l Settings to use full patron entry.
l Configuration of the displayed fields in the patron search results.
l User-defined lists of accessible phone, email, address, salutation, and VIP types.
l Settings to enable or disable access to specific patron data, including biographical, devel-
opment, eVenue, institution, and ticketing data.

Control Descriptions
Policy Code

This is the code that uniquely identifies a policy. The code is mandatory, must be a single word with
no spaces, and cannot exceed 32 characters.

Policy Name

This is a mandatory field where you enter a descriptive name for the policy. This name will be dis-
played when you enter the policy code on a Paciolan selling control or patron management control

Pac7 Release 7.2



User Guide  990

setup screen. The name cannot exceed 128 characters.

Patron Entry Options

Enable Duplicate Name Checking

If the Enable Duplicate Name Checking option is selected, Pac7 will require operators to search the
patron database for an existing patron record before allowing them to enter a new patron. This
option applies to both the selling and patron management processes, and it is intended to reduce
the number of duplicate patron records. During order management, enabling this option will check
for both duplicate names and email addresses.

Automatically Assign New Patron ID

Note: This option is only applicable when using full patron or advanced quick patron entry.

If this option is selected, Pac7 automatically assigns new patron IDs when operators create new
patrons. Operators do not have the option of manually entering patron IDs.

When this option is cleared, Pac7 displays the Auto-Assign New Patron ID option on the Enter Pat-
ron Information page during patron creation. By default, the option is selected and Patron IDs will
be created automatically. However, operators can clear the option and manually enter a new pat-
ron ID for each patron they create.

Default Parameters for New Patron

Patron Status

The Default Patron Status option applies to creating a new patron record in Pac7. For full patron
entry, default patron status displays in the Patron Status drop-down list of the Patron Information
group. This group is on the Home and Personal tabs of the full Enter Patron Information page and
the Patron Information page on the Order Management tab. Press F3 for a list of status codes with
their descriptions.
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For quick patron entry, there is no Patron Status field, so all patrons are saved with the default pat-
ron status value you set here.

Patron Source

The Default Patron Source option applies to creating a new patron record in Pac7. For full patron
entry, default patron source displays in the Patron Source drop-down list of the Patron Information
group. This group is located on the Home and Personal tabs of the full Enter Patron Information
page and the Patron Information page on the Order Management tab. Press F3 for a list of the avail-
able Default Patron Source codes and their descriptions.

For quick patron entry, there is no Patron Source field, so all patrons are saved with the default pat-
ron source value you set here.

Ticketing Status

This option sets the default ticketing status code. The corresponding name is displayed in the Tick-
eting Status drop-down list of the Patron Information group.

This group is on the Home and Personal tabs of the full Enter Patron Information page and the
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advanced Quick Patron Entry page.

Press F3 for a list of the available ticketing statuses.

Ticketing Type

The Ticketing Type option sets the default ticketing type code. The corresponding name is dis-
played in the Ticketing Type drop-down list of the Patron Information group.

The group is on the Home and Personal tabs of the full Enter Patron Information page and the
advanced Quick Patron Entry page.

Press F3 for a list of the available ticketing types.

Organization Type

The Organization Type option sets the default organization type when creating a patron record for a
new organization. The corresponding name is displayed in the Organization Type drop-down list on
the Home and Personal tabs of the full Enter Patron Information page and the Patron Information
page on the Order Management tab.
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The name is also displayed in the Organization Type drop-down list on the Home and Personal tabs
of the advanced Quick Patron Entry page.

Other Options

Additional Settings

Click this button to display the Additional Settings subscreen.

Note: If you are using basic quick patron entry, you do not need to access this subscreen. The set-
tings on the Additional Settings subscreen are only applicable when using advanced quick patron or
full patron entry.

Patron Search Options

Click this button to display the Patron Search Options subscreen.

Note: If you are using basic quick patron entry, you do not need to access this subscreen. The set-
tings on the Patron Search Options subscreen are only applicable when using advanced quick pat-
ron or full patron entry.

Data Access Options

Click this button to display the Data Access Options subscreen.

Note: If you are using basic quick patron entry, you do not need to access this subscreen. The set-
tings on the Data Access Options subscreen are only applicable when using advanced quick patron
or full patron entry.

Other Patron Attributes

Click this button to display the Other Patron Attributes subscreen.
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Note: If you are using basic quick patron entry, you do not need to access this subscreen. The set-
tings on the Other Patron Attributes subscreen are only applicable when using advanced quick pat-
ron or full patron entry.

Additional Settings Subscreen

Paciolan 7 > Patron Setup > Patron Policy

TK.PPOLICY.E

From the Patron Policy screen, click the Additional Settings button to display the Additional Settings
subscreen. The settings on this screen are for Advanced Quick Patron and Full Patron searches
only. Use this subscreen to set address and phone/email type options for the advanced quick pat-
ron entry and full patron entry versions of the Enter Patron Information page when using controls
that are assigned the patron policy.

Control Descriptions
Accessible Phone/Email Types

The Accessible Phone/Email Types field is the list of phone/email types for which users of the pat-
ron policy have edit access on the advanced quick patron or full patron versions of the Enter Patron
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Information page. Phone/email types are displayed in the Phone/Email group of the Home and Per-
sonal tabs on the page.

In the Phone/Email group, the types are divided into phone numbers and email addresses, and
those two groups are displayed in the order they are listed in the Accessible Phone/Email Types
field. See an example.

Note: The tRes (TK) system must have edit access allowed for a phone/email type in PD.PTYPE.E
for the type to be valid in this field.
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You must specify at least one phone/email type. Press F3 for a list of valid phone/email types. The
Quick Patron Phone Types set up at the Paciolan 7 control level override the phone types set up
here.

Accessible Address Types

The Accessible Address Types field is the list of address types for which members of the patron
policy have edit access on the full and quick versions of the Enter Patron Information pages.
Address types are displayed in Pac7 in the order they are listed in this field. You must specify at
least one address type. Press F3 for a list of valid address types. See an example.

Note: The tRes (TK) system must have edit access allowed for an address type in PD.ATYPE.E for
the type to be valid in this field.

If an address type is not specified here, it will not display in the Address Types drop-down list on
the full and quick versions of the Enter Patron Information pages.

Default Address Types Options

The Default Address Types options are globally configured in the data account (TK.TSETUP.E in
tRes). However, the Default Address Types Options in the Patron Policy, if defined, will override
the values configured in the data account. The Default Address Types Options include the following:

l Override Address Types Defined in Data Account. Select this option if you want the default
shipping and billing addresses you set below to override the default settings on the Data
Account screen.

l Default Shipping Address Type. If you enter an address type here, it overrides the default set-
ting on the Data Account screen. An entry here will not be saved unless the Override Address
Types Defined in Data Account option is selected above.

l Default Billing Address Type. If you enter an address type here, it overrides the default set-
ting on the Data Account screen. An entry here will not be saved unless the Override Address
Types Defined in Data Account option is selected above.

Other Options

If you select Allow Access to Change Address Type, users will be able to change address types
when entering patron data in Pac7. This option is only applicable when using the advanced quick
patron entry version of the Enter Patron Information page.
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Patron Search Options Subscreen

Paciolan 7 > Patron Setup > Patron Policy

TK.PPOLICY.E

From the Patron Policy screen, click the Patron Search Options button to display the Patron Search
Options subscreen.

This subscreen is used to set the data fields that you want to display in your patron search results
when using controls that are assigned the patron policy. The settings on this screen are for the
Advanced Quick Patron and Full Patron searches on the Item Sales tab, as well as on the Patron tab
and CRM. They do not apply to the Order Management tab or the Order Inquiry tab versions of the
search results.

Control Description
In the Display column, select the fields you want to display in your patron search results. Patron ID
and Patron Name will always be displayed, so you cannot clear their Display selection. For fields
that have adjacent text entry fields, you can enter the code for the type of that field to display. For
example, you may choose to display any Phone Number type, such as home, business, or cell.
Press the F3 key to select from a list of valid types.

Data Access Options Subscreen

Paciolan 7 > Patron Setup > Patron Policy

TK.PPOLICY.E

Note: These settings are only applicable when using the full version of the Enter Patron
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Information page.

From the Patron Policy screen, click the Data Access Options button to display the Data Access
Options subscreen. Use this subscreen to set whether users can create and edit new patrons and
which sets of patron data they can edit when using controls that are assigned the patron policy.
Also use this subscreen to select the data fields to display on the Enter Patron Information page.
Data fields display in the order that they are listed on this subscreen.

Control Descriptions
Options for Selling Control Only

Allow Access to Patron Tab in Selling

This option determines whether users can create and edit new patrons using the patron man-
agement functions of Pac7 outside of the selling process. By default, this option is not selected.

If the option is selected, the Patron tab is displayed in the header after users select a control on the
Select a Data Account page in Pac7. The Patron tab allows you access to the Patron tab. If the
option is cleared, the Patron tab is not displayed in the header.
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Access Options

Allow Access to Biographical Data

This option determines whether users can access the Biography tab on the full version of the Enter
Patron Information page. If the option is cleared, the Biography tab will not be displayed for the
group or any related data fields on the Home tab. If the option is selected, the Biography tab will
be displayed. By default, this option is cleared.

Allow Access to Development Data

This option determines whether users can access the Development tab on the full version of the
Enter Patron Information page. If this option is cleared, Pac7 will not display the Development tab
or any related data fields on the Home tab. If this option is selected, the tab will be displayed if the
patron is a Donor type. By default, this option is cleared.

Allow Access to eVenue Data

This option determines whether users can edit eVenue data in the eVenue Profile group on the full
version of the Enter Patron Information page. By default, this option is cleared.

Allow Access to Institution Data

This option determines whether Pac7 displays the Institution tab on the full version of the Enter Pat-
ron Information page. If this option is cleared, Pac7 will not display the Institution tab or any
related data fields on the Home tab. If this option is selected, Pac7 will display the tab.

By default, this option is cleared.

Allow Access to Magnetic Stripe ID

This option sets whether Pac7 displays the Magnetic Stripe ID group of the Personal tab on the full
version of the Enter Patron Information page. If this option is cleared, Pac7 will not display the Mag-
netic Stripe ID group. If this option is selected, Pac7 will display the group.

By default, this option is cleared.

Allow Access to Ticketing Data
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This option sets whether Pac7 displays the Ticketing tab on the full version of the Enter Patron
Information page. If this option is cleared, Pac7 will not display the Ticketing tab or any related
data fields on the Home tab. If this option is selected, Pac7 will display the tab.

By default, this option is cleared.

Note: To understand how the above settings affect the Pac7 interface, reference this example.

Because Allow Access to Create/Edit Patron Data is selected on the Data Access Options Sub-
screen in this example, users will have access to the functionality of Patron tab in Pac7.

Since the users have access to Patron functionality, they will have edit access to the Enter
Patron Information page on the Patron tab.

They also will have edit access to a version of the Enter Patron Information page used in the
selling process.

Note: The control used in this example is not configured for order management, but this also
allows access on the Patron Information page of the Order Management tab.
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Because Allow Access to Biographical Data is selected on the Data Access Options Subscreen
in this example, the Biography tab will display on the Enter Patron Information pages.

Also, because Phone/Email Data and Address are selected in the Data Fields to Display in Pat-
ron Home Page group of this Patron Access tab, they will be displayed on the Home tab of the
both the Patron tab and Item Sales tab versions of the Enter Patron Information page.

Data Fields to Display in Patron Home Page (maximum of 12)

Note: Because the Patron home page can display a maximum of twelve groups (modules), you
must select twelve or fewer of the options below.
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Secondary Patron

The Secondary Patron option sets whether Pac7 displays the Secondary Patron group on the Home
tab of the Enter Patron Information page for controls that use this policy. If this option is cleared,
Pac7 will not display the Secondary Patron group. If this option is selected, Pac7 will display the
group.

By default, the Secondary Patron option is cleared.

Phone/Email Data

The Phone/Email Data option sets whether Pac7 displays the Phone/Email Data group on the Home
tab of the Enter Patron Information page for controls that use this policy. If this option is cleared,
Pac7 will not display the Phone/Email Data group. If this option is selected, Pac7 will display the
group.

By default, the Phone/Email Data option is cleared.

Address

The Address option sets whether Pac7 displays the Address group on the Home tab of the Enter Pat-
ron Information page for controls that use this policy. If this option is cleared, Pac7 will not display
the Address group. If this option is selected, Pac7 will display the group.

By default, the Address option is cleared.

Ticketing Information

The Ticketing Information option sets whether Pac7 displays the Ticketing Information group on the
Home tab of the Enter Patron Information page for controls that use this policy. If this option is
cleared, Pac7 will not display the Ticketing Information group. If this option is selected, Pac7 will
display the group.
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By default, the Ticketing Information option is cleared.

Organization

The Organization option sets whether Pac7 displays the Organization Information group on the
Home tab of the Enter Patron Information page for controls that use this policy. If this option is
cleared, Pac7 will not display the Organization Information group. If this option is selected, Pac7
will display the group.

By default, the Organization option is cleared.

eVenue Profile

The eVenue Profile option sets whether Pac7 displays the eVenue Profile group on the Home tab of
the Enter Patron Information page for controls that use this policy. If this option is cleared, Pac7
will not display the eVenue Profile group. If this option is selected, Pac7 will display the group.

By default, the eVenue Profile option is cleared.

Salutations

The Salutations option sets whether Pac7 displays the Salutations group on the Home tab of the
Enter Patron Information page for controls that use this policy. If this option is cleared, Pac7 will
not display the Salutations group. If this option is selected, Pac7 will display the group.

By default, the Salutations option is cleared.

Mail Codes/Keywords/Tags

The Mail Codes/Keywords/Tags option sets whether Pac7 displays the Mail Codes/Keywords/Tags
group on the Home tab of the Enter Patron Information page for controls that use this policy. If this
option is cleared, Pac7 will not display the Mail Codes/Keywords/Tags group. If this option is selec-
ted, Pac7 will display the group.

By default, the Mail Codes/Keywords/Tags option is cleared.

Comments/Announcements

The Comments/Announcements option sets whether Pac7 displays the Comments and Announce-
ments group on the Home tab on the Enter Patron Information page for controls that use this
policy. If this option is cleared, Pac7 will not display the Comments and Announcements group. If
this option is selected, Pac7 will display the group.

By default, the Comments/Announcements option is cleared.

Biography

The Biography option sets whether Pac7 displays the Primary and Secondary Patron Biography
groups on the Home tab of the Enter Patron Information page for controls that use this policy. If
this option is cleared, Pac7 will not display the Primary and Secondary Patron Biography groups. If
this option is selected, Pac7 will display the group.

By default, the Biography option is cleared.

Children

The Children option sets whether Pac7 displays the Children group on the Home tab of the Enter
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Patron Information page for controls that use this policy. If this option is cleared, Pac7 will not dis-
play the Children group. If this option is selected, Pac7 will display the group.

By default, the Children option is cleared.

Institutions

The Institutions option sets whether Pac7 displays the Primary and Secondary Patron Institution
groups on the Home tab of the Enter Patron Information page for controls that use this policy. If
this option is cleared, Pac7 will not display the Primary and Secondary Patron Institution groups. If
this option is selected, Pac7 will display the group.

By default, the Institutions option is cleared.

Ticketing Memberships

The Ticketing Memberships option sets whether Pac7 displays the Ticketing Memberships group on
the Home tab of the Enter Patron Information page for controls that use this policy. If this option is
cleared, Pac7 will not display the Ticketing Memberships group. If this option is selected, Pac7 will
display the group.

By default, the Ticketing Memberships option is cleared.

Ticketing Activities

The Ticketing Activities option sets whether Pac7 displays the Ticketing Activities group on the
Home tab of the Enter Patron Information page for controls that use this policy. If this option is
cleared, Pac7 will not display the Ticketing Activities group. If this option is selected, Pac7 will dis-
play the group.

By default, the Ticketing Activities option is cleared.

Ticketing Order History

The Ticketing Order History option sets whether Pac7 displays the Ticketing Order History group on
the Home tab of the Enter Patron Information page for controls that use this policy. If this option is
cleared, Pac7 will not display the Ticketing Order History group. If this option is selected, Pac7 will
display the group.

By default, the Ticketing Order History option is cleared.

Ticketing Credit Status

The Ticketing Credit Status option sets whether Pac7 displays the Ticketing Credit Status group on
the Home tab of the Enter Patron Information page for controls that use this policy. If this option is
cleared, Pac7 will not display the Ticketing Credit Status group. If this option is selected, Pac7 will
display the group.

By default, the Ticketing Credit Status option is cleared.

Ticketing Customer Comments

The Ticketing Customer Comments option sets whether Pac7 displays the Ticketing Customer Com-
ments group on the Home tab of the Enter Patron Information page for controls that use this policy.
If this option is cleared, Pac7 will not display the Ticketing Customer Comments group. If this
option is selected, Pac7 will display the group.

By default, the Ticketing Customer Comments option is cleared.

Ticketing Tags

The Ticketing Tags option sets whether Pac7 displays the Ticketing Tags group on the Home tab of
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the Enter Patron Information page for controls that use this policy. If this option is cleared, Pac7
will not display the Ticketing Tags group. If this option is selected, Pac7 will display the group.

By default, the Ticketing Tags option is cleared.

Development Information

The Development Information option sets whether Pac7 displays the Development Information
group on the Home tab of the Enter Patron Information page for controls that use this policy. If this
option is cleared, Pac7 will not display the Development Information group. If this option is selec-
ted, Pac7 will display the group.

By default, the Development Information option is cleared.

Development Credit Status

The Development Credit Status option sets whether Pac7 displays the Development Credit Status
group on the Home tab of the Enter Patron Information page for controls that use this policy. If this
option is cleared, Pac7 will not display the Development Credit Status group. If this option is selec-
ted, Pac7 will display the group.

By default, the Development Credit Status option is cleared.

Development Comments

The Development Comments option sets whether Pac7 displays the Development Comments group
on the Home tab of the Enter Patron Information page for controls that use this policy. If this option
is cleared, Pac7 will not display the Development Comments group. If this option is selected, Pac7
will display the group.

By default, the Development Comments option is cleared.

Development Mail Codes/Tags

The Development Mail Codes/Tags option sets whether Pac7 displays the Development Mail
Codes/Tags group on the Home tab of the Enter Patron Information page for controls that use this
policy. If this option is cleared, Pac7 will not display the Development Mail Codes/Tags group. If
this option is selected, Pac7 will display the group.

By default, the Development Mail Codes/Tags option is cleared.

Other Patron Attributes Subscreen

Paciolan 7 > Patron Setup > Patron Policy

TK.PPOLICY.E

From the Patron Policy screen, click the Other Patron Attributes button to display the Other Patron
Attributes subscreen.
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This subscreen is used to set default parameters, as well as the available salutation types and VIP
codes, for the entry of individual and organizational development information during patron entry.
These settings only apply to the full version of the Enter Patron Information page from the Item
Sales and Patron tabs and the Patron Information page on the Order Management tab.

Control Descriptions
Default Parameters for New Patron

Donor Mail Code

This option is only used for fund development. The Default Donor Mail Code option is displayed
in the Mail Code drop-down list of the Development Mail Codes/Tags group. This group is on the
Personal and Development tabs of the full edit version of the Enter Patron Information page and
the Patron Information page on the Order Management tab. Press F3 for a list of the available
mail codes.
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Donor Type

This option is only used for fund development. The default donor type code is displayed in the
Development Type drop-down list of the Development Information group. This group is on the
Personal and Development tabs of the full edit version of the Enter Patron Information page and
the Patron Information page on the Order Management tab. Press F3 for a list of the available
donor types.

Org Address Type

The organization address type code only applies when adding a new patron that is an organ-
ization type. The default organization address type is a labeled text entry field in the Organ-
ization Information group on the Organization tab of the full edit version of the Enter Patron
Information page and the Patron Information page on the Order Management tab. Press the F3
key to display a list of valid types.

Org Phone Type

The organization phone type code is used when adding a new patron that is an organization
type. The default organization phone type is a labeled text entry field in the Organization Inform-
ation group on the Organization tab of the full edit version of the Enter Patron Information page
and the Patron Information page on the Order Management tab. Press the F3 key to display a
list of valid types.

Accessible Salutation Types

The Accessible Salutation Types field is the list of salutation types to which users have access on
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the full version of the Enter Patron Information page and the Patron Information page on the Order
Management tab. Salutation types are displayed in Pac7 in the order they are listed in this field.
You must specify at least one salutation type. Press F3 for a list of valid salutation types.

Note: The tRes (TK) system must have edit access allowed for a salutation type in PD.STYPE.E for
the type to be valid in this field.

The salutation type codes in this list are displayed in a drop-down list in the Salutations group of
the Personal tab on the full version of the Enter Patron Information page and the Patron Inform-
ation page on the Order Management tab.

Accessible VIP Codes

The Accessible VIP Codes field is the list of VIP codes to which users have access on the full version
of the Enter Patron Information page and the Patron Information page on the Order Management
tab. VIP codes are displayed in Pac7 in the order they are listed in this field. You must specify at
least one VIP code. Press F3 for a list of valid VIP codes.

Note: The tRes (TK) system must have edit access allowed for a VIP code in PD.STYPE.E for the
type to be valid in this field.

The VIP codes in this list are displayed in a drop-down list in the Patron Information group of the
Home and Personal tabs of the full version of the Enter Patron Information page and the Patron
Information page on the Order Management tab.

Patron Management Control Screen

Paciolan 7 > Patron Setup > Patron Management Control

TK.PMGMT.E

Use the Patron Management Control screen to create or edit your patron management controls. Pat-
ron management controls set the policy for users of full patron management. These controls allow
users access to full patron management functionality, but do not allow them access to the selling
process. You can define one or more patron management controls per data account.
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When users log in to Pac7, each defined patron management control is displayed on the Select a
Data Account page, assumig they are linked to one of the operator codes listed in the control.

When users select a patron management control, only the full patron functionality pages on the Pat-
ron tab are displayed. The features and functions available to users in full patron are defined by the
patron policy linked to the selected control.
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Note: The patron management controls described above are different than Paciolan 7 selling con-
trols. Use a Paciolan 7 selling control instead of a patron management control when you want to
allow operators access to selling functionality. Paciolan 7 selling controls may also allow access to
patron management functionality.

Control Descriptions
Control

Enter the code of the patron management control you are creating or editing. Press the F3 key for
the list of existing controls. The code cannot exceed 16 characters.

Name

Enter a descriptive name for the patron management control, or edit the displayed name of an
existing control. This is the text that will display as a link on the Select a Data Account page in
Pac7. The name cannot exceed 128 characters.

Operator

Enter the operator codes that will allow the use of the patron management control. Only users
whose accounts are linked to this operator code will be allowed access to the control. You can set
up this linkage when managing individual users in Pac7.

Policy

Enter the code of the policy to which you want to link the patron management control. The patron
policy sets the full patron functionality available to the control, including access rights, default pat-
ron attributes, and accessible codes.

Copy

Click this button to display the Copy to Patron Management Controls subscreen. This subscreen
allows you to copy the patron management control's settings to one or more new patron man-
agement control codes. You cannot copy over any existing control codes.

Operator Access Screen (tRes)

Paciolan 7 > Patron Setup > Shortcut to Operator Access

TK.OP.E

For Pac7 setup, use the Operator Access screen (TK.OP.E) to access the Selling Parameters
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subscreen.Through this screen you can set up customer and batch access for the operator code. If
you need to create operator codes, use the system level Operator Access Screen.

Note: For more information about setting up operator access to the tRes TK.SELL (non-Pac7)
selling processes, see the tRes reference topic.

Control Descriptions
Season

The operator's default season, which is used whenever a Season field is included on a tRes screen.

Sell Params

Click this button to display the Selling Parameters subscreen. Use the Selling Parameters sub-
screen to control the customer and batch access of users assigned the operator code.

Selling Parameters Subscreen

Paciolan 7 > Patron Setup > Shortcut to Operator Access

TK.OP.E

From the Operator Access screen, click the Sell Params button to display the Selling Parameters
subscreen. Use this subscreen to control an operator's customer and batch access by season in
Pac7.

Control Descriptions
House Cust Only
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This option is ignored in Pac7. For information about setting screen options for tRes operators, see
the Operator Access tRes reference topic.

House Cust Access

Set this option to determine whether an operator with permission to sell to house customers can
change to a different house customer during the selling process. Do one of the following:

l Select the House Cust Access option to allow operators to change to a different house cus-
tomer or to the default house customer.

l Clear the House Cust Access option to allow operators to change to the default house cus-
tomer but not change to a different house customer. The option is cleared by default.

The affect of this option on the Pac7 interface is different depending on the currently active tab. On
the Item Sales and Adjustments tabs, it affects the Change Patron page, which is available from
the cart during sales and returns.

On the Order Management tab, this setting determines whether the House customer search tab is
available on the Patron Search form.

Batch Change Access

Set this option to determine whether Pac7 allows operators to change batches during order man-
agement and the item sales selling and adjustments processes. Choose one of the following:

l For the Item Sales tab, select this option to allow operators to temporarily change or create
a batch during the selling and adjustments processes. Pac7 displays a Change Batch link on
the Review Items in the Cart, Enter Payment Information, Search for Order to Return, and
Enter Refund Payment pages.
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l For the Order Management tab, select this option to display a Change link in the Pac7 nav-
igation bar when you are working on the Order Management tab. Clicking the Change link dis-
plays the Manage Batch form where you can change or create new batches.

Clicking the link from any of the tabs will display the Select/Create Batch page. For information
about changing batches, see Changing Batches.

Clear this option to prevent operators from temporarily changing or creating a batch during the
onsale and general sales selling processes. The Change Batch link will not be displayed during the
selling or adjustment processes. By default, the Batch Change Access option is cleared.

View Operator Holds

This option is ignored in Pac7. For information about setting screen options for tRes operators, see
the Operator Access tRes reference topic.

Batch Create Access

This setting is only used by Pac7 for controls if the Ticketing Operator Permissions option is selec-
ted on the Batch Options subscreen. It affects both onsale and general sales pages. In the Batch
Create Access field, enter one of the following codes:

l N (No access). If operators log into the system and select an invalid batch control, they will
remain on the Select Data Account page. On the page, the system will display an error mes-
sage and operators will not be able to create a new batch or change to an existing batch.

l C (Create new only). After an operator selects an invalid batch control, a new batch will
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automatically be created. If the Batch Options settings in the control allow the user to change
the batch name, then the Create New Batch page will be displayed. The expiration date will
default based on the control setting. If the user cannot change the batch name, the new batch
will be created automatically, and the user will be taken to the start of the selling process.

l U (Unrestricted access). After an operator selects an invalid batch control, Pac7 will display
an error message on the Invalid Batch page. Pac7 also displays Create New Batch and Use
Existing Batch links.

By default, the Batch Create Access field is cleared

Selling Setups Overview
This section contains descriptions of the Paciolan 7 > Selling Setups menu items in tRes. This menu
is used to set up the Pac7 system. The menu is organized as follows:

l Item Sales Item Groups
l Item Sales Delivery Method
l Item Sales Email Templates
l Shortcut to Activity Price Table
l Shortcut to Season Price Table
l Shortcut to Facilities
l Paciolan 7 Controls
l Item Sales Forms
l Order Management Forms
l Exchange In Forms
l Shortcut to Promo Entry

Item Sales Item Groups Screen

Paciolan 7 > Selling Setups > Item Sales Item Groups

TK.TGROUP.E

Use the Item Sales Item Groups screen to define the list of item groups that you can assign to Pac7
controls.
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For operators assigned to those controls, the sum of all items from all seasons listed here will be
displayed on the Search for Item page.

Control Descriptions
Item Group

Enter the code of the item group you want to define. The code cannot exceed 15 characters. Define
the item group by adding seasons to be sold from the group. These items groups will be available
to assign to a Pac7 control for selling. Press F3 to display the available item groups for this data
account owner.

The item groups defined on this screen will be available for selection from the Item Groups sub-
screen when editing Pac7 controls. Pac7 will display the item groups on the Search for Item page.
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Name

Use the Name field to enter or edit a descriptive name for the specified item group. The name can-
not exceed 128 characters. The names of the item groups defined here will be available for selec-
tion from the Item Groups subscreen when editing Pac7 controls. Pac7 will display selected item
groups and their names on the Search for Item page.

Season

Use the Season column to enter the season codes used to include items in this item group. Press
the F3 key to display the available seasons. To be available, a season must exist in TK.SEASON.
You must have at least one season in the Season column.

(Season X Items subscreen)

Use the Season X Items subscreen to list the items in the selected season that operators with
access to the data account can sell in Pac7.

Comments

(Optional) Use this field to add comments to this item group definition. These comments are for
tRes setup reference only— they do not appear in the Pac7 interface.

Copy button

Use the Copy button to copy the currently displayed item group and use it to create a new item
group. tRes will display the Copy to TCS Item subscreen, where you must enter the name of the
new Pac7 item group code. tRes will create an item group with the new code using the definition of
the current item group.
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Copy From button

Use the Copy From button to copy information from a new or existing item group. The system will
prompt you for a tRes item group code and will display the Copy Data from tRes subscreen, where
you must select an existing tRes group to copy from. Press F3 for the list of available tRes groups.
The system will copy the Name, Season, and Item data from that record into the current record.

Season X Items Subscreen

Paciolan 7 > Selling Setups > Item Sales Item Groups

TK.TGROUP.E

From the Item Sales Item Groups screen, select a season, and then click the details buttonx to
display the Season X Items subscreen.
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Use the Season X Items subscreen to list the items in the selected season that operators with
access to the data account can sell in Pac7 general sales. You can select which items are assigned
to the specified season. Pac7 will display the selected items, along with those selected for the other
seasons assigned, on the Search for Item page in general sales.

Control Descriptions
Item

This column lists the items in the season available for this data account owner to sell in Pac7. The
item names listed here will be included with the item group when the group is assigned to a Pac7
control.

For an item to be displayed in Pac7, the item group and item must be assigned to a Pac7 control.
Even if an item is not assigned to an item group, users with permission to sell the item can still find
it using the Search for Item page.
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Users with permissions can also find the item using the Search for Multiple Events page.

The item names listed here are displayed on the Search for Item page in Pac7.

Set button

Click the Set button to select the season item set (TK.SET.SEA.E) whose items you want to include
in the season. If you enter a valid item set, tRes will add all items in the set for use in Pac7.

Item Sales Delivery Methods Screen

Paciolan 7 > Selling Setups > Item Sales Delivery Method

TK.TDMETH.E

Use the Item Sales Delivery Methods screen to define Pac7 item sales delivery methods, including
their mapping to tRes disposition codes.

Pac7 Release 7.2



User Guide  1020

Control Descriptions
Delivery Method

Enter the code of the delivery method that you want to define and map. The code cannot exceed 32
characters. The delivery methods you define here apply to all business accounts assigned to the
data account owner. Once these are defined, you can specify the valid delivery methods for item
sales in each Pac7 control.

The delivery method code will display during the General Sales process in the Item Details, Find
Best Available Seats, Review Items in the Cart, and Enter Additional Information pages. During the
Onsale process, the code displays in the Select Onsale Items and Seats, Review Items in the Cart,
and Enter Additional Information pages.

Name

Enter the name for the delivery method that Pac7 will display on the Select Onsale Items and
Seats, Find Best Available Seats, and Review Items in the Cart pages. The delivery method name
will display in Pac7 item sales each time the code is displayed. The name cannot exceed 128 char-
acters.

Type

This is the type of delivery method that is used for reporting. Press F3 to display the available
types.

tRes Disposition Code

All item sales delivery methods must be mapped to a tRes disposition code and order charge. In
this field, enter the Disposition Code that is sent from Pac7 to tRes with an order/transaction that
uses this delivery method. This mapping applies to this data account owner only.

Press F3 to display the available codes. To be available, disposition codes must exist in TK.DCODE.

Season
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This column lists the seasons for which the delivery method is available in the data account. For
each season, you can select an order charge to be associated with the delivery method.

Press F3 to display the available seasons. To be available for this column, a season must exist in
TK.SEASON. You can only list a season once in this list, but multiple delivery methods can be set up
for each season.

The delivery method drop-down list will display on the Select Onsale Items and Seats, Find Best
Available Seats, and Review Items in the Cart pages.

Charge

Order charges are displayed as the Delivery Charge for the order in Pac7 item sales and will be sub-
mitted with the order/transaction. The following rules apply for orders with multiple events and sea-
sons:

l If events in the order are in more than one season, the same delivery method can have dif-
ferent order charges for each season.

l If the events in an order are from one season, the order charge for the delivery method is
only charged once.

l If the events in an order are from more than one season, the same delivery methods are
charged once per season, even if the order charges are the same.

Press F3 to display the available order charges. To be available for this column, an order charge
must exist in TK.CHARGE.

The order charge will display in the Delivery Method drop-down list on the Select Onsale Items and
Seats, Find Best Available Seats, and Review Items in the Cart pages.

Available Timeframe

Note: If you leave both Start Days and Start Hours blank, the delivery method will be available
immediately when you put the event on sale. If you leave both Cutoff Days and Cutoff Hours blank,
the delivery method will be available until the end of the event day (more specifically, midnight or
12:00 AM of the day after the event date).

Start Days

If you enter a number of days in Start Days, Pac7 will use that number, along with the number of
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hours in Start Hours below, to set a date and time when the delivery method will be available for
selling events. Pac7 will not display the delivery method in the Delivery Method drop-down list if
the order/transaction date is before that time and date.

The value you enter in Start Days can be any whole number greater than 0. If you also enter a num-
ber of Cutoff Days, the number of start days you enter must be greater than that number. If you
enter n Start Days and leave Start Hours blank, the delivery method's start date and time is mid-
night (12:00 AM) of the day that is n days before the event day. See an example.

With the following settings:

Event date/time: 7:00pm Friday

Start Days: 2

Start Hours: <blank>

The delivery method will be available starting at midnight on the Wednesday before the event
date and time. So, the delivery method is available 2 days and 19 hours (67 hours) before the
event time on the event date. Note that the delivery method availability is not exactly 2 days
(48 hours) before the event time.

Start Hours

If you enter a number of hours in Start Hours, Pac7 will use that number, along with the number of
days in Start Days above, to set a date and time when the delivery method will be available for
selling events. Pac7 will not display the delivery method in the Delivery Method drop-down list if
the order/transaction date is before that time and date.

The value you enter in Start Hours can be any whole number from 1 to 24. If you enter n Start
Hours and leave Start Days blank, the delivery method's start date and time is n hours before the
event time on the event date. See an example.

With the following settings:

Event date/time: 7:00pm Friday

Start Days: <blank>

Start Hours: 8

The delivery method will be available starting at 11:00 AM on the day of the event.

Cutoff Days

If you enter a number of days in Cutoff Days, Pac7 will use that number, along with the number of
hours from Cutoff Hours below, to set a date and time when the delivery method will no longer be
available for selling events. Pac7 will not display the delivery method in the Delivery Method drop-
down list if the order/transaction date is after the cutoff time on the cutoff date.

The value you enter in Cutoff Days can be any whole number greater than 0. If you also enter a
number of Start Days, the number of cutoff days you enter must be less than that number. If you
enter n Cutoff Days and leave Cutoff Hours blank, the delivery method's end date and time is mid-
night (12:00 AM) of n - 1 days before the event day. See an example.

With the following settings:

Event date/time: 7:00 PM Friday

Cutoff Days: 1

Cutoff Hours: <blank>
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The delivery method will no longer be available as of midnight on Friday (the event date). So,
the delivery method is cutoff 19 hours before the event time on the event date. Note that the
cutoff is not exactly 1 day (7:00 PM Thursday) before the event time.

Tip: Typically, cutoff days are used for postal mail and other shipping (overnight, two day, etc.)
delivery methods.

Cutoff Hours

If you enter a number of hours in Cutoff Hours, Pac7 will use that number, along with the number
of days from Cutoff Days above, to set a date and time when the delivery method will no longer be
available for selling events. Pac7 will not display the delivery method in the Delivery Method drop-
down list if the order/transaction date is after the cutoff time on the cutoff date.

The value you enter in Cutoff Hours can be any whole number from 1 to 24. If you enter n Cutoff
Hours and leave Cutoff Days blank, the delivery method's cutoff date and time is n hours before
the event time on the event date. See an example.

With the following settings:

Event date/time: 7:00pm Friday

Cutoff Days: <blank>

Cutoff Hours: 3

The delivery method will no longer be available after 4:00 PM on the day of the event.

Tip: Typically, cutoff hours are used for postal mail and other shipping (overnight, two day, etc.)
delivery methods.

Item Sales Email Entry Screen

Paciolan 7 > Selling Setups > Item Sales Email Templates

TK.ET.EMAIL.E

Use the Item Sales Email Entry screen to create templates for the automatically generated Pac7
confirmation and print at home email messages.

Control Descriptions
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Email Template

Enter the code of the email template you are creating or editing. Press the F3 key for the list of
existing templates. The code cannot exceed 32 characters in length.

From Addr

Enter the email address you want in the From field of the email message header.

Reply To

Enter the email address you want in the Reply-To field of the email message header. If email recip-
ients click the Reply button in their email clients, this address will automatically be entered in the
To field.

Type

Enter the code of the type of email (O for Order Confirmation and P for Print at Home) for which
this template will be used.

Subject

Enter the text to display in the Subject field of the email message.

Text at the beginning of the order detail

Enter the text that you want to appear at the beginning of the order detail. The number of char-
acters in the beginning text cannot exceed 1024.

Text at the end of the order detail

Enter the text that you want to appear at the end of the order detail. The number of characters in
the ending text cannot exceed 1024.

Activity Price Table Screen

Paciolan 7 > Selling Setups > Shortcut to Activity Price Table

TK.PTABLE.ACT.E

For Pac7 setup, use the Activity Price Table screen to access the Paciolan 7 PL Names subscreen.
Click the Paciolan 7 PL Names button to access this subscreen, and then define the display names
of each of the price levels for the current activity. You can also use this screen to setup price type
dependencies for the current price table, by clicking the Price Type Dependency button.
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Note: For complete information about the controls on the Activity Price Table screen, see the Activ-
ity Price Table Subscreen tRes reference topic.

Control Descriptions
Paciolan 7 PL Names

Click this button to display the Paciolan 7 PL Names subscreen. Use this subscreen to create display
names for each of the price levels of the current activity. (In the example above, the current activ-
ity is F for Football).

Price Type Dependency

Click this button to display the Price Type Dependency subscreen. On this subscreen, enter the
price types that require the purchase of additional price types.

Click the details buttonx to display the Price Type Dependency Detail subscreen and configure
the required price types and quantity restrictions.
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Price type dependencies can only be defined for the price types listed in the price table. So, the
table must have at least two price types before you can create any price type dependencies. Also,
once you create price type dependencies, you cannot remove any of the required or dependent
price types from the price table. See an example if a price table originally has price types A, B,
and C, and A is dependent on B, you cannot remove A or B from the price table. If you need to
remove required or dependent price types from the price table, you must first remove them from
the Price Type Dependency and Price Type Dependency Detail subscreens.

Note: For more information, see Setting Up Price Type Dependencies and the Price Type Depend-
ency Screen tRes reference topic.

Paciolan 7 PL Names Subscreen

Paciolan 7 > Selling Setups > Shortcut to Activity Price Table or Shortcut to Season Price Table

TK.PTABLE.ACT.E / TK.PTABLE.SEA.E

From either screen, click the Paciolan 7 PL Names button to display the Paciolan 7 PL Names sub-
screen. Use this subscreen to enter display names for each of the price levels (PLs) of the current
activity or season.

Control Descriptions
PL Name
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In PL Name enter the price level (PL) description that will display in the PL/PT (price type) matrix
during item sales and in the Item Details window. The name you enter can be up to 20 characters
long. If you do not enter a name for a PL, the price table PL name will be used to display the PL
description.

During the onsale process, PL Names display on the Select Onsale Items and Seats page. During
the general sales process, they display on the following pages:

l Find Best Available Seats
l Search for Best Available Seats
l Review Items in the Cart
l Enter Payment Information
l Order Confirmation
l Select Items to Reprint

During both the order management and item sales processes, the Item Details window is access-
ible and also displays the PL names you enter here.

Season Price Table Screen

Paciolan 7 > Selling Setups > Shortcut to Season Price Table

TK.PTABLE.SEA.E

For Pac7 setup, use the Season Price Table screen to access the Paciolan 7 PL Names subscreen.
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From the subscreen, you will define the display names of each of the price levels for the current
season price table. You can also use this screen to setup price type dependencies for the current
price table, by clicking the Price Type Dependency button.

Note: For complete information about the controls on the Season Price Table screen, see the
Season Price Table tRes reference topic.

Control Descriptions
Paciolan 7 PL Names

Use the Paciolan 7 PL Names subscreen to create display names for each of the price levels of the
current season price table. If you do not create display names, Pac7 will use the tRes names by
default.

Price Type Dependency

Click this button to display the Price Type Dependency subscreen. On this subscreen, enter the
price types that require the purchase of additional price types.

Click the details buttonx to display the Price Type Dependency Detail subscreen and configure
the required price types and quantity restrictions.
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Price type dependencies can only be defined for the price types listed in the price table. So, the
table must have at least two price types before you can create any price type dependencies. Also,
once you create price type dependencies, you cannot remove any of the required or dependent
price types from the table. See an example if a price table originally has price types A, B, and C,
and A is dependent on B, you cannot remove A or B from the price table. If you need to remove
required or dependent price types from the price table, you must first remove them from the Price
Type Dependency and Price Type Dependency Detail subscreens.

Note: For more information, see Setting Up Price Type Dependencies and the tRes Reference
topic.

Facilities Screen

Paciolan 7 > Selling Setups > Shortcut to Facilities

TK.FACILITY.E

Note: For a description of the Facilities screen and its controls, see the tRes reference topic.

Pac7 Release 7.2

http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/maintenance/Price_Type_Dependency_Screen.htm
http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/maintenance/Price_Type_Dependency_Screen.htm
http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/maintenance/facilities.htm
http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/maintenance/facilities.htm


User Guide  1030

Level:Section Conversions Subscreen

Paciolan 7 > Selling Setups > Shortcut to Facilities

TK.FACILITY.E

Access this subscreen by clicking the Lev:Sect Conv button on the tRes Facilities screen. The set-
tings on the Level:Section Conversions Subscreen are used for email confirmations and whenever
non-abbreviated seatblocks are displayed. Use this screen if you want the level or section names
specified in tRes to be different when printed on tickets. If you do not enter any conversions on this
screen, the tRes names will print on tickets. The "From" column data in the Level and Section con-
version tables will be validated as existing in the master facility template (TK.MANIFEST.MASTER)
for the facility.

Control Descriptions
Level Conversion

From

This is the level name that is specified for the facility in tRes. This name will print on the ticket if
there is no name entered in the To column. The level name also displays on the Review Items in
the Cart, Order Confirmation, and Select Items to Reprint pages.

Note: This level name conversion is not required for the Level:Section conversion.

To

This is the level name that will replace the tRes name for this facility on the Review Items in the
Cart, Order Confirmation, and Select Items to Reprint pages. This name will print on the ticket
instead of the Level Conversion From name.

Note: This level name conversion is not required for a Level:Section conversion.

Section Conversion

From
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This is the section name for the facility in tRes. This name will print on the ticket if there is no Sec-
tion Conversion To (Sec To) name listed. Press F3 for a list of Section From names.

To

If Level:Section is set up to print on the ticket, this field determines the Section information that
should be printed for events taking place at this facility. This will also be used whenever seatblocks
are displayed in the “not abbreviated” format (the Not Abbreviated option is selected on the Dis-
play Options subscreen of the Paciolan 7 control).

Paciolan 7 Controls Screen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

Use the Paciolan 7 Controls screen to create and modify selling controls, as well as assign them to
selling organizations and the operators within the organization. Assigning a control to a selling
organization or its operators sets the selling parameters that display in Pac7 for them.

Each Pac7 control will be represented as a policy in the Pac7 interface, and each policy is available
under one of the data accounts from which your organization sells. See an example.

On the Select Data Account page, the ACME Events data account has been expanded to show its
policies. In this example, the Phone Room policy is selected.
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Pac7 users are assigned to operator codes and through these codes inherit the union of the para-
meters defined for the data account, business account, patron policy, control, and operator code—
the union of all levels of permissions.

You can assign multiple Pac7 controls to one business account, and you can assign multiple oper-
ator codes to a control. You can also define a subset of the control selling parameters for operator
codes. However, each Pac7 user is assigned to only one operator code in a data account.

Note: The Pac7 controls described in this topic are different than patron management controls.
Use a patron management control instead of a Pac7 control when you want to allow operators pat-
ron entry access, but exclude them from using selling functionality.

Control Descriptions
Control

In the Control field, enter the control code you want to create or modify. Press the F3 key for a list
of the existing controls. The number of characters in the code cannot exceed 32.

Name
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Enter the name of the control. The number of characters in the name cannot exceed 128. This
name will be displayed under its data account on the Select a Data Account page, if a user logs in
with an operator code that is assigned to more than one control. If the operator code is only
assigned to one control, the Select a Data Account page is bypassed and the configured selling
page is displayed.

Operator

Enter the operator codes that you want to be assigned to the control. Press F3 to display the list of
available operator codes.

Pac7 users assigned to a tRes operator code that is not assigned to a business account cannot sell
from that business account. If the operator code is assigned to one control, the assigned operators
can directly select the business account name.

If the operator code is assigned to multiple controls, the business account name will be listed but
will not be linked— operators assigned to that code will have to select a linked control to sell tick-
ets.

Hcust

This is the house customer number that the specified operator code is assigned to use when sub-
mitting orders for house customers. However, permission to sell to house customers is set on the
Patron Options subscreen. This is a mandatory field. Press F3 for a list of available house customer

numbers or select the operator's row, and then click the Next HCust buttonx at the bot-
tom of the screen to create a new house customer.

Batch

Enter the batch number that the operator code will use when submitting orders. This number dis-
plays in the Pac7 page header when the Order Management, Item Sales, Adjustments, or Exchange
tabs are displayed. Press F3 for a list of available batch numbers or select the operator's row, and

then click the Next Batch buttonx at the bottom of the screen to create a new batch.
You must select a valid, open batch.

Season
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List the seasons from which the operators assigned to this control can sell. They are displayed in
the list of available items during item sales and in a selection list in order management and
exchanges. A season that has not been massloaded can be added to a control, but items in that sea-
son will not be available for sale until the season is successfully massloaded.

Select a season and click the details buttonx to display the Season Detail subscreen.

(Season Detail subscreen)

Click this button to display the Season Detail subscreen. You must set up the details for each sea-
son listed in the Season field.

Salecode

Enter the salecodes that will be available for selection on the Enter Payment Information page of
the Item Sales tab and after clicking the Purchase button on the Order Management tab. The selec-
ted code is submitted with the order/transaction to tRes. Press F3 for a list of available salecodes.
You must enter at least one salecode in this field. If only one salecode is listed, the salecode option
will not be displayed in Pac7 and the system will automatically assign that salecode to all trans-
actions.

Shared Setups

The buttons in this group are used to configure options that apply to the Order Management, Item
Sales, Inquiry, Adjustments, Exchange, and Patron tabs.

Batch Options

Use the Batch Options subscreen to configure how batches are created and when they expire.

Order/Exchange Options

Use the Order/Exchange Options subscreen to select a custom Exchange In form. If you do not
select a custom form, the standard PSI form is entered by default.

Patron Options

Use the Patron Options subscreen to set the customer type allowed and customer information dis-
played for ticketing operators during sales.

Payment Options

Use the Payment Options subscreen to set up how operators can sell tickets.
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Print/Receipt Options

Use the Print/Receipt Options subscreen to set up how operators can issue receipts and mailers in
Pac7. You also must select the printer type (BOCA or laser) with which operators will print items.

Seat Searching/Map Options

Use the Seat Searching/Map Options subscreen to configure the auto assign seat gap and price
level search options.

Item Sales, Inquiry, and Adjustments

Delivery Methods

Use the Delivery Methods subscreen to set the allowed ticket delivery methods.

Display Options

Use the Display Options subscreen to set up the display of information for the general and onsale
selling paths, including the Select Onsale Items and Seats page and the Review Items in the Cart
page.

Item Groups

Use the Item Groups subscreen to select the item groups you want to add to this control.

Order Options

Use the Order Options subscreen to set batch options, order timeout options, and order processing
requirements for ticketing operators.

Patron Options

Use the Patron Options subscreen to set the customer type allowed and customer information dis-
played for ticketing operators during sales.

Post Sale Options

Use the Post Sale Options subscreen to set up the available functionality for completed orders. This
functionality includes sending order confirmation email messages, voiding orders, reprinting
orders, searching existing orders, returning order items, and completing will call pickups.

Order Management

Allow Order Management Access

Select this option to display and allow access to the Order Management tab.

Default to Item Sales. If you select the Allow Order Management Access option, select this
option to display the Item Sales tab by default after you sign in to Pac7 and select the selling
control policy.
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Default to Order Management. If you select the Allow Order Management Access option, select
this option to display the Order Management tab by default after you sign in to Pac7 and select
the selling control policy. However, if you have configured an onsale for the Item Sales tab, this
setting will be ignored and the Item Sales tab will be displayed with the Onsale page selected.

Order Options

Click this button to display the Order Management Order Options subscreen. Use this subscreen to
set order processing options for order management users.

Payment/Post Sale Options

Click this button to display the Order Management Payment/Post Sale Options subscreen. Use this
subscreen to set up order payment rules, payment application, refund parameters, and end of sale
options for users of the Order Management tab.

Go Exchange

Go Exchange Options

Click this button to display the Go Exchange Options Subscreen. Use this subscreen to enable Go
Exchange and set password requirements.

Copy

Click this button to display the Copy To Control(s) dialog box. Use this box to create new controls
with the same configuration as the currently loaded control. You must enter one or more new con-
trol names.

Next Batch

Click in the table row of the operator code that you want to change to a new batch, and then click
this button. tRes displays the Next Batch dialog box with the default batch name in the Name field.
If you want the batch to expire on particular date, enter the date in the Expires field.

Next HCust
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Click in the table row of the operator code to which you want to assign a new house customer, and
then click this button. tRes displays the Next House Customer dialog box. Enter the name of the
new house customer in the Name field. In the Type field, enter the code of the house customer
type or press the F3 key to select one from a list. Click the Save button. tRes creates a new house
customer number and enters it in the HCust field for the operator.

Season Detail Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

From the Paciolan 7 Controls screen, select a Season, and then click the details buttonx to dis-
play the Season Detail subscreen. Use this subscreen to set the items that are included from a sea-
son for order management, exchanges, and item sales. Since the season is part of the Paciolan 7
control, these items will be available for sale when operators are using the control. You also use
this subscreen to configure the associated price level and price types that will be available, as well
as the charge, discount, search plan, and seat status options.
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Control Descriptions
Order Management and General Sales Items

Only Items Listed are Available

Select this option if you want to limit the items available from the season to those you add to the
Item table below. You cannot add items to the Item table until you select this option. For this
option to be valid, you must add at least one item to the Item table.

All Items are Available

Select this option if you want all items in the season, including every item's price level/price type
combinations, to be available for sale when operators are using this control. However, available
price types will still be limited by operator to the price types that are allowed in TK.OP.E. When this
option is selected, Pac7 will not allow you to enter any items in the Item table.

Item

If the Only Items Listed are Available option is selected, this list should include all the items that
are available through general sales. These items will also be available to create item groups. For
an item to be displayed in the search results on the Search for Item page, it must also be included
in the item group for the season inventory. If an item is listed as available but is not included in an
item group, the user must search for the item using the free text search, the facility search, or the
multiple events search.

Note: Before you enter values in the Min Qty, Max Qty, and Multiple fields, make sure you under-
stand how the item level and item price level/price type (I:PL/PT) level settings work together for
single and combination items. In addition, note that the items you set up here, including mis-
cellaneous items, may have further minimum, maximum, and multiple quantity restrictions set in
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the item entry processes (TK.EVENT.SEA.E, TK.COMBO.SEA.E, and TK.IMISC.SEA.E). See Setting
Up Order Quantity Rules for more information.

Tip: You can limit the total quantity of items that operators can sell to individual customer s from
the season. For more information, see Setting Seasonal Customer Item Limits.

Min Qty

Set the minimum quantity of the item that can be purchased during order management and general
sales. If an operator tries to add a smaller quantity, the system will display an error message. This
field is optional. See Setting Up Order Quantity Rules for information about how this item level set-
ting works with the Max Qty and Multiple settings, as well as the I:PL/PT level settings.

Max Qty

Set the maximum quantity of the item that can be purchased during order management and gen-
eral sales. If an operator tries to add a larger quantity, the system will display an error message.
This field is optional. See Setting Up Order Quantity Rules for information about how this item level
setting works with the Min Qty and Multiple settings, as well as the I:PL/PT level settings.

Multiple

Set the multiple requirement for the quantity of this item that can be purchased during order man-
agement and general sales. If an operator tries to enter a quantity that is not evenly divisible by
the multiple, the system will return an error message. For example, if the multiple is 2, the quant-
ity must be 0, 2, 4, 6 etc. However, if the Max Qty is set to 4 for an item with a multiple of 2, the
quantity could only be 0, 2, or 4. This field is optional. See Setting Up Order Quantity Requirements
for information about how this item level setting works with the Min Qty and Max Qty settings, as
well as the I:PL/PT level settings.

(Season Item subscreen)

Use the Season Item subscreen to control the item price levels, price types, and prices that can be
sold by operators using this control. You must set these for each item.

Load Item Groups

Click this button to update the Item column with all items that are included in the item groups ref-
erenced by the control. This process also removes items that are not referenced by the control.

Auto Modify PL/PT

Use the Auto Modify Price Level/Price Type subscreen to set the valid combinations of price levels
and types for all the items in a season. If you selected the Only Items Listed are Available option
above, then you must set these combinations before accepting the season details. If you want to
set the combinations for each item separately, use the Season Item subscreen instead.

Onsale Items

Item

This list should include all the items for the season that you want included in the Onsale Items
group on the Select Onsale Items and Seats page. The onsale path does not use item groups. All lis-
ted items will be displayed on the Select Onsale Items and Seats page. Only single items can be lis-
ted on the Onsale page. A maximum of 10 items can be listed in the onsale path.
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Note: Before you enter values in the Min Qty, Max Qty, and Multiple fields, make sure you under-
stand how the item level and item price level/price type (I:PL/PT) level settings work together for
single items. In addition, note that the items you set up here, including miscellaneous items, may
have further minimum, maximum, and multiple quantity restrictions set in the item entry pro-
cesses (TK.EVENT.SEA.E and TK.IMISC.SEA.E). See Setting Up Order Quantity Rules for more
information.

Def Qty

Set the default quantity of the onsale item. This is the amount that will automatically display for
the first price level/price type on the Select Onsale Items and Seats page. This field is optional.

Min Qty

Set the minimum quantity of the item that can be sold to individuals during onsales. If an operator
tries to add a smaller quantity to the cart, the system will display an error message. This field is
optional.See Setting Up Order Quantity Rules for information about how this item level setting
works with the Max Qty and Multiple settings, as well as the I:PL/PT level settings.

Max Qty

Set the maximum quantity of the item that can be purchased during onsales. If an operator tries to
add a larger quantity to the cart, the system will display an error message. This field is optional.
See Setting Up Order Quantity Rules for information about how this item level setting works with
the Min Qty and Multiple settings, as well as the I:PL/PT level settings.
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Multiple

Set the multiple requirement for the quantity of this item that can be purchased during onsales. If
an operator tries to enter a quantity that is not evenly divisible by the multiple, the system will
return an error message. For example, if the multiple is 2, the quantity must be 0, 2, 4, 6 etc.
However, if the Max Qty is set to 4 for an item with a multiple of 2, the quantity could only be 0, 2,
or 4. This field is optional. See Setting Up Order Quantity Requirements for information about how
this item level setting works with the Min Qty and Max Qty settings, as well as the I:PL/PT level set-
tings.

(Season Item subscreen)

Use the Season Item subscreen to control the item price levels, price types, and prices that are
available to operators. You must set these for each item.

Auto Modify PL/PT

Use the Auto Modify Price Level/Price Type subscreen to set the valid combinations of price levels
and types for all the items in a season. You must set these combinations before accepting the sea-
son details.

Add Items for Autoload
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Click this button to display the Onsale Autoload Items subscreen. In Misc items, enter mis-
cellaneous items that will be available for autoload, if they have been properly set up at the item
level. For example, a parking pass item is automatically added to the cart when concert tickets are
ordered.

Bill Plan Options

Click this button to display the Season Bill Plan Options Subscreen.

Charge Options

Click this button to display the Charge Options subscreen.

Discount Options

Click this button to display the Season Discount Options subscreen.

Search Plan Options

Click this button to display the Season Search Plan Options Subscreen.

Seat Status Options

Click this button to display the Season Seat Status Detail subscreen.

Season Charge Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

From the Paciolan 7 Controls screen, select a Season, and then click the details button to display
the Season Detail subscreen. On that subscreen, click the Charge Options button to display the
Season Charge Options subscreen. Use this subscreen to set up ticket and order charges for order
management, general sales, and onsales orders.
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Control Descriptions
Order Management and General Sales Charges

Available Ticket Charges

Note: Ticket charges in tRes are referred to as item charges on the Order Management tab and as
item fees on the Item Sales tab. Ticket charges are defined in the TK.TCHARGE.SEA.E process and
are applied per order line in order management and per item in the item sales shopping cart. See
an image showing how ticket charges are displayed.
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Select one of the following options:

l None. Select this option if you do not want ticket charges to be available in order man-
agement or general sales.

l All Charges Assigned at the Item Level. Select this option if you want all ticket charges
defined at the item level to be available in order lines for order management (as item
charges) and for items in the item sales cart (as item fees). If you enter a code in the Default
field for this option and the charge is available for an item, the default ticket charge is auto-
matically selected in the order management order lines Charge column and the Item Fee
drop-down list on the Review Items in the Cart page for general sales. If you do not enter a
code in Default or the code you enter is not available for an item, there will be no selection in
the order management Change column and the general sales Item Fee drop-down list selec-
tion will default to None.
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l One. Select this option if you want the ticket charge you enter in the adjacent field to be the
only available selection in the Charge column for order management order lines. For general
sales, this option will automatically enter the ticket charge in the Item Fee field on the
Review Items in the Cart page. If you select this option and the adjacent ticket charge is not
available for an order line or cart item, no ticket charges will be applied to the order line or
cart item.

Available Order Charges

Apply Default Order Charge for New Orders

Select this option to automatically add the default order charge to the Add Order Charge group in
order management and to the Review Items in the Cart page during general sales for new orders.

If the Some option is selected below, the first order charge listed in the Order Charge table will be
displayed as static text for cart items in general sales. Operators can delete the default order
charge or add other order charges as needed.
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None / All / Some

The Available Order Charges configuration determines the order charges that will be available and
displayed in the Charge Summary group on the Review Items in the Cart page for general sales.
For order management, the configured order charges will be available in the Add Order Charge
group. See an image showing how ticket charges are displayed.

Choose one of the following settings:

l None. No order charges will be displayed or added to orders. Charges listed in the Order
Charge table are ignored.

l All. All configured order charges will be available. Charges listed in the Order Charge table
are ignored.
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l Some. Only the order charges listed in the Order Charge table will be available in order man-
agement and general sales. At least one order charge must be listed in the Order Charge
table.

Order Charge

The order charges in this table are only used if you select the Some option above. Use the Order
Charge table to set the order charges that will be available for display and selection in order man-
agement and general sales. The order charges will be displayed in order management order lines
in the Add Order Charge drop-down list and in the Charge Summary drop-down list on the general
sales Review Items in the Cart page. In both lists, they are included in the order they are listed in
this table.

For each order charge you add to this table, the default charge amount is automatically added to
the read-only Amount column. The amounts are only editable during sales in Pac7.

Load All

Click the Load All button to add all available order charges to the Order Charge table above.

General Sales Only

Order Charge Required

Select this option to require users to choose at least one order charge before they can proceed to
checkout (the Enter Payment Information page) in item sales (general sales or onsales). If you
attempt to checkout without an order charge, the Review Items in the Cart page will redisplay with
an error message. If this option is cleared, operators can proceed to checkout without an order
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charge selected.

Order Charge Amount is Never Changeable

Select this option if you do not want operators to change the order charge amount, regardless of
whether the order charge has been configured to be changeable in the TK.OCHARGE.SEA.E process.
If this option is cleared and the order charge is setup as changeable, the order charge is change-
able in Pac7.

Onsale Charges

Same As Order Management and General Sales

Select this option to use the same charge configuration for the Onsale Charges group that you used
for the Order Management and General Sales Charges group on the left side of this subscreen. If
selected, none of the other Onsale Charges options will be available for setup.

If this option is cleared, you must configure the Available Ticket Charges and Available Order
Charges options below for onsales.

Available Ticket Charges

Note: Ticket charges in tRes are referred to as item fees on the Item Sales tab. Ticket charges are
defined in the TK.TCHARGE.SEA.E process and are applied per item in the item sales shopping cart.
See an image showing how ticket charges are displayed.
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Select one of the following options:

l None. Select this option if you do not want any ticket charges to be available during onsales.

l All Charges Assigned at the Item Level. If you select this option, all ticket charges defined at
the item level will be available for items in the Review Items in the Cart page (as item fees)
during onsales. If you enter a code in the Default field for this option and the charge is avail-
able for an item, the default ticket charge is automatically selected in the Item Fee drop-
down list on the Review Items in the Cart page. If you do not enter a code in Default or the
code you enter is not available for an item, the onsales Item Fee drop-down list defaults to
None.

l One. Select this option if you want the ticket charge in the adjacent field automatically
entered in the Item Fee drop-down list on the Review Items in the Cart page (as item fees)
during onsales. If you select this option and the adjacent ticket charge is not available for an
item, no charge will be applied to the cart item.

Available Order Charges

None / All / Some
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The Available Order Charges configuration controls the order charges that are available and dis-
played in the Charge Summary group on the Review Items in the Cart page during onsales. See an
image showing how order charges are displayed.

Choose one of the following settings:

l None. Select this option if you do not want order charges to be displayed in or added to
orders during onsales. Charges listed in the Order Charge table below are ignored.

l All. Select this option if you want all configured order charges to be available during onsales.
Charges listed in the Order Charge table below are ignored.

l Some. Select this option if you only want the order charges listed in the Order Charge table
below to be available during onsales. At least one order charge must be added to the Order
Charge table.

Load All

Click the Load All button to add all available order charges to the Order Charge table above.

Apply Default Order Charge

Select this option to automatically add the default order charge to the order total on the Review
Items in the Cart page during onsales. If the Some option is selected above, the first order charge
listed in the Order Charge table will be displayed as static text. Operators can delete the default
order charge or add other order charges as needed.
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Order Charge Required

Select this option to require users to choose at least one order charge before they can proceed to
checkout (the Enter Payment Information page) in item sales (general sales or onsales). If you
attempt to checkout without an order charge, the Review Items in the Cart page will redisplay with
an error message. If this option is cleared, operators can proceed to checkout without an order
charge selected.

Order Charge Amount is Never Changeable

Select this option if you do not want operators to change the order charge amount, regardless of
whether the order charge has been configured to be changeable in the TK.OCHARGE.SEA.E process.
If this option is cleared and the order charge is setup as changeable, the order charge is change-
able in Pac7.

Season Item Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E
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From the Paciolan 7 Controls screen, select a Season, and click the details buttonx to display the
Season Detail subscreen. On that subscreen, select an item in the Items table of the Order Man-
agement and General Sales Items group or the Onsale Items group, and then click the details but-
ton to display the Season Items subscreen.

Use the Season Item subscreen to control which price levels and price types for an item can be
sold by operators using this control. You can also set the maximum quantity of the item that can be
sold at specific item price level/price type (I:PL/PT) combinations per order.

Control Descriptions
PrLev

Enter the codes of the price levels that you want to be available for sales of the item by operators
using this control. Press F3 in a PrLev field to display a list of the available price levels. During
order management and general sales, these price levels are listed in the Item Details window.
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They are also listed on the Find Best Available Seats page for general sales.

During an onsale, price levels are listed in the Item Details window and the Select Onsale Items
and Seats page.
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PrType

Enter the codes of the price types that you want to be available for sales of the item by operators
using this control. Available price types will be filtered by the price types that are available by oper-
ator in TK.OP.E. Press F3 to display a list of the available price types for the selected price level.

During order management and general sales, these price levels are listed in the Item Details win-
dow. They are also listed on the Find Best Available Seats page for general sales. During an onsale,
price levels are listed in the Item Details window and the Select Onsale Items and Seats page.

Price

The price of the price level and price type combination, as set in the item's price table.

Note: Before you enter values in the Min Qty, Max Qty, and Multiple fields, make sure you under-
stand how these I:PL/PT level settings and the equivalent item level settings on the Season Detail
subscreen work together. In addition, note that the I:PL/PT combinations you set up here may have
further minimum, maximum, and multiple quantity restrictions set in the item entry processes
(TK.EVENT.SEA.E and TK.COMBO.SEA.E). See Setting Up Order Quantity Rules for Single and Com-
bination Items for more information.

Tip: You can limit the total quantity of items that customers can obtain per season. For more
information, see Setting Seasonal Customer Item Limits.

Min Qty

Set the minimum quantity of the item that can be purchased at the specific I:PL/PT combination dur-
ing order management and general sales. If an operator tries to add a smaller quantity to an order,
the system will display an error message. This field is optional. See Setting Up Order Quantity
Rules for information about how this I:PL/PT level setting works with the Max Qty and Multiple set-
tings, as well as its interaction with the item level settings on the Season Detail subscreen.

Max Qty

Set the maximum quantity of the item that can be purchased at the specific I:PL/PT combination
during order management and general sales. If an operator tries to add a greater quantity to an
order, the system will display an error message. This field is optional. See Setting Up Order Quant-
ity Rules for information about how this I:PL/PT level setting works with the Min Qty and Multiple
settings, as well as its interaction with the item level settings on the Season Detail subscreen.
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Multiple

Set the multiple requirement for the quantity of the item that can be purchased at the specific
I:PL/PT combination during order management and general sales. If an operator tries to enter a
quantity that is not evenly divisible by this multiple, the system will display an error message. For
example, if the multiple is 2, the quantity must be 0, 2, 4, 6 etc. However, if the Max Qty is set to 4
for an item with a multiple of 2, the quantity could only be 0, 2, or 4. This field is optional.

See Setting Up Order Quantity Rules for information about how this I:PL/PT level setting works
with the Min Qty and Max Qty settings, as well as its interaction with the item level settings on the
Season Detail subscreen.

Auto Modify Price Level/Price Type Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

From the Paciolan 7 Controls screen, select a Season, and click the details buttonx to display the
Season Detail subscreen. On that subscreen, select at least one item in the Items table of the
Order Management and General Sales Items group or the Onsale Items group, and then click the
Auto Modify PL/PT button to display the Auto Modify Price Level/Price Type Subscreen.

Use the Auto Modify Price Level/Price Type subscreen to set the valid combinations of price levels
and types for all the items in a season. This screen can be used for order management and general
sales or onsale items.

Control Descriptions
Load Type

Select whether you want to Add or Remove price level/price type combinations from the control.

Seq
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Sequence number of the price level and type. This field cannot be updated.

PrLev

These are the valid price levels that apply to items in the season. These price levels will be listed
on the PL/PT detail screen for single and combo items listed on the Season Detail screen (if they
are valid for that item).

When you enter a valid PrLev, tRes displays the price level description in the adjacent column.

PrType

These are the valid price types that apply to items in the season. These price types will be listed on
the PL/PT detail screen for single and combo items listed on the Season Detail screen (if they are
valid for that item).

When you enter a valid PrType, tRes displays the price type description in the adjacent column.

Season Bill Plan Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Season table on the Paciolan 7 Controls screen, select a season and then click the details but-

tonx to display the Season Detail subscreen. On the subscreen, click the Bill Plan Options button
to display the Season Bill Plan Options subscreen. Use the Season Bill Plan Options subscreen to
configure access to bill plans for users of the Pac7 control during Order Management, General
Sales, and Onsales.

Control Descriptions
Order Management and General Sales Bill Plans

Available Bill Plans

Select one of the None, All, or Some options to control access to bill plans in Order Management
and General Sales. If you select Some, you will need to enter the bill plans you want to be avail-
able for the control in the Available Bill Plans table below.

Load All

Click this button to load all of the bill plans into the Available Bill Plans table. This is the same as
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selecting the All option above. However, you may want to use this function instead to load them all
into the table, and then delete the ones you do not want to be available.

Onsale Bill Plans

Same As Order Management and General Sales

Select this option to apply the setup in the Order Management and General Sales group to Onsales.
If you select this option, you do not need to configure the Available Bill Plans in the Onsale Bill
Plans group.

Available Bill Plans

Select one of the None, All, or Some options to control access to bill plans for Onsales. If you select
Some, you will need to enter the bill plans you want to be available for the control in the Available
Bill Plans table below.

Load All

Click this button to load all of the bill plans into the Available Bill Plans table. This is the same as
selecting the All option above. However, you may want to use this function to load them all into the
table, and then delete the ones you do not want to be available.

Season Discount Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

From the Paciolan 7 Controls screen, select a Season, and click the details buttonx to display the
Season Detail subscreen. On that subscreen, click the Discount Options button to display the
Season Discount Options subscreen. Use this subscreen to set up discounts for order management,
general sales, and onsales. Discounts are configured by season in tRes using the TK.DISC.SEA.E
process.

Control Descriptions
Order Management and General Sales Discounts

Available Discounts

Use this option to specify the discounts that will be available for order management order lines and
for general sales items on the Review Items in the Cart page. Choose one of the following settings:
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l None. Select this option if you do not want discounts to be available in order management
order lines or for items on the Review Items in the Cart page in general sales. The discounts
listed in the Available Discounts table below are ignored.

l All. Select this option if you want all discounts to be available in order management order
lines and for items on the Review Items in the Cart page in general sales. Discounts listed in
the Available Discounts table below have no effect on the available discounts.

l Some. Select this option if you only want the discounts in the Available Discounts table below
to be available in order management order lines and for items on the Review Items in the
Cart page in general sales. You must add at least one discount to the table.

Available Discounts table

Enter the discounts that you want to be available for display and selection in order management
and general sales. Discounts will be displayed in the Discounts drop-down list in Pac7 in the order
they are listed here. If you select None or All for the Available Discounts option above, you do not
need to enter any discounts in the table.

Load All

Click the Load All button to add all available discounts to the Available Discounts table above. For
these discounts to be used, you must select Some for the Available Discounts option above.

Onsale Discounts

Same As General Sales

Select this option to apply the order management and general sales discounts settings (Order Man-
agement and General Sales Discounts on the left side of the screen) to onsales. If selected, none of
the other Onsale Discounts options need to be set up. If this option is cleared, you must configure
the Onsale Discounts options below for onsales.

Available Discounts
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Use this option to specify the discounts that will be available for onsale items on the Review Items
in the Cart page. Choose one of the following settings:

l None. Select this option if you do not want discounts to be available for items on the Review
Items in the Cart page during onsales. The discounts listed in the Available Discounts table
below are ignored.

l All. Select this option if you want all discounts to be available for items on the Review Items
in the Cart page during onsales. Discounts listed in the Available Discounts table below have
no effect on the available discounts.

l Some. Select this option if you only want the discounts in the Available Discount table below
to be available for items on the Review Items in the Cart page during onsales. You must add
at least one discount to the table.

Available Discounts table

Enter the discounts that you want to be available for display and selection during onsales. Dis-
counts will be displayed in the Discounts drop-down list in Pac7 in the order they are listed here. If
you select None or All for the Available Discounts option above, you do not need to enter any dis-
counts in the table.

Load All

Click the Load All button to add all available discounts to the Available Discounts table above. For
these discounts to be used, you must select Some for the Available Discounts option above.

Season Search Plan Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

From the Paciolan 7 Controls screen, select a Season, and click the details buttonx to display the
Season Detail subscreen. On that subscreen, click the Search Plan Options button to display the
Season Search Plan Options subscreen. Use this subscreen to configure the search plans that you
want to be available to operators when they are assigning seats to order lines with allocatable
items. Search plans are configured by season and facility in tRes using the TK.SPLAN.SEA.E
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process.

Tip: For information about using search plans in Pac7, see Using Search Plans in Order Man-
agement.

Control Descriptions
Available Search Plans

Use this option to specify the search plans that will be available for order management order lines.
Choose one of the following settings:

l None. Select this option if you do not want search plans to be available in order management
order lines. The search plans listed in the Facility:Search Plan table below are ignored.

l All. Select this option if you want all search plans to be available in order management order
lines. Search plans listed in the Facility:Search Plan table below will have no effect on the
available search plans when you select this option.

l Some. Select this option if you only want the search plans in the Facility:Search Plan table
below to be available for order management order lines. You must add at least one search
plan to the table if you select this option.
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Facility:Search Plan table

Enter the search plans that you want to be available for selection in order management order lines.
The Search plan command will be displayed in the Seats drop-down list in Pac7. Selecting the
command displays the Search Plan form, where the search plans are available in the order they
are listed in this table. If you select None or All for the Available Search Plans option above, you do
not need to enter any search plans in the table.

Season Seat Status Detail Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E
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From the Paciolan 7 Controls screen, select a Season, and then click the details button to display
the Season Detail subscreen. On that subscreen, click the Seat Status Options button to display the
Season Seat Status Detail subscreen. Use this subscreen to set up the Best Available Seat Search
feature for order management, general sales, and onsale items.

Control Descriptions
Order Management and General Sales Seat Status

Auto Assign Seat Stats

The Best Available Seat Search feature will only search for seats with the statuses listed here. This
is a mandatory field. Press F3 for the list of seat statuses.

Onsale Seat Status

Same As Order Management and General Sales

Select this option to apply the seat status settings for order management and general sales (Order
Management and General Sales Seat Status on the left side of the screen) to onsales. If this option
is cleared, you must set up onsale and order management/general sales seat status separately.

Auto Assign Seat Stats

The Best Available Seat Search feature will only search for seats with the statuses listed here. You
cannot add seat statuses here if you select the Same as Order Management and General Sales
option above. Press F3 for the list of seat statuses.

Batch Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Common group of the Paciolan 7 Controls screen, click the Batch Options button to display
the Batch Options subscreen. Use the Batch Options subscreen to set up how batches are created
and when they expire. The settings on this subscreen apply to the Order Management, Item Sales,
Adjustments, and Exchange tabs.
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Control Descriptions
If Batch is invalid when the user selects control

This option allows you determine what happens when the batch validation process finds an invalid
batch when the user selects the policy. This setting is applied when entering a Paciolan 7 control. If
an invalid batch is encountered at the end of a transaction, a new batch will always be created auto-
matically. You must choose one of the following:

l Automatically create new batch for all operators. When an invalid batch is detected, a valid
batch will be created and written to the control record for all operators. This is the default set-
ting.

l Ticketing operator permissions. When invalid batches are detected, look to users' Batch
Create Access settings in the Selling Parameters subscreen of TK.OP.E to determine beha-
vior.
l If Batch Create Access = N (No Access), an error is displayed and the operator cannot con-
tinue.

l If Batch Create Access = C (Create New Only), a valid batch will be created and written to
the control record.

l If Batch Create Access = U (Unrestricted access), the user can create a new batch or
select an existing batch. The new or existing batch will be written to the control record.

l Never create new batch. When an invalid batch is detected, an error message will be dis-
played and the operator will not be able to continue. This will apply to all users.

Expire Batch

This option allows you to set the number of days after which a new batch will expire. When the
time limit is reached and the batch is expired, the system will automatically create a new batch. If
the time limit is reached during a transaction, the operator will be allowed to complete the trans-
action and it will be written to the expiring batch record.

If you select Do Not Set Expiration Date, batch age does not affect batch expiration.

User Cannot Change Batch Name or Expiration Date

This option only applies to a new batch being created when the user selects a policy. The batch
name and expiration date cannot be changed for batches created at the end of a sale.

l If this option is selected, the system will automatically generate the batch name. The batch
name format is: DATE – OPCD – WBST. The system will also automatically assign an expir-
ation date based on the Expire Batch option settings on this screen. The user will not be able
to change the batch name or expiration date.
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l If this option is cleared, the batch name will be editable. The user will also be able to update
the expiration date on the same page.

Batch Limit

Enter the number of transactions at which the batch will expire. After that number of transactions
is complete, the When Batch is Invalid option setting above will determine how the new batch will
begin.

Order/Exchange Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Shared Setups group of the Paciolan 7 Controls screen, click the Order/Exchange Options but-
ton to display the Order/Exchange Options subscreen. Use this subscreen to configure the available
marks and the Exchange In form for a control.

Control Descriptions
Mark Code

Enter the mark codes that you want to be available for order lines when using this control. You can
create mark codes using the Marks (TK.MARK.E) Marks (TK.MARK.E) process. If you do not enter
any mark codes here, all mark codes will be available to operators using the control.

Exchange In Form

Enter the code of the custom exchange form that you want to use for this control. If you do not
select a custom form, the standard PSI form is entered by default. Thjs form is used for the
Exchange In part of the Pac7 exchange process. For more information, see Creating Custom Forms
for Exchanges.

Patron Options Subscreen (Shared)

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E
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In the Shared Setups group of the Paciolan 7 Controls screen, click the Patron Options button to dis-
play the Patron Options subscreen. Use this subscreen to set the customer type allowed and cus-
tomer information displayed for ticketing operator during sales.

Control Descriptions
Individual Patron Options

Individual Patron Options

The Individual Customer Options control has the following options:

l If House Customer Only is selected, the user can sell only to house customers. Search for Pat-
ron will not be seen in the Process Navigation, and the Search for Patron page will not dis-
play.

l If Individual Customer Only is selected, the user can sell only to individual patrons. Search
for Patron will be displayed in the Process Navigation, the Search for Patron page will dis-
play, and users must sell to individual patrons. No Checkout button is available on the Search
for Patron page.
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l If House or Individual Customer is selected, the user can sell to house and individual cus-
tomers. Search for Patron will be in the Process Navigation. Users choose whether to sell to
house customers. A Checkout button is available on the Search for Patron page.

Note: Pac7 will only look at the Individual Patron permissions at the Control level.

Pac7 will use the TK.OP.E selection for the House Cust Access option (on the Selling Parameters
Subscreen) to determine whether an operator can change the house customer during the selling
process.

Patron Policy Options

Patron Policy

Enter the code of the patron policy you want this control to use. Patron Policies are used to define
patron permissions for Pac7 operators. (For more information, see Defining Patron Policies.) Press
the F3 key to select from a list.

Shipping/Billing Address Entry Options

Use Single Address Entry Form for Shipping and Billing

Select this option if you want to allow the operator to enter only one address for shipping and
billing during the selling process. If an address is entered, it will be stored in both the shipping and
billing fields of the patron database.

Address is Required

Select this option if you want to require operators to enter an address before continuing with the
selling process.

Use Separate Address Entry Forms for Shipping and Billing

Select this option if you want to allow the operator to enter separate addresses for shipping and
billing during the selling process. Entered addresses will be stored in the patron database.

Shipping Address is Required

Select this option if you want to require operators to enter a shipping address before continuing
with the selling process.

Billing Address is Required

Select this option if you want to require operators to enter a billing address before continuing
with the selling process.

Search Options

Allow Search by Credit Card Number

You can allow operators to search for customers by their credit card numbers.

l If you select this option, Pac7 displays a Credit Card # option on the Search for Orders page
during order inquiry.
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Pac7 also displays a Credit Card # option on the Search for Patron page during both the
onsale and general sales selling processes. If operators are not allowed to sell to individual
customers, they may still be able to search by credit card number during the inquiry process,
depending on their permissions.

l If you clear this option, Pac7 does not display a Credit Card # option on the search pages for
either order inquiry or selling.

Payment Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Shared Setups group of the Paciolan 7 Controls screen, click the Payment Options button to
display the Payment Options subscreen. Use the Payment Options subscreen to set up how oper-
ators can process customer payments.
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Control Descriptions
CA Mode

If the payment mode type selected for an order is CC (Credit Card) or SV (Gift Card), Pac7 sends
the value of the Credit Authorization (CA) mode with the order to tRes. The value must be either
Immediate (I) or Pending (P). This is a mandatory field.

CA Terminal Id

The value of the Credit Authorization (CA) Terminal Id is sent with the Pac7 order to tRes, if the pay-
mode type of the order is CC (Credit Card). This is an optional field. If this field is left blank, the CA
Terminal Id will be pulled from the Business Account level.

Valid Payment Modes

Payment Mode

Use the Payment Mode column to set the av4ailable payment modes (paymodes) for the Payment
Type drop-down list on the Pac7 payment information pages on the Order Management, Item
Sales, and Exchange tabs. The valid paymodes will be displayed in the drop-down list in the same
order they are listed here. If full payment is required (see Order Options), the first paymode listed
becomes the default.
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You must add at least one paymode. Press F3 for a list of the available paymodes (along with their
names and payment types) for this control. If the paymode you need is not available, you can cre-
ate it using TK.PAYMODE.E. Each paymode is classified as one of the following payment types:

l CA = Cash paymode (Cash)
l CC = Credit card paymodes (Amex, Discover, MasterCard, Visa)

Note: For credit card paymodes in TK.SELL, TK.PAYMODE allows you to turn off credit card
number verification using the Verify CC Number option on the Credit Card Parameters sub-
screen. However, this option is not applied to use of the paymode in Pac7 — credit card num-
bers are always checked for validity during payment entry in Pac7.

l CK = Check paymodes (personal check or traveler’s check)
l G = Gift certificate paymodes

l OT = Other paymodes except cash (for example, offline credit card or voucher payment)
l SV = Saved value/gift card paymodes

Note: Givex gift cards can be configured as a valid paymode. Gift card payment type must
be added using the Payment Modes process (TK.PAYMODE.E) and included in the Paymode
field here to allow operators to use it as a payment type in the selling process. However, you
will need the assistance of your client partner to configure Givex gift cards as a paymode.

Regardless of which paymodes you include in the control, Pac7 will always display all the fields that
are necessary to enter payment information for all valid paymodes (CA, CC, CK, G, OT, and SV) in
the Payment group of the Enter Payment Information page of the Item Sales tab and the Payment
Methods table of the Payment Information page through the Order Management and Exchange
tabs. However, Pac7 will only let operators make entries in the fields that are required for the Pay-
ment Type (paymode) that is currently selected. For example, if a cash payment type (CA) is selec-
ted, only the Amount text box is active.

AVS Options
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Note: These options only apply if CA Mode is I (Immediate).

AVS Options

Use the AVS Options to set how Pac7 handles address verification results from the credit card pro-
cessing service. Select one of the following:

l Always Accept, No Message. If the credit card processing service accepts the credit card num-
ber but returns a mismatch on the patron's billing address, the credit card will be accepted
and the operator will not be notified about the mismatch.

l Always Accept, with Message. If the credit card processing service accepts the credit card
number but returns a mismatch on the patron's billing address, the credit card will be accep-
ted, however a message about the mismatch will be displayed for the operator.

l Always Reject Mismatches. If the credit card processing service accepts the credit card num-
ber but returns a mismatch on the patron's billing address, the credit card will not be accep-
ted, and a message about the mismatch will be displayed for the operator.

l Approval Authority for Mismatches. If the credit card processing service accepts the credit
card number but returns a mismatch on the patron's billing address, the operator will have
the authority to accept or reject the credit card purchase.

CVV2 Options

Note: These options only apply if CA Mode is I (Immediate).

CVV2 Required

If CVV2 Required is selected and a CC type paymode is used for the order, Pac7 requires the oper-
ator to enter a value in the CV# box during payment entry. By default, CVV2 Required is cleared.

CVV2 Options

These options only apply if you select the CVV2 option above. Choose one of the options for how
Pac7 handles the credit card processing service's response to the supplied CV#:

l Always Accept, No Message. If the credit card processing service accepts the credit card num-
ber but returns a mismatch on the CV#, the credit card will be accepted and the operator will
not be notified about the mismatch.

l Always Accept, with Message. If the credit card processing service accepts the credit card
number but returns a mismatch on the CV#, the credit card will be accepted, however a mes-
sage about the mismatch will be displayed for the operator.

l Always Reject Mismatches. If the credit card processing service accepts the credit card num-
ber but returns a mismatch on the CV#, the credit card will not be accepted, and a message
about the mismatch will be displayed for the operator.

Other Options

Ok to use Last CCNUM

If Ok to use Last CC NUM is selected, the current patron has previously used a credit card, and CC
type is a valid paymode in the Paciolan 7 control, Pac7 will display an active Use Previous CC but-
ton during payment entry for individual patrons. This setting is not valid for sales to house cus-
tomers.
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If Ok to use Last CC NUM is cleared, Pac7 will not display the Use Previous CC button. By default,
Ok to use Last CC NUM is selected.

Display Tendered/Change Due

If Display Tendered/Change Due is selected, Pac7 will display Tendered and Change fields during
payment entry. If Display Tendered/Change Due is cleared, Pac7 will not display the Tendered and
Change fields. By default, Display Tendered/Change Due is cleared.

Print/Receipt Options for Selling Paths Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Common group of the Paciolan 7 Controls screen, click the Print/Receipt Options button to
display the Print/Receipt Options for Selling Paths subscreen. Use this subscreen to set up how
ticket operators can issue receipts and mailers on the Item Sales, Order Management, and
Exchange tabs. You also must select the printer type (Boca or laser) with which operators will print
items.
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Control Descriptions
Print To

This option sets the type of printer to be used to print tickets, receipts, and mailers for this control
to either a Boca or a Laser printer. You cannot set a control to print to both laser and Boca printers.

Traditional Delivery Defaults

Print Tickets

This option sets the default print option for each order line that contains an allocatable item during
order management, exchanges, and item sales. Traditional delivery methods include those that
print tickets to stock, including Boca and laser printers. If this option is selected, allocatable items
will print at the end of the sale. If not selected, allocatable items will not print at the end of the
sale.

Note: If the Review Items in the Cart or Enter Additional Information pages in item sales are cus-
tomized to allow operators to select the print option, their choice will override this default.

Process Items

This option sets the default print option for each order line that contains a non-allocatable item dur-
ing order management, exchanges, and item sales. Traditional delivery methods include those that
print items to stock, including BOCA and laser printers. If this option is selected, non-allocatable
items will print at the end of the sale. If not selected, non-allocatable items will not print at the end
of the sale.

Note: If the Review Items in the Cart or Enter Additional Information pages in item sales are cus-
tomized to allow operators to select the delivery method, their choice will override this default.

Electronic Delivery Defaults
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Print Tickets

This option sets the default print option for each order line that contains an allocatable item during
order management, exchanges, and item sales. Electronic delivery methods include print at home
and magstripe delivery. If this option is selected, allocatable items will be sent (print at home
email) or activated (magstripe ID/credit card) automatically at the end of the sale. If not selected,
allocatable items will not be sent or activated at the end of the sale.

Note: If the Review Items in the Cart or Enter Additional Information pages in item sales are cus-
tomized to allow operators to select the print option, their choice will override this default.

Process Items

This option sets the default print option for each order line that contains a non-allocatable item dur-
ing order management, exchanges, and item sales. Electronic delivery methods include print at
home and magstripe delivery. If this option is selected, non-allocatable items will be sent or activ-
ated at the end of the sale. If not selected, non-allocatable items will not be sent or activated at the
end of the sale.

Note: If the Cart or Enter Additional Information pages in item sales are customized to allow oper-
ators to select the print option, their choice will override this default.

Mailer/Receipt Options

Print Mailer

Select a Print Mailer option to set whether Pac7 should print a mailer along with order items. You
must choose one of the following options:

l Always. Pac7 will print mailers whenever tickets are printed, and the operator will not be noti-
fied about the printing. Pac7 will not display the mailer option when entering payment inform-
ation during order management, exchanges, and item sales.

l Optional. When entering payment information during order management, exchanges, and
item sales, the Mailer Option (see the Item Sales tab version) is available and defaults to Do
Not Print. The operator can select the Print option.

l Never. Pac7 will not display the Mailer Option when entering payment information during
order management, exchanges, or item sales, and no mailers will be printed at the end of
the sale.

Mailer Form Code

Enter the code for the mailer form to be used when printing mailers. You must enter a value in the
Mailer Form Code text box, unless you select Never for the Print Mailer option. Use the Print Forms
process (TK.FORMS.E) to configure mailer forms.

Print Receipt

Select a Print Receipt option to set whether Pac7 should print a receipt with the order items. You
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must choose one of the following options:

l Always. Pac7 will print for all paymodes or for each user receipt group, based on whether
you select the Print for All Paymodes or the User Receipt Group option below.

l Optional. The operator will be able to select when to print a receipt. The Receipt Option will
display when entering payment information during order management, exchanges, or item
sales. However, the Receipt Option (see the Item Sales tab version) will only be available
when receipt printing is available, according to your selection of the Print for All Paymodes or
the User Receipt Group option below.

l Never. Receipts will never print at the end of a sale.

Receipt Form Code

Enter the code for the receipt form to be used when printing receipts. You must enter a value in the
Receipt Form Code text box, unless you select Never for the Print Receipt option. Use the Print
Forms process (TK.FORMS.E) to configure receipt forms.

Print for All Paymodes

If Print for All Paymodes is selected, Pac7 will print one copy of each receipt for all order pay
modes. The operator cannot change this setting.

Use Receipt Group

Select this option to limit receipt printing to one predefined subset of paymodes. If the Use Receipt
Group option is selected, Pac7 will select the Print for the Receipt option (see an Item Sales tab
example) when entering payment information for paymodes in the selected receipt group.
However, the operator can override this option by selecting a different receipt option for any order.

Receipt Group

This is the default receipt group code for the group of paymode types to be used to print receipts.
Press F3 to display a list of receipt groups. A code is required only if you select the Use Receipt
Group option above.

Seat Searching/Map Options Subscreen (Shared)

Paciolan 7 > Selling Setups > Paciolan 7 Controls
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TK.ETCONTROL.E

In the Shared Setups group of the Paciolan 7 Controls screen, click the Seat Searching/Map Options
button to display the Seat Searching/Map Options subscreen. Use this subscreen to set the seat
gap, next price level search, seat map,and sold seat display for the Order Management, Exchange,
and Item Sales tabs. You can also use this subscreen to set the multiple event search option for
item sales.

Control Descriptions
Auto Assign Seat Gap

During the best available seat search for item sales, exchanges, and order management, the sys-
tem will not allow a seat gap in a row that is less than or equal to the number you enter here. For
example, if you enter 1 in this field, the system will not allow a seat selection that would leave a
single seat open.

If you leave this field blank, the system will be allowed to create any seat gap when doing a best
available seat search.

Search Next Price Level

When searching for a specific price level during a best available seat search, you have the fol-
lowing options:

l If you select Search Next Price Level and seats are not found at the price level specified, the
system will search for seats at the next lower price level, as long as the specified price type
is valid for the that price level.

l If you clear Search Next Price Level and seats are not found at the price level specified, the
system will stop searching and display an alert message.

Seat Map Options
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Access to Seat Map in Item Sales

Select this option to allow access to the seat map functionality in item sales. If you do not select
this option, operators using this control for item sales will not have access to the seat map, and
none of the other Seat Map Options below are applicable. In addition, the item sales seat map but-

tonx that allows seat map access will not be displayed.

Access to Seat Details

This option controls access to seat details from the right-click menu on the Seat Map. If you select
the option, operators will have access to seat details from the right-click menu. If the option is
cleared, operators will not have access to seat details from the right-click menu.

Access to Seat History

This option controls access to seat history from the right-click menu on the Seat Map. If you select
the option, operators will have access to seat history from the right-click menu. If the option is
cleared, operators will not have access to seat history from the right-click menu. By default, this
option is selected.
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Access to Seat Status

This option controls access to seat status from the right-click menu on the Seat Map. If you select
the option, operators will have access to seat status from the right-click menu. If the option is
cleared, operators will not have access to seat status from the right-click menu.

Access to Manually Nest a Section in the Map

Nesting allows you to establish relationships between combo items that reference the same
events, and between a combo and its associated single events. The primary function of nesting in
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tRes is to provide composite seat maps, which indicate the availability of same-seats in the nest
and nesting levels based on the data setup in Season Status (TK.SEASON.E).

Nesting allows the user to get a view of seat availability across all events within a combo. When
nesting, the system “stacks” all the events in the combo and drills through each seat to determine
if the same seat is available for all events. See a graphical example.

If a seat is not in the same status for one or more events in the combo and the user has access to
all of these statuses, the seat status will display the M character (Mixed seat statuses). If the seats
are available in a better combo (one that is listed at a higher level in TK.SEASON.E), the seat
status is displayed as the number of the higher level (1 to 9).

Note: For more information about season status nesting levels, see the tRes Help topic.

Access to View How Seats were Sold

Select this option to allow operators to view how seats were sold in one or more sections on the
seat map. The table below details how the current seat statuses will display on the map.

Current seat status Display as…

Any available seat White “.” These seats can be selected while in this
view.

* Black “*” (asterisk). These seats can be released
while in this view.

C, T, H, K, un-sold seat in an seat status
unavailable to the user

Display Character & Color defined for status “-“ 
(dash)

X
A true sold seat.
Does not apply to seat displayed as X
because its seat status is unavailable to
the user

Display Character & Color defined for Item Basis: PT
for which the seat was sold. Defined at
TK.PRTYPE.SEA.E
If no Display Character & Color is defined for the Item
Basis: PT, display black “0”

Note: This option does not work in conjunction with the access to seat status or manual nesting
options. If these options are selected, selecting the Access to View How Seats were Sold will auto-
matically deselect them.

Display sold seats as:

"X" (use if selling from multiple data accounts)

This is the default option. If this option is selected, user access to hold codes (seat status) will be
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controlled by the eligible hold codes setup in TK.OP.E for the operator code that they are assigned
during user administration. If a user does not have access to a Paciolan hold code and this option is
selected, seat map will usually display the seat as an X.

This option is useful for outlet operators who do not need to understand why certain seats are not
available. This is also helpful for phone operators who will be selling across multiple data accounts,
because the user defined character may change for each data account. Using this option will allow
for a consistent display across the data accounts.

User Defined Character for "X" Status

If this option is selected, user access to hold codes (seat status) will be controlled by the eligible
hold codes setup in TK.OP.E for the operator code that they are assigned during user
administration. If a user does not have access to a Paciolan hold code and this option is selected,
seat map will use the display character for each status as defined in TK.SSTAT.SEA.E (see the tRes
topic). This option is useful for employees who need to know why a certain seat is not available.
This option may also be useful for full time staff at the main venue.

Option for Item Sales - General Sales Only

Multi Event Seat Search

If this option is selected, the Search for Multiple Events page will be available during general sales,
and the Search Multiple Events link will be displayed at the top and bottom of the Search for Item
page. If this option is not selected, then neither the Search for Multiple Events page or the link will
be available.

Order Management Order Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Order Management group of the Paciolan 7 Controls screen, click the Order Options button to
display the Order Management Order Options subscreen. Use this subscreen to select custom
forms, set order defaults, and set user functionality permissions for operators using the Order Man-
agement tab.
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Control Descriptions
Order Management Form

Enter the code of the order form you want to use for the order header, order line, and order line
additional tables and toolbars on the main page of the Order Management tab. For more inform-
ation, see Creating Custom Forms for Order Management.
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Order/Pay Only

Select this option to limit users of this selling control to order and payment processing tasks. Users
will not be allowed to use the following seat processing functionality:

l Reallocation
l Seat map
l Assign best available seats
l Seat splits
l Multiple event searches
l Seat fields (read-only viewing allowed)
l Seatblocks (read-only viewing allowed)

Mandatory Seat Assignment

Select this option to require operators using this selling control to assign seats to allocatable items
when processing orders. Operators will not be allowed to finish processing orders until seats are
assigned.

Drop Past Events

Select this option to keep single event items whose event dates have passed out of item search res-
ults. This setting does not affect past events in combination items.
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Default Price Split Quantity

Select this option to automatically add the order line quantity into the Available Price Types table
on the Price Split form.

Customer Limit Override

Select this option to allow operators to override customer limits on item quantities. Customer lim-
its reduce the quantity of an item that customers can obtain through purchases, post-sale trans-
actions, and other processes. For more information, see Setting Seasonal Customer Item Limits in
the tRes Help.

Require Password

If you select the Customer Limit Override option, configure whether operators should be
required to enter a password by selecting the Password Required option. The password is set on
the Order Management Passwords subscreen of the Paciolan 7 Business Accounts screen
(TK.BA.E).

Item Sale Date/Time Override

Select this option to allow operators to sell items outside of their configured sale date and time
intervals (from and to dates). Item sale dates are set at the item level for single event, com-
bination, miscellaneous, and access pass items.

Require Password

If you select the Item Sale Date/Time Override option, configure whether operators should be
required to enter a password by selecting the Password Required option. The password is set on

Pac7 Release 7.2

http://webhelp.paciolan.com/robohelp/robo/server/general/projects/tres/How/Setting_Seasonal_Customer_Item_Limits.htm


User Guide  1083

the Order Management Passwords subscreen of the Paciolan 7 Business Accounts screen
(TK.BA.E).

Allow Cancels

Select this option to allow operators to cancel order line items. If you clear this option, you will not
be able to reduce the quantity for order lines once they have been processed.

If you select the Allow Cancels option, you must configure whether the system should enforce item
rules (min/max/multiple) when operators cancel item quantities. Select one of the following:

l Allow with no restrictions. Select this option to ignore item rules when canceling order line
quantities.

l Use Item Rules. Select this option to prevent a cancel operation that would reduce the quant-
ity of the order line item to an amount that violates item rules (an invalid minimum or a mul-
tiple quantity).

l Use Item Rules with password override. Select this option to allow a cancel operation that
violates item rules if the operator enters the override password for cancels. The password is
set on the Order Management Passwords subscreen of the Paciolan 7 Business Accounts
screen (TK.BA.E).

Tip: For more information about item rules, see Order Quantity Rules in the tRes Help.

Allow Exchanges

Select this option to allow operators to exchange tickets from the Order Management tab. If you
clear this option, the Exchange menu item and toolbar button will not be available in the Order
Lines table. This setting is separate from enabling the use of the Exchange tab (Go Exchange),
which is configured on the Go Exchange subscreen.

Require Password

If Allow Exchanges is enabled, select this option to require that operators enter a password
when they attempt to exchange seats from the order management order line. The password is
set on the Order Management Passwords subscreen of the Paciolan 7 Business Accounts screen
(TK.BA.E).
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Exchange Out Seat Status Changeable

If Allow Exchanges is enabled, you can select this option to allow operators to change the status
of exchanged out seats from the exchange parameters default.

Require Password

If Exchange Out Seat Status Changeable is enabled, you can select this option to require that
operators enter a password when they attempt to change the seat status from the default
status. The password is set on the Order Management Passwords subscreen of the Paciolan 7
Business Accounts screen (TK.BA.E).

Allow Reprints

Select this option to allow operators to reprint order line items. If you clear this option, the
Reprint tickets menu item and toolbar button will not be available in the Order Lines table. If you
select this option, configure whether operators should be required to enter a password using the
Password Required option. The password is set on the Order Management Passwords subscreen of
the Paciolan 7 Business Accounts screen (TK.BA.E).

Require Password

If Allow Reprints is enabled, select this option to require that operators enter a password when
they attempt to reprint tickets from the order management order line. The password is set on
the Order Management Passwords subscreen of the Paciolan 7 Business Accounts screen
(TK.BA.E).
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Allow Returns

Select this option to allow operators to return tickets for a customer from an order line on the
Order Management tab. When tickets are returned, the money can either be refunded or, more typ-
ically, kept as a donation credit for the customer. If you clear this option, the Returnmenu item
and toolbar button will not be available in the Order Lines table.

Require Password

If Allow Returns is enabled, select this option to require that operators enter a password when
they attempt to return tickets from the order management order line. The password is set on
the Order Management Passwords subscreen of the Paciolan 7 Business Accounts screen
(TK.BA.E).

Return Seat Status Changeable

If Allow Returns is enabled, you can select this option to allow operators to change the status of
exchanged out seats from the exchange parameters default.

Require Password

If Exchange Out Seat Status Changeable is enabled, you can select this option to require that
operators enter a password when they attempt to change the seat status from the default
status. The password is set on the Order Management Passwords subscreen of the Paciolan 7
Business Accounts screen (TK.BA.E).

Allow Voids

Select this option to allow operators to void order line items. If you clear this option, the Void
order line menu item and toolbar button will not be available in the Order Lines table.

Require Password

If you select the Allow Voids option, configure whether operators should be required to enter a
password by selecting the Password Required option. The password is set on the Order Man-
agement Passwords subscreen of the Paciolan 7 Business Accounts screen (TK.BA.E).

Fee Cap Setting

This option applies to single event items only. The fee cap is the maximum dollar amount that can
be charged for a single transaction. It does not apply at the order level. If the sum of the fees for a
transaction is greater than the fee cap amount, the excess fee amount is subtracted from the order
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charge. The per ticket charge amount in the order lines is not reduced. (For more information, see
Season Fee Cap Parameters Screen in the tRes Help.)

Select one of the following options from the drop-down list:

Option Description

Do NOT Enable Fee
Cap Savings

No fee cap is applied to transactions.

Enabled Fee Cap-
ping (Savings
Amount is NOT
Changeable)

If the item charges for a single transaction exceed the cap amount, the order
charge will be reduced by that amount.

Enabled Fee Cap-
ping (Savings
Amount is Change-
able)

If the item charges for a single transaction exceed the cap amount, the order
charge will be reduced by that amount by default. However, operators will be
able to change the fee cap amount subtracted from the order charge.

Cancel Item Charge

If an order line item has been processed with an item charge and the item is canceled, you can
decide what level of control operators have over canceling the item charge. Choose one of the fol-
lowing:

l Never Cancel. The item charge is automatically added to the order charges.
l Optional. The operator can decide whether to cancel the item charge or add it to the order
charges.

l Always. The item charge is automatically canceled when the item is canceled.

Will Call Disposition Code

This is an optional field. Enter the will call disposition code that you want entered automatically in
order lines for event items beginning at a set number of days before the event date. In Days, enter
the number of days before the event to automatically begin using the will call disposition code. If
the item is a fixed combo, the date for each single event in the combo will be checked. This field
does not apply to designer combos.

Available Disposition Codes

Disposition

Enter the disposition codes that you want to be available to operators using this control. If you do
not enter any disposition codes, all disposition codes will be available.

Order Management Payment/Post Sale Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Order Management group of the Paciolan 7 Controls screen, click the Payment/Post Sale
Options button to display the Order Management Payment/Post Sale Options subscreen. Use this
subscreen to configure the payment, refund, and end of sale options for the Order Management
tab.
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Control Descriptions
Order Payment Rules

Auto Add Payment

Select this option to automatically add the balance due to the Amount field in the Payment Methods
table when finishing an order. You can change the amount after it has been automatically added. If
you change the amount to a partial amount and add another Payment type row, the balance due
will be automatically entered in the Amount field of the added row.
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Full Pay Required

Select this option if you want full payment to be required when using this selling control. If this
option is selected, a sale cannot be finished until the amounts entered in the Payment Methods
table will leave no positive amount due.

Over Pay Allowed

Select this option to allow over payment of the amount due when finishing an order. Over payment
is represented by a negative number in the amount due after payment. In the example below, the
balance due is $100 and a $180 payment is entered, so the amount due after payment is -$80.
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Mandate Refund

Select this option to prevent partial refunds when processing a refund payment. In the example
below, the balance due is -$80 but only -$30 is entered for the payment amount, leaving -$50 due
after payment. This order cannot be purchased until one or more payment amounts are equal to -
$80.

Require Refund Password

Select this option to require operators using this control to enter a password before finishing a
refund order. The password is set on the Order Management Passwords subscreen of the Paciolan 7
Business Accounts screen (TK.BA.E).
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Payment Apply

The Payment Apply Options determine the options operators using this control will have for dis-
tributing payments when processing order payment information. The option you select is the
default in the Payment distribution selection list. Choose one of the following options:

l No Payment Apply. If you select this option, the Do not apply payments option is chosen
by default in the Payment distribution selection list. This option prevents the application of
dollar amount payments to order line items or order charges.

l Apply Current Payment. If you select this option, the Apply payment to current order
only option is chosen by default in the Payment distribution selection list. This option dis-
tributes the total dollar amount of payments to the current order's line items and order
charges only.

l Apply All Payments. If you select this option, the Apply payment to all line items option
is chosen by default in the Payment distribution selection list. This option distributes the total
dollar amount of payments to all orders associated with the patron. Undistributed payments
will be distributed for the entire season.

Apply Option Changeable

If Apply Option Changeable is selected, all 3 Payment Apply options will be available in the Pay-
ment Distribution selection list. The Payment Apply options selection above will be the default
option, but operators using this control will be able to select any one of the options. If Apply Option
Changeable is cleared, operators will not be able to change the default option.
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Refund Parameters

Display Previous Paymodes/Amounts

Select this option to display previously used paymodes and amounts when processing returns.

Auto Refund Paymode

Enter the codes of the paymodes that you want to be available for automatic refunds.

Default Refund Paymode

Enter the code of the paymode that you want the system to use for refunds that have no purchasing
paymode specified.

End of Sale

Show Reprint link on End of Sale dialog

An End of Sale dialog box is displayed when you finish processing an order during order man-
agement. Select this option to display a Reprint current order link in the End of Sale dialog box
when printing tickets for one or more order lines. The link only displays when operators have prin-
ted tickets as part of finishing the current process. If you want operators to be able to reprint prin-
ted tickets during subsequent order processing, you will need to select the Allow Reprints option on
the Order Management Order Options subscreen.

Allow Order Confirmation Email

Optional (Default No) / Optional (Default Yes)

Select one of these two options if you want to allow operators to send confirmation email mes-
sages when they finish processing orders. For this option to be available in Pac7, confirmation
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email must also be enabled for TK.SELL on the Email Templates subscreen of the System Setup
(TK.SETUP.E).

Never Allow

Select this option if you do not want the operator using this control to be able to send a con-
firmation email. The Confirmation Email options will not be displayed on the Payment Information
page.

Allow send for House Customer

Select this option to allow operators to enter an email address and send a confirmation email
message to that address when selling to a house customer. This option is not available if you
select the Never Allow option.

Show Order Summary link on End of Sale dialog

An End of Sale dialog box is displayed when you finish processing an order during order man-
agement. Select this option to display a Print order summary link in the End of Sale dialog box.
When you can click this link, a printable window containing the content of the confirmation email
message is displayed. This option is not available if you select the Never Allow option.
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Delivery Methods Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the
Delivery Methods button to display the Delivery Methods subscreen. Use this subscreen to set the
allowed item delivery methods for item sales.

Control Descriptions
Delivery Method

The delivery methods specified here are listed in the Delivery Methods drop-down list. At least one
delivery method must be defined per control.

Delivery methods are displayed in the drop-down list in the order they are listed on this subscreen.
The first delivery method is the default delivery method. Delivery methods are displayed if the
cutoff days and hours are greater than the system date minus the event date.

Note: Delivery methods do not control whether tickets are printed at the end of sales. End of sale
printing is controlled by the settings on the Print/Receipt Options for Selling Paths subscreen and by
operator selection (if allowed).

Display Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the Dis-
play Options button to display this subscreen. Use the Display Options subscreen to set up the dis-
play of information for the general and onsale selling paths, including the Select Onsale Items and
Seats, Search for Item, and Review Items in the Cart pages.
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Control Descriptions
Ticket Price Display Options

Use these options to determine whether facility fees will be displayed with item prices. Choose one
of the following options:

l Item Price Only. If you select this option, the item price will only include the base ticket
price.

l Item Price + Facility Fee. If you select this option, the item price will include the base ticket
price and the facility fee. This setting applies only to single event and fixed combo items.

l Item Price + Facility Fee + Item Charge. If you select this option, the item price will include
the base ticket price, the facility fee, and the ticket charge. This setting applies to all item
types except donation items.

The setting you choose is reflected everywhere pricing is displayed by PL and PT, including the fol-
lowing locations:

l Find Best Available Seats page
l Item details window
l Select Onsale Items and Seats page

Seatblock Display Options

Use these options to set how seatblock information is displayed during the selling process. Select
one of the following:

l Abbreviated (Lev:Sect:Row:SeatFrom,SeatTo). Select this option to display seatblocks in
concatenated format (as they display in tRes).

l Not Abbreviated. Select this option to display seatblocks in three separate columns:
Level:Section, Row, and Seats. The Level:Section values will be taken from the settings on
the Item Sales Level Section Conversion screen. If no Level:Section conversions have been
entered, the value from the manifest will be displayed.

These options set how seatblocks display on all Pac7pages, except where the seats are broken out
separately for selection purposes (for example, during reprints).

Cart Display Options
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Onsale Form Code

Enter a form code to designate what fields display on the Review Items in the Cart and Enter
Additional Information pages in the onsale sales path (Onsale path selected). This is a man-
datory field. Press the F3 key for a list of form codes that have been created using TK.EFORMAT.E.
For the procedure, see Creating Custom Forms.

Access to Item Additional Page

This option sets access to the Enter Additional Information page (for onsales only).

l If this option is not selected, the Enter Additional Information page will not be available,

and Pac7 will not display the item additional buttonx for any order lines in the cart. This
is true regardless of whether the general sales form you select designates elements to be
displayed on the Enter Additional Information page.

l If this option is selected, the Enter Additional Information page will be available, and Pac7

will display the item additional buttonx for all order lines in the cart. The values on the
Enter Additional Information page will be based on the general sales form you select.

This option applies regardless of whether the cart pages are editable or static. The cart includes
the following pages: Review Items in the Cart, Enter Payment Information, and Order Con-
firmation. This option does not apply to any inquiry or adjustment process, such as order
inquiry, return, or reprint.

Access to Charge Details Page

This option sets access to the Order Charge Additional Details page (for onsales only).

Pac7 Release 7.2



User Guide  1096

l If this option is not selected, the Order Charge Additional Details page will not be avail-
able, and Pac7 will not display the Change buttonx in the Charge Summary group
of the cart.

l If this option is selected, the Order Charge Additional Details page will be available, and
Pac7 will display the Change buttonx in the Charge Summary group of the cart.

General Sales Form Code

Enter a form code to designate what fields display on the Review Items in the Cart and Enter
Additional Information pages in the general sales path (General Sales path selected). This is a
mandatory field. Press the F3 key for a list of form codes that have been created using
TK.EFORMAT.E. For the procedure, see Creating Custom Forms.

Item Display Options

Display Future Events

By default, the Search Results group on the Search for Item page only shows events that are cur-
rently onsale. Pac7 does not display events that go on sale in the future. You have the following
choices with this option:

l If Display Future Events is cleared, Pac7 will not display events with a Sell From Date in the
future.

l If Display Future Events is selected, Pac7 will display events with a Sell From Date in the
future in the following way:
l In the Item Name field, the system will display the onsale date (for example, Home vs.
Visitors on sale 01/01/08). This is the "sell from" date for the item based on the time zone
for the user's location.

l There is no link under the event name, since that link would allow operators to search for
seats that they cannot sell for a future event. For example, "Home vs. Visitors on sale
01/01/08" would not be a link.
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l The Details link is displayed but only shows the Event Date and Time info and the Event
Description and Comments. Pac7 does not display the Availability and Pricing matrix.

Display Seat Availability on Item List

This option determines whether Pac7 displays seat and miscellaneous item availability for general
sales in the Search Results group on the Search for Item page. By default this option is not selec-
ted. You have the following options:

l If this option is selected, Pac7 displays seat availability in the Search Results on the Search
for Item page.

l If this option is not selected, Pac7 does not display seat availability in the Search Results on
the Search for Item page.

Display Seat Availability on Item Details Popup

This option determines whether Pac7 displays seat and miscellaneous item availability for general
sales in the Item Details window.
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This window displays when a user clicks the Details link for an item in the Search Results group of
the Search for Item page. By default this option is not selected. You have the following options:

l If this option is selected, Pac7 displays seat and miscellaneous item availability in the Item
Details window.

l If this option is not selected, Pac7 does not display seat and miscellaneous item availability
in the Item Details window.

General Sales Best Available View

Allowed

When this option is selected for a view, the view will be accessible to users of this control during
general sales. You must select this option for at least one of the views. You cannot make a view the
default unless its Allowed option is selected.
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Default View

You must select this option for one of the views, to make it the default view during general sales.
The default view automatically displays on the Find Best Available Seats page when you click an
item name on the Search for Item page.

PL-PT Table View

This Table View lists all the price level and price type combinations for an item.

PL List View

This List View shows only price levels for an item on the Find Best Available Seats page. You
choose a price type later in the item sales process.

Quick Entry View

This single line entry format allows you to enter the price level and price type codes without a selec-
tion list. This format can allow faster entry when operators already know the codes for the items
they are selling.

Item Groups Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls
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TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the Item
Groups button to display this subscreen. Use the Item Groups subscreen to select the item groups
you want to add to the selling control for item sales.

Control Descriptions
Item Group

In the Item Group field, press F3 to select the Item Group names that will be displayed during gen-
eral sales for operators assigned to this selling control. This is a mandatory field. Only item groups
that have been created using TK.TGROUP.E will be available for display.

The item groups will be displayed on the general sales version of the Search for Item page in the
order they are listed on this subscreen. See an example.

Note: Item groups listed here can include all item types.

Order Options Subscreen (Item Sales)

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

Note: These settings do not apply to the Order Management tab. For information about order
options for order management, see Order Management Order Options Subscreen.

From the Item Sales, Inquiry, and Adjustments area on the Paciolan 7 Controls screen, click the
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Order Options button. Pac7 displays the Order Options Subscreen. Use the Order Options subscreen
to set order options for item sales, item pricing, order timeout options, and payment apply options
for the Item Sales tab.

Control Descriptions
Options for Promo Sales

Allow Access to Promotions

Select this option to allow access to the Promo Sales pages for users of this control. The main
Promo Sales page is displayed along with the General Sales and Onsale pages on the Item Sales
tab. When this option is selected, operators using this control can sell all promotions configured for
the data account, provided they enter a valid promotion access code. This includes operators that
do not have access to some or all of the price types or seat statuses used in the promotion.
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The price types and seat statuses listed in the promotion setup override all TK.OP.E restrictions dur-
ing promotion sales. For more information, see Setting Up Promotions.

Options for General Sales

Allow Prorating Events Out of a Fixed Combo (also applies to Promo sales)

You can set the following proration options on the Find Best Available Seats and Enter Additional
Information pages:

l If this option is selected, Pac7 displays the Prorate link for fixed combo items.

l If this option is cleared, Pac7 does not display the Prorate link for fixed combo items. If one
or more events in the combo has an event date in the past, then the combo will not be dis-
played on the Search for Item page.

This option also applies to promotional sales.

Seat Assignment Required

If this option is selected, users must assign seats before they can submit the Review Items in the
Cart page. If this option is cleared, users will be able to submit the Review Items in the Cart page
without making seat assignments.

Note: This setting does not apply to promotional sales. The seat allocation rules are set separately
for each promo item during promotion setup.

Full Payment Required (also applies to Promo Sales)

This option allows you the following payment options:
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l If Full Payment Required is selected, the order must be paid in full on the Enter Payment
Information page. The operator cannot place the order until the Balance Remaining = 0.00.

l If Full Payment Required is cleared, the order may be underpaid on the Enter Payment
Information page. The operator can place the order as long as the Balance Remaining >=
0.00. Overpayment is not allowed for item sales.

This option also applies to promotional sales.

Allow Autoload

You add autoload items to single events in tRes through the season event setup (TK.EVENT.SEA.E)
at the item price level/price type (I:PL/PT) level on the Item Miscellaneous subscreen.

If this option is cleared, items set up with autoload items can be added to the cart, but their auto-
load items will not be added with them. This setting applies to items purchased through the general
sales path only.

If this option is selected, autoload items can be added automatically or offered to the operator
when the primary item is added to the cart. Autoloaded single items are assigned at the I:PL/PT
level; as a result, the default quantity of the autoloaded item is the same as the I:PL/PT quantity.
However, if you select the Ask Operator Before Adding Autoloaded Items option below, the oper-
ator will be allowed to change the default quantity before items are added to the cart. The operator
can change the quantities of autoloaded items in the cart at any time.

The autoload option assigns seats to single event items before they are added to the cart. If seat
assignment is not possible for a single event, the item is still added to the cart with no seats
assigned, and the operator must use the seat map or use best available search with a different
I:PL/PT to find seats. Combination items are always autoloaded with no seats assigned.

If this option is selected, you must select either the Add Autoload Items Directly to Cart option or
the Ask Operator Before Adding Autoload Items option below.

Add Autoloaded Items Directly to Cart

Select this option to add autoload items to the cart without prompting the operator. However,
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once items are autoloaded to the cart, operators can always remove items and change item
quantities. When items are autoloaded, Pac7 informs the operator by displaying a message in
the cart.

Ask Operator Before Adding Autoloaded Items

Select this option to prompt the operator to decide which autoload items and what quantity
should be added to the cart. Before displaying the cart page, Pac7 displays the Add More Items
(Optional) page. This page allows the operator to decide what autoload items and quantities will
be added to the cart. Operators can always change item quantities and remove items on the cart
page.

Item Pricing

Miscellaneous Items

Setup miscellaneous item pricing by selecting one of the following:

l Price is Never Changeable. If this option is selected, the price will not be changeable for any
miscellaneous items.
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l Look to Item Level "Changeable" Flag. If this option is selected, Pac7 will look to the item
level changeable (Changeable) option (in TK.IMISC.SEA.E or TK.IMISC.ACT.E) to determine
if the item price is changeable.

Donation Items

Setup donation item pricing by selecting one of the following:

l Price is Never Changeable. If this option is selected, the price will not be changeable for dona-
tion items.

l Look to Item Level "Changeable" Flag. If this option is selected, Pac7 will look to the item
level changeable (Changeable) option (in TK.IDON.SEA.E or TK.IDON.ACT.E) to determine if
the item price is changeable.

Options for Onsale

Seat Assignment Required

Select this option if you want to require users to assign seats before they can checkout from the
Review Items in the Cart page. If Seat Assignment Required is cleared, users will be able to check-
out from the Review Items in the Cart page without making seat assignments.

Full Payment Required

Use this option to choose whether underpayment is allowed. If Full Payment Required is selected,
the order must be paid in full on the Enter Payment Information page. The operator cannot place
the order until the Balance Remaining = 0.00. If Full Payment Required is cleared, the order may
be underpaid on the Enter Payment Information page. The operator can place the order as long as
the Balance Remaining >= 0.00. Overpayment is not allowed during item sales.

Allow Autoload

Note: Only miscellaneous items can be autoloaded through the onsale path. For miscellaneous
items to be autoloaded, they must first be added as an autoload item to the single item setup
(TK.EVENT.SEA.E). You add autoload items in TK.EVENT.SEA.E at the price level/price type level
through the Item Miscellaneous subscreen. Once it is added in TK.EVENT.SEA.E, you must add the
autoload item to the control using the Add Items for Autoload button on the Season Detail sub-
screen.
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If this option is cleared, no item that is added to the cart through the onsale path will be auto-
loaded, regardless of the autoload settings at the item level.

If this option is selected, autoload items can be added automatically or offered to the operator
when the primary item is added to the cart. Also, if you select the Ask Operator Before Adding Auto-
loaded Items option below, the operator will be allowed to change the default quantities before
items are added to the cart. The operator can always change the quantities of autoloaded items
once they are in the cart.

If this option is selected, you must select either the Add Autoload Items Directly to Cart option or
the Ask Operator Before Adding Autoload Items option.

Add Autoloaded Items Directly to Cart

Select this option to add autoload miscellaneous items to the cart without prompting the oper-
ator. However, once items are autoloaded to the cart, operators can always remove items and
change item quantities. When items are autoloaded, Pac7 informs the operator by displaying a
message in the cart.
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Ask Operator Before Adding Autoloaded Items

Select this option to prompt the operator to decide which autoload miscellaneous items and
what quantities should be added to the cart. Before adding autoload items to the cart, Pac7 dis-
plays the Add More Items (Optional) page. This is the page allows the operator to select auto-
load items and enter quantities. Operators can always change item quantities and remove items
on the cart page.

Payment Apply Options

Click this button to display the Item Sales Payment Apply Subscreen. Use this subscreen to set up
how payments are distributed when orders are processed during item sales.

Timeout Options

Click this button to display the Order Timeout Options subscreen. Use this subscreen to set the
order timeout, as well as under what conditions and for how long the order time may be extended.

Item Sales Payment Apply Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the
Order Options button to display the Order Options subscreen. On the Order Options subscreen, click
the Payment Apply Options button to display the Item Sales Payment Apply subscreen. Use this sub-
screen to set up how payments are distributed when orders are processed during item sales. The
option you select is the default in the Options group of the Enter Payment Information page on the
Item Sales tab.

Control Descriptions
No Payment Apply

If this option is selected, the total payment dollar amount for the order will not be distributed to
line items or order charges. If this option is selected and Apply Option Changeable is also selected,
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a Do Not Distribute Current Payments option is included in the Payment Distribution list of the
Options group on the Enter Payment Information page.

Apply Current Payment

If you select this option, the total payment dollar amount for the order will be distributed to the cur-
rent line items and order charges. If you select this option and Apply Option Changeable, the Dis-
tribute Current Payments to Current Order option is included in the Payment Distribution list of the
Options group on the Enter Payment Information page.

Apply All Payments

If you select this option, the total payment dollar amount for the order will be distributed to all
orders associated with the patron (undistributed payments will be distributed for the entire sea-
son). If this option is selected and Apply Option Changeable is also selected, a Distribute All Undis-
tributed Payments option is included in the Payment Distribution list of the Options group on the
Enter Payment Information page.

Apply Option Changeable

If Apply Option Changeable is selected, all three Payment Apply Options will be selectable in the
Payment Distribution list of the Options group on the Enter Payment Information page. The Pay-
ment Apply Options selection you make will be the default option, but the user will be able to select
any one of the options.
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If Apply Option Changeable is cleared, the user will not be able to change the option that you set in
the Payment Apply Option group.

Order Timeout Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the
Order Options button to display the Order Options subscreen. On the Order Options subscreen, click
the Timeout Options button to display the Order Timeout Options subscreen. Use this subscreen to
set the order timeout, as well as under what conditions and for how long the order time may be
extended.

Control Descriptions
Timeout in Seconds

This option limits the time that seats can be kept on hold. If the duration of an order exceeds this
limit, the order will expire and the on hold seats will be released. This is a mandatory field. The
default value is 300 seconds.

Limit in Seconds
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This is the time limit within which the order timeout will be extended if the user is actively working
on the order. This is a mandatory field. The default value is 60 seconds.

Extension in Seconds

This is the amount of time the order timeout will be extended if the order time is within the order
time-out limit and the user is actively working on the order. This is a mandatory field. The default
value is 3600 seconds.

Patron Options Subscreen (Item Sales)

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

Note: These settings do not apply to the Order Management tab. For information about patron
options for order management, see Patron Options Subscreen (Common).

From the Item Sales, Inquiry, and Adjustments area on the Paciolan 7 Controls screen, click the
Patron Options button to display the Patron Options subscreen. Use this subscreen to set the quick
patron mode and patron entry options in item sales for the ticketing operators using this control.

Control Descriptions
Options for Quick Patron Only

Quick Patron Mode

Choose the mode for the Quick Patron function: Basic or Advanced. The Basic Quick Patron entry
page has the standard Shipping and Billing address entry fields along with standard phone/email
fields, including day phone, evening phone, and email. The address types and phone/email types
used are defined in the Data Account setup screens.

The Advanced Quick Patron entry page allows for more customization. The address types and
phone/email types used are defined in the Data Account and Patron Policy setup screens. In addi-
tion to the basic patron entry information, Advanced Quick Patron displays the following:
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l Multiple phone/email types
l Multiple shipping and billing address types
l The names of the ticketing status and type codes
l Ticketing comments associated with the patron

Allow Update of Existing Patron Data

If operators are allowed to sell to individual customers and they select an existing patron record,
you can set the following:

l If you select this option, operators can update the patron information fields.
l If you clear this option, the patron information fields for existing customer records are static
(cannot be updated).

Options for General Sales and Promo Sales

Display Patron Entry Form

Set whether Pac7 should display the patron entry forms (the Search for Patron and Enter Patron
Information pages) before or after the Review Items in the Cart page during general sales and pro-
motional sales.

Patron Entry Format

Set whether Pac7 should display the full or quick patron entry format during general sales and
promo sales. If you select Quick Patron Entry, the format will be basic or advanced, depending on
your selection for the Quick Patron Mode option above. If you select Full Patron Entry, all the con-
figured patron entry tabs (Home, Personal, Biography, and so on) will display. The full entry
format allows operators to enter complete patron information during general sales and pro-
motional sales.

Post Sale Options Subscreen (Item Sales)

Paciolan 7 > Selling Setups > Paciolan 7 Controls
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TK.ETCONTROL.E

Note: These settings do not apply to the Order Management tab. For information about post sale
options for order management, see Order Management Payment/Post Sale Options Subscreen.

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the Post
Sale Options button to display the Post Sale Options subscreen. Use this subscreen to set up the
available functionality for completed orders. This includes sending order confirmation email mes-
sages, voiding orders, reprinting orders, inquiring about existing orders, returning orders items,
and completing will call pickups.

Control Descriptions
End of Sale Options

Allow Order Confirmation Email

Use this option to set when order confirmation email messages should be sent to patrons. You can
prohibit confirmation email messages by selecting the Never Allow option, or you can allow the
operator to choose when to send messages. To allow the operator to choose, select Optional
(Default Yes) to make the default choice sending a message, or select Optional (Default No) to
default to not sending a message.

Allow Void Last Order

This option allows you to set whether operators assigned to this control can void item sales trans-
actions. If selected, Pac7 displays the Void this Order button on the Order Confirmation page. By
default, this option is cleared, and the Void button is not displayed.
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Password Required

If this option is selected and an operator clicks the Void this Order button, Pac7 displays the
Password Verification page, including password instructions. When the operator enters a pass-
word, Pac7 validates the password against the Void Last Order password entered on the Paci-
olan 7 Business Accounts screen.

Allow Reprints

This option allows you to set whether Pac7 operators assigned to this control can reprint tickets. If
this option is selected, Pac7 displays the Reprint button on the Order Confirmation page during
selling, the Order Details page during order inquiry, and the Pickup Confirmation page during will
call pickup.

Password Required

If this option is selected and a user clicks the Reprint button, Pac7 displays the Password Veri-
fication page, including password instructions. When a user enters a password, Pac7 validates
the password against the Reprint password entered on the Paciolan 7 Business Accounts screen.
By default, no password is required for the Allow Reprints option.
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Display Message if New Batch or House Customer is Created

Select this option to display a message on the Order Confirmation page if a new batch or house cus-
tomer has been created during the transaction. The message will include the new batch or house
customer number. Clear this option to not display the message when a new batch or house cus-
tomer has been created.

Order Inquiry

Select this option to allow users to perform order inquiries. Pac7 will only display the Inquiry tabin
the navigation bar if this option is selected.

If you clear this option, the Inquiry tab is not displayed in the navigation bar, and users of this con-
trol cannot perform order inquiries.

If you select this option, click the Order Inquiry Options button to set the options on the Order
Inquiry Options subscreen.

Order Inquiry Options

Click this button to display the Order Inquiry Options subscreen.

Hide Adjustments Tab

Select this option to hide the Adjustments tab for operators during Item Sales.

Return Items

This option allows you to determine whether Pac7 operators assigned to this control can return
items. Operators return items using the Adjustments tab on the Pac7 navigation bar. This tab is dis-
played regardless of your Return Items option setting.
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If this option is selected, operators are allowed to search for and return individual items from cus-
tomer orders. If it is cleared, when users click the Return Items tab, Pac7 displays a static page.
By default, this option is cleared.

Return Options

Click this button to display the Return Item Params subscreen.

Will Call Pickup

This option determines whether Pac7 users assigned to this control can access will call orders.
Users access will call orders by doing the following:

1. Click the Adjustments tab on the Pac7 navigation bar.
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2. Click the Will Call Pickup page link.

If this option is selected, users are allowed to search for and select will call orders for pickup. If it
is cleared, the Will Call tab does not display under the Adjustments tab tab. By default, this option
is cleared.

Will Call Options

Click this button to display the Will Call Pickup subscreen.

Order Inquiry Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the Post
Sale Options button to display the Post Sale Options subscreen, and then click the Order Inquiry
Options button to display the Order Inquiry Options subscreen.

Use this subscreen to setup the functionality of the Inquiry tab, including order accessibility, pass-
word protection, and email messaging of order confirmations.
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Control Descriptions
Search Item Sales Orders Only

Select this option from the drop-down list to only allow users to perform inquiries on orders placed
through the Item Sales tab. When a user clicks the Inquiry tab, Pac7 displays the Search for Orders
page without the option to switch to a search of all systems.

Search All Orders (Default Search All Systems)

Select this option to allow users to perform inquiries on orders placed through any sales channel,
including Item Sales, eVenue, and TK.SELL. The When a user clicks the Inquiry tab, Pac7 displays
the Search for Orders page. If this option is selected, a Search for Orders in this System Only link
is displayed on the page. This link allows users to switch to a search on seasonal orders placed in
Item Sales only (referred to as This System Only).

Search All Orders (Default Search Item Sales)

Select this option to allow users to perform inquiries on orders placed through any sales channel,
including item sales, eVenue, and TK.SELL. The When a user clicks the Inquiry tab, Pac7 displays
the Search for Orders page. If this option is selected, a Search for Orders in All Systems link is dis-
played on the page.This link allows users to switch to a search on seasonal orders placed in all sys-
tems.

Password Required
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If this option is selected, Pac7 displays the Password Verification page when users click the Inquiry
tab. Pac7 validates the password against the Order Inquiry password specified on the Paciolan 7
Business Accounts screen.

If the password is validated, Pac7 displays the Search for Orders page. By default, this option is
cleared and no password is required to access the Inquiry tab pages.

Able to Email Order Confirmation

If this option is selected, Pac7 displays the Email Order Confirmation link on the Order Details page
during the order inquiry process. Users can send a confirmation email to the patron who placed the
order by clicking this link.

Note: When an order confirmation is resent through order inquiry, the order confirmation email
will display the order as it was at the time the order was originally placed. Any subsequent back
office (tRes) changes made to the order will not be reflected in the resent order confirmation.

Able to Search for Incomplete Orders

From the Search for Orders page, Pac7 can allow users to search specifically for incomplete
orders. If you select this option, users can click the Search for Incomplete Orders link to search for
incomplete orders. If this option is cleared, the control does not allow users to search for incom-
plete orders, and the link will not be displayed.
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Return Item Params Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the Post
Sale Options button, and then click the Return Options button to display the Return Item Params
subscreen. The purpose of the returns process is to allow operators to return and refund payments
for items that were originally purchased through Pac7. For different users, access to the returns
feature can be turned off entirely, restricted so that printed tickets must be present to be returned,
or set up to allow ticket returns with the customer or order information only.
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Pac7 can also assist outlets with a return by allowing supervisors in a remote support location to
process returns for other users. Payments refunded through Pac7 will then be reflected on Pac7
sales reports so that users at your outlets, remote phone centers, and box office can balance at the
end of the day.

Note: When processing returns you must assign a sales code. The list of sales codes is the same
list assigned to the entire Paciolan 7 selling control. To make the appropriate sales codes available
during the returns process, you must include them in the Salecode table on the Paciolan 7 Controls
screen.

Use the Return Item Params subscreen to setup the Return Items page functionality of the Adjust-
ments tab, including password protection, search options, treatment of order charges, and the
refund payment modes that are valid.
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Note: Only items defined as returnable in the item setup will be allowed to be returned. This is
accomplished by selecting the Returnable option on the Item Miscellaneous subscreen
(TK.EVENT.SEA.E) of the event item setup.

Control Descriptions
Password Required

If this option is selected, Pac7 displays the Password Verification page when users click the Return
Items page link on the Adjustments tab. Pac7 validates the password against the Return password
specified on Passwords subscreen of the Paciolan 7 Business Accounts screen.

If the password is validated, Pac7 displays the Return Items page. By default, this option is cleared
and no password is required to access the Adjustments tab.

Search Options

Use this option to set what search criteria will be available to operators using this control. You can
either allow searches by the order barcode only, or you can allow the use of all available search cri-
teria, including the barcode.

Cancel Order Charge

This option allows you to determine how to handle order charges during item returns. You have the
following choices:

l Never Cancel. Select this to never allow canceling of the order charge on returned items,
with no user input. Order charges will never be returned to the customer.

l Optional - Default Yes. Select this to display the Select Fees to Return page during the item
return process.
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A Change button will also be displayed in the Fees to Return group on the Summary of Items
to Return page.

If the user clicks the Change button, Pac7 displays the Select Fees to Return page with all the
Fees selected. On both pages with all fees selected, all order charges will be returned to the
customer. The user can then clear the selection of one or more fees to not return them.

l Optional - Default No. Select this to display the Select Fees to Return page during the item
return process.

A Change button will also be displayed in the Fees to Return group on the Summary of Items
to Return page.
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If the user clicks the Change button, Pac7 displays the Select Fees to Return page with all the
Fees cleared. On both pages with all fees cleared, no order charges will be returned to the
customer. The user can then select one or more fees to return them.

l Always Cancel. Select this to always cancel the order charge on returned items, with no user
input. Order charges will always be returned to the customer.

Note: Do not cancel order charges for items from seasons that do not have items selected for
return.

Cancel Item Charge

This option allows you to determine how to handle item charges during item returns. You have the
following choices:

l Never Cancel. Select this to never allow canceling of the item charges on returned items,
with no user input. Item charges will never be returned to the customer.

l Optional - Default Yes. Select this to display the Return Item Fee checkbox, defaulting to
selected. If the user leaves it selected, the item charges will be returned to the customer. If
the user clears the selection, the item charges will not be returned.
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l Optional - Default No. Select this to display the Return Item Fee checkbox, defaulting to
cleared. If the user selects the checkbox, the item charges will be returned to the customer.
If the user leaves it cleared, the item charges will not be returned.

l Always Cancel. Select this to always cancel the item charges on returned items, with no user
input. Item charges will always be returned to the customer.

Note: Do not cancel item charges for items from seasons that do not have items selected for
return.

Process Returns for Another User

Ability to Assign a Return/Credit to Alternate User for Balancing

Select this option to allow operators using this control to assign a return credit to an alternate user,
for the purpose of balancing your books. The return amount will be reflected on the Alternate BOCA
Sales Summary Report.

Tip: Use this option for managers who need to process returns for outlet operators, when the
refund amount needs to be reflected on the outlet operators' cash cards.
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If you select this option, the user can assign alternate user data to a return by clicking the Process
a Return for Another User link on the Search for Orders to Return page.

Pac7 will display the Search for User to Assign Return page. If the option is cleared, the link is not
displayed. By default, this option is cleared.

Return Salecode

Each return is assigned a salecode. By default Pac7 uses the salecode from the original order.
However, you can allow the operator (usually a manager concerned with accurate reporting) to
choose another salecode during the return. Select one of the following options:

l Allow Salecode to be Selected. Select this option to allow the operator to choose from the
available salecodes during the return. This is the default option.

l Always use Salecode from the Original Order. Select this option to automatically use the sale-
code that was used to process the original order. The original order's salecode will be used
even if it is not currently configured for the control.

Valid Refund Modes

Refund Payment Mode

Use this table to enter the payment modes that can be used for refunds when an item is returned.
These pay modes are listed as Payment Types in the Refund Payment group on the Enter Refund
Payment page. The names of all pay modes listed here will be displayed in the Payment Type drop-
down list in the order they are listed in this box.
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This is a mandatory field. Press F3 for a list of the valid paymodes, along with their names and pay-
ment types, for this control. Each mode is classified as one of the following payment types:

l C = Cash pay mode (Cash)
l CC = Credit card pay modes (Amex, Discover, MasterCard, Visa)
l CK = Check pay modes (personal check or traveler’s check)
l OT = Other pay modes (for example, offline credit card or voucher payment)

If there are no CC type pay modes, Pac7 will not display credit card specific information fields. If
there are no CK (Check) type pay modes, Pac7 will not display the CK information fields (Document
ID).

Will Call Pickup Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Item Sales, Inquiry, and Adjustments group on the Paciolan 7 Controls screen, click the Post
Sale Options button, and then click the Will Call Options button to display the Will Call Pickup sub-
screen. The purpose of the will call pickup process is to allow immediate printing of tickets for pat-
rons at the will call window. If your business practice is to pre-print will call tickets in bulk, you will
not use the will call pickup process. Items purchased through any sales channel (item sales, order
management, TK.SELL, eVenue, and TMP orders) can be picked up using will call pickup through
the Adjustments tab.
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In Pac7, will call tickets are located by searching for the patron who is assigned to pickup the tick-
ets. This can either be the patron who ordered the tickets or a different patron who is assigned on
the order to pick up the tickets. All items eligible for that patron will be available for pickup.

Use the Will Call Pickup subscreen to setup the Will Call Pickup tab functionality of the Adjustments
tab, including the allowable items and valid dispositions settings. Items ordered through any Paci-
olan sales channel can be picked up using the Pac7 will call process.

Note: To make sure that tickets are available for will call pickup, verify the following:

l The correct item types are available to be picked up.
l The disposition codes used in all of your sales channels are listed.
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l The season from which the will call items were purchased is accessible in the Paciolan 7 con-
trol. (See the Season table on the Paciolan 7 Controls Screen). Items purchased on TK.SELL,
eVenue, and TMP orders will not be available if the season from which the will call items
were purchased is not added to the Season table.

Note: In addition to the tRes setup issues detailed above, items may not be available for pickup
because the patron has a balance due on the season from which the will call items were purchased.
To determine why tickets are not available for pickup, you will need to check the patron’s order for
the season the tickets were from to see if there is a balance due on the account. The balance will
need to be paid to make tickets from that season available for will call pickup.

Control Descriptions
Allowable Items

Non Renewable Items Only

If you select this option, only non-renewable items will be available for will call pick up. If an order
contains both renewable and non-renewable items, only the non-renewable items can be picked up
through the will call process. If this option is cleared, both non-renewable and renewable items will
be available. By default, the option is cleared.

Single Event Items

If this option is selected, single event items can be picked up. If you also select Non-Renewable
Items Only above, however, pickups will be limited to non-renewable single event items. If the
Single Event Items option is cleared, no single event items cannot be picked up. By default, this
option is selected.

Combo Items

If this option is selected, combination items can be picked up. If you also select Non-Renewable
Items Only above, however, pickups will be limited to non-renewable combo items. If the Combo
Items option is cleared, combo items cannot be picked up. By default, this option is cleared.

Miscellaneous Items

If this option is selected, miscellaneous items can be picked up. If it is cleared, miscellaneous
items cannot be picked up. By default, this option is cleared.

Valid Dispositions

This list of disposition codes limits the items that are eligible for will call pickup. Items must be
assigned one of these codes to be eligible, unless the Allow Items w/No Disposition option is selec-
ted below.

If no disposition codes are entered, no disposition codes are valid for will call pickup. So, you must
enter at least one disposition code, unless the Allow Items w/No Disposition option is selected.

Allow Items w/No Disposition

If this option is selected, items with no disposition code assigned will be eligible for will call pickup.
If cleared, only items assigned one of the disposition codes in the Valid Dispositions table will be eli-
gible. By default, this option is cleared.

Other Options

Salecode

Enter the salecode that will be submitted with the order/transaction to tRes. This is the salecode
that is used to track where and how the will call order occurred. This salecode is independent of the
salecode values that are listed in the Salecode field of the Paciolan 7 Controls Screen.
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Print Mailer

Use this option to set the circumstances under which mailers will be printed for will call orders. The
selections include the following:

l Never. Select this option to not allow print mailers.
l Default Checked. Select this option to allow users to decide when to print mailers. The
default selection will be to print mailers.

l Default Unchecked. Select this option to allow users to decide when to print mailers. The
default selection will be to not print mailers.

l Always. Select this option to automatically print mailers with each will call transaction.

Format

Select a print format for mailers. This format must be compatible with your printer setup on the
Print/Receipt Options subscreen (either BOCA or Laser). Press the F3 key select one from the list of
formats that are compatible with your setup.

Season

Enter the codes of the open seasons from which you want to select items that will not be eligible for
will call pickup. You can add seasons that have not been massloaded to the setup, although none of
the items from that season will be available for will call pickup anyway until the season has been
successfully massloaded.

Items Not Allowed

Enter items from the seasons you enter that you do not want to be eligible for will call pickup.
Press the F3 key for a selection list of the items from the associated season.

Go Exchange Options Subscreen

Paciolan 7 > Selling Setups > Paciolan 7 Controls

TK.ETCONTROL.E

In the Go Exchange group of the Paciolan 7 Controls screen, click the Go Exchange Options button
to display the Go Exchange Options subscreen. Use the Go Exchange Options subscreen to con-
figure access to Go Exchange functionality, as well as whether the operator can change the
exchange out seat status.

Control Descriptions
Allow Access to Go Exchange

Select this option to allow operators access to the Go Exchange functionality using the Exchange
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tab.

Require Password

If Allow Access to Go Exchange is enabled, select this option to require that operators enter a pass-
word when they click the Exchange tab. For information about setting Go Exchange passwords, see
Configuring Exchanges for Paciolan.

Exchange Out Seat Status Changeable

If Allow Access to Go Exchange is enabled, select this option to allow operators to change the
status of exchanged out seats from the exchange parameters default.

Require Password

If Exchange Out Seat Status Changeable is enabled, select this option to require that operators
enter a password when they attempt to change the seat status from the default status. For inform-
ation about setting Go Exchange passwords, see Configuring Exchanges for Paciolan.

Item Sales Formats Screen

Paciolan 7 > Selling Setups > Item Sales Forms

TK.EFORMAT.E

Use the Item Sales Formats screen to customize the display of data fields on the Review Items in
the Cart and Enter Additional Information pages in Pac7. You do this by creating one or more
forms, and then linking those forms to Pac7 selling controls. For each control, you can also assign
different forms for the general sales and onsales selling processes.
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Each form has data field settings for both the Review Items in the Cart and the Enter Additional
Information pages. In addition to determining the data fields that are displayed on these pages,
forms allow you to choose which fields are mandatory and where the fields are positioned.

Control Descriptions
Format

The code for the format you are creating or editing. Enter a new or existing alphanumeric string, or
press the F3 key to see the list of existing formats.

Name

The description for the code entered in Format above. This description automatically displays for
existing formats and must be entered for new formats.

Cart Display Options

Default Headings

This option sets the length of the format's default headings. If you select Not Abbreviated, Pac7 dis-
plays the long column headers. If you select Abbreviated, the shortened version is displayed. The
following table shows each form of the Review Items in the Cart page headings.

Abbreviated Not Abbreviated

Qty Qty

PL Price Level

PT Price Type

Seatblock Seatblock (for the Abbreviated seat)

Lev Level (for the Not Abbreviated seat)

Sec Section (for the Not Abbreviated seat)

Row Row (for the Not Abbreviated seat)

SFrom Seat From (for the Not Abbreviated seat)
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Abbreviated Not Abbreviated

STo Seat To (for the Not Abbreviated seat)

Unit $ Unit Price

Sub $ Subtotal

FFee Facility Fee

Disc Discount Name

Disc $ Discount

SChg Surcharge Name

SChg $ Surcharge

IFee Item Fee Name

IFee $ Item Fee

Total Total

Mark Mark

Promo Promotion

Gift Cert# Gift Certificate #

APass # Access Pass #

Special Special Handling

Notes Notes

Print Print/Process

BPlan Billing Plan

Item Pref Item Preference

Loc Pref Location Preference

OLPri Order-Line Priority

Grp# Group #

ODate Order Date

Cart Definition

Click this button to display the Cart Definition subscreen.

Item Additional Options

Order-Line Details

Click this button to display the Order-Line Details subscreen.

Additional Information

Click this button to display the Additional Information subscreen.

Cart Definition Subscreen

Paciolan 7 > Selling Setups > Item Sales Forms

TK.EFORMAT.E

From the Item Sales Formats screen, click the Cart Definition button to display the Cart Definition
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subscreen. Use the subscreen to select the data fields that you want to display on the Review Items
in the Cart page on the Item Sales tab. For some data fields, you can also select the format of the
displayed data.

Control Descriptions
Field

The list of fields that can be displayed on the Review Items in the Cart page. Each field has a Dis-
play setting, and some fields also have a data Format selection.

Display

In the Display column, select the fields that you want to display on the Review Items in the Cart
page. Fields that are selected to display and dimmed (including Qty, Price Level, Price Type, Unit
Price, Base Price, and Subtotal), are required to display on the page by the system.

Tip: Select the Order Breakdown Popup option to display a link in the Charge Summary group of
the Review Items in Cart page. Operators can click this link to display the order total breakdown in
a popup window.
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Format

This option allows you to choose the format of the data for some of the data fields (those with a
drop-down list in the Format column). For these fields, you can display the tRes name, code, or
code and name. For example, if the Price Level code is 1 and its name is Field, you can choose to
display 1 (Code Only), Field (Name Only), or 1 - Field (Code - Name).

More Cart Options

Click this button to display the More Cart Options subscreen. This subscreen contains some addi-
tional fields that you can choose to display on the Item Sales tab. The Display and Format options
work as described above.
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Any fields you select on this screen will display at the right in each item group on the Review Items
in the Cart page. For each selected field, enter a number in the Seq text box, starting with 1. The
higher the number, the farther to the right the field will display.

Some fields allow the Pac7user to select or enter values. For example, the Mark field displays a
drop-down selection list, and the Notes field displays a text box. If you want to require the user to
make a selection or enter a value for a field, select the Mandatory option for that field. If you
select Mandatory for a field with a drop-down list, the user will not be able to select None.

Note: If you are selling promotion items during item sales and they are setup with location pref-
erences in TK.PROMO.E, the location preference field will only be displayed during item sales if you
select the Location Preference option on this subscreen. However, if you also select the Mandatory
option for the Location Preference display here, at least one location preference must be listed for
each item in the promotion through TK.PROMO.E, and the Allocate option for each item must not be
selected.

Order-Line Details Subscreen

Paciolan 7 > Selling Setups > Item Sales Forms

TK.EFORMAT.E

From the Item Sales Formats screen, click the Order-Line Details button to display the Order-Line
Details subscreen.
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Use this subscreen to select the data fields that you want to display in the Order Line Details group
on the Enter Additional Information page on the Item Sales tab. For some data fields, you can also
select the format of the displayed data.

Control Descriptions
Field

The list of fields that can be displayed on the Enter Additional Information page. Each field has a dis-
play setting, and some fields also have a data format selection option.

Display

In the Display column, select the fields that you want to display on the Enter Additional Information
page.

Format

This option allows you to choose the format of the data for some of the data fields (those with a
drop-down list in the Format column). For these fields, you can display the tRes name, code, or
code and name. For example, if the Item Fee code is P and its name is Phone Convenience Charge,
you can choose to display P (Code Only), Phone Convenience Charge (Name Only), or P - Phone
Convenience Charge (Code - Name).
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Additional Information Subscreen

Paciolan 7 > Selling Setups > Item Sales Forms

TK.EFORMAT.E

From the Item Sales Formats screen, click the Additional Information button to display the Addi-
tional Information subscreen.
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Use this subscreen to select the data fields that you want to display in the Additional Details group
on the Enter Additional Information page on the Item Sales tab. For some data fields, you can also
select the format of the displayed data and whether operator input is mandatory.

Control Descriptions
Field

Pac7 Release 7.2



User Guide  1139

A list of fields that can be displayed in the Additional Details group on the Enter Additional Inform-
ation page. Each field has a Display setting, and some fields also have a data Format selection or a
Mandatory option.

Note: For information about how the Bill Plan, Alternate Address, Will Call Customer, and Asso-
ciated Customer options are used by operators, see Entering Additional Information for Items.

Display

In the Display column, select the fields that you want to display in the Additional Details group on
the Enter Additional Information page.

Format

This option allows you to choose the format of the data for some of the data fields (those with a
drop-down list in the Format column). For these fields, you can display the tRes name, code, or
code and name. For example, if a Mark code is A1 and its name is Option A1, you can choose to dis-
play A1 (Code Only), Option A1 (Name Only), or A1 - Option A1 (Code - Name).

Mandatory

Some fields allow the Pac7 user to select or enter values. For example, the Mark field displays a
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drop-down selection list, and the Notes field displays a text box. If you want to require the user to
make a selection or enter a value for a field, select the Mandatory option for that field. If you
select Mandatory for a field with a drop-down list, the user will not be able to select None.

Order Management Forms Screen

Paciolan 7 > Selling Setups > Order Management Forms

TK.OMFORM.E

Use the Order Management Forms screen to customize the toolbars, table columns, and fields on
the main page of the Order Management tab.

Control Descriptions
Form

Enter a new or existing code for the order management form you want to configure. Press the F3
key to select one from the list of existing forms.

Name

Enter a descriptive name for the form code. This is only used on this screen to help you identify the
form that is configured for the form code.

Field

Enter each field for which you want a column displayed in the Order Lines table on the Order Man-
agement tab. The item (ITEM), item quantity (QTY), price level (PRLEV), and price type (PRTYP)
fields are required and are automatically entered in the first rows of the table in that order. You
can add the item name field (ITEMN), but only directly under ITEM. The columns display in the
Order Lines table from left to right based on the order they are entered.
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See the list of column fields below with codes, descriptions, column heading text, and rules. You do
not need to add a field that is not required in the Field column, because a column for that field does
not need to be included in the Order Lines table in Pac7.

Code Description Column
Heading Rules

ACUST Associated Cus-
tomer

Assoc cus-
tomer Not required

ACUSTN Associated Cus-
tomer Name

Assoc cus-
tomer name

Not required (if used, must directly follow
ACUST)

APNUMBER Access Pass
Number Access pass Not required

ATYPE Address Type Ship address Not required

ATYPEN Address Type
Name Address name Not required (if used, must directly follow

ATYPE)

BAL Item Balance Item balance Not required

BPTYPE Billing Type Bill plan Not required

BPTYPEN Billing Type
Name Bill plan name Not required (must directly follow BPTYPEN)

CHG Item Charge Charge Not required

CHGA Item Charge
Amount

Charge
amount Not required (if used, must follow CHG)

CHGN Item Charge Charge name Not required (if used, must directly follow
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Code Description Column
Heading Rules

Name CHG)

CHGP Item Charge
Price Charge price Not required (if used, must follow CHG)

DATE Item Order Date Order date Not required

DID Item Delivery
ID

Item delivery
ID Not required

DISC Item Discount Discount Not required

DISCA Item Discount
Amount

Discount
amount Not required (if used, must follow DISC)

DISCN Item Discount
Name

Discount
name

Not required (if used, must directly follow
DISC)

DISCP Item Discount
Price Discount price Not required (if used, must follow DISC)

DISP Disposition
Code Disposition Not required

DISPN Disposition
Code Name

Disposition
code name

Not required (if used, must directly follow
DISP)

EXT Extension Extension Not required

EXTP Extension Price Extension
price Not required

FEEA Fee Amount Fee amount Not required

FEEP Fee Price Fee price Not required

GCDOC Gift Cert Doc # Gift Cer-
tificate Not required

GROUP Group Number Group Not required

GTW.GROUP GTW Group
Number GTW group Not required

GTW.GROUPN GTW Group
Name

GTW group
name

Not required (if used, must directly follow
GTW.GROUP)

INRDATA Internet Refer-
ral Data

Inet referral
data Not required

INRSRC Internet Refer-
ral Source

Inet referral
source Not required

INSRC Internet Source Inet source Not required

IPKG Item Package Item pkg Not required

IPKGN Item Package Item pkg Not required
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Code Description Column
Heading Rules

Name name

IPREF Item Preference Item pref Not required

IPREFN Item Preference
Name

Item pref-
erence name

Not required (if used, must directly follow
IPREF)

ITEM Item Item Required and mandatory (must always be the
first variable listed in the grid)

ITEMN Item Name Item name Not required (if used, must directly follow
ITEM)

MARK Mark Code Mark code Not required

MARKN Mark Code
Name

Mark code
name

Not required (if used, must directly follow
MARK)

NOTE Item Note Note Not required

OLID Online Order ID Online order
ID Not required

PREF Location Prefer-
ence

Location pref-
erence Not required

PREFN Location Prefer-
ence Name

Location pref
name

Not required (if used, must directly follow
PREF)

PRI Item Priority Item priority Not required

PRICE Item Price Price Not required

PRINT Print Item Print Tickets Not required

PRNT Quantity Printed Qty Printed Not required

PRLEV Price Level Price level Required and mandatory

PRLEVN Price Level
Name

Price level
name

Not required (if used, must directly follow
PRLEV)

PROMO Promotion Code Promo code Not required

PRTYP Price Type Price type Required and mandatory (must follow PRLEV)

PRTYPN Price Type
Name

Price type
name

Not required (if used, must directly follow
PRTYP)

QTY Item Quantity Qty Required and mandatory (must directly follow
ITEM or ITEMN)

SCHG Item Surcharge
Code Surcharge Not required

SCHGA Item Surcharge
Amount

Surcharge
amount Not required (if used, must follow SCHG)
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Code Description Column
Heading Rules

SCHGN Item Surcharge
Name

Surcharge
name

Not required (if used, must directly follow
SCHG)

SCHGP Item Surcharge
Price

Surcharge
price Not required (if used, must follow SCHG)

SEAT Seatblocks Seatblocks Not required

SPEC Special Hand-
ling

Special hand-
ling Not required

STAT Item Status Item status Not required

SUBTOTAL Total Item Price Subtotal Not required

WCCUST Will Call Cus-
tomer

Will call cus-
tomer Not required

WCCUSTN Will Call Cus-
tomer Name

Will call cus-
tomer name

Not required (if used, must directly follow
WCCUST)

There is no limit to the number of fields (columns) in the Order Lines table. If there are too many
columns to display given the size the operator makes the browser window, a horizontal scroll bar
will automatically be added to allow access to hidden columns by scrolling. You cannot enter the
same optional fields in both the Order Lines table and the Order Line Additional group.

Description

This column contains a read-only description of each field. This is for your reference only.

Heading

This is the text that will be used for the field's column heading. You cannot edit the column heading
text.

Pac7 Release 7.2



User Guide  1145

Mandatory

For each field, enter either Y (Yes) or N (No). If you enter Y, the field is mandatory, and operators
must enter a valid value in the field's column for each order line before they can continue pro-
cessing their orders. Fields with empty or invalid entries are bordered in red and have mouse-over
tool tips explaining the reason. The item (ITEM), item quantity (QTY), price level (PRLEV), and
price type (PRTYP) field rows default to Y because they are always mandatory.

Order Line Additional

Click this button to display the OM Form Additional Fields subscreen. Use this subscreen to select
the fields you want to display in the Order Line Additional group of the Order Management tab. For
more information, see OM Form Additional Fields subscreen.

Toolbar Buttons

Click this button to display the Order Management Toolbars subscreen. Use this subscreen to select
the toolbar buttons you want to display in the order header and the Order Lines table toolbars on
the Order Management tab. For more information, see Order Management Toolbars Subscreen.

Copy To
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Click this button to display the Copy TO OM Form subscreen. Use this function to copy the settings
of the currently loaded Pac7 order management form to a new Pac7 order management form. The
currently loaded form is unchanged. If you want to copy the applicable settings from a TK.SELL
order form to a Pac7 order management form, use the Copy From function instead.

Copy From

Click this button to display the Copy FROM OForm subscreen. Use this function to replace the set-
tings of the currently loaded Pac7 order management form (TK.OMFORM.E) with the applicable set-
tings from an existing TK.SELL order form (OForm from TK.OFORM.E). Regardless of the
configuration of the TK.SELL order form, the required Pac7 order management form settings will
remain on the new order management form.

Note: If you use this process and save the new settings, any optional settings on the currently
loaded Pac7 order management form will be overwritten, including those from the OM Form Addi-
tional Fields subscreen and the Order Management Toolbars subscreen.

The field, right-click, and button configurations in the TK.SELL order form from which you are copy-
ing are converted to TK.OMFORM.E fields and buttons where applicable. None of the TK.SELL order
form width numbers are used, because Pac7 automatically sizes the column widths and there is no
limit to the number of columns allowed. If a field is used on both the main and additional screens in
a TK.SELL order form, the field is only added to the main order management form screen. This is
because, in Pac7, fields cannot be used in both the Order Lines table and the Order Line Additional
group.

Many of the fields that are available on the TK.SELL order form are automatically added or not
applicable within the Order Line Additional group in Pac7, and so they will not be added to the OM
Form Additional Fields subscreen during the conversion. These include the following:

ACUSTN EXT PRLEV
ATYPEN GTW.GROUPN PRLEVN
BPTYPEN IPKGN PRTYP
CHGN IPREFN PRTYPN
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CHGP ITEM QTY
DISCA ITEMN SCHGA
DISCN MARKN SCHGN
DISPN PREFN WCCUSTN

When converting the right-click actions and buttons from a TK.SELL order form, most of the options
are not applicable (N/A) to Pac7 and are ignored. Order management options that are built into
standard Pac7 functionality are called Standard instead of having an OM form button number in the
conversion table below. The OM form button numbers are used when configuring toolbar buttons on
the Order Management Toolbars subscreen. Click here for the conversion table.

Order man-
agement
option

OForm
level

OForm
number

OM form
toolbar but-
ton level

OM form button number

Additional
Order Data

Right-
click 7 N/A N/A

Assign Seats to
Line Button 1 Order Line Standard

Assign Seats to
Line

Right-
click 8 Order Line Standard

Bulk Reprint Button 2 Order Line 14

Bulk Reprint Right-
click 9 Order Line 14

Bulk Transfer Button 3 N/A N/A

Bulk Transfer Right-
click 10 N/A N/A

Bulk Void Button 4 Order Line 17

Bulk Void Right-
click 11 Order Line 17

Cancel Right-
click 5 N/A N/A

Change Batch Button 5 Order
Header Standard

Change Batch Right-
click 12 Order

Header Standard

Choice Items Button 6 N/A N/A

Contact Entry Button 37 Order
Header Standard

Contact Entry Right-
click 47 Order

Header Standard

Customer Entry
- Control Button 7 Order

Header Standard
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Customer Entry
- Control

Right-
click 13 Order

Header Standard

Customer Entry
- Individual Button 8 Order

Header Standard

Customer Entry
- Individual

Right-
click 14 Order

Header Standard

Customer
Inquiry Button 9 N/A N/A

Customer
Inquiry

Right-
click 15 N/A N/A

Event Detail
(Combo)

Right-
click 16 Order Line 7

Event Inquiry Button 10 N/A N/A

Event Inquiry Right-
click 17 N/A N/A

Event List (PYO
Combo)

Right-
click 18 Order Line 8

Exchange
(Single/Combo) Button 11 N/A N/A

Exchange
(Single/Combo)

Right-
click 19 N/A N/A

Execute Pro-
cess

Right-
click 1 N/A N/A

Exit Right-
click 6 N/A N/A

Fees Button 12 Order Line 9

Go Right-
click 4 N/A N/A

Go Custom
Exchange Button 35 N/A N/A

Go Custom
Exchange

Right-
click 45 N/A N/A

Go Exchange
Form Button 36 N/A N/A

Go Exchange
Form

Right-
click 46 N/A N/A

Go Item Form Button 13 N/A N/A

Go Item Form Right-
click 20 N/A N/A
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Go Pickup Form Button 14 N/A N/A

Go Pickup Form Right-
click 21 N/A N/A

Help Right-
click 2 N/A N/A

Hold Seats Button 33 Order
Header 11

Hold Seats Right-
click 43 Order

Header 11

Intuitive Help Right-
click 3 N/A N/A

Item Info Button 15 N/A N/A

Item Info Right-
click 22 N/A N/A

Membership
Inquiry Button 16 N/A N/A

Membership
Inquiry

Right-
click 23 N/A N/A

Multi Event
Seat Search Button 17 N/A N/A

Multi Event
Seat Search

Right-
click 24 N/A N/A

Order Holds Button 34 Order
Header 10

Order Holds Right-
click 44 Order

Header 10

Patron Sum-
mary Button 32 Order

Header Standard

Patron Sum-
mary

Right-
click 42 Order

Header Standard

Previous
Season Over-
view

Button 18 Order
Header 6

Previous
Season Over-
view

Right-
click 25 Order

Header 6

Price Split Right-
click 26 Order Line 12

Pricing and
Availability Info Button 19 N/A N/A
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Pricing and
Availability Info

Right-
click 27 N/A N/A

Print BOCA
Batch Sum-
mary

Button 20 Order
Header 12

Print BOCA
Batch Sum-
mary

Right-
click 28 Order

Header 12

Prorate a
Combo Button 21 Order Line 13

Prorate a
Combo

Right-
click 29 Order Line 13

Reallocate Button 22 Order
Header

9 or 7 (If both Reorder and Reallocate are
available in OForm use 9. If only reallocate
is available use 7.)

Reallocate Right-
click 30 Order

Header

9 or 7 (If both Reorder and Reallocate are
available in OForm use 9. If only reallocate
is available use 7.)

Reorder Button 24 Order
Header 9

Reorder Right-
click 32 Order

Header 9

Reprint Seats Button 23 Order Line 14

Reprint Seats Right-
click 31 Order Line 14

Return
(Single/Combo) Button 25 N/A N/A

Return
(Single/Combo)

Right-
click 33 N/A N/A

Same Seat,
Multi Event
Search

Button 26 Order Line Standard

Same Seat,
Multi Event
Search

Right-
click 34 Order Line Standard

Search Plan Button 28 Order Line Standard

Search Plan Right-
click 36 Order Line Standard

Seat Fields Right-
click 37 Order Line Standard

Seat Map Right- 38 Order Line Standard
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click

Sect Seat
Status Sum-
mary

Button 27 N/A N/A

Sect Seat
Status Sum-
mary

Right-
click 35 N/A N/A

Transfer Spe-
cific Seats Button 29 N/A N/A

Transfer Spe-
cific Seats

Right-
click 39 N/A N/A

Unreserve
Items Button 30 N/A N/A

Unreserve
Items

Right-
click 40 N/A N/A

Void Specific
Seats Button 31 Order Line 17

Void Specific
Seats

Right-
click 41 Order Line 17

OM Form Additional Fields Subscreen

Paciolan 7 > Selling Setups > Order Management Forms

TK.OMFORM.E

On the Order Management Forms screen, click the Order Line Additional button to display the OM
Form Additional Fields Subscreen.
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Use this subscreen to customize the fields included in the Order Line Additional group on the main
page of the Order Management tab.

Control Descriptions
Field
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Enter each field that you want to include in the Order Line Additional group on the Order Man-
agement tab. The item (ITEM), item quantity (QTY), price level (PRLEV), price type (PRTYP), and
extension (EXT) fields are required and are automatically displayed as read-only at the top of the
Order Line Additional group.

See the list of column fields with codes, descriptions, and display names, and rules. All of the fields
are optional. You cannot enter the same optional fields in both the Order Lines table and the Order
Line Additional group. If you do not enter any fields, the Order Line Additional group will not display
on the Order Management tab.

Code Description Display
Name Rules

ACUST Associated
Customer

Assoc cus-
tomer Includes customer number and name

APNUMBER Access Pass
Number

Access
pass Read-only number

ATYPE Address
Type

Ship
address Includes address type code and name

BAL Item Bal-
ance

Item bal-
ance Read-only amount

BPTYPE Billing Type Bill plan Drop-down list of concatenated billing plan codes and
names

CHG Item Charge Charge

Drop-down list of concatenated charge codes,
amounts, and names. Charge price is also displayed in
a read-only field directly under the Charge drop-down
list

CHGA Item Charge
Amount

Charge
amt

Read-only amount directly under Charge price. If you
include the CHGA field, the CHG field will display
above it automatically. You do not need to add the
CHG field

DATE Item Order
Date Order date Editable date field
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Code Description Display
Name Rules

DID Item Deliv-
ery ID

Item deliv-
ery ID Read-only number

DISC Item Dis-
count Discount

Drop-down list of concatenated item discount codes,
amounts, and names. Discount price is also displayed
in a read-only field directly under the Discount drop-
down list

DISCP Item Dis-
count Price

Discount
price

Read-only amount directly under Discount price. If
you include the DISCP field, the DISC drop-down list
will display above it automatically. You do not need to
add the DISC field

DISP Disposition
Code

Disposition Drop-down list of concatenated disposition codes and
names (for example, P - Priority Shipping)

EXT Extension Extension Read-only field automatically displayed at the top of
the Order Line Additional group

EXTP Extension
Price

Extension
price Read-only amount

FEEA Fee Amount Fee
amount Read-only amount

FEEP Fee Price Fee price Read-only amount

GCDOC Gift Cert Doc
#

Gift Cer-
tificate

Numeric text entry box. You can only enter a number
here if the selected order line contains a gift cer-
tificate item

GROUP Group Num-
ber Group Free form (no validation) text entry box

GTW.GROUP GTW Group
Number GTW group Read-only field

INRDATA
Internet
Referral
Data

Referral
data Read-only field

INRSRC
Internet
Referral
Source

Referral
source Read-only field

INSRC Internet
Source

Internet
source Read-only field

IPKG Item Pack-
age

Item pack-
age Read-only field

IPREF Item Prefer-
ence

Item pref-
erence

Drop-down list of concatenated item preference codes
and names

ITEM Item Item Read-only field automatically displayed at the top of
the Order Line Additional group
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Code Description Display
Name Rules

MARK Mark Code Mark code Drop-down list of concatenated mark codes and
names

NOTE Item Note Note Free form (no validation) text entry box

OLID Online Order
ID

Online
order ID Read-only field

PREF Location
Preference

Location
pref

Drop-down list of concatenated location preference
codes and names

PRI Item Priority Item pri-
ority Text box requiring a valid integer

PRICE Item Price Price Read-only text box

PRINT Print Item Print tick-
ets Check box that can be checked or cleared

PRNT Quantity Prin-
ted

Qty prin-
ted Read-only field

PRLEV Price Level Price level Read-only field automatically displayed at the top of
the Order Line Additional group

PROMO Promotion
Code

Promo
code Read-only field

PRTYP Price Type Price type Read-only field automatically displayed at the top of
the Order Line Additional group

QTY Item Quant-
ity Qty Read-only field automatically displayed at the top of

the Order Line Additional group

SCHG
Item
Surcharge
Code

Surcharge
Drop-down list of concatenated item surcharge codes
and names. Read-only Surcharge amt field displayed
under the drop-down list

SCHGP
Item
Surcharge
Price

Surcharge
price Not required (if used, must follow SCHG)

SEAT Seatblocks Seatblocks Click linked seatblock code to display the Seat Fields
form

SPEC Special Hand-
ling

Special
handling Free form (no validation) text entry box

STAT Item Status Item
status Read-only field

WCCUST Will Call Cus-
tomer

Will call
cust Search field with access to the Patron Search function

There is no limit on the number of fields you can add to the Order Line Additional group. If there
are too many fields to display given an operator's sizing of the browser window, a vertical scroll
bar will automatically be added to allow access to the fields that are not visible.
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Mandatory

For each field, enter either Y (Yes) or N (No). If you enter Y, the field is mandatory, and operators
must enter a valid value in the Order Line Additional group for each order line before they can con-
tinue processing their orders. The mandatory setting still applies when the Order Line Additional
group is hidden. Mandatory fields have bolded names that are preceded by an asterisk.

Order Management Toolbars Subscreen

Paciolan 7 > Selling Setups > Order Management Forms

TK.OMFORM.E

On the Order Management Forms screen, click the Toolbar Buttons button to display the Order Man-
agement Toolbars subscreen.
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Use this subscreen to customize the buttons that will display in the order header and Order Lines
table toolbars on the main page of the Order Management tab. A button will only display if the oper-
ator's control allows access to it's functionality and the functionality is applicable to the current
state of the Pac7 application.
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Regardless of the toolbar configuration, all currently applicable functions will be available via the

Order actions button in the order header. In the Order Lines table, the currently applic-

able functions are all available from the Seats button and the Line actions button

. Neither of the toolbars display until the operator selects a patron and a season. The
functions of the toolbar buttons are represented by their graphical icons. In addition to viewing the
button icons, operators can mouse-over buttons to display their function names.

Control Descriptions
Order Header Buttons

The buttons in the first table (Miscellaneous and User) are not editable and will always be dis-
played. In the second table, enter the code numbers of the buttons you want to display in the order
header toolbar. They will display from left to right after the Miscellaneous and User buttons based
on their order in the table. You can also add one or more separator lines in the toolbar between any
two toolbar buttons.
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See the list of toolbar buttons for the order header

Button Code # Function

N/A Comments, tags, and order priority

N/A User defined fields

0 Separator line

3 Application items

5 Billing plans

6 Previous season overviews

7 Reorder and reallocate

8 Reprint prior receipts

9 Reallocate

10 Order held seats

11 Hold seats

12 Print Boca batch summary

Order Line Buttons
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The buttons in the first table (Add, Delete, Seat Map, Best Available, and Seats) are not editable
and will always be displayed first in the Order Lines table toolbar. In the second table, enter the
code numbers of the buttons you want to add to the toolbar. They will display from left to right
after the buttons from the first table in the order you add them to the second table. You can also
add one or more separator lines in the toolbar between any two toolbar buttons.

See the list of the toolbar buttons for the Order Lines table

Button Code # Function

1 Add or insert an order line

2 Cancel order line

4 Seat map

3 Assign best available seats

5 Seats menu

0 Separator line

6 Area search
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Button Code # Function

7 Display event details

8 Select events for combo

9 Facility fee inquiry

10 Item details

11 Search for multiple events

12 Price split

13 Prorate

14 Reprint tickets

15 Search plan

16 Seat fields

17 Void

18 Exchange

19 Return

Exchange In Forms Screen

Paciolan 7 > Selling Setups > Exchange In Forms

TK.EXFORM.E

Use the Exchange In Forms screen to customize the toolbars, table columns, and fields on the
Exchange In table. Exchanges using the Exchange in table are available during order management
or through a standalone Exchange process, which is similar to "Go Exchange" in TK.SELL
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Control Descriptions
Form

Enter a new or existing code for the Exchange In form you want to configure. Press the F3 key to
select one from the list of existing forms. If you are entering a new form, a default set of fields will
be loaded into the Field table. You can add fields to the table but, if you delete any of the default
fields, you will not be allowed to save the form.

Name

Enter a descriptive name for the form. This is only used for this screen to help you identify the
form that is configured for the form code.

Field

Enter each field for which you want a column displayed in the Exchange In table on the Exchange
tab. The item (ITEM), item quantity (QTY), price level (PRLEV), price type (PRTYP), and seatblock
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(SEAT) fields are required and are automatically entered in the first rows of the table in that order.
You can add the item name field (ITEMN), but only directly under ITEM. The columns display in the
Order Lines table from left to right based on the order they are entered.

See the list of column fields below with codes, descriptions, column heading text, and rules. You do
not need to add a field that is not required in the Field column, because a column for that field does
not need to be included in the Order Lines table in Pac7.

Code Description Column
Heading Rules

ACUST Associated Cus-
tomer

Assoc cus-
tomer Not required

ACUSTN Associated Cus-
tomer Name

Assoc cus-
tomer name

Not required (if used, must directly follow
ACUST)

ATYPE Address Type Ship address Not required

ATYPEN Address Type
Name Address name Not required (if used, must directly follow

ATYPE)

BPTYPE Billing Type Bill plan Not required

BPTYPEN Billing Type
Name Bill plan name Not required (must directly follow BPTYPEN)

CHG Item Charge Charge Not required

CHGA Item Charge
Amount

Charge
amount Not required (if used, must follow CHG)
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Code Description Column
Heading Rules

CHGN Item Charge
Name Charge name Not required (if used, must directly follow CHG)

CHGP Item Charge
Price Charge price Not required (if used, must follow CHG)

DATE Item Order Date Order date Not required

DISC Item Discount Discount Not required

DISCA Item Discount
Amount

Discount
amount Not required (if used, must follow DISC)

DISCN Item Discount
Name Discount name Not required (if used, must directly follow DISC)

DISCP Item Discount
Price Discount price Not required (if used, must follow DISC)

DISP Disposition Code Disposition Not required

DISPN Disposition Code
Name

Disposition
code name Not required (if used, must directly follow DISP)

EXT Extension Extension Not required

EXTP Extension Price Extension
price Not required

FEEA Fee Amount Fee amount Not required

FEEP Fee Price Fee price Not required

GROUP Group Number Group Not required

IPREF Item Preference Item pref Not required

IPREFN Item Preference
Name

Item pref-
erence name

Not required (if used, must directly follow
IPREF)

ITEM Item Item Required and mandatory (must always be the
first variable listed in the grid)

ITEMN Item Name Item name Not required (if used, must directly follow ITEM)

MARK Mark Code Mark code Not required

MARKN Mark Code Name Mark code
name

Not required (if used, must directly follow
MARK)

NOTE Item Note Note Not required

PREF Location Prefer-
ence

Location pref-
erence Not required

PREFN Location Prefer-
ence Name

Location pref
name Not required (if used, must directly follow PREF)
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Code Description Column
Heading Rules

PRI Item Priority Item priority Not required

PRICE Item Price Price Not required

PRINT Print Item Print Tickets Not required

PRLEV Price Level Price level Required and mandatory

PRLEVN Price Level
Name

Price level
name

Not required (if used, must directly follow
PRLEV)

PRTYP Price Type Price type Required and mandatory (must follow PRLEV)

PRTYPN Price Type Name Price type
name

Not required (if used, must directly follow
PRTYP)

QTY Item Quantity Qty Required and mandatory (must directly follow
ITEM or ITEMN)

SCHG Item Surcharge
Code Surcharge Not required

SCHGA Item Surcharge
Amount

Surcharge
amount Not required (if used, must follow SCHG)

SCHGN Item Surcharge
Name

Surcharge
name

Not required (if used, must directly follow
SCHG)

SCHGP Item Surcharge
Price

Surcharge
price Not required (if used, must follow SCHG)

SEAT Seatblocks Seatblocks Not required

SPEC Special Handling Special hand-
ling Not required

SUBTOT Total Item Price Subtotal Not required

WCCUST Will Call Cus-
tomer

Will call cus-
tomer Not required

WCCUSTN Will Call Cus-
tomer Name

Will call cus-
tomer name

Not required (if used, must directly follow
WCCUST)

There is no limit to the number of fields (columns) in the Exchange In table. If there are too many
columns to display given the size the operator makes the browser window, a horizontal scroll bar
will automatically be added to allow access to hidden columns by scrolling.

Description

This column contains a read-only description of each field. This is for your reference only.

Heading

This is the text that will be used for the field's column heading. You cannot edit the column heading
text.
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Mandatory

For each field, enter either Y (Yes) or N (No). If you enter Y, the field is mandatory, and operators
must enter a valid value in the field's column for each order line before they can continue pro-
cessing their orders. Fields with empty or invalid entries are bordered in red and have mouse-over
tool tips explaining the reason. The item (ITEM), item quantity (QTY), price level (PRLEV), price
type (PRTYP), and seatblock (SEAT) field rows default to Y because they are always mandatory.

Toolbar Buttons

Click this button to display the Exchange In Toolbar Buttons subscreen. Use this subscreen to select
the toolbar buttons you want to display in the Exchange In table toolbar.
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The buttons in the first table (Add, Delete/Remove, Seat Map, Assign Best Seats, and Seats) are
not editable and will always be displayed first in the Order Lines table toolbar. In the second table,
enter the code numbers of the buttons you want to add to the toolbar. They will display from left to
right after the buttons from the first table in the order you add them to the second table. You can
also add one or more separator lines in the toolbar between any two toolbar buttons.

See the list of the toolbar buttons for the Exchange In table

Button Code # Function Configurable?

1 Add or insert an order line No
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Button Code # Function Configurable?

2 Delete/Remove order line No

3 Seat map No

4 Assign best available seats No

5 Seats menu No

0 Separator line Yes

6 Area search Yes

7 Item details Yes

8 Price split Yes

9 Search plan Yes

NEED TO ADD OR EDIT THE TOPICS TO WHICH THESE LINKS GO

Promotions Screen

Paciolan 7 > Selling Setups > Shortcut to Promo Entry

TK.PROMO.E

Use the Promotions screen to configure promotions for use in the promotions selling path on the
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Item Sales tab. The controls on this screen and on the Paciolan 7 Item Sales subscreen are
described in the tRes reference topic.

Items for both Pac7 and eVenue are included in promotions by adding seasons and then setting up
season and item details. Part of each included item's setup allows you to add location preferences,
but only if you disable the Allocate option for that item. If you are using the promotion in Pac7 and
want to make including location preferences mandatory in the promotions selling path, you must
include at least one location preference for each item in the promotion. For more information, see
the More Cart Options button description in the Cart Definition Subscreen topic.
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Massload Parameters Overview
This section contains descriptions of the Paciolan 7 > Massload Parameters menu items in tRes.
This menu is used to set up the Pac7 system. The menu is organized as follows:

l Massload Season Entry
l Massload Data Pre-Check

Paciolan 7 Season Status Entry Screen

Paciolan 7 > Massload Parameters > Massload Season Entry

TK.ETSTAT.E

Use the Paciolan 7 Season Status Entry screen to add the seasons that you want to massload into
the system. When you display this screen, Pac7 lists all seasons that have been assigned a Pac7
status code, along with their current statuses. When you are finished adding seasons, Paciolan
Implementation Services uses this screen to massload seasons into Pac7.

Note: When you run a season data massload, tRes automatically runs a data pre-check using the
settings on the Massload Data Pre-Check screen. tRes must run this process without errors before
any seasons can be massloaded.
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Control Descriptions
Season

Press F3 in this field for a list of the all available seasons. You can add seasons to this screen as
required, if they have an Open ticketing status.

Status

When a season is added to the list, the season status defaults to I (Initialize (New)). Seasons may
not be removed from the list once their status code is S (Massload Successful) or F (Massload
Failed). If you try to remove them, tRes displays an error.

You can change a season with status I to X (Do Not Initialize), and you can change a status of X to
I. These are the only manual status changes that are allowed in the Status field.

Massload New

Click Massload New to initiate the massloading of seasons that have the status code I (Initialize
(New)). tRes displays the New Seasons to Massload screen, which lists all seasons that are eligible
for massload (status code = I).

You can remove seasons from this list, but you cannot add them. Click Accept to massload the lis-
ted seasons.

Retry Failed

Click Retry Failed to initiate the massloading of seasons that have the status code F (Massload
Failed). tRes displays the Seasons to Retry screen, which lists all seasons that are eligible for retry
(code = F).
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You can remove seasons from this list, but you cannot add them. Click Accept to retry massloading
the listed seasons.

Massload Data Pre-Check Screen

Paciolan 7 > Massload Parameters > Massload Data Pre-Check

TK.TCS.PRECHECK

Note: Pac7 requires the conversion of the back office database from UniVerse to DB2. The con-
version to DB2 requires that your data pass this pre-check.

Using the Massload Data Pre-Check screen, you can complete a data pre-check to ensure that the
massload of the inventory data into the Pac7 system is successful. This pre-check must be done
after configuring the controls for a seller, but prior to loading inventory for the first time. In addi-
tion, the pre-check can be used to check that the data in a new season or an item being added to
the Pac7 system is setup correctly. All data errors that are found as a result of the pre-check must
be fixed before you can use Pac7 to sell inventory items
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Control Descriptions
Note: This process checks for invalid special characters in all Code and Name fields, but not in any
of the other fields (for example, Description or Text).

Codes - Invalid Characters Names - Invalid Characters

 ' (single quote) \ (back slash)

 " (double quote) " (double quote)

 # (pound sign) + (plus sign)

 ~ (tilde) < (less than)

 > (greater than) > (greater than)

& (ampersand) & (ampersand)

/ (forward slash)

 < (less than)

: (colon)

, (comma)

\ (back slash)

* (asterisk)

? (question mark)

| (pipe symbol)
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Codes - Invalid Characters Names - Invalid Characters

^ (caret)

 + (plus sign)

 space

$ (dollar sign)

Seasonal Data

Select seasonal data settings you want to be checked. For a complete list of the files and fields that
are checked for each setting, click here.

Settings Files Checked Field Character
Checks

Associated Pro-
cesses

Adjustments (Charges, Dis-
counts, Charge Tables)

TK.CHARGE.season Code: <= 32
Name: <= 128
Amount: Must be
numeric and <=
12, including
decimal values
added by the sys-
tem

TK.FCHARGE.SEA.E,
TK.OCHARGE.SEA.E,
TK.SCHARGE.SEA.E,
TK.TCHARGE.SEA.E

TK.DISCOUNT.season Code: <= 32
Name: <= 128
Message: <=
2048
Amount, Max Qty,
Percentage, Max
Discount: Must be
numeric and <=
12, including
decimal values
added by the sys-
tem

TK.DISC.SEA.E

TK.CTABLE.season Code: <= 32
Name: <= 128
Pricing: Must be
numeric and <=
12, including
decimal values
added by the sys-
tem
References: Can-
not be unknown
price type, non-
ticket charge
code, or unknown
charge code

TK.CTABLE.SEA.E

Billing Plan Types TK.BPTYPE.season Code (Key): <=
32
Name: <= 128

TK.BPTYPE.SEA.E

Pac7 Release 7.2



User Guide  1175

Settings Files Checked Field Character
Checks

Associated Pro-
cesses

Date Format:
Must be valid

Events TK.EVENT.season Code: <= 32
Name: <= 256
Print Line Length:
<= 2048
Event Code: <=
32
Message: <= 128
Keyword: <= 64
Keyword Total:
<= 512
References: Can-
not be unknown
event group,
event type, con-
figuration, facil-
ity, facility fee, or
item
Event Date, Drop
Date, and Inter-
net Drop Date:
Must have valid
formats

TK.EEVENT.E.COPY,
TK.EEVENT.SEA.E,
TK.EVENT.SEA.E

Event Groups TK.EGROUP.season Code: <= 32
Name: <= 128

TK.EGROUP.SEA.E

Items TK.ITEM.season Code: <= 32
Name: <= 256
Print Line Length:
<= 2048
Keyword: <= 64
Keyword Total:
<= 512
Default Item
Format: <= 32
Event List Descrip-
tion: <= 128
Electronic Deliv-
ery Location: <=
512
Event Price, Event
Print Price, Item
Amount, Reissue
Amount, Default
Chg Amount,
Ticket Charge
Amount, Event

TK.COMBO.SEA.E,
TK.EVENT.SEA.E,
TK.IAPASS.SEA.E,
TK.IDON.SEA.E,
TK.IGC.SEA.E,
TK.IMISC.SEA.E,
TK.ILOAD.ITEM,
TK.ILOAD.MISC
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Settings Files Checked Field Character
Checks

Associated Pro-
cesses

Tax, Event Fee,
and Acct Price:
Must be numeric
and <= 12, includ-
ing decimal val-
ues added by the
system
References: Can-
not be unknown
basis, default
charge, operator
group, price
detail key, event
(combo), event
(single), price
detail, price type,
charge code, or
discount
Category: <= 64
Message: <= 128
Item Format: <=
32
Price Detail Cat-
egory: <= 64
Price Detail Tag:
<= 32

Manifests/Configurations/Areas TK.AREA.season Code: <= 32
Name: <= 64
Seat Value: Must
be numeric and
<= 12, including
decimal values
added by the sys-
tem
References: Can-
not be unknown
facility or mani-
fest

TK.AREA.SEA.E

TK.CONFIG.season Code: <= 32
Name: <= 64
References: Can-
not be unknown
facility or area

TK.CONFIG.SEA.E

TK.MANIFEST.season Level: <= 15
Section: <= 15
Name: <= 64
Default Gate: <=
32

TK.MANIFEST.SEA.E,
TK.MANIFEST.SEA.B.E
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Settings Files Checked Field Character
Checks

Associated Pro-
cesses

Row: <= 15
Row, Gate: <= 32
Row, Seat: <= 15
References: Can-
not be unknown
facility
Row Allocation:
Must be defined

Price Tables TK.PTABLE.season Code: <= 32
Name: <= 128
PL Name: <= 20
PL WBST: <= 20
PL:PT Price: Must
be numeric and
<= 12, including
decimal values
added by the sys-
tem
Price Type: Can-
not be unknown,
contain $ (dollar
sign)
Cannot reference
a PL:PT more
than once

TK.PTABLE.SEA.E

Price Types TK.PRTYPE.season Code: <= 32
Name: <= 128
Message: <=
2048

TK.PRTYPE.SEA.E

Seat Status Codes TK.SSTAT.season Name: <= 128
Message: <=
2048
Standard seat
status codes must
exist: H (Held), K
(Killed), O
(Open), T (Cus-
tomer Hold), and
X (Allocated)

TK.SSTAT.SEA.E

Other Data

The options below allow you to determine what non-seasonal tRes, tPatron, and tFund data to
include in the pre-check. By default, all data types are selected. To deselect all data options on a
subscreen, clear the check box next the button. If you open a subscreen and select one or more
data type options, the check box for the subscreen button is automatically selected once you accept
the changes. If you open a subscreen and clear all the options, the check box is also cleared auto-
matically.
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tRes Non-Seasonal Data

Click this button to display the tRes Non-Seasonal Data subscreen. On the subscreen, select the
non-seasonal data settings you want to be checked.

For a complete list of the files and fields that are checked for each setting, click here.

Settings Files
Checked Field Character Checks Associated Pro-

cesses

Activities TK.ACTIVITY Code: <= 32
Name: <= 128

TK.ACTIVITY.E

Alert Mes-
sages

TK.TALERT Code: <= 32
Name: <= 128
Message: <= 1064
Seller Codes: Must be valid
Business Accounts: Must be at least one
valid account

TK.TALERT.E

Business
Accounts,
Data Account

TK.BA Code: <= 32
Name: <= 128
Return Instructions: <= 256
Adjustment Options: Must be valid
Operator: Must be valid

TK.BA.E

Classes TK.CLASS Code: <= 32
Name: <= 512

TK.CLASS.E

Customer
Status Codes

TK.STATUS Code: <= 32
Name: <= 128

TK.STATUS.E

Customer TK.CTYPE Code: <= 16 TK.CTYPE.E
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Settings Files
Checked Field Character Checks Associated Pro-

cesses

Types Name: <= 256

Delivery Meth-
ods

TK.TDMETH Code: <= 32
Name: <= 128
Disposition Code: Must be valid
Charge Code: Must be valid

TK.TDMETH.E

Disposition
Codes

TK.DCODE Code: <= 32
Name: <= 512

TK.DCODE.E

Event Types TK.ETYPE Code: <= 32
Name: <= 128

TK.ETYPE.E

Facilities TK.FACILITY Code: <= 32
Name: <= 128
Address: <= 256
Zip Code: <= 16
Manager: <= 32
Telephone: <= 32
Time Zone: Must include one
Level From: <= 15
Level To: <= 32
Level:Section To: <= 32

TK.FACILITY.E,
TK.FACILITY.E.ADR

Item Groups TK.TGROUP Code: <= 15
Name: <= 128
Event: Must be valid
Item: Must be valid

TK.TGROUP.E

Item Prefer-
ences

TK.IPREF Code: <= 32
Name: <= 128

TK.IPREF.E

Location
Preferences

TK.PREF Code: <= 32
Name: <= 128

TK.PREF.E

Mark Codes TK.MARK Code: <= 32
Name: <= 512

TK.MARK.E

Member
Codes

TK.MEMBER Code: <= 16
Name: <= 256

TK.MEMBER.E

Messages TK.MSG Code: <= 32
Name: <= 5120

TK.MSG.E

Operators and
Operator
Groups

TK.OPERATOR Must be defined as System Operator
Price Type: Must be valid
Seat Status: Must be valid

TK.OP.E, SYS.OP.E

TK.OPGRP Code: <= 32
Name: <= 132

TK.OPGRP.E

Patron Man-
agement
Policies

TK.PMGMT Code: <= 16
Name: <= 128

TK.PMGMT.E
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Settings Files
Checked Field Character Checks Associated Pro-

cesses

Operator Code: Must be valid
Patron Policy Code: Must be valid

Patron
Policies

TK.PPOLICY Code: <= 16
Name: <= 128
Customer Type: Must be valid
Organization Type: Must be valid
Patron Status Code: Must be valid
Patron Source Code: Must be valid
Donor Code: Must be valid
Donor Type: Must be valid
Additional Settings Phone Types: Phone
types must be valid
Additional Settings Address Types: Address
types must be valid
Override Shipping Address: Address type
must be valid
Override Billing Address: Address type must
be valid
Patron Search Options: Phone type and
address type must be valid
Other Patron Attributes: Phone type, address
type, donor code, donor type, VIP code, and
salutation type must be valid

TK.PPOLICY.E

Paymodes TK.PAYMODE Code: <= 32
Name: <= 128
Merchant: <= 32

TK.PAYMODE.E

Price Level
Names

TK.SETUP
SYSTEM

Price Level Names: <= 32 TK.SETUP.E.PRLEV

Print Forms TK.FORMS Name: <= 128 TK.FORMS.E

Promos TK.PROMO Code: <= 32
Name: <= 128
Season: Must have at least one
Delivery Method: Must be valid
Order Charge: Must be valid for each season
Item: Must be valid for each season
Seat Status: Must be valid for each season
Promo Text: <= 256 per Item PL/PT

TK.PROMO.E

Receipt
Groups

TK.RGROUP Code: <= 32
Name: <= 128

TK.RGROUP.E

Salecodes TK.SALECODE Code: <= 32
Name: <= 128

TK.SALECODE.E

Seasons TK.SEASON Code: <= 15
Name: <= 128

TK.SEASON.E
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Settings Files
Checked Field Character Checks Associated Pro-

cesses

TK.SPARAM Fee Cap Amt: Must be numeric and <= 12 TK.FCPARAM.E

Selling Con-
trols

TK.ETCONTROL Code: <= 32
Name: <= 128
Season: Must be valid
Will Call Season: Must be valid
Return Paymode: Must be valid
Delivery Method: Must be valid
Item Group: Must be valid
Paymode: Must be valid
Salecode: Must be valid
Operator: Must be valid
House Customer: Must be valid
Charge: Must be valid per season
Onsale Ochg Amt: Must be numeric and <=
12
Gen Sales Ochg Amt: Must be numeric and
<= 12
Item: Must be valid per season
Price Type: Must be valid per season
Seat Status: Must be valid per season

TK.ETCONTROL.E

Stock Codes TK.STOCK Code: <= 32
Name: <= 128

TK.STOCK.E

User Defined
Codes

TK.USER Code: <= 32
Name: <= 64

TK.USER.E

User Defined
Fields

TK.UDEFINE Name: <= 32
Description: <= 64

SU.UDEFINE.E,
SU.UDSCREEN.E

Email Tem-
plates

TK.ET.EMAIL Code: <= 32
Text: <= 24000

TK.ET.EMAIL.E

Item Sales
Formats

TK.OFORM Code: <= 32
Name: <= 256

TK.EFORMAT.E

tPatron Data

Click this button to display the tPatron Data subscreen. On the subscreen, select the data set-
tings you want to be checked.
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For a complete list of the files and fields that are checked for each setting, click here.

Settings Files Checked Field Character Checks Associated Processes

Approach Codes PD.APPROACH Code: <= 16

Name: <= 256

PD.APPROACH.E

Attribute Codes PD.ATTRIBUTE Code: <= 16

Name: <= 256

PD.ATTRIBUTE.E

Address Types PD.ATYPE Code: <= 16

Name: <= 256

PD.ATYPE.E

Ethnicity Codes PD.ETHNIC Code: <= 16

Name: <= 256

PD.ETHNIC.E

Income Codes PD.INCOME Code: <= 16

Name: <= 256

PD.INCOME.E

Industry Codes PD.INDUSTRY Code: <= 16

Name: <= 256

PD.INDUSTRY.E

Institutions PD.INST Code: <= 16

Name: <= 256

PD.INST.E

Institution Status Codes PD.INST.STAT Code: <= 16

Name: <= 256

PD.INST.STAT.E

Interest Codes PD.INTEREST Code: <= 16

Name: <= 256

PD.INTEREST.E

IProfile Codes PD.IPROFILE Code: <= 16

Name: <= 256

PD.IPROFILE.E

Language Codes PD.LANGUAGE Code: <= 16 PD.LANGUAGE.E
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Settings Files Checked Field Character Checks Associated Processes

Name: <= 256

Mail Codes PD.MCODE Code: <= 16

Name: <= 256

PD.MCODE.E

Marital Status Codes PD.MSTATUS Code: <= 16

Name: <= 256

PD.MSTATUS.E

Organization Types PD.OTYPE Code: <= 16

Name: <= 256

PD.OTYPE.E

Phone Types PD.PTYPE Code: <= 16

Name: <= 256

PD.PTYPE.E

Religion Codes PD.RELIGION Code: <= 16

Name: <= 256

PD.RELIGION.E

Relation Types PD.RTYPE Code: <= 16

Name: <= 256

PD.RTYPE.E

Source Codes PD.SOURCE Code: <= 16

Name: <= 256

PD.SOURCE.E

Status Codes PD.STATUS Code: <= 16

Name: <= 256

PD.STATUS.E

Salutation Types PD.STYPE Code: <= 16

Name: <= 256

PD.STYPE.E

User Defined Codes PD.USER Code: <= 16

Name: <= 64

PD.USER.E

User Defined Fields PD.UDEFINE Name: <= 32

Description: <= 64

SU.UDEFINE.E

VIP Codes PD.VIP Code: <= 16

Name: <= 32

Alert Text: <= 128

PD.VIP.E

tFund Data

Click this button to display the tFund Data subscreen. On the subscreen, select the data settings
you want to be checked.
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For a complete list of the files and fields that are checked for each setting, click here.

Settings Files Checked Field Character Checks Associated Processes

Credit Status Codes FD.CRSTATUS Code: <= 16

Name: <= 32

FD.CRSTATUS.E

Donor Types FD.TYPE Code: <= 16

Name: <= 256

FD.TYPE.E

Mail Codes FD.MCODE Code: <= 16

Name: <= 256

FD.MCODE.E

Membership Codes FD.MSHIP Code: <= 16

Name: <= 256

FD.MSHIP.E

User Defined Codes FD.USER Code: <= 16

Name: <= 64

FD.USER.E

User Defined Fields FD.UDEFINE Name: <= 32

Description: <= 64

SU.UDEFINE.E

Internet Setups

Click this button to display the Internet Setups subscreen. On the subscreen, select the data set-
tings you want to be checked.
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eRes Email Templates

Select this option to check the field character lengths in the ERES.EMAIL file (Code <= 32,
Text <= 24000). The values are entered in the SU.EMAIL.E process.

SYS Operators

Select this option to check the field character lengths in the SYS.OPERATOR file (Code <= 32,
Name <= 128). The values are entered in the SYS.OP.E process.

Season

This field lists the seasons that will be checked using the Seasonal Data settings above. You must
have at least one season in this field. Press the F3 key to display a list of configured seasons that
you can add to this list.

Run

Click this button to start the massload data pre-check. A Messages screen displays alert messages,
if errors are found during the pre-check. Fix the errors and run the pre-check again until it com-
pletes without any errors. For the pre-check procedure, see Pre-Checking the Massload Data.

Cancel

Click this button to cancel the pre-check without saving any changes.

Load Paciolan 7 Seasons

Click this button to load all seasons with Paciolan 7 Status = S or I.

Select All

Click this button to select all the pre-check options on this screen, including those on the tRes Non-
Seasonal Data, tPatron Data, and tFund Data subscreens.

Deselect All

Click this button to clear all the pre-check options on this screen, including those on the tRes Non-
Seasonal Data, tPatron Data, and tFund Data subscreens.

System Setup Screen
Maintenance > System > System Setup

TK.SETUP.E

When setting up Pac7, use the System Setup screen to verify that Pac7 has been enabled. Pac7 is
enabled when the Paciolan 7 option is selected.
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Note: The System Setup screen contains many other parameters specific to each ticketing install-
ation, such as customer and other parameters. For information about all of the fields on this
screen, see the tRes reference topic.

Control Descriptions
Paciolan 7

The Paciolan 7 option indicates whether Pac7 is enabled. When the Paciolan 7 option is selected,
tRes sends real-time data changes to Pac7. If the option is not selected, data will not be sent.

Note: This control is for display only. The first request for a Pac7 massload selects the option.
Once turned on, you cannot turn the option back off. If the option were to be turned off, tRes and
Pac7 data would get out of sync. If you want to turn off the option, contact Paciolan for assistance.

Print Forms Screen
Maintenance > System > Format > Forms

TK.FORMS.E

When setting up and using Pac7, use the Print Forms screen to create or update forms for printing
tickets, mailers, or receipts in Pac7.
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Note: For more information about creating forms using the Print Forms screen (TK.FORMS.E), see
the tRes reference topic.

Control Descriptions
Note: When working with print forms for Pac7, you can reference a list of supported print form
variables.

Use with Pac7

Select this option to make the form specified by the Form Code usable in Pac7 for printing tickets,
receipts, or mailers. All forms you create or update with this screen are usable in tRes, whether or
not you select this option.

System Functions Setup Screen
In System Functions: Maintenance > System > System Setup

SYS.SETUP.E

When setting up Pac7, reference this screen to find the Client ID. For information about the con-
trols on this screen, click in a control field and press F1. If you have questions about this setup,
please contact Paciolan Customer Services.
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Operator Access Screen (In System Functions)
(In System Functions) Operators > Operator Access

SYS.OP.E

Use the System Functions level version of the Operator Access screen during Pac7 setup to create
operator codes to assign to Pac7 users. Once you have created an operator code, you can set up its
selling parameters and make it available for use for individual business accounts.

Note: Only controls that are referred to in this Help system are described in this topic. For a com-
plete description of the controls on this screen and its subscreens, see the System Functions ref-
erence topic.

Control Descriptions
Operator
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Enter the operator code in uppercase letters. If this is a new operator, match the name with the
AIX logon for simplicity. Limit operator codes to eight characters. Operator codes of more than 8
characters may not work well with some systems with which Paciolan systems interact. The max-
imum number of characters is 32.

This operator code is displayed in Pac7 in a drop-down list on both the Manage Groups of users
page and in the Assign User Access Rights group on the Manage User page.

Name

This name is not displayed in Pac7, so this field is optional. The maximum number of characters is
128.

View Unmasked Credit/Gift Card

Select this option to allow user's with this operator code to view unmasked credit/gift card inform-
ation. However, if a user signs in to Pac7 as this operator, the option will automatically be cleared
when the user signs out.

Processes Allowed

Click the Processes Allowed button to display this subscreen. Use this subscreen to configure the
processes that the operator is allowed to use in tRes. You can enter the process codes, or press the
F3 key to select them from a list. If you do not configure any codes, the operator will have access
to all processes, except for any that you add to the Processes Disallowed subscreen.

Processes Disallowed
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Click the Processes Disallowed button to display this subscreen. Use this subscreen to configure the
processes that the operator is not allowed to use in tRes. You can enter the process codes, or press
the F3 key to select them from a list.
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Glossary

3
3rd party outlet

Ticket outlets operated by independent busineses, such as convenience stores. A 3rd party outlet can be set
up as a separate business account.

A
Access pass

A pass to an event that allows special privileges to the bearer. You must select a patron (not a house cus-
tomer) to sell an access pass, and WBST only allows one access pass per patron for each season.

Account management
Tracking patron account history across seasons.

Activity
A generic version of a type of season. Activities are used as templates for creating seasons.

Administrator
Business organization and data account administrators. TBD

Allocatable item
An item to which you can assign seats. See also Non-Allocatable Item.

Allocatable items
Items to which seats can be assigned. Only single event and combination items are allocatable.

Allocation
The assignment of a specific seat to a single event or combination item.

Apply payments
Associating undistributed money to an order line or order charge. Payments can be applied automatically or
manually, depending on the selling control configuration.

Area
A group of seats that have the same price level (PL). A seat can not belong to more than one price level.

Auto-assign
A Best Available search using default system settings. The default system setting for Best Available always
finds contiguous seats within the same row. Auto-assign adheres to seat gap rules.

B
Back office

Another term for the Ticket Reservation System (tRes).

Batch
A a record of item transactions collected over a period of time to store operator selling data. Batch inform-
ation is used for reconciling sales and reports.

Best available
A function that automatically assigns the best available seats to an allocatable item. The seats considered
the best available for an event at a facility are configured by the ticket manager in tRes.

Business account
Business accounts are the business organizations through which you sell tickets. Multiple business accounts
can be assigned to a data account. Independent business accounts are required for business organizations
that need to manage their users and sales reports separately from other business organizations.
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Business organization
The organizations through which you sell tickets. A business organization may have multiple selling loc-
ations, each of which use oneor more ticketing terminals. Each business organizations can manage its users
and sales reports separately from other business organizations.

C
Cancel order

Ending the current order without saving changes.

Cancel order line
Reducing the quantity of an item in an order line during order management.

Combo Item
The combo item is a multiple event item (for example, season tickets or a series). A combo item is built
using previously created single event items.

Control
A control is a selling environment. It is used to set up the parameters of the selling process, such as valid
items, operators and pay modes. One or more controls can be assigned to each seller, thereby allowing you
to customize the permissions given to each business organization.

Counter hold
A status applied to seats that are held but not yet part of a customer order.

Credit authorization
Paciolan's back-end system for credit card authorization.

Customer
See Patron.

Customer hold
A status applied to seats that are held for a customer order but not yet allocated.

Customer seat hold
Seats for a single event that are on hold for a customer without being added to the customer's order.

D
Data account

The account that is comprised of the database/supplier. Multiple business accounts can be assigned to a
data account.

Data account owner
The owner of the database or the supplier.

Data synch
The process of sending data from tRes to WBST due to data changes in tRes.

Deallocation
The removal of seat assignments from an order line in order management.

Delivery method
Delivery methods (also called dispositions) represent the ways in which ticket ownership is transferred to
patrons. The types of delivery methods include magstripe credit cards, magstripe student IDs, print at
home, and traditional.

Designer combo
See flex combo
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Discount
A set deduction from a standard item price.

Disposition
See Delivery Method.

Disposition code
Code used by the ticket office to indicate how the customer wants tickets to be disbursed (for example, print
and mail or will call).

Distributor
A ticketing services company whose business involves providing sales channels for tickets. This service
could be provided through a manned outlet, ATM machine, or other means.

E
Enterprise Ticketing

An old name for Item Sales that is no longer used.

Event
A single game or performance which is taking place at a specific date, time, and location. An event is an
instance of a particular item. For example, "The Rose bowl" event at the Rose Bowl on January 1, 2005.

F
Facility

The physical location where events are held.

Facility fee
The fee that the customer is charged in addition to the ticket price. A facility fee is typically used to separate
the facility and ticket revenues.

Facility map
Map of the facility where the event takes place. Shows seat sections and relationship to stage.

Facility time zone
The time zone within which a facility is located.

Fee cap
A fee cap is a limit to the per item fees on an order for a specific season. If an item's fees exceed the fee
cap, WBST automatically applies a negative charge to offset the extra fees.

Finish and Pay
Completing this process is required during order management when changes to a patron's order have pay-
ment implications, require entry of a magstripe credit card number, or require entry of a print at home
email address.

Firewall
A security product set up to control access to a company's internal systems from external sources, and to
control access to outside systems from within the company.

Fixed combo
An Item with a fixed list of events. A Fixed combo cannot include miscellaneous items, donations, or gift cer-
tificates.

Flex combo
A group of fixed combinations from which patrons can choose.
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G
Gift certificates

A non-allocatable item that can be purchased by customer as all or part of an order.

Group
A collection of similar events.

H
Hold

See On hold seats.

Hosted system
A specific collection of hardware and software applications housed at a Hosting Facility for the purpose of
providing a customer remote access to the applications under the terms of a Hosted Services Agreement.

Hosting facility
A physical plant at which system hardware is located, for the purpose of hosting system functions to be used
by others, usually via Internet or leased-line connectivity.

House customer
The house customer is a group of customers about which no information, including address, is gathered or
stored. You can use the house customer for sales to walk up customers and, typically, the category is used
in a quick sale (on sales) situation.

I
Individual customer

An individual (or public) customer is a single patron about which WBST keeps a record of personal inform-
ation. In this record, WBST stores the customer's address and phone number, as well as many other other
types of pertinent information.

Internet
A worldwide system of computer networks.

Inventory
The set of items that can be sold.

Item
Anything you can sell using Paciolan software. You search for items by key item attributes. Every item has a
type, but may or may not have an inventory. All items are uniquely identified by item key (season and item
codes) An item can contain other items.

Item group
A list of seasons and the items that compose the seasons. When item groups are included in a control, oper-
ators assigned to that control can sell the component items of all the seasons in the item group.

Item sales
Predefined sales paths that guide an operator through the sales process. The types of item sales include
onsales, general sales, and promotional sales.

L
Level

A subdivision of a facility that contains sections.
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M
Magstripe

(magnetic stripe readers) swipe reader for reading any card with magnetic stripe information, such as credit
cards, driver's licenses, and access control cards.

Massload
The loading of inventory data from tRes to Paciolan 7 for a complete load or for changed season, event seat,
or seatmap data.

MiniMap
A window that is docked in the detailed view of the seat map. The MiniMap allows you to navigate to other
areas of the detailed map and displays where each seat block is located.

Miscellaneous item
An item that is not covered by the normal ticketing process. The item may represent away game events
(attached to your external events) or be used to sell hats or T-Shirts.

N
Non-Allocatable item

An item that is not a ticket and to which you cannot allocate seats. For example, a hat or a donation.

O
On hold seats

Seats that a ticket operator has selected for an order, but for which the order is not yet placed.

Onsale
High-volume ticket sales event.

Operator codes
Operator codes represent the operators that can use each control. This allows multiple operators to be
assigned to each control and individual operators to be assigned to multiple controls.

Order
A specific monetary event recording items purchased, customer ID, Order total, and Payment Method. The
sum of all transactions for a Customer. An order is not specific to a date. One customer's transactions at an
instance in time, once an item is added to the cart. An order is either Open, Completed, Voided, Returned,
Exchanged, or Cancelled.

Order charge
The total handling or service charges for an order. Order charges are added to the ticket prices, discounts,
surcharges, and delivery charges for the order.

Order line
An order line is an order management element that contains a single item and quantity for a selected patron
and season. If the item is allocatable, the order line will also contain a price level, a price type, and seat-
block information.

Order Line Additional pane
A part of the Order Management tab that displays both standard and customizable information and entry
fields that apply to a single order line item.

Order management
A method of adding or editing sales based on a patron and season combination. You can manage each com-
bination at the order level and order line, as well as input payment information.

Overallocate
Selling more than one ticket/person per seat. Paciolan software does not allow overallocation. You must
have seats available to print tickets.

Pac7 Release 7.2



User Guide  1196

Oversell
When demand exceeds supply. You can oversell by choice in Paciolan software. When you oversell, you can
have a lottery to determine which patrons get tickets.

P
Patron

A generic personal record that is used to capture demographic information about individuals or institutions.
These records are stored in the patron database. Also called a customer.

Pay mode
A method of payment such as cash, check, or credit card.

Payment mode
See Paymode.

Payment type
The means that patrons use to pay for their orders, including the cash, check, credit, gift card, gift cer-
tificate, and other types. You cannot edit or add to these payment types.

Paymode
A set of attributes that define methods of payment used by patrons, including the payment type. For,
example, the Visa or MasterCard paymodes are assigned the Credit payment type.

Permanent batch
The batch assigned to the current user's operator code in the WBST control (policy). Whenever you select a
policy for selling, WBST automatically uses the permanent batch number to record item transactions

Policy
The name of the controls under which you are currently selling.

POS batch
A group of orders dealing with Money recorded in a date range. A POS Batch may include orders across DB.

Price level
A group of sections or seats within a facility that have similar pricing. The group cannot belong to more than
one price level.

Primary event
An event in a combo item that you use to automatically select or deselect seats for multiple events. For
example, you use one game in a season ticket package to select seats for all of the games in the season.

Prorate
The process of adding or removing event items from a fixed combination item. When you prorate items,
their cost is removed from the order total.

R
Reallocate

A method of assigning seats from a season to the patron who purchased the same seats in a previous sea-
son.

Renewal
A method of selling seats from a season to the patron who purchased the same seats in a previous season.

Reorder
A method of selling items from a season to the patron who purchased the same items in a previous season.

Pac7 Release 7.2



User Guide  1197

S
Sales code

Sales codes are used to track the origin of sales via the selling process.

SBClient
SBClient allows you to create a logical connection between your PC and a host system. You use this con-
nection to run Paciolan systems, such as tRes. Each connection is called a session.

Search plan
A pre-defined search path that specifies the sequence and other criteria that seats should be searched by.
Search plans are often used for group sales.

Season
A time period in which a set of similar events occur (e.g., Football Season or 2005 Ballet Season). A season
does not have a time limit. Item pricing is determined by season.

Seat block
An adjacent group of seats in same row that are on hold for an event.

Seat map
Map of individual seats within a section and whether they are occupied or available. Can also show seat
type: wheel chair accessible, season ticket holders, etc.

Seat status
A seating description used to indicate whether a seat is occupied, in use during a sale, or on hold.

Shopping cart
The page you use to gather the items your customer wants to purchase. This page allows you to review
selections, make necessary modifications or additions, and complete orders.

Single-event item
See event.

Surcharge
A percentage of a fixed amount that is added to the item price and any per item fees. Typically used in Cana-
dian markets to represent tax.

T
TCS

An old name for WBST. Should be deleted.

Temporary batch
Whenever you change the permanent batch from within WBST, the newly assigned batch is considered tem-
porary. Temporary batch numbers do not change the setting in the WBST control (policy).

Terminal ID
(TID) The identifier supplied by the credit card processor to allow a merchant to designate the source of a
particular transaction.

Ticket
Admission to an event. A ticket may or may not have a seat assigned.

Ticket charge
The amount of money charged to customers (by order line) for each ticket that they buy.

Traditional delivery method
Traditional delivery methods are those that physically transfer tickets to patrons, for example, box office,
will call, mail, or FedEx.
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Transaction
A monetary event recorded in a batch. Transactions are specific to a date and time.

tRes
Also called the back office or the Ticketing Reservation System.

U
Undistributed payment

A payment that is not applied to an order line at the time the order is placed.

URL
A URL (Uniform Resource Locator) is the address of a file accessible on the Internet. A Web site address is
an example of a URL.

V
Venue

See Facility.

W
WBST

Web-Based Sales Terminal. An old name for item sales that is no longer used.

Will call
A type of ticket disposition where the ticket purchaser picks up the tickets at a ticket office or other location.
This is commonly used when it is impractical to mail tickets for some reason.
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Index

A

Access Pass Options (TK.BA.E) 975
Account information 4
Activating terminals 940
Active users 935
Activity Price Table (TK.PTABLE.ACT.E) 1024
Additional Information (TK.EFORMAT.E) 1137
Additional Settings (TK.PPOLICY.E) 994
Address type data 185
Adjustment Options (TK.BA.E) 984
Adjustments hub 772
Administration
business organizations See Business organizations
onsales 959
overview 908
terminals 938
users See User management

Alert messages
creating 22

Aligning printers 951
Allocating seats
in item sales 616
in order management 412

Alternate shipping addresses 698
Application access 943
Application items 234
Applying payments 526
Area search 368
Assigning seats in item sales
assigning later 616
overview 616
using best available 619
using Quick Entry 621

Associated patrons 703

B

Back office reference 966
Balancing Report by Item Fee 842
Batch change
in item sales
for another user 791
overview 337, 743
permanent 744
temporary 746, 784

in order management 337, 743
Batch Options (TK.ETCONTROL.E) 1062
Best available seats
in item sales 619
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in order management 366
Billing plans
in item sales 709
in order management 237, 536

Boca Sales Summary Report 294, 827
Browser configuration 939
Business accounts
Business Accounts (TK.BA.E) 969
creating 14

Business organizations
changing terminal setup password 933
creating locations 928
overview 928
setting the password policy 931
viewing active users 935
viewingmassload status 936

C

Canceling order changes 577
Canceling order lines 477
Canceling orders 735
Cart Definition (TK.EFORMAT.E) 1132
Cart page
adding items 685
changing quantity/price 694
checking out 691, 734
deleting items 713
going to 689
modifying items 690, 692
overview 684
viewing order item details 602, 689

Cash drawers 139
Changing patrons in item sales
house customers 683
individuals 681
overview 681

Checking out of item sales cart 691, 734
Collecting payments See Payment collection
Combos in item sales
prorating 599
selecting with seat map 384, 635

Combos in order management
prorating event items 437
selecting events for flex combo 362
selecting seats in seat map 384, 635
viewing event details 433

Confirmation email
for item sales
resending 770
setting up 118

for order management
sending during payment 533
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setup in tRes 115
connection speed 954
Contact entry 321
Creating patrons See Patron entry
Credit cards
re-swiping
in item sales 732
in order management 561

using previous
in item sales 733
in order management 550

Custom sales forms
for item sales 98
for order management 102

Customer seat holds See Seat holds

D

Data Access Options (TK.PPOLICY.E) 997
Data accounts
Data Account (TK.TSETUP.E) 966
setting up 9

Data massloading See Massloading data
Data pre-checking See Massloading data
Data sync See Synchronizing data
Data types 172
Deallocating seats
in item sales 713
in order management 459

Delivery charges 711, 715
Delivery methods
using in item sales
adding 713
changing 711, 714

using in order management 557
Designer combos
selecting events for 362

Detailed Transaction Report by Batch 841
Discounts/Surcharges 693

E

Editing patron records See Patron editing
Email confirmation See Confirmation email
Enabling Paciolan 7 9
Enter Payment Information page 720
Entering patron information See Patron entry

F

Facilities (TK.FACILITY.E) 1029
Facility time zones 15
Finishing orders 575
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Full patron entry in item sales 675

G

General sales transactions 589
Getting Started 1
Gift card 552
Gift certificates
getting the value in item sales 729
re-issuing in order management 562
re-scanning in item sales 730

Groups of users 917

H

House customers
changing in item sales 683
searching for in item sales 671
using in order management 220

I

Individual users 908
Inquiries
for incomplete orders 767
in all systems 762
in Paciolan 7 only 754
overview 754

Inquiry hub 754
Item additional details 603
Item groups
defining 19
Item Sales screen 1014
searching in item sales 611

Item order details 603
Item sale dates 66
Item Sales Delivery Methods (TK.TDMETH.E) 1019
Item Sales Email Entry (TK.ET.EMAIL.E) 1023
Item Sales Forms (TK.EFORMAT.E)
Additional Information 1137
Cart Definition 1132
Item Sales Formats 1130
Order-Line Details 1136

Item Sales hub 580
Item Sales Item Groups (TK.TGROUP.E) 1014
Item Sales Level Section Conversion (TK.TFAC.E) 1030

L

Laser printing 133
Locations for business organizations 928
Logging in/out See Signing in/out
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M

Magstripe delivery 129
Mailer/Receipt options 728
Map/Seat Search Options (TK.ETCONTROL.E) 1074
Massload Data Pre-Check (TK.TCS.PRECHECK) 1172
Massloading data
adding seasons for
adding 174
overview 173
status inquiry 175

fixing pre-check errors 154
Massload Data Pre-Check (TK.TCS.PRECHECK) 1172
Massload Season Entry (TK.ETSTAT.E) 1170
massloading 170
overview 149
pre-checking data 152
preparing for first 152
viewing status 936

Min/Max/Multiple 81
Multi-day events 77
Multiple event items
searching for seats in item sales 658
selecting in order management 355

Multiple price level details 604
Multiple seatblock details 605

N

Navigating Paciolan 7
Item Sales hub 581
Order Management hub 191
Paciolan application 3

Network connection speed 954
Non-Allocatable items in item sales
access passes 665
donations 664
gift certificates 663
miscellaneous items 661
processing 661

O

Onsale management
conducting an onsale 964
preparing for an onsale 959

Onsale transactions 583
Operator Access (SYS.OP.E) 1188
Operator Access (TK.OP.E)
Operator Access 1010
Selling Parameters 1011
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Operator codes
creating 12
Operator Access screen (System Functions) 1188
Operator Access screen (tRes) 1010
setting up access 14

Operator management See User management
Operators (TK.BA.E) 974
Order-Line Details (TK.EFORMAT.E) 1135
Order Amount Breakdown form 337, 518
Order charges
in item sales
adding 716
changing 717
deleting 719
overview 715

in order management 332
Order entry
during onsales 583
in general sales 589
in order management 204
in promo sales 594

Order inquiry See Inquiries
Order level information 230
Order Line Additional pane 511
Order line item selection
multiple items 355
overview 345
single items 345

Order lines
adding 343
canceling 477
deallocating 459
overview 341
printing 441
reprinting 441
searching 342
voiding 490

Order Management hub 191
Order Options (TK.ETCONTROL.E)
item sales 1100
order management 1079

Order quantity rules 81
Other Patron Attributes (TK.PPOLICY.E) 1005

P

Paciolan 7 Alert Messages (TK.TALERT.E) 985
Paciolan 7 Business Accounts (TK.BA.E)
Access Pass Options 975
Adjustment Options 984
Operators 974
Paciolan 7 Business Accounts 969
Passwords 976
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Report Options 975
Paciolan 7 Controls (TK.ETCONTROL.E)
Batch Options (Common) 1062
Delivery Methods (Item Sales) 1093
Display Options (Item Sales) 1093
Item Groups (Item Sales) 1099
Order Options (Item Sales) 1100
Order Options (Order Management) 1079
Paciolan 7 Controls 1031
Patron Options (Common) 1064
Patron Options (Item Sales) 1064
Payment Options (Common) 1067
Payment/Post Sale Options (Order Management) 1086
Post Sale Options (Item Sales) 1111
Print/Receipt Options (Common) 1071
Season Detail (Common) 1037
Seat Search/MapOptions 1074

Paciolan 7 Data Account Setup (TK.TSETUP.E) 966
Paciolan 7 Season Status Entry (TK.ETSTAT.E) 1170
Passwords
changing for terminal setup 933
setting the policy 931

Passwords (TK.BA.E) 976
Patron change in item sales See Changing patrons in item sales
Patron editing
in order management 225, 310, 515
on the Patron hub 814

Patron entry
in item sales 675
full entry 675
quick entry 672

in order management 205
on the Patron hub 807

Patron hub 803
Patron Management Control (TK.PMGMT.E) 1008
Patron management controls 13
Patron Options (TK.ETCONTROL.E)
common 1064
item sales only 1064

Patron policies 12
Patron Policy (TK.PPOLICY.E)
Additional Settings 994
Data Access Options 997
Other Patron Attributes 1005
Patron Policy 988
Patron Search Options 997

Patron Search Options (TK.PPOLICY.E) 997
Patron search/selection
house customers in item sales 671
in order management 209
individuals in item sales 669
on the Patron hub
displaying recent 824
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searching for 803
Patron Summary 312
Payment collection
in item sales 720
in order management 514

Payment distribution 727
Payment methods 521
Payment Options (TK.ETCONTROL.E) 1067
Payment types
adding 725
setting 721

Placing orders in item sales 737
Post Sale Options (TK.ETCONTROL.E) 1111
Previous credit cards See Credit cards
Previous season overviews 293
Price level names 17
price splitting 410
Price type dependencies 70
Price types in item sales 667
Print at home 121
Print form variables
standard address type data 185
supported variables 176
unsupported variables 184

Print forms 113
Print/Receipt Options (TK.ETCONTROL.E) 1071
Printer configuration See Ticket printer configuration
Printing
Boca batch summary 297, 829
mailers/receipts
in item sales 728
in order managment 554

order line items 441
Promotion item transactions 594
Promotions
Promotions (TK.PROMO.E) 1168
setting up for item sales 66

Prorating combos
in item sales 599
in order management 437

Q

Quick item entry in item sales 621
Quick patron entry in item sales 672

R

Reallocating/Reordering 298
Recall last patrons 824
Record locking 186
Reissuing gift certificates See Gift certificates
Releasing seats in the cart 712
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Reording/Reallocating 298
Report Options (TK.BA.E) 975
Report views 920
Reporting
Balancing Report by Item Fee 842
Boca Sales Summary 294, 827
Detailed Transaction Report by Batch 841
sales summary reports See Sales summary reports

Reprinting
in item sales 740
in order management 441
prior receipts 304, 569

Rescanning gift certificates 730
Resetting terminals 957
Reswiping credit cards See Credit cards
Return Authorization Report 839
Returns
in item sales 772
in order management 566

Roles for users 923

S

Sale codes for item sales 724
Sale dates 66
Sales summary reports
overview 831
Return Authorization 839
Sales Summary 831
Sales Summary by Item 833
Sales Summary by Paymode 837
Sales Summary by User 835

Search plans 371
Searching for Item Sales Items
by facility 609
displaying recent items 614
overview 605
using item groups 611
using the text box 606

Searching for patrons See Patron search/selection
Searching for seats in item sales
assigning seats 616
overview 615
using the seat map 625

Searching order lines 342
Season Detail (TK.ETCONTROL.E) 1037
Season massload See Massloading data
Season overviews 293
Season Price Table (TK.PTABLE.SEA.E) 1027
Season selection 229
Seat assignments in item sales
assigning later 616
changing in the cart 693
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overview 616
using best available 619
using Quick Entry 621

Seat fields
deallocating seats 429
overview 365
processing holds 416
viewing seat assignments 413

Seat holds
adding 251
editing 264
ordering 260
overview 251
releasing 288

Seat map
going to a seat location 395, 646
going to overview map 407, 655
overview
in item sales 625
in order management 373

releasing seats 392, 643
selecting seats
for combo items 384, 635
for single event items 376, 627

viewing seat information 399, 647
viewing seats
during item sales 399, 647
from an order line 396

viewing the legend 409, 657
Seat Search/MapOptions (TK.ETCONTROL.E) 1074
Selling controls
creating 23

Selling Parameters (TK.OP.E) 1011
Setup overview 7
Shopping Cart See Cart page
Signing in/out
of the system 2
testing user logins 944

Standard address type data 185
Submitting payment information See Payment collection
Surcharges/Discounts 693
Synchronizing data 149
SYS.OP.E 1188
SYS.SETUP.E 1187
System Functions Setup (SYS.SETUP.E) 1187

T

Tagging patron records 820
Terminal configuration
activating the terminal 940
configuring application access 943
configuring browsers 939
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overview 938
testing user logins 944

Terminal management
analyzing network connection speed 954
changing terminal location 956
changing the setup password 933
configuring terminals See Terminal configuration
configuring ticket printers See Ticket printer configuration
resetting terminals 957

Ticket printer configuration
modifying 950
overveiw 946
testing alighment 951

Time zones 15
TK.BA.E 969
TK.ET.EMAIL.E 1023
TK.FACILITY.E 1029-1030
TK.OP.E 1010
TK.PMGMT.E 1008
TK.PPOLICY.E 988
TK.PROMO.E 1168
TK.PTABLE.ACT.E 1024
TK.PTABLE.SEA.E 1027
TK.TALERT.E 985
TK.TDMETH.E 1019
TK.TGROUP.E 1014
TK.TSETUP.E 966
Transaction logging 10

U

User account 4
User defined fields 232
User management
Boca report views 920
groups of users 917
individual users 908
overview 908
user roles 923

V

Viewing item sales details
item additional 603
item order 603
multiple price level 604
multiple seatblock 605
overview 602, 689

Views of reports for users 920
Voiding last order in item sales 741
Voiding order lines 490

Pac7 Release 7.2



User Guide  1210

W

Will call patrons 706
Will call pickups 795

Pac7 Release 7.2


	Copyright, Trademarks, & Disclaimer
	Table of Contents
	Chapter 1 Getting Started
	Sign In / Sign Out
	Navigating in Pac7
	Updating Account Information

	Chapter 2 Setup
	Enabling Paciolan 7
	Setting Up Data Accounts
	Setting Up Transaction Logging
	Setting Up Patron Management Access
	Defining Patron Policies
	Creating Operator Codes
	Creating Patron Management Controls

	Setting Up Operator Access
	Creating Business Accounts
	Defining Facility Time Zones
	Defining Level Section Print Conversion
	Defining Item Sales Price Level Names
	Defining Item Sales Item Groups
	Defining Item Sales Delivery Methods
	Creating Alert Messages
	Creating Paciolan 7 Selling Controls
	Configuring Operator Seat Map Access
	Configuring Order Management Returns
	Configuring Order Management Exchanges
	Creating Custom Forms for Exchanges

	Setting Up Item Level Options
	Setting Up Item Sale Dates by Operator Group
	Setting Up Promotions
	Setting Up Price Type Dependencies
	Setting Up Multi-Day Events
	Setting Up Order Quantity Rules
	Setting Up Order Quantity Rules for Single and Combo Items
	Setting Up Order Quantity Rules for Miscellaneous Items


	Creating Custom Sales Forms
	Creating Custom Forms for Item Sales
	Creating Custom Forms for Order Management

	Using TK.SELL Print Forms for Pac7
	Setting Up Email Confirmation for Order Management
	Setting Up Email Confirmation for Item Sales
	Setting Up Print at Home Delivery
	Setting Up Magstripe Delivery
	Setting Up Laser Printing
	Setting Up Cash Drawers
	Synchronizing Data
	Massloading Data Overview
	Preparing for the First Data Massload
	Pre-Checking Massload Data
	Fixing Data Pre-Check Errors
	Adjustment (Charges, Discounts) Errors
	Event Errors
	Item Errors
	Manifests/Configurations/Areas Errors
	Price Table Errors
	Seat Status Code Errors
	Alert Message Errors
	Business Account Errors
	Data Account Errors
	Delivery Method Errors
	Facilities Errors
	Item Group Errors
	Operator Errors
	Patron Management Errors
	Patron Policy Errors
	Selling Control Errors


	Massloading Data
	Data Update Types by tRes Function

	Adding Seasons Overview
	Adding Seasons
	Performing a Season Status Inquiry

	Supported Print Form Variables
	Unsupported Print Form Variables
	Setting up Standard Address Type Data

	Paciolan 7 Record Locking Recommendations
	Placing an Order
	Saving a Patron


	Chapter 3 Order Management
	Navigating the Order Management Tab
	Moving Between Order Management Pages
	Using Order Level Processes in Order Management
	Creating Orders in Order Management
	Creating Patrons in Order Management
	Selecting Patrons in Order Management
	Using House Customers in Order Management
	Editing Patrons in Order Management
	Selecting Seasons in Order Management
	Adding Order Level Information in Order Management
	Editing User Defined Fields in Order Management
	Using Order Level Actions in Order Management
	Adding Application Items in Order Management
	Using Billing Plans in Order Management
	Using Customer Seat Holds in Order Management
	Adding Customer Seat Holds in Order Management
	Ordering Customer Held Seats in Order Management
	Editing Customer Seat Holds in Order Management
	Releasing Customer Held Seats in Order Management

	Viewing Previous Season Overviews in Order Management
	Generating the BOCA Sales Summary Report
	Reordering and Reallocating Items in Order Management
	Reprinting Prior Receipts in Order Management

	Editing Patron Information in Order Management
	Viewing the Patron Summary in Order Management
	Using Contact Entry in Order Management
	Using Order Charges in Order Management
	Changing Batches
	Viewing the Order Amount Breakdown in Order Management

	Using Order Line Processes in Order Management
	Searching for Order Lines in Order Management
	Adding Order Lines in Order Management
	Selecting Items for Order Lines in Order Management
	Selecting One Item for an Order Line
	Standard search
	Advanced search
	Search results
	Recent item selection

	Selecting Multiple Events for Order Lines

	Selecting Events for Designer Combos
	Selecting Seats for Allocatable Items in Order Management
	Assigning Best Available Seats in Order Management
	Using Area Search in Order Management
	Using Search Plans in Order Management
	Using the Seat Map in Order Management
	Using the Seat Map to Select Seats
	Selecting Combo Item Seats Using the Seat Map
	Releasing Seats Using the Seat Map
	Going to a Seat Location on the Seat Map
	Viewing Seats on the Seat Map from an Order Line
	Viewing Seat Information Using the Seat Map
	Seat Map Views

	Going to the Overview Version of the Seat Map
	Displaying Specific Seat Statuses


	Price Splitting by Item PL/PT in Order Management
	Allocating Seats in Order Management
	Using Seat Fields in Order Management
	Viewing Seat Assignments in Order Management
	Using Seat Fields for Holds in Order Management
	Using Seat Fields for Deallocation in Order Management

	Viewing Combo Event Order Details in Order Management
	Viewing Facility Fees in Order Management
	Viewing Item Details During Order Management
	Prorating Combination Items in Order Management
	Printing Items in Order Management
	Reprinting Items in Order Management
	Deallocating Seats in Order Management
	Returning Seats in Order Management
	Exchanging Seats in Order Management
	Canceling Order Lines in Order Management
	Voiding Order Lines in Order Management

	Using Go Exchange
	Using the Order Line Additional Pane
	Collecting Payment Information in Order Management
	Editing Patron Information in Order Management
	Viewing the Order Amount Breakdown in Order Management
	Using Payment Methods in Order Management
	Applying Payments in Order Management
	Sending Confirmation Email in Order Management
	Using Billing Plans in Order Management
	Using Previous Credit Cards in Order Management
	Using Gift Cards in Order Management
	Printing Mailers & Receipts in Order Management
	Using Delivery Methods in Order Management
	Re-Swiping Credit Cards in Order Management
	Reissuing Gift Certificates in Order Management
	Issuing Refunds in Order Management
	Submitting Payments in Order Management
	Reprinting Prior Receipts in Order Management

	Finishing Orders in Order Management
	Canceling Order Changes in Order Management

	Chapter 4 Item Sales
	Navigating the Item Sales Tab
	Completing an Onsale Transaction
	Completing a General Sales Transaction
	Selling Promotion Items
	Prorating Combination Items in Item Sales
	Viewing Order Item Details in Item Sales
	Viewing Item Details in Item Sales
	Viewing Item Additional Details
	Viewing Multiple Price Level Details
	Viewing Multiple Seatblock Details

	Searching for Items
	Searching for Items Using the Text Box
	Searching for Items by Facility
	Searching for Items Using Item Groups
	Displaying Recent Items

	Searching for Seats
	Assigning Seats
	Assigning Seats Later
	Assigning Best Available Seats in Item Sales
	Assigning Seats Using Quick Entry

	Using the Seat Map in Item Sales
	Using the Seat Map to Select Seats
	Selecting Combo Item Seats Using the Seat Map
	Releasing Seats Using the Seat Map
	Going to a Seat Location on the Seat Map
	Viewing Seat Information Using the Seat Map
	Seat Map Views

	Going to the Overview Version of the Seat Map
	Displaying Specific Seat Statuses

	Searching for Multiple Events

	Processing Non-Allocatable Items
	Processing Miscellaneous Items
	Processing Gift Certificates
	Processing Donations
	Processing Access Passes

	Selecting Price Types
	Selling to Patrons
	Searching for Patrons During Item Sales
	Searching for Patrons During Item Sales
	Searching for House Customers

	Creating a Quick Patron Entry
	Using Full Patron Entry During Item Sales
	Changing Patrons During Selling
	Changing Individual Patrons During Selling
	Changing House Customers During Selling


	Using the Shopping Cart
	Adding Items to the Shopping Cart
	Going to the Shopping Cart
	Viewing Order Item Details in Item Sales
	Modifying Items in the Shopping Cart
	Checking Out from the Shopping Cart

	Modifying Items in the Shopping Cart
	Changing Seat Assignments in the Cart
	Modifying Item Discounts and Surcharges
	Changing the Quantity and Price of Items
	Entering Additional Information for Items
	Using Alternate Shipping Addresses for Order Items
	Using an Associated Patron for Order Items
	Using Will Call Patrons
	Assigning Billing Plans to Order Items

	Changing Delivery Methods in Item Sales
	Changing Delivery Charge Details from the Cart
	Releasing Seats in the Shopping Cart
	Deleting Items from the Shopping Cart

	Using Delivery Methods in Item Sales
	Changing Delivery Methods in Item Sales
	Changing Delivery Charge Details from the Cart

	Using Order Charges
	Adding Order Charges
	Changing Order Charges
	Deleting Order Charges

	Collecting Payment Information in Item Sales
	Setting the Payment Type
	Selecting an Order Sale Code
	Adding Payment Types for an Order
	Selecting a Payment Distribution Option
	Printing Mailers & Receipts in Item Sales
	Getting the Value of a Gift Certificate
	Re-Scanning a Gift Certificate
	Re-Swiping Credit Cards in Item Sales
	Using Previous Credit Cards in Item Sales

	Checking Out from the Shopping Cart
	Canceling an Order
	Placing an Order
	Reprinting Order Items
	Voiding the Last Order in Item Sales
	Changing Batches
	Changing a Permanent Batch
	Changing to a Temporary Batch


	Chapter 5 Order Inquiry
	Searching for Orders in Pac7 Only
	Searching for Orders in All Paciolan Systems
	Searching for Incomplete Orders
	Resending Confirmation Email in Item Sales

	Chapter 6 Order Adjustments
	Returning Item Sales Items
	Changing to a Temporary Batch
	Processing a Return for Another User

	Processing Will Call Pickups

	Chapter 7 Working with Patrons
	Searching for Patrons on the Patron Tab
	Creating Patrons on the Patron Tab
	Editing Patrons on the Patron Tab
	Tagging Patron Records
	Displaying Recent Patrons

	Chapter 8 Reporting
	Generating the BOCA Sales Summary Report
	Generating Sales Summary Reports
	Generating the Sales Summary Report
	Generating the Sales Summary by Item Report
	Generating the Sales Summary by User Report
	Generating the Sales Summary by Paymode Report
	Generating a Return Authorization Report

	Generating a Detailed Transaction Report by Batch
	Generating a Balancing Report by Item Fee

	Chapter 9 Utilities
	Using the Event Inquiry Utility
	Limiting Operator Access Using Activities
	Item Sales tab
	Inquiry tab
	Adjustments tab
	Patron tab


	Using the Print Tickets Utility
	Using the Seat Hold Management Utility
	Using the Counter Seat Hold Management Utility

	Chapter 10 Administration
	Managing Users
	Managing Individual Users
	Managing Groups of Users
	Managing BOCA Sales Summary Report Views
	Managing User Roles

	Managing Business Organizations
	Creating Business Organization Locations
	Setting the Password Policy
	Changing the Terminal Setup Password
	Viewing Active Users
	Viewing Massload Status

	Managing Terminals
	Configuring Terminals
	Configuring Browsers
	Disable Auto Complete
	Configure Toolbar
	Third Party Toolbars
	Popup Blockers

	Activating the Terminal
	Configuring Application Access
	Testing User Logins

	Configuring Terminal Ticket Printers
	Modifying a Ticket Printer
	Testing Printer Alignment

	Analyzing Network Connection Speed
	Changing the Terminal Location
	Resetting Terminals

	Preparing for an Onsale
	Conducting an Onsale


	Chapter 11 Back Office Reference
	Paciolan 7 tRes Menu
	General Setups Overview
	Paciolan 7 Data Account Setup Screen
	Paciolan 7 Business Accounts Screen
	Operators Subscreen
	Report Options Subscreen
	Access Pass Options Subscreen
	Passwords Subscreen
	Item Sales, Inquiry, and Adjustments Passwords Subscreen
	Go Exchange Passwords Subscreen
	Order Management Passwords Subscreen
	Patron Passwords Subscreen

	Item Sales Adjustment Options Subscreen

	Paciolan 7 Alert Messages Screen (Item Sales Only)

	Patron Setup Overview
	Patron Policy Screen
	Additional Settings Subscreen
	Patron Search Options Subscreen
	Data Access Options Subscreen
	Other Patron Attributes Subscreen

	Patron Management Control Screen
	Operator Access Screen (tRes)
	Selling Parameters Subscreen


	Selling Setups Overview
	Item Sales Item Groups Screen
	Season X Items Subscreen

	Item Sales Delivery Methods Screen
	Item Sales Email Entry Screen
	Activity Price Table Screen
	Paciolan 7 PL Names Subscreen

	Season Price Table Screen
	Facilities Screen
	Level:Section Conversions Subscreen
	Paciolan 7 Controls Screen
	Season Detail Subscreen
	Season Charge Options Subscreen
	Season Item Subscreen
	Auto Modify Price Level/Price Type Subscreen
	Season Bill Plan Options Subscreen
	Season Discount Options Subscreen
	Season Search Plan Options Subscreen
	Season Seat Status Detail Subscreen

	Batch Options Subscreen
	Order/Exchange Options Subscreen
	Patron Options Subscreen (Shared)
	Payment Options Subscreen
	Print/Receipt Options for Selling Paths Subscreen
	Seat Searching/Map Options Subscreen (Shared)
	Order Management Order Options Subscreen
	Order Management Payment/Post Sale Options Subscreen

	Allow Order Confirmation Email
	Delivery Methods Subscreen
	Display Options Subscreen
	Item Groups Subscreen
	Order Options Subscreen (Item Sales)
	Item Sales Payment Apply Subscreen
	Order Timeout Options Subscreen

	Patron Options Subscreen (Item Sales)
	Post Sale Options Subscreen (Item Sales)
	Order Inquiry Options Subscreen
	Return Item Params Subscreen
	Will Call Pickup Subscreen

	Go Exchange Options Subscreen

	Item Sales Formats Screen
	Cart Definition Subscreen
	Order-Line Details Subscreen
	Additional Information Subscreen

	Order Management Forms Screen
	OM Form Additional Fields Subscreen
	Order Management Toolbars Subscreen

	Exchange In Forms Screen
	Promotions Screen

	Massload Parameters Overview
	Paciolan 7 Season Status Entry Screen
	Massload Data Pre-Check Screen


	System Setup Screen
	Print Forms Screen
	System Functions Setup Screen
	Operator Access Screen (In System Functions)

	Glossary
	Index

